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Introduction
Solar Fire is a state-of-the-art astrology software
package for Windows on a PC.
Solar Fire is intuitive, easy-to-use yet powerful calculation
software, designed for both novice and expert astrologers
alike, and it provides easy access to high-quality chart
production using the Windows visual interface.
Solar Fire uses the latest Swiss Ephemeris and ACS Atlas
files, plus you can exchange chart files between Solar Fire
and our AstroGold program for Apple devices via email.

Getting started – new users
Check out A GUIDED TOUR of Solar Fire to familiarize yourself with the basics of the
program.
Study all the links in the Help and Support topic – plenty of help is available!

Getting started – users upgrading from Solar Fire 8
Have a look at Changes from Version 8.x to Version 9 for a quick summary of what's
new.

Why Solar Fire?
Solar Fire includes natal, progressed, directed, solar, lunar and any planet or asteroid
return, composite, harmonic, lunar phase, rise/set and prenatal charts, with a flexible
selection of aspect sets, chart point sets, and database files for chart and place detail
storage. It also includes flexible and powerful dynamic transit and progression reporting
over any specified time period, plus novel options for sorting and viewing output
graphically for maximized readability.
It is possible to view interpretations of any natal chart or of any dynamic report event
interactively on the screen, by simply clicking on items in the chart or report. Synastry
interpretations are also included for any pair of charts. Both interpretations of individual
charts plus general definitions of a large variety of astrological categories are included.
It is possible to edit or append your own text to that supplied with the program.
Chart viewing includes an aspectarian inside the Chart Wheel (or as a separate
tabulation, if preferred), plus Dual Wheels, BiWheels, TriWheels, QuadriWheels or even
QuinquiWheels for displaying combinations of two or more charts, and synastry grids.
Chart points can be viewed in color, as can the zodiac sign glyphs.
Reports include sorted listings of standard chart analysis details, lunar phasing,
modalities and elements, plus additional listings of aspects, rulerships and
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dispositorships, both traditional and esoteric, and midpoints listings, midpoint trees and
axes, fixed star and Arabic Parts positions and aspects.
There are 50 standard chart points to choose from, including planets, moons, chart
angles, trans-neptunians, asteroids and other minor bodies. There are also additional
sets of asteroids, fixed stars, Arabic parts, and midpoints, for example.
Solar Fire has aspect sets selectable from the 1st to the 12th harmonic, with glyphs and
colors for each, plus the ability to accept user defined aspects of any type.
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Help and Support
Solar Fire has an extensive network of help and support for users at all levels of
astrological and computer ability. On-line help is detailed and accessible, the website
has FAQ and numerous tips and tutorials, and you can contact dedicated support
personnel if needed.

2.1

Finding the Information You Need
If you are new to the Solar Fire program, then you should first read the sections Installing
Solar Fire and Finding Your Way Around Solar Fire. This presents some basic information
about the manner in which the program operates.
If you are familiar with the basic concepts and method of operation, but you wish to find
out how to achieve a specific task, then refer to the relevant chapters in the body of the
User Guide as the need arises (see below).
If you are upgrading your version of Solar Fire from earlier versions, then you may wish to
refer to the section that contains a summary of differences between this version and
older versions, and Importing Charts, Files and Settings.
>> To get context sensitive information or help anywhere in Solar Fire
Press the F1 key on the keyboard. This opens an on-line Help topic related to your
current location in Solar Fire
The off-line Help supplied with Solar Fire contains very extensive and detailed
information about all aspects of using Solar Fire. While the context sensitive help
invoked by using the F1 key will probably provide immediate help for the task at hand, it
will rarely be the last word relevant to the task you are performing. To gain a full
appreciation and understanding of the operations you wish to perform in Solar Fire, and
the most effective and efficient ways of carrying them out, progressively read through
the "Contents" of the off-line User Guide, or use it's "Index" to scan for a variety of of
information based on your need.
>> To get access to the full on-line User Guide
Pressing the F1 key from anywhere in Solar Fire, as above, opens the User Guide.
or...
Select Solar Fire User Guide from the Help menu

2.2

Getting the most from Off-line Help
Solar Fire has comprehensive off-line Help, which can be invoked from anywhere within
the program. You do not have to be connected to the Intenet to access off-line Help.
>> To invoke help from any window
Press the F1 key. This will call up a Windows help window containing information
about whichever window or control currently has the focus. This is known as context
sensitive help.
© 2014 Esoteric Technologies Pty Ltd
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>> To invoke help from the menu
Select Solar Fire User Guide from the Help Menu.
The Help window has four tabbed panels (called "tabs") on the left hand side. These
tabs are "Contents", "Index", "Search" and "Favorites". When the Help window opens
usually the tab you were last using will be displayed. If you don't see the tabbed panels
this means they have been hidden. To display them click the Show button on the top left
of the Help window. In the same vein if you wish to hide the tabbed panels to make more
room in the window for the Help text itself, click on the Hide button at the top left of the
window. (See below for more information about the tabbed Panel.)
Getting answers from the off-line User Guide
Contents
In the Contents tab, help information is arranged into a few different categories. The first
categories introduce you to Solar Fire and get you started. The next categories cover the
everyday use of Solar Fire. The remaining categories cover advanced, technical and
reference information.
Each category contains help chapters, like a book, with some chapters having subchapters.
To open up a category or chapter, click on "+" sign to the left of the category/chapter, to
close a category/chapter click on the "-" sign to the left of it. The categories, and the
chapters within them, are arranged so that if those new to Solar Fire start reading from
the first chapter in the first category, to the very end of the User Guide, they will
progressively gain a full understanding of how Solar Fire works. The topics are grouped
according to the tasks you'll need to perform first to get going, as well as the
progressive level of skill required to complete the various operations possible in Solar
Fire.
To aid in reading through the on-line User Guide from beginning to end you can use the
"Next Page", "Previous Page" and "Chapter Overview" red and green arrow buttons to
the right of the topic Header (just above the topic text itself).
However you can also simply jump to any point in the Contents tab at any time to
navigate through topics and their text as you wish.
Index
Use the Index tab to enter words in the "keyword" box that describe what you want help
on.
If the word you are typing exists as an entry in the index it will be jumped to and
highlighted as you type. Often an index entry has related sub-entries underneath it which
makes the index a powerful tool when looking for help on a specific topic. Once you can
see an index entry or sub-entry that you want to look up in the body of the Help text,
either double-click on it with the left mouse button, or click on the Display button at the
bottom.
The index is the best option to use for quick answers, as it can immediately present to
you an ordered list of all the relevant topics in Help containing the information you are
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searching for. The index is comprehensive and cross-referenced.
TIP: if you have entered a word in the "keyword" box but not found what you're looking
for in the Index, check there isn't a similar index entry just above or below the one you
are looking for.
Here are some potentially useful index keywords to try: Aspects, Calculations, Chart,
Directions, Interpretations, Progressions, Points, Reports, Returns, Search, Settings, Solar
Fire, Transits.
If you are reading something in this User Guide and want to know more about it, try
entering a word for it in the "keyword" box - it may lead to more information.
Search
Use the Search tab to search for all occurrences of one or more words in the Help text.
Enter the word(s) you are looking for, then press the Enter key on the keyboard, or click
on the List Topics button. Then double-click on a "Title" or select it by clicking on it once
and then click on the Display button.
Generally you would use the Search tab if you have tried the Index but still couldn't find
what you were looking for. Using Search will enable you to find any piece of information
in Help if it exists, but the results are not organized at all and it is thus more time
consuming processing the results. But you can use it to ferret out any last little detail
about something, if it exists somewhere in the User Guide.
TIP: If you enter several words in the "Type the word(s) to search for" textbox (e.g.
progressed planet) and press the Enter key or click on the List Topics button, all topics
with any of those words (whether they occur together or not, and/or in the order you've
typed them in or not), in their text will be presented - which can result in a large number
of topics which potentially have the information you're looking for.
If however you enclose the words in quote marks (e.g. "progressed planet") then only
text that has that same combination of words occurring together in that order will be
found, usually resulting in far less topics with much more likelihood of containing the
information you're after.
Favorites
Once you have found and displayed the topic you are interested in you can save that
topic as a favorite for quick access from that point onwards - use the Favorites tab for
this. With the topic text displayed in the right hand viewing pane, click on the Favorites
tab, then on the left, down the bottom below the "Current topic" box, click on the Add
button. At a later time you can then display any topic in the Favorites tab by either
double-clicking on it or by selecting it then clicking on the Display button.
Navigating forwards and backwards in Help
To easily get back to previous topics you've read click on the <= Back arrow at the top
left of the Help window. You can do this multiple times if you need to, to return to a
place you originally were in the Help after having read many topics. Likewise you can
click on the Forward => arrow to traverse the Help text in the opposite direction.
TIP: Often in the Help text you will come across a link (like this) to another topic in the
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Help contents. If you click on this link it will jump you directly to that section. To return
to where you were before clicking on the link use the Back & Forward arrows.
You can always tell where you are in Help, relative to the category/chapter hierarchy in
the "Contents" tab, by looking at the "breadcrumb" trail above the topic Header (in small
text at the very top of the Help text). The breadcrumb trail starts with the word
Navigation: followed by Category > Chapter1 > Chapter2 > ... etc where "Chapter" is the
name of a chapter or sub-chapter in a Category.
The topic currently displayed on the screen, is either in the last chapter listed in this
"breadcrumb trail", or a standalone topic in the Category listed in the trail. It is called a
breadcrumb trail because each chapter is a "crumb" or link in the route you have made
into the information in that Category. You can also click on any one of the breadcrumbs
(e.g. Chapter2) and you will then jump directly to that chapter itself. As you access
different parts of the Help contents this breadcrumb navigation trail keeps changing to
reflect where you are in the body of the Help text. You'll notice too that as you move
around different topics, the entry in the Contents tab for the current topic you are
reading is also highlighted.
TIP: Sometimes when you have selected an index entry the context of the displayed topic
may not be immediately clear. This is where the breadcrumb trail comes in handy simply look at the chapters in the trail and you will be able to see not only which chapter
you are in (the last chapter in the trail), but also where that chapter fits in the Category
hierarchy. If the context still isn't clear click back in the trail (previous chapter),
repeatedly if necessary, until you arrive at the Category itself.
Once you have determined the context of the topic you were originally viewing you can
return to it by clicking the <= Back arrow until the topic is re-displayed. (If you click the
<= Back arrow too many times - overshoot your topic - you can correct this by clicking on
the Forward => arrow as many times as necessary.)
Sizing the tabbed panels Pane
The Panel on the left of the Help window that contains the Contents / Index / Search /
Favorites tabs can be hidden or displayed (see above). It can also be resized.
>> To resize the tabbed panels Pane
1. Hover the mouse over the right hand vertical border (side) of the Panel until the
cursor turns into a left-right pointing arrow.
2. Click the left mouse button down, and holding it down, drag the mouse either to
the left or right until the Panel is the width that you want it.
3. Release the mouse button.

2.3

Encyclopedia
You can use the Encyclopedia as an astrological knowledge reference.
>> To open the on-line Encyclopedia
Select the Encyclopedia menu item from the Help menu.
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This encyclopedia contains definitions and articles from Nicholas deVore's original
'Encyclopedia of Astrology' with edits and updates by Esoteric Technologies Pty Ltd,
2008. Nicholas deVore, 1882-1960, was President of the New York based Astrological
Research Society.

2.4

Support, Updates and Links
Solar Fire is a very intuitive program to use, even for beginners. However it also a very
full featured program, rich in functionality. Therefore most users at some point will need
to gain a deeper understanding and greater knowledge of how it works. The best way to
do this is by using the on-line Help.
Note: In order to run any of the internet related functions of Solar Fire, you need either to
be already connected to the internet when you run them, or to have the possibility of
connecting when prompted to do so.

2.4.1 Technical Support
If you are having a problem running your software, please don't hesitate to contact our
technical support team.
If the problem you are having is procedural, then please do consult the documentation
first. If you still cannot resolve the problem yourself, then let us know.
Most technical problems can be resolved quickly. We understand that we provide
software for astrologers, not computer experts. We can help with the basics.
The best method of contact is by email, using Technical Support item from Solar Fire’s
Help menu. This automatically generates an email for you containing information about
your operating system and program version. All you have to do is add a clear description
of your problem, and then send the email when you are ready.
However, we realize that not everyone will have access to email. In this case you can
contact us by mail, fax or telephone.
Here's a checklist to help you help us when you run into a problem.
If the problem you are having is procedural, go to the documentation first.
Know what program you're using. This program is Solar Fire version 9.
Know what equipment you're using. Use this space to keep your hardware brand
information handy.
Computer: e.g. Pentium IV 433Mhz / Core 2 Duo T9400 2.53 GHz / Core i5 2410-M
2.3 GHz
Windows Version: e.g. Windows 98, Windows NT, Windows 20000, Windows XP,
Windows Vista, Windows 7, SoftWindows on Macintosh
RAM: e.g. 512MB, 512MB, 1GB, 2GB, 4GB, 6GB
Printer: e.g. HP Laserjet 1200, Epson Stylus Pro, Canon MP640
As soon as you receive an error message, write it down. This can tell us exactly what
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the problem is.
Also what job were you working on? Were you entering data for a natal chart, or
printing out a chart wheel or experimenting with some other option? Were you
importing Nova-type chart files? Have you used that part of the program before?
With all this information at hand, email, fax or call us on our technical support line.
Technical support is available on most working days. If not, you will be able to leave a
message on our answering machine, and we will get back to you as soon as we can see
(Get Technical Support by Email for more information).
2.4.2 Get Technical Support by Email
It is possible to get technical support by letter, phone, fax or email. However, the most
efficient means of contact for us is by email, and if you use this built-in option, it
increases the likelihood of a rapid resolution because of the detailed information that it
automatically provides us about your program setup.
Note: Many computers have a MAPI compliant email program, see About MAPI for
further information.
>> To get technical support by email
1. Select the Get Technical Support by Email menu item from the Help menu
2. Next you will be prompted to enter your contact registration details.
3. Once you have entered or updated your details, click on the Proceed button to
have your default email program opened automatically with a new email
containing your registration details, program setup information, some computer
configuration information, and addressed to us. You can then preview the email,
insert a description of your problem or query, and send it at your leisure.
Note: Alternatively you can create a new email manually and add your own content into
the body of the email.
To capture a snapshot of a screen in Solar Fire press the Print Screen key on the
keyboard (for the entire screen), or press the Alt key on the keyboard, and while holding
it down press the Print Screen key, then released both keys (for just the active part of the
screen e.g. a small window or dialog box that has the focus). This copies the screen to
the clipboard (i.e. into memory).
Then in the body of the email place the cursor where you want what you copied to be,
and press the Control key and while holding it down press the "V" key on the keyboard,
then release both keys. This will paste the screen snapshot into your email body as a
picture (graphic). If you then click on the picture it will be "selected" and display very
little square boxes (sizing handles) on its corners. Hovering the mouse over a sizing
handle until tyhe cursor changes shape then holding the mouse button down while you
drag the handle diagonally inwards or outwards (depending on whether you want make
the graphic smaller or larger) will re-size the graphic. Once it is the size you want
release the mouse button.
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2.4.3 Solar Live
Solar Live is a utility via which we provide (and regularly update) various internet links
that may be of use and interest to Solar Fire users and to astrologers in general.
>> To open the Solar Live dialog
Select the Solar Live menu item from the Help menu
or...
Click on the Solar Live status bar on the Main Screen of Solar Fire
This will attempt a connection to the internet to determine whether any updates are
available for the list of links, and if so download them. The Solar Live dialog is then
displayed.

The list of links is organized into topic headers (with square bullets), and live links
under each topic header (with round bullets).
Individual topics that have previously been visited by you are displayed with a BLUE
round bullet, whereas those that have not yet been visited are displayed with a
YELLOW round bullet.
Topic headers under which you have previously visited all the available links are
displayed with a BLUE square bullet.
Topic headers under which there is at least one previously unvisited topic are
displayed with a YELLOW square bullet.
>> To select a topic to view in your default web browser
1. Click on the required topic with the mouse.
Topics are underlined as you move the mouse over them, showing that they are ready
to be clicked.
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>> To Expand all topics to make all the links under them visible
1. Click on the + button.
>> To Collapse all topics
1. Click on the – button.
>> To set Solar Live update options
1. Click on the Options button.

Auto check for updates on the internet – when checked, Solar Fire will automatically
check for updates after each specified interval of days. On the day that it is checked,
auto checking occurs about one minute after Solar Fire starts running. Note: The
update check will be skipped if there is no internet connection available at the time
of checking. It is recommended that you switch this option off if you don’t normally
have an internet connection when you run Solar Fire.
Auto show new updates when found – when checked, if an update is found, then the
user is immediately notified and prompted whether to display the updated list of
Solar Live links.
2.4.4 Find Program Updates on Web
>> To find program updates on the web
Select the Check for Updates on the Web menu item from the Help menu
If your computer is not already connected to the internet, then you will be prompted to
connect, or connection will start automatically, depending on the internet connection
options in your operating system.
When a connection is established, your current program version number will be
automatically compared with the latest available version number over the internet, and if
an update is available, you will be asked whether you wish to proceed with the update.
If so then your default web browser will open and display a web page containing links to
download and install the latest software updates.
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Note: Using this option does not send any information about you over the internet apart
from your current program version information, and that information is not retained.
2.4.5 Visit Website
You can navigate to the Solar Fire publisher’s website to find out about our latest news,
products, patch updates and other items of interest.
>> To visit our website
Select the Visit Website menu item from the Help menu
If your computer is not already connected to the internet, then you will be prompted
to connect, or connection will start automatically, depending on the internet
connection options in your operating system.
When a connection is established, your default web browser will open and display the
home page of our website.
2.4.6 Submit Suggestions by Email
Our philosophy of software design is to create software that addresses the needs and
desires of the users. Consequently we welcome any feedback and suggestions that you
might feel inspired to send us.
>> To submit suggestions by email
1. Select the Submit Suggestions by Email menu item from the Help menu
Firstly, you will be prompted to enter your contact registration details.
2. Once you have entered or updated your details, click on the Proceed button to
open your default email program with a new email containing your registration
details.
You can then preview the email, insert your feedback or suggestion, and send it at
your leisure.
2.4.7 Other Solar Products
Esoteric Technologies has created a range of astrological software products, many of
which are compatible with or interactive with Solar Fire. You can navigate to our website
to find about these products,
>> To visit our products page
Select the Other Solar Products menu item from the Help menu
If your computer is not already connected to the internet, then you will be prompted
to connect, or connection will start automatically, depending on the internet
connection options in your operating system.
When a connection is established, your default web browser will open and display the
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appropriate website page.
2.4.8 Register by Email
Registration is desirable, but not obligatory, in order to keep us informed of your current
contact details.
It is helpful to re-register whenever you change your street or email address.
>> To register by email
Select the Register by Email menu item from the Help menu
This will display the "Confirm Current Details" dialog box.

Once you have entered or updated your details, click on the Proceed button to open your
default email program with a new email containing your registration details, and
addressed to us. You can then preview the email and send it at your leisure.
2.4.9 Astrology Schools
Solar Fire now assists a user by providing a direct link to a web page on the website of
Esoteric Technologies where a list of schools, the principal(s) and a classification of
what type of astrology the school focuses on is displayed.
>> To access the list of Astrology Schools
On the Help menu click on Astrology Schools
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Getting Started
Getting started in Solar Fire is a simple process. Once you've installed Solar Fire there
are just a few simple set-up tasks to complete and then you're ready to start casting
charts. If you have upgraded your version of Solar Fire you also have the option of
importing all your previous charts, files and settings, so that you can carry on the same
way you were able to in your previous version of Solar Fire.

3.1

Installing Solar Fire
Installing Solar Fire is simple to do and takes about 15 minutes. The following topics
guide you through the process.

3.1.1 Computer System Requirements
Before installing the program, ensure that you have all the hardware and software you
need to run Solar Fire:
A PC or compatible computer with (at a minimum) an Intel Pentium processor or
equivalent, or preferably a more modern type of processor (e.g. an Intel or AMD
Dual Core or Core-2-Duo type of processor)
CD or DVD drive
Operating System - Windows Vista, 7, 8 or later.
1 GB of RAM minimum (2 GB of RAM or more recommended)
SVGA (800x600 pixels) monitor and adapter with 256 or more colors (XGA 1024x768
pixels or higher resolution modes with True Color is recommended)
A hard disk drive with at least 250Mb of free disk space (or about 100Mb for a
compact installation with minimal features installed)
Internet access is recommended
Windows 8 computers
PCs
Solar Fire v9 works on PCs running Windows 8 Pro, but not Windows 8 RT.
Tablets
Solar Fire v9 will work on a tablet running Windows 8 IF the tablet uses an INTEL
processor.
All tablets using an ARM or other processor (cannot run the older generic nonWindows 8 applications, and thus) cannot run Solar Fire v9
NOTE: Users on Windows 8 RT devices can only install the newer dedicated Windows 8
"Windows Store" apps.
(Windows Store apps use the "Windows Runtime" (RT for short), a new cross-platform
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application architecture that supports both Windows 8 Pro and Windows RT and their
respective processors).
3.1.2 Installation
>> To Install Solar Fire
1. Insert the Solar Fire installation CD into your CD/DVD drive.
2. After a short delay, the "Esoteric Program Installation Supervisor" will be displayed.
If an "AutoPlay" dialog box is displayed with "Run INSTALL.EXE" highlighted,
click on this to display the "Esoteric Program Installation Supervisor".
If a "User Account Control" dialog box is displayed, asking if you want
"INSTALL.EXE" to make changes to your computer, click on Yes.
(If nothing happens when you insert the CD, to start the installation: open
"Windows Explorer", then in the left pane click on the icon for the CD/DVD
Drive where you have inserted the installation CD, locate "INSTALL.EXE" in the
right hand pane, and double-click on it with the left mouse button. To open
Windows Explorer see Windows Explorer).
3. Click on "Solar Fire v9" then click on the Install button. The installation program
will display licensing information and guide you through the subsequent steps.
4. You may choose the location for your installation. Unless you are familiar with
folders (also known as "directories"), and have a reason for altering the suggested
location, then it is recommended that you proceed without altering the suggested
location.
(In any case, if you are using a 64-bit version of Windows do not change the
installation location to "C:\Program Files\SolarFire9", as the even though the
installation will go ahead Solar Fire will not work, and you will have to uninstall it
then reinstall it again.)
5. You can then choose one of the following setup types...
Typical – This installs the entire program with all options included. This is the
recommended option for most users.
Compact – This installs the program with a reduced ephemeris range and no
additional asteroid ephemerides. This option is recommended for those users
who wish to conserve space on their computers, and have no interest in charts
prior to 1200BC or after 3000AD, or in the additional asteroids.
Custom – This allows you to choose exactly which items to install. This option is
only recommended for expert users who are re-installing parts of the program.
6. You will be shown any important last minute information before the installation
goes ahead.
7. You will next be prompted to enter your name, serial number and password as
supplied to you by your vendor. Note that you must enter these three items exactly
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as they as given to you, including the same spelling and spacing.
8. The installation will proceed, follow any screen prompts as they arise.
Notes:
If You are Re-installing Solar Fire
The installation program will find your existing installation location and suggest that you
re-install it there.
If You are Upgrading from an Earlier Version of Solar Fire
It is recommended that you install Solar Fire into its own new folder instead of into the
same folder of your earlier version. Note that Solar Fire allows you to import copies of
your old charts, files and other settings from your earlier version. Solar Fire will ask you if
you wish to do this when it first runs.
3.1.3 First Run Setup Tasks
The first time that Solar Fire runs after it has been installed, you will be prompted to
allow some initial setup tasks to be performed.
These initial tasks are...
Checking for program updates via the Internet (www.esotech.com.au) – if an
update it found, then it is recommended that you download and install it before
proceeding further. If you do not have an Internet connection, or you would prefer
not to do this now, you can do so at any later time by choosing Visit Website from
the Help menu.
Importing Charts, Files and Settings from an earlier version of Solar Fire – this
option is available only if you still have an earlier version of Solar Fire on your
computer. If you prefer not to do this now, you can do it at any later time by
selecting Import Charts and Settings from the Utilities menu.
Obtaining the “Solar Live” list of links via the Internet – this will ensure that you
have the latest available information. If you prefer not to do this now, you can do
so at any later time by choosing Solar Live from the Help menu.
3.1.4 Further Manual Setup
There are a few further tasks that need to be performed to complete setting up SolarFire.
Some of these involve adjustments to a few Windows settings, others to settings in Solar
Fire.
3.1.4.1 Connecting to the ACS Atlas

Besides having it's own built-in ACS Atlas, Solar Fire interfaces seamlessly with the
stand-alone ACS atlases if you have one of them installed on your computer. Solar Fire
works with:
ACS PC Atlas, version 2.x or 3.x
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ACS PC Atlas for Windows
ACS PC Mini Atlas
Solar Fire does not work with the ACS PC Atlas version 1.x for DOS. If you try to use an
ACS Atlas while running Solar Fire and get the error message “Invalid TIMZON.BIN file”,
it means that you have the ACS PC Atlas version 1. In this case, contact your dealer to
have it upgraded to a current version.
>> To connect to an ACS Atlas
If you have a standalone ACS Atlas already on your hard disk, then Solar Fire will connect
with it automatically. However, you can specify between the built-in or standalone
atlases in Solar Fire by clicking on the "Places" tab of the "Preferences" dialog. See
Places for more details.
3.1.4.2 Setting Your Computers Internal Clock

On its Main Screen, Solar Fire has a constantly updated display of current planetary
positions. In several of its data-input dialogs it has a “Now” button that automatically
inserts the current date and time. For these features to work correctly, you should ensure
that your computer’s internal clock is correctly set.
Most modern computers with internet connections will not need adjusting, as they
automatically check and synchronize their clocks via the internet. However, some older
computers may not keep accurate time, or you may want to change from Standard to
Daylight or Summer time or vice-versa, if Windows has not done this for you
automatically.
>> To set the computer’s internal clock
Click on the Date or Time box of the status bar across the top of the Main Screen of
Solar Fire.
This will open up the Control Panel dialog that allows you to reset the date and time
as required.
3.1.4.3 Selecting a Time Format

To choose between AM/PM and 24-hour time format, you also need to use the Windows
Control Panel. Solar Fire lets you enter time in virtually any format - the time format you
select here determines how times are written in Solar Fire displays and printouts. Your
computer will probably already be preset to whatever time format is usually used in your
country.
>> To reset the time format
Click the Start button, then Control Panel, select the Regional Settings or Region
and Language icon. In the “Time” tab or area of the screen, you can select various
time format options, including whether a 12hr or 24hr clock is used, and how AM/
PM is displayed.
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3.1.4.4 Selecting a Date Format

In most cases the computer will already be preset to show dates using the normal
convention for your country. Solar Fire displays dates in its own format, but decides on
whether to show the International order (Day, Month, Year) or the American order
(Month, Day, Year) according to the format that you select in the Control Panel.
>> To reset the date format
Click the Start button, then Control Panel, select the Regional Settings or Region
and Language icon. In the “Date” tab or area of the screen, you can select various
date format options, including the order in which the day and month appear.
3.1.4.5 Setting the Default Place

On its Main Screen, Solar Fire has a constantly updated display of the current Ascendant
and Midheaven for whatever location is currently selected as the default place. When
you first install Solar Fire, this default place will probably not be set to the place where
you currently live. It is recommended that you set the default place to the location where
you are currently living, so that the displayed Ascendant and Midheaven will be correct
for you own location. Solar Fire also uses the default place that you set as a “first guess”
whenever you choose to relocate a chart to a new location. If this is set to your current
location, then this guess will probably often be correct, and this will save you from
having to enter new location details needlessly.
>> To set the default place
1. Click on the Place box of the "Date and Place" status bar on the Main Screen.
2. If your current location is one that is already listed in the list of Favorite Places,
then select it with the mouse.
3. Otherwise click on the Add button to open the Atlas and either find your location
or enter it a new location. See Using the ACS Atlas for full instructions on choosing
a place from the Atlas.
4. Once your location appears on the list of favorite places, then select it with the
mouse and select the Set as Default button.
5. You can then click on the Save button to return to the Main Screen.
The location shown in the status bar at the top of the Main Screen will now show the
newly saved location, and the Ascendant and Midheaven will be correct for this location.
You will need to update the default place details in the same way whenever you move
with your computer to a new place.
3.1.4.6 Pre-Setting Calculation Options

Solar Fire is shipped to you with the most commonly used chart options already selected
for you. Choices like house system, coordinate system and zodiac are easy to find, as
they appear on the “New Chart Data Entry” dialog itself. If you are new to astrology or
Solar Fire then the options set when Solar Fire shipped should initially be perfectly
adequate for your needs.
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However, there are some less frequently used options that can be set in the
“Preferences” dialog of Solar Fire, and you may like to set them before you start
calculating charts.
Geocentric Latitude Correction
Lunar Parallax Correction
Lunar Node Type
Zodiac
Angle Progressions
Progression Day Type
User Progression Rate
Primary Direction Rate
Vulcan Calculation
Part of Fortune
These options are described in detail in Changing Preferences.
3.1.4.7 Customizing the Compliments Text

Most chart and grid pages printed from Solar Fire contain some text placed on a corner
of the page that gives the name and address of your software supplier. You can alter this
text to display your own name and address (or any customized message) if you wish.
>> To change the compliments text
1. Select the Edit Settings… item from the Preferences menu on the Main Screen.
2. Select the Compliments tab.
3. This will display six lines of text that you can freely edit.
4. When you click on the Save button, any charts subsequently printed will display
the newly edited compliments text, and this text will also be permanently retained
by Solar Fire for future sessions.

3.2

Importing Charts, Files and Settings
If you are new to Solar Fire then you will not have a need to import items from another
Solar Fire installation, and you can skip this topic. However if you have owned an earlier
version of Solar Fire, and it is still installed on your computer, or if you have a copy of
Solar Fire on another disk which is accessible to your computer (via a network or other
link), then you may wish to import copies of charts files, other files and Solar Fire
settings and Preferences from those other copies of Solar Fire. In many cases this is
possible.
The main benefits of this utility are...
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Upon first installation, to allow you to automatically set up Solar Fire in the same
way as your previous version of Solar Fire.
At any later time, to import chart files from Solar Fire on another computer.
Note: Due to the flexibility of Solar Fire in allowing a variety of user-created files and
settings and the fact that there are many differences in design of different versions of
Solar Fire, this import process may not always be 100% successful in setting up Solar Fire
exactly as you would like. You may find after importing settings that you still need to
make several adjustments to settings manually.
>> To open the import dialog
Select Import Charts and Settings from the Utilities menu.

Where to Import From
What to Import
Import Options
3.2.1 Where to Import From
When the "Import Charts and Settings" dialog opens, it searches for earlier versions of
Solar Fire on your computer, and if any are found, adds them to the list titled Where to
import from, including their folder paths.
The final entry in the list is Other Location…, which will be a blank entry initially, or
otherwise points to the last location your specified here.
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>> To set or change the Other Location
Click on the Other Location… list item.
This will display a file open dialog, allowing you to navigate to the desired location
(which may also be on another disk or another computer on a network). You must
locate and select the file solfire.exe in the Solar Fire folder that you require. Once you
have done so, the newly selected folder path of the selected location will be
displayed in the list.
3.2.2 What to Import
In the "Import Charts and Settings" dialog you can choose what items to import by
clicking in their checkboxes individually, or by using the All On or All Off buttons.
The items that may be selected for importing are as follows...
Chart Files – All Solar Fire type chart files and chart comments files (with file
extensions *.SFcht, *.cht and *.chm).
Pages/Wheels/Points/Aspects/Tasks & related files – All Solar Fire type files of
these various types, including color schemes. This will include any user created
files of these types that you may have stored with the other copy of Solar Fire.
Note: If you also select Other Saved Settings, then all settings relating to these
files such as your default displayed point set, aspect set and color scheme setting
will also be set for you.
Interpretation Files – All Solar Fire interpretation files (with file extensions *.int).
Note: If you also select Other Saved Settings, then the default interpretation file
settings will also be set for you.
Default Place Details – The location and timezone that is set within the other copy
of Solar Fire.
Compliments Text - The compliments text that is set within the other copy of Solar
Fire.
Other Saved Settings – Most other settings and preferences.
Note: If you are using Other location, then any files types can be imported, but place,
compliments and other settings cannot, and will be omitted from the list.
3.2.3 Import Options
In the "Import Charts and Settings" dialog you can set one of the various import options
below.
Rename and keep existing files – Use this option to ensure that all existing files
are kept and remain available in addition to any newly imported files. Any existing
files in your current copy of Solar Fire that have the same name as files you are
importing are simply renamed first, by appending a number to the end of the
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existing file name (e.g. Main.cht is renamed to Main_2.cht).
Only import Files with different names – Use this option to keep all existing files,
and import only those files that have different names from existing files.
Overwrite existing files – Use this option to adopt all imported files, keeping only
those existing files that have a different name from any of those being imported.
Prompt me for each (skip/overwrite) – Use this option to decide on a file by file
basis whether to import any existing file which has the same name as an existing
file.
When importing chart files there is also an additional option (to the one selected above)
to import charts from a file that has the same name as an existing chart file. To do this
...
Click on the Merge Chart files with the same name checkbox at the bottom of the
dialog box so that it has a tick in it (clicking on it toggles it on and off). Then if a
chart file being imported has the same name as an existing chart file the charts
from the import file will be copied to the existing chart file (added to the charts
already in the existing file).
Note: that you can use different import options with different import items. To do so, just
choose one item on the What to Import list to import at a time, and set the require
import option separately for each one before importing.

3.3

Finding Your Way Around Solar Fire
We have designed the Solar Fire program to be flexible and easy to use. There are often
several different ways of achieving the same objective, and it is up to each individual
user to decide the manner in which they prefer to proceed.
Most operations, such as casting a new chart, will be very easy to learn for those who
are experienced astrologers, and the intuitive manner of operation of the program should
enable inexperienced astrologers to proceed almost as quickly.
To facilitate data entry and selection, most have default values, so that it is not
necessary to enter new data every time a dialog is used. Generally, whenever a dialog
box is called up, it will initially contain all the values that were entered into that box the
last time it was used. For example, when a new chart is cast, the chart's name, date,
time, location, house type etc. are all retained. The next time that a new chart is cast, it
will only be necessary to update the items that need to be changed. This makes it very
quick and easy to generate the same chart with a different house system, or with a
slightly different birth time, for example.

3.3.1 Starting Solar Fire
>> To start Solar Fire
Double-click the Solar Fire shortcut icon on your desktop with the left mouse
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button, or click on it once and press the Enter key on the keypad
or...
From the Start button click on All Programs, then Esoteric Technologies, then
Solar Fire v9, then Solar Fire v9
or...
In the Program Files folder or the Program Files (x86) folder, find and open the
SolarFire9 folder, and then double-click the icon for the file Solfire.exe. (This option
requires knowledge of Windows folder structures).
If you are using Windows Vista or a later Windows version, and a "User Account Control"
dialog box is displayed, asking if you want "Solfire.exe" to make changes to your
computer, click on Yes.
3.3.2 Using Solar Fire
When you start Solar Fire, the Main Screen appears, ready for you to create charts. To
use the program, you will need to be able to select menu items and command buttons,
enter information into dialog boxes, and use scroll bars and list boxes. If you are
unfamiliar with using menus, dialog boxes, list boxes and scroll bars, then it is desirable
that you read your Windows documentation & Help to familiarize yourself with these
concepts.
A few essential concepts are...
The Main Screen is the main Solar Fire window that is first displayed when Solar Fire
is opened
To select an item in a list, a command button, or a menu or menu option - means to
click on it with the left mouse button.
To "click" on something, unless explicitly stated otherwise, always means to use
the left mouse button to click on an icon, item in a list, a button, menu option etc.
Right-clicking on something means to click with the right mouse button.
Double-clicking on something means, clicking the left mouse button quickly two
times in a row.
When you see three dots after a menu item e.g. the "Open..." option on the "Chart"
menu, it means that if you click on this option no action will occur immediately,
instead a dialog box will be displayed where you usually can select some options
before finally confirming you want to proceed, usually by clicking on an "OK" button,
or a button indicating to go ahead. Usually there is a way of cancelling the task on
the dialog box if you change your mind and don't want to proceed, e.g. a "Cancel" or
"Quit" button.
3.3.3 Solar Fire's Main Screen
Solar Fire’s Main Screen consists of the following components...
Menu
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Toolbar
Date and Place
Current Settings panel
Current Chart Preview
Calculated Charts
Solar Live Latest Link
Planet Bar
Background
Each of these is described in more detail in the following sections. Note that you can
switch off some of these components by using options under the "Preferences" menu.
3.3.3.1 Menu

The Menu on the Main Screen provides access to all the available functions and actions
that Solar Fire can perform. Some menu items can be activated by shortcuts – either
particular key combinations, or via Toolbar buttons, or the "Current Settings" panel.
One form of shortcut are "short-cut keys", which are usually the function keys on the
keyboard (e.g. F2, F3 ... etc) or a combination of keys held down together (e.g. the "Ctrl"
key and the "P" key, or the "Shift" key and the function key "F1" ...). You press and hold
down the first key, and while continuing to hold it down you then press the second key in
the pair, then release both keys.
When you click on a menu (e.g. the Chart menu at the top left of the Main Screen) you
can see all the short-cut keys (for the menu items that have short-cut keys) to the right
of the menu item. When the short-cut key is actually a two key combination it is written
in this format: key1 + key2 e.g. Ctrl+F2. Mostly the descriptions of the keys match the
actual text on the keyboard keys themselves, but not always. For instance, on the Chart
menu the "Delete..." menu item has a short-cut key of "Del". On some keyboards the
actual delete key may have "Delete" written on it, although often it will just have "Del"
written on it.
See Short-Cut Keys for a full listing.
3.3.3.2 Toolbar

The Toolbar on the Main Screen contains a range of graphical buttons that provide
shortcuts to various items within Solar Fire. It may be customized by changing the
selection or ordering of the buttons it contains, and can also be switched off altogether
if you prefer. See Editing the Toolbar Buttons for instructions on customizing the Toolbar.
3.3.3.3 Date and Place

The "Date and Place" status bar, underneath the Toolbar at the top of the Main Screen,
contains the current system date and time, the current Ascendant and Midheaven
positions, and the current place name and timezone details. If the details shown are
incorrect then you can change them as follows.
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>> To change the date
Click on the Date box in this bar. This will display the Control Panel utility that
allows you to adjust the date on your computer system.
>> To change the time
Click on the Time box in this bar. This will display the Control Panel utility that
allows you to adjust the date on your computer system.
>> To change the place
Click on the Place box in this bar. This will display the "Preferences" dialog for
editing and selecting your current location from an atlas. See Current Default Place
for more details. Changing the place will usually result in the correct timezone
being displayed as well.
>> To change the timezone
Click on the Timezone box in this bar. This will display a "Time Zone Selection"
dialog from which you can select the correct timezone.
Note: The Ascendant and Midheaven positions are calculated according to the date,
time and place details as displayed in the other panels in this bar. However, other
options that affect these positions are...
The Geocentric Latitude Correction – See Apply Geocentric Correction to Latitude
for further information.
The Default Zodiac type – See Default Zodiac for further information.
3.3.3.4 Current Settings

The "Current Settings" panel on the Main Screen displays a range of items that reflect
how various options have been set. For example, the name of the currently selected
displayed points file, aspect set, default zodiac and screen colors are all shown here.
As well as allowing you to see what options are in effect, this panel provides a shortcut
to altering these options, simply by clicking on the option you wish to change. For
example, clicking on the Displayed Points area will cause the "File Manager" to appear
with a list of displayed point selections, allowing you to select an alternative file or
perform various other functions.
3.3.3.5 Current Chart Preview

The "Current Chart Preview" panel on the Main Screen displays a preview style wheel
(see Wheel Styles and Dial Styles) and chart details of whichever calculated chart is
currently selected – or optionally the wheel may be switched off and just chart details
and comments displayed. The chart’s astrological settings, such as its coordinates,
house system and zodiac are shown at the upper right of the preview window. Any such
settings that differ from Solar Fire’s current defaults for those settings are highlighted to
draw your attention to them.
Note: The "current" chart in the list of "Calculated Charts" can be determined by it's
appearance in the list. If only one chart is highlighted that is the current chart. If many
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charts are highlighted the current chart will be one of these and it will be surrounded by
a dotted rectangle. The current chart is the last chart to be selected, i.e. to be clicked on,
or dragged over, by the mouse or up/down arrow keys.
>> To change the current chart preview display type
Use a right hand mouse click while the mouse is over the "Chart Preview" panel.
This will display a pop-up menu with the following options...
Chart Wheel – Display a preview chart wheel with small captions
Chart Details – Display larger chart captions
Chart Details & Comments – Display chart captions and chart comments (if any)
Preview Wheel Style – Allowing you to select an alternative wheel style to display
The following information is also displayed just below the preview window...
"Save Status" – This is a caption that indicates whether or not this chart is already
saved in a chart file. The text can be “Not Saved”, “Saved”, “Retained” or “Cannot
be Saved”. If the current chart was opened from a file, or was saved to a file, then
hovering the mouse over this item causes a pop-up hint to appear showing the
filename and record number of the chart, and clicking on this item will cause the
Chart Open dialog to appear, displaying this file and highlighting this chart entry in
it.
"Comments" – This is text that indicates whether or not any comments have been
added to this chart, and if so how many characters of text. Clicking on this item will
open up the comments editing dialog in which you can see the comments and edit
them if you wish.
"Events" – This is text that indicates whether or not any life events have been
added to this chart, and if so how many events. Clicking on this item will open up
the events editing dialog in which you can see the events and add, delete or edit
them if you wish.
3.3.3.6 Calculated Charts

The "Calculated Charts" listbox (also referred to as the "Calculated Charts" list) on the
Main Screen contains a list of all the charts that are currently available for immediate
use in Solar Fire. This is not all the charts that exist in Solar Fire, rather it the charts that
have been "calculated" and are therefore now able to be used in the current session.
This list of charts is the CENTRAL point for nearly all operations in Solar Fire as most
(although not all) of the things you can do in Solar Fire involve a chart of one kind or
another. And to use a chart it needs to be in the list of "Calculated Charts".
You can add to this list by casting new charts, opening saved charts, generating
subsidiary charts using various options in the "Chart" menu, or copying a chart that is
already in the "Calculated Charts" list .
You can select any number of charts in this list by holding down Ctrl or Shift keys while
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clicking the left mouse button. (The "Current Chart Preview" panel will always display
the details of the most recently selected chart - the "current" chart.) To select charts all
adjacent to each other (next to each other) in the list click on the first chart, then hold
the Shift key down and click on the last chart you want, then release the Shift key. To
select charts not adjacent in the list click on the first chart, then hold the Ctrl key down
and click on each chart you want in the selection, then release the Ctrl key. Use the Ctrl
in the same manner to unselect any chart from a selection.
Some functions in Solar Fire will allow all your selected charts to be processed, whilst
others can work only with the single current chart. For example, when you choose View /
Current Chart or Chart / Save to File, all the selected charts will be processed. However,
when you choose Interps / View, only the current chart is used.
You can also delete charts from this list if you wish. To delete many at the same time
first select all the charts, as described above.
3.3.3.7 Solar Live Latest Link Bar

The "Solar Live" bar on the Main Screen displays the most recently added item in the
Solar Live list of internet links. You can display the full list of Solar Live links by clicking
on this panel.
3.3.3.8 Planet Bar

The "Planet" bar on the Main Screen contains the current positions of the ten main chart
bodies, as well as information on lunar phases and eclipses. Planets that are currently in
retrograde motion are shown in red, and those that are direct are shown in black. These
positions are automatically updated on a regular basis.
You can get further information about each planet or item by moving the mouse over its
box. This will cause a “hint” type message to appear, giving the following information.
The Moon and the Sun – Sign, date and time of last sign ingress, and of next sign
ingress.
Other Planets – Date and time and position of last and next planetary station.
Lunar Phases - Date and time of the last and next new or full moon.
Eclipses - Date, time and eclipse type of the last and next eclipses.
3.3.3.9 Background

The background of the Main Screen may be customized to show either a uniform color or
a user-selected graphic.
>> To set the Main Screen background options
Click the right-hand mouse button anywhere over the background area of the Main
Screen.
This will bring up a pop-up menu with the following options.
Background Graphic… - This will display a file selection dialog allowing you to
browse for a graphic file that you wish to display. This must be a file of type *.bmp,
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*.rle, *.gif, *.jpg, *.jpeg, *.wmf, *.emf, *.ico. Once selected the graphic will be
either tiled or stretched according to the option selected below.
Background Color… - This will display a color selection dialog allowing you to
select any desired color. Note that you must clear any existing graphic file before
this change will take effect.
Clear Graphic – This will clear any graphic file that has been previously selected, in
which case the current background color will be applied.
Tile – If a graphic file is being displayed, this will tile the graphic to fill the entire
background area.
Stretch - If a graphic file is being displayed, this will stretch the graphic to fill the
entire background area.
3.3.4 Exiting from Solar Fire
Before exiting from Solar Fire you may wish to save any charts you've cast that haven't
been saved yet (see Saving your charts).
>> To exit from the program
Click on the Chart menu in the Main Screen, then click on the Exit option.
If you haven't saved all new or edited charts before exiting you will also be prompted
if you wish to do so (see Saving Charts to a File for more information).
3.3.5 Using the Keyboard
Although Windows is most easily used with a mouse, use of the keyboard is compulsory
for certain data entry items, and it is possible to perform almost all operations from the
keyboard instead of the mouse if this is desired.
Additionally, there are various "short-cut" keys that enable some tasks to be invoked
more quickly from the keyboard then by using a mouse.
3.3.5.1 Dialog Boxes

Movement and editing within a dialog box may be carried out according to the key
definitions as described in your Windows manual. A brief reminder of some of these keys
follows.
TAB
SHIFT+TAB
ALT+character
Arrow key
HOME
END
INSERT
DELETE

Move from option to option
Move from option to option in reverse order
Move to option whose letter matches character
Move cursor within a data box
Move cursor to start of data within a data box
Move cursor to end of data within a data box
Toggle between type over and insert modes
Delete the next character or the selected text
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BACKSPACE
ENTER
SHIFT+cursor

Delete the previous character
Activate the dialog box's default command button
Select text across which cursor moves

When the text in a dialog box is selected (highlighted), then typing any text will cause
the existing text to be deleted. To avoid this, use the END or cursor keys to switch off the
selection of text before typing any characters.
3.3.5.2 Short-Cut Keys

A variety of short-cut keys have been defined within Solar Fire to facilitate the activation
of certain frequently used menu options without having to use the mouse. Each short-cut
key combination activates an item from the menu. A list of these keys follows:
F1
F2
F3
F4
F5
F6
F7
F8
F9
F11
F12
CTRL+F1
CTRL+F2
CTRL+F3
CTRL+F4
CTRL+F5
CTRL+F6
CTRL+F7
CTRL+F8
CTRL+A
CTRL+C
CTRL+D
CTRL+E
CTRL+G
CTRL+H
CTRL+I
CTRL+L
CTRL+N
CTRL+P
CTRL+R
CTRL+S
CTRL+T
CTRL+V
CTRL+Z
SHIFT+F1
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Context sensitive help
New chart
Open chart
Progressed chart
Return chart
Harmonic chart
Combined chart
Prenatal chart
Rising/Setting chart
Lunar Phase chart
Save chart to file
Dual Wheels
BiWheel
TriWheel
QuadriWheel
Synastry grid
User defined page
Planetarium
Solar Maps
Aspect set
View current chart
Displayed points
Edit current chart
View current chart+grid
View current grid
View Interpretations
Toggle lunar node type
Edit chart events
Print chart/s
Restore settings
Save settings
Aspected Points
View last image
Toggle chart zodiac
Reports for current chart
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SHIFT+F2
SHIFT+F3
SHIFT+F4
SHIFT+F5
SHIFT+F6
SHIFT+F12
SHIFT+INS
DEL
CTRL+INS
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Synastry reports
Dynamic report
Graphic Ephemeris
Eclipse Search
Electional Search
Locality chart
Edit chart comments
Delete current chart
Copy&edit current chart

When you are viewing interpretations in the "Interpretations Window", the following
short-cut keys apply
F2

Previous information type

F3

Next information type

CTRL+C

Current Chart Mode

CTRL+G

General Mode

Note: "CTRL" is an abbreviation for "Control". "DEL" is an abbreviation for "Delete". "INS"
is an abbreviation for "Insert".
TIP: You can quickly exit the "View Chart" window and many dialog boxes (such as the
"New Chart Data Entry", "Chart Database", "Dynamic Reports Selection" etc.) by pressing
the ESC short-cut key on the keyboard.
With dialog boxes check first that you have finished with that dialog; pressing "ESC" with
some dialog boxes is equivalent to cancelling the dialog.
See How short-cut keys work for information on using short-cut keys.
3.3.6 Chart Calculation and Storage
When the Solar Fire program saves and reads charts to and from chart databases, only
the chart details are stored e.g. name, date, time, location, etc. Planetary positions and
house cusp positions are not stored in a chart database file.
However, once a new chart is cast in the program or opened from a chart database, all
planetary positions and house cusps are calculated and stored until the user exits from
the program. These are known as "Calculated Charts", and the Main Screen displays a
list of all such charts in a list box.
It is only possible to display a chart, aspect grid, report, or to generate any subsidiary
charts, after that chart has been calculated and is listed in the "Calculated Charts" list
box on the Main Screen.
Calculated charts can be of any type - natal, progressed, return, composite, harmonic,
etc.
The following table summarizes which chart types may be used in each type of
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operation. The symbol denotes that it is possible to perform the operation in the
left hand column on the chart type at the top of that column.
The chart operations are as follows.
Open

To retrieve chart details from a chart file and calculate the chart

Save

To store the details of a chart to a chart database file

Edit

To copy and edit an existing calculated chart

Delete

To delete a chart from the list of "Calculated Charts"

Retain

To retain calculated charts for use in future sessions

Progress
Return

To calculate a progressed or directed chart from a base chart
To calculate a planet or asteroid return chart from a base chart

Combine

To calculate a combined chart from two or more base charts

Harmonic

To calculate an harmonic or arc transform chart from a base chart

Antiscia

To calculate an antiscia or contra-antiscia chart from a base chart

Locality

To calculate a relocated or locality chart from a base chart

View
Report
Dynamic

To view a calculated chart or aspect grid on the screen or to print it
To generate a report from a base chart
To generate a transits/progressions report or graphic ephemeris from a base chart

Charts which are equivalent to Natal are - Return, Ingress, Transit, Davison, Lunar Phase,
Lunar Phase Return, Rise/Set, Prenatal, Relocated
Calculated Chart Type
Operation

Natal or
Equivalent

Progressed
/Directed

Composite/
Coalescent

Harmonic

Antiscia/
Contra-antiscia

-

-

-

-

-

-

-

-

Open
Save
Edit
Delete
Retain
Progress
Return
Combine
Harmonic
Antiscia
Locality
View
Report
Dynamic
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3.3.7 A GUIDED TOUR of Solar Fire
Once you’ve carried out a few simple tasks in Solar Fire, you’ll probably be able to run
the program without much reference to the manual, unless you wish to learn about some
of the advanced operations possible. This section takes you through the basic tasks and
gives you an idea of some of the things that Solar Fire can do.
If you have never used any version of Solar Fire before, then the easiest way to learn the
program is to go through this chapter and try out each operation that is described. If you
are eager to plunge in on your own, we recommend that you start with the tasks below.
If you have already used earlier versions of Solar Fire, then you can skip most of this
section, simply noting the parts that are new.
Starting Solar Fire
Casting a natal chart
Saving your charts
Opening a chart
Casting a solar return chart
Changing aspects (and redrawing a chart)
Exiting from Solar Fire
If you haven't already started Solar Fire refer to Starting Solar Fire to do so.
3.3.7.1 Casting a Natal Chart

The basic steps involved in calculating and displaying or printing a new Natal Chart are
as follows.
1. Click on the Chart menu on the Main Screen, then click on the New option.
2. Enter all the natal details, including name, date, time, place and timezone. (It is
possible to use the Place or Zone buttons to choose an existing location or
timezone.)
3. Select a house system, coordinate system and zodiac type from the available
choices on the screen. (Normally, western astrologers use Placidus, Koch or
Porphyry houses, geocentric coordinates and the tropical zodiac.)
4. Optionally select an event type, chart source ratings and description.
5. Click on the OK button. The program will then calculate all the planetary positions
and house cusps, and add the chart to the list of "Calculated Charts" on the Main
Screen.
6. To display the chart - click on the View menu on the Main Screen, then the Current
Chart option (or to view the chart with an aspect grid, click on the Current Chart
+Grid option instead).
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7. To print the chart on your printer, select the Print button from the "View Chart"
window, or select the Print Chart option from the View menu on the Main Screen.
3.3.7.2 Changing Displayed Points

>> To change the current set of displayed points and view a chart with the new
points
1. Click on the Chart Options menu on the Main Screen, then click on the Displayed
Points option.
2. Click on the name of an alternative set of displayed points from the list, and click
on the Select button.
3. Click on the View menu on the Main Screen, then click on the Last Image item
from
The last image that you created will then appear on the "View Chart" window.
(If the "Last Image" item is greyed out, click on the Current Chart option from
the View menu on the Main Screen).

In order to redraw any of the existing chart images in the "View Chart" window with
the new set of displayed points...
1. Click on the required entry in the list of images.
2. Click on the ReDraw button from the "View Chart" window.
3.3.7.3 Changing Aspects

>> To change the current aspect set and view a chart with the new aspects
1) Click on the Chart Options menu on the Main Screen, then click on the Aspect Set
option.
2) Click on Planets from the pop-out menu.
3) Click on the name of an alternative aspect set from the list, and click on the Select
button.
4) Click on the View menu on the Main Screen, then click on the Last Image item
from - The last image that you created will then appear on the "View Chart"
window.
(If the "Last Image" item is greyed out, click on the Current Chart option from
the View menu on the Main Screen).

In order to redraw any of the existing chart images in the "View Chart" window with
the new aspect set...
1. Click on the required entry in the list of images.
2. Click on the ReDraw button from the "View Chart" window.
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3.3.7.4 Changing Aspected Points

A set of "Aspected Points" specifies which of the "Displayed Points" will have their
aspects shown in the chart wheel.
>> To change the current set of aspected points and view a chart with the different
displayed aspects
1) Click on the Chart Options menu on the Main Screen, then click on the Aspected
Points option.
2) Click on the name of an alternative set of aspected points from the list, and click
on the Select button.
3) Click on the View menu on the Main Screen, then click on the Last Image item from
The last image that you created will then appear on the "View Chart" window.
(If the "Last Image" item is greyed out, click on the Current Chart option from
the View menu on the Main Screen).

In order to redraw any of the existing chart images in the "View Chart" window with
the different displayed aspects:
1. Click on the required entry in the list of images.
2. Click on the ReDraw button from the "View Chart" window.
3.3.7.5 Viewing an Interpretation

Now that you have cast some charts you may wish to view interpretations for a person's
chart, or for the relationship of two people
>> To generate a chart interpretations report
1. In the Main Screen select the chart in the "Calculated Charts" list.
2. Select the Full Report item from the Interps menu. This will display a selection
dialog box from which you can choose which categories of interpretations will be
included in the report.
You can select any of the available text categories by ensuring that the check box for
that category contains an "X". Click on any of these to select or unselect them. If you
switch off the "Chart Points" category then it is not possible to include categories
relating to rulerships and aspects between points, so these option become disabled
(greyed out). When you are happy with the selection, click on the View button. Your word
processor will be opened up displaying this report. You are then free to browse the
report or to print it. When you have finished with the report, exit from your word
processor.
Note: If you do not exit from your word processor, then the next time that you generate
an interpretations report you may see the old report instead of the newly generated one.
If this happens, then exit from your word-processor, and generate the report again.
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>> To generate a synastry interpretations report
1. Select two natal charts in the "Calculated Charts" list.
2. Select the Synastry Report item from the Interps menu. This will display a
selection dialog box from which you can choose which categories of interpretations
will be included in the report, and also the gender of each of the charts.
The interpretation categories may be selected in the same manner as for natal
interpretations. However, bear in mind that the some categories do not apply to the
synastry report, so that selecting them will make no difference to the final report. In
particular, the following items are not included in the default synastry report.
Balances
House Cusps
Rulerships & Dispositor
Rays
3.3.7.6 Saving your charts

Having created some charts you may wish to save them for future use.
>> To save a chart
1) In the list of "Calculated Charts" click on the chart you want to save. .
2) Click on the Chart menu then click on the Save to File option. This opens the File
Management "Save Charts To" dialog box.
3) If you cannot see a file name in the list that you would want to save your chart to,
then create a new chart file...
a)
b)
c)
d)

Click the Create button
Enter a name for your new chart file
Click the OK button
Click the Yes button (to create a v6/v7/v8/v9 format chart file)

4) Click on any filename in the list, then scroll through the list by pressing the Up or
Down arrow keys on the keyboard, until the filename you want to use is
highlighted.
5) Click on the Select button. Your chart is now saved.
3.3.7.7 Opening a chart

Charts are opened via the "Chart Database".
>> To display the Chart Database dialog box
1. Click on the Chart menu, then click on the Open option.
Whenever this screen is displayed, the list box on the left of the screen contains a
list of all the chart names that are stored in the currently selected chart database
file. The name of the currently selected chart database file is displayed in the box
to the right of the File... button. If there are no charts in this file then no chart
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names will appear in the list box.
If the chart you want is not displayed in the list then you will need to open another
chart file.
a) Click on the File button. This will open the "File Manager".
b) In the list click on the name of the chart file that contains the chart you want
to open.
c) Click on the Select button. This will open the selected chart file and it's
charts will now be displayed in the list of charts.
When the chart you want to open is displayed in the list of charts...
2. Click on the chart you want to open.
3. Click on the Open button. This will calculate the chart and add it to the list of
charts in the list of "Calculated Charts" on the Main Screen.
3.3.7.8 Casting a Solar Return Chart

The steps involved in calculating and displaying or printing a Solar Return chart are as
follows...
1. Either cast a new chart or open the existing chart for which you wish to generate a
solar return chart.
2. Click on the Chart menu on the Main Screen, then click on the Return & Ingress
option.
3. Select the chart that you wish to use by clicking on the chart in the Base Charts list,
and ensure that the selected calculation method in the Chart Type to Generate is
"Solar Return".
4. Select which solar return you require (current, nearest or next).
5. The location of the selected base chart will automatically be entered, and this will
be sufficient to cast the Solar Return chart. However if you want to calculate the
Solar Return for a different location enter the details of the different place. (It is
possible to use the "Location" option buttons or the Place or Zone buttons to
choose an existing location or timezone.)
6. Click on the OK button - The program will then calculate all the planetary positions
and house cusps, and add the chart to the list of "Calculated Charts" on the Main
Screen.
7. Select the Current Chart option from the View menu on the Main Screen to display
the chart.
8. To print the chart on your printer, select the Print button from the "View Chart"
window, or select the Print Chart option from the View menu on the Main Screen.
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3.3.7.9 Displaying or Printing a BiWheel

The steps involved in displaying or printing a BiWheel chart are as follows...
1. Either cast new charts or open the existing charts that you wish to use in the
biwheel.
2. Click on the View menu on the Main Screen, then click on the BiWheel option.
3. Select the charts that you wish to place on the inner and outer wheels..
a) In the "Selected Charts" box click on Inner Wheel then click on a chart for that
wheel in the Charts list.
b) Outer Wheel in the "Selected Charts" box will now be highlighted. Click on
another chart for that wheel in the Charts list.
4. Click on the View button - the BiWheel will then be drawn on the "View Chart"
window.
5. To print the biwheel on your printer, select the Print button from the "View Chart"
window, or repeat the first 3 steps above and then select Print button from the
"BiWheel Selection" dialog box.
3.3.7.10 Displaying or Printing a Synastry Grid

>> To display or print a synastry grid
1) Either cast new natal charts (see Casting a Natal Chart) or open the existing charts
that you wish to use in the grid.
2) Click on the View menu on the Main Screen, then click on the Synastry Grid
option.
3) Select the charts that you wish to place across the top and side of the grid.
a) In the "Selected Charts" box click on Across then click on a chart for the top of the
grid in the Charts list.
b) Down in the "Selected Charts" box will now be highlighted. Click on another chart
for the side of the grid in the Charts list.
4) Click on the View button - The grid will then be drawn on the "View Chart" window.
5) To print the grid on your printer, select the Print button from the "View Chart"
window, or repeat the first 3 steps above and then select Print button from the
"Synastry Grid Selection" dialog box.
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Basic Operations
Solar Fire is generally a very intuitive program to use. It is also flexible and efficient in
the way it allows you to work with many different windows at the same time without
creating clutter on your screen. Additionally most of the common operations can be
carried out either by using the mouse, or the keyboard (see Short-Cut Keys).
The topics in this chapter cover the procedures you need for basic chart casting.

4.1

Exiting from Solar Fire
Before exiting from Solar Fire you may wish to save any charts you've cast that haven't
been saved yet (see Saving your charts).
>> To exit from the program
Click on the Chart menu in the Main Screen, then click on the Exit option.
If you haven't saved all new or edited charts before exiting you will also be prompted
if you wish to do so (see Saving Charts to a File for more information).

4.2

Casting a New Chart
This chapter describes how to enter data to cast a new natal or event chart. The same
conventions apply to entering data for subsidiary charts, dynamic reports and all other
places where you would enter dates, times or places.

4.2.1 Pre-Setting Calculation Options
There are several options in Solar Fire that affect the calculation of the chart. If you wish
to alter them, then you must do so before the chart is cast, as you cannot set them on
the “New Chart Data Entry” screen.
These options are...
Geocentric Latitudes - Whether or not the entered latitude is converted to a
geocentric latitude. Most astrologers do not use geocentric latitude.
Lunar Parallax - Whether or not a correction is made to the moon’s position due to
location. Most astrologers do not correct the moon for parallax.
Lunar Node Type - Whether the true node or mean node is calculated. Astrologers
today are fairly evenly divided on this issue.
Vulcan Calculation - Which method of calculating Vulcan’s position is used. This
option is only relevant if you intend to display Vulcan in your chart. Most
astrologers do not display Vulcan.
Part of Fortune - Which formula is used to calculate the position of the Part of
Fortune in the chart, i.e. whether to use ASC+Moon-Sun for both day and night
births, or to change it to ASC+Sun-Moon for night births.
MC in Polar Regions – Which formula is used to calculate the position of the MC for
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charts cast in locations when the Sun does not rise across the horizon during the
day.
>> To alter any of the above options
1. Select the Edit Settings item from the "Preferences" menu on the Main Screen.
2. Select the Calculations tab.
3. Alter any settings as required
See Changing Preferences for more information on these options.
4.2.2 The New Chart Data Entry Dialog Box
>> To begin casting a new chart
Choose New from the Charts menu.
This will display the "New Chart Data Entry" dialog box into which natal details and
chart options may be entered.

When this dialog box is displayed it will already contain data. If you have not yet cast or
opened a chart since the program was started, then the data displayed is whatever has
last been saved as default values. (See Saving and Restoring Settings for details of how
to alter default values.) Otherwise it will contain the data from the last chart that was
cast or opened.
4.2.3 Casting an Instant Chart for Here and Now
To cast a quick chart for the current time and place, you can use the default time and
place values that you have already set. This is handy for casting a quick horary or event
chart.
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>> To calculate a chart for the current moment
Select the Now button.
The Chart Name box will appear as “Transits of [date]”, and the Date and Time fields
will be updated to correspond to the computer’s internal clock.
>> To calculate a chart for the default place
Select the Restore button.
The boxes "Place" through to "Longitude" will fill with whatever values were selected
for the default place. (You will probably have set the default place to be your current
location.)
4.2.4 Entering the Chart Name
Up to 30 characters of text may be entered to describe the chart. Typically this will be
the name of the person for whom a birth chart is being cast (e.g. "John Smith"), but could
also be a description of an event (e.g. "President's Inauguration"), or a horary question
(e.g. “Where are my keys?”). You must enter at least 1 character in the Chart Name box.
Note: If the name you enter contains the string “transit” anywhere, then the event type
is automatically set to “Event”. If the name you enter ends with a “?”, then the event
type is automatically set to “Horary”. However, you can subsequently alter this
automatic event type selection if you wish.
Note: For chart list indexing and when combined charts are being produced, the last item
on the line is assumed to be a "last name" (except in the case of Event and Horary
charts). Therefore, when entering chart names for a person’s natal chart, we recommend
that names always be entered with the first name first, and the last name last.
4.2.5 Entering a Date
You can enter the date in almost any format you like, and when you leave the date box,
the date will be converted into Solar Fire’s standard format. If you enter an impossible
date such as February 30 or a month number greater than 12, or use a format that the
program does not understand, then you will get an error message and be given a chance
to try again.
There is also a group of three spin buttons to the right of the date entry box. These
buttons allow you increment the individual parts of the date upwards or downwards
without having to retype the entire date. For example, the rightmost spin button allows
you to change the year number up or down by one year at a time.
Following are some examples of valid dates, and the manner in which they are displayed
by the program.
User Entered Date
1 Dec 1992
1 Dec 92

International Display Format
1 Dec 1992
1 Dec 1992

US Display Format
Dec 1 1992
Dec 1 1992
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User Entered Date

International Display Format

US Display Format

1 Dec 02
Dec 1 1992
1 December 1992
1st December 1992
1 Dec 1992 AD
1 Dec 1992 BC
1 Dec 0092
1/12/92
12.1.92

1 Dec 2002
1 Dec 1992
1 Dec 1992
1 Dec 1992
1 Dec 1992
1 Dec 1992 BC
1 Dec 0092
1 Dec 1992
12 Jan 1992

Dec 1 2002
Dec 1 1992
Dec 1 1992
Dec 1 1992
Dec 1 1992
Dec 1 1992 BC
Dec 1 0092
Jan 12 1992
Dec 1 1992

The display format that Solar Fire uses is based on the date order settings within
Windows, which may be set by using the Regional Settings icon on the Windows
Control Panel.
Description of Format
You must enter a day, month and year, separated by any of the following characters:
blank( ); slash(/); period(.); colon(:); semi-colon(;) or comma(,). If you use a month name
or abbreviation instead of a month number, then you do not need to use any separators.
You may also enter just a day number, in which case the last entered month and year are
assumed, or just a day and month in which case the last entered year is assumed. You
may also enter just a 4 digit year number, in which the day and month are automatically
set as 1s t January.
A day number (e.g. 1, 2, 3, ..., 31). You may also use any of the following suffixes:
"st", "nd", "rd" or "th".
A month name, abbreviation or number (e.g. Jan, Feb, Mar, ..., Dec, or 1, 2, 3, ...,
12). These must be English month names, but may be in upper, lower or mixed case.
Abbreviations must contain at least the first three letters of the month name. If you
use a month name or abbreviation, then it does not matter whether you put the day
or the month first. However, if you use a month number, then you must ensure that
you enter the date in whatever order has been set in Windows. See Selecting a Date
Format for instructions on settings the Windows date order.
A year number (e.g. 57, 1957, 2005, -6). You may also use any of the following
epoch indicators: “AD”, “A.D.”, “BC”, “B.C.”, “CE”, “C.E.”, “BCE”, “B.C.E”. If you
only enter two digits, then the year is assumed to be within the time window
specified in the Preference settings. To enter dates in the 1st century, you must use
a 00 prefix (e.g. 0059 for year 59).
Optionally there may also be any of the following items:
A calendar style indicator (i.e. OS, O.S., NS, N.S.)
The epoch is assumed to be AD unless BC or BCE has been entered, or if the year is
negative. If the year is negative, then Solar Fire will automatically convert the year into a
BC year, and remove the minus sign. (Note that there is a difference of 1 year between
© 2014 Esoteric Technologies Pty Ltd

Basic Operations

55

BC years and negative (astronomical) years e.g. the year -6 is converted into 7 BC. This
is due to the absence of a year 0 in the BC format.)
Modern and Old Calendars
Unless you specify otherwise (by entering an OS or NS suffix), Solar Fire assumes that
the dates that you enter...
on or before 14th October 1582 are in the old style (Julian) calendar.
on or after 15th October 1582 are in the new style (Gregorian) calendar.
The Gregorian calendar was not adopted everywhere at the same time. Sometimes dates
after 15th October 1582 are given in terms of the old style calendar (often followed by
the initials O.S.). Also, some sources convert pre 1582 dates to new style dates (often
followed by the initials N.S.).
If you wish to enter a date on or after the 15th October 1582 which is expressed as an
old style date, then add the suffix “OS” or “O.S.” to the entered date (e.g. 17 Dec 1723
OS).
If you wish to enter a date before the 15th October 1582 which is expressed as a new
style date, then add the suffix “NS” or “N.S.” to the entered date (e.g. 7 Jan 1503 NS).
The way in which these dates are displayed in Solar Fire depends on user-modifiable
preferences. You can determine whether or not Solar Fire will automatically convert any
entered dates into the default calendar for that date, or alternatively whether any dates
that you enter with an OS or NS suffix will always be displayed exactly as they were
entered. Additionally, you can specify a range of years between which the OS or NS
indicator is displayed with all dates. See Changing Preferences for more details.
The following table shows the adjustment that Solar Fire makes in order to convert from
old style to new style dates:15 Oct 1582 to 28 Feb 1700
29 Feb 1700 to 28 Feb 1800
29 Feb 1800 to 28 Feb 1900
29 Feb 1900 to 28 Feb 2100

Add 10 days
Add 11 days
Add 12 days
Add 13 days

4.2.6 Entering a Time
The time that you enter should be ordinary clock time of the locality, or “Universal
Time”. If you enter a Universal Time or Greenwich Mean Time, be sure to change the
initials in the Zone box to “UT” or “GMT”. If necessary you can also enter a Local Mean
Time or a Local Apparent Time which were the prevalent time standards prior to the late
19th century. If you enter time as Local Mean Time or Local Apparent Time then you
should enter “LMT” or “LAT” in the Zone box.
There is no need to convert a time to Ephemeris Time (ET), as Solar Fire does this
internally whenever it is necessary.
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You may enter a time in any of the most commonly used formats. Any characters within
the time may be in upper, lower or mixed case. Entered times are always immediately
transformed into a standard display format if they are recognized. If they are not
recognized as valid times then an error dialog box appears, after which a further attempt
may be made.
The display format that Solar Fire uses is based on the time format settings within
Windows, which may be set by using the Regional Settings icon on the Windows
Control Panel. See Selecting a Time Format for further details.
Following are some examples of valid times, and the manner in which they are displayed
by the program:
User Entry
Noon
12
12 PM
12 AM
12:00
12:00:00
6
13:00
13:25
13:25:49
1:25:49 AM
1:25:49 PM

AM/PM Format
12:00 PM
12:00 PM
12:00 PM
0:00 AM
12:00 PM
12:00 PM
6:00 AM
1:00 PM
1:25 PM
1:25:49 PM
1:25:49 AM
1:25:49 PM

24Hr Format
12:00
12:00
12:00
0:00
12:00
12:00
6:00
13:00
13:25
13:25:49
1:25:49
13:25:49

Description of Format
You must enter at least an hour; minutes and seconds are optional. You can separate
hours, minutes and seconds with a blank( ), slash(/), period(.), colon(:),semi-colon(;) or
comma(,).
You can enter time in the 24 hour format (with an hour from 0 to 23), or you can use an
AM/PM format by typing either AM or PM after the time. If the hour number is less
than 12, then there is no need to type AM.
You can also enter any of the following words: "Noon", "Midday" or "Midnight".
4.2.7 Entering Location Details
Location details are: the place name, the country or state, the timezone, the latitude and
the longitude. It is possible to enter each of these items manually onto the “New Chart
Data Entry” screen, but there are also shortcuts to finding and entering the location
details that you need.
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>> To restore the default location details
You would normally already have set the default location to be where you live (see
Setting the Default Place). To retrieve all the details and insert them automatically into
the required text boxes, simply select the Restore button.
TIP: To recall a place that you have used recently, or is on your list of favorite places,
click on the down arrow on the Place drop-down box and select the required place from
the list
>> To perform an automatic atlas lookup
1. Ensure that the Auto Lookup check box is checked
2. Enter the name of the required place into the Place box. You can enter up to 20
characters to describe the location name. Typically this would be city name or city
name and state (e.g. "London" or "New York NY").
3. Enter the country or state into the Country/State box. You can enter up to 20
characters to describe the country or state (e.g. Canada, USA, Australia, NY, MA,
NSW, VIC).
4. As soon as you move the cursor out of the Country/State box (or press the Enter
key whilst the cursor is still in the Country/State box), an atlas lookup will be
performed invisibly to you, and if the place is found, then the remaining zone
latitude and longitude boxes will be updated with the details stored in the atlas for
this place.
5. If the place is not found in the atlas, then you will see a dialog box informing you
of this, and you will be taken into the place dialogs in order to try to find the
required place.
SHORTCUT: If when entering a new chart, you enter a place in the "Place" textbox and
see that the country for that place is already entered in Country/State textbox, and
therefore you next click on the "OK" button, a warning may be displayed. This is to
ensure that the timezone, latitude and longitude are updated for the place you have
just entered, and the warning will tell you that a Country must also be entered. If you
know the country is correct then you can just click in the "Country/State" textbox and
then click on the "OK" button again - this will force a fresh lookup of the place details
in the Atlas, there is no need in this case to actually re-enter the country again.
>> To perform a manual atlas lookup
Select the Place button.
This will display a dialog box that allows the selection or entry of a place from the ACS
Atlas. This is described in detail in Using the ACS Atlas. Using this button will cause data
to be automatically entered into all the boxes relating to location, including time zone,
longitude and latitude. The time zone will be adjusted automatically for any daylight
saving etc.
If you have already obtained all the location details from the atlas, then you can skip the
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following sections that describe how to enter timezones, latitudes and longitudes.
4.2.8 Entering a Time Zone
Time zones may be selected either by using the Zone button to display the "Time Zone
Selection" screen, or by entering a time zone mnemonic or a time directly into the Zone
box.
You can enter standard time zones, Local Mean Time or Local Apparent Time.
Standard Time Zones – These are standards that were adopted by various
authorities in order to ensure that all people living in the same region used the
same time standard.
Local Mean Time (LMT) – This is the standard time of the longitude of a location.
This was used in most places prior to the adoption of standard time zones. Using
this standard, the mean position of the Sun is on the meridian at noon, but note
that the true Sun varies from this position by up to about 15 minutes either way.
Local Apparent Time (LAT) – This is the time according to the true position of the
Sun in its diurnal arc, which is equivalent to sundial time. By this standard, noon
occurs on each day when the Sun is exactly on the meridian. This is the standard
that was generally used prior to LMT.
>> To enter a time zone using its mnemonic abbreviation
Enter one of the standard 3 or 4 letter time zone abbreviations (e.g. “EST”, “AEST”,
“BST”, “CWT”, etc.).
For the program to recognize the abbreviation, it must be in Solar Fire’s internal time
zone database. If the abbreviation is not recognized, you will see an error dialog box, and
you can try again. If it is recognized, then the corresponding zone time will be
automatically appended after the abbreviation in the Zone box.
>> To enter a time zone using its time offset
Enter the number of hours (and optionally minutes and seconds) from Universal
Time or Greenwich Mean Time e.g. +8 or 8 for Pacific Standard Time, or -10:30 for
Australian Central Daylight Time. For zones west of Greenwich, use a plus (+) sign
or no sign. For zones east of Greenwich, use a minus (-) sign. You must use a
colon(:) to separate hours minutes and seconds.
>> To enter Local Mean Time
Type “LMT” into the Zone box.
The correct zone time for the current longitude will be appended after the abbreviation in
the Zone box, and if you subsequently alter the longitude, this zone time will be
amended automatically.
>> To enter Local Apparent Time (Sundial Time)
Type “LAT” into the Zone box.
© 2014 Esoteric Technologies Pty Ltd

Basic Operations

59

The correct zone time for the current date and location will be appended after the
abbreviation in the Zone box, and if you subsequently alter the longitude or date, this
zone time will be amended automatically.
>> To choose a time zone from the database of time zones
Select the Zone button.
This will display the "Time Zone Selection" dialog box from which a time zone may be
selected.

You can alter the order in which entries are shown by selecting the Sort Order as
follows...
Full Name - the records will be sorted into ascending alphabetical order of their full
descriptive name.
Zone Time - the records will be sorted into numerical order by their hours from
GMT. (Note that the ordering is from 0 to 12 positive numbers followed by 0 to 12
negative numbers).
Mnemonic - the records will be sorted into ascending alphabetical order of their
mnemonic abbreviation.
>> To retrieve time zone details to the screen from which the Zone button was
selected
1. Select the desired time zone entry from the list box
2. Click on the Select button.
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4.2.9 Entering Longitudes and Latitudes
Longitudes and latitudes must be entered either in degrees and minutes with a letter
indicator of which hemisphere they are in, or as a decimal degree number with its sign
indicating which hemisphere (-ve for East or South).
Longitudes and latitude must have at least a degree number (i.e. 0 to 180 for longitude,
0 to 90 for latitude) and a hemisphere code (i.e. E or W for longitude, N or S for latitude).
They may also have a minutes number (i.e. 0, 1, 2, 3, ..., 59) and a seconds number.
Separators between the numbers may be any of the following: blank( ); slash(/);
period(.); colon(:); semi-colon(;) or comma(,).
Some examples of valid longitudes are as follows...
0W 0W0 149e38 78W23 E 167 52 -167.8667
Some examples of valid latitudes are as follows...
0S 0N0 17S58 62n17 S 45 23 -45.3833
Enter ordinary geographic latitudes, even if you want to use the geocentric latitude.
(Atlases always give geographic latitudes). If you wish to use geocentric latitudes in
chart calculations then you should switch the Geocentric Lats option on. See Optional
Correction Factors for instructions on how to do this.
4.2.10 Selecting an Event Type
By default, any new chart is labeled as an “Unspecified” chart, which is a catchall name
to cover any kind of astrological chart. However, you are also able to select some
alternative labels that describe more exactly what type of event the chart describes.
Some of these labels are used in other parts of Solar Fire to help display chart
information in its most appropriate format.
If the event type that you wish to select is not already highlighted in the Event Type list
box, then simply find the required event type from the drop-down list and highlight it.
The event types available in Solar Fire are as follows...
Unspecified – This is used for charts which were created in older versions of Solar
Fire, or alterative astrology programs when imported into Solar Fire.
Male – use this label for the birth chart of a male. This label is used in synastry
reports to apply the correct gender language to the interpretations.
Female – use this label for the birth chart of a female. This label is used in synastry
reports to apply the correct gender language to the interpretations.
Event – use this label for any non-natal chart, such as a transit chart or mundane
event.
Horary – use this label for any chart which is cast for the purpose of asking an
horary question. In this case, the Chart Name can contain the text of the question.
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4.2.11 Selecting a House System
If the house system that you wish to use is not already highlighted in the House System
drop-down list box, then simply find the required house system from the list and
highlight it.
You can reset the default house system that is selected whenever you start Solar Fire by
altering a preferences setting. See Houses for instructions on selecting the default house
system, and a description of what they mean.
4.2.12 Selecting a Zodiac
You can select any of the available zodiac types by highlighting the desired option on the
drop-down list of Zodiac types.
Most Western astrologers normally use the Tropical zodiac, whereas Sidereal astrologers
normally use one of the other (sidereal) zodiacs. Most Western astrologers who practice
sidereal astrology use the Fagan-Allen zodiac.
The initial default value of the zodiac selection is set according to your choice of zodiac
in the Preferences menu. See Zodiac for instructions on changing the default zodiac.
4.2.13 Selecting a Coordinate System
You can select either geocentric or heliocentric coordinates from the drop-down
Coordinate System list.
Most astrologers use the geocentric coordinate system. If you select the heliocentric
coordinate system, then the chart will be calculated with heliocentric planetary positions
on geocentric houses.
If you do not want to display geocentric houses on a heliocentric chart, then you could
select "0 Deg Aries" as your house system, as this is a "neutral" house system which is
independent of the chart’s location on earth.
4.2.14 Entering a Source Rating
The source rating is an optional code that indicates how accurate or reliable the chart’s
date and time are. This is very useful when charts are exchanged with other astrologers,
because it can help avoid misunderstandings about how accurately a chart’s time is
known. For example, a chart’s time may be given as “10:43 am”, implying that it was
timed to the nearest minute, but if the source rating is given as “D – Conflicting/
Unverified”, then an astrologer would be very cautious about drawing firm conclusions
from the chart.
>> To enter a source rating
Either...
Select a pre-defined rating category from the drop-down list box
or...
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Enter any rating code up to 2 characters long
The predefined rating codes are known as “Rodden Rating” codes as devised and
promoted by Lois Rodden. These codes are:
AA - From birth record, e.g. directly from a birth certificate or hospital record, or
quoted from such a record
A - From memory or from a news report
B - From a biography or auto-biography
C – Original source unknown or rectified from an approximate time
DD – Conflicting with other sources or otherwise unverified
X - Time unknown e.g. only the date is known or has been rectified without an
approximate starting time
XX – Date in question or otherwise undetermined
4.2.15 Entering a Source Description
In addition to entering a source rating code, you can optionally also enter a brief source
description to elucidate the rating code. The purpose of this field is to provide more
information about the chart rating than can be conveyed by the two-character source
rating code.
Some examples of possible source descriptions are...
AA - “Birth certificate” or “Quoted from hospital record”
A – “The Times 3 Nov 1992” or “Mother’s memory”
B – “from ‘A Good Life’ by C.Cook”
C – “Rectified from 10am by John Smith”
DD – “Alternative time 11:15pm” or “Several alternatives known”
X – “Time unknown”
XX – “Calendar type uncertain”
4.2.16 Entering Chart Comments
It is possible to enter up to about 30,000 characters (many pages) of free text which is
stored and saved along with the chart details. This can be used to store, for example,
biographical information, a description of the chart event, records of what astrological
analysis has been done on the chart, notes on the chart’s rectification etc.
>> To enter or edit chart comments
Click on the Comments button
This will open up the comments editing window, which allows you to browse, enter or
edit any comments text. Any text that you enter will remain associated with the chart
when you use it in Solar Fire, so that when you save the chart to a file, the comments
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that you enter here will also be saved with it.
Note that you can also easily edit any comments that you enter here after you have
calculated the chart, and also after you have saved the chart, if you wish to, from other
places in the program.
However, if you do not save this chart to a file or retain it before exiting from Solar Fire,
then any comments that you enter here will be discarded along with the chart that you
create here.
4.2.17 Entering Life Events
It is possible to enter an indefinite number of life events relating to a chart, which are
stored and saved along with the chart details (see Working with Life Events for more
information). These events can be accessed in other parts of Solar Fire, making it easy to
cast subsidiary charts (such as progressions or directions) for such life events, or view
the chart animation screen for these life events, without having to re-enter the event
details again.
Each life event can also have an unlimited amount of free text stored with it. This can be
used, for example, to store a description or detailed account of the event and
circumstances surrounding it.
>> To enter or edit life events
Click on the Life Events… button
This will open up the Life Events editing window, which allows you to browse, enter or
edit any life events. Any events that you enter will remain associated with the chart
when you use it in Solar Fire, so that when you save it to a file, the life events that
you enter here will also be saved with it. See 50 for an explanation of how to use the
Life Events editing window.
Note that you can also easily edit any life events that you enter here after you have
calculated the chart, and also after you have saved the chart, if you wish to, from other
places in the program.
However, if you do not save this chart to a file or retain it before exiting from Solar Fire,
then any life events that you enter here will be discarded along with the chart that you
create here.
4.2.18 Calculating the New Chart
When all the required data items have been entered and preferred options chosen,
select either the OK or the OK More button.
OK - The chart is then calculated and added to the list of "Calculated Charts" on
the Main Screen, and the New Chart Data Entry screen closes.
OK More - The chart is then calculated and added to the list of "Calculated Charts"
on the Main Screen, and the New Chart Data Entry screen remains open ready for
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you to enter details for another chart.
It is possible to view, print, report on, or cast subsidiary charts from any such chart on
the list of "Calculated Charts" by selecting the appropriate options from the menu.

4.3

Places: using the ACS Atlas
This chapter describes how to select a place for use in chart casting, and how to manage
the place database and atlas data.
There are two different sources of place data
Built-in ACS Atlas – provided within Solar Fire.
Standalone ACS Atlas – may be purchased as a separate product.
If you have a standalone ACS Atlas installed on your computer, then you can choose
whether you wish to use this Atlas in preference to Solar Fire's built-in ACS Atlas. See
Atlas to Use for instructions on how to select which Atlas you wish to use.
>> To activate the ACS Atlas dialog box:
When creating a new chart in the "New Chart Data Entry" dialog, select the Place
button.

When the ACS PC Atlas dialog appears, the place, date and time boxes will contain the
information that was held on the "New Chart Data Entry" dialog . You have the option of
changing any of these if you wish to, and then clicking on any of the four main command
buttons, which are described below. When you have found the place that you require,
then clicking on the OK button will return you to the previous screen, and the displayed
place details will be copied automatically onto that screen.
Atlas Lookup
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You may enter the place to look up using any of the following formats...
PlaceName
PlaceName, CountryOrStateName
PlaceName, CountyOrAdminDivisionName, CountryOrStateName
When you click on the Lookup button, one of the following will occur...
A Place name with a country name or US State name – (e.g. “Athens, Greece”) If
this place name exists as a unique name in the given country or state, then the
lookup is performed immediately, and the results shown in this dialog. If there is
more than one such place with this name, then you will be presented with a list of
these places, from which you can select one. If the place name does not exist, then
you will be presented with a list of places in that country or state whose names are
closest, alphabetically, to the one you entered.
A Place name with country name as “US” or “USA” – (e.g. “Athens, USA”) If this
place name exists in a US state within the atlas, then you will be presented with a
list of all places found with that state name and the local administrative division in
which they fall. If the place name does not exist within the atlas, then you will be
presented with a list of US state names from which to choose, after which you will
be presented with a list of places in the chosen state whose names are closest,
alphabetically, to the one you entered.
A Place name (without country or state name) – (e.g. “Athens”) If this place
name exists in the atlas, then you will be presented with a list of all places found
with their country or US state name and the local administrative division in which
they fall. If the place name does not exist within the atlas, then you will be
presented with a list of country or state names from which to choose, after which
you will be presented with a list of places in the chosen country or state whose
names are closest, alphabetically, to the one you entered.
Similar Names
If you click on the Similar Names button, or if the place you are looking for was not
found, then you will be presented with the City dialog box.
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>> To select the required city
Click on the required entry and select the OK button, or double-click on the required
entry
If you select the Cancel button, then you will return to the ACS Atlas screen after
seeing a message indicating that the lookup was not successful.
Radius Search
If you click on the Radius Search Button, then the selection box appears.

The initial settings of the longitude and latitude will be the same as the most recent
entry that was found in the atlas. You have the option of altering these if you wish, and
of specifying the radius of the search in minutes of arc by editing the Distance box. By
default it is set to 1 minute of arc.
>> To start the search
Select the Start Search button
You will be prompted for the country or state in which you wish to search, and the
results will be presented in the City dialog box, from which you may select any entry.
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If no entries are found within the given radius, then you will be returned to the ACS
Atlas screen without any result.
Zone Changes
>> To see a list of dates and times at which the time zone changes occur
1. Select the Zone Changes button
You may be prompted for the country or state, and for the city for which you wish to
see the zone changes and the results will be presented in a dialog box.

2. Selecting the OK button will simply return you to the ACS Atlas screen.
4.3.1 Adding or Deleting Place
The ACS Atlas comes with an extensive range of locations from around the world.
However, from time to time you may like to add your own places to the atlas, thus
allowing them to be looked up with the correct timezone changes automatically applied.
>> To add or delete a place to the ACS Atlas:
Click on the Add/Del Places button.
This will display the Personal Atlas Locations Dialog.
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This dialog lists any personal locations that you have already added previously, but will
be blank the first time you use it.
>> To add a place to the ACS Atlas:
Click on the Add New button.

This displays a dialog into which you can enter the required new place details.
The items you need to supply are:
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Place - Enter the name of the place you wish to add
Country - Enter the Country or US State name in which this place is located.
Normally this will be a country or US State name which already exists in the ACS
Atlas, but it is possible to enter a new country name if you wish.
Latitude - Enter the latitude of the place. See Entering Longitudes and Latitudes
Longitude - Enter the latitude of the place.
Zone - If the timezone option is set to "Fixed timezone", then you can enter a
timezone yourself. See Entering a Time Zone
Specified Place, Country - If the timezone option allows it, you can enter a location
which exists as a valid location within the ACS Atlas. See Using the ACS Atlas
Timezone & DST Changes - This has three possible settings, as follows...
Same as nearest location in atlas - If you select this option then the timezone
and DST changes for your newly added place will automatically be the same as
that for the nearest place in the atlas. This is normally the best option, unless
your new location is near a border, for example, in which case the nearest place
may not be in the same timezone region, and you may then want to specify a
place which you know is in the correct region, instead.
Same as this specified place, country - Allows you to specify an existing place in
the ACS Atlas from which the timezone settings will be copied.
Fixed timezone - If you don't want your place to have automatic daylight savings
adjustments applied, you can either enter a fixed timezone, or use the Zone
button to select one from the list.
>> To delete a place from the ACS Atlas:
Highlight the place you wish to delete, and then use the Delete button.
Note - you can only delete places that you have previously added as personal places
yourself. It is not possible to delete any of the locations that form part of the ACS Atlas
as supplied.

4.4

Viewing Charts, Grids and Pages
This chapter describes how to view charts, aspect grids or other page displays for charts
that appears on the list of "Calculated Charts" on the Main Screen.
Before viewing a chart or its grid, it is necessary to have either cast or opened the charts
that you wish to use. If you have not yet done so, see Casting a Natal Chart for
instructions on casting a new chart, or Retrieving Charts From a File for instructions on
opening an existing chart.
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4.4.1 Viewing a Single Chart or Grid
Any type of chart that Solar Fire calculates can be viewed in wheel form or in an aspect
grid as follows.
>> To view a chart from the Main Screen
1. Select a chart on the list of "Calculated Charts".
2. Choose Current Chart from the View menu, or double-click the left mouse button
on a chart on the list of "Calculated Charts", or press the Ctrl+C short-cut key.
>> To view an aspect grid from the Main Screen
1. Select a chart on the list of "Calculated Charts".
2. Choose Current Grid from the View menu.
>> To view a chart and aspect grid on the same page, from the Main Screen
1. Select a chart on the list of "Calculated Charts".
2. Choose Current Chart+Grid from the View menu.
>> To view a chart or grid whose image was the last one to be displayed
1. Choose Last Image from the View menu.
4.4.2 Viewing MultiWheels and Synastry Grids
There are a variety of wheel and grid displays that show more than one chart e.g.
biwheels, synastry grids, dual wheels etc.
>> To view any display which requires more than one chart
Select the required option from the View menu. These options are...
Dual Wheels - Two separate charts
BiWheel - Two concentric charts
TriWheel - Three concentric charts
QuadriWheel - Four concentric charts
QuinquiWheel - Five concentric charts
Synastry Grid - An aspect grid showing inter-chart aspects
Selecting any of these options will display the "Chart Selection" screen, which allows two
or more charts to be selected for viewing, printing or reporting.
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>> To select the positions of charts on the multiwheels (or on the synastry grid)
1. Select a wheel (or grid) position on the Selected Charts list box
2. Select a chart for this position from the Charts list box
Repeat above steps for each chart position
When a chart is selected, its name and type is written into the "Selected Charts" list
box. If there are further selections to be made, then the highlight bar will move to the
next wheel (or grid) position on the "Selected Charts" list, ready for the next chart to be
selected from the Charts list box. It is possible to change the selection of any chart by
repeating the above procedure as often as required. Whilst all the chart selections
have not yet been made, the View, Report and Print buttons are disabled, and cannot
be used.
>> To clear all the selections that have been made so far
1. Select the Clear button. This will return the state of the screen to how it appeared
before any selections were made.
When all required charts have been selected, then the following options are available...
>> To view the chart, grid or page
1. Select the View button.
If this image has not already been created, then it will create the image. Otherwise it
will locate the old image, and in both cases it will then display the desired image on
the "View Chart" window.
>> To print the chart, grid or page
1. Select the Print button.
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This displays the "Print Chart" dialog box, allowing the user to cancel printing, add the
print job to the batch print queue, to alter printer settings, or to print immediately. See
Casting a Natal Chart for more details on these options.
For dual wheels, biwheels, synastry grids and page displays which contain 2 charts
only, a further option is available.
>> To view a report using the two selected charts
1. Select the Reports button.
This will display the "Report View" screen, which allows a variety of synastry reports
for the selected charts to be browsed, edited or printed. See Synastry Reports for
further details about synastry reports. The same set of synastry reports is generated
regardless of whether the user has selected the biwheel, synastry grid or other user
defined page option.
Reports are not available for triwheels or quadriwheels or other pages that contain more
than two charts. (It is possible, however, to generate reports on the individual charts in a
multiwheel by selecting the appropriate options from the Main Screen menu.)
See Also:
Multiwheel Superimposition
Shortcuts for Viewing Multiple Wheels or Charts
4.4.3 Viewing Pages
"Pages" in Solar Fire are viewable pages that can show one or more charts and other
astrological data in ways that are not possible from any of the other display options in
Solar Fire. Pages all start off as a blank page that information has been added to. This
can be a small or large amount of information, and it can be arranged in a free-form way
to be however is wanted. Being so customizable pages are therefore very flexible. For
example, a page may display a single wheel in a non-standard scaling and positioning,
or may display multiple wheels, grids or tabulations on a single page.
Solar Fire also comes pre-supplied with a variety of pages already made up for you, and
you can use these pages immediately. You can also change the appearance of these
pages, or if you prefer you can create your own pages - either by editing a copy of one of
the pre-supplied pages, or creating pages of your own from scratch.
See the advanced topic Editing a Page Design File to see how to create and edit pages,
and what information can be used to create a page.
>> To view any page
From the Main Screen...
Select the Page Topic Index option from the View menu.
This will display the Page Selection by Topic dialog box, listing all available page
layout files categorized by topic. If you select a page layout file that displays the
same number of charts as are already selected in the list of "Calculated Charts", then
it will display that page immediately, using the currently selected charts. Otherwise
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the "Chart Selection" screen will be displayed, which allows the charts to be selected
prior to viewing the page.
From the "View Chart" window...
Select the Pages button (or make a right hand mouse button click over the list of
images at the top right of the screen).
This will display the “Page Selection by Topic” dialog box, listing all page layout files
that use the same number of charts as the currently displayed page type. When you
have chosen a page, you have the option of selecting the View button to preview the
new page without creating a new image, or selecting the OK button to create a new
image and close the "Page Selection" dialog.
>> To view any of the four most recently viewed page types
From the Main Screen...
Select the name of the required page from the list in the View menu underneath
the User Defined Page option.
This list is empty the first time you run Solar Fire, but is updated each time you view a
user-defined page, and is retained from one session on Solar Fire to the next.
You may change the appearance of any existing pages, and new pages may be created
from scratch. See Editing a Page Design File for more information.
4.4.4 Using the Page Topic Index
The "Page Topic Index" is a dialog that contains a list of displayable wheels and pages,
categorized into various topics, in a collapsible/expandable list. You have the ability to
select pages from this list to view or preview, and to re-organize the arrangement and
names of topic categories as you wish.
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Cancel – closes this dialog without selecting a page.
Edit… – opens the highlighted page for editing in the Page Designer.
OK - selects the highlighted page and closes the dialog.
Apply - selects the highlighted page but leaves the dialog open. This is useful in
order to preview multiple pages before selecting a final one.
Transparent – (only available in Windows 2000, XP or later) allows the dialog to be
made semi-transparent. This is useful in helping you to see otherwise hidden parts
of pages when you are using the Apply button to preview pages without closing this
dialog.
>> To add a new topic category
Click on any topic category name and use the right hand mouse button to display a
pop-up menu, and select the Add Topic item.
This will display a dialog allowing you to enter the new category name
>> To rename a topic category
Click on the topic category name and use the right hand mouse button to display a
pop-up menu, and select the Rename Topic item.
This will put a focus box around the topic category name and allow you to edit it.
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>> To move a page from one category into another
Simply drag the page description onto another topic category name.
If the topic category you wish to move to is off the top or bottom of the page, then
drag the page off the top or bottom of the list. This will cause the list of pages to
collapse, and scroll up or down respectively, thus making the required target topic
category visible.
>> To copy a page from one category to another
Hold the Shift Key on the keyboard down while you drag the page description onto
another topic category name.
Note: Sometimes you may wonder where new pages created in the Page Designer, or
simply added externally to Solar Fire by placing Page files (.pag) in the Pages
subfolder of the Solar Fire User Files folder, have gone to, and have trouble finding
them in the Page Selection by Topic list box. Each time the Page Selection by Topic
list box is accessed it checks for all new pages added to the Pages subfolder since it
was last used. Any pages found that are of the "Chart Art" type are automatically
moved to the Chart Art category, and other new pages are moved to the Added
Recently category.
>> To refresh the list of pages after creating a new page or editing a page title
Use the F5 key.
This is the standard Windows key for refreshing lists of files.
4.4.5 Shortcuts for Viewing Multiple Wheels or Charts
It is possible to expedite the process of viewing wheels, grids and pages by selecting
multiple charts from the list of Calculated Charts before selecting the required viewing
option.
>> To create chart wheel images for several charts at once
1. Select all of the required charts from the list of "Calculated Charts" on the Main
Screen.
2. Select the Current Chart menu option from the View menu, or press the Ctrl+C
short-cut key.
An image will be created for each of the selected charts without any further action
on your part.
>> To view a biwheel without using the Multiwheel selection screen
1. Select all of the required charts from the list of "Calculated Charts" on the Main
Screen.
2. Select the BiWheel menu option from the View menu, or press the Ctrl+F2 shortcut key.
An image of the biwheel will be displayed immediately. The first chart on the list
of "Calculated Charts" will be on the inner wheel. If you want to reverse the order
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of charts, then you can select the Swap button.
>> To create images for several biwheels at once
1. Select all of the required charts from the list of "Calculated Charts" on the Main
Screen.
2. Select the BiWheel menu option from the View menu, or press the Ctrl+F2 shortcut key.
An image will be created for each pair of selected charts. The first chart of each
pair will be on the inner wheel. If you want to reverse the order of charts, then you
can select the Swap button.
The same principle applies for any selectable page as well. For example, if you
have an eight-wheel page, then you can select the eight charts from the list of
"Calculated Charts" in order to avoid having to select them later in the Multiwheel
selection screen.
The main limitation of this shortcut technique is that the charts are always taken
in the order in which they appear in the list of "Calculated Charts".

4.5

Using the View Chart window Features

If you are viewing a chart or page for the first time, then its image will be drawn
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according to the currently selected chart options, and the chart's reference number will
be added to the list box on the top right hand side of the screen.
If you are viewing a chart or grid whose image has already been created previously, then
its existing image will simply be redisplayed.
Resizing the View Chart window
The "View Chart" window is sizeable down to minimum dimensions of 640x480 pixels.
You resize it by "restoring" it, which is done by clicking on the middle icon (button) in the
top right corner of the window (the "Restore" button), and then dragging it's edges to the
new size.
This "Restore" button toggles a window between two states: being maximized (taking up
the full screen) and being restored to the last size the user set the window to. The
middle button icon will be in the shape of the a square when the window is in the
restored state (the square conveys the idea of the full screen) and indicates that by
clicking it you can expand the window up to a full screen size. The middle button icon
will be in the shape of two smaller overlapping squares when the window is in the
maximized, full screen state, (these overlapping squares convey the idea of many
windows overlapping each other) and indicates that by clicking on it the window will be
shrunk to a size less than the full screen (e.g. to become one of many windows on the
screen). So if the window is taking up the full screen you can shrink it by clicking on the
middle button in the top right hand corner of the window. And if you click on the middle
button again it will expand in size back up to filling the whole screen.
When the window is shrunk (restored) you can then alter it's size by hovering the mouse
over any edge of the window until the mouse-pointer shape is a double pointed arrow,
then clicking the left mouse button and holding it down, drag the mouse in the direction
you want that edge of the window to be resized to, and release the mouse button when
the desired size is reached. By doing this on the edges you want resized you can get the
window to be the size on the screen that you want it. Dragging the bottom right corner of
the window as above, diagonally, will move both the edges concerned at the same time.
Thus you can quickly resize the window in only one movement of the mouse.
TIP: In the restored state you can move the whole window itself, by holding the mouse
over the title bar of the View Chart window, clicking the left mouse button and holding it
down, then drag the whole window to where you want it on the screen, then release the
mouse button.
You can also "minimize" the window, which temporarily removes it from the screen, and
places an icon for it in the Windows TaskBar. When you want to see the window again
you just click on the icon in the TaskBar and it is displayed on the screen again. In some
versions of Windows the icon for the window may be stored on the TaskBar as part of
the Solar Fire program group of icons, in which case you will be able to access it by
clicking first on the Solar Fire icon itself in the TaskBar, then on the "View Chart" window
icon.
To minimize the "View Chart" window click on the left icon (button) in the top right
corner of the window (the "Minimize" button). It is the shape of a horizontal line.
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>> To change any of the display options
Place the mouse over any part of the displayed chart or page image and click on the
right-hand mouse button.
This will display a pop-up menu containing the same items as the Main Screen's
Chart Options (such as displayed points, aspect set, color schemes etc.) from which
you may select any items to change with the left-hand mouse button, as usual. See
Changing Chart Options for instructions on altering chart options. After you have
changed any display options, select the ReDraw button in order to regenerate and
update the image using the current set of chart options.
If you invoke this menu while the mouse is hovering over an object on the page (such
as a wheel, grid of tabulation), then the pop-up menu also has an option allowing you
to edit properties of that object. See Editing Properties of Objects on the Page for
further information.
>> To view any other previously created image
Select (click on) the desired chart or page item in the list box on the right hand side
of the window. The image of the selected chart, grid or page will be displayed in
place of the last image.
It is possible, during computation of a chart or grid image, that the computer may run
out of video memory. In this case an error dialog box will appear, notifying the user of
the problem. If this happens, you can take several different corrective steps. The first
time that this happens, it might still be possible to generate the image despite the
error. To try to generate the image despite the problem, select the ReDraw button. If
the error recurs, then use the following procedure. Firstly, print all the chart images
that you wish to keep (or add them to the batch print queue), and then from the Main
Screen select the Clear Images option from the View menu. This will delete all the
chart, grid and page images that have been created so far, and free up all associated
memory. You can then proceed normally again.
Whilst viewing a chart, there are a number of buttons and controls that may be used
for various purposes. Some of these, such as the Rectify button or the Save button
may be used when a single chart is being viewed, and others, such as the Swap
button, when multiple charts are being viewed.
4.5.1 Using View Screen Buttons
There are three page viewing mode buttons underneath the "Quit" button. These are:Normal view - this displays the page as optimized for normal viewing on the screen
Printer Preview (Full) - this displays the full page as it would be printed
Printer Preview (Zoomed) - this displays the page as it would be printed, but
zoomed enough to allow its full width or height to fit in to the available space, and
allowing the rest of the page to be viewed by scrolling
Note: Page designs may contain multiple page sizes. If the page design you are using
contains different information in its page sizes for screen as opposed to its printer page
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sizes, then you will see this difference reflected when you change viewing modes. See
Editing a Page Design File for information on using the Page Designer.
Note: If the page design you are displaying contains only printer sized pages, then the
Normal view button will be hidden.
The other buttons are:ReDraw - This option causes the displayed page to be redrawn according to the
current settings and display options.
Swap - This option is only available for page displays involving two or more charts.
It causes the displayed charts to be swapped or cycled. For example, if you are
displaying a biwheel, then the inner and outer charts are swapped. If you are
viewing a quadriwheel, then each time you use this option, the innermost chart
moves to the outermost position, and the others charts are moved inwards
correspondingly.
Rectify - This allows you to easily and interactively edit the date, time, Ascendant,
Midheaven, latitude or longitude of the chart (or of the first or innermost chart on
the page if there are multiple charts). It is described fully in Adjusting a Chart to a
new Time or Date.
Save - This allows the displayed chart to be saved to a file. It is fully described in
Saving Charts to a File.
Reports - This invokes the Reports screen, which is fully described in Generating
Chart Reports.
Transits - This invokes the Dynamic Report Selection screen, which is fully
described in Using Dynamic Reports and Time Maps.
Copy/Send - This invokes a “Copy Image To” dialog that allows you to select
whether to send the currently displayed image to the clipboard, to a file, or to an
email attachment, with various selectable options. See Copying, Publishing and
Sending Graphics.
Print - This allows the displayed image to be sent to your printer, or to the print
queue for printing later. You can also alter printer settings before printing, if
desired.
Pages – This displays the “Page Selection by Topic” dialog, allowing you to select
other page types to preview or display.
Charts – This displays the chart selection dialog, allowing you to select alternative
charts to be displayed with the currently displayed page type. Note: You can also
edit the charts events or comments from this dialog, by using a right hand mouse
click to bring up a pop-up menu when hovering over any chart in the list.
Wheel Style – If the currently displayed page has only one wheel type displayed,
then this will display the "File Manager" with a list of wheel style files that you can
select for this wheel type. If there is more than one wheel type displayed on the
current page (e.g. a uniwheel and a biwheel), then this will display the Chart
Options menu, from which you can choose one of the wheel style types.
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TIP: to quickly exit from the "View Chart" window press the ESC short-cut key.
4.5.2 Adjusting a Chart to a new Time or Date
This section describes how to use a rectification-assisting tool to adjust the date, time or
angles of a natal or event chart. (If the chart that you are displaying is not a natal or
event type chart, then the Rectify button will be disabled.)
>> To adjust a chart
1. Display the chart that you wish to rectify in the "View Chart" window. (If you are
viewing a multiwheel, then make sure that the chart you wish to rectify is the first
charts listed, which is usually the innermost chart.)
2. Click on the Rectify button
3. This will display the "Rectify Assist" dialog box.

>> To adjust the chart’s date
Click on the spin button next to the Date box to change the date by 1 day at a time,
or type a new date directly into the box.
>> To adjust the chart’s time
Click on the spin button next to the Time box to change the time by whatever
interval is selected in the Time Step Interval box, or type a new time directly into
the box. (You can make the Time Step Interval box visible by clicking on the More
button.)
>> To adjust the chart’s MC or ASC
Click on the spin button next to the MC or ASC box to change the angle by whatever
interval is selected in the Angle Step Interval box, or type a new time directly into
the box. (You can make the Angle Step Interval box visible by clicking on the More
button.)
>> To adjust the chart’s latitude or longitude
1. Click on the More button to make the Lat and Long boxes visible.
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2. Click on the spin button next to the Lat or Long box to change the angle by
whatever interval is selected in the Angle Step Interval box, or type a new
latitude or longitude into the box.
Whenever you adjust any of the values, then the data displayed in each of the other
boxes is updated automatically to ensure inter-consistency between them. For example,
adjusting the MC by 1 degree will cause the time to shift by 15 seconds.
Note that if spin buttons are used to pass the time forward through midnight, then the
date is automatically incremented by one day. If the time passes backwards through
midnight, then the date is automatically decremented by one day.
Angles can be entered in degrees, minutes and seconds (e.g. "133 24 20") or in zodiacal
annotation (e.g. "13 Cn 24 20"). For more information on entering angles see Entering
Angles.
Time can be entered in hours, minutes and seconds and include an am/pm indicator (e.g.
"7:30" or "2:23pm"). See Entering a Time for more details.
>> To preview the effect of the changes on the chart image
Click on the Apply button.
This will create a new calculated chart, and replace the chart image with an image
using the new chart, but leave the “Rectify Assist” dialog box where it is for further
adjustments to be made.
You can check the Transparent box to make this dialog semi-transparent. This allows
you to see otherwise hidden parts of the chart when you are applying changes and
leaving this dialog open.
>> To apply the changes and return to the View Chart screen
Click on the OK button. This will create a new calculated chart, and replace the
chart image with an image using the new chart, and The “Rectify Assist” dialog box
will disappear.
You may repeat these procedures as many times as you wish with the same chart image.
When you display the first adjusted image, a new chart is created. When subsequent
adjustments are made, this new chart is edited, and no further new charts are created.
Note that the new chart calculated this way will be unsaved (unless you have switched
on the Autosave option), so you may wish to save it before proceeding by clicking on the
Save button.
4.5.3 Using Dials and Pointers
In the "View Chart" window it is usually possible to alternate between displaying a chart
wheel and a dial display of the same chart or charts by simply selecting the desired
option with the mouse from the Wheel/Dial drop-down list (just above the "ReDraw"
button). The style of wheel or dial that is displayed depends on whatever is selected as
the default style under the Wheel Styles and Dial Styles of the Chart Options menu.
This option has no effect if the displayed page is one that uses a specifically named
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wheel or dial style (see Editing a Page Design File for information regarding this).
However, if you are using any of Solar Fire’s pre-defined displays from the View menu,
such as the Biwheel or Wheel+Grid options, or if you are using an ordinary page layout
which uses default display styles, then this option will work as expected.
Whenever a dial is displayed, a pointer is displayed in the middle of the innermost chart
in the dial. Initially this pointer will be pointing to the zero point on the dial scale. You
can move the pointer in a variety of ways, set an orb for the display of midpoints, and
select which chart the pointer is associated with. Before any of these things can be
done, you must first switch on the pointer options box.
>> To switch on the pointer options box
Click anywhere inside the innermost chart of the dial that you want to use.
If the page you are viewing has more than one dial on it, then the pointer options box
will only appear inside one dial at a time. Clicking on another dial will switch it off in
the previous dial, and switch it on in the newly selected dial.

>> To step the pointer around the dial
1. Click on the Options button in the pointer options box to see the drop-down menu
2. Select one of the following Step options
Step by Degree - Step by one degree on the dial scale at a time
Step by Minute - Step by one minute of a degree on the dial scale at a time
Step by Planet - Step to the next planet position on the dial
3. Click on the left or right arrows on the spin button above the options button. Each
click will step the pointer to the next degree, minute or planet position on the dial,
depending on which step option was chosen.
If the dial is a multiwheel, then the pointer will always initially be associated with the
innermost chart in the dial. However, you can select another chart to use the pointer
with, as follows.
>> For a multiwheel - to select which chart to use the pointer with
1. Click on the Options button in the pointer options box to see the drop-down menu.
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2. Select one of the charts listed at the bottom of the menu.

When the pointer reaches a position where it is at the midpoint of two planets in the
dial, then a solid red line is drawn between those two planets. If those two planets also
happen to form an aspect in the chart, then a dashed line is drawn from each planet to
the center of the dial. The dashed line takes on the same color as the color of the aspect
is formed, according to the current selected aspect colors.
In addition to the lines which appear, a midpoint tree is displayed underneath the
options box indicating which planets are forming the midpoint to the pointer position,
and if an aspect is formed in the chart, then the aspect symbol is also displayed.
In the example shown, the pointer is pointing to Chiron which is at 41°08’ in the dial, and
this is the midpoint in the dial of the Saturn and Juno, of Pluto & Pallas and the
Ascendant/Descendant axis, and also of Jupiter and the Midheaven, and Jupiter and
Mars. Additionally in the chart, Pluto and the Ascendant are in trine (120 ) aspect, Pallas
and the Ascendant are in sextile (60 aspect, Pluto and the Descendant are in sextile
(60 aspect, and Pallas and the Descendant are in trine (120 aspect.
As the above example is using a 90 dial, where the Pointer is pointing to (Chiron in
above example) is not necessarily the actual midpoint of the planets shown in the tree
and by the lines. However when the Dial Pointer position is not the actual midpoint of
the planets in the tree, it will be in some hard aspect to the midpoints of the planets in
the tree. If you wanted to see soft aspects you could use a 120 dial. A 30 dial will show
a variety of both hard and soft aspects.
Initially the orb for midpoints and aspects is set to 1 00’. However, you can change this
orb. The orb is measured in terms of a 360 degree circle, regardless of the modulus of
the dial, so for example a 1 degree orb corresponds to 1/4 degree on the dial scale of a
90 degree dial, and to 1/8 degree on the dial scale of a 45 degree dial.
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>> To change the orb of the midpoint tree in the dial
1. Click on the Options button in the pointer options box to see the drop-down menu.
2. Select the Change Orb option.
3. This will display a dialog box which allows you to enter the orb that you require, in
decimal degrees or degrees and minutes, separated by a space.
4.5.4 Direct Access to the Chart Options menus
When you are in the "View Chart" window, if you right-click the mouse (click the right
mouse button) anywhere in the page layout area, you will see a menu pop up.
This menu is a replica of the "Chart Options" menu located on the Main Screen of Solar
Fire. Clicking on any menu item here enables to quickly access any of the "Chart
Options" and to make changes. In many cases, if you do make changes then when you
return to the "View Chart" screen, you will most likely need to click on the ReDraw
button, to update the current page layout with any setting changes you make.
Half Aspect Grid Page Object
On many page layouts, you will see a half aspect grid showing the planetary aspects.
If you right-click over a half aspect grid object, to display the Chart Options menus,
there is an additional (last) menu item, called Grid Settings.
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If you click on the Show angles in aspect grid checkbox, the half aspect grid changes so
that while it still displays the aspects that are active, it now also displays all angles
between planets. There is a further option to display the angle in Degree/Minute/
Second format or in Decimal degree format. There is also an option to display the angle
up to 180 degrees, the usual practice in astrology, or as an angle up to 360 degrees.
When 360 degrees is selected, the grid displays the angle the faster planet is away from
the slower planet after the last conjunction, increasing the angle from 0 to 360.
Because this half aspect grid takes up space on screen, on some page layouts, it is likely
to overlap other page objects. A new page has been designed that only displays the half
aspect grid near the middle of the page so that it can expand easily when the angles are
added. You can find this new half aspect grid page layout, named Half Aspect Grid Single Chart [halfaspectgrid.pag], at View / Page Topic Index / Added Recently.
One useful application of this half aspect grid and the grid settings is when you use the
Dynamic / Real Time Clock menu items. Once this screen displays, it begins "ticking
over". By clicking on the Page button, you can double-click on the Half Aspect Grid Single Chart [halfaspectgrid.pag] sitting under the Added Recently topic. By rightclicking over the aspect grid and selecting the Grid Settings item, described above, you
can now see the angles changing, especially the ones associated with the ASC and MC.
Page Object Properties
If you right-click on any graphic object in the "View Chart" window in addition to the
"Chart Options" menu (and "Grid Properties" for aspect grids), you will also see
"Properties of..." as the first item of the menu. The properties depend on what page
object your mouse cursor was sitting over when you right-clicked to display the menu.
The Properties item allows you to modify some of the properties of the page object "inplace" without using the Page Editor. These changes permanently alter the original
settings in the Page design so an understanding of how pages are designed is desirable
in using this feature. See the advanced topics Editing a Page Design File and Changing
Page Object Properties from View Charts for more information.
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Manipulating Calculated Charts
As soon as you create a new chart or retrieve a chart from a chart file, it is "calculated"
and the name of the chart is added to the “Calculated Charts” list on the Main Screen. A
calculated chart is open and ready to view, see reports on, cast subsidiary charts from,
and print. Calculated charts may or may not have been saved to a file.
This section describes certain file-type manipulations that you can do with "Calculated
Charts", even though they may not yet have been saved to a file.
If a calculated chart has not already been saved, it can be saved after being edited or
retained. Once an unsaved chart is removed from the list of “Calculated Charts”, it
cannot be saved or retrieved.

4.6.1 Editing a Calculated Chart
This section describes how to copy and edit, or edit and replace, a natal or event chart
that appears on the list of "Calculated Charts" on the Main Screen. It is not possible to
edit any type of chart other than a natal or event chart or its equivalent. If you wish to
alter any other type of chart you will have to use one of the subsidiary chart options such
as Progressed, Return, Harmonic, etc.
It is also possible to copy and edit, or to edit and replace a chart that is already stored in
a chart file. For instructions on how to do this, see Retrieving Charts From a File.
>> To copy and edit a natal type calculated chart
1. From the Main Screen, select the required chart in the list of “Calculated Charts”.
2. Select the Edit / Copy and Edit item from the Chart menu. (If the selected chart is
not editable, then this option is disabled).
3. The “New Chart Data Entry” dialog box will appear, displaying the details of the
selected chart.
4. Type over whatever details you wish to change.
5. Select the OK button. An edited copy of the original chart will be created and
added to the list of "Calculated Charts". The original chart will remain in the list.
>> To edit and replace a natal type calculated chart
1. From the Main Screen, select the required chart in the list of “Calculated Charts”.
2. Select the Edit / Edit Chart item from the Chart menu. (If the selected chart is not
editable, then this option is disabled), or press the Ctrl+E short-cut key.
3. The "Edit Chart Data” dialog box will appear, displaying the details of the selected
chart.
4. Type over whatever details you wish to change.
5. Select the OK button. An edited copy of the original chart will replace the original
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chart on the list of "Calculated Charts".
Note: Doing this does not edit the chart in the "Chart Database", it simply replaces
the chart in the "Calculated Charts" list (which you had originally opened from the
"Chart Database") with this newly-created edited copy of it. Furthermore this copy is
not saved either, it simply exists as a new chart in "Calculated Charts". If you want to
also have access to the original chart you had opened in "Calculated Charts" you will
have to retrieve it from again from the "Chart Database".
TIP: To edit a previously saved chart you have opened in "Calculated Charts", and at
the same time have those changes saved in the chart file that the chart was opened
from, follow these steps...
1. From the Main Screen, open the "Chart Database" dialog from the Chart menu,
Open option, or by pressing the F3 short-cut key.
2. Find the chart in the database (see Opening a chart) and select it.
3. In the "Chart Database" dialog click on the Edit button. The "Edit Chart Data"
dialog opens.
4. Make sure the checkbox Replace Chart in File is ticked by clicking on it until it is.
5. You can then make changes to the chart fields, and when you are finished click on
the OK button.
6. Click the Cancel button, or press the ESC short-cut key (on the keyboard) to exit
the "Chart Database".
4.6.2 Toggling Zodiac, Lunar Node or Coordinates
If you wish to change the zodiac or lunar node type of a chart that appears on the list of
"Calculated Charts" on the Main Screen, then you can do so via a shortcut, without
having to edit the chart details.
>> To toggle the zodiac (and optionally also house system) of a chart
From the Main Screen, select the required chart(s) in the list of Calculated Charts.
Then either...
From the Chart menu select the Edit, Toggle Chart Zodiac
or...
Right-click on the highlighted chart(s) on the Calculated Charts list and select
Edit, Toggle Chart Zodiac
or...
On the keyboard, press two keys together, Ctrl+Z.
The change is instantly applied to the selected chart/s. See Default Zodiac and Default
House System for information on changing your preferred zodiac and house system for
vedic (sidereal) charts.
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>> To toggle the lunar node of a chart between true and mean
From the Main Screen, select the required chart(s) in the list of Calculated Charts.
Then either...
From the Chart menu select the Edit, Toggle Lunar Node
or...
Right-click on the highlighted chart(s) on the Calculated Charts list and select
Edit, Toggle Lunar Node
or...
On the keyboard, press two keys together, Ctrl+L.
The change is instantly applied to the selected chart(s). However, any new charts you
cast or open will still use the default lunar node type. To change the default lunar node
type, see the Calculations section in Editing Settings.
>> To toggle the coordinates of a chart between geocentric and heliocentric
From the Main Screen, click on the required chart(s) in the list of Calculated Charts
to highlight it/them.
Then either...
From the Chart menu select the Edit, Toggle Coordinates
or...
Right-click on the highlighted chart(s) on the Calculated Charts list and select
Edit, Toggle Coordinates
or...
On the keyboard, press two keys together, Ctrl+K.
The change is instantly applied to the selected chart(s). However, any new charts you
cast or open will still use the default coordinates.
4.6.3 Deleting Charts from the List of Calculated Charts
This section describes how to remove one or more charts from the list of "Calculated
Charts". You might wish to do this if you already have a large number of charts
calculated, and wish to reduce the list of charts to a more manageable size. Any type of
chart may be deleted.
>> To remove one or more charts from the list of “Calculated Charts”
1. From the Main Screen, select the required chart(s) in the list of Calculated Charts
2. Select the Delete item from the Chart menu
3. A dialog box will appear, asking you to confirm whether or not you wish to delete
the selected charts. If you select the OK button, then the charts will be removed.

© 2014 Esoteric Technologies Pty Ltd

Basic Operations

89

4.6.4 Retaining Charts
This section describes how to retain or remove a selection of calculated charts to appear
automatically in the list of "Calculated Charts" in subsequent Solar Fire sessions.
Retained charts are different from saved charts in that any types of calculated charts
may be retained, whereas group composite charts may not be saved to file. Also,
retained charts are stored with all the planetary positions pre-calculated, whereas charts
saved to file must have their planetary positions re-calculated each time that the chart is
opened. Retained charts use much more disk storage than saved charts - about 3000
bytes for each chart, whereas saved charts use only about 300 bytes. Typically it is
useful to retain only a small number of charts that you like to work with frequently.
Retaining a large number of charts uses a lot of space and clutters up the list of
"Calculated Charts". For example, if you frequently work with your own and your
partner’s charts, then you might like to retain both of your natal charts plus your
composite chart, and perhaps also your current solar return charts.
>> To retain one or more charts for subsequent sessions of Solar Fire
1. From the Main Screen, select the required charts from the list of "Calculated
Charts"
2. Select the Retain Chart/s option from the Chart menu
This will display a dialog box asking you to confirm whether or not you wish to retain
the selected charts. If you select the OK button, then these charts will be added to
the list of retained charts for subsequent sessions
>> To clear the retained charts
1. From the Main Screen, select the Clear Retained option from the Chart menu
This will display a dialog box asking you to confirm whether or not you wish to clear
the selection of currently retained charts. If you select the OK button, then no charts
will be retained for subsequent sessions.
Note that these options have no effect on the list of "Calculated Charts" during the
current session. They only take effect when Solar Fire is next started up.
4.6.5 Cloning Charts
Cloning charts is a process where you can keep in view a copy of one or more chart
wheels you are interested in. Sometimes you might be in one of the many screen reports
in Solar Fire and wish to see instantly see the chart wheel rather than closing the reports
you are studying. By using the "Clone" feature after you open or enter a chart, you can
now keep any number of copies of the chart wheel on screen for an instant reference.
This feature is particularly useful if you have more than one monitor on your computer
or have a monitor that is large and has a lot of screen "real estate" to display things.
Solar Fire also remembers the position and size of previous clone windows and
automatically creates new clone windows in those positions with those sizes.
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>> To Clone a chart for viewing
From the Main Screen:
Either...
A. Select and highlight the required chart in the list of Calculated Charts (only one
highlighted chart at a time).
Then either...
From the Chart menu select the Clone item
or...
On the keyboard, press two keys together, Ctrl+O.
TIP: Once you've cloned a chart in this manner you keep repeatedly cloning more
copies of it if you want, without having to first highlight it (as it's already
highlighted).
OR...
B. Right-click on a chart on the Calculated Charts list and select Clone
Once the chart wheel appears in a separate smaller window, you can move this window
to other parts of the screen or resize it by using the mouse.
>> To reposition or resize a Clone window
1. To reposition a clone window using the window title bar you can just drag the
window to where you want it.
(To drag a window : hold the mouse cursor over the window's title bar, push the
left mouse button down, hold it down, and then drag the window to where you
want it, then release the left mouse button).
2. To resize a clone window drag on the window's borders, or the bottom right hand
corner of the window, to expand or shrink it.
(To drag a window border : hover the mouse cursor over one of the borders until
the cursor changes to a thin black horizontal line with a small arrowhead on
each end. Push the left mouse button down, hold it down, and then drag the
window border in or out to where you want it, then release the left mouse
button).
(To drag a window corner : hover the mouse cursor over the bottom right corner of
the window until the cursor changes to a thin black diagonal line with a small
arrowhead on each end. Push the left mouse button down, hold it down, and
then drag the window corner in any direction to where you want it, then release
the left mouse button. Dragging the corner diagonally upwards towards the
opposite corner is the quickest way to resize the window to it's smallest size).
>> To close the cloned chart window
Click on the X button at the top right of the cloned chart window.
Note: at the bottom left corner of the cloned window, you will see the option "Always on
top". By default, this option is ticked so that it is always in view even if other windows
are opened - it always remains on top of other windows. If you click this option, to take
away the tick mark, this window will be placed behind any other larger windows that you
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may subsequently use.

4.7

Saving Charts to a File
This chapter describes how to save a calculated chart to a chart database file, so that it
may be opened again in subsequent sessions with the Solar Fire program.
You can save charts of all types created in Solar Fire apart from multiple composite
charts. Although these types of charts cannot be saved to a chart database file, you may
still retain them for use in subsequent sessions of Solar Fire. See Retaining Charts for
details on how to retain charts.
The Chart Details display box on the Main Screen indicates, in the notification area in
the bottom left corner, whether or not the chart can be saved, and if it can be saved whether it has already been saved or is retained. Hovering the mouse over the
notification area shows extra information about the chart's saved status, e.g. the chart
file it is saved in.
It is possible to save as many copies of a chart as you wish, either to the same chart file
or to a different one. (See Using the File Manager for information about how to create
new chart files.)
Note that if the Auto Chart Save option is switched on, then all new or edited charts will
be saved automatically to the currently selected chart file as soon as they are cast. See
Auto Chart Save for more information about this option.
>> To save one or more charts from the Main Screen
1. Select the required chart or charts from the list of "Calculated Charts"
2. Select the Save to File item from the Chart menu, or press the F12 short-cut key
3. If you are saving a single selected chart, and that chart is already saved, then a
dialog box will appear asking you to confirm whether you wish to save another
copy of the chart. If you are have selected more than one chart to save, then you
will not be asked to confirm whether to re-save any saved charts.
4. The "File Manager" will appear, listing all of the available chart database files.
Select the required chart file from this list, or click on the Create button to create a
new empty chart file, and then click on the OK button.
>> To save the currently displayed chart in the “View Chart” screen
Select the Save button and then follow step 4 above.
>> To save any unsaved charts before exiting from Solar Fire
When you exit from Solar Fire you will be asked whether you want to save any charts
that have not yet been saved. If you choose not to, then the program will close
immediately. Otherwise the "Unsaved Charts" dialog will appear.
>> In the "UnSaved Charts" dialog - to select a different chart file to save
charts into
1. Click on the File button
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This will display the "File Manager", from which you can select another chart
file or create a new one.
>> To save one or more charts to the displayed chart file
1. Highlight the charts you wish to save to this file.
2. Click on the Save button.
Once the charts are saved they will disappear from the list, leaving only any
other unsaved charts. If no unsaved charts remain, then the program will close.
>> To exit without saving any more charts
1. Click on the Discard All button.
The program will close without saving any remaining charts.
>> To go back to Solar Fire without closing
1. Click on the Cancel button.

4.8

Retrieving Charts From a File
This chapter describes how to find and select charts from your Solar Fire chart files, so
that you can view, work with, edit and print them.
Whenever you retrieve a chart from a file, you do so from the “Chart Database” dialog
box. This dialog box is also a gateway to editing and manipulating chart files.
>> To display the Chart Database dialog box
Select Open from the Chart menu, or press the F3 short-cut key.
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Whenever this screen is displayed, the list box on the left of the screen contains a list of
all the chart names that are stored in the currently selected chart database file. The
name of the currently selected chart database file is displayed in the box to the right of
the File button, and its descriptive title (if it has one) is displayed below this. The
number of charts stored in this file is shown in the Charts box. If there are no charts in
this file then the number of records will be zero, and no chart names will appear in the
list box. The number of charts that have been selected for copying, deleting or opening is
shown in the box titled Selected.
4.8.1 Choosing Chart Data Columns to Display
In the "Chart Database" it is possible to select a range of different columns to display in
the chart list, to rearrange the order of the columns and to re-size them. Any column
rearrangement you make is remembered for future sessions.
>> To resize the width of a column
1. Use the mouse to drag the column border between any two column headers, or
2. Double-click on a column border to make the column automatically re-size to fit the
largest item of data that is displayed in that column.
>> To edit the column selection and order
1. Use a right hand mouse click when the cursor is over the column headers.
2. This will display the "Choose Columns" dialog.

You can select or unselect any of the available columns by either clicking in the
checkbox to the left of the column name, or by using the Show or Hide buttons.
You can change the order of a column by highlighting it and then using the Move Up or
Move Down buttons to re-order it relative to the other columns.
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Note: The Name column must always be the first, and it is not possible to change its
order.
Note: If the selected column’s widths are cumulatively wider than the displayed width of
the list, a horizontal scroll bar will appear at the bottom of the list, allowing you to scroll
to see the extra columns. Alternatively you can increase the displayed width of the list
by resizing the width of the entire dialog.
4.8.2 Selecting the Required Chart File
In the "Chart Database" if the chart that you want is not in the current chart file, then
you can select another file to look in.
>> To select a recently used chart file
Click on the down arrow button to the right of the File button.
This will display a pop-up menu with a list of the ten most recently used chart files,
sorted in order of access with the most recent at the top. Select an entry from this list
to re-open that chart file.
Note: If any chart files in this list are in different folders to the folder of your current
chart file, then their folder paths will be displayed on the menu. Any chart files on the
list that are in the same folder as your current chart file will not have any folder path
displayed.
>> To select a different chart file
Select the File button.
This will display the “File Manager” dialog box with a list of chart database files from
which it is possible to select an existing chart file or create a new one. See Using the
File Manager for instruction on using the "File Manager".
The chart file that you have selected becomes the "current" (default) chart file.
Whenever you open the "Chart Database" this is the file that will be pre-opened and
it's charts will be displayed in the list of charts.
4.8.3 Searching All Chart Files
Solar Fire can also search through all your chart files at once for any chart or charts with
the same string of characters in the chart name.
In the "Chart Database"...
>> To search through all chart files in a folder
1. Select the Search All Files button.
2. In the displayed dialog box, type in the series of characters that you wish to find
(e.g. type in “kennedy” to find all charts with Kennedy in their name), and select
the OK button. Alternatively, to re-access a recently used search string, click on
the down arrows of the drop down box and select an item from the presented list.
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3. All of the valid chart files in Solar Fire’s current chart folder (i.e. the folder or folder
in which the currently selected chart file resides) will be searched, and the results
are displayed in the "Chart Search Results" dialog.
4. You can double-click any chart in the list to open it (i.e. to add it to the list of
"Calculated Charts" on the Main Screen). There are various other options available
here – see Working with the Results of a Chart Search for a full explanation of all
the options available to you in the "Chart Search Results" dialog.
Note: If you wish to search all chart files in a different folder, then you can do so by first
selecting a chart file that resides in that folder. Alternatively, you can control precisely
which chart files are searched by using the "Chart Search" facility from Solar Fire’s Main
Screen, instead. (See Chart Search).
4.8.4 Finding a Chart in the Current Chart File
In the "Chart Database" the "Stored Charts" list box (underneath the "File" button)
displays a list of all the chart names that are in the current chart file. You can use any of
the following ways to help find the required chart or charts.
Scroll the list by using the scroll bar on the right hand side of the list box.
Jump to the beginning entry for any letter of the alphabet by selecting any chart on
the list and then pressing the key for the letter you want. Hit the same key to move
through each successive entry beginning with the same letter.
Use the Find button to find charts with any character string in their name or in their
chart comments, or to find charts with certain planetary placements or aspects.
Sort the list in various ways to make finding charts easier, by clicking on the Name,
Date or other column headers and using the Reverse Chart Names and Descending
Sort Order check boxes.
The sort options have the following effects...
"Name" will list charts in either alphabetical order of their listed names, or in the
order in which the charts are stored in the file. Subsequent selection of this option
will toggle between these sort modes.
"Date" will list charts in order of their date and time.
"Other column headers" will list charts in the order of the value of that columns. For
example, the Zodiac column sorts the charts into alphabetical order of the zodiac
type name.
Reverse Chart Names" will display the listed chart names starting with the last
distinct character string (i.e. preceded by at least one blank) in each chart name as
it was entered. e.g. an entered name of “Bill Clinton” is displayed as “Clinton, Bill”.
If this option is not checked, then the chart names are shown exactly as they were
entered. (Note that the titles of charts that are marked as Horary or Event charts are
not affected by this option – they are always displayed exactly as they were
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entered.)
"Descending Sort Order" will list the charts starting from the highest value to the
lowest value i.e. from Z to A, from last date to earliest date, from last chart entered
to first chart entered. If this option is not checked, then the charts will be listed in
ascending order of the current sort option, instead.
4.8.4.1 Searching for Character Strings

In the "Chart Database"...
>> To find charts containing certain character strings in their names or comments
1. Select the Find button.
2. From the drop-down menu, select one of the following options
Next Chart Name with - to select the next chart on the list (after the currently
highlighted chart) which contains a specified character string in its name
All Chart Names with - to select all the charts on the list which contain a
specified character string in their name
Next Chart Comment with - to select the next chart on the list (after the
currently highlighted chart) which contains a specified character string in its
comments
All Chart Comments with - to select all the charts on the list which contain a
specified character string in their comments
3. In the displayed dialog box, type in the series of characters that you wish to find
(e.g. type in “kennedy” to find all charts with Kennedy in their name, or “athlete”
to find all charts with the word athlete in their comments), and select the OK
button.
4. If any chart or charts are found with the specified string, then they will be selected
(highlighted) on the list. It is then possible to open, copy or delete all of these
charts using the appropriate buttons.
4.8.4.2 Performing an Advanced Search for Chart Details or Astrological Criteria

In the "Chart Database" you can search for charts in the current chart file or other chart
files using a variety of advanced criteria.
>> To enter the “Chart Search” dialog box
1. Select the Find button.
2. From the drop-down menu, select the Chart Search option
This displays the Chart Search dialog. See Chart Search for a full explanation of this
advanced feature.
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4.8.5 Selecting Charts Manually
In the "Chart Database" a chart is selected by clicking the mouse onto its name in the
Stored Charts list box (underneath the "File" button). A selected chart is shown in the
list box with a reverse video, highlighted entry. It is possible to select any number of
charts to open, copy, delete or print a summary, by one of two methods...
a) to select charts at random (non adjacent) places in the list:
hold down the Ctrl key whilst clicking with the left mouse button on subsequent
charts in the list. Any selected chart may also be de-selected by clicking on it again
whilst holding down the Ctrl key.
b) to select charts in a contiguous block in the list:
click on the first chart in the block, hold down the Shift key, click on the last chart in
the block, then release the Shift key.
>> To select all the charts in the current file
Click on the Select All button.
>> To deselect all selected charts
Click on the Clear button.
Note: The chart "Edit" button is only enabled if a single chart has been selected, because
it is not possible to edit multiple charts simultaneously.
4.8.6 Opening Charts
Any number of selected charts from the current chart file may be opened and added to
the list of "Calculated Charts" in the Main Screen. If opening a single chart, you can also
automatically view it in a wheel as well.
>> To open a single chart from the list of Stored Charts
Select the required chart and then click on the Open button, or double-click on the
required chart.
>> To open multiple charts at once
Select all the required charts and then click on the Open button.
>> To open a single chart, and immediately view it as a wheel
Select the required chart and then click on the Open+View button.
This is simply equivalent to opening the chart, and then choosing Current Chart from
the View menu.
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Manipulating Charts in Files
This section gives you the tools to keep your chart files up-to-date and organized. It
shows how to correct a chart that has been incorrectly cast; how to add comments to a
stored chart, such as notes on the source of the data, biographical notes or other client
notes; how to copy, delete and move charts from one file to another; how to add a
descriptive title to a chart file, making it easier to tell what the file contains; how to print
a summary of charts contained in a file.
The instructions in this section assume a basic knowledge of how to find, select and
open charts. See Retrieving Charts From a File for further information.

4.9.1 Editing Chart Details
Instead of opening a chart exactly as it is stored in the chart file, you may wish to
change some of the chart’s details, for example to correct an incorrect birth time, or to
specify a different location, house system, zodiac or event type for the chart.
>> To edit a chart
1. Select a single chart, and then click on the Edit button.
This will display the “New Chart Data Entry” dialog box with the data from the
selected chart. Type any new data over the existing data.
>> To replace the stored chart with the newly edited chart
Select the Replace Chart in File option by ensuring that it is checked.
The original chart will be overwritten with the newly edited details
Note: This option will now remain checked for the duration of this session in Solar
Fire or until you uncheck it.
>> To create a separate copy of the edited chart
Do not select the Replace Chart in File option (ensure that it is unchecked).
The original chart will remain the same in the chart file, and a new chart will be
opened with the newly edited details. To keep a permanent copy of this new chart
you will need to save it to a file yourself. See Saving Charts to a File for further
instructions on saving files.
2. Select the OK button.
>> To alter one or more chart’s event type
Select one or more charts by highlighting them, and then use the shortcut keys shown
below to set the selected chart/s event type.
Ctrl+F1 - Unspecified
Ctrl+F2 - Male
Ctrl+F3 - Female
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Ctrl+F4 - Event
Ctrl+F5 - Horary
4.9.2 Copying Charts
You can copy any number of charts from the current chart file into any other chart file,
either existing or new.
>> To copy charts into another file
1. Select the required charts
2. Click on the Copy button. This will display the "File Manager" with a list of target
chart files.
3. Either select one of the files on the list, or select the Create button to create a
new empty chart file to copy the charts into.
4. A "Copy Charts" dialog box will be displayed, asking you if you want confirmation
for each individual chart before copying it.
5. You can choose from the following options...
Yes - One by one, for each selected chart in sequence, a dialog box will be
displayed asking whether or not that individual chart should be copied.
No - All of the selected charts are copied immediately
Cancel - Cancel - no charts are copied
Note: When charts are copied to another chart file, any chart comments that are
associated with the charts are copied as well.
4.9.3 Deleting Charts
>> To delete charts from the current chart file
1. Select the required charts
2. Click on the Delete button, and choose the Selected Charts item from the dropdown menu
3. A "Delete Charts" dialog box will be displayed, asking you if you want confirmation
for each individual chart before deleting it.
You can choose from the following options...
Yes - One by one, for each selected chart in sequence, a dialog box will be
displayed asking whether or not that individual chart should be deleted.
No - All of the selected charts are deleted immediately
Cancel - Cancel, none of the charts are deleted
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>> To remove duplicate copies of charts from the current chart file
The process is the same as above, except instead of choosing the Selected Charts item,
choose the Duplicate Charts item from the drop-down menu.
Note: Charts are considered to be duplicates if they have the same basic chart details
(Name, date, time, location, house system, zodiac etc.). However, special conditions
apply if the comments associated with each of the duplicate charts are different: If
comments are present on only one of the charts, then those comments are retained.
However, if comments are present on both charts, but are different, then only the
comments from the chart that is stored later in the file will be kept.
4.9.4 Moving Charts
>> To move charts from the current chart file to another chart file
First copy the charts to the new file, and then delete them.
4.9.5 Adding or Editing Chart Comments
You can add permanently saved comments to any chart. These comments are displayed
in the Chart Comments box whenever the chart is highlighted in the list of Stored
Charts.
>> To add or enter comments for a chart
1. Select the required chart from the list of Stored Charts
2. Click inside the Charts Comments box, or select the Comments… button
This will display the comments editing dialog where you can type in whatever text you
wish
Any changes that you make are permanently saved when you select the Save button. You
can enter up to about 30,000 characters of text (which is equivalent to about 10 pages of
typewritten text).
4.9.6 Changing the Chart File Description
To aid in identifying and selecting chart files, any Solar Fire chart file can have a
description of up to 80 characters. When a new chart file is created it is given a default
description - "New Chart File". You can overwrite this with your own description.
This description is displayed in the "File Manager", as well as on the “Chart Database”
screen. However, note that you cannot enter a description for Solar Fire chart files which
are v2 (Standard Edition) format or earlier.
>> To add or edit a chart file description
Click inside the chart description box above the list of chart names, and type in
whatever you want. Any changes that you make are permanently saved as soon as
the cursor leaves the description box.
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4.9.7 Printing a Summary of Charts in a File
You can print out a summary listing of any or all charts contained within a single chart
file. The summary may be printed at three different levels of detail:
Brief Listing - Each chart occupies a single line of output, and contains only the
essential details that would be required to recast the chart: Name, date, time,
timezone, latitude and longitude.
Full Listing - Each chart occupies two lines of output, and contains the same
information as the brief listing plus the coordinate system (geocentric/heliocentric),
zodiac type, house system, place name and country/state.
Full with Comments - The details of each chart occupy two lines of output, containing
the same information as the full listing, and any chart comments that are associated
with the chart occupy additional text lines below the chart details.
>> To print a summary of all charts in the current chart file
1. Select the Print Details button and from the drop-down menu select the All Charts
option.
2. Select the Print Details button and from the drop-down menu select one of the
listing options Brief Listing, Full Listing or Full with Comments.
3. The “Print” dialog box will appear, from which you can alter printer settings, add
this job to the print queue, or print it immediately. See Printing from Solar Fire for
further information on printing.
>> To print a summary of only the selected charts in the current chart file
1. Select the Print Details button and from the drop-down menu select the Selected
Charts Only option.
2. Proceed as in steps 2 to 3 above.
4.9.8 Chart File Limitations
The number of charts which can be stored in a single chart file is about 64,000.
As a general recommendation, it is suggested that you save no more than several
thousand charts in any one chart file. This will ensure that Solar Fire’s performance
remains good, and avoids the likelihood of the chart file limitations ever being reached.

4.10

Using the File Manager
This chapter describes how to use the "File Manager". The "File Manager" is a common
access point to various file management functions for all the file types which exist
within the program. It is possible to create new files, delete existing files, copy files,
rename files or select files to be the current file, from within the "File Manager". For
certain file types it is also possible to edit the file.
© 2014 Esoteric Technologies Pty Ltd

102

Solar Fire 9 User Guide

The "File Manager" is accessed from a variety of different menu options and screens
within the program.
Choosing any of the following types of options from the Main Screen menu, or from other
locations in Solar Fire, will invoke the "File Manager".
Chart File
Displayed Points
Displayed Transiting Points
Extra Ring Points
Aspect Set
Aspected Points
Fixed Star File
Arabic Parts File
Asteroid File
Extra Bodies File
Wheel Styles
Dial Styles
Point Colors
Aspect Colors
Sign Colors
Interpretations File
In the dynamic report selection and graphic ephemeris selection screens, clicking on any
of the following boxes will also invoke the file manger.
Transiting Points
Extra Transiting Points
Progressing Points
Extra Progressing Points
Radix Points
Extra Radix Points
Transiting Aspects
Progressing Aspects
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The "File Manager" will also be invoked if the "File" button is selected from any screen.
When the "File Manager" screen appears its title line will display the name of the file
type that has been chosen, and the list box will contain an entry for each file name of
this file type. The file name that is highlighted is always initially the "current" file (i.e.
the last selected file). If there are no files of this type then the list box will be empty,
and it will only be possible to create files.

The "File Manager" dialog can be resized horizontally or vertically as required by
dragging its borders with the mouse. It is possible to leave the "File Manager" at any
time by selecting the Cancel button.
4.10.1 Selecting a File
In the "File Manager" selecting a file then clicking the OK button causes the contents of
that file to be read into the program to be used wherever appropriate for that type of
file.
For example selecting a file of the "Displayed Points" type, called (say) "plan&ast.pts",
updates the list of points that will be displayed on any subsequently drawn chart with
the points in this file. This file now also becomes the "current" file wherever this type of
file ("Displayed Points" type in this example) is used in the program.
If the "Current Settings" panel on the Main Screen displays the current setting for this
type of file, then as soon as it's selected it's name is updated in the "Current Settings"
panel showing it is currently being used (e.g. for "Displayed Points").
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>> To select a file
Select a file from the list of file names and click on the Select button, or doubleclick on a file on the list of file names.
If you are selecting a chart file, then you also have the option of choosing a folder to
look in first. After file selection, the "File Manager" screen is hidden.
Note: If you need more space to see long file or folder names, then re-size the dialog box
by hovering the mouse over a border until the cursor is a left-right arrow, then click the
left mouse button and holding it down, drag the border to the desired position, then
release the mouse button.
4.10.2 Selecting a Folder
When selecting Chart files in the "File Manager", it is possible to access folders other
than Solar Fire’s User Files folder. This can be useful if you wish to read from or save
charts to a CD/DVD, networked computer, or any other location on your own computer,
for example.
>> To select a folder (also known as a "directory")
If the folder selection box is not already visible, then click on the Folder button to
make it visible.
You can select an alternative drive by finding it on the drop-down list box of drives,
and any folder on that drive by navigating through the folders on that drive.
>> To re-select a recently used folder
Click on the down arrow button to the right of the Folder button.
This will display a pop-up menu allowing you to select from any of the ten most
recently used folder names.
4.10.3 Creating a File
In the "File Manager"...
>> To create a new file
Select the Create button.
This will display the "Create File" dialog box, which allows the entry of the file name to
create. Note that the file name must be a valid file name, without a file extension (the
"File Manager" automatically adds the appropriate file extension for this file type). A
valid file name can consist of up to 80 characters. If the name is not valid then an error
dialog box will be displayed.
When the file has been created its name is added to the list of file names on the "File
Manager" screen, and it may be edited if it is of an edible file type.
The initial contents of a newly created file depend on the file type:
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For a "Charts" file, the file will be empty after it is created, and it will be possible to
add entries by saving charts.
For "Displayed Points", “Displayed Transiting Points”, "Aspected Points", "Radix
Points", "Transiting Points" and "Progressing Points" files, the file will contain a
selection of points containing all the planets, Chiron, the North Node, the
Ascendant and the Midheaven.
For "Point Colors", "Aspect Colors" and "Sign Colors" files, the file will contain
colors all set to black.
For "Aspect Set" files, the file will contain a list of standard 12th harmonic aspects.
It is not possible to create an "Interpretations” file. If you wish to do so, you must
use the "Interpretation Compiler", which is a separate utility program. (See
Interpretations Compiler in Advanced Operations).
If you wish to create a new file that is to be only slightly different from an existing file, it
may be easier to copy the existing file and naming the copy with new file name instead
of creating the file from scratch. This will result in less editing being required.
4.10.4 Deleting a File
In the "File Manager"...
>> To delete a file
1. Select the file from the list of file names.
2. Select the Delete button.
This will display a dialog box asking for confirmation of deletion. When the file has
been deleted its name is removed from the list of names on the "File Manager"
screen.
4.10.5 Copying or Renaming a File
Copying a file results in a new file being created with a copy of the contents of the
selected file, whereas renaming a file results in the name of an existing file being
changed.
It is possible to use these options to copy or rename files to or from floppy disks or other
folders on the computer's hard disk.
In the "File Manager"...
>> To create a copy of an existing file under a new file name
1. Select a file from the list of file names
2. Select the Copy button
This will display a standard file save dialog box allowing you to enter a new name
and/or location
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>> To rename a file
1. Select a file from the list of file names
2. Select the Rename button
Then follow the same procedure as for copying a file.
Note: If any files other than chart files are copied or renamed to other folders or floppy
disks then the "File Manager" will not be able to display them in its list of selectable
files. The "File Manager" only displays the names of files that are in the Solar Fire’s
default Solar Fire User Files folder.
4.10.6 Editing a File
You can edit the contents of any file for which the Edit button in the "File Management"
dialog box is enabled. It is not possible to edit "Chart" files from the "File Manager".
Charts files can only be manipulated in the "Chart Database" screen.
The manner in which each of the various file types can be edited is described in other
sections.
4.10.7 Merging Chart Files
You can merge chart files together into a single chart file. This is especially useful if
you’ve been working on different computers; you may find that you’ve added some
charts to Solar Fire on one machine and added others to Solar Fire on another machine,
and want to get them into a single file you can use on either or both machines. You can
merge as many chart files as you like into a single file.
NOTE: This merging of chart files into one file also is available as an automatic option
when importing charts and settings (see Importing Charts, Files and Settings).
>> To manually merge chart files together
1. From the Main Screen click on the Chart menu.
2. Click on the Open menu item, and the "Chart Database" dialog box will open.
3. Click on the File button in the upper left corner to display the "File Management"
dialog box with a list of your chart files.
4. Select the chart file you want to merge charts into (from other files) by clicking on
it - see Selecting a File for info on how to find and select the file you want. If the
file you want to merge charts into doesn't exist then create it (see Creating a File
for more info).
5. Click on the Merge button. This opens the "Chart Merge Utility" dialog box.
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The list on the left shows all the chart files in the current folder. To see other chart
files in other folders change the folder (see Selecting a Folder). The file that will
receive all the charts from other files (the destination chart file) is shown in blue in
the bottom right of the dialog box.
The list on the right shows all the files whose charts will be merged together (in the
destination chart file, along with whatever charts are already in the destination
file). This is the "merge list" of files and are they are in bold.
6. For each chart you want to add to the merge list (on the right) click on the file in
the left list and then click on the Add button. The file will be added to the merge
list on the right. Alternatively you can double-click on the file and it will be
automatically added to the merge list. Or you can select many files by one of two
methods (see below) and then click the Add button.
a) to select files at random (non adjacent) places in the list:
hold down the Ctrl key whilst clicking with the left mouse button on subsequent
files in the list. Any selected file may also be de-selected by clicking on it again
whilst holding down the Ctrl key.
b) to select files in a contiguous block in the list:
click on the first file in the block, hold down the Shift key, click on the last file in
the block, then release the Shift key.
7. The process is the same for removing files from the merge list. Select the file(s)
first then click on the Remove button (double-clicking doesn't apply for this part of
the process).
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8. Once you have the destination file selected (shown underneath the right hand
"merge list"), and the files whose charts are to be merged displayed in the merge
list above, you can click on the Merge button and copies of the the charts will be
created in the destination chart file. A message will let you know the number of
charts that were merged in this way. Click on the OK button and the "Merge"
dialog will close.

4.11

Generating Chart Reports and Tabulations
This chapter describes how to view and print any of Solar Fire’s report or tabulation types
relating to a single chart or synastry report types relating to two charts. It is not possible
to generate a report relating to more than two charts at a time.
If you wish to generate dynamic transits and progressions reports, rather than a chart
report, then refer to Using Dynamic Reports and Time Maps.
Before generating a report, it is necessary to have either cast or opened the chart or
charts that you wish to report on. If you have not yet done so, see Casting a Natal Chart
for instructions on casting a new chart, or page Retrieving Charts From a File for
instructions on opening an existing chart.
Also it is necessary to have selected the required set of displayed chart points and
aspects to be used in generating the report. See Displayed Points for instructions on
selecting the set of displayed points and Aspect Set regarding the aspect set.

4.11.1 Descriptions of the Reports
These are the different types of reports you can choose from in Solar Fire. To view any of
these reports see Viewing Reports or Tabulations for a Single Chart.
Chart Analysis
Chart details: name, birth date, birth time, latitude, longitude, etc.
Astronomical information: DeltaT, Ephemeris Time, Julian Day, Sidereal Time at
Greenwich, Local Sidereal Time, Obliquity of the ecliptic, Adjusted Calculation Date
for midnight and midday ephemerides.
Chart angles: the longitudes of the Ascendant and Midheaven computed to the
second of arc.
House cusps: the longitudes of the intermediate house cusps and angles computed
to the second of arc.
Chart points: longitudes, daily travel, latitudes, declinations, azimuths and altitudes
of all planets and points selected.
Stationary Points: for any points deemed stationary, shows the distance from exact
station in time and longitude
Lunar phase: the Sun/Moon angle and its phase out of 8 and 28 phases.
Sign Elements and Modalities analysis: weighted points showing the concentration
of planets and points in Fire, Earth, Air and Water; Cardinal, Fixed and Mutable.
House Modalities analysis: weighted points showing the concentration of planets
and points in Angular Succedent, Cadent.
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Chart Shape: name of chart shape, if any
Note: In the Chart point listing, the daily travel values are normally given in degrees and
minutes per day. However, if the rate of travel is less than 1 degree per day, then it is
given in minutes and seconds of arc per day instead.
Note: In the Chart points listing, the following flags may be shown immediately after the
longitude:
(no flag) - Direct, not within orb of a station
R - Retrograde, not within orb of a station
SD - Within orb of a station - Direct, following the exact station
DS - Within orb of a station - Direct, prior to the exact station
SR - Within orb of a station - Retrograde, following the exact station
RS -Within orb of a station - Retrograde, prior to the exact station
Rulerships Report
This report is available using any available level of rulerships. (It is possible to add your
own rulerships to Solar Fire. Refer to page Changing Rulerships and Weightings for
instructions on how to do this.) It shows the following:
Planets: accidentally dignified, in mutual reception, in rulership, detriment,
exaltation and fall, and the final dispositor.
Chart points: in signs, house, house ruled, dispositor and dispositor's house.
Horary Report
Planetary day, planetary hour, hour of day or night
House Cusps: Almutens (calculated according to the options in the houses.alm
almuten definition file)
Chart Points: Ruler, Exalted, Triplicity, Term, Face, Detriment, Fall, Score, Peregrine
(calculated according to the options in the essdig.alm dignity definition file)
Chart Hyleg: according to Bonatti’s method and Ptolemy’s method.
Aspects List
Aspects used: aspect abbreviation or glyph, aspect angle, luminary applying and
separating orb (Sun/Moon to other planets), other planet or chart point applying and
separating orb, aspect name.
Aspects list: listing of aspects in order from the Moon to the Lunar South Node,
showing orb and whether applying or separating.
When this report is produced as a synastry report, aspects shown are between the
two charts instead of between planets within the single chart.
Sorted Aspects
Aspects used: aspect abbreviation or glyph, aspect angle, luminary applying and
separating orb (Sun/Moon to other planets), other planet or chart point applying and
separating orb, aspect name.
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Orb used: maximum orb angle
Aspects list: listing of aspects in order of increasing orb and whether applying or
separating.
When this report is produced as a synastry report, aspects shown are between the
two charts instead of between planets within the single chart.
Aspects Analysis
Aspects used: aspect abbreviation or glyph, aspect angle, luminary applying and
separating orb (Sun/Moon to other planets), other planet or chart point applying and
separating orb, aspect name.
Major aspect patterns found: Click on the Patterns… button to preview all the
available aspect patterns and to switch any patterns on or off.
Aspect distribution grid: the number of aspects found among the inner planets,
outer planets, and angles.
Aspect frequency analysis: aspect type, actual aspect hits, likely aspect hits, and
the percentage of difference from expected frequency of aspect hits.
When this report is produced as a synastry report, aspect patterns do not appear on the
report, and the aspect distribution relates to aspects between the two charts.
Note: The "Orb Tightness" of each pattern indicates how close the aspects involved in
the pattern are to being exact. A value of 100% would indicate that all the aspects in the
pattern are exact, whereas a value of 0% would indicate that all the aspects are at the
outer limit of their allowable orbs. In more technical terms, it uses an RMS (root mean
square) value of the normalized orbs (where normalized means the ratio of actual orb to
maximum allowable orb).
Chart Point Sort
Modulus used: modulus angle
List of chart points: In order of modulus angle, including zodiacal positions
When this report is produced as a synastry report, the points from both charts are listed
together, and are flagged to show which chart they belong to.
Sensitive Points
Aspects used: aspect abbreviation or glyph, aspect angle, luminary applying and
separating orb (Sun/Moon to other planets), other planet or chart point applying and
separating orb, aspect name.
List of sensitive points: zodiacal position, aspect made, chart point aspecting this
position
This report is especially useful for quickly finding what is being triggered in a chart by
a transiting planet, for example. It is also useful simply as a list of what points in the
zodiac are sensitive in chart.
MidPoint Listing
Modulus used: modulus angle
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List of midpoints: In planetary order, modulus angle
List of midpoints: In midpoint order, modulus angle
When this chart is produced as a synastry report, the midpoints from the first chart are
mixed with the primary positions (i.e. the positions of the chart points themselves) of the
second chart, and these are flagged to show which chart they belong to. In this manner it
is possible to see the positions of the transiting planets relative to a chart's midpoints,
for example.
MidPoint Axes
Modulus used: modulus angle
Orb used: orb angle
List of Axes: In planetary order down the screen. Midpoints within orb are listed
across the page (and onto next line if line is full).
Example: *Ura* Vp/Sat 0 02d *ASC* 0 05 Mar/Jup 0 09
This shows that Uranus is within 2 minutes of arc of the midpoint of the Vernal Point
(0 Aries) and Saturn; within 5 minutes of arc of the Ascendant; and within 9 minutes
of arc of the midpoint Mars and Jupiter, within the modulus specified. Also note that
the "d" indicates that the midpoint is a conjunction or opposition, regardless of the
modulus chosen.
MidPoint Trees
Modulus used: modulus angle
Orb used: orb angle
List of Trees: In planetary order across the screen. Midpoints within orb are listed
down the page under each point.
Example, showing the same midpoints as in the previous example:
*Ura*
Vp/Sat 0 02d
*ASC* 0 05
Mar/Jup 0 09
Midpoint Modes
Cardinal Points: Zodiacal position of chart points and midpoints which are in
cardinal signs, plus modulus angle of points which are in semisquare or
sesquisquare to chart points and midpoints.
Fixed Points: As for cardinal points
Mutable Points: As for cardinal points
This report is especially useful for quickly finding any 8th harmonic aspects to
midpoints in a chart.
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Mar/Nep 14Li59 Mer/Nod 15 25
... then a transiting point at 15Cp00is square the Mar/Nep midpoint in the chart
with an orb of 1 minute, and is either semisquare or sesquisquare the Mer/Nod
midpoint with an orb of 25 minutes.
Arabic Parts
Aspects used: aspect abbreviation or glyph, aspect angle, luminary applying and
separating orb (Sun/Moon to other planets), other planet or chart point applying and
separating orb, aspect name.
List of Parts: Name and zodiacal position
List of Aspects: Aspects to chart points, orbs
Star Aspects
Aspects used: aspect abbreviation or glyph, aspect angle, luminary applying and
separating orb (Sun/Moon to other planets), other planet or chart point applying and
separating orb, aspect name.
Chart Points: Zodiacal position and declination
List of aspects: Aspects to fixed stars in current fixed star file, orb and star
keywords
Star Parans
Parans Used: List of which parans are included (rise, set, upper culmination, lower
culmination)
Paran Orb: maximum paran orb
Chart Points: Zodiacal position and declination
List of parans: Parans to fixed stars in current fixed star file, star keywords
Planetary Nodes
Aspects used: aspect abbreviation or glyph, aspect angle, luminary applying and
separating orb (Sun/Moon to other planets), other planet or chart point applying and
separating orb, aspect name.
Chart Points: North node position and daily travel, South node position and daily
travel
List of aspects: Aspects to other chart points, in order of increasing orb
Asteroids
Aspects used: aspect abbreviation or glyph, aspect angle, luminary applying and
separating orb (Sun/Moon to other planets), other planet or chart point applying and
separating orb, aspect name.
List of Asteroids in current asteroid file: Longitude, daily travel, latitude, R.A. and
Declination, list of aspects from asteroid to other chart points, orbs
Other Bodies
Aspects used: aspect abbreviation or glyph, aspect angle, luminary applying and
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separating orb (Sun/Moon to other planets), other planet or chart point applying and
separating orb, aspect name.
List of Bodies: Name, longitude, daily travel, latitude, R.A. and Declination
List of Aspects: Aspects to chart points, orbs
The bodies which appear in this report are those whose orbital elements are defined
in a file called “extras.dat”, which resides in Solar Fire’s \Solar Fire User Files\Points
& Colors folder. If you have adequate knowledge of orbital elements, it is possible to
add or remove bodies from this file, and these changes will be reflected in this report.
See Format of the Orbital Elements File for an explanation of the format of this file.
MWA (Munkasey Midpoint Weighting Analysis)
Total Hits, Midpoints in weighted order, Hits in weighted order, Planets in weighted
order, sign weights, house weights, harmonic weights.
Unlike the original MWA that includes all of Munkasey’s PSPs (personal sensitive
points), this version of the report uses only the currently selected chart points.
The weightings are specified in the file MWA.INI in Solar Fire’s Settings folder, and
adventurous users can edit this file if they wish to alter the weightings.
Difference Listing
Modulus used: modulus angle
List of differences: In planetary order, modulus angle
List of differences: In difference order, modulus angle
The difference between a pair shown in the report as “A/B” is computed as (Position
B – Position A), i.e. it indicates the zodiacal distance from point A forward through the
zodiac to point B.
Extra Ring Points
Aspects used: aspect abbreviation or glyph, aspect angle, luminary applying and
separating orb (Sun/Moon to other planets), other planet or chart point applying and
separating orb, aspect name.
List of points in current extra ring points file: Longitude, daily travel, latitude, R.A.
and Declination, list of aspects from asteroid to other chart points, orbs
4.11.2 Descriptions of the Tabulations
The tabulations are a series of pre-defined collections of page objects organized into
useful groupings. (If you aren't familiar with Solar Fire's "Pages" see Viewing Pages for
an introduction.)
These are the same page objects that are used in Solar Fire's pages, and if users wish to
create their own collections of page objects and customize them differently from the way
they are presented here, then this can be done by designing your own pages using the
Page Designer (see Editing a Page Design File for more information).
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However, the tabulations presented here allow users to quickly view some pages of
information without having to create new pages first to see this kind of information.
Each tabulation displays a header for the currently selected chart, showing the name,
birth date, birth time, latitude, longitude, etc. These are the different types of
tabulations you can choose from:
Stations
For each displayed point, shows the longitude, speed indicator, the zodiacal positions of
the last and next station, and the time since the last station and until the next station.
The speed indicator is determined according to the typical speed of each point, and can
be Fast, Slow, Stationary or Retrograde.
Rise/Set Times
For each displayed point, shows the longitude, and the paran values for the rise,
culmination, set and anti-culmination of that point.
The paran values may be displayed as local times, or LST angles or times, according to
the user-setting in the Preferences dialog.
Gauq. Sectors
For each displayed point, shows the longitude, distance in A.U. (usually geocentric, but
heliocentric if the chart is heliocentric), the Gauquelin sector (1 to 36) and a flag to show
if it is in one of the Gauquelin plus sectors.
Note that (for a planet on the ecliptic) the sectors start at the horizon, and sectors 1 to 9
run from the Ascendant to the Midheaven, 10 to 18 run from the Midheaven to the
Descendant, 19 to 27 run from the Descendant to the IC, and 28 to 36 from the IC to the
Ascendant.
The Plus sectors are 1, 2, 3, 9, 10, 11, 12, 36.
Modulus Sort
For each displayed point shows the longitude, and the modulus of the longitude
according to the current modulus value which may be set by the user on this screen.
There is also a graphical modulus sort strip.
Chart Balances
This shows graphical representations of the balance of modes, elements, rays quadrants
and hemispheres. Note the asterisked (*) objects denote that they are showing weighted
values i.e. adjusting the scores for each category using the user-editable weightings for
each point.
House Cusps
For each house cusp, show the longitude and its degree almuten (calculated according to
the options in the houses.alm almuten definition file).
Phases/Eclipses
Shows the four last lunar phases and the next phase due (using the standard 4 lunar
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phases).
Also shows the last two and next three eclipses due (both solar and lunar).
The times are for either maximum eclipse or for the exact corresponding lunar phase,
depending on the eclipse settings in Preferences.
Essential Dignities
For each chart point: Ruler, Exalted, Triplicity, Term, Face, Detriment, Fall, Score,
Peregrine (calculated according to the options in the essdig.alm dignity definition file)
Further Dignities
Shows a collection of page objects with various types of dignities, including planetary
sect, planetary hour and day, chart Hyleg mutual receptions, horary consideration and
lunar aspects.
AstroDyne Plan&Asp
For each chart point, shows its astrodyne score, giving the overall power score, the %
contribution towards the total power score, and a Harmony/Disharmony score.
Also, the strongest, best and worst nine aspects are listed, along with their scores.
AstroDyne Houses
For each house and house type, shows its astrodyne score, giving the overall power
score, the % contribution towards the total power score, and a Harmony/Disharmony
score.
AstroDyne Signs
For each sign and sign type, shows its astrodyne score, giving the overall power score,
the % contribution towards the total power score, and a Harmony/Disharmony score.
Declinations
For each displayed point shows the declination, the longitude, and longitude equivalent
of its declination.
There is also a graphical declination strip.
Aspects - Closest
This list all the aspects currently selected, and then lists the aspects within the current
chart in order of closeness of orb. Aspects will not appear in this list unless their orb is
within i) the maximum orb specified for this object, and ii) the maximum orb allowed for
that aspect in the aspect set which is being used. The total number of aspects shown is
limited to 24.
Midpoint Trees
This displays midpoint trees for each displayed point in the chart, using the currently
specified modulus and orb, both of which may be edited by the user on this screen.
Planetary Hours
This shows the planets of each planetary hour on the chart's date, starting at dawn and
ending with dawn of the following day.
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Almuten Scores
This object displays planetary scores for various dignity or almuten calculations. The
scores are calculated according to the default dignity and almutens scores stored in the
file general.alm, which resides in Solar Fire’s program folder.
Firdaria (and Firdaria variant)
This lists the starting dates of planetary periods and the ages of the individual at each of
these dates, for the current chart. There are two variants of this object, one using
planetary periods as they were used by Al Biruni and Schoener, and the other is a variant
of this which places the nodes in a different order for night-time charts. (The variants
give identical results for daytime charts.)
Vedic Dasas
This displays a list of Dasas (major planetary periods) and Bhuktis (sub planetary
periods) using the current default sidereal zodiac for the selected chart.
Nakshatras
This shows the Nakshatras (Vedic lunar divisions) for the current chart according to the
default sidereal zodiac. The names and types of the mansions are given, as well as a few
keywords describing the attributes of the mansion.
Arabic Mansions
This lists, for each displayed point, the number of the Arabic mansion it occupies (1 to
28), the name of the mansion as given in the Picatrix, the Arabic name, and the English
name.
Chinese Mansions
This shows the Chinese Lunar Mansion occupied by each chart point. These mansions
are divisions in right ascension, the boundaries of which are defined by the positions of
certain fixed stars. The Chinese and English names of the mansion are given, as well as
a few keywords describing the attributes of the mansion.
Direction of Divisions
This lists the starting dates of planetary term periods and the ages of the individual at
each of these dates, according to the primary mundane direction of the Ascendant of the
current chart. This direction always uses the “Placidus” primary method, but does give
different results for different Primary Direction Rate Keys.
Zodiacal Releasing Periods
One of the major draws for western astrologers who have been studying Indian astrology
over the past few decades are the “dasha” systems, which are employed by Indian
astrologers in order to divide a native’s life into broad periods of time. Over the past
couple of decased, as a result of recent translations, a whole set of equivalent
techniques known as “time-lord” systems have been uncovered in the early western
astrological tradition. Some of these techniques have been lost for centuries as a result
of the scattered transmission of astrology over the past 2,000 years.
One of the more important time-lord systems that have been recovered in recent times is
known as Zodiacal Releasing. Zodiacal Releasing is used in order to divide a person’s
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life into broad spans of time or chapters, with each chapter activating a specific sign of
the zodiac and a specific planet. Once these periods are determined, the technique can
be used to identify periods of heightened activity or importance relative to certain topics,
such as one’s career or relationships. The technique also provides information about
which periods of the native’s life will tend to be either more easy or difficult relative to
those topics.
When used in coordination with other timing techniques, Zodiacal Releasing provides
astrologers with a powerful system for determining information about the course of a
native’s life.
Miscellaneous
This first object displays the same information as the Planetary Hour/Day object, but
also indicates the current planetary rulers of a 36 year cycle. Each 36 year period is ruled
by one of the 7 planets from Mars to Neptune, and each year within that 36 year period
is sub-ruled by a planet. The periods of rulership start on the tropical Aries ingress each
year. This 36 year cycle is described in American Astrology Magazine - Year 1940, in an
article by David Anrias (although it is referred to in that article as a 35 year cycle), and is
also alluded to in the title of the book “The Initiate in the Dark Cycle” by Cyril Scott –
Publ. Samuel Weiser Inc. This “Dark Cycle” is the 36 year period from 1909 to 1945
which was ruled by Mars.
The second object shows the polarity, element (of the five Chinese Elements) and the
animal of the current Chinese lunar year.
Temperaments
Four temperaments weighted according to Lilly – Choleric, Sanguine, Melancholic,
Phlegmatic.
Points used: Sun, Moon, Ascendant; Aspects to: Sun, Moon
Aspects Used: Conjunction, Square, Trine, Opposition and Sextile
Data and References for the Temperaments have been kindly provided by Lee Lehmann
4.11.3 Viewing Reports or Tabulations for a Single Chart
>> To view a report for a single chart
Do either of the following...
From the Main Screen, select a chart from the list of "Calculated Charts", and then
choose Current Chart from the Reports menu.
or...
From the "View Chart" window, select an image of the required single chart, aspect
grid or user-defined page from the list box, and select the Reports button.
This will display the "Chart Report" screen, which allows reports to be selected,
browsed, edited and printed.
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The list box on the top right of the window contains a list of all the report types that may
be displayed.
>> To display any report
1. Select the required report name from the list box on the top right of the window.
If you select a chart point sort report, or any midpoint type of report, then you can
select a modulus angle for the report.
>> To select a Modulus angle
2. Do either of the following...
Click on the Modulus drop-down list box and select a pre-defined value
It is possible to select a modulus for any harmonic from the 1st to the 12th
or...
Enter an angle into the Modulus box
It is possible to type in any angle from 1 minute of arc to 360 degrees in degrees,
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minutes and seconds (e.g. "67 23" for 67° 23').
If you select a report which requires an orb to be entered, such as a midpoint axes
or trees report, or a star paran report then you can enter a limiting orb.
>> To enter an orb
3. Type the required orb into the Orb box - Any orb may be entered from 0 to 10
degrees, in degrees, minutes and seconds (e.g. "0 10" for 10 seconds of arc).
You can browse through the report by clicking on the scroll bars to the right and
bottom of the report display box. You can alter the appearance of the report by
switching on or off any of the following options:
Use Glyphs - This will substitute astrological glyphs into the report wherever
appropriate, replacing abbreviations for planets, asteroids, zodiac signs and
aspects.
Use Colors - This allows you to switch on or off the selected colors of each
planet, asteroid, zodiac sign and aspects wherever they appear in the report.
When this option is switched off, all items appear in black. It is possible to alter
which colors are used for each item by selecting Point Colors, Sign Colors and
Aspect Colors from the Chart Options menu of the Main Screen. See Editing a
Color File for instructions on how to do this.
Bold Text - This allows you to switch between regular (light) text and bold text.
Full Headers - This allows you to switch on or off the full chart details and full
listing of aspects used (in reports which use aspects). This option is useful if you
do not need to see the full details, or if you wish to use less paper when printing
a report.
>> To select an alternative chart for the same report
4. Select the Charts button
This will display a list of calculated charts, from which you may select any one.
Note: By switching on the "Auto-apply" option, you may also scroll through charts and
see the report automatically updated for each chart you select, without having to close
the chart selection dialog.
Note: You can also use this dialog to view or edit the events or comments for any chart
by using a right hand mouse click over that chart's entry, which brings up a pop-up menu.
>> To send a copy of the report to the Windows Clipboard
5. Select the Copy button
Note that glyphs and colors cannot be copied to the clipboard. Abbreviations are used
instead of glyphs when the report is copied into the Clipboard. Also, report columns
may not align correctly in the Clipboard. If you paste the Clipboard contents into your
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word-processor, you may have to edit the document to ensure that the columns align
correctly.
>> To print the report which is currently displayed
1. Select the Print button.
This will display the "Print" dialog box, allowing you to cancel, alter printer settings,
add the report to the batch print queue, or to print it immediately. See Printing from
Solar Fire for instructions on printing. The printed report will contain glyphs (if you
have the Use Glyphs option selected), and colors (if you have a color printer and you
have the Use Colors option selected). However, the printed report always uses regular
(light) text. It is not possible to print the report using bold text.
>> To view a Zodiacal Releasing tabulation
1. Select a natal chart in the Main Screen, then go to the Reports menu, and click on
Current chart.
2. On the right hand side click on the Tabulations tab.
3. Optionally enter a date in the "Target Date" box. This date must occur after the
chart date.
4. Decide on the starting basis for the releasings by selecting a value in the Zodiacal
Start combo box. By default it is the sign the "Part of Spirit" is in, but you can
select the "Part of Fortune" instead, or otherwise a specific sign to start with.
Whatever you select here will be used from that point onwards until you change it
again.
5. Click on Zodiacal Releasings in the list.
6. If you subsequently change the date, afterwards click on the Enter button to
refresh the list.
NOTE: If a Target Date is entered, this aligns the releasing periods with the date
given, providing a full description of the influences stemming from that date. However,
its possible to see information focused on a period another way that is very flexible:
>> To manually zero in on particular dates or a combination of zodiacal
influences
1. Click on the Date you’re interested in the Level 1 column. This populates the
Level 2 column with dates relevant to that.
2. Click on a Date you’re interested in the Level 2 column. This populates the Level
3 column with dates relevant to that.
3. Click on a Date you’re interested in the Level 3 column. This populates the Level
4 column with dates relevant to that.
* Loosing of the Bond is written "LOB" when it happens
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4.11.4 Synastry Reports
>> To view a synastry report
Do either of the following...
From the Main Screen, choose Synastry from the Reports menu - you must then
select charts as described in Viewing MultiWheels and Synastry Grids, and then
select the Reports button.
or...
From the "View Chart" window, select the image of the required biwheel or synastry
grid from the list box, and then select the Reports button.
This will display the "Reports" screen, which allows reports to be selected, browsed,
edited and printed. Refer to Viewing Reports or Tabulations for a Single Chart for
instructions on how to use this screen.
4.11.5 Ashtkoot Reports
The Ashtkoot Compatibility System is a system that has its roots in India and is primarily
used in Vedic astrology. “Ashtkoot” simply means “8 factor”. The scoring within this
system is based on the position of the sidereal Moon (Lahiri) of the two people and the 8
factors are scored on the integration of these two Moon positions. The maximum score
is 36. The implementation of this system in Solar Fire allows a user to select two charts
from either the chart files or ones that have been entered and if a zodiac used in those
charts is one other than the Lahiri zodiac then Solar Fire automatically converts the Moon
position to the Lahiri (sidereal) position internally and the scores calculated.
>> To view an Ashtkoot report
1. From the Main Screen, select two charts on the "Calculated Charts" list
2. Click on the Reports menu then click on the Ashtkoot Compatibility item
3. Set the gender of the two charts if they have not already been previously selected
for those charts
The Compatibility score will display in the Summary report next to the Total. The
individual scores making up the Total score can also be seen together with a short
description of the 8 factors. If you are already familiar with the Ashtkoot Compatibility
system then you can also click on the “Ashtkoot Detailed” option on the right of the
screen to see the individual factors for each chart. Some of the words will be familiar
and some will not be familiar.
Neville Lang studied about 100 couples over a 10 year period (still a small sample size)
using the Ashtkoot Compatibility system. He came up with some tentative boundaries of
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the Total score. If you think about using traffic lights as a quick indicator then the Red
light will represent scores of 40% of the maximum 36 (a score of 14.4) and lower, the
Orange light will represent the range from 40% (14.5) to 69% (24.7), and the Green light
will represent scores of 24.8 and higher. Basically, the Red light indicates a warning for
the long term viability of the relationship, the Orange light means that is it “middling”
and requires more analysis of the two individual charts while the Green light indicates a
high degree of compatibility for the relationship to run for the long term.
4.11.6 Paran Report Options
The fixed star paran report lists stars that are in paran to points in the chart. Parans may
be of four types - rising, setting, culminating or anti-culminating. It is possible to select
which parans to include or exclude from the report. For example, if only rising and
settings parans are selected, then the report will list any stars which are rising or
settings as the chart points rise or set, but not as the stars or chart points culminate or
anti-culminate.
>> To select which parans to use in the fixed star parans report
From the Main Screen, click on the Reports menu then on any of the Parans to Use
options.
Parans that are selected will have a check mark on their left of their entry in the
menu. Clicking on an unselected paran will switch it on, and clicking on a selected
paran will switch it off. Note that the fixed star paran report lists which parans are
currently in use when the report is generated.

4.12

Printing from Solar Fire
This section describes how to send a chart page, report or time map to the printer which
is attached to your computer system, how to add a print job to the batch print queue, to
be printed at a later time instead of immediately, and how to alter printer settings such
as the number of copies of each page to be printed, the page orientation and the print
resolution.
If you wish to set page margins, then you must do this before printing. See Setting Page
Margins for information on how to do this.
Before printing a chart, grid or report relating to a chart or grid, it is necessary to have
either cast, opened or generated the charts which you wish to print, or to have generated
the report which you wish to print.
You can print from any screen with a Print button, or with a Print menu option.

4.12.1 Printing from a View screen
You can print any wheel, grid, user-defined page, dynamic report, Time Map, ephemeris
page or Planetarium view by clicking on the Print button on the screen. In most cases a
print dialog box will appear, which you can use as described in following sections.
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>> To print any chart or grid or page layout for which an image has already been
created
1. From the "View Chart" screen, select the required image from the list of images
2. Select the Print button
>> To print any report, from the "Chart Reports & Tabulations" screen
1. Select the desired report from the list of reports
2. Select the Print button
4.12.2 Printing without Viewing
If you just want printouts, you can print single and multiple wheels and grids without
first viewing them on the screen. These printouts will use whatever displayed points,
aspects set, wheel style, display options, colors, fonts and other options that are
currently selected in the Chart Options and Preferences menus.
>> To print one or more charts or aspect grids from the Main Screen
1. Select the chart(s) from the list of "Calculated Charts".
2. Select the Print Chart or Print Grid options from the Chart menu.
>> To print a multiwheel chart or synastry grid from the Main Screen
1. Follow the instructions in Viewing MultiWheels and Synastry Grids to select the
required charts.
2. Select the Print button.
4.12.3 Using the Print Dialog Box
Most print options in Solar Fire will display the "Print" dialog box, which allows the user
to add the print job to the batch print queue, to alter printer settings, or to print
immediately.
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If you wish to exit from this dialog box without taking any action, then the Cancel button
may be used.
>> To select a Color/Greyscale/Black options
Choose one of the two options provided...
Color/Greyscale - if you have a color printer (on which the color printing ability is
enabled), then the output will be printed using the colors selected in your current
color scheme for printers. If your printer is not a color printer (or is a color printer,
but on which the color printing ability is disabled), then it will appear in greyscale
equivalents to the colors selected in your current color scheme for printers.
or...
Black Only - this converts all color output to black. This produces the clearest
output on most monochrome printers.
>> To send output to the printer immediately
1. Optionally select a Color/Greyscale/Black option.
2. Optionally enter a number of Copies to print.
3. Select the Print button - This will start the print job, and messages will appear on
the screen to indicate the status of printing. Generally the printer will not actually
start printing until the "Print" dialog box disappears. It is not possible to cancel
printing once it has started, although it is possible to delete an item from the
Windows print queue if it has not already been sent to the printer in its entirety.
See your Windows manual for information on the Windows print queue.
If the printer is switched off, not connected to the computer, or has other problems, then
Windows will issue a message asking whether you wish to cancel or retry. You may then
attempt to remedy the problem and select the Retry button, or select the Cancel button
if you wish to continue working without fixing the problem now. If the Cancel button is
selected then the output will not be sent to the printer, but it will remain on the
Windows print queue (not to be confused with the Solar Fire batch print queue). Please
refer to your Windows manual for instructions on using the Windows Printer object to
deal with the Windows print queue.
>> To add this output to the print batch queue
1. Optionally enter a number of Copies to queue for printing.
2. Select the Queue button
This will display a dialog box asking you to confirm whether or not you wish to add
this print job to the Solar Fire print batch queue. If you select the OK button, then it
will be added to the queue, and it will not be printed at this time. It is possible, at any
later time, to start printing all the jobs which are on the batch print queue by
selecting the Start Print Queue option from the View menu of the Main Screen.
Note: If you have specified more than one copy, then the print queue will have the
specified number of copies added to it instead of just one.
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>> To alter printer setup options
Select the Setup button
See Altering Printer Settings for information on altering printer settings.
Note: The number of copies you set in the printer settings is ignored by Solar Fire. To
print multiple copies, you must set the number of copies required in this dialog instead.
Note: The number of copies you select in this dialog is always automatically reset to one
when it is next opened. This is done deliberately to prevent you accidentally printing
multiple copies when you have simply forgotten to reset it from last time you printed.
4.12.4 Setting Page Margins
It is possible to set page margins which apply to all types of Solar Fire’s printed output,
including charts, reports and time maps.
>> To set page margins
From the Main Screen, select the Charts menu then the Page Margins option
This will display a “Page Margins” dialog box in which it is possible to view the
current page margins or to set new ones.
There are four margins (left, right, top and bottom), each of which may be different, if
desired. These margins are expressed in terms of a ratio of page dimensions (based on
the printable page area, not the full page size), so a setting of 0.1 indicates a margin of
1/10th of the printable page size, for example.
Each margin must be between 0 and 0.4 inclusive. A page margin of 0 indicates that
printed output will extend right to the edge of the printable area of the page.
For example, if you wish to set a 10% left hand binding margin, but to otherwise use the
full printable area, then enter
0.1 0.0 0.0 0.0
When you select the OK button you will be asked to confirm your settings before they
are saved. Note that the page margin settings are saved for subsequent sessions only if
you choose to Save Settings or if Save Settings on Exit is on.
4.12.5 Altering Printer Settings
>> To alter printer settings
From Solar Fire’s "Print Dialog" box, select the Setup button
This will display a "Print Setup" dialog box that allows the selection of an alternative
printer, and the number of copies of each page to print and whether to collate the
pages in order.

© 2014 Esoteric Technologies Pty Ltd

126

Solar Fire 9 User Guide

If you wish to exit from this dialog box without altering any settings, then the Cancel
button may be used. If you wish any changes that you make to take effect, then the OK
button should be used.
There is also a Properties button which allows page orientation and size and other
options to be selected.
Use this option if you wish to alter the page orientation from portrait (normal
orientation) to landscape (page sideways) or vice-versa. However, note that if you use
landscape format to print charts, then any reports subsequently printed will also be in
this orientation unless you switch this option back first.
Please refer to your Windows manual for further information on how to specify printer
settings.
Any alterations made with this option result in changes to the printer setup being stored
in Windows, and these changes will therefore affect any other Windows applications
that use the printer.
4.12.6 Using the Batch Print Queue
The batch print queue is a means of storing instructions for the printing of a series or
charts and/or reports and then allowing them to be printed all together at a later time.
The purpose of the option is to allow the user to generate a large number of charts and
reports in a short space of time, without having to wait for each one to print before
generating the next one. Then at a convenient time, the user may take a break whilst the
whole batch of charts and reports in printed out without requiring any further user
interaction. The print queue keeps a record of all the chart display options that were in
effect at the time when each item was added to the queue, and when the queue is sent
to the printer it uses the appropriate options for each chart individually as it is printed.
After the batch queue has finished printing, the chart display options are automatically
restored to the settings that were in effect immediately before the queue was sent.
© 2014 Esoteric Technologies Pty Ltd

Basic Operations

127

4.12.6.1 Adding Items to the Print Queue

For instruction on how to add items to the batch print queue, see Printing from Solar Fire.
It is possible to put any type of chart or grid image and most types of reports onto the
batch print queue.
4.12.6.2 Starting the Print Queue

This section describes how to start the batch print queue, which will print all the items
that have been added to the print queue during this session, or since the batch print
queue was last printed or cleared.
>> To start the print queue
From the Main Screen...
From the Chart menu select Print Queue then the Start Print Queue option
This will display a dialog box asking for confirmation of whether to start printing
items on the batch print queue. Select the Cancel button to quit without starting the
queue, or the OK button to start printing.
4.12.6.3 Clearing the Print Queue

This section describes how to clear all the items from the print batch queue that have
been added since it was last printed or cleared. If the print batch queue is cleared, then
all the items on the print queue will be lost.
>> To clear the print queue
From the Main Screen...
From the Chart menu select Print Queue then the Clear Print Queue option
This will display a dialog box asking for confirmation of whether to clear all the items
from the batch print queue. Select the Cancel button to quit without clearing the
queue, or the OK button to clear it.

4.13

Changing Chart Options
It is possible to alter any of the following items that relate to the manner in which charts
and reports are calculated and displayed.
Chart points displayed
Points displayed in transits charts
Current chart’s displayed points
Points included in an extra wheel ring
Aspects used and their orbs
Chart points which have aspects drawn to them
Fixed Star file, Arabic Parts file, Asteroids file and Extra Bodies file
Style of displayed chart wheels
Style of displayed chart dials
Selection of whether to display houses proportionally
Application of house cusps adjustment when houses are over-full
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Selection of whether aspect lines appear in displayed charts
Selection of whether aspect glyphs appear in displayed charts
Selection of aspect highlighting and filtering options
Special chart superimposition options when displaying multi-wheels
Colors schemes used for chart points, aspects, zodiac signs and as backgrounds
Fonts used for screen displays and printouts
The selection of each of these is described in detail in the following sections. It is
possible to save any of these selections so that they will be used automatically when the
program is next started up. See Saving and Restoring Settings for instructions on how to
do this.
4.13.1 Displayed Points
Displayed points are the planets, asteroids and other points which appear on a displayed
chart or synastry grid or in any report.
A set of displayed points is a named file containing a list of which points are switched on
and which are switched off.
The name of the currently selected set of displayed points is shown in the "Current
Settings" panel on the Main Screen of the program.
When the program is first installed, there are a variety of named displayed point sets
which may be selected. It is possible to alter which points are displayed by selecting an
alternative set of displayed points, or by editing an existing one or creating a new one.
>> To alter the displayed point set, from the Main Screen
1. Choose the Displayed Points option from the Chart Options menu
2. Then follow the instruction relating to displayed points in Using the File Manager.
>> To alter the displayed point set, from the View Chart window
1. With the mouse right-click on the screen, and a pop-up menu appears
2. Choose the Displayed Points option from the menu
3. Then follow the instruction relating to displayed points in Using the File Manager.
4.13.2 Current Charts Displayed Points
It is possible to select a set of displayed points which will be used only with the currently
selected chart. This is useful, for example, when you wish to display a chart of the
current transits in a biwheel with a natal chart. In this case, you might prefer the transits
chart to display only the outer planets, because the inner planets and chart angles move
so quickly as to be of much lesser importance.
>> To alter the current chart’s displayed point set - from the Main Screen
1. Select the chart that you wish to use from the list of "Calculated Charts"
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2. Choose the Current Chart’s Displayed Points option from the Chart Options menu
3. Then follow the instruction relating to displayed points in Using the File Manager.
Whenever this chart is subsequently displayed, it will always contain the newly
selected displayed points instead of the current set of displayed points which are
used in all other cases.
If you wish to reset the displayed points for this chart to be the current set of displayed
points again, then you must re-use this option to select whichever set of displayed
points is the current set.
>> To alter the current chart’s displayed point set - from the View Chart window
1. With the mouse right-click on the screen, and a pop-up menu appears
2. Choose the Current Chart’s Displayed Points option from the menu
3. Then follow the instruction relating to displayed points in Using the File Manager.
Note: This doesn't necessarily change the displayed points of the chart currently
displayed in the "View Chart" window. It will do if that chart is also the chart in the
"Calculated Charts" list that was last selected, and is therefore the "current" chart (see
current chart for more info). Otherwise it will change the points to be displayed for
whatever chart happens to be the current chart, which may not have even been viewed
in the "View Chart" window at that point.
4.13.3 Displayed Transiting Points
A set of displayed transiting points is a named file containing a list of which points are
switched on and which are switched off.
Displayed transiting points are the planets, asteroids and other points which can appear
on a displayed multi-wheel chart when both of the following are true...
the chart is deemed to be a “transits” chart by Solar Fire
when that chart is not the house cusp anchor chart for that wheel (which is usually
means when it is not the innermost chart)
The criteria by which Solar Fire deems a chart to be a “transits” chart are either one
of the following...
Any natal type chart that has an event type of “Event”
Any natal type chart that has an event type of “Unspecified”, and that contains
either “transit” or “event” anywhere in its name
Unless either of these conditions is met, Solar Fire assumes that the chart is not a
“transits” chart, and therefore uses only the default Displayed Points set.
However, when either of these conditions is met, then the points which are actually
displayed are all those points which are switched on in BOTH the default Displayed
Points AND in the Displayed Transiting Points. Therefore, you should use this selection
to switch OFF only those points that you DO NOT wish to see in a transits chart (e.g.
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chart angles, and perhaps other fast moving points such as the moon), and you should
leave ALL other points switched ON, even if you do not normally display them in a chart.
Doing this will allow you to later choose a set of ordinary Displayed Points containing
some additional points, and have those additional points automatically also appear in
transits charts, without having to also reselect a set of Displayed Transiting Points.
When the program is first installed, there are a variety of named displayed point sets
which may be selected. It is possible to alter which points are displayed by selecting an
alternative set of displayed points, or by editing an existing one or creating a new one.
>> To alter the displayed transiting point set, from the Main Screen
1. Choose the Displayed Transiting Points option from the Chart Options menu
2. Then follow the instruction relating to displayed points in Using the File Manager.
4.13.4 Extra Ring Points
Extra Ring Points is a selection of points or bodies of various types that can be displayed
in a special chart wheel which includes an extra ring in addition to the normal ring which
displays the standard chart points.
The types of extra points that can be selected are standard chart points, midpoints, fixed
zodiacal positions, fixed stars and astronomical objects, Arabic parts, asteroids, bodies
calculated from orbital elements, prior lunar phases, eclipse points and planetary nodes.
When the program is first installed, there are a variety of named extra ring point sets
which may be selected. It is possible to alter these selections by editing an existing set
or creating a new one.
>> To alter the extra ring points set, from the Main Screen
1. Choose the Extra Ring Points option from the Chart Options menu
2. Then follow the instruction relating to extra ring points in Editing an Extra Ring
Points File.
4.13.5 Aspect Set
Aspect sets are named files containing a list of which aspects are switched on and off
and what orbs each aspect has. The aspect set controls which aspects are displayed on
charts or synastry grids and in any reports. It is also used when any dynamic transits or
progressions report is created.
The name of the currently selected aspect set is shown in the information box on the
Main Screen of the program.
When the program is first installed, there are a variety of named aspect sets which may
be selected. It is possible to alter which aspects are displayed and their orbs by
selecting an alternative aspect set, or by editing an existing one or creating a new one.
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>> To alter the aspect set, from the Main Screen
1. Choose the Aspect Set option from the Chart Options menu
2. Then follow the instruction relating to aspect sets in Using the File Manager.
4.13.6 Aspected Points
Aspected points are the planets, asteroids and other points to which aspects are drawn
on a displayed chart.
A set of aspected points is a named file containing a list of which points are switched on
and which are switched off.
It is possible for an aspected point set to be different from a displayed point set. In this
case the displayed chart will not have aspects drawn between every chart point. This is
useful in order to switch off aspects to the Ascendant and Midheaven, for example,
when they are still required to be displayed in the chart.
The name of the currently selected set of aspected points is shown in the information
box on the Main Screen of the program.
When the program is first installed, there are a variety of named aspected point sets
which may be selected. It is possible to alter which points are aspected by selecting an
alternative set of aspected points, or by editing an existing one or creating a new one.
>> To alter the aspected point set, from the Main Screen
1. Choose the Aspected Points option from the Chart Options menu
2. Then follow the instructions relating to aspected points in Using the File Manager.
4.13.7 Files
This menu option allows you to select any of four different types of files to use as the
default, or to edit or browse their contents. These file types are as follows...
Fixed Stars – files containing selections of fixed stars or other astronomical objects
Arabic Parts – files containing lists of Arabic part definitions
Asteroids – files containing lists of asteroids
Extra Bodies – files containing orbital elements for various bodies
See Using the File Manager for more details on how to select, edit and use these file
types.
4.13.8 Wheel Styles and Dial Styles
It is possible to select from a range of available chart and dial styles to be used
whenever Solar Fire displays or prints charts. Solar Fire comes supplied with several
different pre-defined chart styles, and it is also possible to create your own designs with
the separate Wheel Designer program. The most common types of wheel styles that you
might like to use are the Anglo/American style, European Style and French style.
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You can select any available pre-defined style for use with single chart displays, bi-chart
displays, tri-chart displays, quadri-chart displays, small wheel displays (which includes
dual wheels on a page and wheel and grid on the same page), and preview wheel
displays, such as on Solar Fire’s Main Screen.
>> To select a particular style of display for all subsequent wheel or dial display
and printing
1. Click on the Wheel Styles or Dial Styles button, or choose the required chart
combination option from the Wheel Styles or Dial Styles option of the Chart
Options menu
2. Then follow the instruction relating to wheel and dial styles in Using the File
Manager.
Once a particular style is selected, all subsequent displays of that chart combination
type will use that selected style. For example, if you select a “French” style for biwheel
chart combinations, then all subsequent biwheel displays will use the “French” style.
4.13.9 Proportional Houses
Most house systems, apart from equal house systems, have houses that vary in size. In
some cases, especially at high latitudes, there can be a considerable "distortion" so that
a couple of houses are very narrow, whilst others are very wide. It is possible to display
Solar Fire charts either with equal-sized (non-proportional) houses, or with proportional
houses. However, when displaying a chart using a wheel style which contains a zodiac
ring (such as a French or European style), then the proportional houses option is
automatically overridden, as in this case the house cusps must always maintain their
positions in relation to the zodiac ring. When a chart is displayed with non-proportional
(equal sized) houses, the planets will not be drawn in their correct geometrical positions.
Instead they will be moved, wherever possible, to fall within the correct house cusps.
Also, in this case, the tick marks on the inside rim of any single wheel display will also
be moved to correspond to the displayed position of the planet.
Therefore, when displaying non-proportional charts, it is advisable to either switch on
the House Expansion option, or to carefully check whether planets are in their correct
houses by looking at their angles, as this will not necessarily be obvious from their
plotted positions. Generally, this problem does not occur if the chart is drawn with
proportional houses, as the tick marks will clearly show exactly where each planet is in
relation to the house cusps, even if the planet symbol is not in its correct house.
>> To alter the current Proportional Houses setting, from the Main Screen
Choose the Proportional Houses option from the Display Options submenu of
Chart Options menu.
This will switch on the option if it is currently off, or switch it off if it is currently on.
When this option is switched on, a tick appears to the left of this item on the menu.
Once this setting is altered, any chart subsequently displayed on the screen or printed
will be affected.
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To update the display of any previously viewed chart in the "Chart View" screen, click
on the the ReDraw button.
4.13.10 House Expansion
A chart may sometimes have many planets or other chart points in a single house. In this
case, when you view the chart you may find that some of these points spill over into
adjacent houses. If this happens, you can switch this option on to prevent this from
happening. When switched on, this option will cause any over-full houses to be
expanded to accommodate all the required points, so that it is clear in which house they
reside.
>> To change the current house expansion setting, from the Main Screen
Choose the House Expansion option from the Display Options submenu of the
Chart Options menu
This will switch on the option if it is currently off, or switch it off if it is currently on.
When the house expansion option is switched on, a tick appears to the left of this
item on the menu.
Once this setting is altered, any chart subsequently displayed on the screen or printed
will be affected.
To update the display of any previously viewed chart in the "Chart View" screen, click
on the the ReDraw button.
4.13.11 Aspect Lines
Any single-wheel chart which you view on the screen or print may optionally display
aspect lines inside the central ring of the chart.
>> To alter the Aspect Lines setting, from the Main Screen
Choose the Aspect Lines option from the Display Options sub menu of the Chart
Options menu
This will switch on the option if it is currently off, or switch it off if it is currently on.
Once this setting is altered, any single-wheel chart subsequently displayed on the
screen or printed will be affected.
To update the display of any previously viewed chart in the "Chart View" screen, click
on the ReDraw button.
4.13.12 Aspect Glyphs
Any single-wheel chart which you view on the screen or print may optionally display
aspect lines inside the central ring of the chart. When they are displayed (i.e. when the
Aspect Lines option is on), it is also possible to choose whether or not to show the
aspect glyphs in the middle of each aspect line.
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>> To alter the Aspect Glyphs setting, from the Main Screen
Choose the Aspect Glyphs option from the Display Options sub menu of the Chart
Options menu. This will switch on the option if it is currently off, or switch it off if it
is currently on.
Once this setting is altered, any single-wheel chart subsequently displayed on the
screen or printed will be affected.
To update the display of any previously viewed chart in the "Chart View" screen, click
on the ReDraw button.
4.13.13 Aspect Highlighting and Filtering
This option allows you to highlight aspects according to their tightness of orb, use
different line styles for applying and separating aspects, and to display conjunction
lines. The filtering features allow you to flexibly switch on or off aspect lines according
to a range of useful criteria, such as limiting the orb, displaying only aspects belonging
to a particular harmonic, or only those aspects emanating from a selected chart point.
This can be performed quickly and interactively whilst displaying a chart (without having
to change the currently selected aspect set), and is therefore a powerful tool in assisting
the analysis of aspects.
>> To open the Aspect Highlighting and Filtering Dialog
Choose Aspect Highlighting and Filtering… from the Chart Options menu.
This will display the "Aspect Highlighting and Filtering" dialog.
If you wish to apply highlighting or filtering to a chart interactively, then you should first
display the required chart in the View Chart or Animation window, and use a right hand
mouse click over the chart to bring up the Chart Options menu.
The Apply button is enabled when you are already viewing a chart on the Main Screen, in
the View Chart, Animation or any Chart Preview window. It may be used to apply any
changes you make without closing this dialog.
The Transparent option (only available in Windows 2000, XP or later) allows the dialog to
be made semi-transparent. This is useful in helping you to see otherwise hidden parts of
pages when you are using the Apply button to preview any changes without closing this
dialog.
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4.13.13.1 Aspect Highlighting

In the "Aspect Highlighting and Filtering" dialog...
Click on the Highlighting tab, and select one of the following options...
No highlighting – the aspect lines are not highlighted. All aspect line
thicknesses are set to their standard default line width.
By relative tightness of orb – the aspect line thickness are scaled according to
how tight they are (by taking the ratio of the actual orb to the maximum possible
orb i.e. by relative orb ratio). The tightest orbs have the thickest lines, and the
widest orbs have the thinnest lines. The maximum line width multiplier can be set
to control the factor by which the line width is increased for the tightest orbs.
The Linear option thickens the lines in direct proportion to the relative orb ratio
e.g. an aspect whose orb is half of its maximum allowed orb has its thickness
multiplied by half the maximum line width multiplier. The Sqr option thickens the
line in proportion to the square of the relative orb, so an aspect whose orb is half
of its maximum allowed orb has its thickness multiplied by one quarter of the
maximum line width multiplier. The Sqr*Sqr option thickens the line in proportion
to the fourth power of the relative orb, so an aspect whose orb is half of its
maximum allowed orb has its thickness multiplied by one eight of the maximum
line width multiplier.
Partile aspect only (same degree) – only those aspects that are partile (i.e.
those which are in the same whole degree of their sign at each end of the aspect)
are highlighted by the line width multiplier. All other aspects are set to their
standard default line width.
By absolute tightness of orb - the aspect line thicknesses are scaled according
to their actual orbs in degrees. When this option is selected, the list box below
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contains a list of orb limits and the corresponding line width multipliers to apply.
This list may be edited by the user. Use the Add button to add a new line, the Del
button to remove a line, and use the Max Orb box to set the orb in degrees and
minutes.
App=Solid; Sep=Dotted – When this box is checked, all applying aspects are
shown as solid lines, and all separating aspects are shown as dotted lines. This
can be used in addition to the line thickness options.
Display Conjunction Aspect Lines – When this box if checked, an aspect line is
drawn between points which are conjunct. Note: If the points are very closely
conjunct, then these conjunction lines will not be easily visible.
4.13.13.2 Aspect Filtering

In the "Aspect Highlighting and Filtering" dialog...
Click on the Filtering tab, and select one of the following options.
No filtering – the aspect lines are not filtered. The aspects displayed are those
that are enabled and within orb according to the currently selected aspect set.
By applying/separating – only those aspect types shown in the drop-down list
box at the right are displayed. This may be All Aspects (no filtering), Applying
only, Separating only. This option may be used together with some of the other
options below. For example, if you are filtering by aspect harmonic, then you can
use this to limit the aspect to applying or separating aspect of that harmonic.
By % of maximum orb – only those aspects whose orbs are less than the
prescribed percentage of their maximum possible orb are displayed. The
prescribed percentage may be adjusted by the user either by typing a new
number into the adjoining box, or by using its spin buttons.
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By absolute maximum orb - only those aspects whose orbs are less than the
prescribed orb are displayed. The prescribed orb may be adjusted by the user by
typing a new maximum orb angle into the adjoining box.
By aspect harmonic – only those aspects that belong to the selected harmonic
family are displayed. When this option is selected, the orbs from the current
aspect set are used, but the enabled or disabled aspect settings are ignored.
By individual aspect - only the selected aspect type is displayed. When this
option is selected, the orbs from the current aspect set are used, but the enabled
or disabled aspect settings are ignored.
By aspect pattern – only those aspects that form the selected aspect pattern
type are displayed. If a chart does not contain the selected aspect pattern, then
no aspects are displayed in that chart. If a chart contains multiple instances of
the selected aspect pattern, then all instances are shown. When this option is
selected, the orbs from the current aspect set are used, but the enabled or
disabled aspect settings are ignored.
By chart point – only those aspects that emanate from the selected chart point
are displayed. When this option is selected, only those aspects that are enabled
in the current default aspect set are displayed.
Switch filtering off after close – ensure this box is checked unless you want the
filtering options you set to be maintained permanently. As most filtering is done
on a temporary basis, this options helps you avoid forgetting to set the filtering
off when you finish, which might result in unexpected or missing aspect lines
when you subsequently view charts.
Auto apply changes – setting this option on saves you from having to click on
the Apply button after every change you make. This is especially helpful if you
wish to scroll through many filtering options (such as through the whole list of
aspect patterns, to see if any are present in the chart being examined).
4.13.14 Multiwheel Superimposition
This is a special option that determines the manner in which charts are aligned with one
another (i.e. superimposed). The usual manner of superimposition is “zodiacal”, meaning
that when charts are displayed in a biwheel, for example, 0 Aries in one chart is aligned
with 0 Aries in the other chart. This method is the one used in almost all astrological
books and publications.
However, it is also possible to align charts by other methods, for example according to
their house cusps, or according to the position of points within the charts.
The options available are...
Zodiacal (Normal) – This is the default option when the program is first installed,
and should always be selected unless you specifically wish to use non-standard
superimposition methods.
By Sign of Selected Point – This will align 0 degrees of the sign of the selected
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superimposition point in the superimposed chart with 0 degrees of the sign of the
selected base point in the base chart. In this case the superimposition adjustment
will always be an exact factor of 30 degrees.
By Exact Position of Selected Point – This will align the exact zodiacal position of
the selected superimposition point with the exact position of the selected base
point in the base chart. In this case the superimposition adjustment can be any
angle.
The last two options require a specific chart point to be selected. For example, if the
“Exact Position of Selected Point” option is selected, then the selected superimposition
point and base point might both be set to Ascendant. In this case, when a biwheel is
displayed, the outer chart will have its ascendant aligned exactly to the ascendant of the
inner chart, so that the houses of each chart coincide with one another.
This option never affects a single chart on its own – it only affects multiwheels, reports
or page objects that show chart inter-relationships. Specifically, the items affected are:
Biwheels – The outer chart is adjusted. The inner chart remains fixed.
Triwheels - The two outer charts are adjusted. The inner chart remains fixed.
Quadriwheels - The three outer charts are adjusted. The inner chart remains fixed.
Quinquiwheels - The four outer charts are adjusted. The inner chart remains fixed.
Synastry aspects – Chart B is adjusted. Chart A remains fixed.
Further options are as follows.
Use Radix Point in Subsidiary Charts – This option only affects subsidiary charts (such
as progressed charts) that are superimposed onto other base charts. In this case it is
possible to superimpose the charts by aligning the subsidiary (progressed) point with the
base chart, or alternatively by aligning the radix position of the selected point of the
progressed chart. For example, if we view John’s progressed chart in a biwheel around
Susan’s natal chart, and we have selected to superimpose by exact position of
ascendants, then, when this option is switched off, John’s progressed ascendant will be
aligned to Susan’s natal ascendant. However, when this option is switched on, John’s
natal (radix) ascendant will be aligned to Susan’s natal ascendant, instead.
Display Superimposed Positions – This option determines whether the planets and
zodiac of the superimposed chart retained their original zodiacal positions in the wheel
or reports, as opposed to the entire chart being shifted in the zodiac to appear as if it
was aligned with the zodiac of the base chart. For example, if we view John’s natal chart
in a biwheel around Susan’s natal chart, and we have selected to superimpose by exact
position of ascendants, then, when this option is switched off, John’s ascendant will be
notated with its original (un-superimposed) zodiacal position, and the zodiac of the outer
chart will be shown as offset from that of the inner chart. However, when this option is
switched on, John’s ascendant will be notated with its superimposed position (i.e.
identical to Susan’s ascendant position), and the zodiac of the outer chart will appear to
align exactly with the zodiac on the inner chart. The purpose of this option is to allow
inter-chart aspects to be seen much more readily than would otherwise be the case.
Note: Using these options can cause much confusion if you are not familiar with the
concept of superimposition. After use, please remember to switch this option back to
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Zodiacal (Normal) in order to avoid the likelihood of mistaking a superimposed zodiac
with an erroneously calculated chart!
4.13.15 Color Schemes
A “color scheme” is a set of color selections for aspects, chart points, sign glyphs, sign
fills as well as a background color or graphic which is displayed on the chart viewing
screen.
You can select existing color schemes or create and save your own schemes. The name
of the currently selected color scheme for both screen and printer is shown in the
information box on the Main Screen of the program.
>> To select, edit or create a color scheme
Choose Color Scheme from the Chart Options menu
This will display the color scheme selection dialog.

The elements in the Screen and Printer Colors frame are as follows.
Screen Colors / Printer Colors – You can assign different color selections to be
used for the screen and the printer. This is useful, for example, if you wish to print
in monochrome even though you have a color printer, or if you want the colors on
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the printer to be darker than the colors on the screen to make them more legible on
a white page. This is especially useful if you have selected a dark background color
for the screen, but still wish to print onto white paper. In this case you can choose
light colors to contrast well with the screen background, and dark colors to contrast
well with the printed white page. Note that any colors you select apply only to
either the Screen or the Printer, depending on which option is selected. Thus, when
you change screen colors, the colors that appear on the printer will remain
unchanged unless you also change the printer colors.
Scheme Name – When this program is first installed, there are a number of
predefined color schemes that can be selected from this drop-down list box.
Selecting a named scheme from this list will result in the subsequent items on this
dialog being updated to reflect all the color selections stored in that selection. If
you have made changes to any color selections, then you can save the new color
scheme by clicking on the Save As… button and specifying a name for the scheme.
If you specify an existing scheme name, then that scheme will simply be replaced
with your new scheme. You can also delete any named scheme by first selecting it
from the list, and then clicking on the Delete button. Note that the list of scheme
names is different for screen and printers.
Aspect Colors - Aspect colors are the colors in which aspect symbols and aspect
lines will appear in any displayed chart or grid. A set of aspect colors is a named
file containing a list of which color is assigned to each aspect. When the program
is first installed, there are a variety of named aspect colors sets which may be
selected. It is possible to alter the colors in which aspects are displayed by
selecting an alternative set of aspect colors, or by editing an existing one or
creating a new one. To alter the aspect colors set, click on the box containing the
name of the current aspect colors, and then follow the instruction relating to aspect
colors in Using the File Manager.
Point Colors - Point colors are the colors in which planets, asteroids and other
points will appear in any displayed chart or grid. A set of point colors is a named
file containing a list of which color is assigned to each point. When the program is
first installed, there are a variety of named point colors sets which may be
selected. It is possible to alter the colors in which points are displayed by selecting
an alternative set of point colors, or by editing an existing one or creating a new
one. To alter the point colors selection, click on the box containing the name of the
current point colors, and then follow the instruction relating to point colors in Using
the File Manager.
Sign Text Colors - Sign text colors are the colors in which zodiac sign glyphs will
appear in any displayed chart. A set of sign colors is a named file containing a list
of which color is assigned to each sign. When the program is first installed, there
are a variety of named sign colors sets which may be selected. It is possible to
alter the colors in which signs are displayed by selecting an alternative set of sign
colors, or by editing an existing one or creating a new one. To alter the sign colors
set, click on the box containing the name of the current sign text colors, and then
follow the instruction relating to sign colors in Using the File Manager. Usually you
will want to choose colors which contrast well with the background color or graphic
e.g. if the background is white, then dark sign colors will be most legible.
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Sign Fill Colors - Sign fill colors are the colors in which zodiac signs in chart zodiac
rings will appear in any displayed chart. A set of sign colors is a named file
containing a list of which color is assigned to each sign. When the program is first
installed, there are a variety of named sign colors sets which may be selected. It is
possible to alter the colors in which signs are displayed by selecting an alternative
set of sign colors, or by editing an existing one or creating a new one. To alter the
sign colors set, click on the box containing the name of the current sign text colors,
and then follow the instruction relating to sign colors in Using the File Manager.
Usually you will want to choose colors which blend well with the background color
or graphic e.g. if the background is white, then light sign text colors will be most
appealing.
Background Color – The background color of the "View Chart" window may be set
with this option. You can select any color, but usually it is best to choose either a
fairly light color or a fairly dark color. If you choose a moderately light or dark color,
then you may have difficulty viewing aspects, points and wheels on the page. This
option determines whether charts and page objects are drawn with dark (black)
outlines or light (white) outlines. When you choose a light color, charts are drawn
with dark lines, and when you choose a dark color, charts are drawn with light
lines, in order to maximize the visibility of the displayed items. Note that if you
choose a dark background graphic, then it will be necessary also to choose a dark
background color to ensure that the chart is drawn with light lines.
Background Graphic – You can select any graphic of type *.jpg, *.wmf, *.gif, from
any location, to display as the background to the "View Chart" window. Ideally you
should choose a graphic which does not have large contrasts in color, to avoid the
possibility of making the charts or page objects difficult to see. If you choose a dark
graphic then you will also need to select a dark (e.g. black) background color to
ensure that the page objects are drawn with light colored lines. Similarly, if you
choose a light graphic then you will also need to select a light (e.g. white)
background color to ensure that the page objects are drawn with dark colored lines.
You have the option to stretch the graphic to fit the size of the display, or to tile it,
in which case the graphic is repeated as many times as needed to fit the full
display area. You can clear any graphic selection by clicking on the Clear button.
The Color Schemes for Chart Art frame allows you to choose special color settings
for any pages which have been designed with full-page background graphics - as is
the case for the "Chart Art" pages in Solar Fire. It is necessary to have a special
color setting for these because Solar Fire would normally display line and text colors
according to the current color scheme selected above, but these settings may clash
with the colors of the background graphic of the page. For example if your current
color scheme is for a light background color then lines are displayed in black, but if
the Chart Art page has a dark colored background graphic, then black lines would
not be very visible on top of that. Therefore most page objects have a "Force Color"
property which may be set in order to ensure that one of the following schemes is
applied to that object instead of the default color scheme selected above.
Light Backgrounds - You can choose any color scheme that has been designed to
work with light backgrounds.
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Dark Backgrounds - You can choose any color scheme that has been designed to
work with dark backgrounds.
Note: If you use a background graphic, then you may notice that some chart wheels are
displayed transparently, so that the graphic shows through them, and some are opaque,
so that the background graphic is not visible inside them. This behaviour depends on
whether the rings within the wheel have been designed to be transparent or to have a fill
color. You can alter any wheel design to make it transparent or opaque by setting the its
ring fill color option in the wheel designer. See Editing a Wheel Design File for further
information.
4.13.15.1 Color Depth

Solar Fire can be used on any computer that is capable of displaying at least 256 colors
or greater color depths known as “HiColor” and “TrueColor”, and in this case you will be
able to generate more attractive displays. In most cases, whenever you select a color
from one of Solar Fire’s color selection options (e.g. sign colors, aspect colors, planet
colors etc.), the color which is actually displayed on the screen will be whichever of the
available colors matches your selected color most closely. If your display supports only
256 colors, then you may find that some of the displayed colors are different from your
original selections. If you are using HiColor or TrueColor, then you will find that the
displayed colors match your original selections very well.
If you have a 256 color display, then Solar Fire allows you to choose from three different
palettes (color ranges) in order to help you most closely match the colors that you have
chosen. The color palettes which are available for displays with 256 colors are as
follows.
Bright Colors - A selection of colors which are at the brighter end of the scale
Pastel Color - A selection of colors which are softer in tone
Rainbow Colors - A selection of colors which covers a wide range of tones
If you are viewing a chart, you will need to click on the ReDraw button to see the effect
of the new palette.
Note: Changing the color palette does not change your original color selection, it only
affects how your color selection is currently displayed. For example, if you choose the
color orange for a planet, then displaying it with the Pastel Colors palette shows it as a
browny color, because that is the closest match to orange in that palette. However, if
you then switch to the Bright Colors palette and redraw the chart, it is displayed as
orange, because an orange color is included in that palette.
4.13.15.2 Changing the number of colors your monitor can display

Most modern computer displays allow you to select how many colors they will display,
so if you are currently displaying only 256 colors, then you can probably alter your
display settings to allow more colors to be displayed.
Warning: It is not recommended that you try the following unless you are proficient in
the use of Windows, and able to deal with potential problems caused by changing the
display driver. For further assistance, you should contact your computer dealer, or a
qualified Windows instructor.
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>> To select a greater color depth for your display
1. Exit from Solar Fire
2. From the Windows "Control Panel", select the Display icon
3. Click on the Settings tab (in Windows 7 click on Change Display Settings, then on
Advanced Settings, then on the Monitor tab)
4. Select a color setting from the Color Palette or Colors drop-down box
Note: If you do not exit from Solar Fire before changing color depth, then some colors
may be displayed incorrectly. If so, you should exit from Solar Fire and then start it up
again. This will clear the problem.
4.13.16 Fonts
It is possible to choose which text font style you wish to use on chart captions displayed
on the screen, as well as another text font style for any charts and reports which are
printed on your printer. You can also select a base font size for printed reports and
tabulations.
When the Solar Fire program is first installed orn you computer, it sets your screen font
as "ET Sans Serif 3" and your printer font as "ET Symbol 3". However, you are free to
select alternative fonts if you so wish. If you select any other fonts, then Solar Fire will
use your selected font for displaying any normal text, but will continue to use the
astrological fonts when displaying any astrological symbols.
These two fonts contain all the astrological symbols that are needed by the program,
without which you will not be able to display charts and reports with astrological
symbols. Therefore you must not delete them from your computer. If, for any reason,
these fonts are removed, then Solar Fire will display spurious symbols instead of the
correct astrological symbols.
One reason you may wish to change the fonts Solar Fire uses would be to access
alternative characters specific to a certain language. These characters are saved with
the charts they are used with, and reappear whenever the chart is opened again
TIP: to access characters like "ä" used in European languages change the screen font to
MS Sans Serif and the printer font to Arial.
>> To examine or alter the existing font selections
Choose the Fonts option from the Chart Options menu.
This will display the "Font Selection" screen, which allows the selection of any
available font for your printer or screen.
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When this screen is first displayed, the current font selections will be highlighted in each
of the list boxes.
>> To change a font selection
Select a font name from either list box.
An example of text in the selected font is shown in the display boxes below each list.
Some printer fonts cannot be displayed on the screen, in which case the display box
will contain a message to this effect.
>> To alter the base font size used for printing reports, time maps and graphic
ephemerides
Select a font size from the drop-down list.
Note: This base font size does not affect printed charts or user defined pages, as
these use font sizes which vary according to user-defined font size selections in the
wheel and page designs, and also on the size of the displayed page.
>> To activate the new font selections
Click on the Select button.

4.14

Working with Life Events
Solar Fire allows you save an unlimited number of life event records for any natal type
chart. These life events are saved with the natal chart (provided that the chart file to
which they are being saved is a SFv6/v7 format chart file), and the events remain
permanently linked with it.
The advantage of storing life events along with a natal chart is that it makes it very quick
and easy to cast subsidiary charts (such as transits, progressions and others) for these
events without ever having to re-enter any of the event data, as well as being able to
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select these events from a pop-up list when working with the natal chart in the
animation module, again without having to re-enter any of the event data.
It is possible to import life events from the individual natal charts in a chart file, and also
to export life events into natal charts in a chart file. Thus, if you already have a chart file
that contains an ordinary natal chart for each life event of someone’s life, you can
automatically copy those into life events records.
Note – you cannot save life events to any older format Solar Fire charts (such as SFv1/v2,
SFv3/v4 or SFv5). If you try saving a chart that includes life events into one of these chart
files, then you will be given a warning message telling you that the life events will not
be saved if you save the chart into that chart file. If you do not already have a new
format (SFv6/v7) chart file, then you must first create a new chart file (by using the
Create button in the "File Manager"), and choose the option to create it with the new
chart file format when prompted.
4.14.1 Editing Life Events
It is possible to open the life events dialog from various places in Solar Fire, including
the Main Screen, the New Chart Data Entry screen, various Subsidiary Chart Data Entry
screens, the Animation screen etc.
>> To Open the Life Events dialog box from the Main Screen
1. Choose Edit / Edit Chart Events… from the Chart menu or
2. Click on the Events caption at the bottom of the Current Chart box
>> To Open the Life Events dialog box from the New Chart Data Entry Screen or
from any subsidiary chart data entry screen
Click on the Events button
This will display the Life Events dialog box.
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>> To add a new event
Click on the Add New button.
This will create a new entry ready for you to edit.
>> To delete an event
1. Highlight the event you wish to delete.
2. Click on the Delete button.
>> To edit an event
Use the fields and buttons in the "Event Details" frame to edit the various event
details as required.
Note that the various fields and buttons in this frame work identically to those of
similar appearance in the New Chart Date Entry dialog. See The “New Chart Data
Entry” Dialog Box for a full explanation of how to use these items.
>> To sort events into date order
Click on the Sort button.
>> To import events from a chart file
1. Click on the Import button. If necessary, navigate to the folder in which the
required chart file resides.
2. Select the required chart file and click OK.
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This will import all the charts from the selected chart file, add them to any events that
are already present, and then sort them all into date order.
Note: You cannot overwrite any existing events. If you wish to discard any existing
events, then you must delete them first.
Note: If you do not wish to use all the charts in the selected chart file as life events,
then you will have to delete any events not required after importing them all.
>> To export events to a chart file
1. Click on the Export button. If necessary, navigate to the required folder.
2. Either select an existing chart file, or enter a name for a new chart file.
3. Select the required chart file and click OK.
This will export all the life events records and save them as natal charts in the
selected chart file.
Note: If there are any existing charts already in the selected chart file, then the life
event records will be appended to those existing charts.
Note: All life events in the list are exported. If you do not wish to use all the life
events as charts, then after exporting, you will need to open the chart file and delete
the unwanted charts.

4.15

Casting Subsidiary Charts
This chapter describes how to select, enter data for and cast Solar Fire's subsidiary chart
types. These types include
Transit charts
Progressed charts - secondary, tertiary, minor, user-defined rate
Directed charts - solar arc, ascendant arc, vertex arc, user-defined arc, van Dam
Return charts - any planet or asteroid, any harmonic, plus Wynn-Key and progressed
solar returns
Ingress charts - any planet or asteroid
Harmonic charts - any harmonic or age harmonic
Arc Transform charts - any pair of chart points
Antiscia (Solstice) or Contra-Antiscia charts
Zodiacal Analogue charts
Relationship charts - with 2 charts
Composite charts - up to 15 charts
Coalescent charts - with 2 charts
Prenatal charts - 19 types
Rising/Setting charts - rising, setting, culminating or anti-culminating of any planet
or asteroid
Lunar phase and eclipse charts - any of the main transiting phases or progressed
phases plus lunar phase return charts
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Locality charts - relocated, Johndro or Geodetic
Vedic charts – various Vedic divisional charts
Note: A Natal chart is a chart cast at the time of the birth of usually a person or a
country. An Event chart is a chart cast at the time that an event occurred (e.g. a marriage
between two people). A Radix chart is a chart that is being used as a "base" chart.
"Radix" means base, the core. Natal charts are generally referred to as radix charts, as a
natal chart is usually the beginning or "base" of all astrological calculations regarding a
person and their life - after all it signifies the beginning of the person's autonomous life.
However a natal chart is not always the "base" of astrological work. For instance you
may be working with an event (e.g. a marriage) and calculating transits to that event or a
solar return of that event, i.e calculating transits to the marriage chart, or the marriage
return chart. In this example Solar Fire would regard the marriage chart or return chart,
which is an event/return chart, as the radix chart. If you were calculating transits for a
person, however, their natal chart would be the radix chart.
4.15.1 Selecting a Base Chart
Nearly all subsidiary chart types require a base chart, which is usually a natal chart. If
you have not already cast the natal chart see Casting a Natal Chart for instructions on
creating a new chart, or Retrieving Charts From a File for instructions on opening an
existing chart.
You can cast most subsidiary chart types for any natal chart. This is done in the relevant
subsidiary chart data entry dialog (e.g. the "Returns & Ingresses" dialog, or the "Transits,
Progressions & Directions" dialog, available form the "Chart" menu). Each of these
dialogs has a "Base Chart" listbox, containing all the charts opened in the "Calculated
Charts" list.
Whether or not you can use types of charts other than a natal chart as a base chart
depends on the type of subsidiary chart (return, progression etc.) you are casting. If the
base chart that you select is inappropriate, then the data in the Base Chart Details box
will become grayed out, and the OK button will become greyed out and disabled. In this
case you cannot proceed until you choose another base chart which is of an appropriate
type.
4.15.2 Selecting or Entering Event Details
If the base chart you are using has any stored life events associated with it, then you
have the option of selecting one and having it's details used to automatically fill in the
event details instead of entering them all manually.
If you would like to re-use any new event details that you are about to enter, then you
can create a new life event to be stored with the base chart instead of making a one-off
data entry here.
>> To create a new stored Life Event for this base chart
1. Click on the Events button, which opens the Event Selection dialog.

© 2014 Esoteric Technologies Pty Ltd

Basic Operations

149

2. Click on the Edit button, which opens the Life Events dialog, ready for you to add a
new life event.
Once you have created the new Life Event, you can select it by highlighting it in the
Event Selection dialog and clicking the OK button.
>> To select a previously stored Life Event
1. Click on the down arrow at the right of the Event Description box, and select one
of the events from that drop-down list, OR
2. Click on the Events button, and select one of the events from the Event Selection
dialog box.
Whether or not you are using stored Life Event details here, you have the option of
entering an event description. This description becomes the main title of the subsidiary
chart to be calculated, with the base chart name as a secondary title.
If you omit an event description, then the subsidiary chart title is simply the same as that
of the base chart.
4.15.3 Entering Subsidiary Date, Time and Place Data
If you have not selected a stored Life Event, then you must enter the event details in this
dialog manually.
The Date, Time, Place, Country, Zone, Latitude and Longitude fields in the subsidiary
charts data entry screens follow the same data-entry conventions as those in the New
Chart Data Entry screen, and you can use the Solar Fire place database and ACS Atlases
in the same way. Most forms of data entry will work, and Solar Fire will give you a
message if the data that you enter is not acceptable. See Casting a New Chart for further
information.
4.15.4 Casting a Transiting, Progressed or Directed Chart
You can create a progressed or directed chart from any natal type chart. You can
progress geocentric, heliocentric, Tropical and Sidereal charts. The resulting coordinate
system and zodiac type of the progressed chart are always of the same as those of the
natal type chart that you are progressing.
Whilst it is also possible to cast a transits chart as if it was an ordinary natal chart
independent of any other chart by using the Chart / New menu item, casting it is as a
subsidiary chart instead has the following advantages.
It is possible to retrieve stored Life Events details instead of having to re-enter
them as you cast the chart
The transits chart can include an event description
It is possible to apply precession correction or a converse transits option
The progression rate may be:-
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Secondary - a day for a year
Mean tertiary - a day for a mean lunar month
True tertiary - a day for each true lunar month
Minor - a mean lunar month for a year
User-defined - a rate that can be set in the Preferences dialog
The direction arc may be:Solar Arc - the longitudinal distance moved by the secondary progressed sun
Ascendant Arc - the longitudinal distance moved by the secondary progressed
ascendant
Vertex Arc - the longitudinal distance moved by the secondary progressed vertex
User Rate - a rate that can be set in the Preferences dialog
User Arc – a fixed angle that can be set each time this option is used
Profection Annual – an annual rate of 30 degrees, corresponding to a direction of
one sign (or house) per year.
Progressed charts are calculated according to certain options that are set in the
Preferences dialog.
>> To pre-set basic progression options
From the Preferences menu of the Main Screen, select Edit Settings, and click on
the Progs/Dirns tab.
Chart Angle Progressions Type - to determine how to progress the Midheaven
(which also determines the Ascendant, house cusps and other chart angles). See
Chart Angle Progression Type.
Progression Day Type - to determine the type of daily cycle on which the
progression rate is based. See Progression Day Type.
User Progression Rate - to determine what progression rate is used when the
User-Defined progression rate option is chosen. See Rate for User Defined Progs.
User Direction Rate - to determine what annual direction rate is used when the
User-Defined direction arc option is chosen. See Rate for User Defined Directions.
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>> To cast the transiting, progressed or directed chart
1. Ensure that the required natal type chart that you want to progress or direct is
already calculated.
2. Choose the Tran/Prog/Dirn menu item from the Chart menu
3. Select a chart type from the Chart Type to Generate list box.
4. Select a chart from the Base Chart list box.
5. Enter the Date to which you wish to progress or direct the base chart.
6. (Optional) Enter the Time to which you wish to progress or direct the base chart.
The time is not important for secondary progressed chart (and most directed
charts), unless the Mean Quotidian rate is being used for angle progressions.
7. Select the Location type. Normally the location of a progressed or directed chart
would be the same as the natal chart location. However, if the natal chart is that
of a person who moved during the first few months of their life, it may be
appropriate to relocate the secondary progressed chart. If the Natal option is
selected then all the boxes relating to location, including time zone, longitude and
latitude will contain the location details from the selected base chart. Note that
although it may be technically correct to alter the time zone if the current time
zone is different from the natal one, in practice this is not necessary, as the
difference in the resultant progressed chart would be negligible. If the Relocated
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option is selected then all the boxes relating to location, including time zone,
longitude and latitude will contain the current default values. (See Saving and
Restoring Settings for details on default values.) Any of these values may be
altered in the same manner as when creating a new chart. See Casting a New
Chart for instructions on how to alter location values.
8. (Optional) Select Special Options. It is possible to apply two types of special
options to the calculation of the progressed or directed chart. If the Prec. Corr.
option is checked, then the calculation of the chart will be done according to how
far the planets have moved on the Sidereal zodiac, rather than the Tropical zodiac.
However, the resulting chart will be still be calculated for the Tropical Zodiac. Note
that if the base chart which you are progressing or directing already has a Sidereal
zodiac, then this option will have no effect, and the resulting chart will have a
Sidereal zodiac. Note that for most progressed or directed charts, the effect of
precession is negligibly small, and this option is included for completeness. If the
Converse option is checked, then the calculation of the progressed or directed
chart will be done backwards in time from the time of the base chart instead of
forwards. An additional arc multiplier button (Mult) is visible whenever Solar Arc,
Ascendant Arc or Vertex Arc directions have been selected as the method to
calculate. Clicking on this button produce a drop-down menu with the possible arc
multipliers - x1 (Normal), x2 (Double Arc), x0.5 (Half Arc), x-1 (Negative Arc), x-2
(Negative Double Arc), x-0.5 (Negative Half Arc).
9. Select either the Apply or OK button. The subsidiary chart will be calculated and
added to the list of "Calculated Charts" in the list box on the Main Screen of the
program. Use the OK button to close this dialog after the calculation. Use the
Apply button to leave this dialog open to calculate further charts. After this dialog
closes, you can view, print, report on, and otherwise manipulate the newly
calculated charts.
TIP: You can use a synastry grid to display a snapshot of the current transits to a natal
chart. This lets you see the current transits to a natal chart in a compact form and very
quickly. This is not limited to transits - you can also use this method to see a snapshot
for progressions/directions/return charts etc to a natal chart, or transits to a progressed
chart if you wanted.
>> To display or print a snapshot of current transits to a natal chart in a grid
1. Either cast a new natal chart, or open an existing natal chart, that you wish to see
current transits for.
2. Cast a current transits (or progressed, directed, return) chart. This can be done in
this module.
Optionally for transits you can simply cast a new chart for the current time and location...
a) From the Main Screen click on the Chart menu then select New (or press the F2 key).
b) Click on the Now button.
c) Enter the Place and Country. If you are currently located at the place set as the Default Place
(see Setting the Default Place) this will usually automatically be entered into the "Place" and
"Country" fields - if it isn't, and you are at the default location, then press the Restore button
which will enter the default place information for you.
d) Click the OK button.
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3. Select the Synastry Grid option from the View menu on the Main Screen (or press
Ctrl+F5 - see Short-Cut Keys for more information)
TIP: If you first select both charts in the "Calculated Charts" list, you can then
simply press Ctrl+F5 which will load the charts into a synastry grid directly, and
steps 4 & 5 will not be necessary.

4. Select the natal chart as the Across chart, and the Transits/Progressed/Directed/
Return chart as the Down chart.
5. Click on the View button. The grid will be displayed.
TIP: If you used the short-cut key to load the grid, the Transiting points may be across the top of
the grid and the Natal chart points down the side of the grid. To reverse this situation and get
the Natal chart to be across the top click on the Swap button. Generally this is advantageous
as Solar Fire will apply aspect orbs set for transits in the aspect file in use if you do this.

You can now see the aspects made by the transiting (or progressed, directed, return)
planets and points to the natal chart planets and points. Double-clicking with the left
mouse button on any aspect will pop up the "Interpretations Window" with an
interpretation for that transit, progression or direction (if one exists).
If you are doing this for transits while residing at your default location this is a superfast method of creating a snapshot of current transits to a natal chart, as by using
shortcut keys and Solar Fire's default data entries it can be usually accomplished in just
a few seconds. And you can also do a snapshot of transits to a progressed chart using
this method too if you wished to.
Note: Transiting and progressing aspects to a natal chart usually have an orb of 1
degree. If the aspects in your snapshot have a bigger orb this is because, in the aspect
file being used, the orb set for "Tran" (transits) or "Prog" (progressions) for these
aspects is set to be larger than 1 degree. You can alter this by re-setting these orbs in
the aspect file.
Alternatively you can select (or create if necessary) an aspect file that has orbs of 1
degree set for all aspects for all types of orb - natal, progressing and transiting, and
always select that aspect file when viewing a snapshot.
See Editing an Aspect Set for information on setting orbs in aspect files.
4.15.5 Casting a Return, Ingress or Transit Chart
You can cast solar, lunar, planetary or asteroid returns, ingresses into any zodiac sign, or
transits to any planet in a base chart or to any user-defined zodiac point. You can also
produce multiple returns from one starting date, including demi, quarti and other partial
or harmonic returns. You can also calculate two types of progressed solar returns.
You can cast returns for geocentric, heliocentric, Tropical and Sidereal charts. The
resulting coordinate system and zodiac type of the progressed chart are always of the
same as those of the natal type chart that you are progressing.
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>> To cast a single Solar or Lunar return or Wynn-Key or Progressed Solar Return
1. Ensure that the natal type chart that you want the return for is already calculated.
2. Choose the Return menu item from the Chart menu
3. Select the required chart type from the Chart Type to Generate list box.
4. Select a chart from the Base Chart list box.
5. Enter the Date from which you wish to search, or for Wynn-Key or Progressed Solar
Returns enter the exact date for which you wish to calculate the return chart.
6. The Time is not needed for ordinary solar or lunar returns, as the program will find
the exact time of the return. However you should enter a time for Wynn-Key or
Progressed Solar Returns, as this is used as the time for which the return is
calculated.
7. Select the Location type. Often the return chart is relocated to wherever the
person is living at the time of the return. If the Natal option is selected then all the
boxes relating to location, including time zone, longitude and latitude will contain
the location details from the selected base chart. Note that although it may be
technically correct to alter the time zone if the current time zone is different from
the natal one, in practice this is not necessary, as the difference in the resultant
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progressed chart would be negligible. If the Relocated option is selected then all
the boxes relating to location, including time zone, longitude and latitude will
contain the current default values. (See Saving and Restoring Settings for details on
default values.) Any of these values may be altered in the same manner as when
creating a new chart. See Casting a New Chart for instructions on how to alter
location values.
8. Select a Which Return option. If the "Current" option is selected, then Solar Fire
will search backwards from the entered date to find the return that occurred most
recently. If the "Next" option is selected, then Solar Fire will search forwards from
the entered date to find the return that will occur next. If the "Nearest" option is
selected, the Solar Fire will find either the current or the next return, depending on
which is closer to the entered date.
9. (Optional) Select Special Options. It is possible to apply two types of special
options to the calculation of the progressed or directed chart. If the Prec. Corr.
option is checked, then the calculation of the chart will be done according to how
far the planets have moved on the Sidereal zodiac, rather than the Tropical zodiac.
However, the resulting chart will be still be calculated for the Tropical Zodiac. Note
that if the base chart which you are using already has a Sidereal zodiac, then this
option will have no effect, and the resulting chart will have a Sidereal zodiac. For
each year of life, about 50 seconds of arc will be added to the return planet’s
longitude, thus allowing for the precession of the equinoxes. If the Converse option
is checked, then the calculation of the progressed or directed chart will be done
backwards in time from the time of the base chart instead of forwards.
10.Select either the Apply or OK button. The subsidiary chart will be calculated and
added to the list of "Calculated Charts" in the list box on the Main Screen of the
program. Use the "OK" button to close this dialog after the calculation. Use the
"Apply" button to leave this dialog open to calculate further charts. After this
dialog closes, you can view, print, report on, and otherwise manipulate the newly
calculated charts.
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>> To cast multiple solar, lunar or other returns
1. Follow the steps 1 to 7 above, under “To cast a single solar or lunar return”.
2. In the Chart Type to Generate box, select Advanced & Ingress, and then click on
the Options button. This will display the “Advanced Return Selections” dialog box.
3. From the list of chart points on the left of the screen, select the body for which you
wish to find a return.
4. Select the options in the Which Return/s and Special Options as in steps 8 and 9
above.
5. Next to Number of Returns, type in the number of successive returns that you
want, or click on the spin button to increase or decrease the number of returns.
6. Select the OK button. Solar Fire will calculate the first return just as it would for a
single return chart, and then each successive return after that up to the number
that you specified. When you return to the Main Screen, you will find that all these
returns have been added to the "Calculated Charts" listbox.
>> To cast demi, quarti or other harmonic returns
1. Follow the steps 1 to 5 above, under “To cast multiple solar, lunar or other
returns”.
2. In the "Return...To" area, select Natal Position, and next to Harmonic, type in a
number or use the spin button to change the number. You would enter 2 for demi
returns, 4 for a quarti returns, etc.
3. Select the OK button.
>> To cast planetary or asteroid returns
Proceed as you would for casting multiple returns, choosing a planet or asteroid
instead of the Sun or Moon, and then select the OK button.
If you are casting geocentric planet/asteroid returns, then it is possible that there
may be three or even five possible dates for that return. If so, then a "Return
Selection" dialog box will appear containing a list of all the dates, showing whether
each return is direct or retrograde.

© 2014 Esoteric Technologies Pty Ltd

Basic Operations

157

If only one return date is found, then the chart for that date is calculated automatically,
and the temporary dialog box will disappear. If more than one return is found then you
may choose one or more of the return charts to be calculated. Use the Ctrl key whilst
clicking on each required chart in order to make multiple selections. (Note that if you
have specified a number of returns greater than 1, then selecting the Cancel button will
prevent any further returns from being calculated.)
Note: Even with the most accurate astronomical calculations, the slower a planet is
moving, the harder it is to pinpoint the exact time of its return. For outer planets in
general, and for inner planets when they are near a station point, it is best to treat the
chart angles and house positions as approximate. In the chart details of the return chart,
an estimated accuracy of the return time is given, so that you can judge how accurate
the chart angles and house cusps really are, in each case.
>> To cast a chart for a sign ingress or for a transit to any planet or user-defined
point
1. Follow the steps 1 to 5 under “To cast multiple solar, lunar or other returns”.
2. In the "Return...To" area, select Position or Ingress, and in the drop-down box
below this, either select one of the existing longitudes for sign ingresses, or type in
your own value. If you are finding a return to a planet’s position, then you can
automatically insert that planet’s position into this box by double-clicking on that
planet in the listbox on the left of the screen. (However, don’t forget to
subsequently reselect the required return planet by highlighting it with a single
click.)
3. Select the OK button.
4.15.6 Casting an Harmonic, Transform, Antiscia or Analogue Chart
You can create an harmonic, arc transform, antiscia or contra-antiscia or zodiacal
analogue chart from any other type of chart.
These chart types are calculated as follows...
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Harmonic - The longitude of each point in the chart is multiplied by the specified
harmonic value.
Harmonic Age - The longitude of each point in the chart is multiplied by the exact
age (in decimal years) of the base chart’s subject at the time of the event. (The
harmonic value is zero at time of birth.)
Harmonic Age+1 - The longitude of each point in the chart is multiplied by the
exact age of the base chart’s subject at the time of the event plus one year. (The
harmonic value is one at time of birth.)
Arc Transform - The longitude of each point in the chart is multiplied by an
harmonic value calculated from the longitudinal separation between a pair of points
in the chart. This has the effect of bringing that planetary pair into exact
conjunction in the Arc Transform chart.
Antiscia - The longitude of each point is reflected in the 0 Cancer/0 Capricorn
(Solstice) axis.
Contra-antiscia - The longitude of each point is reflected in the 0 Aries/ 0 Libra
axis.
Long Equiv Decl – The declination of each point is converted into longitude
equivalent (keeping it in the same quadrant of the circle as its original longitude).
Long Equiv Decl (Ant) – The declination of each point is converted into longitude
equivalent and then reflected in the 0 Cancer/0 Capricorn axis.
Z-Analogue Latitude – Zodiacal analogue of latitude. The latitude of each point is
expressed as a longitude. Latitudes from 0 to +90 degree correspond to 0 Aries to 0
Cancer, whereas latitudes from 0 to –90 degrees correspond to 0 Aries to 0
Capricorn.
Z-Analogue RA – Zodiacal analogue of right ascension. The right ascension of each
point is expressed as a longitude.
Z-Analogue Decl - Zodiacal analogue of declination. The declination of each point
is expressed as a longitude. Declinations from 0 to 90 degree North correspond to 0
Aries to 0 Cancer, whereas declinations from 0 to 90 degrees South correspond to 0
Aries to 0 Capricorn.
Z-Analogue Azi - Zodiacal analogue of azimuth. The azimuth of each point is
expressed as a longitude. Due east corresponds to 0 Aries, and due north
corresponds to 0 Cancer. Although this is the traditional way of displaying azimuth
as a zodiacal analogue, in contrast with the local horizon coordinate chart, it
produces a rotated image of the true compass directions (rotated by 180 degrees),
so cannot easily be used as a map overlay.
Z-Analogue Loc Horz - Zodiacal analogue of local horizon coordinate. The local
horizon coordinate of each point is expressed as a longitude. Due west corresponds
to 0 Aries, and due north corresponds to 0 Capricorn. This produces a chart which
corresponds to planetary compass directions for the chart’s location, and is similar
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to the Local Horizon chart generated by Solar Maps.
Z-Analogue Altitude - Zodiacal analogue of altitude. The altitude of each point is
expressed as a longitude. Altitudes from 0 to +90 degree correspond to 0 Aries to 0
Cancer, whereas altitudes from 0 to –90 degrees correspond to 0 Aries to 0
Capricorn.
Z-Analogue Prime Vert - Zodiacal analogue of prime vertical. The prime vertical of
each point is expressed as a longitude. This chart is also known as a Campanus
Mundoscope.
Z-Analogue PV Amp - Zodiacal analogue of prime vertical amplitude. The prime
vertical amplitude of each point is expressed as a longitude. Prime vertical
amplitudes from 0 to +90 degree correspond to 0 Aries to 0 Cancer, whereas prime
vertical amplitudes from 0 to –90 degrees correspond to 0 Aries to 0 Capricorn.
Z-Analogue Diurn Arc - Zodiacal analogue of diurnal arc. The diurnal arc of each
point is expressed as a longitude. Points which do not cross the horizon during their
diurnal rotation are omitted and are not displayed. 0 Aries corresponds to rising
across the horizon, 0 Capricorn to culminating, 0 Libra to setting across the horizon,
and 0 Cancer to anti-culminating. This chart is also known as a Placidus
Mundoscope.
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>> To cast an harmonic, antiscia, contra-antiscia, longitude equivalent or zodiacal
analogue chart
1. Ensure that the natal type chart that you want to use is already calculated.
2. Choose the Harmonic/Transform menu item from the Chart menu
3. Select the required chart type from the Chart Type to Generate list box.
4. Select a chart from the Base Chart list box.
5. [Harmonic Only] Type a numerical value into the Harmonic box, or use the spin
button to set an integer value. The harmonic value may be any positive number,
either integer or real (i.e. it may contain decimal places).
6. [Arc Transform Only] Select a planetary pair from the Arc Transform Pairs list.
7. Select either the Apply or OK button.
The subsidiary chart will be calculated and added to the list of "Calculated Charts"
in the list box on the Main Screen of the program. Use the OK button to close this
dialog after the calculation. Use the Apply button to leave this dialog open to
calculate further charts. After this dialog closes, you can view, print, report on, and
otherwise manipulate the newly "Calculated Charts".
>> To cast an age or age+1 harmonic chart
1. Ensure that the natal type chart that you want to use is already calculated.
2. Choose the Harmonic item from the Chart menu
3. Select the required chart type from the Chart Type to Generate list box.
4. Select a chart from the Base Chart list box.
5. Either select a stored life event or enter the event details into the appropriate edit
boxes.
6. Select either the Apply or OK button. The subsidiary chart will be calculated and
added to the list of "Calculated Charts" in the list box on the Main Screen of the
program. Use the "OK" button to close this dialog after the calculation. Use the
"Apply" button to leave this dialog open to calculate further charts. After this
dialog closes, you can view, print, report on, and otherwise manipulate the newly
"Calculated Charts".
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4.15.7 Casting a Combined Chart
This section describes how to create a composite, relationship or coalescent chart by
combining two charts, or a group composite chart composed of up to 15 base charts.

>> To cast a composite, Davison relationship or coalescent chart
1. Ensure that the natal type charts that you wish to combine are already calculated.
TIP: If you are just combining two charts, first select both charts you want to
combine, then you can skip step 4 (nominating the charts to use)
2. Choose the Combined menu item from the Chart menu
3. Select the required chart type from the Chart Type to Generate list box.
4. Select two or more charts from the Base Chart list box. Holding down the Ctrl key
allows multiple charts to be selected at once. You should only select two charts,
unless you have selected the “Composite Group” chart type, in which case you may
select up to 15 charts.
5. (Optional) Edit the Title1 and Title2 boxes. As charts are selected, these title
boxes are automatically updated. When either one or two charts are selected, the
title list boxes contain the chart name of each chart suffixed with its chart type.
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When more than two charts are selected then the Title1 box contains the last
names of each selected chart, separated by slashes (/), and the Title2 box contains
the chart type of the first selected chart on the list of base charts. These titles will
appear whenever the chart is displayed or printed. These may be edited if you
wish.
6. Select the Location type. If have selected the “Composite - Midpoints” or
“Relationship - Davison” then this option will be disabled, and you can pass to the
next step. Normally the combined chart is relocated to wherever the relationship
exists.
If the Natal option is selected then all the boxes relating to location, including
time zone, longitude and latitude will contain the location details from the
selected base chart, although only the latitude is used in the chart calculation.
If you select the Relocated option, then all the boxes relating to location will
contain the current default values, and you can enter new location data if you
wish to. (See Saving and Restoring Settings for details on default values. See
Casting a New Chart for instructions on how to alter location values).
7. If the Relocated option is selected then all the boxes relating to location, including
time zone, longitude and latitude will contain the current default values. Any of
these values may be altered in the same manner as when creating a new chart. .
8. Select either the Apply or OK button. The subsidiary chart will be calculated and
added to the list of "Calculated Charts" in the list box on the Main Screen of the
program. Use the OK button to close this dialog after the calculation. Use the Apply
button to leave this dialog open to calculate further charts. After this dialog closes,
you can view, print, report on, and otherwise manipulate the newly calculated
charts.
Note - You cannot calculate a composite chart based on other composite charts. The
mathematical basis on which composite charts are calculated does not work if
composite charts are combined. The only way of combining more than two natal charts is
to use the “Group Composite” method.
4.15.8 Casting a Prenatal Chart
This section describes how to create a prenatal chart for an individual whose natal chart
has already been cast. The most commonly used type of prenatal chart is the conception
chart, for which two different methods of calculation are available. However, there are
many other types of prenatal chart type available, plus the ability to derive a natal chart
from the date of conception or quickening, if they are known. See Prenatal Charts for a
full discussion of the different types of prenatal charts that can be calculated.
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>> To cast a prenatal chart
1. Ensure that the base chart that you wish to use is already calculated.
2. Choose the Prenatal menu item from the Chart menu
3. Select the required chart type from the Chart Type to Generate list box.
4. Select a chart from the Base Chart list box.
5. Select the Location type. Normally, a prenatal chart should be located where the
individual was at the time of the prenatal chart. For example, a conception chart
should be located to where the conception took place. However, for some of the
other prenatal chart types you cannot know a definite location. In these cases it is
recommended that the natal location is used.
If you select the Natal option, then all the boxes relating to location will contain
the location details from the base chart.
If you select the Relocated option, then all the boxes relating to location will
contain the current default values, and you can enter new location data if you
wish to.
6. If the prenatal chart type is one for which the calculation is based on a number of
lunar cycles, then you can specify the number of cycles in the Lunar Cycles box.
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The number of lunar cycles is automatically preset to a suggested value e.g. for the
conception charts it is set to 10 lunar cycles (about 273 days) which is the normal
term of pregnancy. If you know that the pregnancy was especially short or long
term, then this number may be changed.
7. If you have selected a “Bailey Conception” or “Bailey Birth (C)” charts, you should
indicate the sex of the individual using the Sex of Subject option buttons. If the
sex is not known, then the best alternative is to use the Jayne Uranus (C) or Jayne
Birth (C) chart types instead, as these are equivalent to the Bailey Conception and
Birth charts but ignore the sex of the subject.
8. Select the OK or Apply button
A dialog box may appear listing details of the possible prenatal charts. You can select
one or more entries from the list and then select the OK button in order to calculate
the selected charts. These calculated charts will be added to the list of "Calculated
Charts" on the Main Screen.
4.15.9 Casting a Rising/Setting Chart
This section describes how to create a chart for the moment of rising, setting,
culmination or anti-culmination of any planet or asteroid on any given day. For rising and
setting charts it is possible to choose whether to calculate the chart for the time at
which the planet or asteroid would appear to cross the horizon visually, or alternatively
to calculate the chart for the time at which its center crosses the true astronomical
horizon.
You can create these types of charts without a base chart. However, if you wish to base
them on the date of an existing chart, you should have already cast or opened the chart
that you wish to use.
1. Choose Rising/Setting from the Chart menu.
2. Select the chart type you want from the Chart Type to Generate list box.
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>>> To base the rising/setting chart on the date and location of an existing chart:
3. Select a chart from the Base Chart list box.
>>> To do a rising/setting chart for some other date or place:
4. Fill in the required Date, or click on the Now button for today’s date.
5. Select the Relocated option button and fill in the required location details.
If you are doing a rising or setting chart (as opposed to a culmination or anticulmination chart), select one of the following Rise/Set Type options
6. Set Rise/Set Type
"True Altitude" - the rising or setting time is that for which the center of the body
crosses the astronomical horizon. This ignores atmospheric refraction, the size of
the body and parallax effects.
"Visual" - the rising or setting time is that for which the leading edge of the body
rises or the trailing edge would set visually on an idealized flat horizon. This
takes account of atmospheric refraction and the size of the body. In the case of
the moon, the lunar parallax is also taken into account.
7. Select the OK button.
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A dialog box will appear listing the times of rise, set, culmination and anticulmination were found. Select one or more entries on the list and then select the OK
or Apply button in order to generate the charts. These charts will be added to the list
of "Calculated Charts" on the Main Screen.
4.15.10 Casting a Lunar Phase or Eclipse Chart
This section describes how to create a chart for...
Progressed Lunar Phases - Any of 8 main progressed lunar phases (new moon,
crescent, first quarter, gibbous, full moon, disseminating, third quarter, balsamic),
starting 2 phases prior to the search date.
Transiting Lunar Phases - Any of the 4 main transiting lunar phases (new moon, first
quarter, full moon, last quarter), starting 4 phases prior to the search date.
Phase Returns - Any lunar phase return (a chart in which the phase angle between
the sun and the moon returns to its natal phase angle), starting one lunar month
prior to the search date.
Phase Family - Any lunar phase belonging to a “moon phase family”, connected to
the other members in the family either past or present. The Lunar Gestation Cycle
divides the "Moon phase family" by 9 month intervals beginning the series at any
New Moon and locates the next or nearest "family related" Moon phase being a
First Quarter, Full Moon and finally Last Quarter Moon, all occurring at similar
positions in the zodiac. (For a detailed explanation, please see the book “Lunar
Shadows, The Lost Key to the Timing of Eclipses” by Dietrich Pessin, who originated
this concept.)
Eclipses (List) - Any total or partial solar or lunar eclipse, selectable from a list,
starting one year prior to the search date. Note: The calculated eclipse times may
be either times of maximum eclipse or times of exact lunar phase depending on the
eclipse settings in Preferences.
Eclipse (Solar or Lunar) - The most recent or next eclipse of any type.
Eclipse (Solar only) - The most recent or next solar eclipse.
Eclipse (Lunar only) - The most recent or next lunar eclipse.
New Moon - The most recent or next new moon.
Full Moon - The most recent or next full moon.
New or Full Moon (Syzygy) - The most recent or next syzygy moon.
You can create a transiting lunar phase chart without a base chart. However, before
creating any other type of lunar phase or eclipse chart, it is necessary to have either
cast or opened the base chart that you wish to use.
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>> To cast a transiting, progressed or lunar phase return or family chart
1. Choose Lunar Phase from the Chart menu.
2. Select the chart type you want from the Chart Type to Generate.
3. If you want to base the lunar phase chart on an existing chart, then select a chart
from the "Base Chart" list box. This is optional for transiting lunar phase or family
charts, but obligatory for progressed phases.
4. Optionally enter or select event details (including Date and Time around which to
search for the charts). As the program will find the exact time of the lunar phases
around the entered date, there is often no need to enter or alter the time.
5. If you have selected “Progressed Lunar Phases” or “Lunar Phase Returns”, then
you will probably want to select a current date. You can do this by either manually
entering a new date, or by selecting the Now button. For all other chart types to
generate, selecting a base chart will automatically set the date and time from the
base chart. This makes it quick and easy to find the prenatal lunar phases and
eclipses.
6. Select Location type.
If you select the Natal option, then all the boxes relating to location will contain
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the location details from the base chart.
If you select the Relocated option, then all the boxes relating to location will
contain the current default values, and you can enter new location data if you
wish to.
7. If you have selected a chart type to generate that produces a list of possible events
to choose from, then you can set the number to find in the Phases to Find or
Eclipses to Find box.
8. If you have selected a chart type to generate which results in a single chart, then
you can choose whether to find the chart prior to (Current), nearest to (Nearest), or
after (Next) the search date in the Which One box. If your search date is the date
of your base natal chart, then the Current option will find a pre-natal chart, and
Next will find a post-natal chart.
9. Select the OK or Apply button.
10.For those chart types to generate which produce selection lists, a dialog box will
appear listing the lunar phases that were found and their dates and times. You can
select one or more entries on the list and then select the OK button in order to
generate the charts for the chosen lunar phases. Any charts calculated from this
procedure are automatically added to the list of "Calculated Charts" on the Main
Screen.
4.15.11 Casting a Locality or Relocated Chart
This section describes how to relocate a chart or to cast a chart for a locality.
The types of locality charts that may be calculated are...
Relocated - calculated for the exact same time as the base chart, but for a different
latitude and longitude.
Geodetic - using either right ascension or longitude, and optionally allowing a userdefined geographic longitude base point. This technique involves adjusting the MC
of the base chart according to a projection of the zodiac onto the earth’s surface.
Johndro - using either right ascension or longitude. This technique is similar to the
geodetic technique, but incorporates a zodiacal precession adjustment in fixing the
base point longitude.
You can create a locality chart based on any geocentric natal type chart. The house
system and zodiac type of the resulting chart are always the same as that of the
base chart that you have selected.
>> To relocate a chart
1. Choose Locality from the Chart menu.
2. Select the “Relocated” chart type from the Chart Type to Generate.
3. Enter the details of the location to which you wish to relocate the chart.
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4. Select the OK button.
The relocated chart will be added to the list of "Calculated Charts" on the Main
Screen.
>> To cast a Geodetic or Johndro type chart
1. Choose Locality from the Chart menu.
2. Select the required chart type from the Chart Type to Generate.
3. Enter the details of the location for which you wish the chart to be calculated.
4. Select the OK button.
If you have selected a User Geodetic chart type, then you will be prompted to enter
the terrestrial longitude at which you wish the zodiac to start. In standard Geodetic
charts, this longitude is 000W00 (i.e. the Greenwich meridian). The Geodetic or
Johndro chart will be added to the list of "Calculated Charts" on the Main Screen.
4.15.12 Casting a Vedic Chart
This section describes how to cast a Vedic or Vedic divisional chart.
A Vedic Natal chart is identical to any other natal chart in Solar Fire except that it must
use a sidereal zodiac rather then the tropical zodiac as conventionally used in Western
astrology. (The most commonly used sidereal zodiac is “Lahiri”, which is the officially
nominated zodiac in India.)
It is possible to calculate any Vedic divisional chart using a tropical chart as the base
chart. However, conventionally, they are only calculated using base charts that have a
sidereal zodiac. Therefore, if you try to calculate a Vedic divisional chart using a base
chart that does not have a sidereal zodiac, then Solar Fire will prompt you with a warning
message. (This warning may be switched off if you wish).
If you wish to work with Vedic charts in the conventional way, then it is recommended
that you ensure that you have all your required base charts already calculated in a
sidereal zodiac. You can do this in a variety of ways, as follows...
Create a new natal chart using Chart / New, and ensure the selected zodiac is a
sidereal one.
Use Chart / Edit / Edit Chart or Copy and Edit Chart and change the selected zodiac
to a sidereal one.
Use Chart / Edit / Toggle Chart Zodiac to change the zodiac (and optionally also
house system) of an existing base chart. See Default Zodiac and Default House
System for information on changing your preferred zodiac and house system for
vedic (sidereal) charts.
Use Chart / Vedic (i.e. this dialog) and choose the “Vedic Natal” method to create a
new base chart using the default sidereal zodiac.
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>> To cast a Vedic or Vedic divisional chart
1. Choose Vedic from the Chart menu.
2. Select the required chart type from the Chart Type to Generate.
3. Select the OK or Apply button.
The chart will be added to the list of "Calculated Charts" on the Main Screen.

4.16

Backing Up and Restoring Chart Files
Most files in Solar Fire can be easily re-installed or fairly readily reconstructed if should
you experience serious problems with your computer’s hard disk or operating system.
However, chart files cannot be reconstructed unless you keep some sort of copy of all
the charts that you cast or import. Therefore, it is wise to make backups of your chart
data on a regular basis.
>> To backup your data to any other location on your computer or network (e.g. a
USB Flash Drive)
a) For Chart Files only: Select the Backup Chart Files… item from the Utilities menu.
b) For All User Files: Select the Backup All User Files… item from the Utilities menu.
You will be prompted to select a drive or location to save the backup files to.
If you want to create a backup copy that you can keep separately from your computer,
then you should choose an external drive, but you can also save copies to another folder,
or another folder on another disk on your computer, or to another computer linked to
yours on a network.
>> To find your Solar Fire User Files folder
Select the Open User Files Folder item from the Utilities menu.
>> To restore your backup chart data
Copy the chart files from their backup location into the Charts sub folder under the
Solar Fire User Files folder.
>> To restore your backup user files
Copy the files from their backup location into the Solar Fire User Files folder.
See also:
Recovery from failure for information regarding re-installation.

4.17

Entering Angles
Angles are required to be entered in several different places in the program, e.g. when
editing aspect orbs, editing report modulus and orb, specifying a chart angle when
rectifying a chart, entering a user-specified ayanamsa and when specifying a return
angle in the Advanced Return Options screen.
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Angles may be entered in degrees, minutes and seconds or as decimal degrees or in
degrees, zodiac sign, minutes and seconds. Whenever an angle is entered, Solar Fire will
convert it into a standard format, unless it cannot understand the entry, in which case an
error message will be displayed, and you can try entering an angle again.
Normal angles (non-zodiacal)
The angle must have at least a degree number. It may also have a minutes number and a
seconds number. The minutes and seconds number must be between 0 and 59 only.
Some examples of valid angle entries are as follows.
23
23 59
23 59 59
Zodiacal Angles
The angle must have at least a zodiacal abbreviation or a degree number. It may also
have a minutes number and a seconds number. The minutes and seconds number must
be between 0 and 59 only. If you enter a zodiacal abbreviation of 2 letters, then it must
be one of the following - Ar, Ta, Ge, Cn, Le, Vi, Li, Sc, Sg, Cp, Aq, Pi. If you enter more
than 2 characters of a sign name, then it must be an exact part of the full name of the
zodiac sign e.g. "Sag" for Sagittarius. Some examples of valid zodiacal angle entries are
as follows.
23Aries
23Ar
23Ar59 59
23Aries 59
133 23
12 Cn 23 59
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Dynamic Time-Based Operations
In previous topics generally all information generated by Solar Fire has been for a fixed
moment in time (a specific date), regardless of whether it was a natal, progressed or
return chart etc. The exceptions are Lunar Phase or Eclipse charts, the result being a
series of charts covering several dates.
The topics in this chapter are more concerned with generating information that covers a
span of time (such as transits or progressions to a chart), from one date to another later
or earlier date usually as a continuous stream of events, and thus the information deals
with the dynamic flow of time itself.
This information is conveyed using one of the following formats...
Graphically - in the "Graphic Ephemeris" and the "Time Map" modules
Lists - in the "Dynamic Reports" and "Eclipse Search" module
Everyday Calendar - in the "Calendar" module
Moving components in charts and grids - in the "Real Time Clock and Animation"
module

5.1

Using Calendars
This chapter describes how to generate, view and print a calendar containing transits,
progressions and/or directions for any radix chart. Calendar data may also be exported
to other calendaring programs, such as MS Outlook and others.
Before generating a calendar, it is necessary to have either cast or opened the chart(s)
for which you wish to generate the calendar. If you have not yet done so, see Casting a
Natal Chart for instructions on creating a new chart, or page Retrieving Charts From a
File for instructions on opening an existing chart.
>> To open the Calendar module
Choose Calendar from the Dynamic menu
This will open the "Calendar" screen, and display calendar entries for the current
chart and date.
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>> To change the calendar duration
Choose the Day, Week or Month items from the View menu
or...
Click in the Day, Week or Month button on the top, left Toolbar.
"Day" - shows one calendar day only
"Week" - shows a 7 day period with the current date in the middle i.e. 3 days to
either side of the current calendar date
"Month" - shows the full calendar month for whatever month the current date
falls into
>> To change the current calendar date
Do any of the following..
Click on the drop-down arrow to the right of the date entry, and use the standard
calendar control to select a new date
or...
Click on the "-" (minus sign) button - this moves the current calendar date back by
one day, week or month, depending on the current calendar duration
or...
Click on the "+" (plus sign) button - this moves the current calendar date forward by
one day, week or month, depending on the current calendar duration
>> To change the current radix chart for the calendar
Select the required chart from the drop-down listbox just above the calendar
viewing frame.
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5.1.1 Calendar Information
Each calendar day displays the following information...
The day number - at top left.
The time zone - at top center - this is the time zone for which any calendar entries
showing times relate to.
Lunar zodiacal info - at top right. This shows the Moon glyph, followed by its current
sign glyph, or two glyphs if the moon makes an ingress into a new sign during this
calendar day. Where there is an ingress, the exact time of ingress is shown below
this. If the Moon goes void of course during the day, then the time that this occurs
is also shown.
Lunar phase information - at bottom center. This shows a small graphic
representation of the current lunar phase, plus a further description of the phase.
The graphic will show the phase as it is viewed for the hemisphere of the chart that
the calendar is based on. If any of the four major phases occur on this day, then the
time of the exact phase is given. On any other day, the name of the current phase,
and the lunar phase angle at midday are shown instead.
Dynamic calendar events - in the central section. This lists all the transits,
progressions and/or directions and other dynamic events which are currently
selected in the Calendar Preferences.
Dynamic Calendar Events
Each entry is given in one of the following formats...
For the first item on a line - Event Type, Point1, Aspect, Point2, Time (optional)
If there is enough space, then there may be additional entries on the same line
which relate to the same Event Type and Point1.
For additional entries on the same line - , Aspect, Point2, Time (optional)
Event Types which appear here are the same event types as those which appear in
the dynamic reports, and are described fully in the description of report layouts.
Ordering of the Events
If the option "Show Exact Times of Hits" is selected in Calendar Preferences the events
are ordered by the time of the day, with the most recent events at the top of the list and
the least recent event at the bottom of the list.
If the option "Show Exact Times of Hits" is not selected in Calendar Preferences the
events are grouped firstly by the type of event, and then within that by planet and/or
point.
>> To view an interpretation of an individual calendar event
Hover the mouse over that calendar event
This causes a tooltip to pop up showing the interpretation of that event. The
interpretation is automatically taken from whichever interpretation file is currently
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selected for use with the calendar.
>> To view a report containing all events and their interpretations
Select the View Interpretations Report item from the View menu.
Your word-processor will be opened up displaying this report.
Note: To keep a permanent copy of the report, you must save it under a different name,
because Solar Fire always uses the same report name.
5.1.1.1 Gardening Calendar

The gardening advice provided in the Calendar is based on the following principles...
The actual days of the New Moon and Full Moon are considered poor days for any
gardening activity, and more appropriate for ceremony.
The Third Quarter phase of the moon (from third quarter to full) is considered poor
for planting, but good for garden maintenance such as weeding or harvesting.
The other phases of the moon are good for planting and transplanting, and the type
of planting that’s most suitable is based on the sign the moon is in. Water signs
are good for leafy vegetables, Earth signs for root crops, Air signs for flowers, and
Fire signs for vegetables or fruits with internal seeds. (This is in line with Rudolf
Steiner’s approach to Biodynamic agriculture.)
Note:
The advice is provided based on the position of the moon at noon; please observe the
actual time of ingress of the moon from one sign to the next for more specific planting
timing.
5.1.2 Setting Calendar Preferences
>> To open the Calendar Preferences dialog
1. Select Edit Settings... from the Preferences menu item of the Calendar screen.
This will display the Calendar Options dialog.
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Many of the options available here are the same as those in the Dynamic Reports
module.
Note: The options that you select and set here are always remembered for future
sessions. To revert to any previous settings, you must reselect those settings
yourself, using this dialog.
2. Set the "Dynamic Events To Include". Check the options which you wish to include.
These options are:
Transits to Radix - transits of planets/asteroids/angles to points in the selected
radix chart.
Transits to Transits - transits of planets/asteroids/angles to one another.
Progressions to Radix - progressions of planets/asteroids/angles to points in the
selected radix chart.
Progressions to Progressions - progressions of planets/asteroids/angles to one
another.
Directions to Radix - arc directed positions of planets/asteroids/angles to points
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in the selected radix chart.
House Ingresses - movements of points across house cusps of the radix chart.
Sign Ingresses - movements of points across sign boundaries.
Parallels of Declination - aspects of declination (in addition to aspects of
longitude, which are always included).
Stations - times when points become stationary.
Show Exact Times of Hits - whether or not to show the time (to the nearest
minute) of each event, rather than just the day on which it occurs.
Show Gardening Times - displays a picture of a plant part and/or brief
instructions to indicate appropriate gardening activity. Additionally a tooltip
indicates which element the Moon is currently in and summary gardening
information.
3. Set "Exported Events"
Include Interpretations - If this option is selected, then calendar data that is
exported to other applications will include Solar Fire's interpretation of each
event, in addition to the event details themselves. Switching this off reduces the
volume of exported information, by limiting it to include only the name, date and
time of each event.
4. Set "Timezone/Location" options
Use default timezone – to use your current default location and timezone settings
for the calendar events.
Use radix chart's location and timezone - to use the current chart's location and
settings for the calendar events.
Specify my own location/timezone - allows you to enter the required place details
and other settings in the Location frame below.
5. Set "Location (for Calendar Timezone)"
You can select location details in a similar manner to choosing a location for a new
natal chart.
The location is relevant only 1) for the selection of which timezone to use, and the
switching dates between daylight savings and normal time for that location, and 2)
for the calculation of transiting angles. However, it is not recommended to include
chart angles as transiting points.
Normally the Auto DST option would be switched on. If the Auto DST option is
unchecked, then the results will show times for the specified timezone only, whether
or not this is the standard timezone for the given location. This is useful if you would
like to see all the results in Universal Time, for example, rather than in the normal
timezone for the selected location.
6. Set "Point Selection"
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Transits - Transiting points. You may, for example want to include just transits
from the inner planets only. On the other hand, for a more detailed calendar, you
may want to include transits by the Moon.
Progs - Progressing and directed points. You can specify a different set of points
from the transiting points.
Radix - Points in the radix chart that you want to include in the report. You could
exclude the MC and Ascendant if the birth time was uncertain; add asteroids, use
inner planets only, etc.
Note: Given the large number of transiting angle events that occur every day, it would
only be possible to display only a very a small proportion of such events in the
calendar dialog, so it is strongly recommended that you do not include chart angles as
transiting points
7. Set "Aspect Selection"
Transits - Aspects formed from transiting points to radix points.
Progs - Aspects formed from progressed or directed points to radix points. This
can be a different set of aspects from the transiting aspects.
8. Set "Calculation Options"
If you want all events to be precession corrected, select the Prec. Corr. checkbox.
9. Set "Interps Report Options"
If you want Moon Ingress and Void of Course (VoC) text categories printed in the
Calendar Interpretations report then select these options.
10. Set "Font Size"
Small - allows up to about 10 lines of event data per calendar day
Medium - allows up to about 8 lines of event data per calendar day
Large - allows up to about 6 lines of event data per calendar day
Note: The font size selection affects only the lines containing the dynamic events.
The day number, lunar sign and phase information always remain at a fixed font
size.
Note: To display more events per calendar day, you can also switch off the Show Exact
Times of Hits option, as this usually allows more individual events to be listed per line of
event data.
5.1.3 Exporting Calendar Events
>> To copy or send a copy of the calendar image
Choose Copy/Send Image from the Export menu of the Calendar dialog
This invokes the Copy Image To dialog that allows you to select whether to send the
currently displayed image to the clipboard, to a file, or to an email attachment, with
© 2014 Esoteric Technologies Pty Ltd

180

Solar Fire 9 User Guide

various selectable options. See Copying, Publishing and Sending Graphics.
>> To send calendar events to MS Outlook
Choose Send Calendar Events / To MS Outlook from the Export menu of the
Calendar dialog.
This will display the MS Outlook Export Options dialog, giving you the ability to add or
remove calendar entries in MS Outlook.
This feature allows you to label all Solar Fire's generated entries so that you can then
easily remove them all later, without interfering with any other existing Outlook
calendar entries. It is recommended that you use "Solar Fire" as the whole label
name, or at least as the start of a longer label name, to reduce the risk of accidentally
deleting entries which were not generated by Solar Fire.
Note: You can, if you wish, export more than one person's calendar events to Outlook.
In that case, it is recommended that you append the chart name to the label before
exporting, so that you can tell the entries apart in MS Outlook e.g. "Solar Fire - Sarah"
and "Solar Fire - John". Doing this also allows you to remove just one person's entries
(by using ""Solar Fire - John" in the delete dialog), or all entries at once (by using
"Solar Fire" in the delete dialog.)
>> To delete existing calendar events from MS Outlook
1. Optionally edit the category label in the Existing Outlook Calendar Entries frame.
2. Click on the Remove button.
You will get a notification message telling you how many entries were deleted.
Note: This removes all entries that start with the given text, so entering "Solar Fire"
will delete all entries for "Solar Fire - John" and "Solar Fire - Susan", for example.
>> To add the existing calendar events to MS Outlook
1. Optionally edit the category label above the Export button.
2. Click on the Export button.
Note: If you wish interpretation text to be included with each event, make sure you
have switched on the Include Interpretations options in the Calendar Preferences
dialog.
>> To export calendar events to another calendaring application
Either choose...
From the Export menu of the "Calendar" dialog select Send Calendar Events, To
iCalendar file.
or...
From the Export menu of the "Calendar" dialog select Send Calendar Events, To
vCalendar file.
You will be prompted to enter a filename and location to save the file to.
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Once you have exported the data, you will need to import it into whatever application
you wish to use it with, instructions for which you must obviously obtain from that
application's own documentation.
iCalendar and vCalendar Formats
iCalendar is a standard for calendar data exchange, sometimes also referred to as "iCal".
vCalendar was the precursor of the iCalendar exchange format. It is implemented and
supported by many different calendaring applications, including Apple's iCal application,
Facebook, Google Calendar, Lotus Notes, Microsoft Entourage, Microsoft Exchange,
Mozilla Calendar, Windows Calendar, Microsoft Works Calendar, Microsoft Outlook, and
many others.

5.2

Using Dynamic Reports and Time Maps
This chapter describes how to generate, view and print a report of transits, progressions
or directions to any chart (hereafter referred to as the "radix" chart - a radix chart often
refers to natal chart but it can also refer to an event chart). It also describes how to view
the output in the form of a “Time Map”.
Before generating a dynamic report, it is necessary to have either cast or opened the
chart for which you wish to generate the report. If you have not yet done so, see Casting
a Natal Chart for instructions on creating a new chart, or page Retrieving Charts From a
File for instructions on opening an existing chart.
Report Header
The full header of the dynamic report usually takes up about half a page, and includes
details of all the selections you made to generate the report. It is possible to prevent this
information from being printed in order to save this space. If this option is switched off,
then only the base chart name and the name of the saved selection are printed.
>> To switch the full transit header option on or off
Choose Full Transit Header from the Dynamic menu - This will switch it on if it was
off, or off if it was on.
Note: If you want to show your report to others who may need to know the settings
you used to generate your report, then ensure the report header option is switched
on.
Report Accuracy
It is possible for Solar Fire to calculate its dynamic reports using two different methods
With "Maximum Accuracy" switched on
In this case all dynamic report calculations are performed using an iterative method
that ensures that the time given for each events is accurate to within one second of
time. However, the "cost" of this accuracy is that it is considerably slower than less
accurate methods.
With "Maximum Accuracy" switched off
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In this case some dynamic report calculations (i.e. aspect hits) are performed using a
quadratic curve-fitting method, which approximates the correct result, and is
generally not quite as accurate as the iterative method, but has the advantage of
being much quicker. The loss of accuracy is usually very small - typically giving results
within several seconds of the maximally accurate result, although in some isolated
cases it could be out by up to ten seconds or more.
Typical users of Solar Fire will probably prefer to have the Maximum Accuracy option
switched off, because it makes dynamic report and calendar generation much quicker,
and still retains a level of accuracy which is more than adequate for most astrological
purposes. However, those users who do need results which are always accurate to
the nearest second of time should switch Maximum Accuracy on.
Note: All sign ingresses and planetary stations in dynamic reports and calendars are
always calculated to maximum accuracy, regardless of whether the Maximum
Accuracy setting is on or off.
>> To alter the report accuracy setting
Choose Maximum Accuracy from the Dynamic menu - This will switch it on if it
was off, or off if it was on.
Note: This option also affects the calendar module, because it uses dynamic reports
which run in the background to generate its calendar events.
5.2.1 Primary Directions in Solar Fire
Solar Fire 9 contains revised and expanded tools for calculating Primary Directions. Primary
Directions are based on the Primary Motion of the points of the chart during the hours
immediately after birth. The question that we ask when looking at Primary Directions is: how
long does it take one point, such as Mars, to reach the same position in the sky that another
point, such as the Moon, had at the moment of birth? By computing precisely the number of
degrees that Mars must travel, and mapping this to the years of the native’s life, we can
compute a rough time when Mars’ influence comes to bear on the Moon.
Over the centuries, astrologers have used different methods to determine exact definitions
for concepts like “the same position in the sky”, and even what “the position of a point”
means. This topic describes how these different techniques are presented in Solar Fire, and
how the results are calculated. Primary Direction tools are accessed from the "Dynamic"
menu on the Main Screen under "Transits & Progressions".
Terminology:

The “Promissor” is the active point or planet, the one bringing its influence to bear
at a particular time.
The “Significator” is the point or planet receiving the influence. (So above, Mars is
the Promissor, and the Moon the Significator.)
“Primary Motion” is the motion of points across the sky during a day.
Directions are engaged in two types of reports – “Directions to Radix” and “Transits to
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Directions”. Primary directions are engaged when you then choose “Primary Mundane”,
“Primary Zodiacal”, or “Primary van Dam” from the “Directions” menu. “Primary van Dam”
directions are based on the work of present-day astrologer Wim van Dam, and are largely
unchanged from Solar Fire 8. This topic is primarily about the other two types, “Primary
Mundane” and “Primary Zodiacal”.
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contrasts with recent innovations. Rumen Kolev’s “Primary Directions I, II, and III” served as
the final guide, with many useful examples and a fine description of the various Rate Keys.
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Mundane or Zodiacal?
All Primary Directions involve computations based on Mundane Position, but there are
two established techniques for which Mundane Positions we work with.
Primary Mundane directions compute mundane positions based on the actual
positions of the planets, and work with aspects in Mundane degrees. Also known
as directions “with latitude”.
Primary Zodiacal directions compute mundane positions of the Zodiacal longitudes
of the planets, and work with aspects based on Longitude.
Consider our example of directing Mars to the Moon. Suppose Mars is at 5 Taurus (so a
longitude of 35 degrees), but 1 degree above the ecliptic (Latitude +1 degree). Then suppose
the Moon is at 5 Aries (longitude 5 degrees), but latitude -3 degrees. If we were computing
Primary Mundane directions, we would work with these points exactly: (35 long, 1 lat)
directed to (5 long, -3 lat). If we use Primary Zodiacal directions, we would discard the
latitudes and work with the points on the ecliptic, so we would be directing (35 long, 0 lat) to
(5 long, 0 lat). These two approaches can produce very different results.
Regarding aspects, the tradition when computing Primary Zodiacal directions is to add (or
subtract) the aspect angle from the first point’s longitude. So if we wanted to know when
Directed Mars would be Square the moon, we would add or subtract 90 degrees from Mars’
longitude, and then direct that point (again with zero latitude) to the Moon’s longitude.
Aspects in Primary Mundane directions are computed based on the Mundane Positions, and
we also base the angle on the planet being directed to, rather than the one being directed.
So we would turn the actual position of the Moon (with latitude) into a Mundane Position,
add or subtract 90 degrees for a square, and then direct Mars to that position.

Placidus or Regiomontanus Methods for computing Mundane Position?
The techniques of Primary Directions generally go back to Hellenistic times, and were
extensively described by Ptolemy. Regiomontanus in the 15th Century, and later Placidus in
the 17th, renewed awareness of these techniques in Europe, but with substantially different
mathematical techniques.
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Regiomontanus’ Mundane Position is based on the planet’s “House Circle”, the circle
connecting the north and south points on the horizon with the planet in question. The angles
of these house circles are measured starting at 0 for the 0 Aries point, and are similar to both
longitude and Right Ascension, but differ slightly from either.
Placidus, and Ptolemy before him, based Mundane Position on proportions of semi-arcs. For
each point, we place it in one of the major quadrants defined by the Eastern Horizon, Upper
Meridian, Western Horizon, and Lower Meridian. We then determine the proportion that it
has traveled through its quadrant. If Mercury is 2/3 of the way from Eastern Horizon to Upper
Meridian at the moment of birth, and Mars is 1/3 of the way through the same quadrant, then
we find the arc that would take Mars to its 2/3 position, and say that that is the arc that directs
Mars to Mercury.
In Solar Fire, following Makransky’s lead, we express Placidus Mundane Positions as degrees
based on these proportions; the first quadrant, from Eastern Horizon to Lower Meridian, is
given the range 0-90 degrees; the second, 90-180, and so on. (So 2/3 from Eastern Horizon to
Upper Meridian corresponds to a Placidus Mundane Position of 300 degrees.)

Rate Key – turning the degrees into dates
Once an arc has been established, how do we map that arc into a person’s life? Many
different techniques have been proposed and embraced. We present seven options in our
software. Rate keys are found in the Preferences dialog, in the “Progs/Dirns” tab, on the
lower left.
All rate keys are approximately 1 degree per year; that is, an arc of direction of 20 corresponds
to about 20 years of life. Some rates are slightly less than a degree per year, and others could
be more or less than a degree based on the sun’s motion immediately after birth. If you
aren’t sure which key to use, the default of Ptolemy’s key, exactly 1 degree per year, is an
excellent place to start.
For a list of rate key options, see Rate for Primary Directions.

Information in the Dynamic Report

Dynamic Report Output

P1 in the chart represents the “Promissor”, the point bringing influence. P2 is the
“Significator”. The houses indicated reflect the house position of the directed point.
Pm-Na is the symbol for a Primary Mundane direction to Radix. Pz-Na would be the
symbol for Primary Zodiacal, and Pv-Na for Primary van Dam.
In Primary Mundane directions, Pos1 represents the Mundane Position of P1, while Pos2
represents the radix longitude of P2. (Note in the above results, which use the Placidus
method – the directed Moon is conjunct the Midheaven, so of course it has a Placidus
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Mundane Position of 270 degrees.)
In Primary Zodiacal directions, Pos1 indicates the sign and degree that P1 has been
directed to.

Converse Directions
The classic “Converse” option affects the Directions to Radix report simply by switching
which planet is being directed to which. So for instance if the Sun were 1/3 of the way up
the morning sky, and Mars at 2/3, we would expect to see Sun directed to Mars to occur
somewhere around 30 years into a person’s life; but traditional interpretations would be
much more interested to know when directed Mars reaches the Sun. Since this would
take around 330 years in direct motion, we work in converse. The converse direction of
Mars to the Sun uses the same mathematics, and produces the same result, as the
regular direction of Sun to Mars.
In a converse direction of Mars to the Sun, Mars is still the Promissor and the Sun the
Significator, but in computations, we actually move the Sun by its primary motion, and
Mars remains fixed in its natal position. In the Dynamic Report, Pos2 will reflect the
directed position of the Sun, and Pos1 will correspond to the radix chart positions.

Modern Converse
You also have an option of using a more modern definition of "Converse" from the 19th
Century; instead of switching which point is being directed to which, we direct the point
backwards. So in this case, we still direct Mars to the Sun, keeping the Sun fixed, and we
come up with a negative arc. Then we swap the sign. If directing Mars to the Sun would take 27 degrees of arc, we say that its converse direction is 27 degrees, and so the Mars/Sun event
happens at somewhere around 27 years of age (depending on the rate key.)

As another example, suppose we wanted the converse direction of Mars to Saturn, for a
chart in which Saturn is a little behind Mars in primary motion (Saturn rises within a few
hours after Mars does). Using the Classical Converse (Ptolemy, Placidus etc), we would
simply direct Saturn to Mars, and use this figure. Using the Modern Converse, we direct
Mars to Saturn, obtaining a negative arc value, and then just swap the sign. If directing
Mars to Saturn would take -5.17 degrees of arc, we say that its converse direction is 5.17
degrees, and so the Mars/Saturn event happens at somewhere around 5 years of age
(depending on the rate key).
**********
The modern and classical converse techniques produce different results; they’re
generally similar, but they can easily differ by a couple years. Solar Fire defaults to the
Classical Converse, but users can switch to using the Modern Converse in Rate for Primary
Directions.

Transits to Directions
Given that Primary Directions happen in Mundane degrees, and Transits happen in Zodiacal
degrees , how do we define Transits to Directions? We can direct the points of the radix to
particular Zodiacal degrees; this degree is termed the “Directional Place” of the point at a
given time. So we compare the transiting planets to the ongoing (very slow, retrograde)
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motion of these directional places, and highlight their intersections.

As an example, using Primary Mundane, Placidus method, and Ptolemy’s rate key, Prince
Andrew’s natal Venus can be directed to the 7 Pisces 51’ point on Feb 4, 2013; at the
same time, transiting Chiron reaches this longitude. So this is the day of Chiron
transiting directed Venus.
5.2.2 Generating a Dynamic Report

Dynamic Reports screen

>> To generate a dynamic report
1. From the Dynamic menu choose Transits & Progressions.
This will display the "Dynamic Report Selection" dialog box that allows the selection
of a radix chart and options to be used in generating the report.
2. Select a chart from the Dynamic Radix Chart list box.
Optionally select a different chart from the Alternate Radix Positions Chart dropdown listbox. Usually this should be the same chart, but if you choose a different
chart, then the generated dynamic report will show dynamic events of the Dynamic
Radix Chart in relation to the chart points of the alternate chart. For example, if you
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choose “Sarah Jones” as your dynamic radix chart, and “David Smith” as your
alternate radix chart, then when you generate a progressions report, it will show
Sarah’s progressed planets making aspects to David’s natal planets.
3. Optionally, choose an item from the drop-down list of Saved Selections
Doing so will cause all the options on this screen to be updated according to what
was last saved in this Saved Selection. Having done this, you may still alter any of the
options on the screen without causing any changes to the Saved Selection. For
example, if your Saved Selection has a report period of 1 year, you might wish to alter
this to 2 years for this particular report, or you may wish to add Eclipses to the report.
These new options will remain in effect until you either choose another item from the
drop down list of Saved Selections, or alter any of the other options yourself. (If you
select the same Saved Selection again, then the options will be reset to what they
were when you last selected it.)
4. Either use the Date Options button to choose an automated date setting (see
below for a full description), or else enter the Start Date for the report manually.
There are some shortcuts to setting the date quickly and easily as follows: Select the
Now button to get today’s date; double-click on the Days option button to set the
date back by one day; double-click on the Months option button to set the date back
to the first day of the month (or to the previous month if the day is already the 1st of
the month); double-click on the Years option button to set the date back to the first
day of the year (or to the previous year if the day is already the 1st of January).
5. Set the length of the reports by selecting any one of the Days, Months or Years
option buttons, and enter the number of days, months or years in the Period box.
This must be a positive integer. The period for which the report will run will be this
number of years, days or months, depending on which of these periods has been
selected with the option buttons.
6. Select Location type to be either Natal or Relocated.
Bear in mind that the natal location is the over-riding imprint on the psyche of an
individual. But if a dynamic report is being generated for an individual, then it can
optionally be relocated to wherever they are living during the period of the report,
perhaps if you were interested in external events. However, if the chart's subject is
someone who is living in the same location as they were born during the time of the
report, then the natal option is best. And if only progressions are being generated for
an individual, then the natal location is best unless you are particularly concerned
with external events.
That said, if the radix chart is that of a person who permanently moved during the
first few months of their life, it may be appropriate to relocate it. If the Natal option is
selected then all the boxes relating to location, including time zone, longitude and
latitude will contain the location details from the selected base chart. Note that
although it is technically correct to alter the time zone if the current time zone is
different from the natal one, in practice this is only necessary if you are examining
lunar or chart angle transits, as the difference in the resultant times is otherwise not
significant. If the Relocated option is selected then all the boxes relating to location,
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including time zone, longitude and latitude will contain the current default values.
(See Saving and Restoring Settings for details on default values.) Any of these values
may be altered in the same manner as when creating a new chart. See Casting a
Natal Chart for instructions on how to alter location values.
7. The Auto DST option allows you to choose whether or not the results of the report
will be shown in the given timezone only, or whether the timezone should be
adjusted automatically to take account of daylight savings periods for the given
location.
8. In the "Event Selection" area, click on the options which you wish to include.
These options are...
Transits to Radix - transits of planets/asteroids/angles to points in the selected
radix chart
Transits to Transits - transits of planets/asteroids/angles to one another
Transits to Progressions - transits of planets/asteroids/angles to their progressed
positions
Transits to Directions - transits of planets/asteroids/angles to their arc directed
positions
Progressions to Radix - progressions of planets/asteroids/angles to points in the
selected radix chart
Progressions to Progressions - progressions of planets/asteroids/angles to one
another
Directions to Radix - arc directed positions of planets/asteroids/angles to points
in the selected radix chart
Note that at least one of the above options MUST be selected in order to produce a
report. Also note that, unless the radix chart is a natal or event type chart, then it
will only be possible to select the Transits to Radix or Transits to Transits options.
In this case, the other options will be disabled (grayed out).
House Ingress - If selected, then the report will contain an entry for each chart
point that crosses a house cusp in the radix chart, either direct or retrograde.
Sign Ingress - If selected, then the report will contain an entry for each chart
point that crosses a zodiac sign cusp in the radix chart, either direct or
retrograde.
Parallels of Declination or Latitude - If selected, then the report will contain
entries for parallels and contra-parallels of declination or latitude, as well as for
aspects of longitude. The selection of either declination or latitude may be made
by clicking on the up-down arrow button to the right of this option. This button
toggles the setting between declination and latitude.
Stationary Points - If selected, then the report will contain entries showing the
dates when planets or asteroids are geocentrically stationary. (This has no effect
if the radix chart is heliocentric.)
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Solar & Lunar Eclipses - If selected, then the report will contain entries showing
the dates and zodiacal positions of either maximum eclipses or of exact
associated lunar phases, depending on the eclipse settings in Preferences.
Void of Course Moon – If Selected, then the report will contain entries showing
the date and time of the last aspect made by the Moon as it enters its void of
course state, as well as the sign ingresses, which indicate where the Moon ends
it void of course state. (Void of Course is calculated according to the userselected options).
Entering/Leaving - If selected, then the report will contain an entry for each chart
point as it enters transiting orb and leaves transiting orb, as well as when the
transit, progression or solar arc direction is exact. Also, any aspects which are
already in orb at the beginning of the report period will be listed. If this option is
not selected, then the report contains entries only for exact hits. The angle of the
transiting orb used for the report is taken from the current aspect set file. This
orb may be altered by editing the aspect set file. See Aspect Set for instructions
on how to edit the aspect set file.
Note: If you need to ensure that slow moving transits are always shown in a short
time-period report, whether or not they actually make any exact hits during that
time period, then make sure the Entering/Leaving option is selected.
Note: Only one of the parallels options can be selected at one time. It is not
possible to produce a report containing both parallels of declination and of latitude.
9. If you have selected any events involving Progressions or Directions, then in the
Dynamic Type box, select which type of progressions or directions you wish to use
by selecting one of the available types from the drop-down list boxes.
The Progression types are...
Secondary - This is the most commonly used type of progression, based on a day
for a year i.e. one day per solar cycle.
Tertiary - This method of progression is based on the mean rate of a day for a
lunar month.
Minor - This method of progression is based on a mean lunar cycle for a year.
User Prog Rate - This method allows you to define whatever rate of progression
you choose. The rate used here must have been previously set in the User
Progression Rate option of the Preferences dialog.
Age Harmonics are based on the idea that as a child our development through the
years of growing can be measured and defined via harmonic correlations to each
year. Harmonics themselves are based on the division of the 360º circle.
Dividing it by 1 (360 / 1 = 360º which is the same as 0º) creates the conjunction
aspect
Dividing it by 2 (360 / 2 = 180º) creates the opposition aspect
Dividing it by 3 (360 / 3 = 120º) creates the trine aspect
Dividing it by 4 (360 / 4 = 90º) creates the square aspect
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etc.
Age harmonics involves creating harmonic charts for each of these years of a
child's life. Each year represents the corresponding harmonic aspect, so for
instance in the third year (between the ages of 2 and 3), we would be interested in
the 2nd harmonic chart (which represents oppositions), in the fourth year
(between the ages of 3 and 4), we would be interested in the 3nd harmonic chart
(which represents trines).
Selecting one of the Age Harmonic options will add the chart point positions for
the corresponding age of the native.
Age Harmonic Age+1 Harmonic
The Direction types are...
Solar Arc - This is the most commonly used method. Chart point longitudes are
directed by the secondary progressed arc in longitude, and chart point
declinations are directed by the secondary progressed arc in declination.
Ascendant Arc - Chart points are directed by the ascendant arc (which is itself
derived from the secondary progressed solar arc.)
Vertex Arc - Chart points are directed by the vertex arc (which is itself derived
from the secondary progressed solar arc.)
User Arc - Chart points are directed by a user-defined annual arc rate. The rate
used here must be set in the User Direction Rate option of the Preferences menu.
Primary Mundane - This method directs chart points according to “Primary Motion”,
the motion of the points through the chart during the hours after birth as the Earth
rotates. Primary Mundane is different from the other options in that aspects formed
using this method are mundane aspects rather than aspects of zodiacal longitude. The
type of Mundane Position used depends on the “Primary Method” below. The rate of
direction can be selected from the Primary Direction Rate option of the Preferences
menu. See Rate for Primary Directions.
Primary Zodiacal - This method directs chart points according to “Primary Motion”, the
motion of the points through the chart during the hours after birth as the Earth
rotates. Primary Zodiacal directions, also known as “without latitude”, work by
directing the zodiacal longitudes of the chart points to each other, rather than the
actual positions of the planets. Aspects are also based on zodiacal longitude. The
directions between these longitudes are based mundane positions of the longitude
points themselves, however, and as such depend on the choice of “Primary Method”
below. The rate of direction can be selected from the Primary Direction Rate option of
the Preferences menu. See Rate for Primary Directions.

Primary Van Dam - See Wim Van Dam's website for more information about how
to use this option (link is valid at time of publication)
Profections (Annual) – This directs the chart by 30 degrees per year.
Conventionally, you would use this direction method to find when the directed
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Ascendant makes conjunctions to points in the radix chart.
For some Direction types you can select the Primary Method...
Note: All Primary Directions work by moving one point (or an aspect to it) to its
conjunction with another. But there are different ways to determine when two points
meet. The choice of this method for determining directional conjunctions affects our
Primary Mundane and Primary Zodiacal directions. (Note that there are strong
mathematical relationships between these methods and the House Systems with the
same names, but there is no reason you have to use the same Primary Method as
House System.)
You can choose between these two Primary Methods:

Placidus
The more ancient technique, used by Ptolemy and more recently promoted by
Placidus, is based on proportions of semi-arcs. For each point, we place it in
one of the major quadrants defined by the Eastern Horizon, Upper Meridian,
Western Horizon, and Lower Meridian. We then determine the proportion that
it has traveled through its quadrant. If Mercury is 2/3 of the way from Eastern
Horizon to Upper Meridian at the moment of birth, and Mars is 1/3 of the way
through the same quadrant, then we find the arc that would take Mars to its
2/3 position, and say that that is the arc that directs Mars to Mercury. These
mundane positions are reported as degrees, but are based on these
proportions; the first quadrant, from Eastern Horizon to Lower Meridian, is
given the range 0-90 degrees; the second, 90-180, and so on. (So 2/3 from
Eastern Horizon to Upper Meridian corresponds to 300 degrees.)
Regiomontanus
Regiomontanus introduced a different type of mundane position based on
Circles of Position, great circles going through the point in question and the
North and South points on the horizon. The intersection of this circle with the
Celestial Equator gives the Mundane Position; usually it’s within a few degrees
of the point’s Right Ascension. This is the mundane position reported in the
Dynamic Report.
10. Optionally, select the Prec. Corr. or Converse options.
If the Prec. Corr. option is checked, then the calculations will be done according to
the position of the planets in the Sidereal zodiac, rather than the Tropical zodiac.
However, the resulting report will still be calculated in the Tropical Zodiac. Note that
if the radix chart which you are using already uses a Sidereal zodiac, then this option
will have no effect, and the resulting report will be in the Sidereal zodiac. If the
Converse option is checked, then the calculation of the transits and progressions will
be done by searching backwards from the converse entered time in relation to the
time of the dynamic radix chart. An additional arc multiplier button (Mult) is visible
whenever Solar Arc, Ascendant Arc or Vertex Arc directions have been selected for
inclusion in the report. Clicking on this button produce a drop-down menu with the
possible arc multipliers - x1 (Normal), x2 (Double Arc), x0.5 (Half Arc), x-1 (Negative
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Arc), x-2 (Negative Double Arc), x-0.5 (Negative Half Arc).
11. You may wish to alter the Point Selection.
The items that you can select are...
Transits - Transiting points. You may, for example want to include just transits
from the outer planets only. On the other hand, for a very short-term report, you
may want to include transits by the Moon.
Extras - Extra transiting points. This can include any combination of midpoints
between planets or other chart points, as well as fixed stars, asteroids and extra
bodies.
Progs - Progressing and Directed points. You can specify a different set of points
from the transiting points.
Extras - Extra Progressing and Directed points. This can include the same types
of points as for Extras - transiting points (above).
Radix - Points in the radix chart that you want to include in the report. You could
exclude the MC and Ascendant if the birth time was uncertain; add asteroids,
use inner planets only, etc.
Extras - Extra radix points. This can include any combination of midpoints
between planets or other chart points, and fixed stars, arabic parts, asteroids,
extra bodies, fixed zodiacal positions and house cusps.
The names of the currently selected sets are displayed, and it is possible to select
different sets, browse or edit them etc. by clicking on the name of the desired set.
Doing so will cause the "File Manager" screen to be displayed See Using the File
Manager for instructions on using the "File Manager" to alter any settings.
12. You may also wish to alter the Aspect Selection
The items that you can select are...
Transits - Aspects formed from transiting points to radix points.
Progs - Aspects formed from progressed or directed points to radix points. This
can be a different set of aspects from the transiting aspects.
13. Optionally select the Merge checkbox
If you do so, then the new report that you generate will be merged with the
previously generated dynamic report, and all events for both reports will be displayed
together. This option is useful for generating reports that require combinations of
settings that are not possible in a single report. For example, you could produce a
report using Solar Arc directions, and then merge this with another report using
Ascendant Arc directions. The final result is a report containing both types of
directions.
14. Finally...
Select the View button.
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The "Dynamic Events Report" screen is displayed, and the report is generated as
you watch.
or...
Instead of viewing the report immediately, you have the option of adding the
report to the print queue, to be printed later.
>> To add the report to the Print Queue
1. Select the Queue button
This will display a dialog box asking you to confirm whether or not you wish to
add this dynamic print job to the Solar Fire print batch queue. If you select the
OK button, then it will be added to the queue, and it will not be calculated or
printed at this time.
It is possible, at any later time, to start printing all the jobs that are on the
batch print queue by selecting the Start Print Queue option from the View menu
of the Main Screen. Note that any dynamic report that is calculated on the
batch queue will be sorted into date order. If you wish to see the report in any
of the other available sort orders, you must generate the report using the View
button.
5.2.2.1 Automated Date Options

It is possible to allow the start date for the Dynamic Report to be set automatically,
based on the current date or the date of the radix chart being used. If one of these
automated options is chosen, and the current settings are saved as a Saved Selection,
then the next time this Saved Selection is used, the report start date will be updated
automatically as required.
Clicking on the Date Options… button displays the Report Start Date dialog.

The available options are...
Fixed date as entered – using this option has the same effect as manually entering
a start date. The date you enter remains fixed for all subsequent reports unless you
manually update it again.
Relative to the current date – this allows you to set a report period that moves
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forward in time as the current date changes. This is useful for creating a limited
period report that always remains up-to-date.
Relative to the radix chart date – this allows you to set a report period which is
fixed relative to the birth date. This is useful for creating a report that always starts
at or near the radix chart’s birth date, i.e. a lifetime report.
The adjustment options for relative dates are as follows.
Go to – allows you to adjust from the reference (current or radix) date back to the
beginning of the day, month, quarter, half year or year.
Adjust date by – allows you to adjust from the reference date by any integer
multiple of days, months or years. This may be a positive or negative multiple, for
an adjustment forward or backward in time respectively.
Examples:
If the settings are Relative to Current Date, Go To Start of Month, Adjust by –1 months,
then any current date in December 2005 results in an automate report start date of 1s t
November 2005 i.e. the first day of the month preceding the current month.
If the settings are Relative to Radix Chart Date, Go To Start of Month, Adjust by +1
months, then a radix chart date of 28th December 1957 results in an automated report
start date of 1s t January 1958 i.e. the first day of the month following the birth date.
5.2.2.2 Saving and Deleting Selections

Solar Fire is supplied with a list of predefined dynamic report selections. It is possible to
select any of these, edit them, delete them, or to create your own selections. Each
named selection in the list is simply a record of all the selections that can be made on
this screen, including start date, period, location details, event types etc. In this manner,
it is possible to customize your own set of dynamic report options and to save them for
easy access in future sessions.
>> To save or re-save the currently selected dynamic options
Select the Save Selection button. You will be asked to enter a description under
which to save this selection. If you then select the OK button, it will then be saved
to the list.
>> To delete a saved selection
Highlight the desired selection in the Saved Selections list and use the Del key.
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5.2.3 Viewing the Dynamic Report

During report generation, you can stop further report calculation by selecting the Cancel
button. When the report is finished, it is possible to exit from this screen by selecting
the Quit button.
The status of report generation is shown in the three boxes at the top right hand side of
the screen. The top box shows the type of calculations being performed, the second box
shows the date for which calculations are currently being performed, and the lower box
shows an approximate percentage completed so far, both by percentage number, and
with a graphical "flood-fill" bar, for the current calculation type.
There is a limit of 10,000 dynamic events in any one report. If this limit is reached then
you will see a dialog box indicating the problem, and the report will be truncated at that
point.
When the report calculation is complete, the report is sorted into whichever sort order
was last chosen. It is possible to sort the report into a variety of different orders as
follows.
>> To change the sort order
1. Select the required sort order option from the drop-down list. Possible orders are...
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Date - Entries in the report will be sorted according to date and time, in
ascending order of time.
E/X/L Event - Entries in the report will be sorted into groups of in orb at the
beginning of report (B), entering orb (E), exact (X) and leaving orb (L) events for
the same transit or progression, and then the groups are sorted into date order of
the first item in the group. If the Entering/Leaving option was not selected for this
report, then this order is the same as Date order.
Point 1 - Entries in the report will be sorted into groups of entries for each point
in the first column of the report. These are the dynamic chart points. The entries
are sorted by date within each dynamic point group.
Point 2 - Entries in the report will be sorted into groups of entries for each point
in the third column of the report. These are normally the radix points, but may
also be dynamic points if the event is a transit to transit, transit to progression,
transit to solar arc or progression to progression. The entries are sorted by date
within each point group.
Weighting - Entries in the report will be sorted into an order calculated according
to weightings ascribed to each transiting point, aspect and radix point. The
weightings relate to the speed of movement of each chart point, so that transits
involving (slow moving) Pluto are at the top of the report, and within the transits
of each planet, transits involving the (fast moving) ascendant are at the top. In
many instances this order will approximate to the level of significance of the
transit. However, due to the subjective nature of determining the importance of
particular transits, this report should only be used as a potential aid - not as a
definitive statement of the relative importance of each transit!
Event Type - Entries in the report will be sorted into groups of the same event
types, for example all the transits to radix (Tr-Na) will appear first, the transits to
transits (Tr-Tr) next etc. The entries are sorted by date within each group.
Aspect - Entries in the report will be sorted into groups of aspect. For example, all
conjunctions appear at the top, oppositions next etc. The order in which of the
aspects appear is determined by Solar Fire’s internal aspect ordering, which is the
same order in which aspects appear in the aspect editor, for example.
You can alter the appearance of the report by switching on or off the Use Glyphs, Use
Colors, and Bold Text option. These work in the same way as for the Chart Reports, as
described in Generating Chart Reports.
If you wish to keep the report to view again later, then you can click on the screen's
minimize button (at the top right of the screen). This will turn the screen into an icon at
the bottom of your Windows desktop area, and you may view it again at any time by
double-clicking on its icon. Note, however, that if you generate another dynamic report,
then it will overwrite your existing report. If you wish to save it then you must print it or
copy it to the clipboard before producing another dynamic report.
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5.2.3.1 Description of Report Layout

The dynamic report appears on the screen in two parts - at the top is a small window
giving a report header. This contains details of the radix chart, the points and aspects
selected and the types of events selected, and the period of the report. Below this is the
large window, containing the body of the report. You can browse through the report by
clicking on the scroll bars to the right of the report display boxes.
A typical report line has the following items:
Point1

Asp

Point2

Hit

Type

Date

Time

Zone

Position1

Position 2

Ura (10)

Sqr

Ven (7)

(X)

(Tr-Na)

Jun 12 1993

11:07:23pm

BST +1:00

19Cp23 R

19Li23 D

In this sample report line, transiting Uranus (retrograde) at 19 23' of Capricorn in the
10th house is making an exact square to natal Venus (direct) at 19 23' of Libra in the 7th
house on 12th June 1993.
The possible items in each line are defined in the following table.
Point1
Aspect
Point2
EXL

The dynamic point and the house it is occupying on the radix chart

Type

A combination of abbreviations from the list below, indicating the type of dynamic
event and radix chart for Point1 and Point2.

Date
Time
Zone
Age
Position1

The date of the event

Position2

Zodiacal position of Point 2 - R indicates retrograde, D direct. If the aspect is a
parallel or contra-parallel, then this shows the declination or latitude.

Chart 1

Indicates the chart number and name of the dynamic radix chart. This column only
appears if an alternate radix positions chart has been selected, or if the report is
merged with other reports which use a different dynamic radix chart.

Chart 2

Indicates the chart number and name of the alternate radix positions chart. This
column only appears if an alternate radix positions chart has been selected.

The aspect formed between Point1 and Point2
The radix point (or second dynamic point) and its house in the radix chart
(X) for exact hit, (E) for entering orb, (L) for leaving orb, (B) for already in orb at
beginning at report, (S) for sign ingress, (H) for house ingress.

The time of the event on the given day
The timezone abbreviation for the given time of the event
Age of native in decimal years at time of event
Zodiacal position of Point 1 - R indicates retrograde, D direct. If the aspect is a
parallel or contra-parallel, then this shows the declination or latitude. If this relates
to a primary mundane direction, then this shows the mundane position of Point1. (0 =
Eastern horizon, 90 = Upper culmination).

Possible Type abbreviations are as follows...
Tr - Transits
Sp – Secondary Progressed
Tp – Tertiary Progressed
Mp – Minor Progressed
Up – User Rate Progressed
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Sa – Solar Arc Directed
Aa – Ascendant Arc Directed
Va – Vertex Arc Directed
Ua – User Arc Directed
Pm – Primary Mundane Directed
Pv – Primary van Dam
Pf - Profected
Pz - Primary Zodiacal
Na – Natal Radix
Pn – Progressed Radix
Di – Directed Radix
Re – Return Radix
Co – Composite Radix
Ha – Harmonic Radix
AH – Age Harmonic
A1 – Age+1 Harmonic
Prefix “c” – Converse
Prefix “p” – Precession Corrected (Prec. Corr.)
Postfix “x2”, “x0.5”, “x-1”, “x-2”, “x-0.5” – indicate the arc multiplier that was
used, if any. (Applies to Solar Arc, Ascendant Arc and Vertex Arc directions only.)
Some examples of these types are as follows...
Tr-Na - Transits to Natal
Sp-Na - Secondary Progressed to Natal
cpVa-Na - Converse Precession Corrected Vertex Arc Directions to Natal
AA0.5-Na – Ascendant Arc Directions (Half Arc) to Natal
Tr-Pn – Transits to a Progressed Radix chart
Tr-Pr – Transits to progressions (same radix chart)
Point1 and Point2 may be any of the following types.
Any chart point (planet, asteroid, Transneptunian, angle) - Shown by either it’s
glyph or by it’s abbreviation (eg ¿ or “Ura”)
A midpoint between any two points - Shown by either their glyph or by their
abbreviations (e.g. ¿/¶ or “Ura/Mon”)
A fixed star - Shown by either s* where * is a number of by its first six letters (e.g.
“s12” or “Mirach”)
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An Arabic Part - Shown by either p* where * is a number, or by its first six letters
(e.g. “p7” or “Brothe”)
An asteroid - Shown by either a* where * is a number or by its first six letters (e.g.
“a3” or “Apollo”)
A fixed position - Shown by either f* where * is a number or by its position (e.g.
“f1” or “00Ar00”)
A house cusp – shown by a number from 1 to 12.
Note: If you have a listing with a large number of fixed stars, Arabic Parts, asteroids or
fixed positions, then you may wish to switch between the alternate display styles to help
you identify which item is which on the list.
>> To switch between the alternate display styles for Point1 and Point 2
Click on the Use Glyphs option in the Report Style frame
5.2.3.2 Editing the Report

You can delete lines from a Dynamic Report, change the widths of the columns, reorder
the columns, and add or remove columns. You can also change the width of the entire
report by resizing the entire report window.
>> To delete lines from the report
It is possible to delete lines from the report, on a line-by-line basis. In order to delete a
line, you must first ...
Select the line by clicking on it. The line is shown to be selected by a dashed
rectangle enclosing it. Then simply use the Del key.
The line will be deleted, and the other report lines adjusted as necessary to fill the
gap. Note that deleted lines cannot be undeleted. You will need to regenerate the
entire report in order to get any deleted lines back.
>> To change the width of a column
Drag the column border on the report header bar with the mouse
>> To reorder, add or remove columns
Use a right hand mouse click on the report header bar.
This will display the Choose Columns dialog.
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You can select any combination of columns to display by checking or unchecking them in
the checkboxes to the left of the items in the list, and change the order of the columns
by highlighting a column and then using the Move Up or Move Down buttons
repeatedly until the desired new position is reached.
Note: If not all columns are visible in the report after adding or resizing them, you can
increase the visible area by resizing the entire report window.
5.2.3.3 Item Info

It is possible to view further information on items in the dynamic report, such as
interpretations or a list of aspects to eclipses. This option also makes it possible to see
the full name of any fixed star, Arabic Part or asteroid that appears in abbreviated form
in a line of the dynamic report
>> To view further information on an item
Select a report line by clicking on it and then select the Item Info button, or doubleclick on a line in the report
The Item Info dialog box will be displayed.
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The top box in this screen will show in words, what dynamic event this line contains,
followed by an interpretation of that event, if interpretation text exists for that type of
event.
The bottom box will list any similar events that are found in the report, e.g. if the
selected line is transiting Saturn square natal Moon, then any other exact, entering or
leaving hits of this transit will also be listed. Also, if the selected event is a transit to a
radix chart, then the total number of exact hits that will occur during this transit is listed,
plus the number of hits that occurred before the report period, and/or the number that
will occur after the report period.
If the event is an eclipse or a stationary point of a planet (i.e. going direct or retrograde),
then a list of aspects of points in the radix chart to the eclipse or stationery position is
shown. The aspects used in this list are those in Solar Fire’s currently selected aspect
set.
When you have finished looking at the information in this dialog box, clicking on the OK
button will cause it to disappear.
5.2.3.4 View Chart

It is possible to calculate and display a full chart for date and time of any event in the
dynamic report. The type of chart depends on what type of dynamic event is selected, for
example for transits to a natal chart, you see a biwheel showing a transit chart on the
outside and the natal chart on the inside; for a stationary point you see a single wheel
showing transits; for transits to progressions you see a biwheel with transits on the
outside and progressions on the inside, etc.
>> To display a chart for any event in the dynamic report
1. Select a report line by clicking on it
2. Select the View Chart button
This will cause any required chart or charts to be calculated and added to the list of
"Calculated Charts", and the “View Chart” screen to be displayed. When you have
finished looking at the chart and Quit from this screen, you are returned to the
dynamic report screen.
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5.2.3.5 Viewing a Dynamic Interpretations Report

You can send all the available interpretations for a dynamic report to be viewed in a
separate word-processor. You may also wish to select which word processor to use (see
Selecting a Word Processor), and whether or not the report will be formatted using Rich
Text Format (see Interps).
>> To view an interpretations report
Select the Interps Report button.
Your word processor will be opened up displaying this report. You are then free to
browse the report, to print it, or to save it under another name if you wish. Note that,
to keep a permanent copy of the report, you must save it under a different name,
because Solar Fire always uses the same report name. When you have finished with
the report, exit from your word processor.
5.2.3.6 Copying to the Clipboard

In a dynamic report...
>> To copy the report to the Windows clipboard
Select the Copy button.
From the clipboard, the report may be pasted into a word-processor or page layout
program, for example. Note that glyphs and colors cannot be copied to the clipboard.
Abbreviations are used instead of glyphs when the report is copied into the Clipboard.
Also, report columns may not align correctly in the Clipboard. If you paste the
Clipboard contents into your word-processor, you may have to edit the document to
ensure that the columns align correctly.
5.2.3.7 Printing the Report

In a dynamic report...
>> To print the report in the displayed sort order
Select the Print button.
The printed report will contain glyphs (if you have the Use Glyphs option selected),
and colors (if you have a color printer and you have the Use Colors option selected).
However, the printed report always uses regular (light) text. It is not possible to print
the report using bold text.
Note that it is not possible to add a report to the print batch queue from this screen.
To do so you must use the Queue button on the "Dynamic Selections" dialog box.
5.2.4 Time Map
>> To view a graphical display of the dynamic events in your report
Select the Time Map button.
After a brief calculating period, the TimeMap screen will appear.
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The time scale for the time map corresponds to the period of the dynamic report upon
which it is based. The list of dynamic events is the same as those in the dynamic report,
expect that all the Entering, Exact and Leaving events of a particular transit or
progression are grouped together into single entries. Also, to optimize space, the events
are listed using astrological glyphs, using subscripts to indicate what kind of dynamic
event they relate to. These subscripts are
t - transiting
p - progressing
d - directed
n - natal
r - radix
It is possible to alter the display to show either transiting hit numbers or dates/times on
which certain events occurred, on the map. The Hit Nos option shows which hit in a
series of direct/retrograde transits to a point is occurring. For example, if the transit has
three hits (1st hit direct, 2nd hit retrograde, and 3rd hit direct), then these events will be
labeled 1:3, 2:3, and 3:3 respectively. If the transit has only one hit, then it will be
labeled 1:1. This enables you to see at a glance whether there are associated hits which
occur before or after the duration of the time map. Note, however, that progressions and
directions and special dynamic events do not have hit numbers shown, as these will
generally always be single events. The Date option shows the day and month of each
major event on the map. For example an event which occurs on the 23rd March will be
labeled either 23/3 or 3/23 depending on the date order in your Windows setup.
However, if the duration of the time map is less than 7 days, then this option shows the
time in 24 hour format, instead of the date. For example an event which occurs at
3:46pm is labeled 15:46. It is possible to scroll through this list by using the scroll bars
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on the right of the screen. It is also possible to reorder and delete lines in the map.
>> To delete one or more lines from the map
1. Select the required lines by clicking on them
2. Select the Delete button
You will be asked to confirm whether or not you wish to delete them. Note that
clicking on any line selects it on the first click, and un-selects it on a subsequent click.
>> To move a line on the map
1. Drag and drop the required line as follows
2. Position the mouse over the line you wish to move and hold down the left hand
button
3. Drag the mouse to the required position in the map
4. Release the mouse button
>> To print a copy of the time map
1. Optionally use the Printer button to alter printer settings such as paper orientation
2. Select the Print button
This will print the entire list, in the displayed order, using as many pages as are
required. Each page will have a time scale printed at the top.
>> To view further information on an item
Double click on a line.
The Item Info dialog box will be displayed, showing interpretations and event
information. This may be used in the same manner as in the dynamic report screen.
>> To return to the dynamic report screen
Select the Quit button.

5.3

Using the Graphic Ephemeris
This chapter describes how to generate, view and print a graphic ephemeris of
longitudes of transits, progressions or directions, and of declinations or latitudes of
transits and progressions, for any chart.
It is also possible to generate a graphic ephemeris of transits without reference to any
chart, which can be printed out as a pro-forma ephemeris for use with any chart. A
graphic ephemeris may also be added to the print batch queue, to be printed later.
Before generating a graphic ephemeris, you should cast, open or generate the subsidiary
chart that you wish to base the ephemeris on, so that it is showing in the “Calculated
Charts” list box on the Main Screen.
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>> To generate a graphic ephemeris
Choose the Graphic Ephemeris menu item from the Dynamic menu.
This will display the “Graphic Ephemeris Selection” screen that allows the selection
of a base chart and various other options.
5.3.1 Choosing Ephemeris Options
In the "Graphic Ephemeris Selection" dialog...
>> To select a base chart
1. Click on the required base chart in the list of Dynamic Radix Charts.
You may also optionally select a different chart from the Alternate Radix Positions
Chart drop-down listbox. Usually this should be the same chart, but if you choose a
different chart, then the generated ephemeris will show dynamic events of the
Dynamic Radix Chart in relation to the radix chart points of the alternate chart. For
example, if you choose “Sarah Jones” as your dynamic radix chart, and “David
Smith” as your alternate radix chart, then when you generate an ephemeris, it will
show Sarah’s progressed planets making aspects to David’s natal planets.
>> To select previously saved options
2. Choose an item from the Saved Selections drop-down list on the left hand side of
the screen.
This will immediately update all the selections on the screen with whatever was
stored under that saved selection description.
>> To set the date from which the ephemeris will start
3. Select the Now button
If the "Now" button is selected, then the "Date" will be updated to correspond to
the computer's internal clock. This button is useful if you wish to produce an
ephemeris covering a period from today onwards.
4. Enter a Date
Enter a date in any acceptable format. Most commonly used formats are
acceptable. If the format is not acceptable then an error dialog box will be
displayed. Acceptable formats are described in detail in Entering a Date.
Alternatively, to facilitate the setting of the date, there is a special feature to help
you quickly set the date back by a day, to the beginning of a month, or to the
beginning of a year. To set the date back by one day, double-click on the Days
option button. To set the date back to the first day of the month (or to the previous
month if the the day is already the 1st of January), double-click on the Years option
button.
Once you have the desired start date then you can set the duration of the
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ephemeris to be any number of days, months or years.
>> To select the duration of the ephemeris
5. Select any one of the Days, Months or Years option buttons
6. Enter the number of days, months or years in the Period box. This must be a
positive integer. The period that the ephemeris will cover will be this number of
years, days or months, depending on which of these periods has been selected
with the option buttons.
>> To select the location for which you wish the ephemeris to apply
7. Select either the Natal or Relocated option button
If a dynamic report is being generated for an individual, then it should normally be
relocated to wherever they are living during the period of the report. However, if
the chart's subject is someone who is living in the same location as they were born
during the time of the report, then the natal option is appropriate.
If only progressions are being generated for an individual, then the location should
normally be the same as the natal chart location. However, if the base chart is that
of a person who moved during the first few months of their life, it may be
appropriate to relocate it.
If you select the Natal option, then all the boxes relating to location will contain
the location details from the base chart.
Note that although it is technically correct to alter the time zone if the current
time zone is different from the natal one, in practice this is only necessary if
you are examining lunar or chart angle transits, as the difference in the
resultant times is otherwise not significant.
If you select the Relocated option, then all the boxes relating to location will
contain the current default values, and you can enter new location data if you
wish to. (See Saving and Restoring Settings for details on default values.) Any of
these values may be altered in the same manner as when creating a new chart.
See Casting a Natal Chart for instructions on how to alter location values.
>> To select the ephemeris dynamic type
8. Select one of the following options from the Ephemeris Selection list:...
Transits - to display transiting planetary positions
Progressions - to display any type of progressed planetary positions
Directions - to display any type of directed planetary positions
If you select progressions, then the Progressions drop-down listbox in the
"Dynamic Type" area will become enabled, and you can select any of the available
progression types from that list. The progressions may be secondary, tertiary,
minor, user-defined rate, age or age+1 harmonic.
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If you select Directions, then the "Directions" drop-down listbox in the "Dynamic
Type" area will become enabled, and you can select any of the available direction
types from that list. The directions may be solar arc, ascendant arc, vertex arc,
user arc 1°/yr or annual profections.
Also note that, unless the base chart is a natal or event type chart, then it will only
be possible to select the Transits option. In this case, the other options will be
disabled (greyed out).
9. If you wish to view Prec. Corr. or Converse planetary position, then you can
optionally also click on their check boxes in the "Dynamic Type" box, and you can
also choose an arc multiplier using the Mult button if your are using Solar Arc,
Ascendant Arc or Vertex Arc directions.
>> To select the graph coordinate type
10. Select Longitude, Declination or Latitude from the drop-down list box below the
dynamic type selection. (Only longitude is available if you have chosen to use
directions.)
If you select longitude, then you have the option of selecting an ephemeris modulus
angle. If you select declination or latitude, then you can select an angle extent.
>> To select the ephemeris modulus angle
11. Select a pre-defined modulus angle from the Modulus Angle drop-down list
Alternatively, you can type any desired angle from 10 minutes of arc to 360 degrees
directly into the Modulus Angle box. You can type in degrees and minutes and
seconds, separating each with a space (e.g. 22 30 for 22°30’), and you can also use
decimal format (e.g. 22.5 for 22°30’).
The graph will display the zero line at the top, and extends downwards by the
amount of the specified modulus angle.
>> To select other display options
12. Click on the Radix Positions check box in order to have the radix chart’s planetary
positions displayed on the ephemeris.
13. Click on the Radix Aspects check box in order to have an aspect glyph displayed
wherever a dynamic planetary position crosses a radix position.
14. Click on the Sign Labels check box in order to have zodiac sign labels for each
planetary line (both radix and dynamic), and sign change bullets on each planetary
line wherever the planet crosses into a new sign.
15. Click on the Lunations check box to have New and Full moon position markers on
the graph. These appear as small circles containing an N for a new moon (without
eclipse), F for a full moon (without eclipse), ¨ for a solar eclipse on the new moon,
and © for a lunar eclipse on the full moon. Note: This option setting is included as
part of the Saved Selection, so if you wish its setting to be remembered as part of
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the current selection, you must use the Save Selection button after changing it.
16. Click on the Deg Gridlines check box in order to have dashed lines drawn across
the ephemeris at each degree division. Having this option switched on helps locate
positions within the ephemeris more easily, but may be distracting when viewing
the ephemeris on a small screen.
17. Click on the Date Gridlines check box in order to have dashed lines drawn down
the ephemeris at each date division.
18. Click on the Back Shading check box to have the entire ephemeris data area
shaded with a light grey. This option affects the aesthetic appearance of the
ephemeris only.
>> To plot financial data on the ephemeris
19. Click on the Import Financial Data button. This will allow you to import data from
a file external to Solar Fire that will then always be displayed on the ephemeris for
the current session of Solar Fire. If you don't want the data to continue to be
displayed you need to quit Solar Fire and then restart it. See Tools for Financial
Astrology for more information.
>> To select which chart points to use in the ephemeris
20. Click on the required point type (Transits, Progs or Radix) inside the Points
Selection box.
This will display the "File Manager" which lists all the available point files. To
select a file, highlight it and click the Select button. To see what is in a file and
optionally make changes, click the Edit button. For more details on selecting and
editing point files, see Editing a Chart Points File.
Note: Only those point types which are applicable to the current selections will be
enabled.
>> To save these selections for future use
21. Click on the Save Selection button.
You will be asked to enter a description under which to save this selection. Type in
a brief description, and then click on the OK button. The description will appear in
the Saved Selections list on the left of the screen, ready to reselect in future.
>> To delete a saved selection
Highlight the desired selection in the Saved Selections list, and press the Del key.
5.3.2 Viewing and Printing the Graphic Ephemeris
Once all the options have been set in the "Graphic Ephemeris Selection" screen, it is
possible to view the ephemeris, to print it now or later, and to copy it to the clipboard for
pasting into other programs.
© 2014 Esoteric Technologies Pty Ltd

Dynamic Time-Based Operations

209

>> To add the ephemeris to the print batch queue
1. Click on the Queue button.
This will display a dialog box asking you to confirm whether or not you wish to add
this job to the Solar Fire print batch queue. If you select the OK button, then it will
be added to the queue, and it will not be calculated or printed at this time. It is
possible, at any later time, to start printing all the jobs which are on the batch print
queue by selecting the Start Print Queue option from the View menu of the Main
Screen.
>> To view the graphic ephemeris
2. Click on the OK button.
The "Graphic Ephemeris" screen is displayed, and the ephemeris is generated as
you watch. Once the ephemeris is finished, you have the option of resizing the
screen. If the screen is smaller than the available screen size, then clicking on the
screen’s maximize button will generate a larger display, which may be easier to
read.
>> To step the graphic ephemeris forward or backward in time
3. Click on the >> or << buttons in the top corners of the screen.
These will recalculate and display the graphic ephemeris for the time periods
adjoining the time period of the current graph.
>> To print the graphic ephemeris
4. Click on the Print button.
The usual print dialog box will appear enabling you to select Setup or Print.
However, the "Queue" button will be disabled. In order to queue the ephemeris, you
must return to the "Graphic Ephemeris Selection" screen.
>> To copy the ephemeris as a graphic
5. Position the mouse anywhere over the Graphic Ephemeris and click once on the
right-hand mouse button.
This will display the "Copy" dialog with the options to copy the graph to various
locations in various formats. See Copying, Publishing and Sending Graphics for a
full description of these options.

5.4

Real Time Clock and Animation
This chapter describes how to use Solar Fire’s real time astrological clock, and how to
animate charts and page displays by running or stepping them forward and backward
through time. This module also allows the one-step construction of biwheels, triwheels
and quadriwheels showing transits, progressions and directions around natal chart.
Some things that can be done in this module are as follows.
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Display a real time astrological clock for the current location
Display a real time astrological clock for any other location and timezone
Display multiple real time clocks
Display a natal chart ready to step forward or backward in time
Display a progressed or directed chart ready to step forward or backward in time
View pop-up interpretations of a chart (see Viewing Interpretations)
Display and operate a dial pointer (see Using Dials and Pointers)
Display a biwheel with a natal chart (or radix chart) on the inner ring, and current
transits on the outer ring, ready to step forward or backward in time
Display a triwheel with a natal chart (or radix chart), current secondary
progressions and transits, ready to step forward or backward in time
Display a quadriwheel with a natal chart (or radix chart), current secondary
progressions, solar arc directions and transits, ready to step forward or backward in
time
Display other combinations of fixed and dynamic charts in uni, bi, tri and
quadriwheels
Display any astrological page ready to step forward and backward in time
Run, step or jump the charts or pages through time
These options are described more fully below.
Note that the wheel styles and other color options used in this module are always the
same as those that are in effect on the View Chart screen, and can be altered by using a
right hand mouse click somewhere over the display to bring up the Chart Options menu.
5.4.1 How to Setup Real Time Clocks and Animations
>> To display a real time astrological clock for the current location
Select the Real Time Clock item from the Dynamic menu
This will display a chart for the current default location, updated at regular intervals.
>> To display a real time astrological clock for any other location and timezone
[A]
1. Cast a new natal chart for the required location for any date and time
2. Select that chart as the current chart
3. Select the Animate Chart… item from the Dynamic menu
4. Click on the Clock option button at the top right of the screen
This will display a chart for the required location, showing the correct current local
time for the timezone of the chart, updated at regular intervals. For example, if your
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default location is Sydney, Australia (AEST –10:00), and it is currently 3pm in
Sydney, and you cast a chart for London, UK (GMT +0:00), then display that chart in
the real time clock, then the clock time will be displayed as 5am GMT, which is the
correct current time for London.
[B]
1. Select the Real Time Clock item from the Dynamic menu (this will display a chart
for the current default location)
2. Click on the Location button on the right hand side of the window. In the resulting
Change Location dialog box you can set a new place and timezone and apply that
to the clock.
>> To display multiple real time clocks
When you select the Dynamic menu, Real Time Clock, the first window displayed will be
the real time chart for the current location. However, if you move that window to another
place on the monitor then select another chart that has been opened on the "Calculated
Charts" list and then select Dynamic / Real Time Clock again, a new real time clock
window will open that "inherits" some settings from the highlighted chart. Some of the
settings that are passed into the new real time clock window are: Place, Country,
Timezone, House System, Zodiac and Coordinates. As an example, you can create two
charts, one for a place with geocentric coordinates and one for the same place but using
heliocentric coordinates. When you create two real time clock windows from these two
charts, you will now have two windows "ticking over" but using two different coordinate
systems. Likewise, you can display two real time clocks using different house systems.
You are not limited to just two clocks, you can open as many real time clocks as you like.
Thus you can create a real time clock windows for different locations, like Sydney,
London and New York, all displaying the local time at those locations with all windows
"ticking over" together. Depending on the chart that is highlighted on the "Calculated
Charts" list, you can create real time clocks for both geocentric and heliocentric
coordinates or use tropical and sidereal zodiacs or different house systems, for
comparison purposes
Note: this multiple window feature only applies to the Real Time Clock feature and not
to the Animate features.
>> To display a natal chart ready to step forward or backward in time
1. Select the required natal chart as the current chart
2. Select the Animate Chart… item from the Dynamic menu
This will initially display the chart exactly as it has been cast. If you use the time
controls to alter or step the time, then the chart’s date and time are used as the
starting point, and then adjusted according to the options you choose.
>> To display a progressed or directed chart ready to step forward or backward in
time
1. Select the required progressed or directed chart as the current chart
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2. Select the Animate Chart… item from the Dynamic menu
This will initially display the chart exactly as it has been cast. If you use the time
controls to alter or step the time, then the chart’s date and time are used as the
starting point, and then adjusted according to the options you choose.
>> To display a biwheel with a natal chart (or radix chart) on the inner ring, and
current transits on the outer ring, ready to step forward or backward in time
1. Select the required natal chart as the current chart
2. Select the Animate BiWheel… item from the Dynamic menu
This will display the natal chart as a fixed chart on the inner ring, and the current
transits on the outer ring. If you use the time controls to alter or step the time, then
the current date and time are used as the starting point, and the transits chart is
then adjusted according to the options you choose.
>> To display a triwheel with a natal chart (or radix chart), current secondary
progressions and transits, ready to step forward or backward in time
1. Select the required natal chart as the current chart
2. Select the Animate TriWheel item from the Dynamic menu
This will display the natal chart as a fixed chart on the inner ring, and the current
secondary progressions on the middle ring, and transits on the outer ring. If you use
the time controls to alter or step the time, then the current date and time are used
as the starting point, and the progressions and transits charts are then adjusted
according to the options you choose.
>> To display a quadriwheel with a natal chart (or radix chart), current secondary
progressions, solar arc directions and transits, ready to step forward or backward in
time
1. Select the required natal chart as the current chart
2. Select the Animate QuadriWheel item from the Dynamic menu
This will display the natal chart as a fixed chart on the inner ring, and the current
secondary progressions on the middle inner ring, solar arc directions on the middle
outer ring and transits on the outermost ring. If you use the time controls to alter or
step the time, then the current date and time are used as the starting point, and the
progressions, directions and transits charts are then adjusted according to the
options you choose.
>> To display other combinations of fixed and dynamic charts in uni, bi, tri and
quadriwheels
If you are already displaying a dynamic wheel with the required number of charts, then
click on the Charts button to display a dialog which allows you to select alternative
charts.
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Alternatively, you can select the Animate Page item from the Dynamic menu. You will
be prompted to select the required page type from the list of available pages, and then
the required chart types. (See below)
>> To display any astrological page ready to step forward and backward in time
If you are already displaying a dynamic wheel or page with the required number of
charts, then click on the Page button to display a dialog that allows you to select
alternative pages.
Note that you will only be able to select another page which requires the same number of
charts as the wheel or page you are currently viewing.
Alternatively, you can select the Animate Page item from the Dynamic menu. You
will be prompted to select the required page type from the list of available pages,
and then the required chart types. (See below)
>> To change the Place and/or Timezone of charts in a multi chart animation
1. Click on the Location button on the right hand side of the window.
2. In the resulting "Change Location" dialog box you can set a new place and
timezone and apply that to any of the charts simultaneously.
As an example, if you open a natal chart from a chart file, have it highlighted in the
"Calculated Charts" list then click on Dynamic > Animate QuadriWheel, Solar Fire
automatically calculates and displays the Natal, the Secondary Progression, the Solar Arc
and the current Transit chart, all with the same natal location and timezone. In this
situation you may wish to retain the natal location for the Natal and Secondary
Progressed chart but use a different location for the Solar Arc and Transit chart,
particularly if the person is now living at a different location than their place of birth.
5.4.2 Selecting Alternative Chart Types
When setting up an animated page the dynamic chart selection dialog is similar to the
multiwheel selection dialog, except for the additional option of selecting a dynamic
method to apply to some or all of the charts in the wheel or on the page.
You can select the following chart types or methods:Transits – This will display a chart of transiting positions, varying with the
animation date and time. When this option is selected, there is no need to select a
base chart.
Fixed Base Chart – This will display the selected base chart as fixed, so that it does
not vary with the animation date and time. This option should be selected, for
example, with a natal chart that you wish to place in the center of a multiwheel,
with transits or progressions around it.
Secondary Progressions – This will display a chart of the progressed positions
calculated from the selected base chart.
Mean Tertiary Progressions – As above
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True Tertiary Progressions – As above
Minor Progressions – As above
User Progressions – As above. The user progression rate is one of the settings that
may be specified in the Preferences dialog of Solar Fire.
Solar Arc Directions – This will display a chart of the directed positions calculated
from the selected base chart.
Ascendant Arc Directions – As above
Vertex Arc Directions – As above
User Rate Directions – As above. The user direction rate is one of the settings that
may be specified in the Preferences dialog of Solar Fire.
Annual Profections – As above. The profection rate is equivalent to a direction arc
of 30 degrees per year.
Age and Age+1 Harmonic - These will display a chart of the age and age+1
harmonic positions calculated from the selected base chart.
van Dam Primaries - This will display a chart of the van Dam directed positions
calculated from the selected base chart.
When you select a progression or direction method, you may also choose whether to
apply converse or precession correction options, by checking the appropriate boxes as
required. If Solar Arc, Ascendant Arc or Vertex Arc methods are chosen, then you can also
use the Mult button to select an arc multiplier if you wish. These options have the same
effect as the same named options when casting subsidiary charts under the Chart menu.
See Casting Subsidiary Charts for further information on these options.
The Selected Chart list at the bottom of the dialog contains a list of which chart types
have already been selected. If you have selected a uniwheel or page which requires only
one chart, then this list will only have a single item in it. If there are multiple items in the
list, then you must click on the one you wish to select or edit before changing your
selection of base chart and/or dynamic chart method.
>> To select a transits chart to animate
1. In the Selected Charts list, click on the item that you wish to change to transits.
2. In the Dynamic Methods list, click on the Transits item.
It is not necessary to select a base chart in this case, because transits depend only on
the animation date and time, and are calculated independently of any base chart.
>> To select a fixed base chart
1. In the Selected Charts list, click on the item that you wish to change to a fixed base
chart.
2. In the Base Charts list, click on the required base chart.
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3. In the Dynamic Methods list, click on the Fixed Base Chart item.
Any chart that you select this way will remain fixed, even though you may be running
an animation. This option is only to be used when you have other dynamic charts in
the same wheel page, such as transits or progressions to the base chart, and you
want the base chart to remain fixed as a radix chart whilst the other dynamic charts
are animated as the date and time change.
Note: If you use the fixed base chart option when you are only viewing a single chart
on a wheel or page, then the animation features will have no effect.
>> To select a dynamic chart to animate
1. In the Selected Charts list, click on the item that you wish to change to an
animated chart.
2. In the Base Charts list, click on the required base chart.
3. In the Dynamic Methods list, click on the required dynamic method (such as
Secondary Progressions, Solar Arc Directions etc,), and optionally also select the
Prec. Corr. and Converse options.
Any chart calculated by this method will be derived as a subsidiary chart of the
selected base chart, and updated according to the animation date and time.
5.4.3 Exporting Animated Charts
It is possible to export any animated charts into Solar Fire’s list of "Calculated Charts"
from where they may be saved to a chart file or used anywhere else in Solar Fire.
It is also possible to automatically export the animated charts and simultaneously
display them in the "View Chart" window, from where various extra functions are
available, such as rectify assist, reports, and copy/send.
These functions are useful when you have used the animation module to find particular
charts of interest, and then wish to be able to save them or use them in other parts of
Solar Fire.
>> To export the current animated chart/s to the list of "Calculated Charts"
Click on the Export button, and select To Calculated Chart List from the pop-up
menu.
>> To export the current animated chart/s and display them as a fixed Chart View
page
Click on the Export button, and select To Fixed Page… from the pop-up menu.
5.4.4 How to Control the Animation
When the real time clock is running, you cannot perform any of the animation functions.
Before using the animation features, you must ensure that the Animation option is
chosen at the top right of the screen.
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If this is a multiwheel animation, and includes a fixed natal chart that has stored life
events, then it is possible to select any life event from a list to set the animation time
and date automatically.
>> To set the time and date to that of a stored life event
Click on the Events button, and select one of the events from the Event Selection
dialog box.
The "Auto Apply" checkbox is ticked by default, which means as you click on any life
event to select it, the date of the event will automatically be reflected in the wheels
outside the inner wheel. To prevent this from happening untick the Auto Apply
checkbox by clicking in it.
Note: You can also add new life events from this dialog if you wish.
>> To set the time and date to a particular value
Enter new values directly into the date and time boxes.
(See Entering a Date and Entering a Time for details on acceptable formats for dates
and times). Depending on whether you want Daylight Savings to be accounted for
when stepping through time then make sure the Auto DLS checkbox is ticked/unticked
(repeatedly clicking in the checkbox toggles it between ticked and unticked).
>> To set the time step interval
1. In the Step By drop-down box, select one of the pre-defined time intervals.
2. Optionally enter a numeric multiple into the box immediately to the left.
For example, to specify a 5 minute interval, select the “Minutes” item from the list,
and then enter the value 5.
>> To run the chart through time
1. The left and right arrows will start the animation running backward or forward in
time respectively, with the display being recalculated at the specified intervals.
2. Click on the red square Stop button to halt the animation.
>> To step the chart forward or backward
The left and right arrows with the adjacent vertical bars will step the animation
backward or forward in time respectively, one step for each mouse click.
or...
Alternatively, after ensuring that the displayed wheel or page has the focus (by
clicking on it), you can use the left or right arrow keys to step back or forward with
one step per keypress.
>> To change the rate of animation
Use the mouse to slide the Animation Speed control left or right.
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When at its leftmost position, this will attempt to update the display as often as the
power of your computer will allow. When moved further right, the display is only
updated after a fixed interval of time has elapsed. If your computer is not a very
recent, powerful model, you may wish to leave this control at or near its fastest
setting. If your computer is especially powerful, you may prefer to choose a slower
setting so that the animation does not run overly fast.
>> To reset the date and time to now
1. Click on the Clock option button – this will reset the date and time to match your
computer’s system clock, and the timezone of the first displayed chart. Note that
this means that the displayed time and date will be correct for the location of the
chart according to its timezone, and may therefore be different from your current
local time, but the planetary zodiacal positions will still be the correct ones for the
current instant.
2. If you wish to animate again from this date and time, then click on the Animation
option button.

5.5

Searching for Eclipses
This chapter describes how to use Solar Fire’s eclipse database to list eclipses and
eclipse data, cast eclipse charts, and search for eclipses that make aspects to any
specified position or any points in a specific chart.
>> To find an Eclipse
1. Select the Eclipse item from the Dynamic menu, which opens the "Eclipse" module.
You will then see the "Find Eclipses" dialog from which you can make various
selections.
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Dates - You must always specify a date range in the From and To fields. These
accept dates in the same way as all other date entry fields in Solar Fire. See
Entering a Date for details on entering dates.
Eclipse Types – You can select any combination of eclipse types and/or Saros
Numbers by using the check boxes for each option, and optionally entering a
specific (van den Bergh) Saros Number. See a description of eclipse types below.
Eclipse Aspects – If you wish to find only those eclipses that make an aspect to a
fixed position, then check the first box, and enter the required zodiacal position. If
you wish to find all eclipses that make an aspect to a planet or point in a chart,
then check the second box and select a chart from the drop-down list of
calculated charts. You can select which set of aspects are used by clicking on the
Aspects box, and which set of chart points are used by clicking on the Chart
Points box.
Solar Eclipse Types
Partial – There is no region of complete obscuration of the Sun. This occurs when
the axis of the Moon’s shadow passes outside of the disk of the Earth. Maximum
partial eclipse therefore occurs in polar regions.
Annular – This occurs when the size of the Moon’s disk is less than the size of
the Sun’s disk, so that when the Moon is directly in front of the Sun, a ring of
sunlight (annulus) is still visible around the Moon.
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Total – This occurs when the Moon’s disk is larger than the Sun’s disk, and
completely obscures the Sun for a period of time.
Hybrid - Hybrid eclipses are also known as annular/total eclipses. They occur
when the vertex of the Moon's umbral shadow pierces Earth's surface along the
central path of an annular eclipse. The eclipse's character then changes to total
along the section of the path where the umbral vertex extends beneath Earth's
surface. The central paths of hybrid eclipses usually (but not always) begin and
end as annular eclipses, but become total along some middle portion of the path.
Lunar Eclipse Types
Appulse – This occurs when the Moon passes across the penumbra of the Earth’s
shadow, and this darkens part of the Moon’s surface, but obscures none of it
completely.
Partial – This occurs when the Moon passes partly across the umbra of the
Earth’s shadow. Part of the Moon’s surface becomes completely obscured.
Total – This occurs when the Moon passes completely into the shadow of the
Earth, and the whole disk of the Moon becomes completely obscured.
2. When you have made all your selections, click on the Start Search button.
Solar Fire will list all of the eclipses that match your selection in the list box on the
bottom right of the dialog.
When you highlight any eclipse on this list, the full details of that eclipse will
appear in the box at the top, right of the dialog, and any aspects that are made
between the eclipse point and the (optionally) selected chart will be displayed
below that. The items displayed are as follows...
Eclipse Type – Solar / Lunar and whether Partial / Annular / Total / Hybrid /
Appulse.
Date and Time – The date and time (Universal Time, timezone +0:00) of
maximum eclipse, given to the nearest whole minute or else the date and time to
the nearest second of exact lunar phase, depending on the eclipse setting under
Preferences.
Position – The zodiacal position of the Sun (in Solar Eclipses) or Moon (in Lunar
Eclipses).
Saros Number – The number of the Saros cycle to which this eclipse belongs. The
Saros is a period of approximately 18 years and 11 days, after which eclipses are
repeated with only slightly altered characteristics. The standard astronomical
numbering system is that first described by Prof G. van den Bergh in “Periodicity
and Variation of Solar (And Lunar) Eclipses” publ. Haarlem, Netherlands, 1955. An
alternative numbering system was described by Robert Carl Jansky in
“Interpreting the Eclipses” publ. Astro Computing Services 1979, and extended by
Bernadette Brady in “The Eagle and the Lark” publ. Samuel Weiser Inc, 1992.
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Gamma – In a lunar eclipse, this is the distance of the Moon from the axis of the
Earth’s shadow, at the time of greatest eclipse. In a solar eclipse, this is distance
of the shadow cone axis from the center of Earth at the instant of greatest
eclipse. Units are of equatorial radii.
Magnitude – The fraction of the Sun’s diameter obscured by the Moon.
Umbral Magnitude – The fraction of the Moon’s diameter obscured by the umbra.
Penumbral Magnitude – The fraction of the Moon’s diameter obscured by the
penumbra.
Duration Total – The duration of total or annular eclipse phase at the point of
greatest eclipse.
Semi-Duration Total – The half-time of totality (complete obscuration of moon) of
eclipse. Adding this time to the time of maximum eclipse would give the time of
ending of totality.
Semi-Duration Partial – The half time of partial (partial obscuration of moon)
phase of eclipse. Adding this time to the end of totality would give the time of
ending of the partial phase of the eclipse.
>> To calculate a chart for one or more listed eclipses
1. Highlight the required eclipse (or multiple eclipses) in the list box.
2. Click on the Chart button.
This will calculate a chart for the time of maximum global eclipse (or multiple eclipse
charts if you have highlighted multiple eclipses).
If you were finding eclipses only with aspects to a specified radix chart, then the
location and timezone of the eclipse chart will be adopted from the specified radix
chart. Otherwise, the current default location and timezone are adopted.
If you wish to see the same eclipse chart for another location, then use the Chart /
Locality menu items to relocate the eclipse chart to the required location.
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Using Interpretations
Solar Fire has the ability to provide interpretative text for a large variety of astrological
topics. The possible categories of interpretations are...
Natal
Progressed
Return
Combined
Prenatal
Synastry (Natal to Natal)
Transits to Natal
Progressions to Natal
Directions to Natal
Transits to Natal (Calendar)
Firdaria
Midpoints
Sabian symbols
The interpretative text, is a set of interpretations contained in an interpretation file
(which has an ".int" extension). Each of the interpretation categories above can have a
different interpretation file associated with it, which is used whenever a chart (or charts)
of that category is/are selected. It is possible for all of the categories to use the same
interpretation file, although ideally each category would have its own separate
interpretation file, containing text that has been written specifically for that chart type.
When you first install Solar Fire, there are interpretation files supplied for natal charts,
transits to natal charts, progressions to natal charts (which also includes progressed
charts), synastry, firdaria, midpoints, and sabian symbols. However, if you have created
additional interpretation files with the "Interpretations Editor", or purchased and
installed any additional interpretation files, then it is possible to also select one of these
other files.
When Solar Fire is first installed, all the categories use the same interpretations file
(standard.int) apart from Synastry (synastry.int), Transits to Natal (transits.int),
Progressions to Natal (progress.int), Firdaria (Firdaria.int) and Midpoints (midpoints.int).
In order to change which set of interpretations (interpretation file) Solar Fire will use for
each of the possible interpretation categories, you must change the appropriate settings
via the Interpretations Files option of the Interps menu. See Changing the
Interpretations File for instructions on how to do this.
You can use any set of interpretations with any type of chart if you wish to, for example
using the natal interpretations (file) for a progressed chart, return chart or composite
chart. However, if you do so, then you will need to bear in mind that some of the
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interpretations may not apply in the same way as they would to a natal chart. It is also
possible, in the future, that you will be able to purchase alternative sets of
interpretations (i.e. files) which are written in different styles, or which apply to different
chart types. You can also edit the existing text in a file, see Editing interpretations for
how to do this.
The interpretations text files which are supplied with Solar Fire are all installed into a
single folder, which is the "Interpretations" subfolder of the Solar Fire User Files folder.
For the technically minded you can change this (see Interpretation Files).

6.1

The "Interps" Menu
The "Interps" menu on the Main Screen is a central access point for both managing and
viewing interpretations although, importantly, some of the same functionality can also
be accessed via the "Interpretations Window" (see Viewing Interpretations).
The following items are available on the "Interps" menu...
View
Opens the "Interpretations Window" (see Opening the Interpretations Window).
Full Report
Used for generating a full interpretations text report (see Viewing a Full
Interpretations Report).
Synastry Report
Allows you to select two charts from the "Calculated Charts" list to see synastry
interpretations for, and then generates an interpretations text report for those two
charts. If there are already two valid charts selected in the "Calculated Charts" list
then those charts will be used automatically.
>> To generate a Synastry interpretations report
1) Select Synastry Report
2) If the "Chart Selection" dialog box opens select the two charts to use (otherwise go
to step 3).
a) If it isn't already highlighted select (click on) the 1st Chart position in the
Selected Charts list box
b) Select a chart for the 1st Chart from the "Charts" list box (at the top of the
dialog box)
c) If it isn't already highlighted select (click on) the 2nd Chart position in the
Selected Charts list box
d) Select a chart for the 2nd Chart from the "Charts" list box
e) When a chart is selected, its name and type is written into the "Selected
Charts" list box. It is possible to change the selection of any chart by
repeating the above procedure as often as required.
3) Click on the View button (until a chart selection for both charts as per step 2 is
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made, the "View" button is disabled and cannot be used).
4) Then the "Select Text for Report" dialog box opens. Select the text categories
you want in the report by clicking in the checkbox to the left of each category
until a cross is in the checkbox (initially all the text categories are selected).
Clicking in a checkbox with a cross in it un-selects the category (it will be blank).
Solar Fire will remember the categories you select for the next time you generate
a synastry report.
5) If the sex of any of the charts is incorrect, correct it in by clicking on the radio
button for the correct sex.
6) Click on the View button.
7) The interpretations report will be loaded up in the default word processor which can be specified via the bottom of the "Interps" menu itself (see below).
8) You can now view the report, edit if you wish, and print it from your word
processor.
Firdaria Report
Used to generate various Firdaria interpretation reports. Firdaria relates to different
periods in life ruled by the planets and Moon's Nodes.
There are two forms of this method, one using planetary periods as they were used
by Al Biruni and Schoener, and the other is a variant of this which places the nodes
in a different order for night-time charts (Nodal Variation). Both forms give identical
results for daytime charts.
You can specify whether or not to use Nodal Variation in the generating of the
report. Simply click on "Nodal Variation" or "Normal" at the bottom of the pop-out
Firdaria menu. Solar Fire will remember your selection for all subsequent reports.
Midpoints Report
Used to generate Midpoint interpretation reports; either for a specific chart in the
list of "Calculated Charts" or interpretations for a variety of midpoints generally.
>> To generate a Midpoints interpretations report
1) Select Midpoints Report
2) To see interpretations for the current chart in the "Calculated Charts" list select
Planets to Midpoints Report. In the dialog box that appears select the modulus
and orb. Click on the OK button, and the report will be displayed in the default
word processor reports.
3) To see general midpoint interpretations select General Midpoints Report. The
report will be displayed in the default word processor for reports.
Interpretation Files
This allows you to change the interpretation files associated with the interpretation
categories (see Changing the Interpretation File).
Word Processor Options
Here you can set the default word processor for displaying interpretation reports
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(see Selecting a word processor).

6.2

Changing the Interpretation File
>> To change the selected interpretation file for an interpretation category
Do either of the following...
a) From the "Interpretations Window", select the Open item from the File Menu.
or...
b) From the Main Screen, select the required file type from the Interpretations Files
menu item in the Interps menu.
You will then see the "File Manager" Dialog Box, from which you can choose any other
available interpretation file. If you click on the Select button, then the chosen
interpretation file will become the default for interpretations of the chosen category (if
selected from the "Interps" menu), or for the category that is currently being viewed (if
chosen from the "Interpretations Window").

6.3

Viewing Interpretations
You can view any of the interpretation text by opening the "Interpretations Window".
This can be done from the Main Screen of Solar Fire, or from the "View Chart" or
“Animation” screens.
When you open the "Interpretations Window", Solar Fire automatically detects which
category of interpretations is required in the current circumstances, and opens the
interpretations file that has been assigned to that category. For example, if you are
viewing a Progressed chart when you open the "Interpretations Window", then Solar Fire
will open the interpretations file that has been selected to apply to Progressed charts.
(At installation this file was "progress.int", containing interpretation text written for
progressed charts.)
The "Interpretations Window" has two modes of operation...
General Mode - In this mode, you can browse through every possible combination
of interpretation and definition text.
Current Chart Mode - In this mode, you are limited to browsing through
interpretation relating solely to the current chart. (The current chart is whichever
chart was last selected from Solar Fire's Main Screen, or the chart which you were
displaying in the "View Chart" window immediately before opening the
"Interpretations Window".

6.3.1 Opening the Interpretations Window
>> To open the "Interpretations Window" from the Main Screen
Choose the View item from the Interps menu
If there are any calculated charts in the Main Screen's list of "Calculated Charts", then
the "Interpretations Window" will open in Current Chart Mode and initially contain
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text relating to the current (last selected) chart. If there are no charts calculated yet,
then the "Interpretations Window" will open in General Mode and initially contain
general definitions text.
You can open the "Interpretations Window" from the "View Chart" window provided
that you are displaying at least one single wheel or multiwheel chart. However, it is
not possible to open the "Interpretations Window" from this screen if you are only
displaying a grid.
>> To open the "Interpretations Window" from the “View Chart” screen
You must be displaying at least one chart in a single or multi-wheel - you cannot open
the "Interpretations Window" if you are displaying only a grid or other tabulations. The
"Interpretations Window" will appear when you click on parts of the wheel as follows:
1. Double-click on any displayed chart point (i.e. planet, asteroid or angle glyph).
This displays an interpretation of that chart point in its house and sign e.g. Jupiter
in the 11th House in Cancer. If this is a multi-wheel, then the house placement is
based on the houses of the anchor chart, which is usually the innermost chart.
2. Double-click on the degrees, sign glyph or minutes of any chart point. This
displays information about the degree occupied by that chart point e.g. 17th
degree of Pisces.
3. Double-click on a sign glyph on any house cusp. This displays an interpretation of
the selected house when ruled by its sign e.g. Leo on the 3rd house cusp.
4. Double click on the degrees or minutes of any house cusp. This displays
information about the chart degree of that house cusp e.g. 3rd degree of Aries.
5. Double-click on any unoccupied space inside a house. This displays information
about the meaning of that house e.g. the 7th House.
6. Double-click inside the aspect ring, or outside the chart. This displays explanatory
text about the set of interpretations, such as who wrote it and to what type of
charts it applies.
7. Click once on any chart point followed by a single click on any other chart point
within 3 seconds. This displays an interpretation of the aspect between those two
points, if there is an aspect made between them e.g. Jupiter Trine The Sun. If the
chart points that you click on are in different wheels, then Solar Fire will
automatically select the Synastry, Transits to Natal, Progressions to Natal or
Directions to Natal set of interpretations, depending on what chart types are
involved.
8. Click once on any chart point followed by a single click on either the sign glyph on
the 1st house cusp, or the sign glyph on the 10th house cusp. This displays an
interpretation of the aspect between the first point and the Ascendant or
Midheaven respectively, if there is an aspect made between them e.g. Venus
Conjunct Ascendant.
The following diagram shows an example of the "sensitive" areas of a chart, which are
numbered according to the list above.
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6.3.2 Exiting from the Interpretations Window
You can exit from the interpretation window in two different ways. One way will close
and unload the interpretations file, which means that next time you open up the
"Interpretations Window" a few extra seconds will be taken to load the file again. The
other way simply minimizes the "Interpretations Window" without unloading the
interpretations, so that it can be accessed again almost instantaneously.
>> To exit from the interpretations and unload the interpretations file
Choose the Exit option from the File menu of the "Interpretations Window".
>> To minimize the "Interpretations Window"
Click on the minimize button on the top right of the "Interpretations Window". Once
it is minimized, you can retrieve it by double-clicking on its icon, or by using any of
the methods previously described to open the "Interpretations Window".
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6.3.3 Browsing the Interpretations

Once the "Interpretations Window" is open, it is possible to browse through all the
categories of interpretations for a chart as well as all the general definitions, without
leaving the window again.
In order to browse through all the available definitions or interpretations relating to the
currently selected mode and information type, select any item from any of the drop-down
list boxes.
You can also browse through the definitions or interpretations simply by using the cursor
keys (UP, DOWN, LEFT and RIGHT). The UP and DOWN keys will move you up and down
the items in the currently highlighted drop-down list box. The LEFT and RIGHT keys will
move you between the drop-down list boxes e.g. if there are two drop down-list boxes
using the left key will shift the highlight to the left box, and using the right key will shift
the highlight to the right box.
Note that some information types do not have any drop-down list boxes, as there is only
one type of information available for them. For example, if you are in Current Chart
Mode, then the Element information type shows a single set of information about the
balance of elements in the current chart. However, if you are in General Mode, then
there will be drop-down list boxes allowing you to browse the different elements (fire,
earth, air, water) and emphasis types (definition, weak, strong).
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6.3.4 Switching Modes
>> To switch between General Mode and Current Chart Mode
Select the desired option from the Mode menu.
A tick appears to the left of whichever menu option is selected. Also, when you are in
General Mode, the title of the interpretations windows is "General Interpretations",
whereas when you are in Current Chart Mode, the title consists of the chart's name and
its type e.g. "Marilyn Monroe - Natal".
It is not possible to select Current Chart Mode if you have not yet cast or opened any
charts. Otherwise you can freely switch between modes as you wish.
In most cases the information type that you are browsing will be retained when you
change mode e.g. if you are looking at information about the degree of Mercury in a
chart (in Current Chart Mode), then when you switch to General Mode you will still see
the same text about that degree, but you will be able to browse through the text relating
to all the adjoining degrees.
6.3.5 Selecting Information Types
There is a large variety of information types available. These can be accessed from the
Info menu.
>> To switch between information types
Select the desired option from the Info menu. A tick appears to the left of whichever
menu option is selected.
Most information types show different text depending on whether the mode is set to
"General Mode" or to "Current Chart Mode". The information types, and a description of
the text which they show in each mode are...
Introduction
General Mode - Title, copyright and explanatory text
Current Chart Mode - Same as General Mode
Degree
General Mode - Information about any degree of the zodiac
Current Chart Mode - Information about the degree of any chart point
Decanate
General Mode - Information about any decanate (10 degree subdivision) of the
zodiac and its ruler
Current Chart Mode - Information about the decanate of any chart point, and its
ruler
Sign
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General Mode - General definition plus weak and strong definition of any sign
Current Chart Mode - Balance of the signs using a scoring system
Element
General Mode - General definition plus weak and strong definition of any element
Current Chart Mode - Balance of the elements using a scoring system
Mode
General Mode - General definition plus weak and strong definition of any mode
Current Chart Mode - Balance of the modes using a scoring system
House
General Mode - General definition plus weak and strong definition of any house
Current Chart Mode - Balance of the houses using a scoring system
Quadrant
General Mode - General definition plus weak and strong definition of any quadrant
Current Chart Mode - Balance of the quadrants using a scoring system
Hemisphere
General Mode - General definition plus weak and strong definition of any
hemisphere
Current Chart Mode - Balance of the hemispheres using a scoring system
Aspect
General Mode - General definition of any aspect
Current Chart Mode - Interpretation of the aspect between any two chart points in
the current chart
Ray
General Mode - General definition plus weak and strong definition of any ray
Current Chart Mode - Balance of the rays using a scoring system
Lunar Phase
General Mode - Interpretation of any of 8 lunar phases
Current Chart Mode - Interpretation of the lunar phase of the current chart
Sign on House
General Mode - Interpretation of any sign on any house cusp
Current Chart Mode - Interpretation of any house cusp's sign in the current chart
Chart Point
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General Mode - Definition of any chart point
Current Chart Mode - Basic technical information and aspect list for any chart point
in the current chart
Point in House/Sign
General Mode - Interpretation of any chart point in any sign and any house
Current Chart Mode - Same as above two information categories combined
Point Ruling House
General Mode - No information available (disabled)
Current Chart Mode - Definition of each of the houses ruled by any chart point in
the current chart
Dispositor's House/Sign
General Mode - No information available (disabled)
Current Chart Mode - Definition of the house and sign of the dispositor of any point
in the current chart
Point's Aspects
General Mode - Any chart point in any aspect to any other chart point
Current Chart Mode - Interpretations of all of the aspects formed to any chart point
in the current chart
Point's Rays
General Mode - Definition of each ray relating to any chart point
Current Chart Mode - Same as General Mode
6.3.6 Changing Rulerships
Some interpretation information types, such as decanates, house rulerships, dispositors
and rays, contain information relating to planetary rulerships of signs and decanates. It
is possible to select any available set of rulerships (such as Modern, Old and Esoteric) to
be used in the text for these items as follows.
>> To change rulerships
Select the desired rulership set from the Rulerships menu.
It is possible to browse or edit these rulerships, and add or delete rulership sets with
a separate utility, which is described in detail in Changing Rulerships and Weightings.
6.3.7 Speaking Interpretations
Speaking options are available only on those computers on which the Microsoft Speech
engine has been installed. This is installed by default on Windows XP or later, but not on
any earlier versions of Windows).
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>> To speak the displayed interpretation text
Select Speak Interpretations from the File menu.
This will speak the displayed text using the built-in speech synthesizer. Closing this
window stops the speech.
>> To automatically speak the displayed interpretations whenever this dialog
opens
Select the AutoSpeak item from the Options menu. This may be switched off simply
by re-selecting it.
6.3.8 Changing the Display Options
You can select a variety of display options as follows:
>> To ensure that the "Interpretations Window" remains visible on top of any
other window
Select the Always On Top item from the Options menu. This may be switched off
simply by re-selecting it.
>> To make the "Interpretations Window" transparent
Select the Transparent item from the Options menu. This may be switched off
simply by re-selecting it.
(This option is available only for Windows 2000, XP, Vista or later.)
>> To display the "Interpretations Window" at full screen size
Click on the maximize button at the top right of the window. You can restore the
window to its original size simply by clicking on the restore button at the top right
of the window.
>> To alter the font style, size or color
Select the Font item from the Options menu. This will display a standard font
selection window, from which you can select any available screen font, plus its
style, size and color.
>> To alter the size of the "Interpretations Window"
Drag the window's borders with the left mouse button held down.
6.3.9 Exporting Text to a File
You can send a selection of the available interpretations for the current chart to an
external file to be used in a separate text editor, printing utility or word-processor. The
resulting text file will have an ANSI format without any carriage return/line feeds within
the body of each paragraph. This makes it easy to use if it is imported into a wordprocessor as it will not be necessary to remove "hard" carriage returns from each
paragraph of text.
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>> To send interpretations to a text file
Select the Export Text item from the File menu of the "Interpretations Window".
This will display a selection dialog box from which you can choose which categories
of interpretations will be exported.
You can select any of the available text categories by ensuring that the check box for
that category contains an "X". Click on any of these to select or unselect them. If you
switch off the "Chart Points" category then it is not possible to include categories
relating to rulerships and aspects between points, so these option become disabled
(grayed out). When you are happy with the selection, click on the Export button.
You will then be able to select a folder and filename to which the interpretations text
will be sent from a standard Windows "Save File" dialog screen. Initially the filename is
set to INTERPS.TXT, but you may change this if you wish, to any valid DOS filename. You
might also prefer to select the folder in which your word processor resides in order to
make it easier to find the exported file from you word processor.
Once you click on the Export button, the interpretations will be sent to the file that you
specified, a series of beeps will be sounded to let you know that it has finished, and you
will be returned to the "Interpretations Window".
Note that you cannot export text if you are in General Mode. This export utility can only
be used with the interpretations relating to the current chart.

6.4

Sending an Interpretations Report to a Word Processor
Solar Fire’s interpretations are designed for personal and professional use rather than for
mass-production of printouts for sale.
For beginners they provide a fun-to-use learning tool, and a way to print out chart
readings for themselves, friends and family.
For professionals they can be the basis for personalized written interpretations. The text
database itself can be revised and expanded to reflect one’s own astrological ideas, and
the interpretations for any chart can be sent to a word processor and modified for a
particular individual.
Today’s word processors offer many sorts of font and formatting possibilities. Combining
creatively formatted text with the special chart wheels and page designs that you can
create in Solar Fire, you can produce distinctive and attractive printouts for gifts and
special occasions.

6.4.1 Selecting a Word Processor
You can select which word processor you wish to use when viewing and printing
interpretation reports. If you do not select one yourself, then Solar Fire will use the
default word processor on your computer system. See Interps for more details on
selecting a word processor.
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6.4.2 Viewing a Full Interpretations Report
>> To generate a chart interpretations report
Select the Full Report item from the Interps menu, or View Full Report option from
the File menu of the "Interpretations Window".
This will display a selection dialog box from which you can choose which categories
of interpretations will be included in the report.
You can select any of the available text categories by ensuring that the check box for
that category contains an "X". Click on any of these to select or unselect them. If you
switch off the "Chart Points" category then it is not possible to include categories
relating to rulerships and aspects between points, so these option become disabled
(greyed out). When you are happy with the selection, click on the View button. Your word
processor will be opened up displaying this report. You are then free to browse the
report, to print it, or to save it under another name if you wish. Note that, to keep a
permanent copy of the report, you must save it under a different name, because Solar
Fire always uses the same report name. When you have finished with the report, exit
from your word processor.
Note: If you do not exit from your word processor, then the next time that you generate
an interpretations report you may see the old report instead of the newly generated one.
If this happens, then exit from your word-processor, and generate the report again.
>> To generate a synastry interpretations report
Select the Synastry Report item from the Interps menu, or View Full Report option
from the File menu of the "Interpretations Window" when you are already viewing
synastry interpretations.
This will display a selection dialog box from which you can choose which categories
of interpretations will be included in the report, and also the gender of each of the
charts.
The interpretation categories may be selected in the same manner as for natal
interpretations. However, bear in mind that the some categories do not apply to the
synastry report, so that selecting them will make no difference to the final report. In
particular, the following items are not included in the default synastry report.
Balances
House Cusps
Rulerships & Dispositor
Rays

6.5

Editing Interpretations
This section describes how to edit any of the interpretations text that is supplied with
Solar Fire. An interpretations editing program is supplied with Solar Fire, and this may be
accessed either on its own, or directly from within Solar Fire.
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>> To start the Interpretations Editor
From the "Interpretations Window" - Select the Edit Interpretations item from the
File menu. This will start the editor with the current interpretations file.
From the Main Screen - Select one of the interpretation types from the
Interpretation Files item under the Interps menu, and when the "File Manager"
appears, select a file and then click on the Edit button. This will start the editor with
the selected interpretations file.
From the Solar Fire Group Folder - Click the Start button, then All Programs, then
Esoteric Technologies, then Solar Fire 9, and finally click on Interpretations Editor.
This will start the editor without opening an interpretations file, and you will need
to select one from the file open dialog that appears upon startup.
When you enter the "Interpretations Editor", you will see text from whatever
interpretations file has been opened. If you wish to edit text within this file, you may
start to do so immediately. However, in many cases you may prefer to keep the original
interpretations unchanged, and to work on a copy of the original file. In this case you
must save a copy of the current file under a new name before proceeding.
>> To save a copy of the current interpretations file under a new name
1. Select the Save As option from the File menu.
2. This will display a standard “File Save” dialog, in which you can select a new name
for the interpretations file, and optionally a different folder. It is recommended
that you keep your new interpretation files in Solar Fire’s \INTERPS folder, because
that is the only folder that Solar Fire can access interpretations from (there is an
exception to this - see Files and Paths). Also, the new file name must be an
acceptable file name and end with a “.int” extension.
3. Click on the OK button. You will then be returned to the interpretations editor and
the newly saved copy will be open instead of the original file.
>> To switch to another interpretations file
1. Select the Open option from the File menu
2. This will display a standard “File Open” dialog in which can select a new file to
open.
3. Click on the OK button. You will then be returned to the interpretations editor and
the newly selected file will be open for editing.
>> To close the current interpretations file
1. Select the Close option from the File menu.
2. This will close the current file, and you will not be able to carry out any editing
functions until you open another file.
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6.5.1 Editing Text
Following is a list of interpretation text types showing what combinations are available
for each, and how they may be used...
Title - A descriptive title for this set of interpretations. This title appears in the "File
Manager" to assist in selecting the required set of interpretations, and as a title to
interpretations reports.
Copyright - A copyright notice. This appears in reports, but can be left blank if you
do not wish copyright to apply to your text.
Introduction - General introductory text. This appears as an introductory section to
interpretation reports. It can contain any preliminary comments that you wish, for
example explaining how the following interpretations should be applied in practice,
and providing disclaimers.
Degree - Information about each degree of the zodiac. This can include Sabian
symbols, medical degree interpretations, medieval degree meanings etc.
Decanate - Information about each decanate (10 degree subdivision) of the zodiac.
Quadrant - General definition plus weak and strong definition of each quadrant.
Hemisphere - General definition plus weak and strong definition of each
hemisphere.
Element - General definition plus weak and strong definition of each element.
Mode - General definition plus weak and strong definition of each mode.
Ray - General definition plus weak and strong definition of each ray.
Aspect - General definition of each aspect.
Lunar Phase - Interpretation of each of 8 lunar phases.
Sign - General definition plus weak and strong definition of each sign.
House - General definition plus weak and strong definition of each house.
Point - Definition of each chart point.
Point in House - Interpretation of each chart point in each house.
Point In Sign - Interpretation of each chart point in each sign.
Sign on House Cusp - Interpretation of each sign on each house cusp.
Point in Aspect to Point - Interpretation of each point in each aspect to each other
point. The aspects that may be used here must be selected before you begin
editing. See Changing Aspects Used.
If you are creating a new set of interpretations, you will probably want to edit the title
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and introduction text first. Otherwise you may wish to jump into any category of text
that you wish to work on currently.
>> To find the text category that you wish to edit
1. Select the required type from the Interpretation Type drop-down list box.
2. Select the required combinations from the adjacent drop-down list boxes.
Any existing text for that category will be displayed immediately in the main editing
window, and you may type over it, add to it, or otherwise edit it as you wish. Any
changes that you make are automatically saved as soon as the focus leaves the
editing window, or when you click on any other control on the screen or access the
menu. You do not need to take any special action to save changes that you make.
On some occasions you may find that you have made an error, and wish to undo any
changes that you have made to the text. You are able to undo any changes made
since you edited the last category of text, but not any changes made prior to that.
>> To undo text changes made since the current topic was displayed
Select the Undo Text Editing option from the Edit menu.
If you change your mind again, selecting the same option again will restore your
edited changes.
6.5.2 Changing Scoring of Balances
When viewing interpretations of a chart, you will notice that there are a number of
interpretation types which relate to the overall distribution of planets around the chart.
These type are as follows...
Balance of Quadrants - ASC to IC, IC to DSC, DSC to MC, MC to ASC
Balance of Hemispheres - Eastern, Southern, Western, Northern
Balance of Elements - Fire, Earth, Air, Water
Balance of Modes - Cardinal, Fixed, Mutable
Balance of Rays - 1st to 7th
Balance of Signs - Aries to Pisces
Balance of Houses - 1st to 12th
In each case, an algorithm is used to determine which divisions are “weak” (i.e.
occupied by fewer than average planets) and which are “strong” (i.e. occupied by more
than average planets) in the chart being interpreted. You have some control over how
this calculation is performed, so that you can fine-tune the circumstances in which
divisions are considered to be weak or strong. The calculation to determine which
divisions are weak or strong is as follows.
1) For each division (such as a quadrant or an element or a sign):
i. The total number of displayed chart points (planets/ asteroids/
TransNeptunians/ others) occupying that division is totalled.
ii. Optionally each displayed point occupying the division is multiplied by its
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weighting score.
2) The average score is found by summing the scores for each division, and dividing
by the number of divisions (i.e. by 3 for modes, 4 for quadrants, hemispheres etc.).
3) If the score for any division is less than the average multiplied by a “weakratio”,
then it is considered to be “weak”.
4) If the score for any division is greater than or equal the average multiplied by a
“strongratio”, then it is considered to be “strong”.
The items which you can adjust in the interpretations editor are...
Whether or not the weighting of each chart point is applied.
What value the “weakratio” has.
What value the “strongratio” has.
The weighting values for each point, if you choose to use them, are the same
weighting values that are used in other parts of Solar Fire. See Editing Weightings
for further information on editing the weightings.
You can prevent weak interpretations from appearing at all by specifying a “weakratio”
of 0 (zero). If you do so, then you need not enter any text relating to weak divisions of
that type. Similarly, by entering a large number (like 99.9), for “strongratio” you can
prevent strong interpretations from appearing, and you do not need to enter any text for
strong division of that type. For example, it might be desirable to set a “weakratio” of
zero for Balance of Signs, because it is likely that a number of signs will be completely
unoccupied in any chart, and it may not be very meaningful to give any interpretation to
those signs being unoccupied.
>> To alter the scoring of balances
1. Select Scoring of Balances from the Edit menu.
2. Select any category from the Balance Type drop-down list.
3. Optionally click on the Use Weighted Scoring check box to toggle it on or off.
4. Enter a ratio into the Ratio for Weak box
5. Enter a ratio into the Ratio for Strong box
6. Repeat steps 2 to 5 for any other category you wish to alter
7. Click on the OK button.
6.5.3 Changing Aspects Used
Before you enter any interpretations text relating to chart points in aspect to one
another, it is important to ensure that you have selected which aspects you wish to write
interpretations for. This is necessary for two main reasons:
If you alter the list of aspects that you wish to use after having written some
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interpretations text for existing aspects, then it is possible that some or all of this text
will be permanently lost or mislocated in the file.
The size of the interpretations file varies in proportion to the number of different aspects
that you wish to include. To use space efficiently, you should plan ahead to decide which
aspects you intend to use, and exclude those that you will not use, and would take up
unnecessary space.
You can select any combination of Solar Fire’s standard 26 aspects to use in an
interpretations file. However, in most circumstances, you will probably want to write text
for a small subset of the available aspects. For example, Solar Fire’s “standard”
interpretations set contains text for conjunction, opposition, trine, square, sextile,
quincunx, and the “transits” interpretation set also contains text for semisquare and
sesquisquare.
Mapped Aspect Names
Solar Fire’s interpretations files use a concept of mapped aspect names. You can define
a list of mapped aspect names for which you will write interpretations, and specify which
of Solar Fire’s standard aspects map onto each of those mapped names. In most cases
you will simply want to map each standard aspect to the same mapped name, so that
the each interpretation that you are writing applies only to that one aspect.
However, if for example you map each of the conjunction, trine and sextile aspects onto
the mapped name “soft” (say), and you then wrote one interpretation for the mapped
name "soft" (intending it to apply to all soft aspects), then whenever any of those three
aspects occur, because they are all mapped to "soft" they will all use that interpretation
you wrote for the mapped name "soft".
Similarly you could map the opposition, square, semisquare and sesquisquare onto the
mapped name “hard”, write an interpretation that would apply to any hard aspect
regardless of what it was, for the mapped name "hard", and then the the opposition,
square, semisquare and sesquisquare aspects would all use that interpretation. In this
way you have created high level interpretations for all soft and hard aspects but only had
to write two actual pieces of interpretation text.
>> To display the “Aspects to Include” dialog box
Select Aspects to Include from the Edit menu
On the left of the screen you will see a list of Solar Fire’s 26 standard aspects, called
“Available Aspects”, some of which will be marked as “Used”. On the right of the
screen you will see a list of “Mapped Aspect Names”.
>> To determine which aspect is mapped to which name
Click on each entry in the “Available Aspects” list - when you do so, the mapped
entry in the “Mapped Aspect Name” will be highlighted automatically.
>> To add a new mapped aspect name
1. Optionally select the required aspect name from the list of “Available Aspects”.
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2. Click on the Add button - This will add the name of the currently highlighted
“Available Aspect” to the list of “Mapped Aspect Names”.
3. Optionally edit the new mapped name by typing into the edit box above the Add
button.
>> To delete an existing mapped aspect name
1. Select the required mapped aspect name in the list of “Mapped Aspect names”
2. Click on the Delete button - This will remove the entry from the list, and will alter
the current entry in the “Available Aspects” list to show it as unmapped.
Note: After deleting mapped aspect names, you will need to check and reselect all the
other mapping relationships to ensure that they are still correct.
>> To set or alter the mapped name of available aspect
1. Select the required aspect from the list of “Available Aspects”.
2. Select the required mapped name from the list of “Mapped Aspect Names”.
Note: Selecting the “Not Used” item from the top of the list will unmap that aspect, so
that it can no longer be used.
>> To save all your changes
1. Firstly, re-check that each aspect is correctly mapped.
2. Select the OK button. If you have made any major changes which are likely to
result in interpretations text being lost, then you will be prompted to confirm your
changes before you are returned tot he main editing screen.
Dynamic Aspects
When you are creating a set of interpretations applying to a single natal chart, or to
synastry between two charts, then you normally want the interpretations for point1 in
aspect to point2 to be the same as for point2 in aspect to point1, e.g. Pluto square Moon
and Moon square Pluto would have the same interpretation.
However, if you are creating a set of interpretations for transits, progressions or
directions to a radix chart, then you would want to supply different interpretations in
each case e.g. Pluto square Moon and Moon square Pluto would have different
interpretations. This case is referred to as Dynamic Aspects.
You can set the interpretation file to work in either way, with the Dynamic Aspects on or
off. When the Dynamic Aspects option is off, Pluto Square Moon and Moon Square Pluto
will both display the same text in the editor, so editing one of them will also affect the
other. When the Dynamic Aspect option is on, they will display separate paragraphs of
text, and editing one will have no effect on the other.
>> To switch Dynamic Aspects On or Off
Select Dynamic Aspects from the Edit menu. This will switch he option on if it was
off, or off if it was on.
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Note: When the Dynamic Aspects option is on, there are more than twice as many
items to write interpretations text for.
6.5.4 Viewing a Summary of Contents
During the process of editing text, you may from time to time want to see a summary of
which categories in the file have already had text inserted, and those categories that
still have no text yet.
>> To see a summary of which items contain text
Select Contents Summary from the View menu.
You may have to wait for a moment or two whilst the entire interpretations file is
searched to determine which items contain interpretations text, and then a summary
will be displayed in the editing window.
>> To revert to editing text
Select Interpretations Text from the View menu.
6.5.5 Compacting the File
When you edit existing interpretations text, if you make the new text longer than the
original text, then the new text will be added to the end of the file, thus making it larger.
The space occupied by the original text is no longer needed, but still occupies some
space in the file. The space that is wasted due to this process is negligibly small if you
only edit a small number of interpretations, but if you make a large number of
alterations, then you may wish to recover the wasted space. This is possible by
compacting the file.
>> To compact the current interpretations file
Select Compact from the File menu,
You will be asked to confirm whether you wish to proceed, and if you click OK then
the entire interpretations file will be rewritten to the disk using the minimum space
possible. When the process is finished, you will see a message indicating how much
space was saved.
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Communicating with Others
This chapter covers features that involve communicating with other people, or sending
them information generated by Solar Fire.

7.1

Appointments Manager
The "Appointments Manager" allows you to store details of clients, and appointments
you make with them for astrological sessions, and record the duration and content of
your sessions. You can also send your clients appointment reminder emails, group
emails and customizable receipts.
>> To open the "Appointments Manager"
Click on the Appointments menu.
The "Appointments Manager" will open with the "Client Details" form opened beside
it.

7.1.1 Adding, Viewing and Modifying Client Details
The "Appointments Manager" is a system for managing your interactions with clients.
Therefore the first step in using the "Appointments Manager" is to enter your clients and
their details.
The following fields are available for storing client details:
Title
First name
Last name
Address1
Address2
City
State/Province
ZIP/Postal Code
Country
Phone (Home)
Phone (Work)
Cell/Mobile
Fax
Email
Website
Skype
Birth date
Birth time
Birth place
Notes
>> To enter details for a new client
1. Click on the Clients tab (just under the title bar) at the top of the "Appointments
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Manager".
2. Enter the client's details in the "Client Details" form.
IMPORTANT: If you have previously selected an existing client their details will
already be showing in the "Client Details" form. If you have made any changes to
these details you must save these changes first, otherwise they will be permanently
lost (see Saving changes to Client details).
To enter details for a new client, overwrite text in the information fields (if any is
there) with text for the new client details.
3. After you have entered the client's details click the Add button on the
"Appointments Manager". A dialog box will confirm if you want to add the details
in the "Client Details" form as a new client. Click the Yes button to add the new
client. The new client will be added to the list of clients in the "Appointments
Manager" and will be selected by a grey highlight bar.
>> To View a client's details
1. Click on the Clients tab at the top of the "Appointments Manager".
2. Select the client whose details you would like to view by clicking on that client in
the list of clients. This will cause their details to be displayed in the "Client
Details" form where you can view them.
>> To Modify details for a client
1. Click on the Clients tab at the top of the "Appointments Manager".
2. Select the client whose details you would like to modify by clicking on that client in
the list of clients. This will cause their details to be displayed in the "Client
Details" form.
3. Make changes to any of these details.
Saving changes to client details
4. When you are finished modifying the client's details click on the Save Changes
button on the "Appointments Manager". A dialog box will confirm if you want to
replace the client's original details with the changes you have just made, Click the
Yes button to overwrite the client's existing details with the new changes you have
made, or the No button to cancel.
If you click "No" to not save the changes your changes will not be lost, they will still
be in the "Client Details" form. If you subsequently decide that you would like to save
your changes (possibly making additional further changes before doing so), then you
can by clicking on the Save button again, and this time in the confirmation dialog box
clicking Yes to saving the changes.
IMPORTANT: Once you select (click on) any other client in the "Appointments
Manager", or click on any of the other tabs, any changes you have made to a client's
details that you haven't explicitly saved (by clicking on the Save button and saying
"Yes" in the resulting confirmation dialog) will be lost forever.
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>> To Delete a client
1. Click on the Clients tab at the top of the "Appointments Manager".
2. In the list of clients in the "Appointments Manager" select (click on) the client you
want to delete.
3. Click on the Delete button in the "Appointments Manager". A dialog box will
confirm you want to delete this client, and all their historical and current
appointment details. If you want to do so click on the Yes button. To cancel the
deletion click on the No button.
7.1.2 Adding, Viewing and Modifying Appointments
Once you have entered one or more clients into the "Appointments Manager" you can
then create session appointments for them.
>> To add an Appointment for a client
1. Click on the Clients tab, then select the client in the list of clients.
2. Click on the Appointments tab
3. Navigate in the calendar to the month of the appointment by clicking on Arrow
buttons to the left or right of the date at the top of the calendar, or by using the
PageUp or PageDown keys on the keyboard.
TIP: To quickly navigate to the current date click on Today's date showing in bold at
the bottom of the calendar.
4. Select the day of the appointment by clicking on it - it will then have a solid grey
circle around it.
Note: the current day is always circled in red.
5. Enter the time in the "Appointment Time" field to the left of the calendar (see
Entering a Time for more information).
6. Enter any notes you may have about the appointment in the "Appointment Notes"
field underneath the list of appointments.
7. Click on the Add button to the left of the "Appointments" list.
8. A dialog box will confirm you want to enter the appointment. If you say Yes the
appointment will be added to the list of appointments.
SHORTCUT: If you want to make another appointment for this client ...
a) select the appointment that you have just made (in the list of "Appointments for
Day"), by clicking on it.
b) you can now create another appointment for this client on the same or a
different day (as above) without having to go back to the "Clients" tab in order to
select the client again to do so.
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>> To view all Appointments for any client
Click on the Clients tab, then select the client in the list of clients. Their
appointment history will be displayed in the list below.
>> To view all Appointments for any day
1. Click on the Appointments tab.
2. In the calendar select the date you want to see all appointments for. All of the
appointments for that date will be displayed in the "Appointments for Day" list
below.
TIP: To quickly navigate to the current date click on Today's date showing in bold at
the bottom of the calendar.
>> To modify a client's Appointment
1. Click on the Appointments tab.
2. Select the date the appointment occurs on. (If you don't know off hand which date
the appointment is for then view all appointments for the client (as above) and
note the date of the particular appointment you want to modify.)
3. Select the appointment in the list of appointments by clicking on it.
4. You can change the "Appointment Time" and modify the "Appointment Notes".
Note: You cannot change the date of the appointment. To change the date you must
delete the appointment and create a new appointment for the client on the date you
want.
5. When you have made the changes you want click on the Save Changes button to
the left of the "Appointments" list. A dialog box will confirm you want to modify the
appointment. If you say Yes your changes will be saved.
>> Deleting an appointment
1. Click on the Appointments tab.
2. Select the date the appointment occurs on. (If you don't know off hand which date
the appointment is for then view all appointments for the client (as above) and
note the date of the particular appointment you want to delete.)
3. Select the appointment in the list of appointments by clicking on it.
4. Click on the Delete button to the left of the appointments list. A dialog box will
confirm you want to delete the appointment. If you say Yes the appointment will be
deleted.
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7.1.3 Sending Email Appointment reminders
In the "Appointments Manager" you can email an appointment reminder to a client.
>> To email a Reminder for an appointment
1. Click on the Appointments tab.
2. Select the date the appointment occurs on. (If you don't know off hand which date
the appointment is for then view all appointments for the client (see Adding,
Viewing and Modifying Appointments) and note the date of the particular
appointment you want to send a reminder for.)
3. Select the appointment in the list of appointments by clicking on it.
4. Click on the Email Reminder button beneath the "Appointment Notes".
5. A new email will be loaded and displayed ready for you to send.
If, for the client you are reminding, you had entered an email address in their "Client
Details" then that email address will be pre entered for the email. Otherwise you will
need to enter an email address for the email manually. You will also need to enter
your name on the email signature. Apart from that nothing else needs to be done
before sending the email, although of course you can make any changes to it that you
want before sending it in the normal manner.
7.1.4 Recording Session Time and Content
In the "Appointments Manager" you can record the total duration (time) of the
appointment session, or just record the duration of parts of the session. If you have a
microphone installed inside, or attached to, your computer you can also record the dialog
you have with your client. If your client cannot be present you can still make an
appointment for them, and record a chart reading for them without them needing to be
present.
Then optionally, in a separate operation outside Solar Fire, you can copy the WAV file
produced from your recording onto a CD or DVD to give to your client which would then
be playable in most other Windows computers, or alternatively email it to them or
upload it onto your FTP site, if you have one, and they can download it from there.
TIPS:
a) If you have a software application on your computer that can convert audio files
from one format to another, before giving the file to your client you may like to
convert it into a MP3 file, which will then be playable on any MP3 player.
b) Recent versions of Windows come with Windows Media Player, and you can use
that application to burn the WAV file to an audio CD which would then be playable
in most CD players or other Windows computers.
iTunes (downloadable from the internet) may be another application you could also use
for this purpose.
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>> To record the duration of a session
1. Click on the Appointments tab.
2. Select the date the appointment occurs on. (If you don't know off hand which date
the appointment is for then view all appointments for the client (see Adding,
Viewing and Modifying Appointments) and note the date of the particular
appointment you want to record the duration of.)
3. Select the appointment in the list of appointments by clicking on it.
4. Click on the Session tab.
5. Click on the Start or Start/Continue button. This will start the session timer.
Note: If the timer isn't showing 0 time elapsed, click on the Reset button first.
6. If you want to pause the session timer at any time (i.e. not include a period of time
in your recorded session duration) click on the Pause button. This will pause the
timer at that point in time.
To resume the recording of the timer where it left off, click on the Start/
Continue button.
7. To save the amount of elapsed time (duration) currently recorded for the selected
appointment click on the Save Duration button. A dialog box will confirm you want
to save this duration for that appointment.
Note: You can save the currently recorded duration (shown in the "Elapsed Time"
field) at any time. However if you don't "Pause" the session timer before doing so it
will continue to keep ticking (recording time) even while you are doing this. You
may therefore wish to "Pause" the timer before saving the duration.
Additionally, you can move away from the "Session" tab onto other tabs and, unless
paused, the timer will continue to keep ticking. This may be useful if you want to
alter the client's details, check on or create new appointments etc as part of the
recorded duration of the session. However if you don't want this to occur,
remember to "Pause" the timer before moving away from the "Session" tab.
IMPORTANT: If you do move away from the "Session" tab before saving the
"Duration", check the appointment you are recording the duration for is still
selected in the "Appointments" tab before saving the duration in the "Session" tab,
otherwise you may inadvertently save the duration to a different appointment than
the one it was meant to be for.
8. To start a completely new "Duration" recording, if the Pause button is visible then
click on it first. Then click on the Reset button. Then when you are ready to start
recording the new duration click on the Start/Continue button.
If the "Pause" button is not clicked first before clicking on the "Reset" button, the
session timer will be reset to 0, and then immediately start ticking again (recording
elapsed time). You may want this to happen, but you may not - in which case make
sure you click on the Pause button before resetting the timer - that way the timer will
not start recording again until you explicitly start it.
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>> To record the voice content of a session
1. Click on the Appointments tab.
2. Select the date the appointment occurs on. (If you don't know off hand which date
the appointment is for then view all appointments for the client (see Adding,
Viewing and Modifying Appointments) and note the date of the particular
appointment you want to record the voice content for.)
3. Select the appointment in the list of appointments by clicking on it.
4. Click on the Session tab.
5. In the "Record Session" area, select the folder where the audio file will be saved in
the "Save Location" field by clicking on the Browse button at the end of the field,
and navigating to the folder. Once you have selected the folder click on the OK
button.
6. A default audio filename will be entered into the "Enter a filename" field. If you
want a different filename you can overwrite this with the different filename.

The Record Session area

7. To start recording voice click on the Record button.
8. To stop recording click on the Stop button.
9. To add the voice recording to the audio file click on the Save Record button. This
will add to the audio file all sound recorded since the last time the Record button
was clicked - it will not replace any recorded sound previously saved to the file.
10. To play the recording click on the Play button. This will play the recording from the
beginning. Note that you must save your recordings before you can play them.
Notes
As with the "Session Duration Timer" (described above), you can record all the
content (i.e. voices) of a session, or only parts of the session.
To record the whole session to the audio file in one unbroken stream of
conversation, you simply start by clicking on the "Record" button and let it run until
the session is finished and then click on the "Stop" button. Then save the recording.
However if you have interruptions in your session, or want to talk about something
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"off the record", you would click on the Stop button to temporarily pause the
recording for the period you are interrupted or want to talk off the record, then
when you want to resume recording you can click again on the Record button and
the recording will start again. You can do this record/stop/record/stop etc. process
as many times as you like in a session - all the incremental bursts of recording are
accumulating in the computer's memory. When you are finally finished recording for
the session click on the Save Record button to save all the various incremental
recordings you have made to the audio file. Once you have done this you can play
back the recording.
IMPORTANT
It is highly recommended that you thoroughly experiment with this feature first
before you intend to use it for any particular purpose. That way you can gain a
familiarity with how it works, what it does and doesn't do.
7.1.5 Generating Receipts
In the "Appointments Manager" you can generate receipts to print out and give to your
clients.
>> Setting receipt preferences
1. Click on the Other Information tab.
2. Fill in your preferences for the following:
Currency Symbol
Currency name
Hourly rate
Tax % to be added to the hourly charge amount
The name of the tax
>> Generating a receipt
1. Click on the Appointments tab
2. Select the appointment in the list of appointments.
3. Click on the Display button in "Receipt" area.
A receipt will be generated and displayed in your default text editor using information
in "Compliments and Receipt Preferences" (above). You can then modify the
information in the receipt, if necessary, before printing it for your client.
7.1.6 Sending a Group Email to Clients
In the "Appointments Manager" you can address an email to one or more clients.
>> To send a single email to one or more clients
1. Click on the Clients tab.
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2. Click on the Toggle Select button beneath the Appointment History.
A checkbox will then appear to the left of every client in the list of Clients and also
a checkbox titled "Select All" above the list. You can now click in the checkbox for
every client you want to be included in the email. To remove a client from the list
simply click in their checkbox again and the tick will be removed.
If you want to include every client in the email then click in the "Select All"
checkbox at the top of the list, which will place a tick in every client's checkbox. If
you want to un-include every client then click in the "Select All" checkbox again
and all the client checkbox ticks will be removed.
3. When you have selected every client you want to send an email to click on the
Send Email button beneath the Appointment History.
4. A new email will be loaded and displayed ready for you to enter your message to
the selected clients.
5. Enter your own email address in the To: address field of the email (you will be sent
a copy of the email).
IMPORTANT: The email addresses of all the clients you are sending the email to
will be pre entered into the Bcc: address field of the email (this means each
client's email address will not be visible to anyone receiving the email).
However if you have not entered an email address for any of these clients in their
"Client Details" then no email address will be pre entered for these clients - in this
case you will need to enter the client's address manually into one of the email's
address fields if you want them to receive the email.
6. Once you've sent your email click on the Toggle Select button beneath the
Appointment History.
This will remove the checkboxes next to the clients and the "Select All" checkbox
at the top of the list of clients.

7.2

Teachers and Students
For teaching purposes a teacher can save their current Solar Fire settings to a single ZIP
file (a file with a ".zip" extension).
The ZIP file can either be sent directly to a student, who already has Solar Fire v9, or the
ZIP file can be sent to Esoteric Technologies where it can be placed on a new Teacher
webpage located at the www.esotech.com.au website on the “Resources” side menu.
Students from anywhere in the world that are taught by that teacher can then simply
download the ZIP file and have their Solar Fire v9 automatically updated with the
teacher’s settings. This means students can quickly and easily create an environment in
Solar Fire that is virtually identical to that of their teacher. At any point in time, a student
can easily switch from the teacher’s settings back to their regular settings and then back
to the teacher’s settings.
An example page of the list of teachers and their ZIP files is on the www.esotech.com.au
website.
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All of the actions for the Teacher/Student feature are accessed from the Utilities menu,
except for enabling teachers.
7.2.1 Enabling Teachers
Teachers wanting to share their Solar Fire settings with students first need to enable
themselves as a teacher in Solar Fire.
>> To enable yourself as a Teacher
1. In the Preferences menu click on Edit Settings.
2. In the Preferences dialog box click on the Misc tab
3. Click in the checkbox "I am an astrology teacher"
Now the Teacher – Create Settings menu item will be enabled on the Utilities menu.
7.2.2 Capturing and Distributing Teacher settings
Once a teacher has been enabled in Solar Fire, all the teacher's settings can be captured
and stored in a ZIP file.
Settings in the ZIP file
Solar Fire system settings (internal settings, birthdays, rulers, weightings etc)
Wheels and Dials
Tasks
Almutens and Dignities
Pages
Points and Colors
Selected Charts
Aspects
>> To capture Teacher settings
1. In the Utilities menu click on Teacher - Create Settings. A dialog box will appear
asking if you wish to continue, click Yes to continue.
2. A dialog box will ask for a name for the file. Enter a name or choose a previously
used name from the drop down list. Click on the OK button.
3. Another dialog box will appear where you can select any chart files you would like
included in the ZIP file by clicking in the checkbox next to each chart file. (To
unselect a chart file just click in the checkbox again so that it is blank).
4. When you have finished selecting chart files click on the OK button. Solar Fire will
then save the settings in a ZIP file.
Finally a message will appear telling you where the ZIP file has been stored.
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>> Distributing Teacher settings to students
In an email you can add the ZIP file as an attachment from the folder it was stored in,
and send it to your students to use, or you can email the file to Esoteric Technologies
who will put it on their website for downloading by students.
7.2.3 Enabling Students
On the Utilities menu the "Load Teacher Settings" menu item is only enabled if one or
more teacher’s ZIP files are found in the "Solar Fire User Files" folder (by default this is
in the user's Documents or MyDocuments folder).
Therefore, when a student downloads a teacher’s ZIP file from Esoteric Technologies
website or receives the ZIP file as an email attachment, they need to save it to the "Solar
Fire User Files" folder on their computer.
7.2.4 Loading Teacher settings
Once a student has received a Solar Fire settings ZIP file from a teacher, or downloaded
one from Esoteric Technologies website, the settings within the ZIP file need to be
loaded into Solar Fire.
>> To load Teacher settings
1. In the Utilities menu click on Load Teacher Settings. A dialog box will open
showing you the available teacher settings, which are in ZIP files (files with a .zip
extension).
2. Select one of these files by clicking on it, and click on the Open button.
3. A message will appear saying the current teacher settings have been removed click the OK button on this message.
The teachers settings contained in the ZIP file will load and a message will briefly
display while this is happening.
7.2.5 Removing Teacher settings
If you have previously loaded Teacher settings into Solar Fire, you must remove them if
you want to return Solar Fire to it's regular settings.
>> To remove Teacher settings
1. In the Utilities menu click on Remove Teacher Settings.
2. A message will appear saying the current teacher settings have been removed click the OK button on this message.
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Emailing Charts
This chapter explains how to send chart files and chart data by email, either from Solar
Fire’s Main Screen, or from the “Chart Open” dialog.
You can send data directly from within Solar Fire provided that you have a MAPI
compliant email program.
If you do not have a MAPI compliant email program, then Solar Fire will generate files
that you can attach to your emails manually, instead.

7.3.1 Email Protocol
Solar Fire supports two different email protocols.
MAPI is a mail automation protocol that allows third party programs to automate the
generation of email. All Microsoft email programs (e.g. Outlook and Outlook Express)
and Eudora are MAPI compliant, for example.
To get the full benefit of MAPI compliance you may need to ensure that the MAPI options
are activated in some email programs, for example in Eudora Pro v3, you may need to go
into the Tools / Options menu item, find the MAPI category, and ensure that “Use Eudora
MAPI server” is switched to either “When Eudora is Running” or “Always”. If you are
unsure about any of these options, you should consult the documentation of your email
program (e.g. search for “MAPI”), or contact the manufacturer of your email program.
A different mail automation protocol is the Mailto protocol. If you use webmail (e.g.
Gmail) this protocol will probably suit you better.
See Email Preferences for more information.
7.3.2 Sending Charts By Email
>> To send a chart file from the Main Screen
1. Select the required chart/s from the list of "Calculated Charts"
2. Select the Send Charts by Email… item from the Chart menu.
3. Select any required chart email options (as described in the following section)
>> To send a chart file from the Chart Open dialog box
1. Optionally, select the required chart/s from the list of charts in the current chart
file
2. Optionally, click on the Send/Add button to choose between the Selected Chart
Only or All Charts items.
3. Click on the Send/Add button and select the Send Charts by Email item.
4. Select any required chart email options (as described in the following section)
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These methods will create any optionally required temporary chart files containing the
selected charts (and optionally also a chart comments file containing any comments
associated with these charts), and start up your email program with these files already
attached to an outgoing email, and optionally also with chart details already listed
within the body of the email.
You will need to address the email, and optionally edit it or append text to the body of
the message as required before sending it.
7.3.3 Selecting Chart Email Options
You have various options available to you regarding the format in which the chart data
will be sent. For example, you can send it as an attached chart file, or alternatively with
the chart details appearing as written text within the body of your message. If it is sent
as an attached file, then you can choose whether this will be a Solar Fire chart file
(readable only by others who own Solar Fire), or whether it will be a text file containing
written chart details.
Whenever you invoke any chart email command in Solar Fire, you will be presented with
the Email Charts dialog, which allows you to select from the various options.

If you uncheck the Show me... option at the bottom of the dialog, then your current
settings will be remembered and applied to all future chart emailing, without you being
re-prompted with this dialog. However, you can re-enable this, or edit any of the settings
in this dialog at any time by choosing Preferences / Edit Settings / Charts / Chart Data
Email Options from the Main Screen.
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7.3.3.1 Attach chart file to email

This option is recommended if you have a large number of charts to send, because there
are limits to how many chart details may be sent in the body of the email.
You must also choose this option if you wish to make the charts available to the
recipients to open within their own copies of Solar Fire.
Chart File Format – If all recipients own Solar Fire Deluxe or later, then choose
Solar Fire v6/v7 format. If all recipients own Solar Fire v5, but not all own Deluxe or
later, then choose Solar Fire v5 format. If any recipients might not own Solar Fire,
then you have a choice of either using the Text File format instead of a Solar Fire
chart file, or alternatively of attaching a Solar Fire chart file anyway (for the benefit
of all those recipients who do own a copy), but additionally including chart details
as text in the body of the email for those recipients who do not own Solar Fire.
Include Chart Comments – This is only relevant if any of the charts you are
emailing contains any comments text. If so, you can choose to include or omit it
with this option.
Include Life Events – This is only relevant if any of the charts you are emailing
contains any stored life events. If so, you can choose to include or omit them with
this option. Note that this option is not available if you have chosen the Solar Fire
v4/v5 chart file format, because this format cannot store life events.
7.3.3.2 Write chart details as text in body of email

This option is recommended only if you don’t have a large number of charts to send,
because there are limits to how many chart details may be sent in the body of the email.
This option may be chosen in addition to the chart file option if you wish – thus providing
the chart information to your recipients both as an attached file and within your email.
Include Chart Comments – This is only relevant if any of the charts you are
emailing contains any comments text. If so, you can choose to include or omit them
with this option.
Include Life Events – This is only relevant if any of the charts you are emailing
contains any stored life events. If so, you can choose to include or omit them with
this option.
Following is an example of chart details as text, as it would appear both in the body of
the email, or as an attached text file. This example includes comments text, but no life
events.
Mary Decker - Natal Chart
4 Aug 1958, 2:59 am, EDT +4:00
Raritan New Jersey, 40N34'10'', 074W38'
Geocentric Tropical Zodiac
Rating: AA
Comments: From Birth Certificate (Mary Frances Wood, AA)
Mary Theresa Decker
Athlete
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Decker (later Slaney) was an outstanding athlete and winner in major competitions
during the Eighties. At the Olympics, this world-class runner never fulfilled her potential.
During the 1984 Olympics she was accidentally tripped up by Zola Budd, ruining both
athletes' chances for medals.

7.4

Emailing Graphics
As well as being able to email charts to others you can also email any page or graphic
ephemeris displayed in Solar Fire. For information on how to do this see the relevant
information in Copying, Publishing and Sending Graphics.
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Miscellaneous Operations
The topics in this chapter vary from setting up simple birthday reminders to using the
Astrologer's Assistant, which is a powerful time-saving feature.

8.1

Using Birthday Reminders
The birthday reminders feature enables you to save a birthday reminder for any person
for whom you have already cast a chart. Solar Fire can optionally check for any birthdays
which are forthcoming (or overdue) each time it is first run on any given day.

8.1.1 Adding New Birthday Reminders
You can add a birthday reminder for any chart which is already in your list of "Calculated
Charts", or from any chart which is stored in a chart file. The reminder is created using
the day and month of the chart's birth date.
>> To add a birthday reminder for one or more chart in the calculated chart list
1. From the Main Screen, select one or more charts from the list of "Calculated
Charts"
2. Then do either of the following
Select the Add to Birthday Reminders item from the Chart menu
Use a right hand mouse click over one of the selected charts, and select the Add
to Birthday Reminders item from the pop-up menu
>> To add a birthday reminder from the Chart Open dialog
1. Select the required chart/s from the list of charts in the current chart file
2. Click on the Send/Add button
3. Select the Add to Birthday Reminders item from the drop-down menu
Once you have added reminders, you can view them at any time. See Viewing Birthday
Reminders
8.1.2 Viewing Birthday Reminders
>> To view the birthday reminders dialog
1. Select the Birthday Reminders item from the Utilities menu
This will display the View Birthday Reminders dialog.
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You can use either of the following Filter options...
Show all - use this to see a list of all stored reminders, regardless of whether they
are current or not
Show current reminders only - use this to display only those reminders for
birthdays which occur within the given range of days, and which have not already
been dismissed for the current year's birthday
>> To dismiss a reminder until next year's birthday
1. Highlight the required reminder entry
2. Click on the Dismiss button
Dismissing a reminder does not remove the reminder altogether, but simply prevents
any further reminders for it from appearing as a "current reminder" until next year.
Dismissed reminders remain visible when the Show All option is being used with the
postfix "[Dismissed]", but will no longer appear when the Show current reminders
only is being used (until next year).
>> To restore a dismissed reminder
1. In the Show All view, highlight the dismissed reminder entry
2. Click on the Restore button
>> To permanently remove a reminder from the list
1. Highlight the required reminder entry
2. Click on the Delete button
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This permanently removes the reminder from all reminder lists. You cannot retrieve a
removed reminder. Instead you must re-add it from a chart.
>> To find the source chart for this reminder
1. Highlight the required reminder entry
2. Click on the Go To Chart button
This will display the Chart Open dialog, with the source chart's file open, and the
chart itself highlighted. From there you can open it, view, add comments etc.
>> To get an automatic reminder pop-up as birthdays approach
Ensure the Show reminders daily on startup option is checked.
When this option is switched on, Solar Fire checks the list of birthday reminders
within a few seconds of starting up, on the first occasion it runs on each calendar day.
If there are any reminders which fall within the specified range of days leading up to
or following a birthday, then this dialog pops up, listing the current reminders.
If you quit without dismissing or removing any reminders, then the same reminders
will be shown to you again on the following day (as long as they still fall within the
specified range of days.)

8.2

Sabian Symbols
There are two places in Solar Fire where Sabian symbols are used. One is in
interpretation reports and the other is in the Sabian Oracle.
When viewing a chart in the "View Chart" window, if you double-click on a planet's
degree (in wheel designs that have degree positions turned on) the Sabian symbol
interpretation for the degree of that planet is displayed in the "Interpretations Window".

8.2.1 Sabian Oracle
There are two sources of Sabian Symbol interpretations in Solar Fire.
Firstly astrologer Lynda Hill uses the Sabian Symbols as a tool to help us discover what’s
going on and why, and to lead us to greater self-awareness. Her interpretations can be
used for the degrees of a chart via her interpretation file "Sabian.int". Also the Sabian
Oracle can be used to gain insights into the future, analyze the present, understand
yourself and others and generally keep in tune with the rhythms of life. For more
information visit: www.sabiansymbols.com
Secondly Charubel is the professional name for Welsh occultist, clairvoyant and healer
John Thomas, who first published interpretations for the degrees in a chart in the 1890s,
and these can be accessed via his interpretation file "Charubel.int".
>> To view the Sabian Symbols Oracle from the Main Screen
On the View menu click on Sabian Oracle
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>> To view the specific Sabian Symbol degree interpretations in a chart
1. From the Main Screen click the Interps menu
2. Click Interpretation Files
3. Select the type of chart you want to see degree interpretations in. This will load the
File Management "Interpretations" window, with the available interpretation files
for that chart type (have an ".int" extension).
4. Select the required interpretation file by clicking on it.
5. Click the Select button.
6. When viewing a chart of that type in the "View Chart" screen double-click on the
actual degrees of any chart point if degrees are showing in the wheel. This will
display the Interpretations Window with the Sabian Symbol interpretations for that
degree from the chosen interpretations file.

8.3

Using the Astrologer's Assistant
The Astrologer’s Assistant is a powerful task automation feature that allows you to
record a list of tasks and then save them for replay at any time. This functionality is also
sometimes known elsewhere by names such as Macros or AutoJobs.
Once it is set into record mode, it keeps a record of the tasks that you carry out (this
window stays on top whilst you work). When you click the Stop button, you can review
and edit certain elements of the task list, and save this list to file for future reuse.
When you click the Play button, it will run through the list of tasks using whatever charts
you have currently selected in your "Calculated Charts" list. Some tasks do not require a
base chart to run, and others require one or more base charts to be selected. If you have
not already selected the required number of charts, then you will be prompted to select
them before the task list runs.
For example, you could record a task to print a chart, calculate a progressed chart and
transits chart for the current date, display them together in a triwheel and print them,
run a dynamic report with one years transits and progressions and then print that out.
This set of tasks can then be replayed for any other starting chart at the click of a button.
Tasks which can be recorded and replayed are:
opening charts from a file
casting new charts
generating any types of subsidiary charts
viewing or printing or copying a page or report
viewing, generating or printing or copying to clipboard dynamic reports, time maps
and graphic ephemerides
deleting and saving charts
selecting files of all types (e.g. Displayed Points, Colors, Aspects, Fixed Stars, etc..)
saving settings and restoring settings
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>> To open the Astrologers Assistant ready to record or play task lists
Select the Astrologers Assistant item from the Utilities menu.
This will display the Astrologer’s Assistant dialog, which is a small dialog with a
range of buttons. This dialog remains on top of any other windows until it is closed.
The buttons are as follows...
Open task list from file – This displays a file open dialog, allowing you to select
any pre-existing task lists. When you open a task list, its title (and the number of
tasks it contains) appears in the box at the bottom of this dialog.
Save task list to file – This displays a file save dialog, allowing you to save a task
list that you have just recorded or edited. Once saved, it can be re-opened and reused at any time.
Start recording tasks – This will put the Astrologer’s Assistant into recording mode.
Any tasks that you subsequently perform (which are on the list above) will be added
to the list.
Pause recording – This stops the recording, but leaves the list of tasks ready for
additions as soon as the Start button is activated again.
Stop recording – This stops recording and closes the task list. It is not possible to
add any extra tasks to the list after this is done.
Run tasks – This will execute whatever task list is already open, using whatever
chart or charts are currently selected in the list of "Calculated Charts". If the task
list requires more than one base charts to be selected, and you have not already
highlighted enough charts, then you will be prompted to select the additional
charts.
Edit task list – This displays the editing dialog. Editing of the task list is limited to
deleting tasks, and selecting date options to apply (such as using a date based
on an offset from the current date for a transits report start date, or using the
current date for a new transits chart etc).
Ellipsis (…) – This will show a popup menu listing up to a maximum of about 30
pre-defined task lists. Selecting an item from this list will open it for running or
editing in the same manner as if it was opened from the file open dialog. This is a
quicker way of selecting task files than using the file open dialog.
8.3.1 Browsing or Editing a Task List
>> To open the task list editor
After opening a task list, or stopping recording of a task list, click on the Edit task
list button on the "Astrologer’s Assistant" dialog.
This will display the Task List dialog, showing the title and description of the current
task list, as well as a list of the individual tasks.
The title and description may be freely edited, but the editing of the individual tasks
in the list is limited to deleting tasks, and selecting save options or date options to
apply (such as using a date based on an offset from the current date for a transits
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report start date, or using the current date for a new transits chart etc).
The Date and Time Options are as follows...
Use specified date and time – When this option is selected, the date and time fields
are enabled, and may be edited by the user. In this case the specified date and time
is always used, regardless of the current date and time at which the task is run.
This option is useful in order to cast a fixed natal chart, or to run dynamic reports
from a fixed date.
Use current date and time as base – When this option is selected, the date field is
disabled, and only the time may be edited. If neither of the following two suboptions is enabled, then the task will always adopt the date and time which are
current when the task list is run.
Use chart date and time as base – When this option is selected, the date field is
disabled, and only the time may be edited. If neither of the following two suboptions is enabled, then the task will always adopt the date and time of the chart
whose number is selected in the adjacent box. The chart numbers which may be
selected are those referred to on the task list above as “Source” charts (i.e. charts
which must be selected prior to running the task list) or “Result” charts (i.e. new
charts which are calculated whilst the task list is running prior to the current task).
This option is useful, for example, if you wish to create a set of tasks based on a
client’s birthday. You can cast a solar return, and then use that chart’s date as the
base for subsequent tasks, such as casting a progressed chart or running a dynamic
report.
Go to – When selected, this allows the user to select a specific date/time to move
to, starting from the current date and time when the task list is run, or from the date
and time of the specified base chart. The “Adjust date by” option may also be used
as a further date modifier if required.
Start of Day – 0:00am of current date
Start of Month –0:00am on 1st day of the current month
Start of Quarter – 0:00am on 1st day of the current quarter (i.e. 1st Jan, Apr, Jul or
Oct)
Start of Half Year – 0:00am on 1st day of the current half (i.e. 1st Jan, or Jul)
Start of Year – 0:00am on 1st day of current year (i.e. 1st Jan)
Specified Time – User entered time on current date
Adjust date by - When selected, adjusts the specified date (or “Go to” date, if
selected), by the specified multiple of days, months or years. The multiple may be
any integer, either positive or negative. A positive integer moves the date forward
in time, whereas a negative integer moves it back in time.
For example, if the selection is to use the current date and time as base, to go to the
beginning of the month, and then adjust the date by –1 months, then the task will always
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use 0:00am of the 1s t day of the preceding month.
The report duration options are only available for a recorded task that involves a
dynamic report. You may select a period and time unit in the same manner as may be
done when an individual dynamic report is being run. If your report contains multiple
dynamic reports that are being merged, then you will usually want to ensure that all the
report tasks have the same duration and start date.
The save options are only available for a recorded task which involved saving a chart to
file.
The options are as follows...
Save to default chart file – The chart file will be saved to the currently selected
(default) chart file, without prompting the user first.
Prompt user for chart file – The replay of the task list will be halted temporarily
whilst the user is prompted to select a chart file into which the chart will be saved.
This option is useful if, at the time of recording, you are unsure which chart file you
might want to save any calculated charts into.
8.3.2 Examples of Recording Task Lists
The following examples may be useful to create for your own use.
8.3.2.1 Progressed Composite

In the Astrologer's Assistant you can progress two different base charts to the same
date, then make a composite chart and print it, delete the progressed charts, and then
view the composite.
1. Click on the Astrologer’s Assistant button to open the floating dialog box
2. Click on the Record button
3. Select any natal type base chart (it doesn’t matter which) from the list of
"Calculated Charts" and then from the Chart menu select Progressed and progress
it to the current date.
4. Select a different natal chart and then from the Chart menu select Progressed and
progress it to the current date.
5. then from the Chart menu select Combined and select both of the newly
calculated progressed charts as the base charts, and select the required
composite method.
6. Once calculated, select from the View menu select Current Chart.
7. Click on the Stop button to stop recording.
8. Click on the Edit Task List button to see the dialog below.
9. Fill in the title and description as required.
10.Click on the two “Calculate: Sec.Prog.” tasks one by one, and select the “Use
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current date and time as base” option for each one. (These ensure that the charts
are always progressed to the current date, instead of the date on which you
created this task list.)
11.Click on the OK button
12.Click on the Save button and supply a file name to save this set of tasks under.
8.3.2.2 Viewing a TriWheel with current progressions and transits

In the Astrologer's Assistant you can cast a transits chart, apply outer planets Displayed
Points to this chart, progress a base chart to current date and view a tri-wheel.
1. Click on the Astrologer’s Assistant button to open the floating dialog box
2. Click on the Record button
3. Select any natal type base chart (it doesn’t matter which) from the list of
"Calculated Charts" and then from the Chart menu select Progressed and
progress it to the current date.
4. Cast a new natal and click on the Now button to set it to transits for the current
date.
5. Highlight the transits chart, and click on the menu Chart Options, then Current
Chart’s Points, then select the outers.pts file. (This ensures that only the outer
planets are displayed in the transits chart.)
6. Click on the View menu, then TriWheel, and select the natal, progressed and
transits chart in required order, and view the wheel.
7. Click on the Stop button to stop recording.
8. Click on the Edit Task List button.
9. Fill in the title and description as required.
10.Click on the Calculate: Sec.Prog. and Cast Chart: Transits tasks one by one, and
select the Use current date and time as base option for each one. (These ensure
that the charts are always calculated to the current date, instead of the date on
which you created this task list.)
11.Click on the OK button
12.Click on the Save button and supply a file name to save this set of tasks under.
8.3.2.3 Jaynes Directions

This is a task list for producing a dynamic report using a typical technique used by
Charles Jayne. He mixed together into the same report solar arc, ascendant arc, vertex
arc directions, both direct and converse. Solar Fire can do each of these in an individual
report, and once merged together result in a single report containing all of these
directions.
In the Astrologer's Assistant to record this task list you would do as follows...
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1. Click on the Astrologer’s Assistant button to open the floating dialog box
2. Click on the Record button
3. Select any natal type base chart (it doesn’t matter which) from the list of
"Calculated Charts", and then from the Dynamic menu select the Transits and
Progressions menu item.
4. Select the first required events, directions type and converse options (Solar Arc
Directions) and ensure that the Merge option is not checked.
5. Click on View to run the report, and when it has finished, click on New Report
6. Repeat steps 4 and 5 for each of the remaining report types (Ascendant Arc
Directions; Vertex Arc Directions; Solar Arc Directions with Converse checked;
Ascendant Arc Directions with Converse checked; Vertex Arc Directions with
Converse cheked) but this time ensuring that the Merge option is checked.
7. Click on the Stop button to stop recording.
8. Click on the Edit Task List button to see the dialog below.
9. Fill in the title and description
10.Click on the tasks one by one, and check that the date and time options are as
below. (These ensure that the reports always start at the beginning of the current
month, instead of the date on which you created this task list.)
Use current date and time as base
Go to: Start of Month
Adjust date by: -1 Months
11.Click on the OK button
12.Click on the Save button and supply a file name to save this set of tasks under.
Now, when you select any natal type base chart from your list of "Calculated Charts",
you can click on the Play button on the Astrologer’s assistant, and the dynamic reports
will be run and merged for you as you watch.

8.4

Generating an Ephemeris Listing
This chapter describes how to use Solar Fire's Ephemeris Generator Utility to view or
print an ephemeris for selected planets and asteroids over a selected time period.
Ephemeris positions generated in this utility have the same accuracy as they do in any
other Solar Fire chart.

8.4.1 Starting the Ephemeris Generator
>> To start the Ephemeris Generator
Select the Ephemeris Generator item from the Dynamic menu.
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Solar Fire then displays a screen allowing you to select what kind of ephemeris you
want.
8.4.2 Setting Ephemeris Options
In the "Ephemeris Generator" the selections that you may make are as follows...
Period of Ephemeris - Enter the date and time from which you wish the ephemeris
to start and the date and time at which you wish the ephemeris to finish. Dates and
times may be entered in the same way as they entered for Solar Fire charts. The
starting date and time are used for the first ephemeris entry, and entries are then
calculated at the specified frequency until the end date and time are reached. (You
may stop the ephemeris generator at any point during calculations if you wish).
Frequency of Entries - Specify the required interval between ephemeris entries by
choosing a unit from the dropdown list box, and optionally a number of units. It is
possible to specify an interval from 1 minute up to thousands of years if required.
Typically, you may wish to generate entries every 1 day, 10 days, 1 month or 1 year.
Ephemeris Time Zone - Published ephemerides are usually calculated for the GMT
timezone (+0:00). However, you may enter any timezone that you wish, either
manually by typing in a zone abbreviation and/or time, or by using the Zone button
and selecting a zone from the list.
Zodiac - Select the zodiac in which you wish the ephemeris to be generated from
the drop-down list of zodiacs. The available zodiacs are the same as those that can
be used in other Solar Fire charts. The topical zodiac is that most commonly used in
western astrology.
Coordinates - Select the desired coordinate system from the option buttons.
Published ephemerides are usually in geocentric coordinates.
Lunar Node - If you are including the moon’s node as a selected point to list, then
select the desired lunar node type from the option buttons. This option is ignored if
the moon’s node is not selected as a point to list.
Items to List - You may select one or more items to list by clicking on their check
boxes. The generated ephemeris will have one column for each item to list for each
selected point to list.
Points To List - You may either select any set of Transiting Points and/or Extra
Points (as in the dynamic report). Click on the name of the file to see the "File
Manager" with a list of selectable files. You can also create new selections by using
the Create button in the "File Manager". Note that some of the points you can
select will give different results depending on the location. For example, chart
angles like the Ascendant and Midheaven, and the parallax corrected Moon will
vary according to location. The location adopted for these calculations is always
that of the currently selected chart in the list of "Calculated Charts". Hence, if you
wish to list chart angles for another location, you must first cast a chart for that
location, and then select it as the current chart, before entering the ephemeris
generator.
Precision - You can select whether to display the calculated positions to the
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nearest minute of arc or second of arc. Bear in mind that most of Solar Fire’s
planets are accurate to seconds of arc, but some asteroids are only accurate to
about a minute of arc. Therefore, displaying the asteroid positions to the nearest
second of arc is not useful.
Notation - The generator can display its output in normal Zodiacal notation, or in
Decimal Degrees. The Decimal Degrees option is useful if you want to export the
data generated into a spreadsheet or database program, and have it recognized as
a numerical value rather than as a text string.
8.4.3 Viewing the Ephemeris
>> To start the generation of the ephemeris according to your selections
Click on the Start button.
You will then see the View Ephemeris screen which displays the ephemeris in a grid
as it is generated. The percentage of the ephemeris completed is updated
continuously in a display at the top right of the screen. This disappears when the
generator has finished.
>> To stop the generator at any point, before it is finished.
Click on the Stop button.
You can browse through the ephemeris by clicking on the horizontal or vertical scroll
bars.
>> To print the output
Click on the Print button. This will open the print dialog allowing you to choose
printer setup options and send the ephemeris to the printer. Note that if your
ephemeris will take more than one page to print, then you will be given an estimate
of how many pages are required, and given the option of canceling without printing.
This is to avoid paper wastage should you accidentally choose to print an
ephemeris which is longer than you intended.
The ephemeris is automatically formatted to fit as many columns as possible onto
each page. However, if the ephemeris is wider than a page, then extra pages will be
generated to print the additional columns.
Note: If the formatting of the printed output is not ideal for you purposes, then it is
recommended that you export the ephemeris listing instead, and use the options in
your spreadsheet program to create your required formatting and layout.
>> To export the listing to Excel or an ASCII file
1. Click on the Export button. This will display a standard File Save dialog.
2. Select a Save as Type option
3. Select a file name and location to send the output to.
4. Click on the OK button.
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Under "Save as Type", you may select any of the following...
Excel Spreadsheet - This will generate a file with a ".xls" file extension, and after
generation, if MS Excel is installed on your computer, then it will be automatically
sent to Excel, and Excel opened if necessary in order to display it.
ASCII Text - This will generate a file with a ".asc" extension, and will be a commaquote delimited file.
All Files - In this case you can choose any file name and extension you like. It will
also generate a comma-quote delimited file.
Note: When exporting the output, any astrological glyphs are automatically converted
to text abbreviations, ensuring that the listing will be comprehensible without the
need for special astrological fonts.

8.5

Astrology and Finance

8.5.1 Introduction to Financial Astrology
Astrology has been used for many purposes over the centuries, but one use of astrology
that is not so commonly known about is assistance with financial forecasts and
decisions. The astrological tools employed are taken from the same common toolset
used with natal and electional astrology, but the interpretation of the astrological data is
applied to financial realities and concerns. And as is the case with all of astrology, this
use of astrology is based on empirical evidence gathered over a long period of time astrological events corresponding to events in financial markets.
Financial astrology has been used, amongst other things, to predict major events in
financial markets, to choose stocks, to time trades in financial instruments, and to
analyze industry performance and movements in a stock market.
This chapter is not meant to be instructive in financial astrology. Rather it is intended to
serve as a very brief introduction to a few of the concepts, and to some of the tools in
Solar Fire that might be useful in this field.
8.5.2 Financial Charts
Just as people have a day and time at which they were born, creating their birthday, so
do business ventures, especially companies and corporations. There are several times
that are significant, two of which are - the date & time of incorporation (formation) of
the business into a legal entity i.e. the Company Chart (the company's "natal chart"), and
also the date and time of any initial public offering (IPO) - the company's First (public)
Trade Chart.
First Trade Charts are cast for the particular stock exchange - eg ASX Sydney, NYSE New
York etc- of the IPO. The time is usually the time the stock exchange opened - e.g. the
ASX opens at 10.00am each day.
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The Company chart will reveal the company’s business individuality and makeup, and the
First Trade chart shows the affect of merging public ownership with that business
individuality. The Company chart is the fundamental indicator of the business - it's
overall characteristics, it's strengths and weaknesses, it's interests and its type of
modus operandi. The First Trade chart chart may have varying significance, but it will
certainly reflect how the company's stock traded on that day, and to some extent may
portray the stock's trading nature and characteristics from that point onwards.
NOTE: In Australia many company listing dates can be obtained from the Australian
Stock Market Data Series, and a source of US company birth data is Bill Meridian's stocks
database and "Planetary Stock Trading" book.
8.5.3 IntraDay Traders
Intraday traders are those people who buy and sell shares in the same day. For these
people various astrological indicators can help them with their on-the-spot analysis and
timing.
8.5.4 Tools to Assist Financial Astrology
The following tools within Solar Fire may be helpful when dealing with financial matters.
Transits to First Trade Charts - either via a dynamic report or the graphic ephemeris
See Generating a Dynamic Report and Using the Graphic Ephemeris.
The Calendar is useful for planetary daily aspects and exact time of culmination
(Intraday Traders). All the planets are significant but the faster moving ones have
more impact on a daily basis, especially the MOON.
See Using Calendars.
Using the Real Time Clock to watch planets rise, culminate and set as you trade
(Intraday Traders).
See Real Time Clock and Animation.
The Moon and Lunar Phases are very important in financial astrology. Overall,
studies and statistics show that the waxing phase of the cycle is more bullish
compared to the bearish waning phase - however each stock has an inherent natal
lunar cycle. The Lunar Phases page object may be useful to use on a chart page.
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See Editing a Page Design File for help putting this object on any page you would
like it on.
You can view similar lunar phase data on a chart Report Tabulation. See Viewing
Reports or Tabulations for a Single Chart - select the Tabulations tab, then the
"Phases/Eclipses" tabulation.
Also see Casting a Lunar Phase or Eclipse Chart for casting all kinds of lunar phase/
return charts etc for a company.
Using a 90 degree dial to quickly see hard (8th harmonic) aspects.
See Using Dials and Pointers.
Changing from Geocentric to Heliocentric charts and graphs. Both kind of charts
are used by traders - when plotted graphically, one is smooth and one isn't. This is
determined when casting a chart; select "Heliocentric" or "Geocentric" as the
coordinate system on the New Chart Data Entry screen.
You can also generate you own geocentric or heliocentric ephemeris with the
Ephemeris Generator, and then export the ephemeris as a MS Excel format file. Any
spreadsheet program that can read Excel files will be able to open this file, which
you can use for further research and analysis of planetary conditions and
movements as they relate to trading.
See Generating an Ephemeris Listing for help with doing that.
WD Gann was a finance trader who developed the technical financial analysis tools
known as Gann angles, Square of 9, Hexagon, Circle of 360. One of his techniques
utilized Planetary Returns.
See Casting a Return, Ingress or Transit Chart for help casting a Planetary Return
Chart.
Fluctuations in individual planetary Declination, or the combination of differing
planetary declinations, may reflect corresponding fluctuations in financial markets.
Thus it may be useful to keep an eye on the declinations of the transiting planets.
You can view a Declination Strip object and a Tabulation on a Reports page, or use
the Graphic Ephemeris with Declination as the coordinate you are interested in
using on the graph.
See Using the Graphic Ephemeris for a declination graph, and Viewing Reports or
Tabulations for a Single Chart to see how to view tabulations. The particular
tabulation you want is called "Declinations" in the "Tabulations" tab of the "Chart
Reports and Tabulations" window.
Via their impact, Eclipses (which astronomically are related to the Moon and Sun's
declination) and the various Saros cycles they occur in, can reflect market swings.
See Searching for Eclipses and Casting a Lunar Phase or Eclipse Chart to see
eclipse data. Additionally you can switch on eclipses for any Dynamic Report,
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include eclipse points in a Extra Ring Points file for use around a Natal or Event
Chart, or in a User Defined Points file for use alongside the normal Displayed Points
in a chart. You can also view eclipse data in a chart's Report Tabulations in the
"Phases/Eclipses" tabulation.
Synastry grids for the trader's natal chart and the Company chart of the company
whose stock they are trading in (or between the trader's chart and the company's
First Trade chart) can be used to see how compatible or incompatible the two charts
may be.
See Displaying or Printing a Synastry Grid.
Graphic Ephemeris for displaying financial data. If for instance you are able to
download financial data for the year from a stock market you may be able to display
that data on a Graphic Ephemeris showing your transits for (say) a year, comparing
the financial movements with your transits.
>> To plot financial data on a Graphic Ephemeris
1. In the Main Screen click on the Dynamic menu, then click on Graphic
Ephemeris.
2. Click on the Import Financial Data button. This launches a File dialog window
where you can navigate to a folder and select a file containing the financial
data.
The file should be in the comma separated value format (.csv) which contains
rows of data, each row containing fields of information separated by commas.
The first row should not contain data, but instead should contain names for the
different fields. Then all subsequent rows contain financial data.
Numeric data is written as it is, textual data is generally surrounded by double
quotes (12,"text data ",1,0).
TIP: Microsoft Excel can read CSV files and display the data as rows and
columns (fields). If you need to check your data before importing it this may be
a handy option for you. You could also use it to manually add field names in the
first row if you needed to by inserting a new spreadsheet row above the top
row of financial data if necessary to create a blank row, and then typing in the
name for each column in the top blank row.
3. If Solar Fire cannot understand the data in the file you have selected you will see
this screen:
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Cannot use data in Financial File

4. If Solar Fire can understand the data in the file you have selected you will see a
screen like this:

Finacial data being imported into Solar Fire

The options on this screen include:

Selecting or de-selecting columns of data to display in the ephemeris by
clicking on the column headers until you have the result you want. The
columns that will be displayed are written above the data.
Using the Pick the Date Column button to pick a column with date information
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(in case Solar Fire has selected the wrong column – usually it detects the first
one with dates).
Choose a range of rows to use – these numbers default to all the rows in the
file, but you can enter your preferred starting and ending row if you wish.
Base the minimum and maximum of the graphing on all columns, or on a
particular data column.
Display a Vertical Scale – this is checked by default, and means that there
will be numbers representing key segments in the total scale of the financial
data numbers (from the lowest to the highest), displayed next to the
astrological angles on the vertical axis in the Graphic Ephemeris
5. Clicking the Import button sets this data to be used whenever the ephemeris is
displayed. You are then returned to the "Graphic Ephemeris Selection" screen, and
can click View to see the ephemeris. The display looks like this:

Financial data in the Graphic Ephemeris

The financial data’s scale is shown on the left – from 33 at the 40-degree line up to 126
at the 0-degree line.
NOTE: Using this facility you can potentially plot non-financial data in an
ephemeris like this. The key thing is to have date based data in the file the numerical data itself can relate to any topic that interests you. By
experimenting with different sets of data in the file you import you may
be able to successfully apply this graphing functionality to another field
of interest.
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Viewing the Planetarium
Any calculated chart in Solar Fire may be viewed in a planetarium style display showing
planets and asteroids against the fixed stars and constellations, from a variety of
perspectives. It is possible to get textual and technical information on the fixed stars in
so far as it has been entered with Solar Fire’s Fixed Star Editor.
>> To display the planetarium for any calculated chart
1. Select the required chart from the list of "Calculated Charts" on the Main Screen
2. Select the Planetarium option from the View menu
This will cause the planetarium screen to be displayed, displaying the currently
selected set of Displayed Points, and the currently selected set of Fixed Stars.
It is also possible to start up the planetarium directly, without running Solar Fire, by
double-clicking on its icon in the Solar Fire Group window. However, in this case no
planets or asteroids are displayed, and the star file that is used is whatever was last
saved as the default Fixed Star file in Solar Fire. See Selecting a File for instructions on
selecting another star file.
Whilst you are in the planetarium screen, it is possible to explore the celestial sphere in
various ways which are explained below.

8.6.1 Choosing the Coordinate System
The possible coordinate systems are...
Equatorial - Coordinate lines on the sphere are lines of right ascension and
declination.
Ecliptical - Coordinate lines on the sphere are lines of longitude and latitude.
Local - Coordinate lines on the sphere are lines of azimuth and altitude. When
viewing a chart, the local horizon is that for the location of the chart at the time of
the chart. If no chart is being displayed, then the local horizon is that of the default
location of Solar Fire, as displayed on Solar Fire’s Main Screen, and the time is
current time according to your computer’s system clock.
When you select the required system from the drop-down list box, the display will be
updated automatically to reflect the new coordinate system.
8.6.2 Choosing the View Direction
The possible view directions for equatorial or ecliptical coordinates are...
Equator - The line of the equator or ecliptic is shown horizontally across the screen,
with the north pole upwards and the south pole downwards.
North Pole - The view is towards the north pole, with the pole in the center of the
screen.
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South Pole - The view is towards the south pole, with the pole in the center of the
screen.
For local coordinates...
Horizontal - the line of the horizon is shown horizontally across the screen.
Above Horizon - The view is upwards, with the horizon around the edge of the
screen.
Below Horizon - The view is downwards, with the horizon around the edge of the
screen.
When you select the required view direction from the drop-down list box, the display will
be updated automatically to reflect the new coordinate system.
8.6.3 Choosing the View Heading
The view heading may be moved through a full 360 degrees by using the horizontal scroll
bar at the bottom of the frame. Its precise value is written at the top right of the frame.
When using an equator or horizontal view, the heading is the angle towards which you
are looking. When using a polar or above/below horizon view, then the heading is the
angle at the top of the display.
8.6.4 Choosing a Star
>> To select an individual star
Do either of the following...
Select a star from the Star List - If it is not visible on the currently displayed
hemisphere, then you will hear a beep. If the selected star is visible on the current
display, then it will be highlighted.
or...
Click somewhere on the displayed sphere - The nearest star to where you clicked
will then be highlighted in the list of stars. This is especially useful if you wish to
find the nearest star to a planet in the chart - to do this, all you need do is click on
the planet symbol.
When the star is highlighted, it becomes brighter than the other stars, and expanding
and contracting rings will be shown around it for a few seconds to help you locate it.
Also, the constellation in which that star resides will appear in the Constellation list
box.
8.6.5 Viewing a Constellation
>> To see a particular constellation
Select it from the Constellation drop-down list box.
If the selected constellation is not visible in the displayed hemisphere, then you will
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hear a beep. If it is visible, then the stars in that constellation will be highlighted in
red, to differentiate them from the other stars.
8.6.6 Viewing Information About a Star
>> To see a pop-up information box which lists information about a star
Do either of the following...
Select the required star from the Star List and then Select the Info button
or...
Double-click somewhere on the displayed sphere - This will show information on
the nearest star to where you clicked.
The information shown on the star is everything that may be entered into the Fixed Star
editor, including name, nomenclature, NGC number, magnitude, spectral class and any
text available for that star. Also, the longitude, latitude, right ascension, declination,
azimuth, altitude and rising and settings times are shown. These times are on the 24hr
clock, and are listed as “Always Above” or “Always Below” if the selected star does not
cross the horizon during this day.
Note: The rise and set times shown in the planetarium are “apparent” times i.e. they
take account of the average refraction of the atmosphere. These may differ by several
minutes from “true astronomical” rise or set times. The apparent rise and set are
calculated to occur when the star is astronomically 34 minutes of arc below the horizon
(i.e. about half of a degree).
8.6.7 Animating the Planetarium
The planetarium can be stepped around continuously by clicking on either the play
forward or play backward buttons. You can click on the stop button to halt this at any
time.
Note: This option simply rotates the planetarium continuously, and does not change the
date or time for the displayed data.
8.6.8 Printing the Planetarium
>> To obtain a full page printout of the currently displayed view
Select the Print button
This will print on the default printer using the currently selected page orientation and
resolution. If you wish to change these settings, then you must do so before printing.

8.7

Viewing Stellarium
Stellarium is a free open source planetarium for your computer. It shows a realistic sky in
3D, just like what you see with the naked eye, binoculars or a telescope.
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>> To display any calculated chart in Stellarium
1. Select the required chart from the list of "Calculated Charts" on the Main Screen.
2. Select the Stellarium option from the View menu.
If Stellarium is already installed on your computer, then this will start it up, with location
and time set according to the current chart in Solar Fire.
If Stellarium is not already installed on your computer, then you will be presented with a
link to the Stellarium site, from where you may download and install it.
If, for any reason, Stellarium is already installed on your computer, but Solar Fire cannot
find it, then you will be prompted to navigate to the folder into which the Stellarium
program was installed. Once you have done this, Solar Fire will remember its location in
future.
Note: Due to limitations of Stellarium, when a Solar Fire chart is displayed, Stellarium
shows the chart time according to your local timezone - not according to the timezone of
the chart. However, it is still the correct instant in time, so the celestial phenomena are
still all correct for that chart.
Note: Stellarium is a third party product, and Esoteric Technologies has no control over it,
or how it may change in future. This link is offered "as-is", and we cannot take any credit
for its features, or any responsibility for its flaws. However, we will do our best to
maintain compatibility with it in future.
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Advanced Operations
The operations described in this chapter generally involve more computer skill than
those covered elsewhere in the User Guide. In some cases you need a basic
understanding of how your Windows file system works, file types, and how to handle
basic file management tasks. In other cases you need to understand specific internal file
structures and simple programming operations. In yet other cases you need to have a
basic understanding of modern computer concepts for best results. And for some options
you may need to have astrological skills that are more than beginner level.
However these are the areas of Solar Fire to explore if you have become reasonably
proficient with the basic operations, and now want to flex your muscles or spread your
wings. Here we cover the power features in Solar Fire.
Don't think however, that these features are necessarily difficult to use. In many ways
they are no more difficult to use than any other part of Solar Fire, just a bit more
understanding is needed. There is certainly nothing here that can't be achieved if you
take the time to carefully view the options on the screen, and then refer to the User
Guide to learn what's involved, clarify your understanding, and then follow the
instructions. With a little bit of experimenting and application, it shouldn't be too long
before you're able to tap into the full richness these features provide.

9.1

Copying, Publishing and Sending Graphics
You can copy any of Solar Fire’s chart displays and graphic ephemerides to the Windows
clipboard (to be pasted into another program), to a file anywhere on your computer or
network, or to a file that is automatically attached to an email ready to be addressed and
sent. Various graphic file formats may be used, as well as some other options governing
the appearance of the output.
>> To copy, publish or send a graphic
From the "View Chart" window...
1. Select the Copy button
Or....
From the "Graphic Ephemeris" window...
1. Select the Copy menu item after using the right hand mouse button over the
ephemeris area.
This will display the “Copy Image To" dialog, allowing various selections to be
made.
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2. Set the options.
In the "Destination" area the following options are available...
Clipboard – This will send the graphic to the Windows clipboard, from where it
can be pasted into any other program that recognizes the graphic type. For
example, you can paste it into a word processor or desktop publishing program.
File – This will send the graphic to a file of your choice. You will be prompted to
specify a file name and location.
Email attachment – This will generate a graphic file that is automatically
attached to an outgoing email, ready to send, provided that you have a MAPI
compliant email program. See About MAPI for further details.
In the "Output File Type" area the following options for setting the graphic type are
available...
Bitmap – This will create a bitmap file, which is a fixed resolution graphics file
used in many Windows applications. This type of graphic may be placed and
scaled in some other application, but as it has a fixed resolution, doing so may
cause some loss of image quality. Typically this type of file is rather large (often
over 1Mbyte), and is therefore not usually suitable for sending over the internet,
unless it is first zipped or compressed in some way.
Metafile - This will create a Windows Metafile, which is a scalable graphics file
used in many Windows applications. It is possible to place and scale the graphic
to your requirements without loss of image quality, using the commands of the
application that you are using. Hence this format is good for high quality desktop
publishing. This type of file is usually very small in size, but it has the
disadvantage that if you send it over the internet, the recipient must have the
required Solar Fire fonts installed on their machine, or else they will see incorrect
symbols in place of any astrological glyphs. (See PDF as a possible better
alternative).
JPEG – This will create a JPEG file, which is a somewhat like a compressed
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bitmap file. This type of graphic may be placed and scaled in some other
application, but as it has a fixed resolution, doing so may cause some loss of
image quality. Generally the JPEG format is preferred when your images contain
photographic or artistic elements. (Otherwise the GIF format is usually much
better).
GIF – This will create a GIF file, which is a compressed bitmap file (without loss
of clarity) allowing a maximum of 256 colors. Typically this type of file is very
small, and is especially well suited to sending over the internet and via email.
The main exception is if the image you are sending contains a very large range of
colors (such as you would find in a photographic image). In such cases, there
would be a significant loss of color depth, and the JPEG format may be
preferable.
PDF – This will create a PDF file containing the graphic on a single page, the size
of which is dictated by your default printer page size settings. This format is fully
scalable, so is well suited for desktop publishing type requirements. This option
automatically includes embedded astrological font glyphs inside the PDF file, to
ensure full portability to other computers over the internet, for example.
"Special Options" that you can set are...
Include Captions - When copying to a Metafile or PDF format, it is possible to
select whether or not the chart details and compliments text are included in the
output. Sometimes, for desk-top-publishing requirements, it is preferable to have
the chart on its own without any text, and for any captions to be added separately
to the document.
Monochrome - When copying to a Metafile or PDF format, it is possible to select
whether or not the generated graphic should be in the currently displayed color
scheme, or in monochrome (black lines and text only). As many publications are
only in monochrome, this option makes it easy to ensure that the graphic is in an
appropriate format.
Quality – When copying to a JPEG format, it is possible to choose the level of
trade-off between quality and size of the graphic. The range is 1 (lowest quality,
smallest storage size) to 100 (highest quality, largest storage size). Typically, a
value of 50 provides an adequate level of quality without using too much storage.
If you are sending graphics that have a lot of detail and small text, you may wish
to increase the quality, whereas if the graphic does not have much fine detail,
and only has large glyphs, then you might be able to economize by decreasing the
quality.
3. When you have set the options you want click on the OK button, or the Cancel
button to abort the copy.

9.2

Wheel Styles and Page Layouts
Solar Fire comes with many pre-designed wheel styles and pages, and as well you can
also create your own. Below are some of the specialized pre-designed wheels and pages
that are supplied with Solar Fire.
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Decanate and Face rulers wheel
Solar Fire comes with a wheel, the decanate ruler wheel, that you can use to
display the decanate and face rulers.
>> To display the decanate/face ruler wheel
1. When you have a Uniwheel chart displayed on the “View Chart” window...
a) Click on the Wheel Style button
b) Select the "DecRuler.wh1" wheel style from the list. This wheel uses the
Modern rulerships and so will display the Decanate rulers for the chart.
c) Click on the Select button. This will take you back to the "View Chart"
window.
2. If you now wish to display the Face rulers (still from the “View Chart” window)...
a)
b)
c)
d)

Click on the Reports button
Click on the Rulerships report.
In the "Rulerships" dropdown box, select Traditional rulerships
Click on the Quit button.

3. Finally now back in the “View Chart” window...
a) Click on the ReDraw button to update the wheel and it will now display the
Face rulers around the wheel.
To return to the "Decanate" rulers, repeat step (2) and simply reselect the Modern
rulers, then repeat step (3).
Term rulers wheel
There are two types of Term rulers: Ptolemy and Egyptian. To select the appropriate
wheel style to display these rulers ...
1. In the "View Chart" window click on the Wheel Style button.
2. Select either TermRulers_Ptolemy.wh1 or TermRulers_Egyptian.wh1
3. Click on the Select button. This will take you back to the "View Chart" window.
Nakshatra wheel
For Vedic astrology users, you can select a wheel style that displays the Nakshatras
around the wheel. This wheel style is usually used when a Vedic zodiac has been
selected, like Lahiri.
1. In the "View Chart" window click on the Wheel Style button.
2. Select Nakshatras.wh1.
3. Click on the Select button. This will take you back to the "View Chart" window.
BiWheel with houses in both wheels
Solar Fire comes with a BiWheel that displays separate houses in both the inner
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and outer wheel. This wheel style might be useful for those times when you want to
see the current transiting houses (and planets) on the outer wheel of a natal chart.
To see this wheel style on the “View Chart” screen
1. In the "View Chart" window click on the Wheel Style button.
2. Select BiBothHouses.wh2.
3. Click on the Select button. This will take you back to the "View Chart" window.
Composite sun house Chart Art page (for all composite sun houses)
Twelve Chart Art pages are available for displaying the house location of the
composite Sun. For example, if a couple’s composite Sun is located in the 4th house
then...
1. On the "View Chart" window, click the Pages button
2. Expand the "Chart Art" category by clicking on the plus sign to the left of it
3. Click on Solar Fire Wheel with Art [art_composite4.pag].
Animating progressions and transits page
A page layout is available that may assist users animating a natal chart, secondary
progression chart and transit chart all at the same time.
>> To animate the progressed chart, and the progressions and transits to the
natal chart, all on the same page
1. From the Main Screen create or open a chart and have it highlighted on the
“Calculated Charts” list.
2. Calculate the current transits chart for the location you want and it will be added
to the “Calculated Charts” list.
3. On the Dynamic menu click on Animate Page.
4. Expand the “Multiple Charts” category by clicking on the plus sign to the left of
it.
5. Double-click on the Transits and Progressed Page [tranprog.pag]. This action
will open a window allowing you to assign the charts.
6. Assign the Natal chart as Chart 1 (Natal base chart, Fixed Base Chart)
7. Assign the Transit chart as Chart 2 (Event base chart, Transits)
8. Assign the Progressed chart as Chart 3 (Natal base chart, Secondary
Progressions)
9. Click on the OK button
10. As you step the charts through time, you will see the relevant movements of
planets and aspects in three of the four wheels (not the natal chart).
For assistance assigning charts in the (Animate) Transits and Progressed Page
dialog see Selecting Alternative Chart Types
Single and BiWheel with Dasas
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A major dasa cycle runs for 120 years and it is further sub-divided into sub-dasas
also known as bhuktis. If you open a natal chart and use a Vedic zodiac, like Lahiri,
you can display the dasa periods for that natal chart. There are three pages you can
use to display Dasas for a chart.
[A] (for a Uniwheel e.g. a single chart)
1.
2.
3.
4.

On the "View Chart" window click on the Pages button.
Expand the "Vedic" category by clicking on the plus sign to the left of it.
Click on UniWheel with Dasas [uni_dasas.pag]
Click the OK button

[B] (for a BiWheel e.g. for a natal chart and transits)
1. Highlight two charts on the “Calculated Charts” list, e.g. one a natal chart and
the other a transits chart
2. Click on the View menu
3. Click on BiWheel
4. In the "View Chart" window click on the Pages button
5. Expand the "Vedic" category by clicking on the plus sign to the left of it
6. Click on BiWheel with Dasas [bi_dasas.pag]
7. Click the OK button
[C] (for a BiWheel e.g. for a natal chart and transits - dasas > 120 yrs)
For example, if you are a mundane astrologer wanting to use an older country’s
chart, like the USA chart, with the current transits displayed around the outside
then you can.
1. Highlight two charts on the “Calculated Charts” list, e.g. one the USA chart and
the other a Transits chart
2. Click on the View menu
3. Click on BiWheel
4. In the "View Chart" window click on the Pages button
5. Expand the "Vedic" category by clicking on the plus sign to the left of it
6. Click on BiWheel with Dasas (> 120 years) [bi_dasas2.pag]
7. Click the OK button
TriWheels showing inter-chart aspects
Three triwheels with names all starting with "TriAspects..." show the aspects
between two of the charts in the triwheel. Each triwheel shows the aspects for a
different combination of two charts (i.e chart 1 to chart 2, chart 2 to chart 3, chart 1
to chart 3). It is recommended to use an Aspects file that uses tight orbs, and an
Aspected Points file that only includes a small number of essential points,
otherwise the number of aspect lines on the screen can often be an impenetrable
mass that is difficult to read clearly.
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Changing Page Object Properties from View Charts
Some objects on the displayed page (such as wheels, grids and tabulations) have
properties that may be edited in place, without the need to first open the page design in
the page designer.
Place the mouse over an object on the displayed chart or page image and click on the
right-hand mouse button. If the object has any editable properties, then the first item on
the menu will be “Properties of <ObjectType>…”, and selecting it will display a small
pop-up dialog which allows you to edit these properties.

When this dialog appears, it contains a list of properties that may be edited in the
selected page object, and the values to which they are currently set.
Properties that have no predefined value are shown as “Default”, followed by the name
of the current Solar Fire default value that applies in the absence of a specifically
selected value. For example, the Points File value is “Default (PLAN&CH)”, which means
that this object has no Points File value, and therefore Solar Fire’s current default points
file will be applied when this object is displayed, and that the current default points file
happens to be “PLAN&CH.PTS”.
The types of properties that may be edited are as follows:
Frame Type – for any object that has a rectangular frame.
Points File – for any object that requires a point file selection.
Aspect File – for any object that requires an aspect file selection.
Rulership Level – for any object that uses a rulership level.
Weighted Scores – for any object that has an option of weighted versus unweighted
scores.
Zodiac Type – for any object that requires a zodiac type setting.
Modulus – for any object that uses a modulus value (such as a sort strip).
Maximum Orb – for any object that uses a maximum orb (such as an aspects list).
Graphic File – for the graphic object only.
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Dignity/Almuten File – for objects that use dignity/almuten definitions.
Star File – for objects that require a star file selection.
Parts File – for objects that require an Arabic Parts file selection.
Asteroid File – for objects that require an asteroid file selection.
Extra Bodies File – for objects that require a extra bodies file selection.
Extra Ring Points File – for objects that require an extra ring points file selection.
Wheel File – for wheel objects (uniwheel, biwheel, triwheel, quadriwheel).
>> To edit a property
1. Click on the property name on the list of available properties.
If the current value of this property is not a “Default” value, then the edit box below
the list will be set to that value, ready for you to edit.
If the current value of this property is a “Default” value, then the edit box below the
list will remain empty, ready for you to enter a value if you wish.
There are three ways of choosing a value...
For properties which are file names – click on the > button to open a file selection
dialog.
For properties which have a pre-set list of possible values - click on the down-arrow
to scroll through the list of values and select one.
For other properties – type the new value directly into the edit box.
After you have edited each property, its new value will be displayed in the list.
>> To reset a property to its default value
Move the cursor into the edit box, delete any text in it, and then press the Enter
key.
>> To apply and view your changes
Click on the Save button.
This will close the dialog and redraw the page.
Note: Only the currently displayed page size is affected by any changes you make
in this way. Page designs may contain multiple page sizes. If you wish to alter
properties of objects in any other page sizes (such as the page size which is used
when printing the page), then you must open the page file in the Page Designer and
edit the objects in each page size individually, as required.
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Importing & Exporting Chart Files
This chapter describes how you can use Solar Fire's Chart Conversion Utility to import
and/or export natal type charts to or from chart files created by Solar Fire or various
other astrological software, as well as sending chart details to text files.
Note that you can also export planetary type data such as longitudes and latitudes –
please refer to Exporting Data to Text Files for further details.
Most charts produced by Astrolabe and Matrix Blue*Star or QuickCharts compatible
software may be imported into Solar Fire format. The capability to import other types of
chart files may also be added at a later date. If you have Nova, Chartwheels,
Professional Natal Report, Blue*Star, or QuickCharts, and you have calculated and saved
important natal charts using these programs, Solar Fire can import them into its own
chart file format.
This utility searches for and processes only the natal chart records in your chart files. It
does not import or export derived-type charts such as progressed charts, solar and lunar
returns, and composite charts, for example.
Note: The ASCII text data that can be imported or exported using this utility can consist
only of chart details such as name, date, place, timezone etc, and cannot include
planetary or house data such as planetary and house cusp longitudes, declinations etc. If
you wish to export planetary type data from Solar Fire, then you must use the Export
Charts as Text… item from the Chart menu, instead. See Exporting Data to Text Files for
further details.
Note: Solar Fire is able to open, read and save charts in Nova type chart files directly,
without the need to import or export chart files. Hence, if you are using Nova type chart
files, then you do not need to import or export using this utility them unless you want to
do so.
The difference between this utility and the "Import Charts & Settings" option on the
"Utilities" menu is that this utility can import or export charts from/to a whole range of
chart files (only) of different program origin and/or Solar Fire versions stored somewhere
on your computer, an external disk or network, whereas the "Import Charts & Settings"
option can import a whole range of user and settings files, including chart files, (but only
if they are part of a previous version of Solar Fire installed somewhere on your computer,
an external disk or network).

9.4.1 Chart Files You Can Import From
The "Chart Conversion Utility" can import natal type charts from any of the following
types of chart files...
Solar chart files - This feature is useful for importing charts created in current or
earlier versions of Solar Fire (v1/2/3/4/5/6,7), Solar Maps, Solar Spark or Solar
Writer.
JigSaw project files – JigSaw v1 or v2 project files have the extension .DAT.
Nova chart files - Nova and Nova-series software has charts in files with the
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extension .NOV. Example: FRIENDS.NOV.
Blue*Star chart files - Blue*Star saves charts in files with the extension .RND.
QuickCharts chart files - QuickCharts saves charts in files with the extension .QCK.
ASCII files – These can be text files that contain chart data in fixed length or comma
quote delimited format, with a file extension of .ASC, .TXT or .DAT.
Kepler chart - in a file called "NAMES.TXT"
Other file formats - Any additional file formats which are added after publication of
this manual
Note: This utility cannot import Win*Star charts directly. However, if you convert your
Win*Star charts into QuickCharts format first (or alternatively into an ASCII text file),
then these charts may be imported with this utility.
9.4.2 Chart Files You Can Export To
The "Chart Conversion Utility" can export natal type charts to any of the following types
of chart files...
Solar Fire v6 or higher format chart Files
Solar Fire v5 format chart files
Solar Fire v3/v4 format chart files
Solar Fire v1/v2 format chart files
JigSaw v2 project files (see Other Solar Products)
ASCII files – These can be flexibly defined to contain selected chart details in fixed
length or comma quote delimited format.
9.4.3 Starting the Solar Fire Chart Conversion Utility
>> To start the utility
From the Start button select All Programs / Esoteric Technologies / Solar Fire v9 /
Chart Import_Export.
After the utility loads, Solar Fire displays a chart conversion dialog containing three
tabbed dialogs.
Import From - To select the file from which data will be read
Save To - To select the file to which data will be exported or written
Options – To select various conversion options
9.4.3.1 Import From

In the "Chart Conversion Utility"...
>> To select the file to import from
1. Select the required File Type from the Chart Type to Import From drop-down list
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box. This selection determines which file types will be visible in the file list below.
2. Select the required Drive from the drop-down list of drive names.
3. Select the required Folder by navigating through the folders. Each time you change
the folder, the list of files available to import from will be updated, to reflect the
newly selected location. When you have selected the required folder, all the files
of the selected chart type that are in that folder will be listed in the file list.
4. Select the required file from the file list. When you do so, the “Import From” box at
the bottom of the dialog will be updated to give the full path and file name of your
selected file.
9.4.3.2 Save To

In the "Chart Conversion Utility" you have the option of saving (exporting) charts either
into a new file, or to be appended to an existing file.
>> To select the file to save or export to
1. Select the required File Type from the Chart Type to Save Into drop-down list box.
This selection determines which file types will be visible in the file list below.
2. Select the required Drive from the drop-down list of drive names.
3. Select the required Folder by navigating through the folders. Each time you change
the folder, the list of existing files of the selected type will be updated, to reflect
the newly selected location. When you have selected the required folder, all the
files of the selected chart type that are already in that folder will be listed in the
file list. If you are importing chart for use in Solar Fire, then you should select
\Solar Fire User Files\Charts folder (or whichever other folder you are using to
store its chart files).
4. If you wish to save your charts into a file that already exists, then select the
required file from the file list.
5. If you wish to save your charts into a new file, then enter a new file name into the
File Name to Save Into box. When you do so, the “Save To” box at the bottom of
the dialog will be updated to give the full path and file name of your selected file.
If you omit the file extension, then the correct extension type will be appended to
the file name automatically when the file is created.
9.4.3.3 Options

You can set various options that control the importing and exporting process.
9.4.3.3.1 New Solar Fire Chart Files

This "Chart Conversion" option is used only when you are saving charts into a new Solar
type chart file. It determines the internal format of any Solar type chart file which is
created by this utility.
Create v1/2 format chart files - Newly created chart files will be compatible with
Solar Fire v1 and v2 only.
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Create v3/4 format chart files – Newly created chart files will be compatible with
Solar Fire v3 and higher, but when used with Solar Fire v5 and higher cannot be used to
store non-natal type charts, chart ratings or source comments. Choose this option if
you wish to create chart files that can be used by owners of Solar Fire v3 and v4.
Create v5 format chart files - Newly created chart files will be compatible with Solar
Fire v5 and higher but when used with Solar Fire v6 higher cannot be used to store Life
Events. Choose this option if you wish to create chart files that can be used by owners
of Solar Fire v5.
Create v6 or higher format chart files - Newly created chart files will be fully
compatible with Solar Fire v6 or higher versions, but cannot be used with any older
version of Solar Fire. Choose this option if you want to be able to save Life Events with
your charts.
9.4.3.3.2 Default House System

This "Chart Conversion" option is used only when you are saving charts into a Solar type
chart file.
The default house system that is selected in this drop-down list is applied whenever the
chart data that is being imported does not have a house system stored with it, or has a
house system that is not recognized in Solar Fire.
If the Force all converted charts to use this house system option is checked, then all
imported charts are given the default house system, regardless of what house system
may be stored in the imported chart.
9.4.3.3.3 Default Zodiac

This "Chart Conversion" option is used only when you are saving charts into a Solar type
chart file.
The default zodiac that is selected in this drop-down list is applied whenever the chart
data that is being imported does not have a zodiac stored with it, or has a zodiac that is
not recognized in Solar Fire.
If the Force all converted charts to use this zodiac is checked, then all imported charts
are given the default zodiac, regardless of what zodiac may be stored in the imported
chart.
9.4.3.3.4 Default Coordinates

This "Chart Conversion" option is used only when you are saving charts into a Solar type
chart file.
The default coordinate system that is selected in this drop-down list is applied whenever
the chart data that is being imported does not have a coordinate system stored with it,
or has a coordinate system that is not recognized in Solar Fire.
If the Force all converted charts to use these coordinates option is checked, then all
imported charts are given the default coordinate system, regardless of what coordinate
system may be stored in the imported chart.
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9.4.3.3.5 ASCII Format to Use

This Chart Conversion option is used only when you are importing from or exporting to an
ASCII text type chart file.
You can either select a pre-defined ASCII format from the drop-down list, or click on the
Edit ASCII Formats… button to create new ASCII format definitions, or edit or browse
existing ASCII format definitions.
See Editing ASCII Definitions for instructions on editing ASCII format definitions.
9.4.4 Converting Charts
Once you have selected all the required options, you can start the conversion by clicking
on the Convert button. If the "Save To" file already exists, then you will be prompted
whether or not you wish to append new charts after any existing charts in that file.
When the process has finished, you will be notified how many charts were successfully
converted.
Note: If you import a Solar Fire chart file, then any comments associated with the charts
in that file will also be imported.

9.5

Chart Search and Electional Search
These two modules both allow you to search using a variety of simple or advanced
criteria, such as for a planet being in specified house or sign, a particular aspect being
formed between two planets, a specified aspect pattern existing, the moon being void of
course, and many others.
As well as searches using a single condition, you can combine criteria to perform
complex searches involving many different factors. For example, you could search for the
Moon in either Taurus or Gemini, and the Sun in the 7th house square Uranus.
The Electional Search module allows you perform searches through time, and presents
a list of matching periods of time during which the criteria are satisfied. It also lists
times when exact aspects are formed or other exact criteria reached, where relevant.
You can search for purely mundane conditions on their own (involving transiting
positions), or you can search for transiting positions in relation to a given radix chart.
The Chart Search module allows you to search through your stored charts, and presents
a list of stored charts that satisfy the criteria. In addition to astrological criteria, this
module also allows you to use chart data criteria in a search (such as chart name, date,
time, house system etc). You can search based purely on the information in the stored
charts, or you can search for stored chart positions in relation to a given radix chart.

9.5.1 Chart Search
>> To open the Chart Search dialog
From the Main Screen, select the Chart Search item from the Chart menu
or...
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From the Chart Database dialog, click on the Find... button and select the Chart
Search menu item.
This will display the Chart Search dialog, which initially displays the last selection
criteria that you used.

You have three different options to determine which chart file(s) are searched...
Current chart file – this option shows the name of the currently selected chart file.
If selected, only this file will be searched.
All Chart Files in \Solar Fire User Files\Charts folder – If selected, then all charts
files in the Charts folder of Solar Fire will be searched.
Selected Chart Files – If selected, then only those chart files listed immediately
below will be searched. Note that you may select any chart files from any folders.
>> To add a new selected chart file to search
1. Click on the Add button.
2. If necessary, navigate to the folder in which the required chart file/s reside.
3. Highlight one (or more) chart files that you wish to add to the search.
Note: You can include multiple chart files at once by using the Mouse + Shift or Ctrl
keys.
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>> To remove a selected chart file from the search
1. Highlight the file that you wish to remove from the search.
2. Click on the Remove button.
>> To clear the list of chart files to search
Click on the Clear button.
>> To select a radix chart to use in your search conditions
Select any calculated chart from the Chart For Radix Positions drop-down list.
If you wish to use a chart which is not in this list, then you must first cast or open that
chart, after which it will be available in this list for selection.
Note: Many searches do not involve radix positions, in which case the chart selected
here is not relevant. However, if you do use a search condition that involves a
condition including a radix chart position, then this is the chart that will be used.
9.5.2 Electional Search
>> To open the Electional Search dialog
1. Select the Electional Search item from the Dynamic menu.
This will display the "Electional Search" dialog, which initially displays the last
selection criteria that you used.
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>> To set the time period for search
2. Enter a start date and time
3. Enter an end date and time
Note: The timezone for your entered dates and times is either the current timezone
for your default location, or the timezone taken from a specified calculated chart,
according to the choice you make below.
Depending on what criteria you select, the search results may vary depending on
the location and other settings for which the search is performed. For example, if
you are searching for an aspect between a planet and a chart angle such the
ascendant, then the timing of aspects formed will vary widely depending on the
latitude and longitude used for the calculation. The settings that may be used
during the search are as follows:
Location – the latitude and longitude to use when criteria involve chart angles
and/or houses
Timezone – the default timezone to use for the specified time period to search
and for the output results
House System – the house system to use when criteria involve house cusps or
placements
Zodiac – the zodiac to use when criteria involve celestial longitudes
Coordinate System – the coordinate system to use when criteria involve
calculating chart points
>> To determine the location and other settings for the search
4. Click on the "..." button in the Location and Settings for Search frame.
This will open the Search Location and Settings dialog.
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5. Select one of the following options...
Use default location and settings – Choosing this option ensures that your
current default location and settings are used for the search.
or...
Specify my own location and settings - Choosing this option allows you to enter
the required place details and other settings in the Location and Settings frames
below.
>> To ensure that the results of the search include automatic timezone change for
daylight savings periods
6. Enable the Auto DST checkbox.
If the Auto DST option is unchecked, then the results will show times for the
specified timezone only, whether or not this is the standard timezone for the given
location. This is useful if you would like to see all the results in Universal Time, for
example, rather than in the normal timezone for the selected location.
>> To select a radix chart to use in your search conditions
7. Select any calculated chart from the Chart For Radix Positions drop-down list.
If you wish to use a chart which is not in this list, then you must first cast or open
that chart, after which it will be available in this list for selection.
Note: Many searches do not involve radix positions, in which case the chart
selected here is not relevant. However, if you do use a search condition that
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involves a condition including a radix position, then this is the chart that will be
used.
9.5.3 Composing Search Conditions
When the Search dialog box is first displayed, the "List of Search Conditions" area
contains whatever search criteria were last used here. You can re-use these criteria, edit
them or clear them to start afresh.
To make this search tool as simple to use as possible, there is an option whether to
display advanced options or not. The advanced options allow you see and use point and
aspect modifiers (explained in more detail later), which give much greater power over
the types of conditions that may be specified. It is expected that only advanced
astrologers will want to use these, and unless you need this extra power, you may prefer
to leave the advanced options switched off.
>> To switch on or off the visibility of advanced options
Click the Show Advanced Options checkbox.
The "Search Condition Selection" box contains a series of tabs, each of which allows
you to specify a different type of condition.
The types of search conditions available from each tab are described individually in the
sections below.
9.5.3.1 In Sign

When composing chart search conditions, "In Sign" allows you to select...
A Planet, Point or Cusp – any of Solar Fire’s standard chart points, or any of the 12
house cusps
A Modifier – a modifier to apply to the selected point or cusp, such as the ruler of
that point, the degree almuten of that point, the antiscia of that point, the contraantiscia of that point.
A Sign or Sign Type – any of the 12 signs, any sign element, any sign mode or either
sign polarity.
Examples: Mars in Cancer; The Traditional Ruler of the 5th House Cusp in a Fixed Sign;
the Antiscia of the Ascendant in Taurus.
9.5.3.2 In House

When composing chart search conditions, "In House" allows you to select...
A Planet, Point or Cusp – any of Solar Fire’s standard chart points, or any of the 12
house cusps
A Modifier – a modifier to apply to the selected point or cusp, such as the ruler of
that point, the degree almuten of that point, the antiscia of that point, the contraantiscia of that point.
A House or House Type – any of the 12 houses, any house mode or above horizon
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(7th to 12th) or below horizon (1st to 6th).
Also, for Chart Searches only, whether the house placement relates to the houses of...
The same chart - i.e. the houses of the chart you are searching (the selected radix
chart is not used)
The radix chart - i.e. the houses of the selected radix chart for this search
or... for Electional Searches only, whether the house placement relates to houses
of...
The transiting chart - i.e. the houses varying with time (the selected radix chart is
not used)
The radix chart - i.e. the houses of the selected radix chart for this search
Examples: Mars in 4th House; The Traditional Ruler of the 5th House Cusp Above Horizon;
the Antiscia of the Ascendant in a Cardinal House.
9.5.3.3 In Aspect

When composing chart search conditions, "In Aspect" allows you to select...
A First Planet, Point or Cusp – any of Solar Fire’s standard chart points, or any of the
12 house cusps
A First Point Modifier – a modifier to apply to the selected point or cusp, such as
the ruler of that point, the degree almuten of that point, the antiscia of that point,
the contra-antiscia of that point.
An Aspect or Aspect Type – an individual aspect in the currently selected aspect
set, any aspect, any soft aspect, any hard aspect.
An Aspect Modifier – a modifier to apply to the selected aspect, such as applying
only, separating only, or applying or partile.
A Second Planet, Point or Cusp
A Second Point Modifier
Also, for Chart Searches only, whether the second point's placement relates to...
The same chart - i.e. the aspect occurs between the two points in the charts being
searched (the selected radix chart is not used)
The radix chart - i.e. the aspect occurs from the first point in the charts being
searched to the second point in the selected radix chart
or ... for Electional Searches only, whether the second point's placement relates
to...
The transiting chart - i.e. the aspect occurs between the two transiting points (the
selected radix chart is not used)
The radix chart - i.e. the aspect occurs from the transiting first point to the second
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point in the selected radix chart
The aspect types which may be chosen are defined as follows...
Any Aspect – Any one of the aspects which is switched on in the currently selected
aspect set, using the orbs defined within that aspect set.
Any Soft Aspect – Any one of Conjunction, Trine, Sextile, using the orbs defined for
those aspects within the currently selected aspect set, regardless of whether or not
they are individually switched on in the aspect set.
Any Hard Aspect – Any one of Opposition, Square, SemiSquare, SesquiSquare, using
the orbs defined for those aspects within the currently selected aspect set,
regardless of whether or not they are individually switched on in the aspect set.
Examples: Mars conjunct Saturn; The Traditional Ruler of the 5th House Cusp in any
applying aspect to the Ascendant; The antiscia of the Ascendant in applying soft aspect
to the almuten of the 9th House Cusp.
Note: The aspect orbs that will be used in the search are those natal orbs specified in
the currently selected aspect set, as specified in the “Aspect Set” box at the bottom of
this dialog. If you wish to change the orbs, then you can either edit this aspect set, or
select a different aspect set.
9.5.3.4 In Phase

When composing chart search conditions, "In Phase" allows you to select...
A First Planet, Point or Cusp – any of Solar Fire’s standard chart points, or any of the
12 house cusps
A First Point Modifier – a modifier to apply to the selected point or cusp, such as
the ruler of that point, the degree almuten of that point, the antiscia of that point,
the contra-antiscia of that point.
A Phase – any individual phase division of 2, 4 or 8 in zodiacal longitude.
A Second Planet, Point or Cusp
A Second Point Modifier
Also, for Chart Searches only, whether the second point's placement relates to...
The same chart - i.e. the phase occurs between the two points in the charts being
searched (the selected radix chart is not used)
The radix chart - i.e. the phase occurs between the first point in the charts being
searched and the second point in the selected radix chart
or... for Electional Searches only, whether the second point's placement relates to...
The transiting chart - i.e. the phase occurs between the two transiting points (the
selected radix chart is not used)
The radix chart - i.e. the phase occurs between the transiting first point and the
second point in the selected radix chart
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Examples: Moon in Phase 1 of 2 with Sun; The Traditional Ruler of the 5th House Cusp in
Phase 3 of 4 with the Ascendant.
Note: The phase is determined by the angle of the first point in relation to the second
point i.e. by how far the first point LEADS the second point in the zodiac. Therefore Moon
in Phase 1 of 2 with the Sun means that the Moon leads the sun by between 0 and 180
degrees.
Note: With the Moon as the first point, and Sun as the second point, these phases are
typically given the following names...
Phase 1 of 2 – Waxing Moon
Phase 2 of 2 – Waning Moon
Phase 1 of 4 – New Moon
Phase 2 of 4 – First Quarter Moon
Phase 3 of 4 – Full Moon
Phase 4 of 4 – Third Quarter Moon
Phase 1 of 8 – New Moon
Phase 2 of 8 – Crescent Moon
Phase 3 of 8 – First Quarter Moon
Phase 4 of 8 – Gibbous Moon
Phase 5 of 8 – Full Moon
Phase 6 of 8 – Disseminating Moon
Phase 7 of 8 – Last Quarter Moon
Phase 8 of 8 – Balsamic Moon
9.5.3.5 At Position

When composing chart search conditions, "At Position" allows you to select...
A Planet, Point or Cusp – any of Solar Fire’s standard chart points, or any of the 12
house cusps
A Point Modifier – a modifier to apply to the selected point or cusp, such as the
ruler of that point, the degree almuten of that point, the antiscia of that point, the
contra-antiscia of that point.
An Aspect or Aspect Type – an individual aspect in the currently selected aspect
set, any aspect, any soft aspect, any hard aspect.
An Aspect Modifier – a modifier to apply to the selected aspect, such as applying
only, separating only, or applying or partile.
A Fixed Zodiacal Longitude
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Examples: Mars conjunct 23Ta00’; The Traditional Ruler of the 5th House Cusp in any
applying aspect to 17Cp30’; The antiscia of the Ascendant in applying soft aspect to
9Cn23’48”.
Note: The aspect orbs that will be used in the search are those specified in the currently
selected aspect set, as specified in the “Aspect Set” box at the bottom of this dialog. If
you wish to change the orbs, then you can either edit this aspect set, or select a
different aspect set.
9.5.3.6 In Dignity

When composing chart search conditions, "In Dignity" allows you to select...
A Planet, Point or Cusp – any of Solar Fire’s standard chart points, or any of the 12
house cusps
A Point Modifier – a modifier to apply to the selected point or cusp, such as the
ruler of that point, the degree almuten of that point, the antiscia of that point, the
contra-antiscia of that point.
A Dignity Type – in rulership, in exaltation, in triplicity, in term, in face, in
detriment, in fall, is peregrine, is planet of hour, is planet of day, is cazimi, is
combust, is under Sun’s beams, is oriental, is in accidental dignity by house, is
unaspected.
A Rulership Level – any one of the available rulership level types, such as Modern,
Traditional, Esoteric. This is relevant only for those dignity types that vary
according to rulership level i.e. rulership, exaltation, detriment, fall, and accidental
dignity by house. For other dignity types it is ignored.
Examples: Moon in its Modern Rulership; Venus is cazimi; Modern Ruler of the Sun is
Oriental.
Note: The orbs used are: cazimi 0°17’; combust 8°30’; under Sun’s beams 17°00’.
9.5.3.7 Is Planet

When composing chart search conditions, "Is Planet" allows you to select...
A Planet, Point or Cusp – any of Solar Fire’s standard chart points, or any of the 12
house cusps
A Point Modifier – a modifier to apply to the selected point or cusp, such as the
ruler of that point, the degree almuten of that point, the antiscia of that point, the
contra-antiscia of that point.
Any Planet - out to Pluto only
Examples: Modern Ruler of the Moon is Mercury; Almuten is the 10th House Cusp is
Saturn.
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9.5.3.8 Consideration

When composing chart search conditions, "Consideration" allows you to select any one
of the following considerations...
Moon is Void of Course – this occurs after the Moon makes it last aspect in any
sign until its ingress into the next sign, using Conjunctions, Oppositions, Trines,
Squares and Sextiles, with aspects to the Sun, Mercury, Venus, Mars, Jupiter,
Saturn, and optionally also to Uranus, Neptune and Pluto, depending on which userdefined void of course definition has been selected.
Moon is VOC (Lilly method) – this is the same as above except that only planets
out to Saturn are used (i.e. ignoring Lunar aspects to Uranus, Neptune and Pluto),
and the signs Taurus, Cancer, Sagittarius and Pisces are deemed never to have void
of course occurring in them.
Moon is Waxing – this occurs when the Moon leads the Sun by between 0 and 180
degrees.
Moon is Fast – this occurs whenever the Moon is traveling at faster than its
average rate of travel (i.e. faster than 13°10’35” per day).
Moon is in via Combusta – this occurs when the moon is between 15° Libra and 15°
Scorpio.
ASC is near sign boundary – this occurs when the Ascendant is within 3° of any sign
boundary (i.e. less than 3° or greater than 27° of any sign).
Sun is Above Horizon – this occurs when the Sun’s is above the Ascendant/
Descendant axis.
9.5.3.9 Aspect Pattern

When composing chart search conditions, "Aspect Pattern" allows you to select one of
the available aspect patterns to search for...
>> To see a list and preview of each available aspect pattern type
Click on the View Patterns… button.
This displays the Aspect Pattern dialog allowing you to browse through the available
patterns, and see a preview of the pattern showing its shape and individual aspect
makeup.
Note: The chart points that will be used in the search are those specified in the currently
specified pattern points set. If you wish to change the selection of points to use, then
you can either edit this point set, or select a different point set by clicking on the >
button to the right of the Pattern Points box. In particular, it is important to decide
whether you want chart angles (such as the Ascendant and Midheaven) to be included in
your search. If you are doing an Electional Search, and you include any chart angles, then
the search will take much longer (and produce many more hits) because the chart angles
move so quickly. If you are doing a Chart Search, this factor is not relevant, but you may
still want to decide whether or not you are interested in pattern involving the chart
angles, or whether you prefer to limit the search only to planets, for example.
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Note: The aspect orbs that will be used in the search are those specified in the currently
selected aspect set, as specified in the “Aspect Set” box at the bottom of this dialog. If
you wish to change the orbs, then you can either edit this aspect set, or select a
different aspect set by clicking on the > button to the right of the Aspect Set box.
9.5.3.10 Coordinates

When composing chart search conditions, "Coordinates" allows you select...
A Planet, Point or Cusp – any of Solar Fire’s standard chart points, or any of the 12
house cusps
A Point Modifier – a modifier to apply to the selected point or cusp, such as the
ruler of that point, the degree almuten of that point, the antiscia of that point, the
contra-antiscia of that point.
A Coordinate Type – Longitude, Speed in Longitude, Latitude, Speed in Latitude,
Right Ascension, Speed in Right Ascension, Declination, Speed in Declination,
Azimuth, Altitude
A Comparison Type – Less than (<), Less than or equal to (<=), Equal to (=), Greater
than or equal to (>=), Greater than (>)
A Comparison Value – the types of comparison value required depends on the
coordinate type. A zodiacal position (including zodiac sign) is required for
longitude, an angle from 0° to 360° is required for Right Ascension and Azimuth. An
angle from -90° to +90° is required for Latitude, Declination and Altitude, and a
daily rate of motion in degrees is required for any speed.
Examples: Sun Longitude is >= 15°Ta00’; Moon Speed in Longitude is >= 13°10’35”;
Midheaven Altitude > 75°00’
Note: If you wish to test for a range of values, then you must create two conditions
combined with a Boolean operator. For example, to test for the Sun being in the 3rd
decanate of Libra, you would need to use two conditions combined with an AND operator
i.e. Sun Longitude >= 20°Li00’ AND Sun Longitude < 0°Sc00’.
9.5.3.11 Chart Details

Note: The items available in this category depend on whether you are performing a
"Chart Search" or an "Electional Search". A "Chart Search" allows you to select any and
all of the items listed below. However, as an "Electional Search" is a search through time
rather than a search of stored charts, most of these items have no relevance to this type
of search. Therefore, the only chart detail type that is available for selection within an
"Electional Search" is Time, which may be used to limit the times of day to be searched.
When composing chart search conditions, "Chart Details" allows you to select...
A Chart Detail Type – as listed below
A Comparison Type – For chart details types which are numerical, date, time,
latitude or longitude types, the available comparison types are Less than (<), Less
than or equal to (<=), Equal to (=), Greater than or equal to (>=), Greater than (>).
For string type chart details, the available comparison types are “contains” (the
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item being searched contains the comparison value anywhere), “starts with” (the
item being searched contains the comparison value starting at the beginning only),
“contains word” (the item being searched contained the comparison value as a
whole word i.e. separated by at least one space from any other characters in the
searched value).
A Comparison Value - the types of comparison value required depends on the chart
details type. String type chart details require a character string comparison value.
Date type requires a date comparison value. Time type requires a time comparison
value. Latitude requires a geographic latitude comparison value and Longitude
requires a geographic longitude comparison value.
Chart Detail Types
Chart Type – the name of this chart type e.g. Natal, Progressed, Prenatal (string
type value).
Name – the chart name (string type value).
Date – the chart date (date type value).
Time – the chart time (time type value)
Zone – the chart’s timezone offset in decimal hours (numerical type value)
Place – the chart’s place name (string type value)
Country – the chart’s country name (string type value)
Lat – the chart’s geographic latitude (latitude type value)
Long – the chart’s geographic longitude (longitude type value)
Coords – the chart’s coordinate system i.e. Geocentric of Heliocentric (string type
value)
Zodiac – the chart’s zodiac type e.g. Tropical, Lahiri, Fagan-Allen (string type value)
Houses – the chart’s house system name e.g. Placidus, Koch, Equal Houses (string
type value)
Rating – the chart’s source rating e.g. AA, A, B, C, DD, X, XX (string type value)
File – the name of the file in which this chart is stored (string type value)
Folder – the name of the folder, including the full pathname, in which this chart’s
file resides (string type value)
Rec – the record number where this chart is stored in its file (numerical type value)
Days to Birthday – days remaining until next birthday from current date, from 0 to
365 (numerical type value)
Comments – comments text stored with this chart (string type value)
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Day of Week - the name of the day of the week for the chart date (i.e. "Monday",
"Tuesday", etc.)
Examples: Name contains “Bush”; Latitude is > 0°N00’; Days to Birthday is < 30; Rating
matches “AA”; Day of Week contains "Sunday"
Note: String comparison types are always case insensitive.
Note: If you wish to test for a range of values, then you must create two conditions
combined with a Boolean operator. For example, to test for times between 9am and 5pm,
you would need to use two conditions combined with an AND operator i.e. Time >= 9am
AND Time < 5pm.
9.5.3.12 Chart Shape

When composing chart search conditions, "Chart Shape" allows you to select...
One of the available chart shapes
Some chart shapes also have a key planet (e.g. "lead" or "handle" planet), in which
case you can also select
A planet as the key planet relating to this shape, or "Any Planet" if you don't mind
which planet is the key one
Examples: Chart contains "Bowl" with Mercury as "Lead Planet" ; Chart contains
"Locomotive" with Any Planet as "Lead Planet"; Chart contains "Bucket" with Sun as
"Handle Planet".
Note: "Chart Shape" searches always include only a standard planet set (Sun, Mon, Mer,
Ven, Mar, Jup, Sat, Ura, Nep, Plu). You cannot change this behavior, as the chart shape
definitions rely on using this fixed set, and would not produce meaningful results with
any less or more points included.
9.5.3.13 Midpoint

When composing chart search conditions, "Midpoint" allows you to select...
"First Midpoint" – consisting of 2 Planets, Points or Cusps (A and B) – any of Solar
Fire’s standard chart points, or any of the 12 house cusps
"Modulus" – any degree value available on the drop-down list, or any other value
typed in by the user
"Orb" – any degree value available on the drop-down list, or any other value typed
in by the user
"Second Midpoint" – consisting of 2 Planets, Points or Cusps (A and B) – any of
Solar Fire’s standard chart points, or any of the 12 house cusps
Also, for Chart Searches only, whether the second midpoint's placement relates to...
The same chart - i.e. the contact occurs between the two midpoints in the charts
being searched (the selected radix chart is not used)
The radix chart - i.e. the contact occurs from the first midpoint in the charts being
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searched to the second midpoint in the selected radix chart
or... for Electional Searches only, whether the second midpoint's placement relates
to...
The transiting chart - i.e. the contact occurs between the two transiting midpoints
(the selected radix chart is not used)
The radix chart - i.e. the contact occurs from the transiting first midpoint to the
second midpoint in the selected radix chart
Example: Mon/Ven contacts Sun/Mer in 90° modulus within 1° orb;
Note: To specify a normal chart point instead of a midpoint, simply ensure that both the
A and B points are the same point.
9.5.4 Creating the List of Search Conditions
In the "Search" dialog box, after composing a search condition (as described in the
previous section) you must add it to the "List of Search Conditions" before the search can
be started.
If you have only a single condition to search for, and the list of search conditions is
empty, then the condition will be automatically added to the list when you click on the
search button.
Otherwise, if you create a search condition, and click on the search button before adding
it to the list, then you will get a warning message reminding you that you have not added
it yet, and allowing you to cancel the search in order to do so, if you wish.
You have the ability to either add your new condition to the end of the list, or to replace
any existing condition on the list with your new condition.
9.5.4.1 Adding, Replacing, Deleting or Clearing Conditions

In the "Chart Search" dialog box, in the "List of Search Conditions"...
>> To add a new condition to the end of the list
1. Compose your new condition using the Search Condition Selection options.
2. Click on the Add button.
>> To replace an existing condition with a new condition
1. Highlight the existing condition you wish to replace.
2. Compose your new condition using the Search Condition Selection options.
3. Click on the Replace button.
>> To clear the list of conditions
Click on the Clear button.
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>> To delete an existing condition
1. Highlight the existing condition you wish to delete
2. Click on the Delete button.
9.5.4.2 Combining Search Conditions with Boolean Logic

In the "Chart Search" dialog box, if you have more than one search condition, then you
must ensure that they are combined using the correct logical (Boolean) operators in the
"List of Search Conditions".
The AND operator requires that BOTH conditions which it links are satisfied in order
to pass the test.
The OR operator requires that EITHER ONE or BOTH conditions which it links may
be satisfied in order to pass the test.
It is also possible to apply a NOT operator, which simply reverses the individual
condition to which it is applied.
>> To apply the NOT operator to a condition
1. Highlight the condition you wish to negate.
2. Click on the Not button.
>> To toggle between the AND or OR operator between two conditions or
bracketed group of conditions
1. Highlight the second condition of the two you wish to act on (or the first condition
of the second group of conditions, if it forms part of a bracket group).
2. Click on the And/Or button.
>> To toggle bracketing on subgroups of conditions
1. Highlight all the conditions you wish to bracket or unbracket together (must be a
sequential group of conditions in the list).
2. Click on the (...) button.
3. If that group is not already bracketed, then it will be bracketed. If it is already
bracketed, then it will be unbracketed.
9.5.4.3 Saving and Restoring Lists of Search Conditions

When you exit from the "Chart Search" dialog, the "List of Search Conditions" is
automatically saved and then redisplayed the next time you return to the same search
screen. However, it is also possible to save and restore lists of conditions to and from
files, so that you can re-use them at any later time without having to re-enter each
individual search condition again.
>> To save the current list of search conditions
1. Click on the Save to File button
2. Either specify a new file name of your choice, or else select an existing file name
to overwrite
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3. Click on the Save button
>> To restore a previously saved set of search conditions
1. Click on the Add from File button
2. Select the required file name
3. Click on the Open button
Note: When you restore a set of criteria, they are added to the end of your existing list.
This is useful if you have stored “snippets” of conditions that you wish to combine.
However, if you prefer to overwrite your existing list, then you must clear the list before
you restore the set of criteria.
9.5.4.4 Selecting the Aspect Set and Pattern Points

When doing a chart or electional search if you intend to use criteria that involve aspects
(In Aspect, At Position, Aspect Pattern), then you can specify which set of aspects you
wish to use. This will determine which individual aspects are available for selection, and
what orbs each aspect has.
In the "Chart Search" dialog...
>> To select which aspects and orbs to use
Click on the > button to the right of the Aspect Set.
This will display the “File Management” dialog box from which an aspect set may
be selected, edited or created. If you intend to use criteria that include an aspect
pattern, then you can specify which chart points to allow as part of the aspect
pattern.
>> To select which pattern points to use
Click on the > button to the right of the Pattern Points.
This will display the “File Management” dialog box from which a point set may be
selected, edited or created.
9.5.5 Running the Search
>> To start the search
Click on the Search button.
You will see a results dialog appear, into which the results are added as the search
progresses.
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9.5.5.1 Working with the Results of a Chart Search

When the Chart Search starts running, the "Chart Search Results" dialog appears.

As the search progresses, the top caption shows the progress, indicating how many
matching charts have been found, how many have been searched, and what percentage
of those searches have resulted in matches.
Each matching chart that is found is added to the main list below, as it is found.
>> To stop the search while it is still running.
Click on the Stop button.
After the search has been stopped, or finishes on its own, the caption on the "Stop"
button changes to "Quit".
>> To preview charts in the results list
Click on the Preview checkbox to toggle it on or off.
When it is checked, whenever you click on a chart in the results list, the chart
preview window will be displayed or updated with the currently highlighted chart.
The Chart preview window may be moved and re-sized according to your
preferences.
>> To resize the width of a column
Use the mouse to drag the column border between any two column headers
or...
Double-click on a column border to make the column automatically resize to fit the
largest item of data that is displayed in that column.

© 2014 Esoteric Technologies Pty Ltd

Advanced Operations

309

>> To edit the column selection and order
Use a right hand mouse click when the cursor is over the column headers.
This will display the "Choose Columns" dialog.

You can select or unselect any of the available columns by either clicking in the
checkbox to the left of the column name, or by using the Show or Hide buttons.
You can change the order of a column by highlighting it and then using the Move Up or
Move Down buttons to re-order it relative to the other columns.
Note: If the selected columns’ widths are cumulatively wider than the displayed width of
the list, a horizontal scroll bar will appear at the bottom of the list, allowing you to scroll
to see the extra columns. Alternatively you can increase the displayed width of the list
by resizing the width of the entire dialog.
>> To copy selected charts from the results list into another chart file
1. Select the required charts (use Ctrl or Shift + Mouse to make multiple selections).
2. Click on the Copy button. This will display the "File Manager" with a list of target
chart files.
3. Either select one of the files on the list, or select the Create button to create a new
empty chart file to copy the charts into.
A "Copy Charts" dialog box will be displayed, giving the options of copying all of the
selected charts without confirmation, of being asked for confirmation of the copying of
each individual chart, or of canceling the copying process. If the Yes button is selected
then, for each selected chart in sequence, a dialog box will be displayed asking whether
or not that individual chart should be copied. If the No button is selected then all of the
selected charts will be copied immediately. If the Cancel button is selected then no
charts are copied.
Note that when charts are copied to another chart file, any chart comments and events
that are associated with the charts are copied as well, provided that the destination
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chart file is of a format that can store these.
>> To email charts in the results file
Select the Email button and from the drop-down menu select either the All Charts…
option or the Selected Charts… option.
You will then see the Email Charts dialog with various options for sending the
charts by email. See ??? for more information about this dialog.
>> To print a chart details summary of charts from the results list
The summary may be printed at three different levels of detail...
"Brief Listing" - Each chart occupies a single line of output, and contains only the
essential details that would be required to recast the chart: Name, date, time,
timezone, latitude and longitude.
"Full Listing" - Each chart occupies two lines of output, and contains the same
information as the brief listing plus the coordinate system (geocentric/heliocentric),
zodiac type, house system, place name and country/state.
"Full with Comments" - The details of each chart occupy two lines of output,
containing the same information as the full listing, and any chart comments that are
associated with the chart occupy additional text lines below the chart details.
1. Select the Print button and from the drop-down menu select either the All Charts…
or Selected Charts… option.
2. Select the Print button again and from the drop-down menu select one of the
listing options Brief Listing, Full Listing or Full with Comments.
3. The “Print” dialog box will appear, from which you can alter printer settings, add
this job to the print queue, or print it immediately. See Printing from Solar Fire for
further information on printing.
>> To open a selected chart in the Chart Database screen
Double-click on the selected chart
Or...
1. Highlight the required chart by clicking on it.
2. Click on the Open button and choose the option to open the chart file.
>> To open selected charts and add them to the main list of "Calculated Charts"
1. Select the required chart or charts (use Ctrl or Shift + Mouse to make multiple
selections).
2. Click on the Open button and choose the option to add the charts to the list of
"Calculated Charts".
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9.5.5.2 Working with the Results of an Electional Search

When the Electional Search starts running, the Electional Search Results dialog appears.

As the search progresses, the top caption shows the progress, indicating how many
matching periods have been found, and what percentage of the time searched has
resulted in a match. Each matching period that is found is added to the main list below,
as it is found.
There are three types of events listed...
Enters - this gives the date and time after which the search condition (or combined
search conditions if more than one) become satisfied.
Leaves - this gives the date and time after which the search condition (or combined
search conditions if more than one) are no longer satisfied.
Is Exact - this gives the date and time on which the search condition (or one specific
search condition if more than one) is exact. This entry is preceded by a number in
square brackets e.g. [1], [2] etc. The number inside the brackets refer to which
particular one condition in the list of conditions is exact, according to the order in
which they are specified. For example, if you have searched for (Jup Cnj Sat and Mar
Opp Sat) then "[1] Is Exact" refers to (Jup Cnj Sat) and "[2] Is Exact" refers to (Mar Opp
Sat).
Note: "Is Exact" events only appear for those types of conditions which can be
considered to have exact hits, rather than just having a period of time during which
they are in orb or in effect. The only types of conditions which do have exact events
are...
In Aspect - this has an exact event when the aspect orb is zero, in addition to Enters/
Leaves events when entering or leaving orb according to the orbs specified in the
aspect set.
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At Position - this also has an exact event when the aspect orb is zero, in addition to
Enters/Leaves events when entering or leaving orb according to the orbs specified in
the aspect set.
Coordinates - if the search condition uses a "Comparison Type" of "=" (equals) then
this only produces exact events. If the search condition uses a "Comparison Type"
involving greater than or less than operators, then it only produces Enters/Leaves
events.
All others types of conditions - can produce only Enters/Leaves events.

>> To stop the search while it is still running.
Click on the Stop button.
After the search has been stopped, or finishes on its own, the caption on the Stop
button changes to Quit.

>> To preview charts in the results list
Click on the Preview checkbox to toggle it on or off.
When it is checked, whenever you click on a chart in the results list, the chart preview
window will be displayed or updated with the currently highlighted chart. The Chart
preview window may be moved and re-sized according to your preferences. See
Current Chart Preview for more information about the Chart Preview dialog.
You can also click on the Dial checkbox to toggle it on or off. If it is on (ticked) then a
Dial or BiDial will be displayed in the preview window instead of a UniWheel or
BiWheel. The dial will have all the Dial Pointer features available to use (see Using
Dials and Pointers).

>> To resize the width of a column
1. Use the mouse to drag the column border between any two column headers, or
2. Double-click on a column border to make the column automatically resize to fit the
largest item of data that is displayed in that column.

>> To refine the search within one of the periods found
1. Highlight either the entering or leaving line of a found matching period.
2. Click on the Refine button.
This will re-open the Electional Search dialog, with the start and end dates and times
set to the these entering and leaving times. This allows you to easily perform a
further search within this time period.
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>> To view one of the entering, leaving or exact events in the animation module
1. Highlight a line on the list of matches (either entering, leaving or exact)
2. Click on the Animate button.
This will open the animation screen displaying a chart set the date and time of the
selected event. You can then step the chart forward or backward through time as you
desire.

>> To copy the results to the clipboard as text
Click on the Copy button.
This will copy the search results to the clipboard as text. You can then paste the
contents of the clipboard into another application (such as a word processor), where
you can edit or print it, for example.

>> To open selected entering or leaving events and add them as "Calculated
Charts" on the Main Screen
1. Select the required rows in the list of matches (use Ctrl or Shift + Mouse to make
multiple selections).
2. Click on the Open button.

9.6

Editing a Wheel Design File
This section describes how to edit files that contain wheel or dial designs which may be
used in Solar Fire’s chart or dial displays and printouts.
>> To edit a particular wheel or dial design
From the Chart Options menu select one of the Wheel Styles or Dial Styles options
or...
On the "View Chart" window select the Wheel Style or Dial Style button -which
button is available depends on whether you are viewing a wheel or a dial ( to view a
dial see Using Dials and Pointers).
or...
From the "File Manager", select the required file from the list of file names, and
select the Edit button
>> To start up the wheel designer directly from Windows
Click on the Start button, then on All Programs, Esoteric Technologies, Solar Fire
v9, Wheel Designer.
If you have started the wheel designer via Solar Fire’s "File Manager", then when the
screen first appears, the current design file will be open. You may simply wish to
examine or edit this file, but you may also use the available menu options to open and
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edit other wheel or dial design files or to create new ones.
The displayed wheel or dial is not that of a true chart - its planetary positions are
fictitious and fixed, and are shown purely for convenience of getting a rough idea of how
the design will look when used with a real chart. In order to see the design with a real
chart, you will need to use it in Solar Fire to display a chart.
9.6.1 Creating a New File
In the "Wheel Designer" ...
>> To create a new wheel or dial design file
Select the New option from the File menu.
If you have made any changes to the current file, then you will be prompted to save
them before a new file is opened. When a new file is opened, it contains a basic
wheel design. You must edit this design and then save it under a new name.
9.6.2 Opening an Existing File
In the "Wheel Designer" ...
>> To open an existing wheel or dial design file
Select the Open option from the "File" menu.
If you have made any changes to the current file, then you will be prompted to save them
before a new file is opened. When you select this option, you will be presented with a
file open dialog box from which you must select the required file. Solar Fire wheel design
files have the file extension .wh1, .wh2, .wh3, .wh4, and dial design files have the
extension .di1, .di2, .di3, .di4. This final digit in the extension indicates how many charts
are included in the wheel or dial e.g. .di3 is dial design with three concentric charts. It is
only possible to open files of one of these types. If you attempt to open a file of a
different type, then a message will be shown indicating that the file cannot be read.
9.6.3 Saving a File
In the "Wheel Designer"...
>> To save the design that you have entered or edited
Select the Save or Save As option from the File menu.
The Save option will save any changes that you have made using the existing file name.
If there is no file name (i.e. if it is a new file), then this option will prompt you to enter a
name before it is saved. This option will automatically provide the appropriate file
extension for your design e.g. if you are saving a biwheel design, then it will be given the
extension .wh2. The Save As option prompts you for a name to save the file as.
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9.6.4 Editing the Wheel Design properties
Each wheel or dial design consists of a number of objects (wheel/dial components), and
all objects have properties (characteristics) that you can change. An object's properties
can have various values that determine how the wheel or dial looks when it is used in
Solar Fire. The wheel itself is an object, as are any items that appear in the wheel, such
as circles, signs, aspects etc.
All object properties initially have a default value set when a new object is added to the
wheel or dial you are creating or editing, but all object properties can be changed to a
different value. Most properties have only a few pre-defined values that you can change
(e.g. True or False), while a few other properties have a great range of possibilities for
the value which you can decide to give them (e.g descriptions, names of files etc).
The objects and properties in a wheel or dial design are...
General Properties - items that relate to the whole design
Circles - circles defining rings in which other objects are placed (up to 20)
Planet Rings - positions of planet and angle text (1 for each chart)
Extra Point Rings - positions of additional points and angle text (1 for each chart).
These points are those that can be selected in the “Extra Ring Points” option of the
Solar Fire Options menu.
House Lines - lines delimiting house cusps (up to 2 per chart)
Cusp Annotation - glyphs and text for each house cusp (up to 2 per chart)
House Numbering - identification of house numbers (up to 2 per chart)
Zodiac/Dial - zodiacal annotation or dial annotation (up to 2 per chart)
Aspect Lines - lines showing aspects in a chart or between two charts
The values of the properties for any of these objects may be set by choosing the required
object from the drop-down list box at the top right of the screen, and then editing the
values of the individual properties which appear in the list below the drop-down box.
The radius of the Circles may also be altered by using drag-and-drop operations with the
mouse directly on the displayed wheel.
>> To alter any property for an object
1. Select the required object from the drop-down list box
2. Click on the required property in the property list
This will cause the value of that property to be displayed and highlighted in the
editing box at the top of the property list. Depending on the type of property, it is then
possible to select a new value by one for the following methods...
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a) Type a new value into the editing box (any property)
b) Select an entry from the drop-down list of possible values (only for properties
with a pre-defined list of possible values, e.g. True/False, Solid/Dashed/Dotted,
etc.)
c) Select a color from the palette by clicking on the > button (only for color
properties)
9.6.4.1 Common Property Types

Common types of properties in the "Wheel Designer"...
LineStyle - Possible values are Solid, Dash, Dot, Dash-Dot, Dash-Dot-Dot. However,
this property is only applicable if the LineWidth is 1. If the LineWidth is greater, then
the line is always Solid, regardless of the value of this property.
LineWidth - This must be in the range 1 to 5. Note that if it is greater than 1, then the
LineStyle is always displayed as solid, regardless of the value of the LineStyle property.
Color - This may be any of several million colors, although the exact color that is used
when the wheel is displayed or printed depends on the color capabilities of your
computer display or printer. The drop-down list of values contains a list of only the 16
main solid colors. If you wish to use any other color, then you must select the > button,
and use the color selection dialog to find or define the color that you want. Note that
where the color property relates to a line, the nearest solid color to the selected color
is always used.
Inner & Outer Circle - These must have values from 0 to the number of circles in the
wheel or dial design, and they define a ring (i.e. the region between these two circles)
in which the object is placed. The circles are always arranged with circle 1 outermost,
and increasing in number to the innermost circle. If you delete any circles after setting
this property, then these values may be automatically altered to ensure that they refer
to existing circles. Setting one or both of these values to 0 will prevent that object from
being included in the chart. For example, setting the house numbers inner and outer
circles to zero ensures that no house numbers will be displayed.
Lengths & Widths - These properties are used to define the length and width of
various items such as tick marks and arrowheads. They must be between 0 and 1, as
they are always relative to the radius of the outermost circle e.g. a value of .1 would
produce an arrow head width or length 1/10th of the radius of the circle, or a value of
.02 would produce a tick mark 2/100ths of the radius of the circle.
9.6.4.2 General Properties

General types of properties in the "Wheel Designer"...
House Anchor Chart - This must have a value between 1 and the number of charts in
this design. It indicates which chart’s house cusps will be used for multi-wheel
displays. This is usually set to 1, indicating that the houses of the innermost chart will
be used. In a three chart wheel, setting this to 2 would indicate that the middle chart’s
houses would be used, and setting it to 3 would indicate that the outermost chart’s
houses would be used.
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Thin Printer Lines - This must be either True or False. When it is false, then when the
design is printed it will have lines that are approximately the same thickness as on the
screen design. When it is true, then the printed lines are somewhat thinner than the
screen lines. Typically the printed chart looks better when this is set to True.
Dial Degrees - This must be a number from 10 to 360, indicating the number of
degrees shown in the wheel. If the number is less than 360, then this design is
considered to be a dial. If the number is 360, then this design is considered to be a
wheel, provided that the glyph type in the zodiac ring is not set to degrees.
Fixed Anchor - This must be either True or False. It indicates whether or not the wheel
or dial is fixed at a particular angle, rather than having the anchor chart’s ascendant
fixed on the left of the chart. Normally it should be set to false for a wheel display and
to true for a dial display. When set to true, the chart is fixed at the angle specified in
the anchor degrees property.
Anchor Degrees - This must be a number from 0 to 360. It specifies at what angle the
wheel or dial is fixed. For example, setting this to 0 ensures that the 0 degree point on
the chart is fixed at the left of the wheel. Similarly, 90 fixes the 0 degrees point of the
chart to the top of the wheel, 180 to the right of the wheel, and 270 to the bottom of
the wheel. For a dial, this should normally be set to 90, putting the origin at the top of
the dial. This option is ignored if the Fixed Anchor property is false.
9.6.4.3 Circles

Circle properties in the "Wheel Designer"...
Radius - This must have a value between 0 and 1. It indicates the radius of the circle
relative to the outermost circle in the design. If it has a value of .6, for example, then
this circle would have a radius 6/10ths of the size of the outermost circle. The radius
of circle number 1 is always set to 1, and cannot be changed. If you wish to design a
chart that is smaller than the standard size, then you should make circle 1 invisible,
and ensure that the other wheel design objects are placed between other smaller
circles. Instead of typing in a value here, it is possible to use the mouse to drag-anddrop the circle radius to its required size.
Visible - This must be either True or False. If this property is false, then it will not be
visible when displayed or printed in Solar Fire. However, for the sake of clarity, it is
always displayed in the wheel designer regardless of the value of this property.
LineStyle - The line style that is used for this circle. Ignored if circle is not visible.
LineWidth - The line width that is used for this circle. Ignored if circle is not visible.
LineColor - The line color that is used for this circle. Ignored if circle is not visible.
Fill Circle - This must be either True or False. If this property is true, then the FillColor
will be used to fill the entire region from this circle inwards. If you wish the fill color to
end at another circle, then you must set that circle’s Fill Circle property to True and set
its FillColor to White.
Fill Color - This defines the color that will be used to fill this circle if the Fill circle
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property is true. Ignored if circle is not visible.
9.6.4.4 House Lines

House line properties in the "Wheel Designer"...
Inner & Outer Circle - These define the circles between which the house lines will be
drawn.
Angular & Other LineStyle - These define the line style used for the house cusp lines.
Angular lines are those of the 1st, 4th, 7th and 10th house cusps.
Angular & Other LineWidth - These define the line width used for the house cusp
lines.
Angular & Other LineColor - These define the color in which the house cusp lines are
drawn.
Arrow on 10th & 1st - This must be either True or False. If this property is true, then
an arrowhead is drawn at the outer end of the 10th or 1st house cusp lines.
Arrow Width & Length - These define the width and length of the arrowhead, and
must be between 0 and 1. Try values .1 for length and .05 for width as a starting point.
9.6.4.5 Cusp Annotation

Cusp annotation properties in the "Wheel Designer"...
Inner & Outer Circle - These define the circles between which the cusp annotation
will be drawn.
Cusp Style - This must be Normal, Crystal, Teardrop or Lotus. You can see what these
different styles look like by selecting them and redrawing the wheel. Cusp styles other
than normal require a reasonable width between inner and outer circles to look their
best.
Show Interceptions - This must be either True or False. If this property is true, then
sign glyphs for any intercepted signs are displayed as well as the glyphs on the house
cusps. Ignored unless Cusp Style is normal.
Inner & Outer Tick Length - These define the length of tick marks pointing out from
the inner circle and in from the outer circle, and must be between 0 and 1. Try a value
of .02 as a starting point. Set this value to 0 to prevent ticks appearing.
Glyph Visible – This must be one of Sign Glyphs On, No Sign Glyphs, or Sign Abbr On.
The last option forces the sign to be displayed as a two-letter abbreviation instead of
as an astrological glyph.
Degrees, Minutes Visible - This must be either True or False. If this property is false,
then the degree text or minute text on each house cusp will not be displayed. For
example, you might like to display only the degree number on each cusp, in which case
you should set the Minutes Visible property to false.
Glyphs, Degrees, Minutes FontSize - This allows you to choose in what font size this
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item should be displayed. Ignored if not visible.
Glyphs, Degrees, Minutes Bold - This must be either True or False. This allows you to
choose whether this item should be displayed in a normal font if false, or a bold font if
true. Ignored if not visible.
Glyphs Italic - This must be either True or False. This allows you to choose whether
the sign glyphs on each house cusp should be displayed in a normal font if false, or an
italic font if true. Ignored if not visible.
9.6.4.6 House Numbering

House numbering properties in the "Wheel Designer"...
Inner & Outer Circle - These define the circles between which the house numbers will
be drawn.
Position Ratio - This must be a number between 0 and 1, defining where the number
is centered between the inner and outer circles. A value of .6 would position the
numbers 6/10ths of the way from the inner circle to the outer circle.
Numbers FontSize - This allows you to choose in what font size this item should be
displayed.
Numbers Bold - This must be either True or False. This allows you to choose whether
the house numbers should be displayed in a normal font if false, or a bold font if true.
9.6.4.7 Zodiac/Dial

Zodiac/Dial properties in the "Wheel Designer"...
Inner & Outer Circle - These define the circles between which the zodiac or dial ring
will be drawn.
Glyph Type - This may be any of the following: None, Vertical, Rotated, Degrees,
Vertical Text Abbr, Rotated Text Abbr, Rotated Degrees, Ruler – Vertical, Ruler –
Rotated, Ruler Abbr – Vertical, Ruler Abbr - Rotated. The ruler options cause the sign
(or decanate if the Division Interval property is set to 10) ruling planet to be displayed
instead of the sign itself. The vertical options display zodiac sign or planetary ruler
glyphs or abbreviations in their normal upright position. The rotated option displays
them rotated according to their position in the zodiac ring, so that their base is always
pointing inwards. The degrees options prevent glyphs or abbreviations from being
displayed, and displays angle text instead.
Note: If the Dial Degrees property is set to anything other than 360 degrees, then
sign or ruler glyphs or abbreviations will not be displayed regardless of the setting of
this property.
Note: If rulers are selected, then the rulership level is determined by the rulership
level setting of this wheel object in the page design. This may be set to the "default",
to use Solar Fire's default rulership level, or it may be set to a specific rulership level.
Fill Signs - This must be either True or False. This allows you to choose whether the
zodiac signs will have their background filled with their colors (as set in Solar Fire). If
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false, then the glyphs or abbreviations will be drawn in their sign colors, but the
background will be unchanged. If true, then the glyphs will be black or white, but the
background of each sign will be filled with its color. Note, however, that in order for
the fill option to work, the individual signs must be fully enclosed with circles on both
sides, and division intervals at either end. If they are not fully enclosed, then the fill
option will not work correctly. (This means that the division interval must be 30
degrees, and the division tick ratio must be 1).
Glyphs Position - This must be a number between 0 and 1, defining where the number
is centered between the inner and outer circles. A value of .6 would position the
numbers 6/10ths of the way from the inner circle to the outer circle.
Glyphs FontSize - This allows you to choose in what font size this item should be
displayed. Ignored if not visible.
Glyphs Bold - This must be either True or False. This allows you to choose whether
this item should be displayed in a normal font if false, or a bold font if true. Ignored if
not visible.
Glyphs Italic - This must be either True or False. This allows you to choose whether
the sign glyphs on each house cusp should be displayed in a normal font if false, or an
italic font if true. Ignored if not visible.
Glyph Widening - This is the ratio between the glyph width and height. A value of 1
ensures that the glyph has its normal appearance. A value of 2 would stretch the glyph
horizontally to be twice its normal width. A value of .5 would shrink the glyph
horizontally to be half its normal width. This option is mainly useful for widening the
glyphs when they are displayed in rotated format.
Division Interval - This must be a number from 1 to 360, indicating at what interval
division markers are placed. For wheels, this should normally be 30, to ensure that the
divisions fall between the zodiac signs, or 10 to ensure that divisions occur between
each sing decanate. (When the glyph type option is set to a ruler, then setting a value
of 30 will ensure that the sign rulers are displayed, whereas 10 will ensure that
decanate rulers are displayed.) For a dial, it should be set to some factor of the dial
degrees e.g. if the dial degrees is 90, then setting this interval to 30 will produce 3
equal divisions in the dial, or setting it to 10 will produce 9 equal divisions in the dial.
Division Tick Ratio - This must be a number from 0 to 1. It indicates how long the
division markers are in relation to the distance between the inner and outer circles. A
value of 1 ensures that the division markers cover the full distance between the two
circles. Use a value of zero to switch off the division markers.
Tick on Inner - This must be either True or False. If true, then all tick marks and
division markers will start from the inner circle and extend towards the outer circle. If
false, then they will all start from the outer circle and extend inwards.
Tick Color - The color that is used for all the division and tick marks.
Large & Small & Tiny Tick Ratio - This must be a number from 0 to 1. It indicates how
long the tick marks are in relation to the distance between the inner and outer circles.
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A value of .2 ensures that the tick marks cover 2/10ths of the distance between the
two circles. Typically the large tick ratio is larger than the small tick ratio, which itself
is larger than the tiny ratio. Use a value of 0 to switch of the tick marks.
Large & Small Tick Interval - Large tick interval must be in the range 1 to 90, and the
small tick interval in the range 1 to 30. These indicate at what intervals the tick marks
are displayed.
Tiny Tick Fraction – This indicates how many tick subdivisions per degree are
displayed. This must be in the range 2 to 10. This option is useful for dials which have
a modulus of say 90 degrees or less, when the interval between degree ticks is quite
large.
Zodiac Type – This must be one of the following: Default, Tropical, Sidereal or
Constellations. The Default option ensures that the displayed zodiac ring uses the
zodiac type of the chart being displayed. The Tropical option ensures that the zodiac
ring displays the tropical zodiac sign positions, regardless of the zodiac type of the
chart being displayed. The Sidereal option ensures that the zodiac ring displays
sidereal zodiac sign positions, regardless of the zodiac type of the chart being
displayed – in this case Solar Fire’s default sidereal zodiac type used is. The
Constellations option makes the zodiac ring display the astronomical constellation
boundaries (giving uneven sign lengths and including a 13th division for the
constellation Ophiuchus). Note: If you include more than one zodiac ring for a chart,
then you can choose different zodiac types for each, so that you can see both tropical
and sidereal sign positions in the same chart, for example.
9.6.4.8 Aspect Lines

Aspect line properties in the "Wheel Designer"...
From & To Circle - These define the circles between which the aspect lines will be
drawn. Usually aspect lines are drawn to different points on the same circle. In this
case both these should be set to the same circle number.
From & To Chart - These must be in the range 1 to the number of charts in the current
wheel. These define the charts between which the aspect lines will be drawn. Usually
aspect lines are drawn to different points in the same chart. In this case both these
should be set to the same chart number. If they are set to different chart numbers,
then you will see aspects between those two charts.
From & To Tick Ratio - These must be numbers from 0 to 1. They indicates how long
the tick marks are in relation to the distance between the inner and outer circles. Use
a value of zero to switch off the tick marks.
From & To Tick Width - This is the line width used to draw the tick marks at the
planetary positions on the circle. Aspects are drawn to the end of these tick marks
instead of to the circles, unless the tick ratios are zero.
9.6.4.9 Planet Rings and Extra Ring Points

Planet ring/Extra ring properties in the "Wheel Designer"...
Inner & Outer Circle - These define the circles between which the zodiac or dial ring
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will be drawn.
Glyph, Degree, Sign, Minute, Retro Position - These must be numbers from 0 to 1.
They indicate where each item is positioned relative to the inner and outer circles. A
value of 0.25 positions it 1/4 of the way from the inner to the outer circle, and a value
of .75 positions it 3/4 of the way. If this value is set to 0, then this item is not
displayed. For example, if you wish to display only the glyph, degree text and zodiac
sign, then assign them non-zero values, but give zero values to the minute and retro
positions.
Glyphs, Degrees, Minutes FontSize - This allows you to choose in what font size this
item should be displayed. Ignored if not displayed.
Glyphs, Degrees Bold - This must be either True or False. This allows you to choose
whether this item should be displayed in a normal font if false, or a bold font if true.
Ignored if not displayed.
Glyphs Italic - This must be either True or False. This allows you to choose whether
the sign glyphs on each house cusp should be displayed in a normal font if false, or an
italic font if true. Ignored if not displayed.
Inner & Outer Tick Length - These must be numbers from 0 to 1. They indicate how
long the tick marks are in relation to the distance between the inner and outer circles.
Use a value of zero to switch off the either of these sets of tick marks.
Tick Width - This is the line width used to draw the inner and/or outer tick marks at
the planetary positions on the inner and outer circles. Ignored if the tick lengths are
zero.
Glyphs as Text – This must be either True or False. If false, then planets are shown as
glyphs. If true then planets are shown as three-letter abbreviations.
Signs as Text - This must be either True or False. If false, then signs are shown as
glyphs. If true then signs are shown as two-letter abbreviations.
9.6.5 Adding a New Circle
In the "Wheel Designer" it is possible to have up to 10 circles in a wheel or dial design.
>> To add a new circle to the design
1. Select the Add Circle item from the Edit menu
2. Click on the wheel at roughly the required radius for the new circle
You can adjust the radius of the circle after it is added either by drag-and-drop with the
mouse, or by setting its radius property in the property list for the circle.
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9.6.6 Deleting a Circle
In the "Wheel Designer"...
>> To delete an existing circle in the design
1. Select the required circle by clicking near it, or select the required circle from the
drop-down list of objects
2. Select the Del key or select the Delete Circle item from the Edit menu
If the deleted circle was referenced by any objects, then those references will be
automatically updated to refer to other existing circles.
9.6.7 Adding a New Chart
In the "Wheel Designer" it is possible to have up to four charts in a wheel or dial design.
>> To add a new chart to the design
1. Select the Add Chart item from the Edit menu
2. Click on the wheel between two circles where you wish that chart’s planets to be
placed
You can adjust the planet positions, the circles used and other properties after it is
added.
9.6.8 Deleting a Chart
In the "Wheel Designer" you cannot delete the chart that is the single remaining one.
>> To delete another chart in the design, do one of the following
1. Select the required chart’s planets from the drop-down list of objects, and then
select the Del key
2. Select the Delete Chart item from the Edit menu, and then click on the wheel
between two circles where that chart’s planets are placed
9.6.9 Setting All Line Colors
In the "Wheel Designer" sometimes you may wish to create a chart with colored circles,
cusp lines etc. You can do this by editing the color properties of each object of the
design. However, you can also set all the lines colors at once, if you prefer.
>> To set all the wheel's line colors to a selected color
1. Select the Set All Line Colors item from the Edit menu
2. Select the required color from the color selection dialog.
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9.6.10 Editing the Wheel Description
In the "Wheel Designer" a description of a wheel or dial design is displayed at the top
left of the design screen, but is not displayed when the wheel or dial is displayed or
printed in Solar Fire. In Solar Fire, its only purpose is to help you select a wheel or dial
design file from the list of available designs. These descriptions are listed in Solar Fire’s
"File Manager" when you invoke the Wheel Styles or Dial Styles items from the
Preferences menu.
>> To edit the description of the current design
1. Select the Wheel Description item from the Edit menu.
2. Enter or edit up to 80 characters of text.

9.7

Editing a Page Design File
It is possible to infinitely customize what is seen on Solar Fire’s Chart Viewing screen from viewing a single chart, to viewing several charts at once, or viewing a large variety
of tables, grids and graphics in addition to charts.
Solar Fire is shipped with a range of pre-designed pages from which the user may
choose. However, if you cannot find a page that suits your requirements, you have the
option of editing an existing page design or of creating an entirely new page design from
scratch.
A page design can be optimized for viewing on any screen size, as well as for printing on
any standard paper size, whether in portrait or landscape orientation.
A single viewable page can contain information on up to 12 individual charts, displayed
in any combination (e.g. 12 single wheels, 6 biwheels, 3 quadriwheels, 6 biwheels plus 6
synastry grids etc).

9.7.1 Opening the Editing Screen
>> To open the "Page Designer"
From within Solar Fire
From the View menu select Page Topic Index, click on the name of a page design
file and select the Edit button. The Page Designer will appear, displaying the
selected page.
or...
From the "Utilities" menu select Page Designer. The Page Designer will appear,
displaying a new blank page.
Note: if you remove this menu entry from the "Utilities" menu then naturally this
option will not be available.
From outside Solar Fire
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Click on the Start button, click on All Programs, click on the Esoteric Technologies
folder, click on the Solar Fire v9 subfolder, and finally click on the Page Designer
icon. The Page Designer will appear, displaying a new blank page.
9.7.2 Selecting Files to Edit
You can either create new page design files or modify existing ones. Usually it is easier
to select the page design that is closest to what you want and then modify it. To save
the new design and also keep the original design intact, you would then use the Save As
option instead of Save.
>> To select a different file without leaving the "Page Designer"
From the "Page Designer" editing screen select the Open menu item from the"File"
menu.
A standard file opening dialog box will appear, allowing you to select a folder and file
name of an existing page design file. This will initially list all the page design files
(*.pag) in Solar Fire’s Pages sub folder of its main User Files folder. You should not
normally change this folder, as Solar Fire requires its user-defined pages to remain in
this folder.
To select any file that is listed, either highlight the name of the file and then choose the
OK button, or just double-click on the file name. If you have made any changes to the
existing page design, then you will be asked if you wish to save it. The editing screen
will reappear, showing the newly selected page design.
>> To create an entirely new file
From the "File Management" dialog box select any page design file and click on the
Edit button. Then select the New menu item from the "File" menu.
or...
From outside Solar Fire - click on the Start button, click on All Programs, click on
the Esoteric Technologies folder, click on the Solar Fire v9 sub folder, and finally
click on the Page Designer icon. The Page Designer will appear, displaying a new
blank page.
9.7.3 The Editing Process
Each page design consists of a collection of objects (wheel/dial components), and all
objects have properties (characteristics) that you can change. The page itself is an
object, as are any items that appear on the page, such as a chart wheel, aspect grid,
tabulation of aspects etc.
>> To select an object for editing
Any object can be selected by clicking on it. If the object cannot be selected by
clicking on it (for example if it is behind another object), then it can be selected from
the drop-down list of objects. When an object is selected, red editing bullets will
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appear around its perimeter, and its properties will be listed in the property display
list, ready to be selected and edited. The page object can be selected by clicking on
any vacant area of the page, and in this case editing bullets do not appear.
>> To bring an object to the front or back of the display order
If two objects overlap one another, then you can move one of them to the front or
back by selecting it, and then choosing the Move to Front or Move to Back menu
item from the Object / Order submenu. This will also alter the order in which the
objects are drawn when they are displayed in Solar Fire. Items at the back are drawn
first, and items at the front are drawn last. This feature can be useful if you want to
display a graphic that overlaps another page object, for example a graphic in the
center of a chart wheel. If you move the graphic to the front of the display order, then
it will always be drawn on top of the chart wheel, thus obscuring any aspect lines that
may appear in the middle of the chart. Reversing the order will cause the aspects
lines to be drawn over the graphic, so they will remain visible.
You can find the current display order of all the objects by browsing through the list of
objects in the drop-down list of objects. The items at the top of the list are drawn first
(at the back), and items at the bottom of the list are drawn last (at the front).
>> To insert a new object
Choose the Add New Object menu item from the Object menu.
This will display the New Object dialog that allows you to select and preview the
shape of any of the available object types. A description of each object appears in the
text box beneath the list when any object name is selected. When you have found the
required object, highlight it and click on the Insert button, or simply double-click its
entry in the list. The new object will be placed onto the page as the currently selected
object, with its properties displayed ready for editing.
>> To make a copy of an existing object
1. First select the object that you wish to copy.
2. Choose the Create Copy of Object menu item under the Object menu.
The new object will be placed onto the page as the currently selected object, with its
properties displayed ready for editing.
>> To move an object with the mouse
1. First select the object by clicking on it
2. Drag the object with the mouse button held down. Releasing the mouse button will
cause the object to become fixed at its new location.
Note: It is also possible to move an object by typing in new AnchorX and AnchorY
property values.
>> To position an object relative to the page
Highlight the required object and select one of the options from the Object /
Position submenu.
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The available positioning options are...
At Left
Centre Horizontally
At Right
At Top
Centre Vertically
At Bottom
Each of these options positions the object relative to the page margins e.g. "At Left"
will move the object so that its left edge lines up with the pages' left margin.
>> To align an object with another object
1. Highlight the object that you want to move and select one of the options from the
Object / Align sub-menu
2. Then click on the object with which you wish to align it.
The available alignment options are...
Lefts
Centres Horizontally
Rights
Tops
Centres Vertically
Bottoms
Each of these options positions the object relative to the next object you click on
e.g. "Lefts" will move the object so that its left edge lines up with the left edge of
next object you click on.
Note: After you have selected the alignment option, the object to be aligned is
shown with green editing bullets instead of the normal red ones. This is a visual
reminder of which object will be moved.
>> To resize an object
1. First select the object by clicking on it.
2. Then position the mouse over one of the red editing bullets, and drag the bullet
with the mouse button held down. Releasing the mouse button will cause the
object to become resized.
Note: If the object that you are resizing is text based (i.e. if it has a "Font Size"
property), then the object will be resized to use the largest font size available which
will fit inside the new size that you have specified. This means that the object will
often end up slightly smaller than you specified. It is also possible to resize these
objects precisely by selecting a new Font Size property value.
© 2014 Esoteric Technologies Pty Ltd

328

Solar Fire 9 User Guide

>> To edit the properties of a selected object
1. First select the required object by clicking on it. Its properties will then be listed in
the property display list, ready to be selected and edited.
2. Any property may be selected by clicking on it, and this property entry will become
highlighted, and the value of this property will appear in the editing box. Some
properties have numerical values, some have text values, and some can be
selected from drop-down lists or file selection dialogs.
Numerical Values - eg "AnchorX"; This can be typed directly into the editing box
Text Values - eg "ListAbbrev"; This can be typed directly into the editing box
Font Sizes, True/False, Justification values, Rulerships - These can be selected
from the drop down list by clicking on the button to the right of the editing box
File Names - e.g. "Points File"; This can be selected by clicking on the > button to
the left of the editing box
Whenever a property is selected, some descriptive text appears in the text box
underneath the properties list. This gives a description of what type of value is
expected for this property, and may give additional hints.
9.7.4 Description of Objects
These topics describe the various objects you can use on a page.
9.7.4.1 Captions

Chart Details

This is an unboxed segment of text which shows all the details of the chart including its
placement, name, type, date, time, timezone, place, latitude and longitude, coordinate
type, zodiac type, house system, node type (and, if switched on, lunar parallax).
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Chart Details+

This is the same as the Chart Details object, but with the addition of the chart rating and
source comments, if any.
Chart Details - Boxed

This shows all the chart details formatted into a rectangular area, optionally inside a
frame.
Chart Details - Brief

This shows the same main chart details as the full Chart Details object, but excludes
coordinate type, zodiac type, house system, node type etc.
Chart Title

This shows only the chart placement, chart name and type.
Chart Name

This shows the chart name only, optionally inside a frame.
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Chart Placement

This shows the chart placement (e.g. Chart 1, Upper Chart, Across Grid etc..), optionally
inside a frame.
Compliments

This displays the current compliments text, provided that the user has not chosen to hide
compliments text in the Preferences dialog. See Compliments.
User Caption Line

This displays up to 20 characters of user-supplied text
Page File Name

This shows the name of the currently displayed page file (without path name).
Page Description

This shows the description that has been saved with the current page file.
Program

This shows the name of the program – Solar Fire
Version

This shows the program name and current version number.
Date/Time Stamp

This shows the date and time at which the current page was displayed or printed.
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Copyright

This shows a copyright notice.
Chart Comments

This is a sizable box that displays any chart comments that are currently stored for the
selected chart. If there are no comments stored, then the box remains empty. If there are
more comments then can be fitted into this box at its selected font size, then the text is
truncated accordingly.
Superimposition Caption

This displays a caption indicating what type of superimposition option the user has
selected. If no superimposition option has been selected, then it remains blank. It is
intended that this object be placed onto pages with multi-wheels, so that the user can
easily see when the charts in the wheel have been superimposed in any way other than
the normal zodiacal way. If this page object is absent, then the user has no way of
knowing when a superimposition option has been selected, and may be misled. For more
information on the superimposition options, see Multiwheel Superimposition.
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9.7.4.2 Chart Wheels

Uniwheel

This is a single chart wheel or dial, the style of which is user selectable.
BiWheel

This is a concentric two-chart wheel or dial, the style of which is user selectable.
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TriWheel

This is a concentric three-chart wheel or dial, the style of which is user selectable.
QuadriWheel

This is a concentric four-chart wheel or dial, the style of which is user selectable.
QuinquiWheel
This is a concentric five-chart wheel or dial, the style of which is user selectable.
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Traditional Chart

This displays a traditional style chart with triangular houses. Various options such as
glyph sizes, line styles and background colors can be altered by editing the
SQUARE1.WH1 wheel design file. (Note that the SQUARE1.WH1 wheel design file
appears as a round wheel in the wheel designer.)
Traditional Chart 2

This displays a traditional style chart with square cardinal houses, and triangular other
houses. Various options such as glyph sizes, line styles and background colors can be
altered by editing the SQUARE1.WH1 wheel design file. (Note that the SQUARE1.WH1
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wheel design file appears as a round wheel in the wheel designer.)
9.7.4.3 Aspect Grids

Full Grid

This is a single chart aspect grid, half of which shows longitudinal aspects, and the other
half shows aspects of declination.
Half Grid

This is a single chart aspect grid showing longitudinal aspects only.
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Synastry Grid

This grid shows aspects of longitude between planets in any two charts.
9.7.4.4 Planets

Points List – Flexible

This object lists data for each displayed point of a chart. Individual columns may be
switched on or off, and their ordering changed by choosing the Edit / Flexible List
Columns menu item when this object is selected. The columns available are:
Pt - Point’s glyph or symbol
Abbr - Point’s abbreviation
Name - Point’s full name
Longitude (Mins) - Zodiacal longitude, given to minutes of arc
Longitude (Secs) - Zodiacal longitude, given to seconds of arc
Longitude (Mins) & Retro. - Zodiacal longitude and retrograde symbol, given to
second of arc for Sun, Moon and chart angles, and to minute of arc for other points,
along with a retrograde flag if required.
Longitude (Secs) & Retro – same as above, but values given to second of arc for all
points.
Travel - Daily travel in longitude (to mins arc if speed 1 deg/day or more, or to secs
arc if less then 1 deg/day)
Relative Speed - percentage of typical speed
Fast/Station/Slow - Shows "Station" if within orb of a station, otherwise "Fast",
"Slow" or "Retro" if it is faster than, slower than typical speed, or retrograde,
respectively.
Time Since Last Station - Time elapsed since last station
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Time To Next Station - Time to go until next station
Position of Last Station - Zodiacal position of last station
Position of Next Station - Zodiacal position of next station
Distance From Last Station - Zodiacal distance from last station
Distance To Next Station - Zodiacal distance to next station
Latitude (Mins) - Zodiacal latitude, given to minutes of arc
Latitude (Secs) - Zodiacal latitude, given to seconds of arc
Right Ascension (Mins) - Right ascension, given to minutes of arc
Right Ascension (Secs) - Right ascension, given to seconds of arc
Declination (Mins) - Declination, given to minutes of arc
Declination (Secs) - Declination, given to seconds of arc
Azi. - Local azimuth (0 Degrees is North, 90 is East)
Alt. - Local altitude (+ve above horizon, -ve below)
Sg - Sign placement
Hs - House placement
Rules - Houses ruled by this point
Disp - Dispositor of this point
Hs (Disp) - House placement of dispositor
Modulus - Longitude using specified modulus
NNode - Longitude of point’s north node
NNTrav - Daily travel of north node
SNode - Longitude of point’s north node
SNTrav - Daily travel of north node
Antiscia - Longitude of point’s antiscion
ContraAntiscia - Longitude of point’s contra-antiscion
G.S. - Gauquelin sector of this point (36 sectors)
G+ - Is this point in a Gauquelin plus zone (+ = yes, blank = no)
Orb Ratios - If the current aspect set uses planet or ratios, then this shows the orb
ratio in effect for this point (otherwise it shows “n/a”)
Point’s Long Name – An extra wide column for the name (intended for use with nonstandard points which have longer names such as asteroids, Arabic Parts, stars and
extra ring points, for example)
Point’s Long Abbreviation – A column with enough width for a long abbreviation –
also see comments for long name
Point’s Long Symbol – A column with enough width for multiple symbols characters
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– also see comments for long name
Time of Rising, Culmination, Setting, Anti-Culm. – the local time, expressed in 24
hour format, indicating when the point crosses the local horizon or meridian. If a
point does not cross the horizon during the day, then it will show times for
culmination and anti-culmination, but not for rising and setting. The rising and
setting times are true astronomical times rather than visual times, having no
adjustment for atmospheric refraction. (Note: The rise and set times in the
planetarium are visual times, and therefore differ slightly from the times given
here.)
Point’s Distance – the distance of the point from the earth (for geocentric charts) or
the sun (for heliocentric charts), expressed in Astronomical Units (1 AU = average
Earth/Sun distance).
Co-Rise, Co-Culmination, Co-Set and Co-Anticulmination - the ecliptical longitude
that crosses the horizon or meridian at the same time as the point does. Points that
co-rise at the same ecliptical longitude are seen to rise at the same time, even
though they may be at different places along the horizon, and have different
zodiacal longitudes. Points that share rise, culmination, set or anti-culmination
ecliptical longitudes are said to be in “paran” to one another, which is a type of
mundane aspect.
Abs (Declination) – The absolute value of declination (i.e. the angular difference
from zero, ignoring its sign). This is useful as the sorting value for a tabulation in
order to ensure that both parallels and contra-parallels of declination can be seen
at a glance, because bodies with equal but opposite declinations have the same
absolute value of declination, and appear together in such a list.
Placidus Mundoscope – the position occupied by each point along its own diurnal
arc, expressed as a pseudo-angle. 0° = Eastern Horizon, 90° = Anti-culminating, 180°
= Western Horizon, 270° = Culminating. (This is similar to the Gauquelin sector
measurement, except that it runs in the opposite direction and is expressed as an
exact angle instead of as a sector number.)
Prime Vertical Angle – the position occupied by each point along the prime vertical,
expressed as an angle (analogous to azimuth).
Prime Vertical Amplitude – the position occupied by each point perpendicular to the
prime vertical, expressed as an angle (analogous to altitude).
Arabic Mansion (Tropical) – The number and name of the Arabic Mansion into which
each point falls, based on the tropical zodiac.
Arabic Mansion (Sidereal) – The number and name of the Arabic Mansion into which
each point falls, based on the default sidereal zodiac.
Nakshatra – The number and name of the Nakshatra into which each point falls.
Chinese Lunar Mansion – The number of the Chinese Lunar Mansion into which
each point falls. These mansions are divisions in right ascension, the boundaries of
which are defined by the positions of certain fixed stars.
Asteroid List – Flexible
Arabic Parts List – Flexible
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Star List – Flexible
Extra Bodies List – Flexible
Ring Points List – Flexible
These all have the same column options as the “Points List – Flexible” object, shown
above. It is recommended that the long name, abbreviation and symbol columns be used
for these object rather than the standard Pt, Abbr, Name columns, in order to allow for
the fact that these items have longer names than the standard chart points. Also note
that not all columns will contain data when used for these types of points. For example,
the Star List does not show any data in the Point’s Distance column, and shows zero
values in the Travel column.
Extra Points
This shows a list of extra ring points. It has been superseded by the “Ring Points List –
Flexible”, and remains only for backwards compatibility.
Astrodynes - Planets
This shows astrodyne scores for each point, giving the overall power score, the %
contribution towards the total power score, and a Harmony/Disharmony score.

Nearest Eclipses

This shows a list of eclipses from 6 months before to six months after the date of the
chart, showing whether they are solar or lunar, their type (partial or total), the date and
time at which they occur (in the time zone of the selected chart), and their zodiacal
position. The times are for either maximum eclipse or for the exact corresponding lunar
phase, depending on the eclipse settings in Preferences.
Lunar Phases
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This shows a list of lunar phases (new moon, 1s t quarter, full moon, 3rd quarter) around
the date of the chart. It lists their dates and times (in the time zone of the selected
chart), the zodiacal position of the moon, and also shows an eclipse glyph if one occurs
on that lunar phase. This list is expandable by changing the number of data lines. The
list always contains at least one phase after the time of the chart, and up to four before
the time of the chart. If the number of data lines is increased to eight or more, then the
phases are split evenly between prior and subsequent lunar phases.
9.7.4.5 Signs

Sign Names

This object lists the name corresponding to each sign glyph.
Astrodynes - Signs
This shows astrodyne scores for each sign, giving the overall power score, the %
contribution towards the total power score, and a Harmony/Disharmony score.

Astrodynes - Sign Types
This shows astrodyne scores for each sign type, giving the overall power score, the %
contribution towards the total power score, and a Harmony/Disharmony score.
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9.7.4.6 Houses

House Cusps

This object lists the zodiacal longitude of each house cusp in the chart.
House Almutens

This object lists the planets which are the almutens of each house cusp in the chart,
calculated according to the default dignity scores stored in the file house.alm, which
resides in Solar Fire’s system folder.
Astrodynes - Houses
This shows astrodyne scores for each house, giving the overall power score, the %
contribution towards the total power score, and a Harmony/Disharmony score.
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Astrodynes - House Types
This shows astrodyne scores for each house type, giving the overall power score, the %
contribution towards the total power score, and a Harmony/Disharmony score.

9.7.4.7 Aspects

Aspects - Flexible

This object lists data for each aspect within the current aspect set. Individual columns
may be switched on or off, and their ordering changed by choosing the Edit / Flexible
List Columns menu item when this object is selected. The columns available are:
Asp - Aspect’s glyph
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Abbr - Aspect’s abbreviation
Name - Aspect’s full name
Angle - Angle of aspect
Lum-A, Lum-S, Oth-A, Oth-S - Orb’s for luminaries and other planets, both applying
(A) and separating (S).
Hits, Actual Hits - The actual number of aspects of this type found in this chart, and
an equivalent graphical display.
Likely, Likely Hits - The likely number of aspects of this type to found in this chart,
and an equivalent graphical display. This calculation is based on the assumption of
a random distribution of planets in a chart, so should not be treated as a definitive
value - rather as an indicative value.
Dev, Deviation - The difference between the actual hits and the likely hits,
expressed as a percentage, and an equivalent graphical display.
Synastry Aspects - Flexible
This is similar to the Aspects - Flexible object, but applies to aspects between two given
charts rather than within a single chart.
Nearest Aspects

This object lists aspects within a single chart in order of closeness of orb. Aspects will
not appear in this list unless their orb is within i) the maximum orb specified for this
object, and ii) the maximum orb allowed for that aspect in the aspect set which is being
used. The total number of aspects shown is limited to the number of data lines specified
for this object.
Nearest Synastry Aspects
This is similar to the Nearest Aspects object, but applies to aspects between two given
charts rather than within a single chart.
Aspects of Moon

This object lists aspects from the moon to other planets, as well as to sign boundaries.
Aspects are sorted from largest separating orb down to largest applying orb, which gives
an indication of the order in which aspects will be made by the moon as time progresses.
A horizontal line separates the separating aspects (those that have already occurred)
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from the applying aspects, (those that will occur in the future). Aspects between the
moon and other planets will not appear in this list unless their orb is within the
maximum orb allowed for that aspect in the aspect set which is being used. The total
number of aspects shown is limited to the number of data lines specified for this object.
Fixed Star Aspects

This object lists aspects made between the planets and fixed stars within a single chart.
Aspects are listed in planetary order, and the aspects and maximum orbs allowed are set
according to the specified aspect set. The stars used are those contained in the
specified star file. If too many aspects are found, then the font-size is reduced to fit all
the required lines of data into the box. If the font becomes too small to be readable, then
you should either reduce the orbs on the specified aspect set, or select a star file with
less stars in it.
Arabic Part Aspects
This object is similar to the Fixed Stars Aspects object, but find aspects with Arabic Parts
contained in the specified Arabic Parts file.
Asteroid Aspects
This object is similar to the Fixed Stars Aspects object, but find aspects with asteroids
contained in the specified asteroid file.
Body Aspects
This object is similar to the Fixed Stars Aspects object, but find aspects with bodies
contained in the specified extra bodies file.
Astrodynes - Strongest Aspects
This object lists the aspects which are considered to be the strongest in the system of
Astrodynes, giving the power score for each one.
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Astrodynes - Best Aspects
This object lists the aspects which are considered to be the best (most harmonious) in
the system of Astrodynes, giving the harmony/disharmony score for each one.

Astrodynes - Worst Aspects
This object lists the aspects which are considered to be the worst (most disharmonious)
in the system of Astrodynes, giving the harmony/disharmony score for each one.
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9.7.4.8 Dignities & Ancient

Planetary Sects

This object contains information about the sect of the seven traditional planets for the
current chart. The first column shows the planetary glyph and its inherent nature. The
“Cht” column shows whether the chart is diurnal or nocturnal (i.e. whether the sun is
above the horizon or not, and is therefore the same for all rows in the table). The “Plc”
column shows whether that planet is in a diurnal or nocturnal placement (i.e. whether it
is in the same hemisphere as the sun). The “Sgn” column shows whether that planet is
in a diurnal (masculine) or nocturnal (feminine) sign. If the planet’s inherent nature
concurs with chart, placement, and sign, then it has a dignity know as “In Hayz”. If it s
nature opposes all of them, then it is “Ex Conditione”, which is a form of negative
dignity.
Essential Dignities

This object lists the traditional essential dignities for each of the displayed points in the
chart. The scores are normally calculated according to the default dignity scores stored
in the file essdig.alm, which resides in Solar Fire’s system folder. Optionally you may
select the name of another dignity scoring file to use instead. The columns contained in
this table are as follows:
Pt - Point’s glyph or symbol
Ruler - Planet which is in rulership at this point’s zodiacal position
Exalt - Planet which is in exaltation “
Trip - Planet which is the triplicity ruler “
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Term - Planet which is the term ruler “
Face - Planet which has its face “
Detri - Planet which is in detriment “
Fall - Planet which is in fall “
Score - Total dignity score (an a “p” flag denoting whether this point is in peregrine)
A plus sign (+) in a column indicates that the point is in its own dignity. A minus sign (-)
indicates that the point is in its own fall or detriment. An “m” indicates that the point is
in mutual reception with another point for that form of dignity.
Dignity/Almuten scores

This object displays planetary scores for various dignity or almuten calculations. The
scores are normally calculated according to the default dignity and almutens scores
stored in the file general.alm, which resides in Solar Fire’s system folder. Optionally you
may select the name of another dignity or almuten scoring file to use instead. Each
dignity or almuten definition requires 3 data lines (hence if the dignity definition file
contains 3 definitions, then 9 data lines are required). The first line displays a
description of the scoring method. The second line displays the list of planets (highest
scoring first, lowest scoring last), and the third lines displays the numerical score values
under each planet.
Planetary Hour/Day

This object shows the planet of the day and hour of the current chart, and which hour of
day or night is current. (These hours are not hours of 60 minutes each, but instead are
exact divisions of 12 into the length of time of day or night.) The bottom two rows
indicate how long since the last planetary hour was in effect, and how long until the next
planetary hour takes effect, and what planets are involved.
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Mutual Receptions

This object lists planetary mutual receptions and cross-receptions found within the
current chart. Items are listed in the order Rulership, Exaltation, Triplicity, Term and
Face, but are limited to the number of data lines specified for this object.
Horary Considerations

This object lists certain pre-defined criteria that are used in evaluating horary charts.
These criteria are i) Moon void of course, ii) Moon in via combusta, iii) ASC in via
combusta, iv) ASC near a sign boundary, v) Saturn in 7th house or conjunct Descendant v)
Moon fast or Moon slow. If none of these conditions are present in the chart, then the
word “None” appears in the box.
Firdaria

This object lists the starting dates of planetary periods and the ages of the individual at
each of these dates. The number of planetary periods covered depends on the number of
data lines selected for the object. For example, 44 data lines will cover 64 years from
birth, and 60 lines will cover 86 years from birth. There are two variants of this object,
one using planetary periods as they were used by Al Biruni and Schoener, and the other
is a variant of this which places the nodes in a different order for night-time charts. (The
variants give identical results for daytime charts.)
Planetary 36Yr Cycle

This object displays the same information as the Planetary Hour/Day object, but also
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indicates the current planetary rulers of a 36 year cycle. Each 36 year period is ruled by
one of the 7 planets from Mars to Neptune, and each year within that 36 year period is
sub-ruled by a planet. The periods of rulership start on the tropical Aries ingress each
year. This 36 year cycle is described in American Astrology Magazine - Year 1940, in an
article by David Anrias (although it is referred to in that article as a 35 year cycle), and is
also alluded to in the title of the book “The Initiate in the Dark Cycle” by Cyril Scott –
Publ. Samuel Weiser Inc. This “Dark Cycle” is the 36 year period from 1909 to 1945
which was ruled by Mars.
Arabic Lunar Mansions

This lists, for each displayed point, the number of the Arabic mansion it occupies (1 to
28), the name of the mansion as given in the Picatrix, the Arabic name, and the English
name.
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Direction of Divisions (Term Directions)

This object lists the starting dates of planetary term periods and the ages of the
individual at each of these dates, according to the primary direction of the Ascendant of
the birth chart by oblique ascension. The number of planetary periods covered depends
on the number of data lines selected for the object. For example, 15 data lines will cover
about 90 years from birth. The type of terms used (either Ptolemaic or Egyptian) can be
chosen by specifying a dignity file that has the required type of term selected in its first
definition.
Chart Hylegs

This object lists the chart Hyleg, and its zodiacal longitude, according to several differing
methods. These methods are defined in detail in Chart Hylegs.
Planetary Hours of Day

This object shows the planets of each planetary hour of the current day, starting at dawn
and ending with dawn of the following day.
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Nakshatras

This shows the Nakshatras (Vedic lunar divisions) according to the default sidereal
zodiac. The names and types of the mansions are given, as well as a few keywords
describing the attributes of the mansion.
Chinese Mansions

This shows the Chinese Lunar Mansion occupied by each chart point. These mansions
are divisions in right ascension, the boundaries of which are defined by the positions of
certain fixed stars. The Chinese and English names of the mansion are given, as well as
a few keywords describing the attributes of the mansion.
Chinese Year Pillar

This shows the polarity, element (of the five Chinese Elements) and the animal of the
current lunar year.
9.7.4.9 Balances

Quadrants

This displays the number of planets in each quadrant and hemisphere of the chart.
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Elements

This displays the balance of elements in the current chart, totaling the number of planets
in each element. If the weighting option is selected, then the scores are weighted
according to Solar Fire’s default point weightings, and an asterisk appears after the tile
on the top line.
Modes

This displays the balance of modes in the current chart, totaling the number of planets in
each mode. If the weighting option is selected, then the scores are weighted according
to Solar Fire’s default point weightings, and an asterisk appears after the tile on the top
line.
Rays

This displays the balance of rays in the current chart, totaling the number of planets in
each ray’s signs. If the weighting option is selected, then the scores are weighted
according to Solar Fire’s default point weightings, and an asterisk appears after the tile
on the top line.
9.7.4.10 Graphical

Elements Graph

This display the balance of elements in the current chart, totalling the number of planets
in each element. If the weighting option is selected, then the scores are weighted
according to Solar Fire’s default point weightings, and an asterisk appears after the tile
on the top line.
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Modes Graph

This display the balance of modes in the current chart, totalling the number of planets in
each mode. If the weighting option is selected, then the scores are weighted according
to Solar Fire’s default point weightings, and an asterisk appears after the title on the top
line.
Rays Graph

This displays the balance of rays in the current chart, totalling the number of planets in
each ray’s signs. If the weighting option is selected, then the scores are weighted
according to Solar Fire’s default point weightings, and an asterisk appears after the tile
on the top line.
Modulus Sort Strip

This displays the currently displayed points in a modulus sort strip whose modulus angle
is user-specifiable.
Midpoint Trees

This displays midpoint trees for each displayed point in the chart. You must specify
sufficient data lines to allow room for the midpoint lists. For example, if there are 14
displayed points, and you want to allow 6 lines in each midpoint tree (including the top
line displaying the root planet), then you must specify at least 84 data lines. This will
only fit onto a page if you also specify multiple data blocks, such as in the example
shown where there are 5 data blocks.
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Declination Strip

This displays the currently displayed points in a vertically oriented strip, with a scale of
declination degrees starting from 0 degrees at the bottom up to the maximum userspecified orb. Positive values are shown on the left, and negative values on the right.
Latitude Strip
This displays the currently displayed points in a vertically oriented strip, with a scale of
latitude degrees starting from 0 degrees at the bottom up to the maximum userspecified orb. Positive values are shown on the left, and negative values on the right.
User Graphic

This displays any graphic file of your choice (of type *.bmp, *.wmf, .jpg). It may be sized
(and stretched) as desired. Note, however, that a metafile graphic (.wmf) will not
appear on the page if the page is copied to the clipboard as a metafile (i.e. you cannot
have a metafile within a metafile).
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9.7.4.11 Vedic

Vedic Chart (S)

This displays a vedic style chart using the South Indian convention of square shaped
whole-sign houses, with a diagonal line through the house which contains the
ascendant. Note that you would normally use this chart style to display charts which
were cast in a sidereal zodiac rather than the tropical zodiac.
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Vedic Chart (N)

This displays a vedic style chart using the North Indian convention of diamond shaped
whole-sign houses. Note that you would normally use this chart style to display charts
which were cast in a sidereal zodiac rather than the tropical zodiac.
Vedic Dasas

This displays a list of Dasas (major planetary periods) and Bhuktis (sub planetary
periods) using the current default sidereal zodiac for the selected chart. The number of
planetary periods covered depends on the number of data lines selected for the object.
For example, 60 data lines will cover about 100 years from birth.
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9.7.5 Description of Page & Object properties
Everything in the Page Designer is an object (a physical component of the page), and
each object has properties (characteristics) that you can change. An object's properties
can have various values that determine how the object looks when the page is used in
Solar Fire. The actual page itself is also an object (you can think of it as the "master"
object if you like), and therefore it too has properties that can be used to alter some of
it's characteristics.
All object properties initially have a default value set when a new object is added to the
page you are creating or editing, but most object properties can be changed to a
different value. Most properties have only a few pre-defined values that you can change
(e.g. True or False), while a few other properties have a great range of possibilities for
the value which you can decide to give them (e.g descriptions, names of files etc).
Properties relating to the Page itself
ListAbbrev - Text - Up to 5 Chars. This text is used in Solar Fire’s Chart View page in
the list of displayed images, and helps the user identify which page type it refers to.
MarginLeft, MarginTop, MarginRight, MarginBottom - Numeric - 0.0 to 1.0 - This
shows how wide a margin to leave at the edge of the page. Typically a small margin of
0.01 (ie 1%) is desirable to avoid objects being drawn tight up against the edge of the
page.
Remaining Object Properties
Chart* Desc - Text - Up to 20 Chars - There is one entry of this type for each chart that is
used on the page (up to 12). This text is used in Solar Fire when the user is prompted to
select which charts to display on the page, and helps the user identify where on the
page this chart is placed e.g. If there are two charts on the page you might enter “Top
Chart” and “Bottom Chart”. If there is only one chart used on this page, then this text
may be left blank.
AnchorX, AnchorY - Numeric - Typically 0.0 to 1.0 - This shows the X and Y coordinates
(across and down the page respectively) at which the object is placed. For most objects
the anchor point is the top, left of the object’s outline, but for wheels it is the center of
the wheel. Objects may be specified to be placed outside the borders by setting their
Anchor values to less than 0 or greater than 1, but they will still be forced to appear
within the page margins. It may be useful to do this to force a wheel to always align with
the edge of the page even when the displayed page size is different from the design
page size. AnchorX and AnchorY properties may also be set by dragging the object
around the page (or off the edge of the page to force the alignment for other page sizes).
Anchor Bottom – True/False – When false, this indicates that the top of the object is
anchored to its specified AnchorY property. Hence if the object shrinks due to having less
data lines than are specified as its default, then its base will move upwards. When true,
this indicates that the bottom of the object is anchored at its bottom (i.e. the specified
AnchorY property plus the default height). Hence if the object shrinks due to having less
data lines than are specified as its default, then its top will move downwards, and its
base will remain fixed.
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Width, Height - Numeric - 0.0 to 1.0 - These properties can only be set for objects which
are not text based (such as a wheel, grid or user graphic). Text based objects have their
width and height determined automatically from the font size in combination with the
number of text lines and data blocks. Wheels must always be round, so specifying
unequal width and height results in both the width and the height being set to the
smaller value when the page is displayed. However, it may be useful to specify unequal
values in order to allow wheels to expand when displayed on different page sizes. For
example, if a landscape shaped page has a single wheel with a caption above it, then its
width could be set to 1 (to potentially take up the full page width), and its height to .8 (to
allow a gap of .2 for the chart caption above). In this case the height is smaller than the
width, so it is the constraining value. If this was then displayed on a portrait page, then
the width would become the constraining factor, so the wheel would expand to take up
the full width of the page, but would still allow a gap at the top for the caption.
Chart - Numeric - 1 to 12 - This indicates which of the page’s charts is to be used in the
current object. For example, if the page has a Synastry Grid, then two charts will be
required (e.g. chart1 = 1 and chart2 = 2), or if the page has two biwheels, then the first
biwheel may use charts 1 and 2, and the second wheel charts 3 and 4.
Justification - Numeric - 0=Left, 1=Right, 2=Center - This indicates how text displayed in
this object is justified.
Reverse - True/False - This indicates the vertical order in which text appears. When
False, the text appears with the first line at the top, and subsequent lines going down.
When True, the first lines appears at the bottom. and subsequent lines going up.
Font Size - Numeric - 3.75 to 25.5 - This indicates the font size at which text is displayed.
In practice the font size may be varied if the object contains more text lines than
expected or the display page size is significantly different from the design page size.
Data Lines - Numeric - Limits vary for different objects - This indicates the maximum
lines of data that are expected to be displayed in this object. For example, a flexible
points list will display a data line for each displayed point in Solar Fire. If you normally
expect to have only 14 displayed points in Solar Fire, then you could set the Data Lines
value to 14, in which case the object would display correctly in the chosen font size.
However, if you increased the displayed points to 20, then the object would remain the
same size, but a smaller font size than the one you specified will be used so that the 20
lines can all fit into the same space. Conversely, if you set the Data Lines to 20, resulting
in a larger object, but only have 14 displayed points, then the selected font size will be
used, but the size of the object will shrink back to enclose the 14 lines of data.
Data Blocks - Numeric - Limits vary for different objects - This indicates how many sideby-side blocks (or columns) to split the data into. For example, if you have 12 Data Lines,
then setting the Data Blocks value to 2 will result in two columns of 6 lines of data each.
This property can be used to change the shape of the object - increasing the number of
data blocks makes the object shorter and wider.
Title Line - True/False - If the object has a main title line available, then this property
can be used to switch it on or off. If it is switched off (False) then the object becomes
slightly shorter, but without its title it may not be obvious to all users what the object is.
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Frame Type - Numeric - 0=None, 1=Single, 2=Double - This controls what type of frame,
if any, is drawn around this object. Most objects that have internal column and row lines
look better with at least a single line frame, but objects such as user graphics may look
better without a frame.
Graphic File - Text - Up to 255 Chars - This property applies only to the graphic object,
and specifies the name of a graphic file (including the file extension) that is to be
displayed. This may be any file of type *.bmp, *.wmf, *.jpg, *.ico, *.gif, *.emf. (Unlike
previous versions of Solar Fire, it is no longer necessary to copy the graphic file into the
Solar Fire folder – you can select a file from anywhere you like.)
Points File, Aspects File, Star File, Arabic Parts File, Asteroid File - Text - Up to 80
Chars - This specifies the name of the Solar Fire file (without the file extension) which is
used to determine which points, aspects, stars, Arabic Parts or asteroids that are used
within this object. If left blank, then Solar Fire will use whatever default file is currently
selected when this object is displayed. This is useful if you wish to always display the
same items in this object, regardless of the currently selected files in Solar Fire.
Dignity File - Text - Up to 80 Chars - This specifies the name of the Solar Fire dignity/
almuten definition file (without the file extension) which is used to calculate dignity or
almuten scores within this object. If left blank, then Solar Fire will use its default file
(“general.alm” for the Almutens object, “houses.alm” for the house almutens and
“essdig.alm” for other objects).
Rulerships - Text - e.g. Modern, Old, Esoteric, Hierarchical - This specifies which
rulerships will be used within this object e.g. in a flexible points list, this influences what
is shown in the house rulership and dispositor columns, or in a chartwheel it influences
which sign or decanate rulerships are shown if it has a zodiac ring showing rulerships.
Modulus - Numeric - Angle in Degrees - This specifies the modulus angle that is used in
this object. Angles may be entered in any format acceptable to Solar Fire (see Entering
Angles).
Max Orb - Numeric - Angle in Degrees - This specifies the maximum orb that is used
within the object. Angles may be entered in any format acceptable to Solar Fire (see
Entering Angles).
Weighted Scores - True/False - This specifies whether scoring in this object will use
unweighted scores (ie 1 point per item) or scores weighted according to Solar Fire’s
default weightings. The default weightings may be edited using the Rulerships and
Weightings editor (see Changing Rulerships and Weightings).
Force Color - Numeric - 0=Automatic, 1=Always Black, 2=Always White - This specifies
what color will be used to draw this object's text (if a caption) and/or lines (if a chart or
graphical object). The normal (default) setting is Automatic, in which case the text and/
or lines are drawn in black if the current background color is light, or drawn in black if
the current background color is dark. (The background color is a property of the Color
Scheme that can be selected by the user.) The main purpose of this setting is to allow
the color to be fixed when the page contains a background graphic, because in that case
the color needs to be fixed appropriately in relation to the colors of the graphic, and
should not change according to the background color, which is not visible in this case.
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9.7.6 Selecting and Inserting Page Sizes
A single page design file may contain multiple page sizes to suit a whole variety of
different display sizes, orientations and types. Selectable display types are...
Screens
Printers
Windows metafiles
Each of these display types may have different sizes (i.e. differing numbers of pixels or
dots per inch across and down the display). For example, screens will typically be one of
the following sizes, although many others are also possible...
640 x 480 pixels
800 x 600 pixels
1024 x 768 pixels
1152 x 864 pixels
1280 x 1024 pixels
Printers have sizes that depend on the physical measurements of the paper onto which
they are printing in combination with the resolution of the printer (e.g. A4 page at 300dpi
resolution is approximately 2357 x 3407 pixels when in portrait orientation).
Windows metafiles have only nominal sizes, because they can be resized to virtually any
size once they are pasted into another program. However, the ratio of horizontal to
vertical pixels in the user defined size still determines the base shape of the page, so
adding a user-defined page size of 3000 x 6000 pixels would result in a page shape
which is twice as high as it is wide. Solar Fire always looks for the largest page size
available when you are copying a page to the clipboard as a metafile, so if you want to
create a user-defined page size that will be used for metafiles, then you must ensure
that its pixels dimensions are larger than any other page sizes in your page design file.
For most users who design a new page, it will be adequate to create just a single page
size i.e. the screen page size which matches your current screen display size. In this case
Solar Fire will still be able to display the page on any display type and size, but will have
to make automatic adjustments to match different page types and sizes as best it can.
These adjustments may involve resizing objects to fit the new page dimensions, and
altering displayed fonts and font sizes in order to fit the text inside the resized objects.
In many cases these automatic adjustments will work well enough to avoid the need for
you to create designs for each page size that you use. However, cases in which the
automatic adjustments may not give the best possible appearance might be...
If you design a page for one screen or printer page size and then display it on a
screen or printer page with a significantly different aspect ratio (height to width
ratio).
If you design an object which uses a small font size and then display it on a smaller
page size.
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You will also need to add extra page sizes to the design in the following circumstances...
If you wish to make what appears on the printer different from what appears on the
screen (for example to add compliments text which doesn’t appear on the screen
display, or to increase the size of tabulations which are too limited on the screen
display)
If you wish to make what appears in a metafile (copied to the clipboard) different
from what appears on the screen or printer (for example to remove chart text
captions when you intend to add your own captions in another program)
Also, you may wish to add extra page sizes to the design in order to improve the display
quality in the following circumstances...
If you intend your page design to be used by other users who may have different
display resolutions
If you want your printed output to be laid out differently from the screen
If you intend to print your page on a variety of different page sizes or orientations
Note:- If you do decide to add new page sizes, then it is strongly recommended that
you only do so after inserting all the required objects onto the original page size. The
reason for this is that when you add a new page size, all the objects on the currently
displayed page size are copied into the new page size. If you have not inserted all the
required objects beforehand, then you will have to insert the same new objects onto
each new page separately afterwards.
>> To select a page size to edit
Click on the required page size in the list of existing page sizes. The new page size
will be displayed immediately, and you may edit objects on the page.
When you start up the page designer, it will automatically select the page size which
corresponds to your current screen size (if there is a page of this size in the current
page design file - otherwise it will select the first page size on the list).
>> To add a new page size
1. Before adding a new page size, make sure that you have first selected the existing
page size that you wish to base the new page size on. All objects on the currently
displayed page will be copied onto the new page.
2. Choose the Add New Page Size menu item under the Page Size menu of the Page
Designer. This will bring up the “Select Page Size” dialog, from which you can
select or create any required page size. If you are adding a new screen size, then
click on one of the Screen page sizes at the top of the list. If you want to add a
new Printer page, then click on the Printer option, and then on the Printer Setup
button. This will allow you to choose the paper type, orientation and resolution of
the new page size. If you want to add a page for copying to metafile, or for any
other screen or printer size which is not otherwise selectable, then click on the
User Defined option and enter the required Width and Height in pixels.
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Note: that you cannot add another page with the same size as an existing page. If you
attempt to do this, then the Page Designer will simply revert to displaying the existing
page of that size.
9.7.7 Editing the Page Description
The page description consists of up to 80 characters of text, the purpose of which is to
describe the page design. Each page design file contains a single description which is
displayed in Solar Fire’s "File Manager" when it displays list of page design files.
Therefore, if you ensure that your page design has a clear description, it is much easier
to find the page design file that you want, when you wish to select it for display.
>> To edit the page description
Choose the Edit Page Description menu item under the File menu of the Page
designer.
This will highlight the text at the top of the page ready for editing. Any changes that
you make are automatically saved when you next save the page design.
9.7.8 Saving Files and Exiting
>> To save changes to a page design
Choose the Save menu item under the File menu.
This will save any changes that you have made since the file was last saved.
>> To save the page design to a new file name
Choose the Save As menu item under the "File" menu.
This will display a standard Save File dialog into which you may enter a new name.
Note that page design files must be saved under a name with the file extension .pag,
and must reside in Solar Fire’s User Files / Pages subfolder in order to be accessed
from within Solar Fire.
>> Exiting from the page designer
Choose the Exit option from the "File" menu.
If you have made any changes to the current page design, then you will be prompted
whether or not to save the changes before the page designer closes down.

9.8

Using the Utilities Menu
Solar Fire has a Utilities menu that is completely customizable by the user. When you
first install Solar Fire, the Utilities menu will already contain a list of options, including
options which start up most of the separate programs that are supplied with Solar Fire,
such as the Chart Export utility and the Rulerships and Weightings Editor. However, you
may add items to, delete items from, or rearrange this list as you wish.
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>> To start up the Utilities Menu Editor
Select the Assign to Menu option from the "Utilities" menu.
This will display the "Edit Solar Fire Utilities Menu" screen.
The list box on the left of the screen displays a list of all the items which will appear in
Solar Fire’s Utilities menu. The text boxes on the right display the details associated with
the currently selected item.
9.8.1 Editing Menu Items
>> To edit an item which is already on the list
Select the required item from the list. You can then edit any of the details, as
follows.
Menu Text - This allows you to enter the text which will be displayed in Solar Fire’s
menu. Note that entering a single & before any letter will cause that letter to be
underscored in the menu, and allow it to be used as a short-cut letter for accessing that
menu item from the keyboard e.g. &Import Charts is displayed as Import Charts, and
the Alt+I keys may be used as a short-cut to accessing this menu item in Solar Fire. It is
recommended that you limit to length of your entries to about 20 characters, so that the
menu will not become overcrowded.
Executable File - This allows you to specify which program will be started whenever this
menu item is selected from Solar Fire. You can either enter a file name directly into this
text box, or you can use the Find File button to search for the file you want and
automatically enter its path and name into this text box. If you enter a file name
yourself, without entering any path, then Solar Fire will assume that the file resides in its
own folder (normally called SOLFIRE), or in the WINDOWS folder. If you want to call up a
program from any other folder than either of these, then you must enter its full path as
well as its name e.g. to call the chart import utility, which resides in the Solar Fire folder,
enter “fileconv.exe”. To call the Nova program, for which a PIF file exists in the Windows
folder, enter “nova.pif”. To call a program mygame.exe which exists in the folder GAMES
on the C drive, enter “c:\games\mygame.exe”. If you are use the Find File button to
select the file, then the full path will be entered automatically.
Help Text - This allows you to specify what help text will be displayed on Solar Fire’s
status bar at the bottom of the Main Screen when this menu item is being browsed. This
may be left blank if you wish.
Note: If you have incorrectly entered the Executable File name or path, or if the program
referred to is later deleted or moved to a different folder, then Solar Fire will issue an
error message whenever you attempt to access that menu item. In this case, you can use
the Assign to Menu option to edit or delete the problematic entry.
9.8.2 Deleting Menu Items
>> To delete any item on the list
1. Select the required item from the list
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2. Click on the Delete button
This will delete the item immediately, without asking for confirmation.
9.8.3 Reordering the Menu
>> To alter the position of any item on the list
1. Select the required item from the list
2. Click on the up or down arrow of the spin button
This will move the selected item up or down the list relative to the other entries.
9.8.4 Saving Changes to the Menu
>> To save your changes
1. Click on the Save button.
This will save any changes that you have made. Next time that Solar Fire starts up,
your changes will be read in, and the Solar Fire Utilities menu will reflect these
changes. Note that if you are editing the menu whilst Solar Fire is running, any
changes that you make will not take effect until you exit from Solar Fire and restart it.
If you select the Quit button, and there are outstanding changes that have not yet
been saved, then you will be asked whether or not you wish any changes that you
have made to be saved.
9.8.5 Suggestions for the Utilities Menu
In addition to Solar Fire’s utility programs, you might consider adding some of the
following items into the Utilities menu.
Other astrology programs - You might find it useful to have some of your other
astrology programs accessible directly from Solar Fire.
Windows utilities - e.g. Calculator (CALC.EXE), Notepad (NOTEPAD.EXE), Paintbrush
(PBRUSH.EXE). Note: These all reside in the WINDOWS folder, so you do not need to
enter a path for them.
Other programs that you use often - e.g. your word-processor

9.9

Viewing Astro-Locality Maps
Solar Fire contains Solar Maps. What follows is a brief description of the features of
Solar Maps.
Solar Maps allows you to...
Display world maps in rectangular or spherical formats
Display planetary positions on maps for any natal type chart that has already been
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calculated in Solar Fire
Display lines of culmination, anti-culmination, rise or set for the chart’s planets and
bodies
Display planetary direction lines in local space
Display day/night shading for any chart on a rectangular world map
View solar eclipse paths for any solar eclipse in the period 1951 to 2200
Measure angular and linear distances between maps locations or planetary lines
Add, edit or remove cities which are displayed on maps
Apply alternative pre-defined map and line color selections
>> To start Solar Maps and display the currently select chart
1. From the Main Screen select the required chart from the list of "Calculated Charts"
2. Select the Solar Maps item from the View menu.
This will start up Solar Maps, displaying the selected chart over the last selected map.
>> To get further help with Solar Maps
Click on the Help menu in Solar Maps

9.10

Exporting Data to Text Files
This chapter describes how to export chart details and astronomical data into text files
or to the clipboard for pasting elsewhere. You have some control over the format of the
exported data, as well as a selection of what types of data to include.
You are able to export data either for a selection of "Calculated Charts" from Solar Fire’s
Main Screen, or directly from an existing chart file.
>> To export data from a selection of "Calculated Charts"
1) Highlight the required charts in the list of charts on Solar Fire’s Main Screen.
2) Then do either:
Select the Export Charts as Text item from the Chart menu.
or...
With the mouse right-click anywhere on the selected charts, and select Export
Charts as Text from the popup menu
This will invoke the "Export Chart Data" dialog.
>> To export data from an existing chart file
1. Select the Open item from the Chart menu
2. If you only wish to export data for selected charts, then you must highlight (select)
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the required charts first.
3. Click on the Send/Add button, and select the required option from the popup
menu.
This will invoke the "Export Chart Data" dialog.
9.10.1 Using the Export Chart Data Dialog
This dialog allows you to select various options relating to the process...
Types of Points – You can select any combination of the available point types.
Note that most point type names are followed by the name of the current file
selection for that point type. If you wish to change the file selection for any point
type, then you must return to Solar Fire’s Main Screen to do so. If you select no
types of points, then only header lines with chart details will be exported.
Types of Data – You can select any combination of the available types of data. If
you are exporting data for more than one chart, and you are not including header
lines for each chart, then you will probably wish to include “Chart Name”, so that
you can identify which data belongs to which chart.
Header Lines to Include – If you select the Column Titles option, then the first line
in the exported data will simply be a label for each column included in the output,
allowing you to identify which column is which. If you select the Chart Details
option, then there will be an additional line at the beginning of each chart’s data,
giving showing certain chart details. The exact format of this line is dictated by the
selection in the drop-down list box below the Edit ASCII button. The Edit ASCII
button can be used to edit or create new formats defining how the chart details are
written. See Editing ASCII Definitions for further details on this option.
Field Delimiters – Comma Quote (CQD) format can be read by most other programs
that allow data to be imported. It places any text fields inside double quote marks,
and separates the fields with commas. Tab format is also quite common, and does
not use quote marks, but separates the fields with tab characters.
Destination – If you export to clipboard, then you can paste it into another
program. If you export to file, then you can specify a file name and location first, by
clicking on the Browse button.
When you have finished your selections, click on the Export button to start the process.
You will be notified with a message box as soon as it is complete.
TIPS:
If you wish to export the chart details only, without any astronomical data, then
ensure that no types of points are selected. This will result in only the chart details
lines being included.
If you are exporting data for multiple charts, and wish to import it into a
spreadsheet, then it is best to include “Chart Name” as one of the types of data,
and not to include the “Chart Details” header line. This is because the Chart
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Details header line has a different layout from the other data lines, and will cause
problems if you want to do things like sorting the data in your spreadsheet.
If you are exporting data for natal charts and subsidiary charts for the same people,
then include the “Chart Type” data type, so that you can differentiate between the
natal data and subsidiary data.
If you intend to do a large export job to a file, then try it first with a small number
of charts and export it to the clipboard, so that you can easily preview that data to
check that it is formatted as you expect.
9.10.2 Editing ASCII Definitions
If your exported data contains chart details in addition to planetary type data, then you
must select an existing (or create a new) ASCII Data Definition, which controls what
types of chart data are exported, the order in which items appear on a line, and the
format in which they are written.
You can select an existing definition whenever needed by highlighting its name in the
drop-down list of definition names. This drop-down box appears on the Export Chart Data
dialog as well as the Chart Conversion Utility.
The ASCII Data Definition editor allows you to browse through the existing definitions, as
well as creating new ones or deleting old ones.
Note that ASCII Data Definitions are used for both exporting data from Solar Fire, and
also whilst using the chart conversion utility to import or export chart files.
>> To enter the ASCII Data Definition editor
Click on the Edit ASCII… button.
This will display the ASCII Format Definitions dialog.
>> To Select a Definition To Browse, Edit or Delete
Click on the drop-down list labeled Definitions and select the required item on the
list by clicking on it.
>> To Delete a Definition
1. Ensure that the required definition is selected
2. Click on the Delete Definition button
This will remove that definition from the list.
9.10.3 Specifying Record Format
Record formats may be either comma-quote delimited (CQD) or fixed length.
CQD - All fields in each record must be separated by commas, and character fields must
be enclosed in double quote marks. If a line break occurs before all the fields are read in,
then it is assumed that the remaining fields can be found on the following line/s. This
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format is commonly used for data exchange with spreadsheets, where each field
corresponds to one cell in a row of the spreadsheet. e.g.
“John Smith”,”1 Jan 1972”,”12:13 pm”,85.6312,42.9832
Fixed Length - Each field in the record is a fixed user-specified length, so that the length
of the full record is exactly equal to the sum of the length of each field in the record.
Each record must be terminated by a line break. e.g.
”John Smith 01011972 1213P 85E38 42N59
If you choose this option then you must specify the length of each field individually so
that the total record length is matched exactly. You can use “Filler” fields if there are
items in the record that are not relevant to the data exchange.
9.10.4 Specifying the Fields in a Record
>> To add a new field to the record definition
1. Highlight the required field from the list of available fields and click on the <
button.
>> To delete a field from the record definition
1. Highlight the required field from the list of fields in the record and click on the >
button.
>> To change the position of a field in the record
1. Highlight the required field from the list of fields in the record and click on the Up
or Dn button.
This will move the highlighted field up or down the list.
9.10.5 Available Fields
The available fields are...
Name/Description - A character string which contains a name for the chart e.g.
“John Smith”
Date (String) - A character string which contains a date for the chart. This may be in
any format that is understood by programs from Esoteric Technologies such as the
Solar range and JigSaw e.g. “1 Apr 1999”
Year - The year number, which can also be negative for BC years (where 1BC = Year
0, 2BC = Year -1 etc...)
Month - The month number (1-12)
Day - The day number (1-31)
Time (String) - A character string which contains a time for the chart. This may be in
any format that is understood by programs from Esoteric Technologies such as the
Solar range and JigSaw e.g. “12:59:17 pm”
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Hour - The hour number (0-23)
Minute - The minute number (0-59)
Second - The second number (0-59)
AM/PM Indicator - A character string which flags whether the time is AM or PM if
its hour number is 12 or less. (The value of this flag for recognizing PM times may
be specified as an additional option.)
Zone Abbreviation - A character string which is a label for the time zone (e.g. “EST”,
“ACDT” etc.)
Zone Time (String) - A character string which contains a timezone for the chart. This
may be in any format that is understood by programs from Esoteric Technologies
such as the Solar range and JigSaw e.g. “-9:30”
Zone Time (Numeric) - The numeric value of the timezone in decimal hours from
GMT. The standard used in programs from Esoteric Technologies is to use a -ve
number for times east of the Greenwich Meridian e.g. -9.5. (If you need to use the
opposite convention, then you can choose to reverse its sign automatically as an
additional option.)
Zone Time Hour - The hour number of the timezone (-13 to +13)
Zone Time Minute - The minute number of the timezone (0-59)
Zone Time Second - The second number of the timezone (0-59)
Place Name - A character string which contains a name for the place of the chart
e.g. “Adelaide”
Country/State Name - A character string which contains an additional name for the
place of the chart e.g. “Australia”
Longitude (String) - A character string which contains a longitude for the chart. This
may be in any format that is programs from Esoteric Technologies such as the Solar
range and JigSaw e.g. “84E59 59”
Longitude (Numeric) - The numeric value of the longitude in decimal degrees. The
standard used in programs from Esoteric Technologies is to use a -ve number for
longitudes east of the Greenwich Meridian e.g. -123.7891. (If you need to use the
opposite convention, then you can choose to reverse its sign automatically as an
additional option.)
Longitude Degree - The degrees number (0-180)
Longitude Minute - The minutes number (0-59)
Longitude Second - The seconds number (0-59)
Longitude Hemisphere - A character string which flags whether the longitude is
East or West. (The value of this flag for recognizing Western longitudes may be
specified as an additional option.)
Latitude (String) - A character string which contains a latitude for the chart. This
may be in any format that is programs from Esoteric Technologies such as the Solar
range and JigSaw e.g. “35S55”
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Latitude (Numeric) - The numeric value of the longitude in decimal degrees.
Latitude Degree - The degrees number (0-90)
Latitude Minute - The minutes number (0-59)
Latitude Second - The seconds number (0-59)
Latitude Hemisphere - A character string which flags whether the latitude is North
or South. (The value of this flag for recognizing Northern latitudes may be specified
as an additional option.)
Filler - Any character string or number. The value for the filler must be specified as
an option of the current field when it is selected.
9.10.6 Choosing the Appropriate Fields
You can select any combination of fields in any order, but there are certain combinations
of fields which are often used together, and some that are incompatible with one
another.
Dates
If the dates in the ASCII records are expressed in everyday date format (e.g. “31 Dec
1957” or “Dec 31 1957” etc.), then it will usually be possible to use the Date (String)
field, and there is no need to use any of the other date related fields. However, if the
dates in the ASCII records are split up into year, month and day parts, then the Year,
Month and Day fields should be used instead.
Times
If the times in the ASCII records are expressed in everyday time format (e.g. “12:17pm”
or “18:23:59” etc.), then it will usually be possible to use the Time (String) field, and
there is no need to use any of the other time related fields. However, if the times in the
ASCII records are split up into hour, minute and second parts, then the Hour, Minute,
Second and AM/PM Indicator fields should be used instead.
Note: If no time field is present in the record definition, then the time defaults to 12:00
(Midday) when data is imported.
Zone Times
If the zone times in the ASCII records are expressed in everyday time format (e.g. “-9:30”
or “+5:00” etc.), then it will usually be possible to use the Zone Time (String) field, and
there is no need to use any of the other zone time related fields. However, if the zone
times in the ASCII records are split up into hour, minute and second parts, then the Zone
Hour, Zone Minute, Zone Second fields should be used instead. If the zone times are
expressed in decimal hours, then only the Zone Time (Numeric) should be used.
Note: If no zone time field is present in the record definition, then the zone time defaults
to 0:00 (GMT or UT) when data is imported.
Longitudes and Latitudes
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If the longitudes and latitudes in the ASCII records are expressed in everyday time format
(e.g. “84W59 59”, “34S55 21” etc.), then it will usually be possible to use the Longitude
(String) and Latitude (String) fields, and there is no need to use any of the other
longitude and latitude related fields. However, if the longitudes or latitudes in the ASCII
records are split up into degree, minute and second parts, then the Longitude and
Latitude Degree, Minute, Second and Hemisphere fields should be used instead. If they
are expressed in decimal hours, then only the Longitude (Numeric) and Latitude
(Numeric) should be used.
Note: If no longitude or latitude field is present in the record definition, then they default
to 0W00 and 0N00 when data is imported.
Fillers
Filler fields must be used in the following circumstances...
Importing Data - when the input records contain an item which is not relevant to
the data required for import
Exporting Data - when the output record needs to contain an item which is fixed in
every record
Filler fields may have a default value specified for them. This default value is ignored
when the record definition is being used for imported data, but if the same definition is
ever used to export data, then that default value is inserted into the output record in the
position where the Filler field appears in the definition.
Example
Import data record: “John Smith”,”1 Jan
1972”,17.834,”12:13pm”,85.6312,42.9832
The 3rd field in the record (17.834) is not relevant to the chart data, so the third field in
the definition of the CQD definition should be a Filler.
Suitable record definition for above record format:
Name/Description
Date (String)
Filler “0.0”
Time (String)
Longitude (Numeric)
Latitude (Numeric)
If the same definition was used for exporting data, then this would produce the following
output record:
“John Smith”,”1 Jan 1972”,0.0,”12:13 PM”,85.6312,42.9832
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9.10.7 Limitations
It is not possible to create a definition for a file which contains records of differing
layouts. All records in the file must be of the same format.
Only those field types listed in the editor may be selected e.g. if you have a file which
contains the time of day in decimal hours, this cannot be used, because only files which
contain integer hour/minute/second (e.g. 12,13,00) or time character strings (eg “12:13
pm”) can be selected as fields in the record.

9.11

Interpretations Compiler
You can easily edit any interpretations in Solar Fire by using the supplied "Interpretations
Editor" program (see Editing Interpretations). However, on occasion you may wish to
decompile an interpretations file into a text file so that you can work on it in a word
processor or text editing program.
There are three main reasons why you may wish to use the compilation options...
a) If you have created text files for an earlier version of Solar Fire, you may still want
to compile them. If you have written new interpretations for this version you will
have to compile them to be able to use them.
b) If you wish to do any work on the entire set of text in bulk, for example, to make
global editing changes, or to spell check the entire text, then you will need to
decompile them first, work on the decompiled file in your word processor, and then
recompile them. In this case you will eventually need to recompile the text file so
that the interpretations can be used in Solar Fire.
c) If you wish to create your own interpretations for a Solar Fire interpretation
category from scratch. In this case you will have to create a new text file with your
interpretations in it, then compile the text file into an interpretations file that can
be used in Solar Fire.
The "Interpretation Compiler" allows you to edit all interpretation text files for a project
individually, and assembles and compiles all the input text into a single, compact
"direct-access" file, from which Solar Fire is able to access any text item almost
instantaneously.
Once you have successfully run the Interpretations Compiler, you will be able to access
your interpretations in Solar Fire by selecting the file you have created to be the current
Interpretations File for one or more interpretation categories, via the "File Manager".

9.11.1 Requirements
In order to edit your interpretations text files and compile your interpretations using the
"Interpretations Compiler", you will need to be familiar with a text editor or wordprocessor which can create ASCII text files with an ANSI format. The "Interpretations
Compiler" allows you to directly access Windows "Notepad" text editor and Windows
"WordPad" word-processor in order to edit the text in the interpretations files. However,
you may also use any other word processor or text editor of your choice, if you prefer.
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9.11.2 Decompiling and Compiling procedure
The process of decompiling extracts all the interpretations text from an interpretation
(output) file and inserts it into a single ANSI text (input) file. The ANSI file is written to
conform exactly to Solar Fire’s requirements for a text input file, so that it may
subsequently be recompiled into an output file without any changes being required. The
decompiled (text) file may be edited with any text editor or word processor. This text file
is the raw source of interpretations text for any category of Solar Fire interpretations text
- it is thus called a "definition" file. A Solar Fire definition (input) file has a ".def"
extension to the filename. It is called an "input" (kind of) file because it will be the file
that is input to the "Interpretations Compiler" when the compile process runs.
A Solar Fire interpretations (output) file has an ".int" extension to the filename. It is
called an "output" (kind of) file because it will be the file that is "outputted" from the
"Interpretations Compiler" when the compile process runs - i.e. when a definition (input)
file is compiled. Another way of saying this is that "*.def" files are fed into the
"Interpretations Compiler" and "*.int" files are what comes back out of it. The resulting
"*.int" files are the files Solar Fire uses as interpretation files when it is fetching and
displaying interpretations for charts, synastry reports etc.
Solar Fire comes supplied with several interpretation ("*.int") files, a different one for
most (but not all) of the different kinds of interpretation categories supported by Solar
Fire. This is another reason you may wish to use the "Interpretations Compiler" for this
decompile/recompile process - so that you can write interpretation text for interpretation
categories that Solar Fire doesn't supply an interpretations file for e.g the "Return"
category, which by default instead uses instead the interpretation file specifically
written for natal charts (standard.int).
Note: The "*" in "*.int" or "*.def" is a wildcard character, which means it represents any
number of characters before the filename extension (the extension is everything from
the dot "." onwards in the filename). Basically it represents the actual name portion of a
filename. Thus "*.def" represents all filenames ending in a ".def" extension (for example
"standard.def", "midpoints.def" etc.), and "*.int" represents all filenames ending in a
".int" extension (for example "standard.int", "midpoints.int" etc).
The decompiling procedure...
1. Open the "Interpretations Window" (see Opening the Interpretations Window)
2. Click on the File menu, then the Edit Interpretations item. This will open the
"Interpretations Editor".
3. Click on the File menu and select Decompile
4. Save the file
The compiling procedure...
1. Open the "Interpretations Window" (see Opening the Interpretations Window)
2. Click on the File menu, then the Edit Interpretations item. This will open the
"Interpretations Editor".
3. From the "Interpretations Editor", choose the Compile option from the File menu.
This will open the "Interpretations Compiler".
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4. Select the definition file (*.def) for the set of interpretations which you wish to edit.
5. Optionally edit any of the displayed files which contain the interpretations text for
this project (usually this is only one - the definition file you have just opened. If
there is more than one it means the definition file contains input files.)
6. Compile the project.
7. If the Compiler finds any errors click on Edit Text Files
8. Repeat steps 4 to 7 until all the errors are eliminated.
You can exit from the "Interpretations Compiler" without creating an interpretation file,
at any time, by clicking on the Quit button.
9.11.2.1 Decompiling

>> To decompile an interpretations (*.int) file
1. Open the "Interpretations Window" (see Opening the Interpretations Window)
2. Click on the File menu, then Edit Interpretations. This will open the "Interpretations
Editor".
3. If no file is opened in the "Interpretations Editor" then select the Open option from
the File menu, select a file then click on the Open button.
4. Select the Decompile option from the File menu - this will display a standard “Save
File As” dialog.
5. Enter a file name - the file name must be a valid file name, and should have a “.def”
extension. (Technically this is not strictly necessary, but you're better off to
standardize your input files with this extension). Normally it is best to choose the
same name as the current file, e.g. standard.def or transits.def, if you are
decompiling one of Solar Fire’s supplied interpretation (*.int) files.
However this too isn't necessary and you can give it any name, which may useful if
you want to experiment or create various definition files for one or more
interpretation categories, and then compile them into alternative interpretation files
that can be selected as appropriate for different uses in Solar Fire.
6. Optionally select a new folder. If you choose a different folder, then you will need to
remember where you have placed the file when you wish to recompile it.
7. Select the OK button. You will see a confirmation message showing you the full path
and name of the decompiled file when it has finished.
Note: Remember that after you have decompiled an interpretations file, you have two
versions of the interpretations - the original interpretations file (an *.int file), and the
decompiled text file (a *.def file). If you make any changes to the original file in (via) the
"Interpretations Window", then if you recompile it's decompiled (*.def) file using the
same name as the original (*.int) file, those changes in the *.int file will be overwritten,
as they were not also made to the *.def file. For this reason, if you are using the
decompile/compile method (via the "Interpretations Compiler") it is better to only make
changes to interpretation text in the decompiled (*.def) file, never in the compiled (*.int)
file.
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9.11.2.2 Editing Decompiled Interpretations Text

Once you have decompiled an interpretation file into a definition file, or if you already
have some definition files from previous versions of Solar Fire, or perhaps even created
some of you own from scratch and want to make changes to these files, or want to
create a new one from scratch, then you need to edit a definition file.
To do this via the "Interpretations Compiler" you must first find the relevant definition
(*.def) file. If you wish to work with a definition file other than that already shown in the
"Definition File" text box, then you must select another file.
>> To select a definition file
Do one of the following...
Enter a full file path and name into the "Definition File" text box
or...
Click on the Browse button to the right of "Definition File" text box. You will be
shown a file selection dialog box from which you may select folders and files.
When you select a definition file in the "Interpretations Compiler", all the definition text
files that are related to this project will be listed in the "Interpretation Text Files" listbox.
You are then able to edit or browse them with an editing program.
Note: A definition file (which is itself a text file) can include (reference) other definition
text files (see Input File Layout), which is why once you've selected a definition file to
edit there might be more than one file showing in the "Interpretation Text Files" listbox the definition file you selected, and the other text files it references.
>> To create new definition file
Enter a full file path and name for your new definition file into the "Definition File"
text box.
As soon as you tab out of the text box, or click in another part of the window, a dialog
box will appear that says your new file as referenced in the project but does not exist,
and do you want to create it as an empty file ready for editing. If you say Yes a new
definition file will be created with the filename you entered in the "Definition File" text
box, and the new file will also be displayed in the "Interpretation Text Files" listbox,
ready for editing.
>> To select a text editor to work with
Do one of the following...
Choose the required editor from the drop down Text Editor / Word Processor
textbox.
In most cases the easiest editor to use is Notepad, which is supplied with Windows,
as this is a simple text editor. Any changes that you make with Notepad are
automatically saved in the correct (ANSI i.e. text) format. However, Notepad is
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unable to edit files which exceed a certain size. If you attempt to do so, then it will
display an error message to this effect. If this happens then you should close
Notepad and use another editor instead. The Wordpad word-processor is also quite
easy to use, but you will need to remember always to save any changes using the
"Save As" menu option and selecting to save as “Text Files (*.txt)” or "Plain text
document" from the drop-down list of File Types. Also, when you open the Wordpad
program, it may ask you whether or not to convert the file to its own internal format.
If it does the best option is to select “No Conversion”.
or...
If you prefer to use an editor or word-processor of your own choosing not listed in
the drop down box, then you may do so by entering its full path and filename into
the drop-down list box.
For example, to use MS Word for Windows 2003 on a 32 bit Windows 7 computer,
you might enter “C:\Program Files\Microsoft Office\OFFICE11\winword.exe”, or "C:
\Program Files (x86)\Microsoft Office\OFFICE11\winword.exe" on a 32 bit Windows
7 computer. Do not include the quote characters. (Whatever you enter here will be
remembered for future sessions with the compiler.)
>> To edit a text file
Select the required file from the "Interpretation Text Files" listbox and click on the
Edit Text button, or double-click on the required file in the list.
This will start up the selected editor with the selected file. Note that you must
remember to close the editor after you are finished with it. Each time that you edit a
file in the compiler, a new instance of the editor is started up. If you do not close the
editor after editing each file, then you will end up with many copies of the editor
running simultaneously.
For help with creating or changing the actual text in a definition file see Input File
Layout.
Note: If you are adept with your computer, then you may prefer to edit the text files
externally, without using the "Interpretations Compiler" at all. This is quite acceptable, in
which case you only need the "Interpretations Compiler" to compile your text files after
you have finished creating/editing them.
9.11.2.3 Running the Compiler

When you have finished creating or editing any text input (.def) files, then you can start
the Compiler after specifying the output (.int) file. The output file is the file which Solar
Fire will use, when the "Interpretations Window" is opened, to read interpretations from.

>> To specify an output file
Do one of the following...
Enter the full file path and name into the "Output File" text box
or...
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Click on the File Selection button to the right of the text box - This will display a
standard windows dialog box allowing you to specify the folder and name of the
output file.
Note: For Solar Fire to be able to use the output file it MUST have an ".INT" file
extension. And generally it should also be placed in the "Solar Fire User files
\Interpretations" subfolder, so if you specify different locations or extensions then
you will have to copy the resulting output file to the correct location and give it the
correct extension before Solar Fire will recognize it as a valid interpretations file.
(There is an exception possible to this folder rule, but it is advised only for the
computer literate- see Interpretation Files)

>> To start the compilation
Click on the Compile button.
The compiler makes two passes of the input file/s. On the first pass the syntax of each
entered line of text is checked. If there are no errors, then a second pass is performed
during which the output file is created. You can see which pass is currently being
performed by looking at the Pass No. text box, and which keyword lines are currently
being read by looking at the Keyword text box. The compilation is complete when the
Pass No. text box contains the word “Finished”.
If the output file that you have selected already exists, then you will be asked whether or
not you wish to overwrite it. If you choose to do so, then the original copy of the output
file will only be deleted after the compiler has checked the syntax of your input files, and
starts its second pass. Therefore, if the compiler finds any syntax errors, the original file
will remain unchanged.
The compilation may take several minutes or more, depending on how much text has
been entered. You can stop the compilation at any time by clicking on the Stop button.
You can safely do this at any time during the first pass. If you do this during the second
pass of the compiler, then the output file will probably be useable by Solar Fire, but will
not contain all of the required text.
If there are syntax errors encountered, then an error message will be sent to the
"Compiler Messages" list box for each line which contains a syntax error. When the
compiler finishes, you can browse through these messages in order to pinpoint where
amendments must be made. You may need to refer to the File Layout specification in
order to determine how to correct the error. You can access the editing options of the
compiler by clicking on the Edit Text Files button.
If no errors are encountered, then the first line of the list box will say "Errors
Encountered: 0", and following this will be a list of the information types for which valid
input text was found. In this case, you will be able to use the output file in Solar Fire
successfully.

>> To exit from the interpretations compiler
Click on the Quit button.
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For information on how to select the interpretations file you have just compiled for
use in Solar Fire, see Changing the interpretations file.
9.11.3 Input File Layout
The easiest way to learn how to lay out a definition text file is to browse through a
definition file which you have decompiled from an interpretations file supplied with Solar
Fire. These will be wherever you have saved the definition file to. Any definition files
supplied by Solar Fire will be found in the "Interpretations" subfolder of the "Solar Fire
User Files" folder. (see Decompiling)
In any input file there are four types of lines which may legally appear. These are
comment lines, directive lines, keyword lines and text lines.
9.11.3.1 Comment lines

In a definition file comment lines are blank lines on which the first character is a
semicolon (;) or a formfeed. These are ignored during compilation. You can use them to
annotate your file with comments which you do not want to be included as
interpretations text. For example...
; The following section was written by John Smith on 17th Sept 1995
9.11.3.2 Directive lines

In a definition file directives lines are lines on which the first character is "#". These
allow you to tell the compiler to include a separate text file at this point in the current
file. You can "nest" these directives in up to five levels of files. The syntax is:
#include <filename>
... where <filename> is either a full path plus a filename, or just a filename without a
path. If no path is given, then the compiler assumes that the file is in the same folder as
the top level input file. Examples on a Windows 7 computer:
#include C:\Users\UserProfileName\Documents\Solar Fire User Files\Interpretations
\decans.txt
#include decans.txt
9.11.3.3 Keyword lines

In a definition file keyword lines are lines on which the first character is an asterisk (*).
These allow definition types to be specified. Any text lines following a keyword line will
be used as text relating to whatever item was defined on the keyword line. The keyword
line must be one of the following types:
* TITLE
eg *Title
* COPYRIGHT
e.g. * Copyright
* INTRODUCTION
e.g. *Introduction
* DEGREE degreenumber (1-360)
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e.g. *Degree 37
* DECANATE decanatenumber (1-36)
e.g. * Decanate 13
* QUADRANT quadrantnumber (1-4) [WEAK/STRONG]
e.g. *Quadrant 3
* HEMISPHERE hemispherename [WEAK/STRONG]
e.g. *Hemisphere Eastern Strong
* ELEMENT elementname [WEAK/STRONG]
e.g. *Element Fire Strong
* MODE modename [WEAK/STRONG]
e.g. * Mode Cardinal
* RAY raynumber (1-7) [WEAK/STRONG]
e.g. *Ray 7
* ASPECT aspectname [mappedname]
e.g. *Aspect Square Hard
* PHASE phasename
e.g. *Phase Balsamic
* housenumber [st,nd,rd,th] [house] [WEAK/STRONG]
e.g. *11th House
* signname [WEAK/STRONG]
e.g. *Aries
* pointname
e.g. *Moon
* pointname IN housenumber [st,nd,rd,th] [house]
e.g. *Sun in 1st House
* pointname IN signname
e.g. *Juno in Sagittarius
* signname ON housenumber [st,nd,rd,th] [house] [cusp]
e.g. *Aries on 3rd House Cusp
* pointname mappedaspectname pointname
(mappedaspectname must have previously appeared as a non-mapped aspect name or
as a mapped aspect name in a "*Aspect" keyword line. See below for more details.)
e.g. *Jupiter Hard Moon
* DYNAMICASPECTS
This is an optional keyword which need appear only once in the file, and should not
followed by any text lines. If it is present, then any keyword entries of the previous type
(point aspecting point) are assumed to relate to dynamic points aspecting radix points,
and the points are therefore not interchangeable. In this case a definition for the aspect
Pluto Trine Venus, for example, is stored separately from the aspect Venus Trine Pluto. If
the DYNAMICASPECTS keyword is not present, then keywords of the previous type are
assumed to relate to either a single chart, or to synastry between charts, in which case,
for example, Pluto Trine Venus is treated as being identical to Venus Trine Pluto. (This
means that if both of these were present in your file, the text for the first one would be
overwritten with the text for the second one.) See below for more details.
* SCORING type WEIGHTED/UNWEIGHTED ratioweak ratiostrong
(type must be one of QUADRANT, HEMISPHERE, ELEMENT, MODE, RAY, HOUSE, SIGN.
The items ratioweak and ratiostrong must be positive real numbers.)
e.g. *Scoring Element Weighted 0.5 1.5
Items in square brackets are optional, and uppercase keywords which are not in square
© 2014 Esoteric Technologies Pty Ltd

380

Solar Fire 9 User Guide

brackets are obligatory. Blanks between "*" and the next non-blank character are
ignored. Text is case insensitive (i.e. text can be entered in lower, upper or mixed case).
Names of chart points must not include blanks i.e. Part of Fortune becomes
PartofFortune, North Node becomes NorthNode, South Node becomes SouthNode, East
Point becomes EastPoint. See the name lists below.
Aspect Definitions
Aspect definitions relate aspects to their mapped aspect names. (Any aspects which do
not have a mapped aspect name in a "*Aspect" definition cannot be used in this set of
interpretations. If no *Aspect definitions appear then no "*Point aspect Point" definitions
can be entered later.) Note that *Aspect definitions must appear before any "*Point
aspect Point" definitions appear in the input file/s. For example:
*Aspect Conjunction Soft
This aspect combines the effects of the planets involved...
*Aspect Opposition Hard
This aspect indicates a conflict between the planets involved...
*Aspect Trine Soft
This aspect indicates an easy flow of energy...
*Aspect Square Hard
This aspect gives motivation...
*Aspect Semisquare
This aspect can result in frustration...
*Sun Hard Uranus
You are rebellious and unconventional...
*Sun Soft Uranus
You have a strong social conscience...
This would have the effect of creating two aspect types (Hard and Soft) which must then
appear with identical spelling in any "*Point aspecting Point" keyword lines. When the
application runs, when an interpretation is requested for a conjunction or trine between
the Sun and Uranus, then the interpretation text for the Soft aspect between those two
points is returned. Similarly the text for the Hard aspect is returned for the opposition
and square between those two points. No text is returned for any semisquare or other
type of aspect between those points (although text is returned for the definition of a
semisquare).
Note that if you are creating an interpretations file for transits, progressions or
directions to a radix chart, then you must include the *DYNAMICASPECTS keyword
somewhere in your file, in which case the first point of a “*Point aspecting Point”
keyword entry will always be assumed to be the dynamic point, and the second point will
be assumed to be the radix point. For example text entered after the “*Saturn Square
Sun” keyword entry will be used by Solar Fire only for dynamic Saturn squaring the Sun in
the radix chart, but will not be used for dynamic Sun squaring Saturn in the radix chart. If
you want Solar Fire to return text for dynamic Sun squaring Saturn, then you would have
to create a “*Sun Square Saturn” keyword entry.
You should NOT include the *DYNAMICASPECTS keyword if you are creating
interpretations for a single chart or for synastry between two like charts, in which case
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the order of points in a “*Point aspecting Point” is irrelevant. You need therefore create
only one entry for each pair of points. For example text entered after the “*Saturn Square
Sun” keyword entry will be used by Solar Fire for both Saturn squaring Sun and for Sun
squaring Saturn aspects.
Scoring for Balances
The "*Scoring" keyword allows you to specify how the balance of quadrants,
hemispheres, elements, modes and rays is calculated. If the "Weighted" keyword is
specified, then Solar Fire will apply a weighting factor to each chart point placement in
the chart. The weighting factor applied in each case may be modified by using the
Rulerships & Weightings Editor supplied with Solar Fire. If the "Unweighted" keyword is
used (or any other word than "Weighted"), then no weightings will be used. The ratios to
be specified are used to determine what score is WEAK and what is STRONG. Solar Fire
does this in the following way.
1. The score for each category (e.g. quadrant, element etc.) is calculated by finding
the number of chart points in each category, and multiplying each one by its
weighting if appropriate. (Note that the chart angles are always excluded in the
calculation for quadrants and hemispheres.)
2. The average score is found by summing the scores for each category and dividing
by the total number of categories (i.e. by 4 for quadrants, hemispheres and
elements, by 3 for modes, by 7 for rays)
3. If the score for any category is less than the average score times the "weakratio"
number, then it is considered to be WEAK in the chart. If the score is equal to or
greater than the average score times the "strongratio" number, then it is
considered to be STRONG in the chart.
Note: It is possible to prevent WEAK interpretations from appearing in the compiler by
specifying a "weakratio" of 0 (zero). Similarly it is possible to prevent STRONG
interpretations from appearing by specifying a large "strongratio" (e.g. 99.9).
Spelling of Keywords
The following lists indicate the exact spelling that must be used in the * header lines for
each interpretation. Abbreviations may be used only as truncations of these words, and
must be unambiguous e.g. "Ca" will cause an error if used as a sign abbreviation, but
"Can" or "Cap" will be accepted correctly as Cancer and Capricorn respectively.
SIGNS: Aries, Taurus, Gemini, Cancer, Leo, Virgo, Libra, Scorpio, Sagittarius, Capricorn,
Aquarius, Pisces
HOUSES: 1 to 12
ELEMENTS: Fire, Earth, Air, Water
MODES: Cardinal, Fixed, Mutable
HEMISPHERES: Eastern, Northern, Western, Southern
POINTS: Sun, Vulcan, Mercury, Venus, Earth, Moon, Mars, Jupiter, Saturn, Uranus,
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Neptune, Pluto, Chiron, Vesta, Pallas, Juno, Ceres, Hygeia, Astraea, NorthNode,
SouthNode, Ascendant, Midheaven, Vertex, EastPoint, PartofFortune, Cupido, Hades,
Zeus, Kronos, Apollon, Admetos, Vulcanus, Poseidon, TransPluto, BlackMoon
ASPECTS: Conjunction, Opposition, Trine, Square, Quintile, Sextile, Septile, SemiSquare,
Novile, Decile, UnDecagon, SemiSextile, BiQuintile, BiSeptile, TriSeptile, SesquiSquare,
BiNovile, QuadriNovile, SesquiQuintile, BiUndecagon, TriUndecagon, QuadriUndecagon,
QuinqueUndecagon, Quincunx, Parallel, ContraParallel
PHASES: NewMoon, Crescent,
ThirdQuarter, Balsamic

FirstQuarter,

Gibbous,

FullMoon,

Disseminating,

RAYS: 1, 2, 3, 4, 5, 6 7
9.11.3.4 Text lines

In a definition file any other line than a comment, directive or keyword line is considered
to be a text line. Text lines are always assumed by the compiler to relate to the last
keyword line that was read in by the compiler.
Note that any carriage returns or line feeds within the body of the text are ignored by the
compiler. In order to force text onto a new line, a "|" (vertical bar) character must be
used. e.g.
The quick brown fox jumped over these items:|A box|A tree|A hen
This will ensure that, when displayed in Solar Fire's "Interpretations Window", the last
three items each appear on a new line, as follows
The quick brown fox jumped over these items:
A box
A tree
A hen
Because the compiler ignores carriage returns, it does not matter how many words are
contained in each text line. You can put as many or as few words on a line as you wish.
When you run Solar Fire, the interpretation text lines are automatically formatted to fit
within the "Interpretations Window", whatever its size.
The limit to the amount of text that can be entered in relation to any one keyword is that
it cannot exceed about 40,000 characters (i.e. roughly 650 lines of 60 characters width).
There is no specific limit on how much text may be entered into any one interpretations
file. In practice you will be limited by the amount of available disk space on your
computer.

9.12

Format of the Orbital Elements File
Solar Fire’s “Other Bodies” report lists the positions of various astronomical bodies for
the time of any chart. The list of bodies that appear in this report may be edited by the
user, so that it is possible to add new bodies to the report, or to remove existing ones.
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>> To see the “Other Bodies” report
1. Select the Current Chart option from the Reports menu
2. In the Reports tab select Extra Bodies.
When Solar Fire is first installed, the bodies included are The Dark Moon (elements
according to Waltemath), and all of Charles Jayne’s hypothetical planets (Sigma, Pan,
Isis etc.)
The orbital elements for these bodies are contained in editable text files called
“extras.dat” and “jayne.dat”, in Solar Fire’s USERDATA folder. You can create any
number of similar files and select them from within Solar Fire, provided that you put
them in this same subfolder.
It is possible for the user to add orbital elements for any other geocentrically or
heliocentrically elliptically orbiting bodies. For example, you could add the elements of
recently discovered body QB1992. However it is not possible to add elements for
parabolic orbits, so you cannot add the Hale-Bopp comet, for example.
These files are comma-quote delimited (CQD), which means that they are text files in
which character strings are enclosed in quotes, and each item on a line is separated by a
comma from the next entry.
The data for a each body takes 8 lines of text, and must follow the prescribed format
exactly. Following is an example of how the data must be entered for a single body
(Sigma).
Example of Format
"***Name Abbr Symbol", "Sigma", "Sig", "S"
"BaseYr/Epoch/Geo/Prec.", 19350107.0, 0, 0, 1
"Semimajor Axis", 5.789593, 0, 0, 0
"Eccentricity", 0.26, 0, 0, 0
"Inclination (Degs)", 5.0, 0, 0, 0
"Perihelion (Degs)", 2.0, 0, 0, 0
"Node (Degs)", 161.0, 0, 0, 0
"Mean Anomaly (Degs)", 137.5489, 2584.1766225, 0, 0
A description of each of the 8 lines follows.
Line 1 - Comment, Name, Abbr, Symbol
Comment - (Text) This is for reference only, and contains a reminder of the items on this
line.
Name - (Text) This is the name of the body which will appear in reports in Solar Fire,
containing up to 20 characters.
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Abbr - (Text) This is a 3 or 4 letter abbreviation of the name of the body.
Symbol - (Text) This is a single character representing the body.
Line 2 - Comment, BaseYr, EpochYr, Geo/Helio Flag, Precession Flag
Comment - (Text) This is for reference only, and contains a reminder of the items on this
line.
BaseYr - (Numeric) The date (expressed either as a decimal year number YYYY.yyyyyyyy
or as a decimal year date YYYYMMDD.ddddd) for which the following orbital elements
were calculated..
EpochYr - (Numeric) The date (expressed either as a decimal year number YYYY.yyyyyyyy
or as a decimal year date YYYYMMDD.ddddd) of the standard ecliptic for which these
orbital elements were calculated. If this is set to 0 (zero), then the EpochYr is taken to be
the same as the BaseYr.
Geo/Helio Flag - (Numeric) Set to 0 (zero) if the orbit is a heliocentric one, or to 1 (one) if
it is a geocentric one.
Precession Flag - (Numeric) Set to 0 (zero) if the orbital elements apply to the Tropical
(precessing) zodiac, or to 1 (one) if the elements apply to the fixed zodiac of the EpochYr
date. When set to 1, the orbital elements are precessed to the date of the calculation,
whereas when set to 0, no precession is performed.
Lines 3 to 8 - Comment, Orbital Elements
Comment - (Text) This is for reference only, and contains a reminder of the items on this
line.
Elements - Each line has 4 numeric items. These items are used to calculate the
elements for a specific date in the following manner.
X = Item1 + Item2 * t + Item3 * t² + Item4 * t³
where t is time since the BaseYr date, expressed in decimal centuries (if the EpochYr
date is prior to yr 2000) or in decimal millennia (if the EpochYr date is yr 2000 or later).
In many cases where the elements are approximate, items 2, 3 and 4 may be zero.
However, they must still appear on the line as zeros, in this case.
Line 3 – Semi-Major Axis
This must be in astronomical units (1 = average earth/sun distance). This item is ignored
for bodies which have a geocentric orbit.
Line 4 - Eccentricity
This must be in units of eccentricity (0 = circular orbit).
Line 5 - Inclination
This must be the inclination of the orbit to the ecliptic, in degrees.
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Line 6 - Perigee/Perihelion
This must be the position of perigee or perihelion in degrees. (Note that this is not the
same as the “argument of the perihelion”, which is equal to the position of the
perihelion minus the position of the north node.).
Line 7 - Node
This must be the position of the north node in degrees.
Line 8 - Mean Anomaly
This must be the mean anomaly in degrees. If the second item on this line is set to 0
(zero), then the rate of change of mean anomaly is automatically calculated from the
semi-major axis instead, according to the formula:
Daily Motion = 0.9856076686 / (Semi-Major Axis)1.5
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Changing Settings
Solar Fire is highly and easily configurable by the user. Much of what is displayed in the
"View Chart" and other windows can be easily customized including the planets and
other points used, what aspects to use, what planets to show aspects for, and the colors
and size of each - sometimes on an individual basis. You can bring in external files
containing various items of data to expand the Solar Fire system, and also create your
own raw data.
You can readily switch between various glyphs, zodiacs, and house systems etc. that you
want to use, mostly on a chart by basis.Additionally rulerships and dignities, fixed stars,
arabic parts and planet weightings can all be customized. Various data entry defaults
can be set-up that make filling in dialog boxes quick and easy.
As well you can modify some of the calculations that Solar Fire uses to generate its data,
and modify aspects of the way Solar Fire itself works.
Generally, once you have altered any preferences to your liking, and set up a few
settings files the way you want them, you may not need to make many further changes
to settings in the program, especially to Preferences. Instead you will likely be able to
focus exclusively on what you want to do. Any changes that you might make would
probably be limited to just changing which "settings" files were selected to be currently
in use (i.e the "current" file of their type), and those kind of adjustments are very easy
and quick to do.
Preferences are settings that are all changed in one place - the "Preferences" tabbed
dialog box, accessed from the "Preferences" menu..
Most of the remaining settings in Solar Fire are stored in different types of files.
Accessed via the "Chart Options" menu
Points files (Displayed, User-defined, Transiting, Current chart, Extra ring, Aspected,
Extra Dynamic)
Aspect Set files
Color files (Aspect, Chart Point, Sign)
Asteroids files
Fixed Stars files
Arabic Parts files
Accessed via the "Utilities" menu
Rulerships and Weightings files
Dignity/Almuten files
Fixed Stars files
Arabic Parts files
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>> Setting a file to be current
Setting a file to be "current" means selecting it in the File Manager. The selected file
becomes the one currently used in the program for settings of that type (e.g.
"Displayed Points", "Aspected Points" etc are all different types of setting).
1. Access the setting type (e.g. off a menu such as one of the above).
2. This opens the "File Manager" with all the files for that type of setting displayed.
3. Select (click on) the file you want to be current.
4. Click on the Select button.
See Using the File Manager for more information.

10.1

Changing Preferences
It is possible to perform any of the following actions from the "Preferences" menu...
Editing current settings
Save all the current settings
Restore the previously saved settings
Switch on or off an option to save settings automatically upon exit
Edit the Toolbar buttons
Switch on or off various panels and bars on the Main Screen
The selection of each of these is described in detail in the following sections. Any
changes to the settings made by using the "Save Settings" option take effect
automatically when the program is next started up.

10.1.1 Saving and Restoring Settings
Whenever the program is started up, all current settings are read in from a SOLFIRE9.INI
file residing in the Solar Fire User Files settings folder of your computer. The program's
settings may be saved or restored at any time. Whenever the settings are saved, the
SOLFIRE9.INI file is updated, so that these will be retained for use next time the program
is started up.
These settings include such things as chart calculation options, compliments text, date
entry and display options, atlas type selection, email options etc.
Some additional items are also stored in this SOLFIRE9.INI file, but these are stored
automatically whenever they are changed, and do not depend on the user selecting a
save option. These include things like the default place, report screen’s modulus and
orb, the dynamic report entry screen’s selection, the dynamic report sort order etc.
>> To save all the current settings in the program
Choose the Save Settings option from the Preferences menu.
This will display a dialog box asking you to confirm whether or not you wish to
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overwrite the previously stored selections. Selecting the Cancel button will prevent
any action from being taken. Selecting the OK button will save the current settings.
>> To restore all the previously saved settings in the program
Choose the Restore Settings option from the Preferences menu.
This will display a dialog box asking you to confirm whether or not you wish to
overwrite the current selections. Selecting the Cancel button will prevent any action
from being taken. Selecting the OK button will restore the previously saved settings
and make them the current settings.
Note that it is not possible to save or restore settings individually - all settings are saved
or restored together.
10.1.2 Save Settings on Exit
It is possible to ensure that any alteration made to settings and defaults (described
above) are saved automatically whenever the user exits from the program.
>> To switch the Save Settings on Exit option on or off
Choose the Save Settings on Exit option from the Preferences menu.
This will switch on the option if it is currently off, or switch it off if it is currently on.
When the save on exit option is switched on, a tick appears to the left of this item on
the menu. If there is no tick then it is currently switched off.
10.1.3 Editing Settings
Choose the Edit Settings option from the Preferences menu. This will display the
"Preferences" dialog with various tabbed panels (often referred to as "Tabs") grouping
the available options into various topics.
10.1.3.1 Calculations

Calculation settings can be changed via the "Preferences" menu, "Edit Settings" option,
"Calculations" tab in the "Preferences" dialog.
10.1.3.1.1 Lunar Node Type

The lunar node is one of the chart points which may be displayed in any chart or grid. In
the "Preferences" dialog, "Calculations" tab it is possible to select the lunar node as
either the true node or the mean node.
True Node - is the real position of the moon's node at any time.
Mean Node - is the position of the moon's node according to a mathematical
formula which ignores many of the minor perturbations in its orbit.
Any chart display or report indicates which type of lunar node has been used during its
calculation. The lunar node type is not saved with a chart - it is only applied when a
chart is being calculated.
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10.1.3.1.2 Part of Fortune Type

The way in which the Part of Fortune, as displayed in charts, is calculated may be
selected by the user. In the "Preferences" dialog, "Calculations" tab the following
options are available...
Different Day/Night - According to researchers of ancient astrological texts, the correct
method of calculating the Part of Fortune is to use ASC+Moon-Sun for daytime charts,
and ASC+Sun-Moon for nighttime charts.
Fixed Formula – (Daytime Only) Many astrological programs in the past (including
earlier versions of Solar Fire) have used a calculation for the Part of Fortune which is
based on a single formula for both day and night charts i.e. ASC+Moon-Sun. Although
this is now thought to be incorrect, many astrologers have become accustomed to using
it in this way, so this option is included for their convenience.
Any charts subsequently opened or calculated will use the newly selected calculation
type.
Note that this option affects the position of the Part of Fortune as shown in charts and
all reports with the exception of the Arabic Parts report of Solar Fire. If you wish to alter
the calculation of the Part of Fortune in the Arabic Parts report, then you must use the
Arabic Parts Editor.
10.1.3.1.2.1 Black Moon Type

The Black Moon is one of the chart points which can immediately be displayed in any
chart or grid – also sometimes known as the Black Moon Lilith. This point is the empty
focal point of the Moon’s orbit around the earth, which is also the apogee of the Moon’s
orbit.
In the "Preferences" dialog, "Calculations" tab it is possible to select the Black Moon as
either the true (osculating) apogee or the mean apogee.
True Apogee - is the position of the moon's apogee, taking into account short term
fluctuations (osculations) in the plane of the moon’s orbit.
Mean Apogee - is the position of the moon's apogee according to a mathematical
formula which ignores many of the minor perturbations in its orbit.
The selected Black Moon type is not saved with a chart - it is only applied when a chart
is being calculated.
Note: Other objects called Lilith are also sometimes used in astrology. These are not the
same as the Black Moon Lilith. (See How do I display all three Liliths? for more
information).
10.1.3.1.3 Optional Correction Factors

In the "Preferences" dialog, "Calculations" tab you can set astronomical corrections to be
applied.
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10.1.3.1.3.1 Apply Geocentric Correction to Latitude

It is possible to calculate charts based either on geographic (also known as geodetic)
latitude or geocentric latitude.
Atlases such as the ACS International Atlas and the ACS American Atlas contain
geographic latitudes. Geographic latitudes are based on the measurement of the angle
of the local horizon (also known as the geodetic horizon) onto the celestial sphere. It is
assumed that all latitudes entered into Solar Fire are geographic latitudes, and all
displayed latitudes, such as in chart details text, are geographic latitudes.
However, because the earth is not perfectly spherical it is also possible to define a
latitude based on where the horizon would be if the earth was a perfect sphere, which
also corresponds to the angle of a line from that location to the center of the earth. This
is known as a geocentric latitude. The geocentric latitude is never more than 12 minutes
of a degree different from the geographic latitude.
There are arguments for and against using each of these types of latitude. Astrologers
are divided about which is the most appropriate to use.
Solar Fire always displays latitudes as a geographic latitudes. However, when this option
is on, any chart calculations performed will have a correction applied to the latitude to
convert it from geographic to geocentric. Any chart that has had this correction applied
will have a “G” appended to its latitude. For example, a geographic latitude of 34°S55’ is
displayed as 34°S55’G when this option is on.
In order to determine exactly what the geocentric correction is, you must view a “Chart
Analysis” report for the chart. If the geocentric correction has been applied, then this will
be specified in the report, and the corrected geocentric latitude will be shown as well as
the originally entered geographic latitude.
In the "Preferences" dialog, "Calculations" tab you can specify whether to apply
geocentric correction or not.
Any charts opened or calculated, or dynamic reports generated are calculated according
to the current setting of this option.
10.1.3.1.3.2 Apply Parallax Correction to Moon

Traditionally, the planet’s positions are calculated as if they were observed from the
center of earth (hence “geocentric”). However, as the moon is much closer to the earth
than the other planets, certain geometrical effects come into play that are negligible for
the other planets. In particular, due to the moon’s proximity to the earth, it appears to be
in a slightly different zodiacal position depending on where on earth it is observed from.
This effect is known as lunar parallax (or also as a “topocentric” coordinate system).
Typically, this can make a difference to the moon’s longitude of the order of 1 degree.
Thus, if the moon is near the end of a sign, applying this correction can actually put the
moon into the next sign in same cases.
In the "Preferences" dialog, "Calculations" tab you can specify whether to apply parallax
correction or not.
Any charts opened or calculated, or dynamic reports generated are calculated according
to the current setting of this option. When this option is switched on for a particular
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chart, the chart details text has an additional line indicating that the parallax correction
has been made.
Note that, although the altitude of the observer also makes a small difference to the
parallax calculation, it is negligible in comparison with the observer’s location, so is
ignored by Solar Fire. For example, an altitude of 3000 meters makes a maximum
difference of only 2 to 3 seconds of arc in the moon’s position, and it is usually less than
this.
10.1.3.1.4 Void Of Course

The Moon is usually said to be “void of course” (VoC) after it has made its last aspect to
another planet in its current sign, and the void of course period ends when the Moon
makes it ingress into the next sign. Thus there is a VoC period corresponding to every
time the Moon comes to the end of a sign, approximately each 2 ½ days, and the length
of this VoC period can vary depending on the positions of all the other planets in the
chart. This is generally held to be a pause or still period, where new initiatives tend not
to go anywhere, generally because the necessary energy for the initiative is lacking.
The end of a VOC period is always the ingress into a new sign, which re-energizes the
Moon. The beginning is usually when the last aspect the Moon can make to a planet or
the Sun has come to perfection (i.e. become exact, 0º orb). There is one exception – in
the rare case where the Moon is applying to an aspect with a planet (which is in the late
degrees of a sign) and then the planet the Moon is aspecting moves into the next sign
(following the one it had been in) before the Moon reaches the position where the
aspect is perfected, then the VoC period begins at that time.
Consider the following three example Void of Course events below. In this Dynamic
Report format (V) indicates the start of VoC, and (S) indicates the Moon’s ingress into a
sign, signifying the end of that particular VoC.
P1 (H)

Asp

P2 (H)

EXL

Date

Time

Pos1

Pos2

Mon (5) Sxt

Mar (7)

(V)

Feb 16 2015

8:18:06 PM

27°Cp33' D

27°Pi33' D

Mon (6) Cnj

Aqu (6)

(S)

Feb 17 2015

12:14:14 AM

00°Aq00' D

00°Aq00' D

Mon (6) Cnj

Sun (6)

(V)

Feb 18 2015

11:48:22 PM

29°Aq59' D

29°Aq59' D

Mon (7) Cnj

Pis (7)

(S)

Feb 18 2015

11:48:33 PM

00°Pi00' D

00°Pi00' D

Mon (7) Cnj

Ven (7)

(V)

Feb 20 2015

8:06:33 PM

28°Pi02' D

00°Ar00' D

Mon (8) Cnj

Ari (8)

(S)

Feb 20 2015

11:14:05 PM

00°Ar00' D

00°Ar00' D

The first VoC begins with the Moon's exact sextile to Mars at 8:18pm (shown be the "V"
in the "EXL column), with no further exact aspects until 12:14am, for a VoC period of
almost 4 hours. The next one is extraordinarily short; the Moon is conjunct the Sun just
11 seconds before it moves into Pisces, so technically the VoC lasts only 11 seconds. In
both of these cases the VoC period begins with the exact aspect, reflected by the same
degrees and minutes of the positions of the two points in the Position columns.
The third VoC, on February 20, is one of the rare ones that begins when a planet (other
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than the Moon) moves into it's next sign. The moon is moving through Pisces,
approaching a conjunction with Venus. But at 8:06pm, Venus enters Aries, and there are
no other exact aspects before the moon follows into Aries at 11:14pm. This means that
there’s no longer any energy building for the Moon in the sign of Pisces, and so the VoC
period is considered to begin at that moment. This unusual situation can be detected in
the report by looking at the Position columns for the VoC event, where the degrees and
minutes of the Moon and Venus are different (and not the same as usual). So even
though the Moon in Pisces is still in applying aspect to Venus in Aries (and so the Moon
hasn't finished making it's last aspect to another planet before the Moon ingresses into
it's next sign) the VoC Period is said to have begun.
VoC calculations always use the primary five aspects – Conjunction, Opposition, Trine,
Square, and Sextile. The possible options for VoC calculations are as follows, and are
available in In the "Preferences" dialog, "Calculations" tab:
Modern - uses aspects to the Sun, Mercury, Venus, Mars, Jupiter, Saturn, Uranus,
Neptune and Pluto.
Traditional - uses aspects to the Sun, Mercury, Venus, Mars, Jupiter, Saturn.
Lilly – uses aspects to the Sun, Mercury, Venus, Mars, Jupiter, Saturn. The signs
Taurus, Cancer, Sagittarius and Pisces are deemed never to have void of course
occurring in them.
10.1.3.1.5 Vulcan Calculation

As Vulcan is a hypothetical planet, there is no officially accepted ephemeris for the
calculation of its position. However, two of the more widely used methods of calculating
its position have been included in Solar Fire, and it is possible to choose which of these
methods you would like to be used whenever Vulcan’s position is calculated. In the
"Preferences" dialog, "Calculations" tab the possible methods are...
L.H.Weston - Professor Weston produced a set of orbital parameters for Vulcan based
on a number of supposed sightings during last century and early this century. This
proposed orbit has Vulcan orbiting the Sun once every 19.5 days, and having a maximum
orb of about 8° from the Sun, as observed from the earth. The complete theory is
published in the booklet “The Planet Vulcan”, published by the American Federation of
Astrologers, Inc. Some doubt has been cast on the correspondence of this proposed orbit
with the observations on which it is based, but no alternative has yet been proposed.
D.Baker - Dr Baker has documented a theory for Vulcan based on a quantum mechanical
type of behavior. Vulcan is positioned 3° from Mercury in the direction of the Sun. If
Mercury is within 3° of the Sun, then Vulcan is conjunct the Sun. It is always on the same
side of the Sun as Mercury. The full rationale behind this concept is explained in his
Dictionary of Astrology.
When this option is changed, any charts that are subsequently opened or calculated will
use the newly selected calculation method, but charts that have already been calculated
retain the option that was in effect when they were calculated.
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10.1.3.1.6 Ray Weightings

The Rays are the seven primary energetic influences proposed and described in various
works relating to esoteric astrology and philosophy.
Each sign is considered to be influenced by a subset of rays, and possibly in varying
proportions. In the "Preferences" dialog, "Calculations" tab two of the most commonly
used schemes for assigning weightings to the rays influencing each sign are provided as
options.
Equal – This scheme is based directly on tabulations in the book “Esoteric
Astrology” by Alice A. Bailey, and assumes that each ray influencing a sign does so
in equal proportion.
D.Baker – This scheme is based on the works of Dr. Douglas Baker, and assumes
that the rays influence each sign disproportionately.
Sign

Equal

D.Baker

Aries

1 = 50% ; 7 = 50%

1 = 40% ; 7 = 40% ; 6 = 20%

Taurus

4 = 100%

4 = 70% ; 1 = 20% ; 5 = 10%

Gemini

2 = 100%

2 = 80% ; 4 = 10% ; 3 = 10%

Cancer

3 = 50% ; 7 = 50%

3 = 40% ; 7 = 40% ; 6 = 20%

Leo

1 = 50% , 5 = 50%

1 = 40% ; 5 = 30% ; 2 = 30%

Virgo

2 = 50% ; 6 = 50%

6 = 60% ; 2 = 30% ; 5 = 10%

Libra

3 = 100%

3 = 80% ; 1 = 10% ; 5 = 10%

Scorpio

4 = 100%

4 = 80% ; 6 = 20%

Sagittarius

4 = 33.3% ; 5 = 33.3% ; 6 = 33.3%

4 = 40% ; 5 = 30% ; 6 = 30%

Capricorn

1 = 33.3% ; 3 = 33.3% ; 7 = 33.3%

3 = 40% ; 1 = 40% ; 5 = 20%

Aquarius

5 = 100%

5 = 40% ; 7 = 40% , 4 = 20%

Pisces

2 = 50% ; 6 = 50%

2 = 50% ; 6 = 40% ; 1 = 10%

Whichever option is selected here will affect any Ray tabulation page objects and
interpretation reports that include a balance of Rays section, when they are
subsequently produced.
10.1.3.1.7 MC in Polar Regions

Historically, astrology has been developed mainly in temperate latitudes, and therefore
the mathematical problems that occur in polar regions have not received much attention
in astrological texts. As a result, many modern astrology programs have failed to deal
with these issues in a consistent manner.
The crux of the problem is that the normal (temperate latitude) way of defining chart
angles and houses breaks down in polar regions. In these latitudes, it becomes possible
for the Ascendant to retrograde, and for certain portions of the zodiac never to rise at all.
Generally, except in some very specific polar locations, it is always possible to identify
the Ascendant as that part of the zodiac that is rising across the horizon (even though it
may in fact be retrograding), and this happens to occur always in the Eastern horizon.
However, there are two different ways of determining the Midheaven (MC), which
sometimes give diametrically opposed answers for its position in the zodiac.
© 2014 Esoteric Technologies Pty Ltd

Changing Settings

395

Always towards equator – In this case the MC is defined as the intersection of the
prime meridian with the ecliptic, towards the equator (or more precisely the
ecliptic). This means that the MC is always due south in northern polar regions (and
conversely is due north in southern polar regions), even though, on those days when
the Sun does not rise, the MC also remains below the horizon. Another consequence
of this definition is that the MC is the same for any location along a line of
longitude, right from one pole to the other.
Always above horizon – In this case the MC is defined as the intersection of the
prime meridian with the ecliptic, above the horizon. This means that the MC is
always above the horizon (even when the Sun does not rise during the day), but as a
consequence, the position of the MC in the zodiac jumps by 180 degrees (i.e. has a
discontinuity) as you move along a line of longitude from the equator to the winter
pole.
When this option is changed in the "Preferences" dialog, "Calculations" tab, any charts
that are subsequently opened or calculated will use the newly selected calculation
method, but charts that have already been calculated retain the option that was in effect
when they were calculated.
10.1.3.2 Progs/Dirns

From the "Preferences" menu, "Edit Settings" option, the "Progs/Dirns" tab in the
"Preferences" dialog has progressions and directions settings you can edit.

Settings (User Preferences) - Progs/Dirns tab
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10.1.3.2.1 Chart Angle Progression Type

When charts are progressed, it is normal to progress all the planets according to the
prescribed progression rate, but to apply a separate calculation to determine the
position of the Midheaven (MC), and then to derive the other chart angles (Ascendant,
Vertex, Equatorial Ascendant) from that newly calculated MC. In the "Preferences"
dialog, "Progs/Dirns" tab Solar Fire includes 5 different methods by which the MC’s
progressed position may be calculated. These methods are as follows...
True Solar Arc in Longitude - The MC’s longitude is progressed by the same
longitude arc as the Sun. This method is possible the most commonly used method
today.
True Solar Arc in Right Ascension - The MC’s right ascension is progressed by the
same right ascension arc as the Sun
Naibod in Longitude - The MC’s longitude is progressed at the rate of the mean
motion of the Sun in longitude (this is 0°59’08’’ per day). This method is also widely
used.
Naibod in Right Ascension - The MC’s right ascension is progressed at the rate of
the mean motion of the Sun in right ascension (this is 3m56.5s of arc per day).
Mean Quotidian - The MC is progressed by the same method as the planets, thus
moving about 361° per day, as opposed to the Sun’s movement of about 1° per day.
This method is also known as “Daily Houses”.
You can select your desired method from the drop-down list. Any progressed charts or
dynamic reports involving progressions that are subsequently calculated will use the
newly selected angle progressions method. It is possible to determine which angle
progression method has been used in a progressed chart by checking the chart type in
the chart details text - the chart type description includes the angle progressions method
that was used. Similarly, it is possible to determine which rate was used in a dynamic
report by looking at the list of selected events in the report header. This contains a
description of the progression type, method and rate.
10.1.3.2.2 Progression Day Type

When charts are progressed by secondary or tertiary rate, it is possible to base the
progression rate on either a solar day or a sidereal cycle. (Minor progressions are not
based on days, so are not affected by this option). The solar day is the time taken for the
sun to move from the Midheaven on one day to the Midheaven on the next day - that is
24hrs. This is the standard rate, also known as Q2. This is the rate that is in most
common use by western astrologers. The sidereal cycle is the time taken for a fixed star
to move through 24hrs of arc, which is slightly more than 24hrs of clock time. This is the
Bija rate, also known as Q1. Astrologers who use the sidereal zodiac sometimes use this
rate. The ratio of the standard rate to the Bija rate is 0.997269566.
When you change this option in the "Preferences" dialog, "Progs/Dirns" tab, any
progressed charts or dynamic reports involving progressions that are subsequently
calculated will use the newly selected progression day type. It is possible to determine
which progression day type has been used in a progressed chart by checking whether the
chart type in the chart details text - this includes either Q1 or Q2 in its name. Similarly, it
is possible to determine which rate was used in a dynamic report by looking at the list of
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selected events in the report header. This contains a description of the progression type,
method and rate.
10.1.3.2.3 Rate for User Defined Progs

In addition to the secondary, tertiary and minor rates of progression, it is possible for the
user to specify their own rate. The existing rates that are pre-defined are as follows...
Secondary Rate - one day per solar year = 1 / 365.24219907 = .00273790926
Mean Tertiary Rate - one day per lunar cycle = 1 / 27.32158648 = .03660109676
Minor Rate - one lunar cycle per solar year = 27.32158648 / 365.24219907 =
.07480402242
You can define your own rate by simply working out the required ratio e.g. if you wish to
use a lunar progression rate
Lunar Progression Rate = 1 day per lunation cycle = 1 / 29.53059027778 =
.033863190359
In the "Preferences" dialog, "Progs/Dirns" tab you can select a previously entered rate
from the drop-down list or simply enter a new progression arc rate as a decimal number.
The last ten rates that you enter here are stored in the list for easy reselection later.
The progression rate selected here will be used whenever you select to use the User
Progressed chart method when creating a progressed chart from the Progressed option
of the Charts menu. This rate is also used in dynamic reports whenever you select User
Rate from the Progression Type option of the “Dynamic Report Selection” screen.
10.1.3.2.4 Rate for User Defined Directions

In addition to the solar arc, ascendant arc and vertex arc rates of direction, it is possible
for the user to specify their own annual direction rate, for use in casting directed charts
or in dynamic reports. The existing arc rates that are pre-defined are as follows.
Solar Arc - the arc of the secondary progressed Sun. This has an average rate of
motion of about 1 degree per year.
Ascendant Arc - the arc of the ascendant, as derived from the Midheaven when it
is progressed by the secondary progressed solar arc. This has an average rate of
motion of about 1 degree per year, but varies somewhat.
Vertex Arc - the arc of the vertex, as derived from the Midheaven when it is
progressed by the secondary progressed solar arc. This has an average rate of
motion of about 1 degree per year, but varies somewhat.
In the "Preferences" dialog, "Progs/Dirns" tab you can define your own fixed rate in
terms of annual longitudinal motion in degrees. You can select a previously entered rate
from the drop-down list or simply enter an annual arc rate in degrees and minutes, or in
decimal degrees. See Entering Angles for a more detailed descriptive of acceptable
formats for entering angles. The last ten angles that you enter here are stored in the list
for easy reselection later.
The direction rate selected here will be used whenever you select to use the User Arc
Directed chart method when creating a directed chart from the Progressed option of
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the Charts menu. This rate is also used in dynamic reports whenever you select User Arc
from the Direction Type option of the “Dynamic Report Selection” screen.
10.1.3.2.5 Rate for Primary Directions

When primary directions are calculated in a Dynamic report or in a Page object, there are
several different methods of determining the exact rate of direction. The Primary
Direction rate is always about one year of life per degree of directed arc, but in the
"Preferences" dialog, "Progs/Dirns" tab any of the following options may be selected...
(Ptolemy) 1 Year per Degree - The progression rate is exactly one degree of arc for
each year of life.
Naibod (1 Year for 59’08’’) - The progression rate is 59’08’’ of arc for each year of
life, which is the average amount that the sun moves in a day (360 degrees / 365.242
days in a year).

Cardan (1 year per 59'12") - The progression rate is 59’12” of arc for each year of
life.
Kepler - Natal Solar Rate in RA - The amount that the sun moves in Right Ascension
on the actual day of birth is computed; the progression rate is then this amount for each
year of life (also known as Brahe’s key.)

Natal Solar Rate in Longitude - Similar to Kepler’s key, only computed based on the
sun’s motion in Longitude on the day of birth.

Placidus - True Solar Arc in RA - This is different from the others in that it’s not a
fixed rate per year; instead, for a given arc of direction, we find how many days it
takes the sun to travel that arc (in right ascension) after the moment of birth; that
number of days is then used as the number of years.
Rate for User Directions - The progression rate is the value set in the “Rate for
User Directions” (in this same preferences dialog) per year of life.
Any dynamic reports or page objects which use Primary Directions that are subsequently
calculated or displayed will use the newly selected calculation method.
In addition in a Dynamic Report you can opt to have dynamic positions calculated in
converse. Prior to Solar Fire 9 all such calculations were based on the Modern method of
conversing points, but now you have a choice (see Primary Directions in Solar Fire). You
can choose between...
Classical Converse
This sets Primary Directions to compute converse according to the classical
technique, where the direction of a point A to some point B behind it (in converse
motion) in computed in exactly the same fashion as the direction of point B to point
A in direct motion, and results in the same arc and timing.
Modern Converse
This sets Primary Directions to compute converses according to a more recent
technique, pioneered in the 19th century, where the direction of a point A to some
point B behind it is computed using the usual equations, as though A were to move
backwards in the sky to B, producing a negative arc; this arc is then flipped to
positive before converting to a date. (Generally this is a different number from the
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direct motion of B to A.)
10.1.3.2.6 Prog/Dirn Relocation Option

This is a special option that relates to relocating progressed and directed charts. In
normal operation, when calculating progressed or directed charts, if a new location is
entered by the user, then the resulting chart is calculated as if the natal chart had been
relocated to that new location before the progressions or directions are applied.
However, when this option is enabled in the "Preferences" dialog, "Progs/Dirns" tab, the
resulting chart is calculated as if the natal chart was relocated only to the latitude of the
new location before the progressions or directions are applied (the longitude remains
unchanged). This applies to the calculation of progressed and directed charts as well as
to the calculation of progressions and directions in the dynamic reports.
10.1.3.3 Zodiac

From the "Preferences" menu, "Edit Settings" option, the "Zodiac" tab in the
"Preferences" dialog has zodiac related settings you can edit.
10.1.3.3.1 Default Zodiac

In the "Preferences" dialog, "Zodiac" tab it is possible to specify which zodiac is used for
any chart calculations. Typically, western astrologers use the Tropical zodiac, which has
its starting point where the Sun is when it crosses the equator northwards. However,
many eastern (Vedic) astrologers use a Sidereal zodiac that has a starting point that is
fixed against the constellations, and is currently roughly 25-30 degrees earlier than the
tropical zodiac’s starting point. The exact difference depends upon which ayanamsa that
is used. The Draconic zodiac is used less commonly – it sets the 0 Aries point from
position of the moon’s north node.
An ayanamsa is the longitudinal difference between the Tropical zodiac and a Sidereal
Zodiac. This difference changes with time, due to the precession of the equinoxes, but
may be defined as a fixed difference at a specific date, such as 1st Jan 1900. If you
select Sidereal (Vedic) as the default zodiac then you can select ayanamsa in the
Ayanamsa for Sidereal Charts. There are certain standard ayanamsas that are used by
astrologers, and the most common of these are available for selection. Any that are not
displayed may be selected by choosing the SVP 00°Ar00'00'' item, and selecting or
entering a value into the SVP on 1st January 1900 textbox. (SVP stands for Sidereal
Vernal Point).
Tropical

Precessing vernal point - Normally used in western astrology

Fagan-Bradley

Standard western astrologers' sidereal ayanamsa

Lahiri

Official Indian government ayanamsa

DeLuce

According to Robert DeLuce in "Constellational Astrology"

Raman

According to B.V.Raman of India

Usha-Shashi

According to Usha-Shashi in "Hindu Astrological Calculations"

Krishnamurti

According to K.S.Krishnamurti

Djwhal Khul
Sri Yukteswar

Based on the assumption that the age of Aquarius starts in the year 2117, as
proposed by some students of the Ageless Wisdom.
According to Sri Yukteswar

JN Bhasin

According to JN Bhasin

Larry Ely

According to Larry Ely
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Takra I

According to Takra – variant I

Takra II

According to Takra – variant II

Sundara Rajan

According to Sundara Rajan

Shill Pond

According to Shill Pond

User Defined

Allows you to enter your own ayanamsa in terms of the position of the Sidereal
Vernal Point at 1st January 1900 for that ayanamsa. Angles may be entered in
degrees, minutes and seconds (e.g. "334 27 32") or using zodiacal sign (e.g. "4 Pi
27 32"). See Entering Angles for more information on entering angles.
Based on position of the moon’s north node

Draconic

Any charts subsequently cast will use the newly selected zodiac type. It is possible to
see which zodiac has been used in any chart, as it appears as part of the chart details
that are displayed in the "Current Chart" box of the Main Screen.
Note that a few page objects (such as Vedic Dasa tabulations) always use a sidereal
zodiac, even when the selected default zodiac is tropical. The sidereal zodiac that is
used for these objects is the Ayanamsa for Sidereal Charts.
10.1.3.3.2 Zodiac Application

In the "Preferences" dialog, "Zodiac" tab...
Use default zodiac only when casting new charts – When this option is selected, any
charts that are opened from chart files will be calculated using the zodiac type with
which they were stored. New charts are calculated using the selected default zodiac.
This is how previous versions of Solar Fire worked.
Use default zodiac for both new and opened charts - When this option is selected,
any charts that are opened from chart files will be calculated using the selected
default zodiac type, instead of the zodiac with which they were stored. This effectively
overrides the zodiac type stored with charts.
10.1.3.3.3 Zodiac Related Options

In the "Preferences" dialog, "Zodiac" tab this option should be checked unless you
deliberately wish to use vedic calculation methods on charts with non-sidereal zodiacs.
When it is checked, attempting to use "Charts", "Vedic" to calculate a chart with a nonsidereal zodiac will produce a warning message. When it is unchecked, there is no
warning message.
10.1.3.4 Houses

From the "Preferences" menu, "Edit Settings" option, the "Houses" tab in the
"Preferences" dialog has house related settings you can edit.
10.1.3.4.1 Default House System

In the "Preferences" dialog, "Houses" tab you can select a house system which is the
one used by default for all new tropical charts in Solar Fire, and optionally also for all reopened charts as well.
You can also select a second house system which is the one used by default for all new
charts which are cast with a sidereal zodiac. This may be the same, or different from the
first house system.
The available house systems are as follows...
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Campanus - Uses the prime vertical as the fundamental circle, divided into 12 equal
lunes. Derived in the 13th century by mathematician Johannes Campanus.
Koch - One of the most commonly used systems. Similar to Alcabitius, except that
the degree of the Midheaven is moved back to the ascendant before the ascendant
is moved towards the Midheaven. Recently derived (1940s).
Meridian - Also known as the Axial system.
Morinus - Uses the equator as the fundamental circle, divided into 12 equal arcs
starting from the projection of the ascendant onto the equator. Attributed to Jean
Baptiste Morin in the 17th century.
Placidus - One of the most commonly used systems. Derived by determining the
points on the ecliptic whose semi-diurnal arcs exactly trisect their quadrant.
Derived by Placidus de Tito in the 17th century.
Porphyry - Each quadrant is dissected by longitude into three equal houses.
Originated in the 3rd century AD.
Regiomontanus - Similar to Campanus, but uses the celestial equator as the
fundamental circle. Derived by Johannes Muller.
Topocentric - Based on the rotation of the horizon line, cutting the ecliptic at equal
spaces in equal time. Recently derived (c 1961) by Vendel Polich and Anthony Page.
Equal - Equal system with the 1st house cusp set to the Ascendant. First described
by Ptolemy in his book Tetrabiblos.
Aries - Equal system with 1st house cusp set to 0° Aries
Solar Sign - Equal system with 1st house cusp set to 0° of the Sun’s sign
"Planet" on 1st - Equal systems with 1st house cusp set to that planet’s longitude
Vertex on 7th - Equal system with 1st house cusp set opposite to the Vertex
MC on 10th - Equal system with 10th house cusp set to the Midheaven’s longitude
Whole Signs - Equal system with 1st house cusp set to 0° of the Ascendant’s sign
Hindu Bhava - Based on the Porphyry system, but with the cusps shifted to the
midpoints of the Porphyry houses, so that the Ascendant falls in the middle of the
first house.
Alcabitius - Time based system, based on the trisection of the diurnal arc of the
ascendant traveling towards the Midheaven.
ASC in 1st - Equal system with center of 1st house set to the Ascendant.
Whole Signs (Fortune) - Equal system with 1st house cusp set to 0° of the Part of
Fortune's sign.
Whichever house system you highlight in the list will become the new default house
system.
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10.1.3.4.2 Asc/MC Display Option

Normally, even if the Ascendant and Midheaven are selected as displayed points, they
are not shown as chart points inside the chart wheel. The only exceptions to this rule are
when these points are not identical to the 1st and 10th house cusps respectively. The
reason for this behavior is to avoid putting superfluous information into the chart, thus
avoiding clutter. However, in the "Preferences" dialog, "Houses" tab there are two
options which you may switch on to alter this behavior...
Show ASC even when 1st House Cusp – When switched on, this option ensures that
the Ascendant is always displayed in a wheel as a chart point, even when it is also the
1s t house cusp.
Show MC even when 10th House Cusp – When switched on, this option ensures that
the Midheaven is always displayed in a wheel as a chart point, even when it is also the
10th house cusp.
10.1.3.4.3 Composite Chart Houses

This option applies only to the calculation of "Composite – Midpoints" charts. In most
cases the calculation of these charts is straightforward, and the house cusps of the chart
are simply the midpoints of the same house cusps in the two base charts. However, if
the house cusps of the two base charts are almost diametrically opposed, then it is
possible that a chart made up of the short-arc midpoints of the base chart’s house cusps
will have its cusps out of zodiacal order. When this happens, Solar Fire will adjust some
of the house cusps to be long-arc midpoints instead of short-arc in order to preserve the
correct zodiacal ordering of the houses. In the "Preferences" dialog, "Houses" tab you
can specify any of the three following ways that this adjustment is to be made...
Auto Anchor – The 1s t and 10th house cusps of the base charts are tested to see
which one has the “strongest” composite midpoint, and then that cusp is taken as a
short-arc midpoint, and other house cusps adjusted as required to maintain correct
zodiacal order of the cusps. The “strongest” midpoint is the one in which the short-arc
difference in angle between the cusps on the two base charts is a minimum.
Anchor on 1st House – The 1s t house cusp is always taken as the short-arc midpoint,
and other house cusps adjusted as required to maintain correct zodiacal order of the
cusps.
Anchor on 10th House - The 10th house cusp is always taken as the short-arc
midpoint, and other house cusps adjusted as required to maintain correct zodiacal
order of the cusps.
10.1.3.4.4 House System Application

In the "Preferences" dialog, "Houses" tab...
Use this house system only when casting new charts – When this option is selected,
any charts that are opened from chart files will be calculated using the house system
with which they were stored. New charts are calculated using the selected default
house system (depending on which zodiac they use).
Use this house system for both new and opened charts - When this option is
selected, any charts that are opened from chart files will be calculated using the
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selected default house system, instead of the house system with which they were
stored (depending on which zodiac they use). This effectively overrides the house
system stored with charts.
10.1.3.5 Points

From the "Preferences" menu, "Edit Settings" option, the "Points" tab in the
"Preferences" dialog gives you the ability to select the order in which you prefer the
planets to be listed in reports, tabulations and grids.
Highlight a point that you wish to adjust, and then use the Move Point Up or Move
Point Down buttons until it is in the required position in the list.
You can reset the entire list to Solar Fire’s initial default order by clicking on the Reset to
Default button.
10.1.3.6 Glyphs

From the "Preferences" menu, "Edit Settings" option, the "Glyphs" tab in the
"Preferences" dialog has zodiac related settings you can edit.
10.1.3.6.1 Capricorn Glyph

In the "Preferences" dialog, "Glyphs" tab you may select either of two available styles for
the Capricorn glyph. This style is used in all chart wheels and reports in Solar Fire.
10.1.3.6.2 Pluto Glyph

In the "Preferences" dialog, "Glyphs" tab you may select any of three available styles for
the Pluto glyph. This style is used in all chart wheels and reports in Solar Fire.
10.1.3.6.3 Neptune Glyph

In the "Preferences" dialog, "Glyphs" tab you may select any of two available styles for
the Neptune glyph. This style is used in all chart wheels and reports in Solar Fire.
10.1.3.6.4 Uranus Glyph

In the "Preferences" dialog, "Glyphs" tab you may select either of two available styles for
the Uranus glyph. This style is used in all chart wheels and reports in Solar Fire.
10.1.3.6.5 Eris Glyph

In the "Preferences" dialog, "Glyphs" tab you may select either of two available styles for
the Eris glyph. This style is used in all chart wheels and reports in Solar Fire.
10.1.3.7 View Menu

From the "Preferences" menu, "Edit Settings" option, the "View" tab in the "Preferences"
dialog allows you to customize the type of astrological data that is displayed from each
of the following "View" menu items.
Current Chart
Current Chart+Grid
Current Grid
Dual Wheels
BiWheel
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TriWheel
QuadriWheel
QuinquiWheel
Synastry Grid
The listbox shows which page style is currently selected for each of these menu items.
The purpose of this option is to allow you view your preferred page type for any chart
without having to go through extra steps of selecting the page type each time you
display a chart. For example, if you usually want to display esoteric astrological
information, then you might select “Rays and Rulerships [esot2.pag]” as your selected
page style for “Current Chart”.
Note that whichever page style you select for “Current Chart” also takes effect whenever
you double-click on the list of "Calculated Charts".
>> To select an alternative page style
1. Select the required menu item from the list
2. Click on the Select button
3. Choose a page type from the "Page Topic Index" dialog, and click on the OK button
You can reset all the page styles to their original defaults by clicking on the Reset to
Defaults button.
10.1.3.8 Misc

From the "Preferences" menu, "Edit Settings" option, the "Misc" tab in the "Preferences"
dialog has general settings you can edit.
10.1.3.8.1 Parans

Solar Fire’s Star Parans report shows a list of parans for currently selected stars and
planets, and parans may also be listed in flexible point’s list page objects.
In the "Preferences" dialog, "Misc" tab a choice is offered in relation to the format for
the parans.
Display as Local Clock Time - The parans are displayed as local clock times. This is
useful if you wish to see approximate rise/set clock times.
Display as LST Angles – The parans are displayed as local sidereal time expressed
as an angle.
Display as LST Times - The parans are displayed as local sidereal time expressed as
a time.
10.1.3.8.2 Now Button Precision

When you click on the "Now" button in Solar Fire’s "New Chart Data Entry" screen (or any
other screen with a "Now" button), the current time is displayed there. In the
"Preferences" dialog, "Misc" tab you can control whether the time is truncated to the
current whole minute, or alternatively to the current second within the current minute.
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10.1.3.8.3 Email Preferences

You can select your preferred email protocol. For programs like the MS Outlook email
client try MAPI first (which is the default), but if that is not always satisfactory change to
Mailto, which may work better. If you use webmail use Mailto.
>> To select an Email Protocol
1. From the Main Screen click on the Preferences menu, then on the Edit Settings
menu option
2. In the Misc tab in the "Email Preferences" section select either MAPI or Mailto.
See Email Protocol for more information.
10.1.3.8.4 Teacher Settings

If you are an Astrology Teacher, and your students also use Solar Fire, you may like your
students to be able to have the same settings in place in their copy of Solar Fire that you
have in your copy. You can achieve this by utilizing Solar Fire's Teacher/Student settings
transfer functionality. This is all accessed via the Utilities menu. See Teachers and
Students for more details.
The first step in this process involves the teacher capturing their settings in current use
to send to their students via the “Teacher – Create Settings” menu item on the Utilities
menu.
However before the “Teacher – Create Settings” menu item will appear on the Utilities
menu, an astrology teacher needs to first set the checkbox "I am an astrology teacher" in
the "Preferences" dialog, "Misc" tab.
10.1.3.8.5 Midpoint Trees

There are two options that affect how all midpoint trees are calculated, both in the
reports and in the midpoint tree page objects. In the "Preferences" dialog, "Misc" tab you
can switch the following options on or off...
Allow trees to contain midpoints which include the root planet – Normally,
when midpoint trees are constructed, the root planet for each tree is excluded from
calculations of the midpoints which fall under that tree. This can only occur when
the root planet is conjunct the other point, and as this can normally be seen easily
in the chart itself, it is of less interest than other items in the midpoint trees.
However, if you prefer, you can ensure that these entries will appear in the trees by
switching this option on.
When sorting trees, take into account the sign of the orb – The entries in
midpoint trees can be sorted in two ways: a) according the absolute orb of the
contact (disregarding which side it is on), in which case the closest orbs appear at
the top of the list, or b) according to the orb and sign, in which case the closest orbs
appear in the middle of the list. If you prefer option b), then switch this option on.
10.1.3.8.6 Sound for Events

The program issues appropriate beeps when any error or information dialog box is
displayed, when the "Print" dialog box is displayed and when printing or copying has
finished. In the "Preferences" dialog, "Misc" tab it is possible to prevent any beeps from
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being sounded by switching off the sound option.
10.1.3.8.7 Angle Rounding

It is possible to display zodiac angles in either of two ways. In the "Preferences" dialog,
"Misc" tab if the angle rounding option is off, then when angles are displayed they will
simply be truncated from their full precision. If the angle rounding option is on, then the
displayed angle will be rounded to the nearest displayed unit (i.e. to the nearest minute
if the angle is displayed in degrees and minutes, or to the nearest second if the angle is
displayed in degrees minutes and seconds). The only exception to this rounding rule
occurs for zodiacal longitudes just prior to a sign boundary. In this particular case no
rounding is applied, to ensure that the displayed angle does not appear to be in the
following sign before the ingress actually occurs.
Some examples follow.
Angle

Angle Rounding On

Angle Rounding Off

12 34' 56.7"

12 35' or 12 34' 57"

12 34' or 12 34' 56"

23 59' 59.5"

24 00' or 24 00' 00"

23 59' or 23 59' 59"

29 59' 59.5"

29 59' or 29 59' 59"

29 59' or 29 59' 59"

Any charts or reports that are generated display any angles according to the current
setting of this option. Note that this option does not affect the way in which angles are
calculated or stored internally (they are always stored to a high precision, regardless of
this option) - it only affects the manner in which angles are displayed.
10.1.3.9 Compliments

From the "Preferences" menu, "Edit Settings" option, the "Compliments" tab in the
"Preferences" dialog allows you to edit the compliments text that appears when most
charts and pages are printed. Typically you might want to enter you name, address and
telephone number, for the sake of any clients who receive your printed charts. On a
single-wheel chart, this text appears on the top right corner of the page; on a biwheel
chart it appears at the bottom right; and on a triwheel chart it appears at the bottom left.
Compliments text is not normally printed on quadriwheel charts, but can be added to or
removed from any page if required, using the Page Editor.
The topmost line of text will always be printed with a bold font (unless it is left blank),
and the subsequent lines will be printed in a normal font. Each line of text is justified to
the right or the left depending on which part of the chart the text is being printed. This
alignment can be changed used the Page Editor.
In some situations you may want to prevent compliments text from appearing e.g. if you
are producing a large number of charts and pages for publication. In this case, you can
check the Hide compliments text box. This will prevent the compliments text from
appearing on any displayed or printed page. It is not necessary to remove the text itself.
Unchecking the box will allow the specified compliments text to be displayed on any
subsequently drawn or printed page that includes a compliments text object.
10.1.3.10 Dates

From the "Preferences" menu, "Edit Settings" option, the "Dates" tab in the "Preferences"
dialog has options you can set for date handling.
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10.1.3.10.1 Window for 2 Digit Year Entry

When you are entering dates into Solar Fire, you can facilitate input by excluding the
century number from the year and entering just one or two digits for the year, and
allowing the century number to be automatically inserted. For example, entering 3/12/98
might result in the date “3 Dec 1998” being assumed, or 3/12/0 might result in “3 Dec
2000”.
In the "Preferences" dialog, "Dates" tab you can specify the 100 year window in which
the century number is correctly assumed.
For example, if you enter the window range 1905 (to 2004), then one or two digit year
numbers are assumed to be within this year range i.e. 0 to 4 are converted to 2000 to
2004, and 5 to 99 are converted to 1905 to 1999.
Note: If you wish to enter a date with any year number which is outside the specified
window, then you must enter at least 3 year digits (or a BC date qualifier), including
leading zeroes for dates in the first century AD e.g. 003 for year 3 AD.
10.1.3.10.2 Calendar Style Display Options

In the "Preferences" dialog, "Dates" tab you can specify how calendar flags should be
handled.
Never show OS/NS flags – Always use default – When this option is selected,
Solar Fire never displays OS (old style, Julian) or NS (new style, Gregorian) suffixes
on its dates. When this option is in effect, any date on or prior to 14 Oct 1582 is an
OS date, and any later date is a NS date. This is how earlier versions of Solar Fire
always worked.
Always show OS/NS flags between years – When this option is selected, Solar Fire
will always display the OS or NS suffix on any chart whose year falls within the
specified range.
Retain all user entered OS/NS flags – When this option is selected, Solar Fire
remembers whether the date you entered had an OS or NS suffix, and if so, always
displays the date with that suffix, and according to that calendar style. For example,
if you entered “17 Aug 1753 OS”, then that date would always be displayed that
way too. However, if you entered “17 Aug 1753 OS” when this option was not
selected, then it would be converted into the NS calendar, and displayed as “28 Aug
1753” or “28 Aug 1753 NS”.
10.1.3.11 Interps

From the "Preferences" menu, "Edit Settings" item, the "Interps" tab in the "Preferences"
dialog has options you can edit. (You can also access this via the "Interps" menu, "Word
Processor Options" item)
The following options apply to textual interpretation reports that Solar Fire generates.
You can select which word processor you wish to use when viewing and printing
interpretation reports. If you do not select one yourself, then Solar Fire will use the
default word processor for your computer system.
Use default word processor – When this option is selected, the report file that
Solar Fire generates is launched using whatever word processor has the RTF file
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type association (for RTF files), or TXT file type association (for TXT files). However,
if your computer does not have a file type association, then you will need to use the
following option instead.
Use specified word processor – Selecting this option requires you to click on the
Browse… button to locate your desired word processor program file. You must
select a word processor that is capable of opening TXT and RTF files.
Apply rich text formatting to report - Rich Text Format (RTF) is a method of
producing formatted reports (i.e. with centered text, bold and italics, for example).
Without RTF, a report file will contain only plain text in a single font, without any
special formatting, and this is much less attractive and harder to read. Solar Fire
can produce its interpretations reports either with or without RTF. However, if you
use the RTF option, then you must be using a word processor that is capable of
understanding the RTF format. MS Word for Windows, WordPerfect and the
Windows WordPad can all understand the RTF format. If you have the RTF option
switched on, but are using a word processor that does not understand RTF, then you
will see a lot of spurious items in the report file that interfere with its normal
layout.
10.1.3.12 Places

From the "Preferences" menu, "Edit Settings" option, the "Places" tab in the
"Preferences" dialog allows you the option to use a standalone ACS Atlas, and to create
a list of favorite places and set one of them as your current location.
10.1.3.12.1 Atlas to Use

Solar Fire contains a built-in copy of the ACS Atlas. It also has the capability of linking to
a standalone ACS PC Atlas (but this option will be grayed out if you don't have one
installed on your computer).
To specify the Atlas to use click on the ACS (Built-in) or ACS (Standalone) in the
"Preferences" dialog, "Places" tab...
After you set this option, whenever the atlas is accessed either directly (by clicking on a
Place… button) or indirectly (by using the Autolookup feature), the chosen atlas is
accessed.
10.1.3.12.2 Favorite Places

This list can contain the details of up to five places. One of these places must always be
your current location, and the other four may be places to which you travel frequently, or
places for which you frequently cast charts, for example.
In the "Preferences" dialog, "Places" tab...
>> To add a favorite place
Click on the Add button.
This will open the ACS Atlas from where you can find the required place. See Using
the ACS Atlas for more details on selecting a place from the Atlas. When you have
selected a place, it is automatically added to the list of favorite places. If your list
already has five places on it, then the one at the bottom of the list (the least recently
used one) is removed to make way for the new place.
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>> To delete a favorite place
Highlight the required place and then click on the Delete button.
10.1.3.12.3 Current Default Place

The current default place should usually be set to your current location. This is what
determines the location details that are displayed on the front screen of Solar Fire.
In the "Preferences" dialog, "Places" tab...
>> To select a new current default place
1. Ensure that the place you want is on the list of favorite places (if it is not there
then add it).
2. Highlight the required place
3. Click on the Set as Default button.
The name of the new default place will be updated immediately.
10.1.3.12.4 Recently Used Places

In addition to your list of favorite places, Solar Fire also remembers up to five other
places you have most recently entered or looked up. These places automatically appear
on drop-down place selection boxes in the Chart Entry dialog, most subsidiary chart
dialogs and others. Having these places listed there makes it easy for users to quickly
re-access recently used places that they have not saved to their favorite places list.
However, there are some circumstances in which you may wish to remove those recently
used places. For example, you may wish to refresh the timezone associated with a
recently used place, in which case you would look it up again in the ACS atlas to ensure
the correct timezone changes are applied. To do so, you first need to remove it from the
list of recently used places. Otherwise Solar Fire will continue to used the recently used
place entry instead of looking it up again from the ACS Atlas.
In the "Preferences" dialog, "Places" tab...
>> To clear the list of recently used places
Click on the Clear button.
10.1.3.12.5 Look-up timezone on each start up

In the "Preferences" dialog, "Places" tab the default place details also contain the
current timezone for that location. If you don’t want to have to remember to adjust that
timezone for daylight savings yourself, then you can switch on this option, so that every
time that Solar Fire starts up, it will check the current timezone according to the Atlas
timezone tables, and set it accordingly for the current date.
However, if for any reason the place you have selected as your current default place is
not linked to a timezone table, then using this option might result in a warning message
each time that Solar Fire starts up, and the timezone will not be updated. In this case you
have the option of either switching this option off, or of re-selecting your current
location.
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10.1.3.13 Charts

From the "Preferences" menu, "Edit Settings" option, the "Charts" tab in the
"Preferences" dialog allows you to specify chart saving, importing and emailing options.
10.1.3.13.1 Chart Conversion to SFv6/v7 Format

This version of Solar Fire uses a chart file format that is different from that of version 5
and earlier. This new file format has advantages over the old format, but it is not
compatible with earlier versions. However, this version of Solar Fire is able to read all
older version chart files, and is also able to save chart files to the SFv5 or SFv3/4 file
format if required.
However, when saving to a SFv5 or earlier version chart file, life events are not saved.
Also, when saving to a SFv3/4 chart file, any chart rating and source notes that you have
entered, along with the chart event type or gender are not saved, and it is not possible to
save any charts other than natal types charts.
In the "Preferences" dialog, "Charts" tab...
Always automatically convert older charts – When this option is selected, any
time that you select an old version chart file (SFv1/2/3/4/5) to open, it will
automatically be converted into a new version chart file, and a backup copy of the
old version file will be stored into the OLDCHART subfolder of the main Solar Fire
Charts folder. This option is recommended if you do not need to maintain
compatibility with other software that is unable to read the new Solar Fire chart file
format.
Prompt me whether or not to convert each older chart file - When this option is
selected, any time that you select an old version chart file (SFv1/2/3/4/5) to open,
you will be prompted whether or not allow it to be converted into a new version
chart file. If you consent, then it is converted and a backup copy of the old version
file will be stored into the OLDCHART subfolder of the main Solar Fire Chart folder.
If you do not consent, then it is left unchanged.
Never convert – keep all older format chart files – When this option is selected,
any old version chart file that you open remains unchanged. However, this means
that you will not have the advantages of the new chart file format features.
10.1.3.13.2 Auto Chart Save

Any new charts that are created by the program, plus any charts which are edited
instead of being opened, must be saved to a chart database if you wish to use them
again in later sessions with the program.
It is possible to save a chart by manually selecting Save options within the program, or
alternatively any new charts can be saved automatically whenever they are created by
switching this option on in the "Preferences" dialog, "Charts" tab.
For more information on saving charts see Saving Charts to a File.
10.1.3.13.3 Chart Data Email Options

Solar Fire allows you to create emails that automatically include details of any charts
that you have selected, either as attached chart files and comment files, or within the
body of the message itself. You can also automatically create emails that include chart
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page graphics as attached files. This should greatly facilitate the exchange of
astrological data.
In order to use these email options, you must have a MAPI compliant email program.
See About MAPI for more information, and for a full explanation of the various email
options that you can set after clicking on the Edit Options button in the "Preferences"
dialog, "Charts" tab.
10.1.3.14 AutoRun

Solar Fire can automatically run a set of Astrologer’s Assistant tasks every time that it
starts up. For example, you may want Solar Fire to generate a chart of current transits
whenever it starts up, or to open your own chart, and then view it in a triwheel with the
current progressions and transits around it.
If a task file has already been selected for AutoRun, then the file name and its title and
description will be displayed in the text boxes.
If you wish to create a new task file, then see Using the Astrologers Assistant for further
instructions.
In the "Preferences" dialog, "Autorun" tab...
>> To select a task file to run on startup
Click on the Select button and choose an existing task file from the list of available
task files.
>> To prevent a task file from running on startup
Click on the Clear button.
10.1.3.15 Ephemerides

Solar Fire installs a copy of the Swiss Ephemeris into a standard location in the Program
Files or Program Files (x86) folder. However, it is possible that you already have a copy
of the Swiss Ephemeris in another location on your computer. In this case you can avoid
keeping multiple copies of the Swiss Ephemeris files by directing Solar Fire to use the
copy in the other location.
In the "Preferences" dialog, "Ephemerides" tab...
>> To select an alternative location of the Swiss Ephemeris
On the Ephemerides tab, click on the Browse button and choose the folder in which
the Swiss Ephemeris resides.
Once you have chosen a new folder, Solar Fire attempts to connect to the ephemeris
files at the new location. If you specified a folder that does not contain the correct
Swiss Ephemeris files, then you will see an error message, and the location will revert
to its original value.
After you have successfully specified an alternative location, you may delete the
ephemeris files from Solar Fire’s old Swiss Ephemeris folder, in order to free up disk
space, if you wish.
Note: Swiss Ephemeris asteroid ephemerides must always reside in subfolders of the
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folder designated as the main "Swiss Ephemeris folder" (as above). If you use this option
to change locations, then you must ensure that any extra asteroid ephemerides you have
are also present in the new location, or you will lose access to them. Also see Using
More Asteroids.
10.1.3.16 Stations

A planet or point is stationary only instantaneously i.e. not for any finite length of time.
Hence, in normal usage, a point referred to as being stationary in a chart actually means
that it is near a station, rather than truly being stationary.
There are a number of possible ways of defining the criteria for how near a point must
be to a station in order to be considered "stationary", and Solar Fire offers four such
options, from which the user may select one.
Within this timespan of exactness - the user may specify the number of days and/or
hours, within which the point is considered stationary
Within this distance of exactness - the user may specify the orb as a distance in
longitude (celestial), within which the point is considered stationary
When actual speed is less than - the user may specify a daily rate of motion (in
zodiacal longitude per day), below which the point is considered stationary
When speed relative to average is less than - the user may specify a percentage of
the typical speed, below which the point is considered stationary
In the "Preferences" dialog, "Stations" tab...
>> To shows stations on chart wheels
Ensure that the Show Stations with "S" option is checked.
When this option is switched on, any chart which normally has space to display a
retrograde symbol will display an "S" in that space if that point is within orb of a station
according to the option selected above. If colors are enabled in the chart, then a
stationary point which is retrograde will have the "S" shown in the retrograde color, or if
the point is direct then in normal text color.
10.1.3.17 Eclipses

Maximum eclipse is defined as the instant when the Moon passes closest to the axis of
Earth's shadow, or when the Moon’s shadow passes closest to the Earth’s center.
The exact lunar phase (i.e. exact conjunction of Sun and Moon around a solar eclipse or
their exact opposition around a lunar eclipse) is defined by their exact aspect in
longitude alone.
The time of maximum eclipse is generally different from the exact time of the associated
lunar phase. However, because the Moon generally has non-zero latitude, the time of
closest approach between the two bodies (maximum eclipse) is slightly different. The
difference between the time of maximum eclipse and exact lunar phase can vary by 15
minutes or more.
In the "Preferences" dialog, "Eclipses" tab, Solar Fire offers the choice of which time to
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use for its eclipse calculations...
Use exact lunar phase - when this option is selected, eclipse titles always have
"(NM)" or "(FM)" as a suffix to indicate that they are the times of the exact new
moon or full moon respectively e.g. "Solar Partial Eclipse (NM)"
Use maximum eclipse time - when this option is selected, there is no suffix on
eclipse titles e.g. "Solar Partial Eclipse"
Note: Earlier versions of Solar Fire only calculated maximum eclipse times, and did not
have an exact lunar phase option. Hence if you keep the default setting of using exact
lunar phase, the eclipse times you obtain will be different from the eclipse times in
earlier versions. If you want to replicate the results from earlier versions, select the
maximum eclipse time option.
10.1.4 Editing the Toolbar Buttons
The Toolbar contains a range of graphical buttons that provide shortcuts to various items
within Solar Fire. It may be customized by changing the selection or ordering of the
buttons it contains.
>> To customise the Toolbar
Select the Edit Toolbar item from the Preferences menu, or double-click the mouse
on any blank area of the Toolbar.
This will display the Toolbar customization dialog, which display a list of available
Toolbar buttons on the left, and current Toolbar buttons on the right. You can
manipulate buttons and separators (i.e. blank spaces) as follows.
>> To add a button
1. In the current Toolbar buttons list, select the button above which you wish to insert
the new button.
2. In the available Toolbar buttons list, select the required new button.
3. Click on the Add button.
>> To remove a button
1. In the current Toolbar buttons list, select the button you wish to remove.
2. Click on the Remove button.
>> To change the order of buttons
1. In the current Toolbar buttons list, select the button you wish to move.
2. Click on the Move Up or Move Down buttons as required.
>> To restore your previous button selection
Click on the Reset button.
This will restore the order of buttons to the way it was when you opened this dialog
box.
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10.1.5 Viewing Panels on the Main Screen
The panels and bars on the Main Screen which may be turned on or off from the
Preferences menu are as follows.
Toolbar
Date and place bar
Current Settings panel
Solar Live bar
Planet bar
See Solar Fire's Main Screen for a detailed description of what each of these items
contains.

10.2

Editing a Chart Points File
This section describes how to edit files that contain definitions of primary chart points to
be included or excluded from a chart, grid or report.
There are six different types of chart point files...
Displayed Points - These are the points that are to be displayed in any chart or
page image or chart report.
Displayed Transiting Points - These are the points that are displayable in any
transits chart or page image or chart report.
Aspected Points - These are the points to which aspects are drawn in any chart
image.
Radix Points - These are the points that are used as radix points in a dynamic
report.
Transiting Points - These are the points that are calculated as transits to the radix
points in a dynamic report.
Progressing Points - These are the points that are calculated as progressions or
directions to the radix points in a dynamic report.
>> To edit a Points file
1. Choose the required point type from the "Chart Options" menu, or click on the
desired points box in the "Point Selection" area of the "Dynamic Reports Selection"
dialog.
2. Select the file from the list of file names.
3. Select the Edit button.
This will display the "Chart Point Selection" dialog box.
All the points in the "Selected Points" list box are considered to be switched on, whereas
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those in the "Unselected Points" list box are considered to be switched off and will not
be used when this file is selected.
>> To switch on a single chart point which is in the unselected list
Click on a point in the "Unselected Points" list, or use the arrow keys to highlight a
point in the "Unselected Points" list, and then click on the Enter key.
>> To switch off a single chart point which is in the selected list
Click on a point on the "Selected Points" list, or use the arrow keys to highlight a
point on the "Selected Points" list, and then click on the Enter key.
>> To switch off or on all planets, asteroids, TransNeptunians or other points which
are in the unselected list
1. Select the Planets, Asteroids, TransNeps or Others option from the Quick Select
Frame
2. Select the Off or On button.
>> To save the current set of selections, and return to the File Manager screen
Select the OK button.
>> To make the file which has just been edited the current file
Select the Select button.

10.3

Editing an Aspect Set
This section describes how to edit files that contain definitions of aspect sets to be used
in displaying an aspected chart or aspect grid or in generating a report type which
includes aspects.
>> To edit an aspect file
1. Choose Aspect Set from the Chart Options menu
2. From the File Manager, select the file you wish to edit, and click on the Edit
button. - This will display the "Edit Aspect Set" screen.
The list box on the left of the screen contains a list of all the aspect names that are
currently available. Those aspect names preceded by a plus mark are those aspects
that are currently switched on, so that it is possible to see at a glance which aspects
are included in this set.
The symbol for the currently selected aspect is displayed in the "Glyph" box, and the orb
angles relating to this aspect are displayed in editable boxes. The color used to display
the aspect line and glyph for the standard aspects is whatever is defined in the currently
selected aspect color set. For instructions on altering aspect colors, see Editing a Color
File.
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>> To switch on an aspect which is currently switched off
Select the aspect name from the list box, and then select the Restore button, or
double-click on the aspect name in the list box.
>> To switch off an aspect which is currently switched on
Select the aspect name from the list box, and then select the Remove button.
>> To switch on or off multiple aspects at once
Select all the desired aspects from the list using the Ctrl key with the mouse to
make multiple selections, and then select either the Restore or Remove button.
>> To alter aspect orbs
1. Select the aspect name from the list box
2. Use the edit keys to edit the entries in the aspect orb boxes - Aspect orbs may be
entered as degrees, minutes and seconds, or as decimal degrees (e.g. 9 30 or 9.5
for 930'). See Entering Angles for more information on entering angles.
There are three types of orbs...
Natal - These orbs are used on all charts and reports other than progressed charts
or dynamic reports.
Progressed - These orbs are used on all progressed charts and reports relating to
progressed charts.
Transits - These orbs are used for entering and leaving events in all dynamic
(transits and progressions) reports.
You may specify different orbs for luminaries and for other chart points. (Luminaries
are the sun and the moon only). Luminary aspect orbs are used whenever at least one
of the chart points in aspect to one another is a luminary. Also, you may specify a
different orb depending on whether the aspect is approaching exactness (applying) or
is moving away from exactness (separating).
Note: Within an individual chart, Solar Fire calculates whether any aspect is applying or
separating according to the rate of motion of both points involved in the aspect. An
exception to this is when a chart angle is involved in the aspect. In this case the chart
angle is assumed to be stationary. (Chart angles are the Ascendant, Midheaven, Vertex
and Equatorial Ascendant.) When an aspect is being made between two separate charts,
Solar Fire takes account of the motion of the planet in the first chart, and holds the
planet in the second chart stationary. Therefore, whether an aspect is found to be
applying or separating depends on the order in which the charts are considered, and
swapping the order of the charts may affect whether a particular aspect is deemed to be
applying or separating. In the case of a biwheel, the inner chart is always held fixed,
whilst in the case of a synastry grid, the chart across the grid is always held fixed. In
synastry reports, the first chart listed is always held stationary.
Note: It is not possible for the user to alter any standard aspect name, aspect angle or
aspect symbol. However, you can add user-defined aspects for which any of these items
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may be altered - see the following section on advanced options for more information.
>> To change the style or thickness of the aspect line
Click on the Linestyle button to loop through the different line styles and
thicknesses that are available.
A sample of the linestyle is displayed below the symbol in the Glyph window.
>> To edit the description of the aspect set
Click on the Description edit box and type in any text you want.
This text appears in the "File Manager" to assist you in finding the aspect set that you
want, so it is best to type in some meaningful description of what this aspect file
contains.
>> To save any changes when you have finished editing the aspect set
Select the Save button
Selecting Advanced Options
10.3.1 Selecting Advanced Options
You can select a number of options relating to how aspect orbs are calculated and used
in Solar Fire, and you can also add your own user-defined aspects for use in any part of
Solar Fire.
>> To display the advanced aspect options
Click on the Advanced button.
Clicking this button toggles the advanced options display area on and off. However, if
certain advanced options are selected, this button will become disabled, and you will
not be able to switch it off unless you switch off the selected advanced options. The
purpose of this limitation is to ensure that you are aware that certain advanced
options have been selected when you select this aspect set for editing.
Orb Types
You can select from three different types of orbs...
Use Luminary/Other Orbs - This is the standard option that applies if you do not
select the Advanced Options button, and was the only option available in previous
versions of Solar Fire. This allows you to enter two sets of orbs for each aspect. One
set of orbs that apply when a luminary (i.e. the sun or the moon) is making an
aspect, and another set of orbs when any other planet is making an aspect.
Use Planet Orb Ratios - This option allows for the possibility of each planet having
a different orb for the same aspect. Rather than allowing orbs to be entered for
each planet (which would involve many hundreds of orbs being entered), the user
specifies an orb ratio for each planet, and specifies just a single set of base orbs for
each aspect. The orbs of any individual planet are then calculated by multiplying
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the base orb by that planet’s orb ratio.
Use Aspects by Sign Only - This option precludes the use of orbs, by determining
aspects only according to which signs each planet is placed in. For example, if one
planet is in Aries, and another in Cancer, then they are in Square aspect, regardless
of which degree of their signs they are in. With this option, only the first nine
aspects in the list are active.
An additional option that may be selected in combination with the first two of the above
Use Sign as well as Orb – When this is enabled, any aspect that is found within its
specified orb is also checked to determine if it is also in the same aspect by sign. If
it is not, then the aspect is ignored. For example, if one planet is at 1 degree of
Aries, and another is at 29 degrees of Gemini, then they would be square with an
orb of 2 degrees, but the signs are 60 degrees apart (i.e. sextile), so this aspect
would be disregarded.
Special Options
There are three special options that can be used in conjunction with some of the Orb
Types.
Use 3D Aspects (True Body) - Astrologers usually work with aspects in ecliptic
longitude, which means that the positions of the planets are projected onto the
ecliptic before aspects are calculated between them. An alternative is to measure
the true angle between the two bodies along the shortest distance between them.
These are known variously as 3D, true-body or great circle aspects. Because most
of the planets have orbits close to the ecliptic, there is normally not much
difference between traditional aspects and 3D aspects. However Pluto has an orbit
that is at a significant inclination to the ecliptic, so it is possible that 3D aspects of
Pluto will be significantly different from the traditional aspects. The other area in
which 3D aspects may be especially interesting is in relation to fixed stars. As most
stars are not close to the ecliptic, there will be a big difference between 3D and
traditional aspects between planets and stars. The fact that stars are not close to
the ecliptic is sometimes given as a criticism of using ecliptical aspects between
stars and planets. Therefore it is well worth trying this 3D option when generating a
fixed star aspects report. This option is provided as an opportunity to experiment there is very little written about this yet.
Use Moieties (Half Planet Orbs) - This option may only be selected in association
with the Planet Orb Ratios option. The principle of moieties is to determine the orb
of an aspect by adding half of the orb of each planet involved. (This is identical to
averaging the orb for each planet involved in an aspect.) For example, if Pluto has
an orb of 6 and The Sun has an orb of 12 , then the moiety is 9 , so they are in
aspect with each other only when they are within 9 of each other.
Unidirectional Orbs - A unidirectional orb is one that operates in a single direction,
so the orb that is applied between two planets depends on the order in which the
planets are considered. For example, if Pluto has an orb of 6 and The Sun has an
orb of 12 , and they are 9 apart, then the Sun would be considered to be conjunct
Pluto (because it has an orb of 12 ), but Pluto would not be considered to be
conjunct the Sun (because it has an orb of 6 ).
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Note: If you have selected to use Planet Orb Ratios as your basic Orb Type, and also
selected Unidirectional orbs, the lowest orb ratio is used for aspects in orb calculations.
>> To set planet orb ratios
1. Select the Planet Orb Ratios option button.
2. Specify the required Aspect Orbs - Applying and Separating, for Natal, Progressed
and Transiting planets.
3. Select one (or more) planets from the Planet Ratios list box
4. Enter an orb ratio in the Current Planet’s Ratio edit box - any changes you make
will immediately be reflected in the orbs displayed under the Current Planet orbs.
5. Repeat steps 3 to 4 until all the planet’s orbs ratios are set as required.
Typically, the orb ratios that you set will be in the range of 0.1 to 2.0 or thereabouts.
To start with, you might like to specify the Sun’s orb as having a ratio 1.0, and then
specify all the other planet’s orbs in relation to that, in which case all your other orb
ratios will probably be less than 1.0.
>> To add a user defined aspect
1. Click on the Add Aspect button - This will add a user-defined aspect with the name
“New Aspect”, abbreviation “New”, angle 0 , an alphabetic character as a glyph,
and a solid black linestyle.
2. Edit the name, abbreviation and Angle by clicking on the appropriate edit boxes
and typing in the new details. The angle may be entered in degrees, minutes and
seconds (eg 22 30) or decimal degrees (e.g. 22.5).
3. Choose a glyph by clicking inside the Glyph box, and then typing any keyboard
character that you would like to use to represent this aspect.
4. Select a line style by clicking on the LineStyle buttons.
5. Select a color for the new aspect by clicking on the Color button and selecting a
color from the standard color selection dialog.
Once you have added a user-defined aspect, you can switch it on or off in the same
manner as for other standard aspects. However, if you wish to permanently remove a
user-defined aspects, then you can remove it from the list altogether.
>> To delete a user defined aspect
1. Highlight the desired user-defined aspect
2. Click on the Del Aspect button.
>> To save any changes and exit from the aspect editor
Click on the Save button.
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Editing a Color File
This section describes how to edit files that contain definitions of colors to be used
when displaying aspect lines and symbols, chart point glyphs, zodiac sign glyphs or sign
fill colors.
There are four different types of color files...
Point Colors - These colors are used when displaying chart points (planets,
asteroids, etc.) in any chart or grid. To invoke the "File Manager" for these files
Aspect Colors - These colors are used when displaying aspect symbols or lines in
any chart or grid. To invoke the "File Manager" for these files
Sign Colors - These colors are used when displaying zodiac sign glyphs in any chart,
and also include a color for the retrograde glyph.
Sign Fill Colors - These colors are used as background colors when drawing zodiac
signs in a chart that includes a color-filled zodiac ring.
>> To edit a selection of color
1. Choose the required Colors option from the Chart Options menu
2. From the "File Manager", select the required file from the list of file names
3. Select the Edit button. This will display the “Edit Colors” dialog box.
You will see a list of all the items displayed in their currently selected colors. It is
possible to view the items as they will appear with either a light or dark background.
>> To view the symbols with a light background
Select the Normal option in the Video Style box.
>> To view the symbol with a dark background
Select the Reverse option in the Video Style box.
>> To select a new color for any item
1. Select the item from the list by clicking on, or by using the cursor keys
2. Select the Color button. This will display a standard color selection dialog, from
which any color may be selected.
>> To copy a color from one item to another
1. Select the item you wish to copy the color of from the list by clicking on it.
2. Hold the mouse button down whilst dragging the cursor onto the item you wish to
copy the color to, and then release the mouse. The color of that item will be
immediately updated.
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>> To save the current set of color selections
1. Select the Save button.
2. From the "File Manager", click on the Select button to make the file which has just
been edited the currently selected file.

10.5

Changing Rulerships and Weightings
This chapter describes how to use Solar Fire's Rulerships & Weightings Editor to browse,
add, edit, rename or delete sets of rulerships, and weightings which are ascribed to
chart points in various reports within Solar Fire.

10.5.1 Rulerships & Associations
The following table shows the relationships between the planets and signs as they are
initially specified in the Solar Fire program. It should be noted, however, that there are a
varying opinions in the astrological community about some of these relationships. Some
of these are noted below. It is possible to alter any rulership in Solar Fire by using the
supplied Rulerships and Weightings Editor.
Zodiac Sign

Modern Ruler

Old Ruler

Esoteric Ruler

Hierarchical Ruler

Exalted Planet

Planet in Fall

Aries

Mars

Mars

Mercury

Uranus

Sun

Saturn

Taurus

Venus

Venus

Vulcan

Vulcan

Moon

Uranus

Gemini

Mercury

Mercury

Venus

Earth

-

-

Cancer

Moon

Moon

Neptune

Neptune

Jupiter

Mars

Leo

Sun

Sun

Sun

Sun

-

-

Virgo

Mercury

Mercury

Moon

Jupiter

Mercury

Venus

Libra

Venus

Venus

Uranus

Saturn

Saturn

Sun

Scorpio

Pluto

Mars

Mars

Mercury

Uranus

Moon

Sagittarius

Jupiter

Jupiter

Earth

Mars

-

-

Capricorn

Saturn

Saturn

Saturn

Venus

Mars

Jupiter

Aquarius

Uranus

Saturn

Jupiter

Moon

-

-

Pisces

Neptune

Jupiter

Pluto

Pluto

Venus

Mercury

Planets are in detriment when they are in the sign opposite to their rulership. For
example, Uranus is in detriment in Leo traditionally, Aries esoterically, and Libra
hierarchically. Neptune may also be considered to be exalted in Cancer or Pisces, and in
fall in Capricorn. Vulcan may also be considered to be in fall in Pisces.
10.5.2 Rulerships
Adding or deleting sets of rulerships will affect how many different rulership reports are
available in the list of available reports as described in Generating Chart Reports, and in
the list of rulerships available in the menu of the interpretations screen. When Solar Fire
is first installed, there are four sets of rulerships: Modern, Old, Esoteric and Hierarchical.
Each set of rulerships defines, for each sign, its ruler, what is exalted and what is the
ruler of each of the decanates.
The Modern set of rulerships uses rulerships as used by most modern astrologers.
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The Old set of rulerships uses Mars as ruler of Scorpio, Saturn as ruler of Aquarius,
and Jupiter as ruler of Pisces.
The Esoteric and Hierarchical rulerships use a completely different set of
associations, as defined in the book "Esoteric Astrology" by Alice A. Bailey.
10.5.3 Weightings
Altering weightings of the chart point will affect the way in which scores are calculated
in the balance of the modes and elements in basic Chart Analysis report of Solar Fire. It
also affects the way in which Solar Fire determines the balance of Modes, Elements and
Rays in the Interpretation reports.
When Solar Fire is first installed, the following weightings are in effect...
Multiplier 3 - Sun, Moon, Ascendant, MC
Multiplier 2 - Mercury, Venus, Mars
Multiplier 1 - Jupiter, Saturn, Uranus, Neptune, Pluto
Multiplier 0 - All other chart points
This means that the Sun and the Moon count three times more than Jupiter or Saturn in
assessing which element is strongest, for example. Asteroids, which have a weighting of
zero, are ignored in this assessment.
10.5.4 Starting the Rulerships & Weightings Editor
>> To start the editor
1. From the Solar Fire Group, double click the Rulerships & Weightings Editor
program icon.
or...
2. From the Utilities menu click on Edit Rulers/Weightings.
After the utility loads, Solar Fire displays the following screen.
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10.5.5 Adding a Set of Rulerships
>> To add a new set (or level) of rulerships
1. Select the Add Level option from the Edit menu. - You will be prompted to verify
that you wish to add a level.
2. Select the Yes button in order to add it, or the Cancel button to return to the editing
screen without adding it.
Note: The new level will initially contain an exact copy of the names and all the
rulerships of the currently displayed level, and will appear in the list immediately after
the currently displayed set. You are then free to change the names and edit the
rulerships as you wish.
10.5.6 Deleting a Set of Rulerships
>> To delete (remove) the set of rulerships currently displayed
1. Select the Delete Level option from the Edit menu. You will be prompted to verify
that you wish to delete the current level.
2. Select the Yes button in order to delete it, or the Cancel button to return to the
editing screen without deleting it.
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10.5.7 Editing Rulerships
>> To edit the rulerships for any level
1. Select the desired Level Number from the drop-down list box. The name of the
level appears in the Name of Set box, and the text by which this level will be
known in Solar Fire menus appears in the Menu Name box. Either of these names
may be edited, e.g. you could rename the "Old" rulers to be "Traditional", and the
menu name to be "Ancient".
2. Select a Zodiac Sign from the list of signs. The remaining boxes will then be
automatically filled in with the rulers relating to the selected sign. It is possible to
alter any of these rulerships (or exaltations).
3. Select any of the available items from each drop-down list box. Note that although
it is possible to select any planet, asteroid or chart angle from the drop-down list
boxes, traditionally only the planets should be selected.
10.5.8 Editing Weightings
>> To change the weighting of any chart point
1. On the lower part of the screen, click on the desired chart point in the list box
2. Click on the Increase Weighting or the Decrease Weighting button as many times
as you wish - Each time that you click on one of these buttons, the weighting
number for that chart point will be updated on the list. Note that a weighting
cannot be set to less than zero or greater than one hundred.
10.5.9 Exiting from the Editor
>> To save your changes
Select the Save option from the File menu
>> To exit from the editor
Select the Exit option from the File menu. You may be shown a dialog box asking
you if you wish to save any changes that you have made. If you wish to exit without
making any alterations to the rulerships or weightings, then select the No button. If
you wish any changes that you made to be saved then select the Yes button.
Selecting the Cancel button will return you to the editor, without exiting. Once you
have exited, you can double click on the Solar Fire icon to launch the main program.
Note: Any changes that you make to the rulerships or weightings will not take effect until
the next time that Solar Fire is launched. If Solar Fire is running whilst you make changes,
you will need to exit from Solar Fire and launch it again in order for the changes to take
effect.
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Editing a User Defined Points File
This section describes how to edit files that contain definitions of additional points to be
included in a normal ring within a wheel. These points are in addition to the normal set
of individual chart points.
Solar Fire allows for up to 50 user-defined points that can appear on the main wheel
along with Sun, Moon, Mercury, and so on. The list of points that can be used is the
same list of points used in the Extra Ring but only up to 50 points can be used. Access to
the user-defined points is made via the "Chart Options" menu item. Similar to other point
files, you can create your own set of user-defined points file. If you want to revert back
to using no user-defined points then all you need to do it is select the “None.ptu” file
>> To edit a User-Defined points file
1. In the Chart Options menu click on Displayed User-Defined Points
2. Select the required file from the list of file names (or create a new one)
3. Click on the Edit button. This will display the "User-Defined Points selection"
dialog box.
In the "Selected Points" box you will see a list of any points which are already
included in the selection. You can remove points from this list, add various new types
of points, and edit the abbreviations, glyphs, color and font used when each point is
displayed in a wheel or in a page object.
The types of points that may be added are as follows.
Point – Any of the standard 36 chart points. Normally you would not need to use
these, because they can be displayed in any ordinary chart wheel by including them
as displayed points. However, you do have the option of adding them to the extra
ring if you prefer.
Midpoint – This is a list of all possible midpoint combinations between the
standard 36 chart points.
Fixed Position – This allows any fixed zodiacal position to be entered into the box
to the right of the Add button.
Fixed Star – This allows the selection of any star or celestial object from the
currently selected star file. Alternative star files may be accessed using the Select
File button.
Arabic Part - This allows the selection of any part from the currently selected part
file. Alternative part files may be accessed using the Select File button.
Asteroid - This allows the selection of any asteroid from the currently selected
asteroid file. Alternative asteroid files may be accessed using the Select File
button.
Extra Body - This allows the selection of any extra body (defined with orbital
elements) from the currently selected extra body file. Alternative extra body files
may be accessed using the Select File button.
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Prior Lunar Phase – This allows the selection of various points related to the lunar
phases which occurred most recently prior to the chart’s date. The Syzygy points
are either a new or full moon – whichever occurred most recently. The “Most
Elevated” point is the point which is closest to the Midheaven of the current chart.
Prior Eclipse - This allows the selection of the position of various eclipse types
which occurred most recently before the chart’s date.
Node – This allows the selection of the Ascending (North) and Descending (South)
nodes of various planets and hypothetical bodies.
>> To add a point or multiple points at once
1. Select the Point Type from the list of options
2. Optionally - use the Select File button to choose another file
3. Optionally - enter a fixed position into the edit box
4. Highlight the required point or points in the list of "Available Points"
5. Click on the Add button
>> To delete a point
1. Highlight the required point in the list of "Selected Points"
2. Click on the Delete button
>> To alter the display attributes of a point
1. Highlight the required point in the list of "Selected Points"
2. Edit the Abbr field to change the point’s abbreviated name. The Abbreviation is
displayed in the wheel instead of the glyph if you switch on the “Glyph as Text”
option in the wheel designer. However, if you do so, then you may find that the text
overlaps other items in the chart if there are many extra points.
3. Edit the Glyph/s field to change the point’s displayed glyph (you may choose a
special font by clicking on the Font button, and invoke the character map by
clicking on the > button). This allows you to choose symbols of various types, such
as a star shaped symbol for star, if you wish.
Asteroid glyphs
Approx 90 asteroid glyphs are available in a font file called ET Asteroid 1 and ET Asteroid
1a. The design of the glyphs was supplied by Roderick Kidston in Australia, an asteroid
expert. Some of the glyphs are in common usage and where there are no glyphs for some
asteroids, Roderick’s glyphs are used. See Asteroids.
>> Saving the file, and setting the current user-defined points file
1. Once you have finished selecting points to be included click on the Save button.
This returns you to the "File Management" dialog box, with the file you've just
edited highlighted.
2. If you want a different file to the one you've just edited to be the "current" file then
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click on that other file, otherwise go to step 3.
3. Click on the Select button.
This closes the "File Management" dialog box, and the file you selected in step 2 is
now the current user-defined points file (the one whose points are always displayed
along with the main planets in charts).

10.7

Editing an Extra Dynamic Points File
This section describes how to edit files that contain definitions of extra chart points to
be included or excluded from a dynamic report or time map. Extra points are points
which are in addition to the normal set of individual chart points which may be selected
as Transiting, Progressing or Radix (Natal), which includes the planets, major asteroids,
TransNeptunians and chart angles.
There are three different types of dynamic extra point files...
Extra Transiting Points - These are the extra points that are calculated as transits
to the radix points in a dynamic report.
Extra Progressing Points - These are the extra points that are calculated as
progressions or directions to the radix points in a dynamic report.
Extra Radix Points - These are the extra points that are used as radix points in a
dynamic report.
The type of points that are available for selection as extra transiting or progressing
points are...
Midpoints - Any group of midpoints between any two normal chart points.
Fixed Stars - Any set of fixed stars which is contained in a fixed star file
Asteroids - Any set of asteroids which is contained in an asteroids file
Extra Bodies – Any set of extra bodies which is contained in an extra body elements
file
Additionally, extra radix points may include the following...
Arabic Parts - Any set of Arabic Parts which is contained in an Arabic Parts file
Fixed Positions - Any number of fixed zodiacal longitudes
House Cusps – All 12 house cusps of the radix chart
>> To edit an extra points file
1. Click on the desired points text box in the Dynamic Reports Selection dialog
2. Select the file from the list of file names
3. Select the Edit button
This will display the "Select Extra Points" dialog box.
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If you are editing extra transiting or progressed points, then only the available point type
options will be enabled. You can determine what items are currently selected as
follows...
Midpoints - All currently selected midpoints are listed in the list box on the right of
the “Midpoints” frame. The box is grayed out if there are no midpoints selected.
Fixed Stars, Arabic Parts, Asteroids, Extra Bodies - The name of any selected file
appears inside the text box in each frame. If no file is selected, then the word
“none” is shown, and the text box is grayed out.
Fixed Positions - All currently selected fixed positions are listed in the list box on
the right of the “Fixed Positions” frame. The box is grayed out if there are no fixed
positions selected.
House Cusps – If the check box is checked, then the house cusps are selected.
10.7.1 Selecting Midpoints
From the "Dynamic Reports Selection" dialog, in a "Select Extra Transiting/Progressing/
Radix Points" dialog...
>> To switch on a single midpoint
1. Select the first point of the midpoint in the left hand list of points.
2. Select the second point in the right hand list of points.
3. Click on the On button. If the midpoint is not already selected, then this will add
the midpoint between those two points to the list of selected midpoints.
>> To switch off a single midpoint
Click on the midpoint in the list of selected midpoints. This will remove it from the
list.
>> To switch on or off a group of midpoints
1. Select any number of points from the left hand list of points. Selecting zero points
has the same effect as selecting all the points. Multiple selections may be made
by holding down the Ctrl key whilst clicking on points on the list.
2. Similarly select any number of points from the right hand list of points.
3. Click on the On button (or the Off button). This will add (or remove) all of the
midpoints formed by combining the two selections. See the example below.
>> To switch on all the midpoints of the Moon to every other chart point
1. Select the Moon in the left hand list
2. Select no points in the right hand list
>> To switch on all the midpoint of the moon to the outer planets
1. Select the Moon in the left hand list
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2. Select each of the outer planets in the right hand list
>> To switch on all the midpoint between outer planets
1. Select each of the outer planets in the left hand list
2. Select each of the outer planets in the right hand list
>> To clear all selected of midpoints
Select the Clear button.
Note: It is possible for you to select up to 595 different midpoints. However, unless you
are running a dynamic report covering a very short time span only, it is recommended
that you save and use selections of no more than about 50 midpoints at a time, in order
to avoid generating a dynamic report which is far too long to be useful.
10.7.2 Selecting Stars, Arabic Parts, Asteroids & Extra Bodies
You can select any set of fixed stars, Arabic Parts, asteroids or extra bodies that are
supplied with Solar Fire, or which you have created or edited yourself. If you wish to use
a set of stars, parts, asteroids or extra bodies that is not already saved in a Solar Fire
file, then you must first create or edit the required file.
From the "Dynamic Reports Selection" dialog, in a "Select Extra Transiting/Progressing/
Radix Points" dialog...
>> To select an existing set of Fixed Stars, Arabic Parts, Asteroids or Extra Bodies
1. Click on the > button on the right of the appropriate box.
2. This will display the "File Management" dialog box, from which a file may selected.
After selection, the name of the selected file will be displayed in the appropriate box.
>> To clear a selection of Fixed Stars, Arabic Parts, Asteroids or Extra Bodies
1. Click on the name of the file in the appropriate box. This will highlight the file
name.
2. Click on the Del key. This will put the word “none” into the box, and grey it out to
show that there is nothing selected.
Note: It is possible to select large numbers of extra points if your fixed star, Arabic Part,
asteroid, or extra bodies files contain many entries. However, unless you are running a
dynamic report covering a very short time span only, it is recommended that you save
and use selections of no more than about 50 extra points at a time, in order to avoid
generating a dynamic report which is far too long to be useful.
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10.7.3 Selecting Fixed Positions
From the "Dynamic Reports Selection" dialog, in a "Select Extra Radix Points" dialog...
>> To select a fixed zodiacal position
1. Click on the Position to Add text box, and type in the required zodiacal position.
Angles may be entered in degrees, minutes and seconds in 360-degree notation
(for example “334 27 32”) or using zodiacal signs (for example “4 Pi27 32”). See
Entering Angles for a more detailed explanation.
2. Click on the Add button. This will add the position to the list of selected fixed
positions.
>> To remove a selected fixed zodiacal position
1. Select the required entry on the list of selected zodiacal positions
2. Click on the Delete button.
10.7.4 Saving Your Selected Extra Points
From the "Dynamic Reports Selection" dialog, in a "Select Extra Transiting/Progressing/
Radix Points" dialog, when you have selected all the required midpoints, fixed stars,
Arabic Parts, asteroids and fixed zodiacal positions for the Extra Dynamic Points file, you
can save your work by clicking on the Save button. This will save your selections and
return you to the "File Management" dialog box, from which you can select the newly
edited file, or choose another file to edit.

10.8

Editing an Extra Ring Points File
This section describes how to edit files that contain definitions of points to be included
in an extra ring within a wheel. These points are in addition to the normal set of
individual chart points, and include fixed positions, midpoints, asteroids, stars, Arabic
parts, extra bodies and prior lunar phases, eclipses and planetary nodes.
These points can only be displayed inside a chart wheel that has been specially
designed to include an extra ring, in which the extra points can be displayed. (See below
for a list of wheels supplied with Solar Fire that have an extra ring).
>> To edit an extra ring points file
1. Select the Extra Ring Point item from the Chart Options menu
2. Select the required file from the list of file names (or create a new one)
3. Select the Edit button
This will display the "Extra Point selection" dialog box.
In the "Selected Points" box you will see a list of any points which are already included in
the selection.
You can remove points from this list, add various new types of points, and edit the
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abbreviations, glyphs, color and font used when each point is displayed in a wheel or in
a page object.
The types of points that may be added are as follows...
Point – Any of the standard 36 chart points. Normally you would not need to use
these, because they can be displayed in any ordinary chart wheel by including them
as displayed points. However, you do have the option of adding them to the extra
ring if you prefer.
Midpoint – This is a list of all possible midpoint combinations between the
standard 36 chart points.
Fixed Position – This allows any fixed zodiacal position to be entered into the box
to the right of the Add button.
Fixed Star – This allows the selection of any star or celestial object from the
currently selected star file. Alternative star files may be accessed using the Select
File button.
Arabic Part - This allows the selection of any part from the currently selected part
file. Alternative part files may be accessed using the Select File button.
Asteroid - This allows the selection of any asteroid from the currently selected
asteroid file. Alternative asteroid files may be accessed using the Select File button.
Extra Body - This allows the selection of any extra body (defined with orbital
elements) from the currently selected extra body file. Alternative extra body files
may be accessed using the Select File button.
Prior Lunar Phase – This allows the selection of various points related to the lunar
phases which occurred most recently prior to the chart’s date. The Syzygy points are
either a new or full moon – whichever occurred most recently. The “Most Elevated”
point is the point which is closest to the Midheaven of the current chart.
Prior Eclipse - This allows the selection of the position of various eclipse types
which occurred most recently before the chart’s date.
Node – This allows the selection of the Ascending (North) and Descending (South)
nodes of various planets and hypothetical bodies.
>> To add a point or multiple points at once
1. Select the "Point Type" from the list of options
2. Optionally use the Select File button to choose another file
3. Optionally enter a fixed position into the edit box
4. Highlight the required point or points in the list of Available Points
5. Click on the Add button
>> To delete a point
1. Highlight the required point in the list of "Selected Points"
2. Click on the Delete button
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>> To alter the display attributes of a point
1. Highlight the required point in the list of "Selected Points"
2. Edit the Abbr field to change the point’s abbreviated name. The Abbreviation is
displayed in the wheel instead of the glyph if you switch on the “Glyph as Text”
option in the wheel designer. However, if you do so, then you may find that the text
overlaps other items in the chart if there are many extra points.
3. Edit the Glyph/s field to change the point’s displayed glyph (you may choose a
special font by clicking on the Font button, and invoke it's character map by
clicking on the > button). This allows you to choose symbols of various types, such
as a star shaped symbol for star, if you wish.
Asteroid glyphs
Approx 90 asteroid glyphs are available in a font file called ET Asteroid 1 and ET Asteroid
1a. The design of the glyphs was supplied by Roderick Kidston in Australia, an asteroid
expert. Some of the glyphs are in common usage and where there are no glyphs for some
asteroids, Roderick’s glyphs are used. See Asteroids.
>> Saving the file, and setting the current extra ring points file
1. Once you have finished selecting points to be included click on the Save button.
This returns you to the "File Management" dialog box, with the file you've just
edited highlighted.
2. If you want a different file to the one you've just edited to be the "current" file then
click on that other file, otherwise go to step 3.
3. Click on the Select button.
This closes the "File Management" dialog box, and the file you selected in step 2
is now the current extra ring points file (the one whose points will be displayed in
wheels that have an extra ring).
UniWheels installed with Solar Fire that have an extra ring for the chart
Extra1.wh1

- extra points as text

Extra2.wh1

- extra points as glyphs

Extra3.wh1

- extra points as glyphs

Extra4.wh1

- extra points as glyphs

Extra5.wh1

- extra points as text

UniExtra.wh1

- extra points as glyphs

UniExtr2.wh1

- extra points as glyphs

UniExtr4.wh1

- extra points as text

UniExtr5.wh1

- extra points as glyphs
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BiWheels installed with Solar Fire that have an extra ring for each chart
BiExtra1.wh2

- extra points as text

BiExtra2.wh2

- extra points as glyphs

UniDials installed with Solar Fire that have an extra ring for the chart
Extra90.di1

10.9

- extra points as text

Editing an Asteroid File
Asteroids used in Solar Fire belong to two different categories...
Asteroids as Chart Points - The asteroids Ceres, Pallas, Juno, Vesta, Astraea,
Hygeia and Chiron are immediately and always available for display in charts and
reports of all kinds in Solar Fire. They can be selected as Displayed Points, Aspected
Points, Transiting, Progressing and Radix Points in their own right, without the need
to select them in a "user" asteroid file.
Additional Asteroids - A collection of more than 1000 further asteroids are also
included with Solar Fire in source files. Once they have been selected into a "user"
asteroid file these asteroids can be selected for use in specific reports and page
objects. When you first install Solar Fire, a set of 45 of these asteroids will already
be in a user file called "standard.ast", and you can select individual asteroids from
this set to be used in wheels and reports etc.
The additional asteroids that come with Solar Fire are available for use over the
period year 1500 to year 2100. It is also possible to extend this range by acquiring
additional asteroid ephemeris files (see Using More Asteroids).
Using additional asteroids in Solar Fire is a three step process...
1. Asteroid ephemeris and other information, from a variety of sources e.g Swiss
Ephemeris files, Pottenger files, is stored on the computer in "source" asteroid
files. These files have names like "se00007s.se1". Solar Fire comes supplied with
source asteroid files containing over a 1000 asteroids.
2. From these source files you can select individual asteroids to be placed into Solar
Fire's "user" asteroid files. Solar Fire's user asteroid files contain collections of
asteroids that have been selected from the various source files on the computer,
as asteroids to be actually used in the program.
3. Once you have selected an asteroid from a source asteroid file into a user asteroid
file, you can then further select the asteroid from the user file - to be used in
specific pages, wheels and reports.
Solar Fire however already comes supplied with some user asteroid files, containing
different selections of asteroids for use in Solar Fire, and to use them in specific pages,
wheels and reports, you only need to carry out step (c) above. These asteroids may be
quite sufficient for your needs and you may never need to edit a Solar Fire user asteroid
file. However, if you wish to add or remove asteroids from Solar Fire user asteroid files,
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you will need to edit the file.
This section therefore describes how to add or remove asteroids from source asteroid
files into, or from, Solar Fire user asteroid files. Whatever asteroids are in Solar Fire user
asteroid files, are the asteroids which can then be used in the reports and page objects
that pertain to asteroids.
>> To edit an asteroid file
1. From the Main Screen select the Chart Options menu, Files option, Asteroids File
item.
2. Select a user asteroid file from the list of file names
3. Select the Edit button
This will display the "Asteroid Selection" dialog box. The asteroids in this box are the
asteroids from all the various source files on the computer.
The user asteroid file name is at the top, and beneath this is the Folder path for the
source asteroid files of type set in the "Location" area.
The "Selected Asteroids" list box on the left of the dialog displays the number and name
of each currently selected asteroid from those in the source files, and the "Available
Asteroids" list box on the right displays the number and name of all the asteroids in the
source files that are currently available for selection.
TIPS for advanced users: Hovering the mouse over the folder path in the "Location"
textbox causes the full path of the location of the source asteroids to be displayed useful if it wasn't fully visible in the textbox.
If you click on the folder path displayed in the "Location" textbox, the folder listed there
will be opened and you will be able see the various source asteroid subfolders and files
in it.
For normal use of Solar Fire you do not need to know anything about these files. However
if you have installed new source files then see Using More Asteroids regarding updating
the list of "Available Asteroids", in this dialog box, from these newly installed source
files).
>> To edit the name of the selection
Click inside the Description text box, and type in a description for the current
selection. This name is displayed in the "File Manager" whenever you are selecting
asteroid files, so it is helpful to enter a meaningful description of what this
selection contains.
>> To include a single asteroid
1. Find the desired asteroid in the list of Available asteroids
2. Click on its entry in the list
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>> To un-include a single asteroid
1. Find the asteroid in the list of Selected asteroids
2. Click on its entry in the list
As well as selecting individual asteroids, one at a time, you can select a range of
asteroids based on their names or numbers.
>> To include or un-include a range of asteroids by name
1. Ensure that the By Name display order is selected
2. In the Quick Select Frame, type the starting letter into the From box
3. In the Quick Select Frame, type the finishing letter into the To box
4. Click on the On button to switch them on, or the Off button to switch them off. All
the asteroids whose names are within the specified alphabetic range will be
affected.
>> To include or un-include a range of asteroids by number
1. Ensure that the By Number display order is selected
2. In the Quick Select Frame, type the starting number into the From box
3. In the Quick Select Frame, type the finishing number into the To box
4. Click on the On button to switch them on, or the Off button to switch them off. All
the asteroids whose numbers are within the specified range will be affected.
>> To alter the order in which asteroids are listed in Solar Fire reports
Select the desired order from the Display Order option buttons.
Whichever order you choose here will be adopted in Solar Fire’s asteroid reports.
>> Save the file and exit
1. When you have selected all the asteroids you want for this user asteroid file, click
on the Save button.
2. You will be back at the "File Management" dialog. If you want the file you have just
edited to be the "current" Solar Fire asteroid file that you will be using to select
asteroids from to use in reports etc, then click on the Select button. Otherwise
click on the Cancel button.
>> Using asteroids in charts, pages and reports
To display asteroids in a chart in the main ring see Editing a User Defined Points
File.
To display asteroids in a chart in an extra ring see Editing an Extra Ring Points File.
To display transiting, progressing asteroids etc in dynamic reports see Editing an
Extra Dynamic Points File.
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10.9.1 Using More Asteroids
Solar Fire reads data for asteroids whose ephemerides conform to the Swiss Ephemeris
format or the older format created by Mark Pottenger (for use with his CCRS program). If
you have additional asteroid ephemerides of either of these types, then you will be able
to use these with Solar Fire. Solar Fire allows you to select many thousands of asteroids
in a single selection file. However, to maintain a reasonable level of performance, it is
recommended that you do not select more than about a thousand asteroids per file.
You can use Pottenger and Swiss Ephemeris asteroid selections interchangeably i.e. you
can create asteroid selection files for asteroids from either source, and switch between
them as you wish.
Note: Mark Pottenger released a new format of asteroid ephemerides in 2003. This new
format is not supported in Solar Fire.
>> To find Pottenger asteroids on your computer
Click on the Pottenger option button.
This will display a message asking if you wish to search for a location in which other
asteroid ephemerides are present. If you click on the Yes button, then the program
will search through all the folders on your hard drives, looking for a folder containing
a file called “ASTPATH”. If this file is found, then you will be asked to confirm the
name of the folder which is inside the file ASTPATH. (You also have the option of
manually typing in a different folder name). The program will then search through that
folder looking for asteroid ephemeris files, and these will appear in the list of
available asteroids, ready to be selected.
Note: You can install Pottenger asteroid ephemerides to any location on your computer.
However, they must be installed according to Pottenger’s recommended method in order
for Solar Fire to be able to access them.
>> To find Swiss Ephemeris asteroids on your computer
Click on the Swiss Ephemeris option button.
This will locate and list any available Swiss Ephemeris asteroids, and these will
appear in the list of available asteroids, ready to be selected.
Downloading and Installing additional Asteroids
There are various resources that can help you to locate further additional asteroids for
use in Solar Fire. However as these involve the use of third party websites they are
subject to changes outside the control of Solar Fire, and the accuracy of the website
addresses and following information cannot be guaranteed. Downloading and installing
additional asteroids requires some ability with FTP sites and Windows file management
and is not recommended for those who are not reasonably competent in these areas.
The Swiss Ephemeris
The Swiss Ephemeris makes freely available a full set of more than 8000 asteroid
ephemeris files, which may be downloaded from their website. The standard date range
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for these Swiss Ephemeris asteroids is 1500 to 2100. This range can be extended to
3000BC to 3000AD (in most cases) by installing alternative larger ephemeris files. See
www.astro.ch/swisseph/ for general information on the Swiss Ephemeris.
Two Swiss Ephemeris FTP folders where you can download asteroid files from currently
are www.astro.com/ftp/swisseph/ephe/ (shorter date range) and
http://
www.astro.com/ftp/swisseph/ephe/longfiles (longer date range). These pages present
the asteroid folders.
>> To download an asteroid source file from the Swiss Ephemeris
1. Open one of the Swiss Ephemeris FTP folders (current url address are shown
above).
2. Click on a folder (directory) link next to the folder icon and another page will
display the individual asteroid files stored in that folder.
3. Right-click on a file and select the Save target as... option on the popup menu and a dialog box will open allowing you to save the file onto your hard disk.
4. Select the "MyDocuments" or "Documents" folder (or a subfolder in one of those)
to download the file to.(Saving to MyDocuments or Documents avoids any
problems in Windows Vista or later concerning lack of administration rights at this
point in the procedure.)
You must use the file in Solar Fire with the same file name that it has on the FTP site,
so once it is saved check that it has saved with the same name and extension, and if
not rename it to be the same.
TIP: Asteroid files are listed according to their number so unless you know which number
a certain asteroid has been allocated it will be difficult to know which folder it is in, and
which file it is in the folder. You may be able to find out an asteroid's number by reading
some of the text files on the asteroids page (www.astro.com/ftp/swisseph/ephe/) these are files ending in a ".txt" extension e.g. "seasnam.txt" and "seasnam2.txt" etc.
Some asteroids and their numbers may also be found in files called ASTNAMES.TXT,
SEASNAM.TXT (if they exist) in Solar Fire's Swiss Ephemeris location on the computer
(see below).
Another way of finding out an asteroid number is to go to the Jet Propulsion Laboratory
asteroid search website, and enter the asteroid name (e.g. Lucifer) in the Search box
then press the Enter key. This will locate the asteroid information, and in the first line of
information (the title) you will see the asteroid number followed by the asteroid name.
(You can also type in the asteroid number and it will find it that way too.)
>> To install an asteroid file
Once downloaded you must install any of these Swiss Ephemeris asteroid files into
subfolders of the main Swiss Ephemeris folder, according to the recommendations of its
creators. The location of the Swiss Ephemeris folder in use can be found under the
Ephemeris tab of the Preferences dialog.
Note: From the Main Screen you can directly open the Windows folder where the Swiss
Ephemeris files are located ...

© 2014 Esoteric Technologies Pty Ltd

438

Solar Fire 9 User Guide

On the Utilities menu on the Main Screen click on Open SwissEph Files Folder.
The required subfolder names for the asteroids are Ast0, Ast1, Ast2, …, Ast10, Ast20.
Asteroids numbered 1 to 999 must be placed in Ast0, 1000 to 1999 in Ast1, 2000 to 2999
in Ast2 etc.
“Ast20” is used for unnumbered ephemeris files whose names begin with “se20…”.
Note: If you cannot create a subfolder in the main Swiss Ephemeris folder, or copy a file
to a subfolder in it, it may be because you need administrator rights. In Windows Vista
and Windows 7, to load a copy of "Windows Explorer" with administrator rights do the
following...
1. With the mouse right-click the Start button.
2. Select All Programs
3. Select Accessories
4. Right-click on Windows Explorer
5. Select Run as administrator
>> To update the list of available asteroids after you have added or removed
asteroid ephemeris files
1. Select the Chart Options menu, Files item, Asteroids File option.
This will open the "Asteroid Selection" dialog. The current asteroids file in use will
be highlighted, but just what file it happens to be is not significant at this point.
2. Click on the Edit button
3. In the Location area click on either Solar Fire, Pottenger or Swiss Ephemeris,
depending on which kind of asteroids you have downloaded.
4. Click on the Refresh List button.
For Solar Fire and Swiss Ephemeris asteroid locations, this will search the specified
folder in the "Location" textbox for asteroid ephemeris files, and then update the list
of available asteroids in the "Available Asteroids" list. For the Pottenger asteroid
location see above.
Note: If you have removed any asteroid ephemeris files from your computer, then you
must also remove them one by one from your list of "Selected Asteroids". If you have
made major changes, then it may be easier to delete the entire asteroid selection file
and create a new one from scratch.
Also see Ephemerides.
To include the newly downloaded asteroids in a Solar Fire asteroids file so you can select
them see Editing an Asteroid File. You must do this before you can access the asteroids
for use in Solar Fire.
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Editing an Arabic Parts File
This section describes how to edit files that contain definitions of Arabic Parts (or other
combinations of points which may be expressed as A+B-C) to be used when displaying
Arabic Parts reports for a chart.
Note: If you have selected Arabic Parts as part of an almuten definition in the Dignity/
Almuten editor, and you later use the Arabic Parts Editor to remove entries from or
reorder the Arabic Parts file which you used, then the almuten calculation will no longer
work correctly. You will need to use the Dignity/Almuten Editor to reselect all the
required Arabic Parts before you can be sure that the calculation will use the correct
Arabic Parts. See Editing a Dignity/Almuten File for instructions on using the Dignity/
Almuten Editor.
>> To edit an Arabic Parts file
1. Select Arabic Parts from the Files option of the Chart Options menu
2. From the "File Manager", select a file from the list of file names
3. Select the Edit button
Alternatively, you can also access the editor directly from Windows.
>> To open the Arabic Parts editor from Windows
From the Start Menu, All Programs, in the Windows group containing the Solar
Fire program icons, double-click on the Arabic Parts Editor icon. You will be
prompted to select a file to edit, and this will then start up the editor with that
Arabic Parts file displayed.
The status box at the top of the screen displays the number of parts already defined,
followed by the name of the current Arabic Parts file.
The list box at the top left of the screen contains a list of all the items that already
exist in this file. It is possible to see the details for any of these items by clicking on
that item in the list. It is then possible to edit any of the following items relating to
that entry...
Full Name - This is the name by which the item is identified in any reports. It is
recommended that you limit the length of this name to about 30 characters, in order
to avoid the possibility of formatting problems in Solar Fire’s Arabic Parts report.
Abbreviation - This is a unique name, limited to 15 characters, by which this item
is identified internally. It is used only when another item in the list refers to this
entry.
Day or Night - Some parts have different formulas, depending on whether the chart
to which they are being applied is a daytime chart or a nighttime chart. For example
the Part of Fortune has a daytime formula of Ascendant + Sun - Moon, and a
nighttime formula of Ascendant + Moon - Sun, so must have two entries in the list.
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If the formula that you enter applies only during the day (when the sun is above the
horizon), or night (sun below the horizon) then select the Day or Night option. If the
formula does not depend on the sun’s diurnal position, then select the Both option.
Formula A + B - C - Each of the elements in this formula may be selected by clicking
on the drop-down list boxes for that element. Each element has two drop-down
boxes. The top one is used to indicate what type of position is being entered, and
the bottom one to indicate which position of that type.
The possible types of position are:
Type of Position

Available Positions

Example

Fixed Position

Any Point of Zodiac

15Cn00

Dispositor of

Any Chart Point

Dispositor of The Moon

Cusp of

Any House

Cusp of 3rd House

Ruler of

Any House Cusp

Ruler of 12th House Cusp

Other Part

Any other part in this file

FortD

Prenatal

Lunar Phases

New Moon

Once you select a type of position from the top box, the list of positions that are
available for selection in the bottom box is automatically updated. The only exception to
this is if you select the “Fixed Position” option, then the bottom box does not contain a
list - instead you must enter a zodiacal position into it using the keyboard. See Entering
Angles for information on how to enter angles.
>> To create a new entry on the list
Select the New button. This will add an item to the bottom of the list, ready to be
edited with the required details.
>> To delete an existing entry from the list
1. Select the required item from the list.
2. Select the Delete button.
>> To alter the placement of an item in the list
1. Select the required item from the list.
2. Click on the Up or Down arrow of the spin button.
>> To obtain a printout of all the items on the list
1. Optionally select the Printer button. This allows you to alter any printer settings
such as page orientation and resolution.
2. Select the Print button.
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>> To save any changes that you have made since the file was last saved
Select the Save button.
>> To exit from the Arabic Parts editor
Select the Quit button.
If you have made changes but not saved them, then you will be asked whether or not you
wish to save them before exiting.
Any changes that you save will take effect immediately in Solar Fire, any subsequent
Arabic Parts reports produced will use the newly saved data.
If you exit from the Arabic Parts Editor without having saved your changes, then the
program will ask you if you wish to save the changes before it closes.

10.11

Editing a Fixed Stars File
This section describes how to edit files that contain listings of fixed stars (or other
astronomical points such as black holes or galaxies) to be used when displaying fixed
star reports or page objects or the planetarium.
>> To edit a fixed star file
1. Select Fixed Stars from the Files option of the Chart Options menu
2. From the "File Manager", select a file from the list of file names
3. Select the Edit button
Alternatively, you can also access the editor directly from Windows, as follows:
>> To open the fixed star editor
Click on the Start button, then on All Programs, Esoteric Technologies, Solar Fire
v9, Fixed Star Editor.

10.11.1 Creating a New File
In the "Fixed Star Editor"...
>> To create a new file of fixed stars
Select the New option from the File menu.
If you have made any changes to the current file, then you will be prompted to save
them before a new file is opened. When a new file is opened, it contains no star
information. You must enter this information yourself, or you can merge information
from another star file, or import information from a Nova star file.
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10.11.2 Opening an Existing File
In the "Fixed Star Editor"...
>> To open an existing file of fixed stars
Select the Open option from the File menu.
If you have made any changes to the current file, then you will be prompted to save
them before a new file is opened. When you select this option, you will be presented
with a file open dialog box from which you must select the required file.
Solar Fire star files have the file extension “.fst”. It is only possible to open files of this
type. If you attempt to open a file of a different type, then a message will be shown
indicating that the file cannot be read.
10.11.3 Saving a File
In the "Fixed Star Editor"...
>> To save the information that you have entered or edited
Select the Save or Save As option from the File menu.
The Save option will save any changes that you have made using the existing file
name. If there is no file name (i.e. if it is a new file), then this option will prompt you
to enter a name before it is saved. The Save As option prompts you for a name to
save the file as.
10.11.4 Merging a File
In the "Fixed Star Editor" this option allows you to merge the information from another
star file into the current star file.
>> To add all the entries from another star file, and append them to the end of the
current file
Select the Merge option from the File menu.
When you select this option, you will be presented with a file open dialog box from
which you must select the required file. You can only select Solar Fire star files with
this option.
10.11.5 Importing a Star File from Nova
In the "Fixed Star Editor" this option can only be used if you have Astrolabe’s Nova
program installed on your computer. It allows you to import the information from a Nova
type star file into a new Solar Fire star file.
>> To create a new star file using data from an existing Nova type star file
Select the Import option from the File menu
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If you have made any changes to the current file, then you will be prompted to save
them before a new file is created. When you select this option, you will be presented
with a file open dialog box from which you must select the required Nova star file.
Nova star files have the extension “.txt”, and normally reside in the Nova folder.
10.11.6 Printing Star Information
In the "Fixed Star Editor"...
>> To print a listing of the information in the current star file
Select the Print option from the File menu.
This will list all the information in the file apart from the keywords and free text user
the current printer. You can change your printer settings, such as page size and
orientation with the standard printer setup dialog.
>> To change the printer settings
Select the Printer Setup option from the File menu.
10.11.7 Editing Star Information
In the "Fixed Star Editor" data for a star may be changed simply by typing the required
information into the display boxes on the Main Screen. Existing information may be
changed by typing over it.
>> To add a new star entry
Use the Add button or menu item.
>> To delete a star entry
Use the Delete button or menu item.
>> To alter the ordering of entries
Click on the up or down arrow of the spin button.
It is also possible to use the Cut, Copy or Paste menu items to manipulate all the
information relating to a single star entry via the Windows Clipboard. This is especially
useful if you have two copies of the Star Editor running, in which case you can cut or
copy entries in one file and paste them into another. (In order to run two copies of the
"Fixed Star Editor", you must start it independently from Solar Fire, using its own icon in
the Solar Fire Group window)
The editable items are as follows...
Traditional Name - The traditional name is the name by which the star (or
astronomical point) is shown in the list of stars. For example, the brightest star in the
constellation Eridanus is commonly known as Achenar.
Nomenclature - This is a standard technical name by which the star is known. There
are several different systems of nomenclature in use, as listed below. This information
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is optional, and may be left blank.
Bayer nomenclature - uses a Greek letter name which is unique in a particular
constellation, denoting the relative brightness of the star. For example, Achenar is
known as Alpha Eridanus. This indicates that it is the brightest star in the constellation
Eridanus.
Flamsteed nomenclature - uses a number indicating the position in order of right
ascension within a constellation. For example, Alcor is known as 80 Ursa Major.
Messier nomenclature - uses letter M plus a number for nebulous objects in a
constellation. For example, Acumen is known as M7 Scorpius.
Greek Alphabet
1. Alpha
2. Beta
3. Gamma
4. Delta
5. Epsilon
6. Zeta

7. Eta
8. Theta
9. Iota
10. Kappa
11. Lambda
12. Mu

13. Nu
14. Xi
15. Omicron
16. Pi
17. Rho
18. Sigma

19. Tau
20. Upsilon
21. Phi
22. Chi
23. Psi
24. Omega

Constellation - The constellation in which the star (or astronomical point) resides can
be selected from the list of available constellation names in the drop-down list box.
This information is optional, and may be left blank.
GC or NGC Number – GC and NGC stand for General Catalogue and New General
Catalogue, respectively. These catalogues contain lists of observed celestial objects,
and assign a number to each one. For example, Achenar has GC number 1979. This
information is optional, and may be left blank. Note: Most of the data supplied with
Solar Fire contains GC numbers.
Spectral Class - This indicates the quality of light emitted by the star. Typically it
consists of a letter and a number. The letter indicates the general class, and the
number (0-9) indicates where in that class it resides e.g. A7 indicates white star with a
yellowish tinge. The possible letters, in order of hottest stars to coolest stars are:Class
W
O
B
A
F
G
K
M
R
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Color
Greenish-White
Greenish-White
Bluish-White
White
Yellowish-White
Yellow
Orange
Orange-Red
Orange-Red

Temperature
80,000K
36,000K+
12-25,000K
8-10,000K
6-7,500K
5-6,000K
3-5,000K
3,100K
2,500K
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S

Red
Red
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2,500K
2,600K

Sometimes there are also one or more small letters preceding or following the letter/
number combination, as listed below. For example, gK7 indicates a giant orange star.
This information is optional and may be left blank.
n

Diffuse absorption lines

s
c
g
d
e
p

Sharp absorption lines
Exceptionally sharp lines
A giant star
A dwarf star
Has emission lines
Peculiarities

Magnitude - This is a decimal number indicating the visual magnitude of the star. The
lower the number, the brighter the star. e.g. the brightest star is Sirius, which has a
magnitude of -1.4. The lowest visible magnitude is about 6. This information is
optional and may be left blank.
Right Ascension and Declination - This is the position of the star in equatorial
coordinates on the date specified in the Equator of Yr field. Right ascension may be
entered either in Degrees, Minutes and Seconds, or in Hours, Minutes and Seconds of
arc. However, it is always displayed in Hours, Minutes and Seconds. Declination is
always entered and displayed in Degrees, Minutes and Seconds. For example, in 1950
Sirius was at a right ascension of 6h42m56.7s and at a declination of -16°38'46".
These may be entered in any of the following ways...
6h42m56.7s -16°38'46" or
6h42 56.7 -16d38 46 or
6 42 56.7 -16 38 46 or
100d44m10.5s -16d38m46s
Note that the first number entered in the Right Ascension field is assumed to be an hour
number, unless the letter “d” appears somewhere in the entry, in which case the entry is
assumed to be in degrees, minutes and seconds, and is automatically converted and
displayed in the equivalent hours, minutes and seconds.
Proper Motion - This is the annual motion of the star in right ascension and
declination. The motion in right ascension must be entered in decimal seconds of Right
Ascension (time). The motion in declination must be entered in decimal seconds of
Declination (arc). For example, the proper motion of Sirius is -0.037 seconds of right
ascension per year and -1.21 seconds of declination arc per year.
Equator of Yr - This is the “epoch” or year for which the entered right ascension and
© 2014 Esoteric Technologies Pty Ltd

446

Solar Fire 9 User Guide

declination are applicable. Astronomical references usually contain star information
for year 1950, or in more modern references, year 2000.
Keywords and Free Text - For each star, up to 30 characters of keywords or definition
text may be entered, plus unlimited free text. The keyword text is used in Solar Fire’s
star reports. The free text is also used in the Planetarium whenever star information is
shown about any star. This information is optional and may be left blank.
10.11.8 Changing the Date
In the "Fixed Star Editor" the zodiacal positions displayed are calculated for the current
date unless you alter the date setting.
>> To change the date for the calculation of the star’s position
Select the Change Date option from the Edit menu.
You may, for example, wish to enter your date of birth in order to see the star’s positions
precessed to your birth. The format of the displayed date is typically “dd mmm yyyy” or
“mmm dd yyyy” e.g. 31 Dec 1994 or Dec 31 1994. As in the main Solar Fire program,
many other formats may also be entered, but if in doubt, then use one of the above
formats.
10.11.9 Sorting the File
In the "Fixed Star Editor" you can sort the entries in the current file into a variety of
different orders.
>> To change the order of the stars in the file
Select the Sort option from the Edit menu.
You will be presented with a list of possible sort options from which you can choose. You
may re-sort the file as many times as you wish.
10.11.10 Viewing Stars in the Planetarium
>> To start up the Planetarium and view stars of the file currently opened in the
Fixed Star Editor.
Select the All Stars option from the View menu.
Alternatively, the planetarium may be started from Solar Fire’s View menu. In this case,
you must select the required fixed star file from Solar Fire’s menu before choosing the
Planetarium option.

10.12

Editing a Dignity/Almuten File
There are several reports and page objects within Solar Fire that use a dignity scoring
system in order to determine which planet is the most dignified in certain circumstances.
These items are as follows...
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Essential Dignities Tabulations - These are displayed in the “Horary” report and
also in the “Essential Dignities” page object, and are defined in the file essdig.alm
in Solar Fire’s main program files folder.
House Almutens - These are displayed in the “Horary” report and also in the
“House Almutens” page object, and are defined in the file house.alm in Solar Fire’s
main program files folder.
Dignity/Almuten Scores - These are displayed in the “Dignity/Almuten” page
object. By default, they are defined in the file general.alm in Solar Fire’s main
program files folder, but the user can generate any number of customized
definitions in files of the type *.alm in Solar Fire User Files / Almutens & Dignities
folder, and opt to use these customized definitions instead of the default.
In each case, the dignity scoring definitions are stored in files of the type “*.alm”, and
any file of this type may be edited in the Dignity/Almuten Editor.
>> To start the Dignity/Almuten editor
From the Utilities menu, select the Dignity/Almuten Editor item.
When the editor first starts up, it will prompt you to select an existing dignity/almuten
file. If you do not select one to open, then it will start with a new dignity definition set
containing a single definition for the scoring of essential dignities.
10.12.1 Manipulating Files
In the "Dignity/Almuten Editor"...
>> To open an existing dignity definition file for editing
Select Open from the File menu.
This will display a standard “File Open” dialog from which you may select any existing
file with a “*.alm” extension.
The default folder for user-defined dignity/almuten definition files is Solar Fire’s
\USERDATA folder. However, the system default definition files reside in Solar Fire’s
main program files folder. Initially, you will have the following files available...
general.alm - The default file used by the Dignity/Almuten page object. This is in Solar
Fire’s main program files folder. It contains several definitions.
essdig.alm - The file used for the calculation of essential dignities tables. This is in
Solar Fire’s main program files folder. It contains a single definition.
house.alm - The file used for the calculation of house cusp almutens. This is in Solar
Fire’s main program files folder. It contains a single definition.
hyleg.alm – The file used for certain parts of the calculation of chart Hylegs. This is in
Solar Fire’s main program files folder. It contains a single definition.
You have the option of editing any of these files, in addition to any further user-defined
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dignity/almuten definition files that you have previously created yourself.
>> To save any changes you have made
Select Save from the File menu. This will save any changes you have made to the
file that is currently being edited.
>> To save the current file as a copy under a new name
Select Save As from the File menu.
This will display a standard “File Save” dialog in which you may enter a new name
(and optionally location) for the file. The file must have a “.alm” extension in order to
be usable in Solar Fire, and it must be saved to Solar Fire User Files / Almutens &
Dignities folder. The only exceptions are for the system default definition files
(essdig.alm, house.alm, hyleg.alm) that must always reside in Solar Fire’s main
program folder.
>> To create a new dignity/almuten definitions file from scratch
Select New from the File menu. This will create a new file containing a single
definition for essential dignities, which you can edit and save under any name you
like.
10.12.2 Editing a Single Definition
In the "Dignity/Almuten Editor"...
>> To edit any definition on the list
Select the entry you wish to edit by clicking on it.
This will update all the other items on the screen to display what is contained in this
definition, and any of these items may be edited.
The editor allows you to create two different types of dignity/almuten definitions.
10.12.2.1 Calculation Types

In the "Dignity/Almuten Editor" the calculation types are...
Degree Dignities - This type of definition allows you to specify a calculation which
determines either i) the dignity score of a planet for the position that it occupies in
the chart (also known as “essential dignities”, or ii) to determine the dignity scores
of all planets at the position of a house cusp, from which the almuten of the house
cusp may be determined.
For example, if Jupiter is at 28 Libra, then the ruler is Venus, exaltation is Saturn,
Triplicity ruler (daytime chart) is Saturn, Term ruler (Ptolemaic) is Mars, the Face is
Jupiter, the Detriment is Mars and the Fall is the Sun. In this case, Jupiter would be
assigned points for being in its own Face. If the definition was being used to calculate
a house cusp, then Saturn would get the highest dignity score, because it is exalted
and in triplicity
Almuten - Sum over Points - This allows you to specify a calculation which sums
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the dignities of each planet at each of a variety of specified positions. The result is
a summed score for each planet, and the highest scoring planet is deemed to be the
overall almuten.
For example, Ibn Ezra suggests that the almuten of the chart can be found by
summing the dignity scores that each planet has at the positions of I) the Moon, ii)
the Sun, iii) the Ascendant, iv) the Part of Fortune and v) the position of the moon at
the last syzygy (new moon or full moon) prior to the time of the chart.
In Dignity/Almuten editor...
>> To select the Calculation Type
Click on either the Degree Dignities or the Almuten option button in the
Calculation Type frame.
If you select the Almuten option, then the Selected Points button and Minimum
Honors edit boxes will become enabled, otherwise these options will remain
unavailable.
10.12.2.2 Selecting Points

In the "Dignity/Almuten Editor"...
>> To select points for almuten calculations
Click on the Selected Points button.
This will display the “Summation Point Selection” dialog box from which you can select a
large range of primary chart points, house cusps or other derived positions.
The points available are as follows...
All Chart Points
Each of the 12 House Cusps
Various Other Points
The Descendant (DSC)
The Immum Coeli (IC)
The prenatal syzygy Moon
The prenatal syzygy Sun
The prenatal syzygy Sun or Moon (Most Elevated)
The prenatal New Moon
The prenatal Full Moon
The prenatal Sun (at the Full Moon)
Any Arabic Parts in a selected Arabic Parts file
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10.12.2.3 Selecting Point Modifiers

In the "Dignity/Almuten Editor"...
For each point, you can also choose to apply the following modifiers...
Own position - no modifier is applied. The position of the selected point is used in
the calculation.
Dispositor - The position of the ruler of the sign in which this point is placed is used
in the calculation. The rulerships used depend of which set is chosen using the
Options button.
Triplicity rulers - The position of the 1s t (in sect), 2nd (out of sect) or 3rd
(participating) triplicity ruler of the element in which this point is placed is used in
the calculation. The triplicity type used depends on what is selected using the
Options button.
Term ruler - The position of the term ruler of this point is used in the calculation.
The term type used depends on what is selected using the Options button.
Face ruler - The position of the face ruler of this point is used in the calculation.
The rulerships used depend of which set is chosen using the Options button.
10.12.2.4 Adding and Removing Points

In the "Dignity/Almuten Editor"...
>> To add a point to the list of selected points
1. Select an option from the Points to Show frame. This will list all the available
points of that type in the Available Points list.
2. Select an option from the Point Type frame.
3. Select the required point from the list of Available Points by highlighting it and
then clicking on the Add button, or by double-clicking its entry. This will add the
selected point to the bottom of the list of Selected Points.
>> To remove a point from the list of selected points
Select the required point from the list of Selected Points by highlighting it and then
clicking on the Delete button, or by double-clicking its entry. This will remove that
entry from the list.
If you wish to specify any Arabic Parts as selected points, then you must first ensure that
you have an Arabic Parts file containing the required Arabic Part definitions. See Editing
an Arabic Parts File for instructions on using the Arabic Parts Editor.
10.12.2.5 Other Items

In the "Dignity/Almuten Editor"...
>> To select an Arabic parts file
Click on the Arabic Parts File button.
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This will display a standard file open dialog listing all available Arabic Part files. You
must select a file from this list. You must not attempt to select a file from any other
folder than the one which is first displayed (the Solar Fire \USERDATA folder), or else
the Arabic Parts will not become available for selection.
Notes:
1. You can select Arabic Parts from a single Arabic Parts file only. Once you have
added Arabic Parts as selected points, and you then select a different Arabic Parts
file, any Arabic Parts selected from a previous file will be removed from the list.
2. If you wish to use an Arabic part that has a separate day/night formula (for
example the Part of Spirit), then you should ensure that you add both the day and
the night formula versions of that Arabic Part to the list of selected points (Part of
Spirit (Day) and Part of Spirit (Night)). When Solar Fire calculates the almuten, it
will ignore that version of the Arabic Part which is not applicable to the sect of the
chart for which the almuten is being calculated.
3. Warning: If you later use the Arabic Parts Editor to remove entries from or reorder
the Arabic Parts file which you select here, then the almuten calculation will no
longer work correctly. You will need to use the Dignity/Almuten Editor to reselect
all the required Arabic Parts before you can be sure that the calculation will use
the correct Arabic Parts.
When you have selected the required points, click on the Save button to return to the
previous screen.

>> To select Minimum Honors
Click inside the Minimum Honors edit box, and type in the minimum number of
honors that a planet must have in order to be deemed the almuten.
An honor is a dignity by rulership, exaltation, triplicity, term of face. This option is
intended to be used to prevent a planet from being deemed the almuten if it does not
have sufficient dignity. If a planet does not have minimum honors when this option is
set, then it is given a zero dignity score. It is currently used only in the hyleg.alm
system file for the calculation of chart Hylegs.
>> To edit text for the Brief Name, Full Name and Description
Place the cursor in the required edit box, and type in the changes.
Brief Name is what this definition is called on the list, and does not affect anything
else in Solar Fire.
Full Name is used in Solar Fire’s dignity/almuten page object as a title for the
definition, so should be brief but descriptive.
Description is not used in Solar Fire, but may be used to add a few notes about the
definition, its origin, and how it should be used, for example.
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10.12.2.6 Editing Dignity Scores

In the "Dignity/Almuten Editor"...

>> To select an item on the Dignity Scoring list for editing
Select the required item by clicking on it.
The Dignity Scoring list items are as follows...
In Rulership - The score for a planet that is a sign which it rules
In Exaltation - The score for a planet that is in a sign in which it is exalted
In Triplicity (In Sect) - The score for a planet that is in its own triplicity for the sect
of the chart (diurnal or nocturnal).
In Triplicity (Out Sect) - The score for a planet that is in its own triplicity for the
opposite sect of the chart (nocturnal or diurnal).
In Triplicity (Extra) - The score for a planet that is in its own triplicity of the extra
(or participatory) triplicity ruler.
In Term - The score for a planet which is in its own term
In Face - The score for a planet which is in its own face
In Detriment - The score for a planet which is in a sign opposite its rulership
In Fall - The score for a planet which is in a sign opposite its exaltation
In MR (Rulership, Exaltation etc.) - The score for a planet that is in mutual
reception by rulership, exaltation, triplicity (in sect), term or face.
Planet of Day - The score for the planet that is the planet of the day.
Planet of Hour - The score for the planet which is the planet of the hour
In Peregrine - The score for planet which is in peregrine
In House x - The score for a planet occupying the xth house.
Notes:
1. Any score may be set to 0 (zero) to prevent it being used in the dignity scoring
calculation.
2. Rulerships, exaltations, faces, detriments and falls are deemed according to
whichever set of rulerships has been selected to be used with this definition.
3. Triplicity rulerships are deemed according to whichever one of the available
options is selected as described below.
4. Term rulerships are deemed according to whichever one of the available options is
selected as described below.
5. A planet is deemed to be in peregrine if it has no dignity by rulership, exaltation,
triplicity, term or face. Optionally, a further condition for deeming a planet to be
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peregrine is that is also has no mutual receptions by rulership, exaltation, triplicity,
term or face. This option may be selected by the user as described below.
6. The Planet of Day, Hour and House options would normally only be used for
almuten calculations rather then degree dignities.
7. When scoring the In House option, the house placement of each planet is
determined according to user-defined options as described below.
>> To adjust the scoring for the selected dignity item
Click on the > button to increment the score by 1 point, or the < button to decrement
the score by 1 point.
When you select a dignity item that is a Mutual Reception (MR), you can also select a
peregrine option, which affects whether or not a planet can be deemed to be in
peregrine if it is in mutual reception. These options are as follows.
Ignore MR for peregrine flag - This option ignores the mutual reception when
determining whether a planet is in peregrine, so the planet may be in peregrine
even if it is in a mutual reception of this type.
Cancel flag if MR occurs - This option cancels the peregrine if any mutual reception
of this type occurs for the planet, so the planet is deemed not to be in peregrine if
the mutual reception occurs.
You can prevent a dignity/almuten definition from being used for either daytime or
nighttime charts if you wish. This is useful if you wish to apply different scoring for day
and night charts, in which case you must create two separate definitions, and apply one
to diurnal (daytime) charts only, and the other to nocturnal (nighttime) charts only. When
Solar Fire displays dignity/almutens scores, it will ignore the definition that does not
apply to the current chart, and display the scores only for the definition that does apply.
10.12.2.7 Diurnal Applicability

In the "Dignity/Almuten Editor"...
>> To select diurnal applicability
Click in the Diurnal Charts and Nocturnal Charts check boxes to switch them on or
off. At least one of these must be checked, and both must be checked in order to
apply the definition to charts of both types.
10.12.3 Selecting Further Options
In the "Dignity/Almuten Editor"...
>> To select further options
Click on the Options button. This will display the “Dignity/Almutens Options”
dialog box.
Planetary Rulerships
You can select any set of rulerships that are defined in Solar Fire’s Rulerships and
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Weightings Editor (see Editing Rulerships).
10.12.3.1 Triplicities

In the "Dignity/Almuten Editor" you can also set these options...
Triplicity Type
There are three different sets of triplicity rulers from which you may choose.
Ptolemy - As defined in his book “Tetrabiblos”
Lilly - As defined in his book “Christian Astrology”
Dorothean - According to Dorotheus of Sidon.
Ptolemy

Lilly

Triplicity
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D=Day; N=Night; P=Participatory
For a more detailed discussion of the different triplicity rulerships and their applicability,
you might like to refer to Dr. Lee Lehman’s book “Classical Astrology for Modern Living”,
published by Whitford Press.
10.12.3.2 Terms

In the "Dignity/Almuten Editor" you can also set these options...
Term Type
There are two different term definitions from which you may choose.
Ptolemy - As defined in his book “Tetrabiblos”. This set of term rulerships is also
sometimes referred to as “Chaldean” (as translated by Lilly)
Egyptian - As defined in Ptolemy’s “Tetrabiblos”.
The following tables indicates the terms of each sign, giving the planet ruling each term
and the number of degrees into the sign at which its rulership ends, e.g. in the Ptolemaic
Terms table, Jupiter rules the first 6 degrees of Aries (i.e. from 0 00 to 5 59’59”), and
Venus rules the next 8 degrees (i.e. from 6 00 to 13 59’59”).
Ptolemaic Terms
Ü
Ý

½6
»8
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» 14
º 15

º 21
½ 22

¼ 26
¾ 26

¾ 30
¼ 30
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ƒ
„
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†
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Š
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º7
¼6
¾6
º7
¾6
¼6
½8
»6
¾6
»8

½ 14
½ 13
º 13
» 13
» 11
½ 14
» 14
º 12
º 12
½ 14

» 21
º 20
» 19
½ 18
½ 19
» 21
º 19
½ 19
» 20
º 20

¾ 25
» 27
½ 25
¾ 24
º 24
º 27
¾ 25
¼ 25
½ 25
¼ 26

¼ 30
¾ 30
¼ 30
¼ 30
¼ 30
¾ 30
¼ 30
¾ 30
¼ 30
¾ 30

½6
»8
º6
¼7
½6
º7
¾6
¼7
½12
º7
º7
»12

» 12
º 14
½ 12
» 13
» 11
» 17
º 14
» 11
» 17
½ 14
» 13
½ 16

º 20
½ 22
» 17
º 19
¾ 18
½ 21
½ 21
º 19
º 21
» 22
½ 20
º 19

¼ 25
¾ 27
¼ 24
½ 26
º 24
¼ 28
» 28
½ 24
¾ 26
¾ 26
¼ 25
¼ 28

¾ 30
¼ 30
¾ 30
¾ 30
¼ 30
¾ 30
¼ 30
¾ 30
¼ 30
¼ 30
¾ 30
¾ 30

Egyptian terms
Ü
Ý
‚
ƒ
„
…
†
‡
ˆ
‰
Š
‹

For a more detailed discussion of the different term rulerships and their applicability, you
might like to refer to Dr. Lee Lehman’s book “Classical Astrology for Modern Living”,
published by Whitford Press.
10.12.3.3 Other Items

In the "Dignity/Almuten Editor" you can also set these options...
Sign Boundaries
The usual modern practice is to deem that an astrological sign starts at 0° of the sign.
However, it is possible that some ancient astrologers may have deemed a sign to
begin at 1° when defining the term rulerships. In this case, the first degree of each
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sign is deemed to be the 30th degree of the previous sign. No other degrees are
affected, and this option only affects determination of the terms. For example, in the
Ptolemaic Terms table, Jupiter would rule from 1°00 to 5°59’59” of Aries, and Saturn
would rule from 25°00 of Aries to 0°59’59” of Taurus.
House System
You can opt to allow Solar Fire to use whichever house system is in use with the chart
for which this definition is being used, or you can force it always to use a selected
house system. This is useful if you are trying to emulate the almuten calculations of
medieval astrologers who used a specific house system, for example.
House Cusps Degree Offsets
When determining which house a planet is placed in, many astrologers read a planet
forward into the next house if it is close to the cusp of the next house. You can
emulate this procedure by specifying a number of degrees from each house cusp type
within which the planet will be considered to be in the next house. Typically this
offset is greatest for angular houses, and smallest for cadent houses. For example,
specifying an offset of 8 degrees will cause any planets lying up to 8 degrees ahead
of an angular house cusp (1st, 4th, 7th or 10th) is deemed to be in that angular house.
This procedure only affects the dignity/almuten scoring for house placements of
planets, so will have no effect unless you are using non-zero scores for the “In
House” dignity scoring items.
Part of Fortune
If the Part of Fortune (or its dispositor) is selected as a summation point in the
Almuten calculation, then you can specify whether it is calculated according to the
daytime formula only, or whether to apply the different nighttime formula in any
nocturnal chart. A similar option is also available within the main Solar Fire program,
but the setting of the option in this screen overrides the choice you have made in
Solar Fire when almuten calculations are being performed.
10.12.4 Adding a New Definition to the List
In the "Dignity/Almuten Editor"...
>> To add a new definition to the list
Select Add New Definition from the Edit menu.
This will add a new definition for essential dignities to the bottom of the list. You can
edit this new definition as you wish.
>> To duplicate an existing definition on the list
1. Select the entry you wish to copy by clicking on it
2. Select the Paste Definition item from the Edit menu. This will add a copy of the
current definition to the bottom of the list. You can edit this as you wish.
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10.12.5 Deleting a Definition
In the "Dignity/Almuten Editor"...
>> To delete a definition from the list of dignity/almuten definitions
1. Select the required entry from the list by clicking on it
2. Select the Delete Definition item from the Edit menu.
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Reference Information
These topics form the Reference section. Here you will find various topics of a data or
technical nature that you can refer to as the need arises.

11.1

Symbols & Abbreviations
Symbols and abbreviations used.

11.1.1 Zodiac Signs
Symbol

Sign

Abbr

Symbol

Sign

Abbr

Ü
Ý
‚
ƒ
„
…

Aries

Ar

Libra

Li

Taurus

Ta

Scorpio

Sc

Gemini

Ge

Sagittarius

Sg

Cancer

Cn

Capricorn

Cp

Leo

Le

Aquarius

Aq

Virgo

Vi

†
‡
ˆ
‰,ú
Š
‹

Pisces

Pi

11.1.2 Chart Points
Symbol

Name

Abbr

¶
·
¸
¹
º
»
¼
½
¾
¿,û
À, õ
Á,þ,ÿ
É
Ê
Â
Ã
Ä
Å
Æ

Moon

Mon

Earth

Ear

Sun

Sun

Vulcan

Vul

Mercury

Mer

Venus

Ven

Mars

Mar

Jupiter

Jup

Saturn

Sat

Uranus

Ura

Neptune

Nep

Pluto

Plu

North Node

Nod

South Node

Sno

Chiron

Chi

Vesta

Ves

Pallas

Pal

Juno

Jun

Ceres

Cer
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Symbol

Name

Abbr

Ç
È
Ë
Ì
Í
Î
Ï
Ð
Ñ
Ò
Ó
Ô
Õ
Ö
×
Ø
Ù
å
æ
ç
è
é
ê
ë
ì
í
î
ï
ð
ñ
ò

Hygeia

Hyg

Astraea

Ast

Ascendant

ASC

Midheaven

MC

Vertex

Vx

Equatorial ASC

Ep

Part of Fortune

PF

Cupido

Cup

Hades

Had

Zeus

Zeu

Kronos

Kro

Apollon

Apo

Admetos

Adm

Vulcanus

Vus

Poseidon

Pos

TransPluto

TPl

Black Moon

BMo

CoAscendant

CAs

Polar Ascendant

Pas

Descendant

DSC

Imum Coeli

IC

AntiVertex

AVx

Equatorial Descendant

EqD

CoDescendant

CDs

Polar Descendant

PDs

Aries Point

Ari

Libra Point

Lib

Vernal Point

VP

Selena

Sel

Sedna

Sed

Eris

Eri
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11.1.3 Aspects
All the aspects of longitude from the 1st to the 12th harmonic are shown in the following
table, with angles in decimal degrees, and fractions relating to a full circle.
Symbol

Name

Abbr

Angle

Fraction

ß

Conjunction

Cnj

0

0

à

Opposition

Opp

180

1/2

á

Trine

Tri

120

1/3

‘

Square

Squ

90

1/4

—

Quintile

Qnt

72

1/5

’

Sextile

Sxt

60

1/6

›

Septile

Spt

51.43

1/7

“

SemiSquare

SSq

45

1/8

ã

Novile

Nov

40

1/9

™

Decile

Dec

36

1/10

¡

Undecile

Und

32.73

1/11

•

SemiSextile

Ssx

30

1/12

˜

BiQuintile

BQn

144

2/5

œ

BiSeptile

BSpt

102.86

2/7

â

TriSeptile

TSpt

154.29

3/7

”

SesquiQuadrate

Sqq

135

3/8

Ÿ

BiNovile

BNv

80

2/9

ä

QuadriNovile

QNv

160

4/9

š

SesquiQuintile

SqQn

108

3/10

¢

BiUndecile

BiUn

65.45

2/11

£

TriUndecile

TrUn

98.18

3/11

¤

QuadriUndec

QaUn

130.91

4/11

¥

QuinqueUndecile

QiUn

163.64

5/11

–

Quincunx

Qnx

150

5/12

The aspects of declination are:-

¦ Parallels - denote equality of declination
§ ContraParallels - denote equal but opposite declination angle (e.g. +3 and -3).
11.2

Technical Details
These topics contain technical information about various definitions, operations and
workings of Solar Fire, Astrology and Windows.
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11.2.1 Solar Fire
This section details the technical aspects of Solar Fire.
11.2.1.1 Solar Fire version

Clicking on the Help menu, then About Solar Fire submenu displays the following
information about Solar Fire:
The full version number
The date this version was created
Who this copy of Solar Fire is licensed to
The serial number of this copy
The Windows version number and type
Note: The Solar Fire version number is also displayed on the title bar of the Solar Fire's
Main Screen.
11.2.1.2 Recovery from Failure

In case of computer hardware failure, or other accidents, it is wise to have made backup
copies of certain key files on your computer.
The Solar Fire program can normally be reloaded from its original installation media
should you ever experience a major problem. If your original CD has become corrupt or
unusable for any other reason, then you can get a replacement copy by contacting you
astrological software dealer, usually at a nominal cost.
However, to avoid losing any data files that you may have created or saved during the
course of your usage of the Solar Fire program, (which therefore cannot be reloaded from
the installation diskettes), you should create your own backup of the user data files
associated with the program.
Alternatively, Solar Fire has a built-in utility that helps you backup just your chart files, or
all your user files (see Backing Up and Restoring Chart Files).
Whichever method you use, you should always backup all the files that are in the Solar
Fire User Files folder in the Documents or MyDocuments folder, including all its
subfolders.
If you are accessing chart files from any location other than Solar Fire User Files folder,
then you should also back them up. If you backup these files, and keep your original
installation media, then you can recover from a disaster as follows...
1. Re-install Solar Fire using the installation media
2. Restore the backup files to the Solar Fire User Files folder under the Documents or
MyDocuments folder (see Solar Fire Files and Folders for details of user file
locations for different versions of Windows). This must be done manually.
It is recommended that you perform backups on a regular basis, or at least after those
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occasions when you have created large numbers of new charts or maps etc.
To aid in manually copying files see Windows Explorer.
11.2.1.3 Uninstalling Solar Fire

>> To uninstall Solar Fire
1. Select Control Panel from the Start button
2. Select Add/Remove programs, or Programs and Features
3. Find Solar Fire on the list, and highlight it
4. Click on the Remove, or Uninstall, button
Note: The Microsoft Windows Installer technology doesn't always remove all application
files from your system.
If you want to effect a full uninstall, you may need to check whether any of the following
are left on your computer after uninstalling, and remove them manually.
Program Files: C:\Program Files\SolarFire9 or C:\Program Files (x86)\SolarFire9
and any files in the folder
Fonts: ETSym3.ttf, ETSans3.fon and ETAst1.ttf - accessed via Fonts in the Control
Panel.
(Check in the font properties for the actual file name).
User files: MyDocuments\Solar Fire User Files or Documents\Solar Fire User Files
and the various sub folders under that folder.
11.2.1.4 Solar Fire Files and Folders

Solar Fire installs three main different groups of files onto your computer - program files,
common files and user files.
FILE TYPES

Program files are internal program files used by Solar Fire to load and run itself
(e.g. Solfire.exe).
Common files are program files used by more than one program (e.g. Swiss
Ephemeris files). Solar Fire stores files common to all of Esoteric Technologies
programs in this group.
User files are files that can be used by you the user (e.g. chart files).
You can create and edit most of the different types of user files. Examples of user
files are chart files, point files, aspect files, color files, wheel and page design files.
Program settings that you can change via Preferences are also stored here along with
your user files.
These three groups of files are stored by default in different places:
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Program and common files
- stored in the Windows PROGRAMS area
User files
- stored in the Windows USER DOCUMENTS area.
FILE LOCATIONS

The exact full folder path for each group of files differs slightly depending on which
version of Windows is being used. As well, when Solar Fire is installed the user is able
to change the installation location of the program files, and after installation relocate
the Swiss Ephemeris files.
Therefore the locations shown below are the default installation locations suggested
by the installation program. If you accepted these defaults and haven't changed them
since, Solar Fire's files will be found at these locations.
Solar Fire's PROGRAM files
- in 32 bit Windows XP, Windows Vista and Windows 7
C:\Program Files\SolarFire9

- in 64 bit Windows Vista or Windows 7
C:\Program Files (x86)\SolarFire9

Solar Fire's COMMON files
- in 32 bit Windows XP, Windows Vista and Windows 7
C:\Program Files\Common Files\Esoteric Technologies\SolarFire9

- in 64 bit Windows Vista or Windows 7
C:\Program Files (x86)\Common Files\Esoteric Technologies\SolarFire9

The Swiss Ephemeris files are stored in the "\SwissEph" subfolder under this folder.
Solar Fire's USER files
- in Windows XP
C:\Documents and Settings\UserName\MyDocuments\Solar Fire User Files

Shortcut - click on the MyDocuments folder, click on Solar Fire User Files

- in Windows Vista
C:\Users\UserName\Documents\Solar Fire User Files

Shortcut - click on the Documents folder, double-click on Solar Fire User Files

- in Windows 7
C:\Users\UserName\Documents\Solar Fire User Files

Shortcut - click on Libraries, double-click on Documents, double-click on Solar Fire
User Files

UserName is the Windows account name used to login to the computer with.
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Multi user situations
Users of the computer with individual logins all have a separate set of user files
and settings. Each user can create and maintain their own preferences and
settings.
If several users are logging in to the computer with the same UserName when
they use Solar Fire, then they will all have to use the same preferences and
settings - any changes made by one will effect the others too.
An exception to this is user's charts. As chart files can be stored in many
different locations, all users of Solar Fire can store their own chart files in
their own dedicated folder - regardless of what username they use to log in
to the computer.
The Solar Fire User Files folder (and all it's subfolders) must always be a
subfolder under the Documents or MyDocuments folder. This is the only place
Solar Fire looks for user files. * Chart files are the one exception to this - Solar
Fire will look for these wherever you tell it to look.
APPLICATION DATA

When Solar Fire operates, as well as creating data that is relevant to the user, it also
creates data that it uses for it's own purposes. This data is stored in the following
locations.
LOCAL PROFILE
Windows XP
C:\Documents and Settings\UserName\Local Settings\Application Data\Esoteric Technologies\Solar Fire\v9

Windows Vista / 7
C:\Users\UserName\AppData\Local\Esoteric Technologies\Solar Fire\v9

ROAMING PROFILE
Windows XP
C:\Documents and Settings\UserName\Application Data\Esoteric Technologies\Solar Fire\v9

Windows Vista / 7
C:\Users\UserName\AppData\Roaming\Esoteric Technologies\Solar Fire\v9

11.2.1.4.1 Windows Explorer

You will need a basic knowledge of Windows to use Solar Fire - such as starting your
computer/Windows, knowing what the Start button is, running programs via icons on the
desktop or the Start menu, and once Solar Fire is running - selecting items off menus,
activating command buttons, filling in dialog forms etc. To learn more about these
activities refer to your Windows documentation and help. Generally you do not need to
know much else about Windows itself, or its file system, to use Solar Fire. However there
are a few occasions where being able to navigate and manipulate folders and files may
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be an advantage.
To do anything directly with folders and files on your hard disk you will generally need to
know how to open and use Windows Explorer. This is the Windows application that lets
you see your folders and files; copy, move and delete folders and files; and access
external media such as CDs, DVDs, USB flash drives, and external hard drives etc. Often
Windows Explorer has an icon on the desktop, or in the Start menu, but depending on
your operating system and use of your computer, not necessarily so. Below is a quick
way to open Windows Explorer that you can always use.
>> To open Windows Explorer
Windows XP, Windows Vista
1. Right-click on the Start button. A small menu will pop up.
2. Click on Explore All Users
Windows 7
1. Right-click on the Start button. A small menu will pop up.
2. Click on Open Windows Explorer
11.2.1.4.2 File Types

The following table describes some of the file types that are included in Solar Fire’s
folders. An asterisk ("*") is a "wildcard", which means it represents any number of
various characters, although the number is limited by standard Windows restrictions, or
by Solar Fire file naming conventions (e.g. in *.wh* the asterisk after "wh" usually
represents a number that shows how many charts are in the wheel design file).
Type
*.adp
*.alm
*.arp
*.asp
*.cas
*.SFcht
*.cht
*.chm
*.cpt
*.SFcri
*.csg
*.dat
*.di*
*.doc
*.elm
*.eph
*.fil
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Description
Aspected points
Dignity/Almuten definitions
Arabic Parts
Aspect set
Aspect colors
"Chart Database" (SFv6/v7/v8/v9 format)
"Chart Database" (SFv5 or earlier format)
Chart comments (SFv5 or earlier format)
Chart point colors
Search criteria
Sign colors
Orbital elements file
Dial design file
Documentation text file
Ephemeris element files
Ephemeris files
Data file
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*.fst
*.lst
*.mnu
*.pag
*.prp
*.pte
*.pts
*.ptu
*.sta
*.trp
*.tsk
*.usr
*.wh*
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Fixed stars
List of files to install
Menu definition
Page layout file
Dynamic progressing points
Extra ring points
Displayed points
User-defined points
Stationary points
Dynamic transiting points
Astrologer's assistant task file
User name file
Wheel design file

11.2.1.4.3 Swiss Ephemeris Files

Solar Fire uses the Swiss Ephemeris for virtually all of it's planetary position calculations.
The user has some flexibility regarding the location of the Swiss Ephemeris files on their
computer that Solar Fire uses. By default Solar Fire installs a copy of the Swiss Ephemeris
into a standard location in the Program Files or Program Files (x86) folder. However Solar
Fire doesn't have to use these files if you have a copy of the Swiss Ephemeris at another
location and would prefer to use that instead.
You can direct Solar Fire to use Swiss Ephemeris files at a different location in either of
two ways:
1. Via the Preferences menu, Edit Settings - see Ephemerides
2. By creating a User environment variable on your computer,which is normally done
via the System icon in Windows Control Panel. (In Windows 7 you need to then
select Advanced System Settings/Environment Variables). This option is included
for users who are reasonably familiar with the technical side of Windows and is
not recommended for those who aren't.
>> Create a new user environment variable called "SE_EPHE_PATH" (without the
quotes) and set it's value to the full path to the folder containing the Swiss
Ephemeris files.
The next time Solar Fire starts up it will check for this variable and if the path is valid
it will use the Swiss Ephemeris files at this location. In this scenario it may also
delete the copy of Swiss Ephemeris files that it initially placed in a location in
Program Files when Solar Fire was installed.
Note: From the Main Screen you can directly open the folder where the Swiss
Ephemeris files are located ...
>> To open the current folder (default or otherwise) of the Swiss Ephemeris
On the Utilities menu on the Main Screen, click on Open SwissEph Files Folder

© 2014 Esoteric Technologies Pty Ltd

468

Solar Fire 9 User Guide

11.2.1.4.4 Interpretation Files

By default Solar Fire's interpretation files (*.int files) are located in the "Interpretations"
subfolder under the "Solar Fire User Files" folder, which is itself a subfolder in the user's
Documents or MyDocuments folder.
However if you wish to store all your interpretation files in a different location you can,
but you must tell Solar Fire where to find them.
>> Specifying the path to the Interpretation files
1. Edit the Solfire9.ini file, which is located in the "Settings" subfolder under the
user's "Solar Fire User Files" folder.
2. In the [Solar Fire] section add a new entry:
InterpPath=<folderpath>
... where <folderpath> is the full path name with a "\" on the end
e.g if you copy all the interpretation files from the default location to a folder in
your documents folder called "MySFInterps" then the entry in the Solfire9.ini file (on
a Windows7 computer) would look like this:
InterpPath=C:\Users\UserName\Documents\MySFInterps\
UserName is the Windows account name used to login to the computer with.
If you enter an incorrect path Solar Fire will look for interpretation files in it's program
installation location. If you select the "Interps" menu off the Main Screen, then select
"Interpretation files" then any of the various kinds of interpretation (e.g. Natal), a File
Management dialog box will appear for all the Interpretation files and the path it has
used to look for these will be found near the top of the dialog box. If this path is not
where your interpretation files are this indicates you have entered an incorrect path in
Solfire9.ini.
11.2.1.5 System functions

Solar Fire stores most of it's settings in INI files (*.ini) which contain a mixture of
internal system and user settings. (INI is short for initialization). The main INI file is the
Solfire9.ini stored in the "Solar Fire User Files\Settings" folder which is a subfolder in the
user's Documents or MyDocuments folder. See Saving and Restoring Settings for more
information.
Auto Repair
This internal function automatically repairs any paths found in Solfire9.ini. This process
runs every time Solar Fire starts up so that it can automatically check and repair any
Solar Fire User Files or Solar Fire system paths that are stored as text in the Solfire9.ini
file. This function allows a user, who currently has Solar Fire v7.x or later installed, to
upgrade to and install a newer Solar Fire version without needing to uninstall the earlier
Solar Fire version. Once this new version is run, it now automatically "connects" the Solar
Fire User Files from the older version to the newer version.
Additionally, if any paths or filenames get corrupted during any Solar Fire session, these
paths and/or filenames will be automatically repaired at the next startup of Solar Fire.
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When checking the "SavedImagePath" key in the Solfire9.ini file Solar Fire checks that
the folder exists and also if the computer is Windows Vista (or later) that the folder is
not a "system" folder, such as C:\Windows or C:\Program Files. If it is a "system" folder
for this Windows version then the path is changed to that of the Solar Fire User Files.
If for some reason, the auto repair feature is required to be turned off then a key
"BypassINIRepair" located in the [Solar Fire] section of Solfire9.ini, can be changed from
1 to 2 (after the newer version has been run for the first time) and once this change is
saved, no further checking or repairing of the INI file will take place.
Auto Recover
This internal function allows Solar Fire to recover if certain common files get deleted.
Common files are files that are stored in an area on a computer for access by not just
one application, but by many applications.
This situation can occur if you already have Solar Fire v7.0.x (or later) installed, upgrade
and install a later version of Solar Fire and then decide to uninstall the earlier version.
During the uninstall of that earlier version, certain common files to the two versions may
be deleted and that situation can potentially give rise to errors at the next startup. With
Auto Recover, Solar Fire will now automatically restore the common files that were
deleted.
11.2.2 Astronomy/Astrology
This section contains technical information about the astronomical and astrological
aspects of Solar Fire.
11.2.2.1 Calculation Methods

This topic outlines the calculation methods that Solar Fire uses.
11.2.2.1.1 Planets and Chart Points

All planetary positions are calculated using the Swiss Ephemeris™, which “is at least as
accurate as the Astronomical Almanac, the standard planetary and lunar tables
astronomers refer to.”
The core part of Swiss Ephemeris is a compression of the JPL-Ephemeris DE406, plus an
extension of the time range to 10,800 years, from 2 Jan 5401 BC to 31 Dec 5399. As a
guide, the accuracy of the standard planets around the current era is estimated to be as
shown in the following table.
Dates
1980 – 2000
1600 – 1980
2000 – 2160
1600 – 1900
1900 – 1980
1910 – 1980
2000 – 2010
1750 – 2169

Planets
all planets
Sun – Jupiter

Accuracy
< 0.01”
a few 0.1”

Saturn – Neptune
Saturn – Neptune
Pluto

a few ”
a few 0.1”
< 1”

Moon

a few ”
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For a more detailed explanation of how the accuracy is estimated, see the Swiss
Ephemeris website at www.astro.ch/swisseph/.
When Solar Fire calculates heliocentric positions, they are true dynamical positions, and
have no corrections applied. Their geocentric positions are corrected for nutation and
light time delay, and therefore correspond closely to the positions published in the "The
American Ephemeris" (ACS), for example.
11.2.2.1.1.1 Asteroids

The asteroid positions in Solar Fire are calculated from ephemeris files. The main
asteroids (Ceres, Pallas, Juno, Vesta) are available for the full range of the Swiss
Ephemeris (2 Jan 5401 BC to 31 Dec 5399). The likely accuracy is a few arc seconds in
1600 AD and a few arc minutes in 3000 BC.
11.2.2.1.1.2 Chiron

As a result of close encounters with Saturn in Sept. 720 AD and in 4606 AD, Chiron’s orbit
beyond this time range is uncertain. Chiron’s position is therefore reliable only for the
time between 700 AD and 4650 AD.
11.2.2.1.1.3 Hypothetical and Experimental Planets

The planet Vulcan, the Transneptunian planets and TransPluto are not officially
discovered planets, but are important in esoteric and Uranian astrology. They should be
treated as experimental. Their true accuracy is therefore unascertainable at this time.
However, efforts have been made to ensure that their calculated positions agree with
the orbits that have been proposed and are in general use for these bodies.
The Lilith used in Solar Fire is the one popular in Europe, and it is also called the Black
Moon. This is not actually a hypothetical planet, but rather the geocentric position of the
empty focus of the moon’s orbital ellipse (the earth being at the other focus). Solar Fire
gives the Black Moon’s mean position.
Selena, also know as the White Moon is also popular in Europe. It has a perfectly circular
hypothetical orbit.
11.2.2.1.1.4 House Cusps and Chart Angles

The house cusps, and chart angles (Ascendant, Midheaven, Equatorial Ascendant,
Vertex, CoAscendant, Polar Ascendant and their opposite points) are accurate for all
dates limited only by the uncertainty of changes in the earth’s rotation rate (sometimes
called DeltaT). Solar Fire uses the best available Swiss Ephemeris calculations to
determine these changes. However, there is still an inherent uncertainty of about 15
minutes of time around 1500 BC, and possibly several hours around 3000 BC.
11.2.2.1.1.5 Typical Speeds

For the purposes of determining factors relating to planetary speed, the following
methods are used to determine their typical speeds...
The Moon - speed based on a lunar orbital period of 27.321586481 days
The Sun, Earth, Vulcan, Mercury Venus - speed based on a solar orbital period of
365.24219907 days
The North and South Nodes - speed based on a nodal orbital period of 18.6 years
The Chart Angles - Earth's rate of diurnal rotation (360.98564736 deg/day)
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Black Moon Lilith - speed based on an orbital period of 3231.45 days
White Moon Selena - speed based on an orbital period of 2556.75 days
All Other Planets - their current heliocentric orbital speed
These typical speeds are used to determine whether planets are
Slow - if speed is less than typical
Fast - if speed is greater than or equal to typical
Stationary - if speed is below the percentage value specified by the user in relation
to the typical speed (but only if this stationary option has been selected).
11.2.2.1.2 Progressed Charts

Mean Progressions
A progressed chart for a particular date is calculated by determining the time elapsed
since the birth or event chart, and applying a progression rate to the elapsed time to get
a progressed elapsed time, and then adding that progressed elapsed time to the birth or
event chart date. For example, secondary progressions are based on a correspondence of
one year to one day. Therefore a progressed chart for a time and date 32.745 years after
the birth time and date is calculated as a natal chart would be for a time and date
32.745 days after the birth time and date.
Once the planetary positions are determined in this manner, the progressed Midheaven
is calculated according to the currently selected method of angles progression, and then
the other chart angles are derived from the Midheaven according to the chart’s location.
True Progressions
Instead of using a progression rate determined from mean periods, it is possible to base
the progression calculation upon true (fluctuating) periods. This is of practical use with
progression rates that are based on the moon’s cycles, because the moon’s cycles do
fluctuate significantly with time. Solar Fire offers this option in relation to the tertiary
progressions of fixed charts (but not in the dynamic module). In this case one is
assuming that each true lunar cycle corresponds to one day in the progressed chart, so
the calculation involves finding the exact times of the lunar returns before and after the
target date, and interpolating between these to find the exact fractional lunar cycle to
add to the number of completed lunar cycles at the target date. The resulting number of
lunar cycles is the number of days by which to progress the chart.
11.2.2.1.3 Directed Charts

Zodiacal Directions
A chart is directed by adding a fixed arc to every point in the chart, including the chart
angles. Therefore a directed chart maintains the same aspects as the chart upon which it
is based, but different zodiacal positions. In Solar Fire, the fixed arc that is applied is
determined by the arc of the secondary progressed Sun’s longitude, or by the arc of the
derived Ascendant or Vertex once the Midheaven has been progressed by the same
longitude as the secondary progressed Sun. Which of these methods is used depends on
which method of directions is currently selected for the chart or dynamic report.
Primary Mundane Directions
Primary directions are created by the diurnal rotation of the earth about its own polar
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axis. Hence each planet or chart angle is directed along its own diurnal arc, starting from
its natal position. Each degree of rotation is deemed to correspond to 1 year in the life of
the individual. Aspects are deemed to be formed between directed and natal planets
when their relative positions in their diurnal arcs are in angular relationship. (Note that
this is quite different from aspects of zodiacal longitude.). For example, if the Sun is
natally situated in the 10th house at 90% along its arc from its rise to its culmination,
then Saturn will be in natal mundane square to it when it is directed to a position in the
1st house which is at 90% along its arc from its nadir to its rise across the horizon. If this
occurs after Saturn has been directed by 24.5 degrees along its diurnal arc, then it is
deemed that directed Saturn makes a mundane square to the Sun when the individual is
24 and a half years old.
This method is also known as "Placidian" directions as apparently practiced by Ptolemy,
Alcabitius, Montulmo, Lucas Gauricus, Simmonite, Zadkiel, Alan Leo, Pracht, Kloekler and
Placidus himself.
Van Dam Primary Directions
This method has also been called “Primary Event Analysis”. This is a variation of the
Primary Mundane (Placidian) method, using a different time-measure, as introduced by
Wim van Dam. The derived positions are given in zodiacal longitude (unlike primary
mundane directions, which are expressed in term of a pseudo-arc).
11.2.2.1.3.1 References

A Primer of Calculation - Bob Makransky
Astrology’s Old Master Technique - Martin Gansten
Primary Directions I, II, and III - Rumen Kolev
Bernadette Brady
11.2.2.1.4 Return Charts

Chart Point Returns
A return chart is calculated for the exact date and time that a chart point returns to its
longitude in the base chart. If the base chart uses the tropical zodiac, then the return is
to the same point in the tropical zodiac (unless it is precession corrected). If it is sidereal
then the return is to the same point in the sidereal zodiac. The program iterates in time
to find the correct date and time of the return. For planets other than the Sun, Moon and
Earth, an approximation to the time of the return is found initially by doing a heliocentric
return. (For Mercury, Venus and Vulcan, an Earth return is used.) A search is then made
for geocentric returns on either side of the heliocentric return date, until the date or
angle exceeds the possible limits for finding further geocentric returns.
In the calculation of returns, the accuracy of the return time is calculated by dividing the
accuracy of the planet's position by the speed of the planet at the time of the return,
both for the natal chart and for the return chart, and these are added together. This
method gives a reasonable assessment of accuracy in most cases. However, the
accuracy of Pluto returns outside the range 1890-2099 is likely to be much worse than is
indicated by this method.
Wynn-Key Return
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This chart is calculated with the planetary positions for the date for which the Wynn-Key
chart is required, but the chart angles are based on the preceding and following Solar
return chart angles. The R.A. of the midheaven is determined by interpolating between
the R.A.s of the two Solar Returns (which are typically about 6 hours apart), based on the
proportion of time that has elapsed between them at the required date.
Progressed Solar Return
This chart uses planetary positions determined by a performing a secondary progression
of the planets in the preceding Solar Return, to the date of the required return chart.
However the chart angles are determined by interpolating between the R.A.s of the
Midheavens of the preceding and following solar returns. The progressed R.A.of the
midheaven is deemed to move through an entire rotation in addition to the exact
difference between the two R.A.s of the returns (i.e. about 30 hours altogether). The R.A.
of the resulting chart is based on the proportion of time that has elapsed between the
two returns at the required date. This return type is also known as a Progressed SolarSidereal Return (or PSSR) chart.
11.2.2.1.5 Harmonic Charts

An harmonic chart is calculated by multiplying the longitude of each base chart point and
angle by the harmonic number, and then reducing the resultant numbers to the range 0
to 360. The house system in the resulting chart is based on the position of the harmonic
ascendant.
11.2.2.1.6 Antiscia and Contra-Antiscia Charts

These charts are calculated by taking the "mirror image" of each planet and asteroid
about an axis of longitude. There are two methods of calculating such charts in this
program.
Antiscia - 0 Degrees Capricorn
The axis about which the mirror image is taken is 0 degrees of Capricorn and Cancer.
Points in a natal chart which are tightly conjunct or opposite points in its antiscia chart
are thought to be points of personal self-fulfillment (i.e. indicators of in what areas the
individual is self sufficient and does not require a relationship in order to be fulfilled.)
Contra-Antiscia - 0 Degrees Aries
The axis about which the mirror image is taken is 0 degrees of Aries and Libra.
Points in a natal chart which are tightly conjunct or opposite points in its contrascia chart
are thought to be points of public self-fulfillment (i.e. indicators of fame).
11.2.2.1.7 Longitude Equivalent of Declination Charts

The longitude equivalent of each chart point is derived from its declination. The
derivation is based on converting a declination to its corresponding longitude on line of
the ecliptic.
Declination
00N00
23N26
23S26

Longitude Equivalents
00Ar00; 00Li00
00Cn00
00Cp00
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Declination

Longitude Equivalents

11N28
11S28
20N08
20S08

00Ta00; 00Pi00
00Sc00; 00Vi00
00Ge00; 00Aq00
00Sg00 ; 00Le00

Generally, each declination has two possible longitude equivalents, and in the standard
method, the one used is that which falls into the same zodiacal quadrant as the original
longitude of the point. The alternative longitude equivalent point is always the antiscia
point (i.e. reflection in the 00Cn00/00Cp00 axis) of the standard one.
A special provision applies if a point’s declination is out-of-bounds (i.e. beyond the
maximum declination of the ecliptic, which is about 23 degrees and 26 minutes). In such
cases, the declination is first adjusted by “mirroring” it about the maximum point. This is
effected by subtracting the excess declination from its maximum value. For example, a
point at 25N00 has an excess of 1°34’, so its adjusted declination is 23N26 - 1°34’, which
equals 21N52.
11.2.2.1.8 Arc Transform Charts

The arc transform chart is simply an harmonic chart whose harmonic number is
determined by the arc between the two selected planets or chart points, as follows.
1. Arc = Longitude of 2nd Planet - Longitude of 1st Planet
2. If Arc is -ve then change it’s sign to +ve
3. Harmonic = 360 / Arc
Note: If the Arc is less than about 1 second of arc, then the harmonic would be
unacceptably high, resulting in an meaningless chart. Hence, to avoid problems in this
case, the harmonic is set to 1.
11.2.2.1.9 Combined Charts

A combined chart is calculated by taking an "average" of two or more base charts, to
produce a single representative chart. There are five methods for calculating combined
charts in this program.
Composite - Midpoints
The midpoint of the shortest arc joining each chart point, angle and house cusp within
the two base charts becomes the position of that point in the new chart. Note that it is
sometimes possible for the house cusps to be out of expected order after this method is
applied. See Composite Chart Houses.
When calculating any type of composite charts, Solar Fire first determines the composite
longitudes, and then determines the composite right ascensions separately. Thus any
right ascensions for a composite chart in Solar Fire are true composite right ascensions
rather than right ascensions of composite longitudes.
Composite - Derived Ascendant
The midpoint of the shortest arc joining each planet, asteroid and the Midheaven within
the two base charts becomes the position of that point in the new chart. The chart
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angles and house cusps are then derived from the Midheaven according the new chart's
latitude.
Composite Group - Derived Ascendant
The average position of each planet, asteroid and the Midheaven along the shortest arc
joining them within each of the base charts becomes the position of that point in the
new chart. The chart angles and house cusps are then derived from the Midheaven
according the new chart's latitude. Robert Hand describes this method in detail in his
book "Planets in Composite".
Relationship - Davison
The new chart is calculated as if it was a natal chart for the midpoint in time, latitude
and longitude of the two base charts.
Coalescent
This is a method which was developed fairly recently by Lawrence Grinnell and David
Dukelow, and is published in a booklet “Coalescent Horoscopes - A New Method of
Synastry” published by ACS Publications in 1992. To determine each planet’s coalescent
position, first find the shortest arc between the pair of planets in the two base charts
and divide this by 360 degrees to get the harmonic factor. Next, multiply the position of
the planet which has the earliest zodiacal position by the harmonic factor. This must be
repeated for each pair of planets and for the Midheavens. The authors of this technique
recommend using the Meridian house system to derive the coalescent house cusps from
the coalescent Midheaven.
11.2.2.1.10 Locality Charts

Geodetic
The planetary positions are calculated as for an ordinary natal chart. However, the
angles of the chart are determined solely by the location of the chart, and are not
influenced by its date or time.
Using the Longitude method, the longitude of the Midheaven is determined as the
longitude of the Sun minus the longitude of the chart. (East is -ve.)
Using the R.A. method, the R.A. of the Midheaven is determined as the R.A. of the Sun
minus the longitude of the chart.
The ascendant and other chart angles are then derived according to the chart’s latitude.
If a user-defined geodetic offset is being used, then this offset is added to the position
of the Sun (either it’s longitude or its R.A., as appropriate).
Johndro
This chart type is very similar in principle to the Geodetic chart type, except that a
precessionary factor is added to the position of the Sun. This factor was 29 10’ of R.A. in
1930, and increases with time at the rate of precession of the equinoxes (about 46.1
seconds of arc per year). Using the longitude method, the precession in R.A. is converted
to an equivalent precession in longitude before it is added to the longitude of the Sun.
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11.2.2.1.11 Prenatal Charts

Although most astrologers place much emphasis upon the chart of the time of physical
birth of an individual, there is also a school of thought that says that the physical birth is
not the only time for which a useful chart can be cast.
In esoteric thinking it is suggested that the incarnation of a human being starts on the
spiritual plane, descends to the mental plane, then the astral/emotional plane, and
finally to the physical plane when birth takes place. If charts can be determined for the
times at which incarnation onto the mental and astral/emotional planes occurred, then
they would provide astrologers with insight into the mental and emotional aspects of the
individual, and thus provide a fuller picture of how the individual functions at different
levels, and how interactions between these levels occur.
The earliest known reference to prenatal charts is in the “Tritune Hermitas”, which
states that the chart of conception (which is usually about nine months prior to birth) has
positions of the Moon and Ascendant that are interchanged from those of the natal
chart.
The concept of prenatal charts has been adopted and developed by several astrologers
in more recent times, such as Sepharial, Johndro, Charles Jayne, E.H. Bailey and Gustav
Schwickert and as a result there are now a number of other prenatal chart types that
have been proposed. For example, in addition to the time of conception (fertilization of
the egg), the time of quickening or animation (first independent movement by the fetus)
is also thought to be especially important. Two of the aforementioned eminent
astrologers (Charles Jayne and E.H.Bailey) who undertook a lifetime study of prenatal
charts, seem to concur from their independent research that these charts reflect mental
(thinking) and emotional (feeling) aspects of an individual, respectively, as distinct from
the birth chart itself which reflects outer physical events and sensations.
11.2.2.1.11.1 Baileys Prenatal Charts

E.H.Bailey worked mainly with just these two types of prenatal charts, as well as with
charts of descent, which are charts of monthly lunar returns during the gestation period.
Solar Fire includes four types of charts based on his methods, listed below.
Bailey’s Prenatal Charts
Prenatal Epoch of

Abb

Prenatal Interval

Chart Inter-Relationship Lunar Phase

Luminary /Angle

Conception

C

10 lunar months

¶ Syz B ASC

-

ASC Syz B ¶

Quickening

Q

5 lunar months

¶ Cnj B ¶
ASC Cnj B ASC

-

-

Birth (C)

B

0

¶ Syz C ASC

-

ASC Syz C ¶

Birth (Q)

B

0

¶ Cnj Q ¶
ASC Cnj Q ASC

-

-

Syz=Syzygy (i.e. Conjunct or Opposite); Cnj=Conjunct; Opp=Opposite; ASC=Ascendant
Bailey’s conception chart is based closely on the simple method described in ancient
times of swapping the birth Moon and Ascendant positions, although he allows syzygies
as well as direct swapping. (Thus the conception Moon may be on either the birth
Ascendant or Descendant, and the conception Ascendant can be on either the birth
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Moon or its opposite point.) He also uses a method of sex determination based on a
Hindu division of the zodiac into male and female divisions. This method is based on the
assumption that the conception chart must confirm the sex of the individual. Therefore,
Solar Fire allows you to specify whether the individual for whom you are casting a
conception chart is male or female, and Solar Fire then automatically eliminates those
possible conception times that would give the wrong sex. Solar Fire also allows you to
alter the prenatal interval used. For example, if you know that the individual was born a
few weeks premature, then you could choose to base the calculation on 9 lunar cycles
instead of the usual 10. As with many of the other types of prenatal charts, Solar Fire
offers you a choice of all the prenatal charts that fit the given criteria. In the case of
conception charts, there are potentially up to 4 possible charts per month, so you may
find that Solar Fire offers up to 8 different possibilities. Solar Fire makes a
recommendation of which chart to use by highlighting that chart on the list. However, it
is up to you to choose which one best fits the requirements. Solar Fire makes its
recommendation based on Bailey’s method, which involves looking at i) the order of the
natal chart, and ii) the rectified birth time.
The natal lunar phase and position indicate the order of the natal chart. If the moon is
above the horizon and waxing then it is a first order chart, or if waning then it is a
second order chart. If the moon is below the horizon and waxing then it is a third order
chart, or if waning then it is a fourth order chart. Bailey recommends that if the natal
chart is of the first or fourth order, then you should look for a shorter gestation than
average, and if it is of the second or third order, then you should look for a longer
gestation than usual.
Bailey recommends that you use a chart which confirms the birth time as closely as
possible by his rectification method, which involves determining what the birth time
would be if the proposed conception chart were used to re-derive the natal chart. To this
end, Solar Fire indicates this “rectified” birth time for each possible conception chart.
Solar Fire finds the chart that most closely matches these criteria. If you have any
knowledge of the actual term of gestation, ten you may wish to alter the choice of chart
to one that more closely matches the known period of gestation.
After generating any prenatal chart, use rectification and predictive techniques to
confirm whether or not the chart you have is valid.
Bailey’s quickening chart is based on the 5th converse lunar return from the birth chart.
The time at which the Ascendant returns exactly to its natal position on this day is the
time for the quickening chart. Thus, the Moon’s position is usually a few degrees away
from its natal position in this chart. Solar Fire also allows you to experiment with the
number of lunar cycles used in this chart. This calculation offers only one possible chart
for the required number of lunar cycles, so no further choice needs to be made.
The Bailey Birth charts (C) and (Q) are included to allow you to reverse the calculation,
and derive a birth chart from a conception (C) or quickening (Q) chart. For example, if
you have a possible conception date and time, then you can use this to create a normal
natal type chart by entering this date and time in Solar Fire’s New option in the Charts
menu, and then use this as your base chart for the calculation of a Bailey Birth (C) chart.
The resulting chart is then a predicted birth chart, based on the given conception time. In
this case Solar Fire also indicates whether the base chart shows that a male of female
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would be born, before calculating the chart. A similar procedure can be used if you have
a possible time for the quickening of a pregnancy. You can create a normal natal type
chart by entering this date and time in Solar Fire’s New option in the Charts menu, and
then use this as your base chart for the calculation of a Bailey Birth (Q) chart. The
resulting chart is then a predicted birth chart, based on the given quickening time.
11.2.2.1.11.2 Jaynes Prenatal Charts

According to Charles Jayne, there are 16 significant times (or prenatal epochs) prior to
birth for which charts may be cast. There are 16 epochs because there is one prenatal
epoch for each planet (10 known and 6 hypothetical). Jayne has developed an extensive
and comprehensive philosophical basis for these charts, and discusses them in depth in
several of his papers and books.
Jayne’s Hypothetical Planets
Vulcan

period 25 days

Rex

period 40 months (focussed in the asteroid belt)

Sigma

period 13.93 yrs

Isis

period 384 yrs sidereal

Morya

period 640 yrs sidereal

Lion

period 1610 yrs sidereal

Jayne also postulated that, following the birth chart, there are another 32 charts that
may be cast for an individual (2 for each planet), and these are known as post-natal
epochs. Thus the total number of charts for an individual is 49 in total. These charts are
somewhat more complex to calculate than the prenatal charts, and have not been
included in Solar Fire. However, all 16 prenatal epoch charts have been included. These
are listed below.
Jayne’s Prenatal Charts
Prenatal Epoch of

Abbr

Prenatal
Interval

Chart InterRelationship

Lunar Phase

Luminary /Angle

Chiron

Y

Sigma

S

13.2 yrs

Independent

¶Trine ¸ (¶in 5th)

Sunrise

9 yrs

¸ Cnj C ASC

NM applying

Jupiter

Sunset

Z

8 yrs

¸ Opp F MC

NM or FM separating

¶ Cnj MC

Rex

H

7 yrs

¸ Opp C MC

NM applying

Noon

Venus

R

6 yrs

¸ Opp T ASC

NM or FM separating

Moonset

Mercury

W

5 yrs

¸ Opp B MC

NM or FM separating

Noon

Vulcan

G

4 yrs

¶ Syz B ASC

NM or FM separating

Sunset

Sun

O

22.3 mths

Independent

FM applying/separating

Noon

Moon

Q

15.7 mths

Independent

FM applying/separating

Moonrise

Lion

U

11 mths

¶ Syz B Vtx

-

Sunrise

Uranus

C

9 mths

¶ Syz B ASC

-

ASC Syz B¶

Isis

I

7.5 mths

¶ Syz B MC

-

Midnight

Pluto

T

6.5 mths

Independent

QM applying

¶ Syz MC

Neptune

A

5 mths

¶ Syz C MC

-

Midnight

Morya

F

3 mths

Independent

QM applying

¶ Syz ASC

Mars

E

2 mths

¶ Syz C Vtx

-

Sunrise

Saturn

B

0

¶ Syz C ASC

-

ASC Syz C¶
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NM=New Moon; FM=Full Moon; QM=Quarter Moon; Syz=Syzygy (i.e. Conjunct or
Opposite); Cnj=Conjunct; Opp=Opposite; ASC=Ascendant; MC=Midheaven; Vtx=Vertex
Calculation Procedure for Jaynes Prenatal Charts
1. A starting date is derived by applying the Prenatal Interval, as tabulated above.
2. If the Chart Inter-relationship involves the sun, then two times are derived by moving
forward and backward from the starting date to satisfy the inter-relationship. This
results in two starting times that will be one year apart.
3. If there is a Lunar Phase to be satisfied, then further times are derived by moving
forward and backward from the starting times produced in previous steps, in order to
satisfy these phase requirements. This will produce times that are one lunar month
(27.3 days) apart if there is a single lunar phase (such as QM applying), or half a lunar
month if there are two possible phases (such as NM or FM separating). This results in
twice as many starting times as there were before this step.
4. Each starting time is moved forward and backward until the luminary/angle
relationship is satisfied. This results in twice as many starting times as there were
before this step.
As a result of these steps, Solar Fire may offer the user up to 8 possible time/date
combinations for prenatal chart. It is up to you to choose which one best fits the
requirements. Solar Fire indicates how far the charts had to be adjusted to match their
starting date and times. The following example shows the choices that Solar Fire offers
when calculating a Jayne Mercury prenatal chart. The first number on each line is the
deviation from the given prenatal interval. Because this prenatal chart involves matching
the position of the Sun with the natal IC, we end up with two groups of possible charts one between 193 and 178 days later, and one between 172 and 187 days earlier than the
given prenatal interval (Step 2). Within each of these groups we have 4 further
possibilities, based on the Moon being either new or full, and the time moving either
forwards or backwards to be conjunct the Midheaven (i.e. local noon). The second item
on each line is how many degrees the moon is away from exactly satisfying the required
phase.
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For example, the first suggested chart above occurs 193.2 days later than the average
prenatal chart of this type, and has a lunar position that is 12.4 degrees away from being
either a full or new Moon. Of the visible options, the fourth item (-178.2 Days / -0.8
Degs) would appear to give the overall closest match. However, Jayne suggests that the
chart which most closely matches the given prenatal interval or lunar phase is not
necessarily the correct chart. Therefore, he recommends that you calculate ALL of the
possible charts, and then use your own judgment, as well as rectification and predictive
techniques to confirm whether or not each individual possible chart is the valid one. In
particular Jayne used directions of longitude of Solar Arc, Ascendant Arc and Vertex Arc,
both direct and converse to confirm timing of events. He also directed the declination by
each of these arc methods, and used parallels and contra-parallels of declination in
timing of events.
Jayne’s conception chart, Uranus (C), is similar to Bailey’s except that the sex of the
individual is ignored. The possible conception charts offered by this option are the same
as those offered by Bailey’s conception chart if the male and female options were
combined. Another difference, however, is that Jayne’s method does not lend itself to
allowing a different term of pregnancy to be specified. Instead, Jayne hypothesized that
short term births occurred at other prenatal epochs, such as the Morya F or Mars E
epochs.
Jayne’s quickening chart, Neptune A, differs more markedly from Bailey’s. Whereas
Bailey’s method involves replicating the position of the natal Moon and Ascendant as
closely as possible, Jayne’s method involves finding a syzygy between the Moon and the
conception Midheaven, and then adjusting the time to give a midnight (Sun on the IC)
chart.
Jayne’s birth chart (C) may be used to predict possible birth dates and times based on a
natal type chart which has been calculated for the proposed time of conception.
However, unlike Bailey, Jayne believes 1) that the true conception chart does not
necessarily occur at the time of physical conception, and 2) that the luminary/angle
relationship of the chart does not need to be exact. Therefore this method would not be
able to predict an accurate birth time. However, this chart calculation method is included
in Solar Fire for completeness and to allow experimentation.
A number of other charts in this list require another prenatal chart to have been
calculated before they can be used. The list below summarizes which prenatal charts are
based on other prenatal charts.
Epoch
Sigma S
Jupiter Z
Rex H
Venus R
Neptune A
Mars E
Saturn B
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For example, to calculate a Neptune chart, you must first calculate a Uranus chart, and
then use that as the base chart for the calculation of the Neptune chart.
Jaynes Law of Sex
Solar Fire does not apply any adjustments to account for the sex of the individual whose
prenatal charts are being cast. However, Jayne does suggest applying small adjustments
to the position of the Moon or Sun in relation to the chart’s angles, depending on which
of these two is used in the Luminary/Angle calculation of the chart in question.
“Lunar charts taking place at moonrise or moonset have the Moon about half a degree
below the Ascendant or about half a degree above the Ascendant for women, whereas
for men the Moons are slightly cadent instead of slightly angular, i.e. are about half a
degree on the other side of the horizon. Of course this is before rectification. In lunar
charts with the Moon on the MC or IC there is no known law as to which side of the
meridian they must fall. In solar charts for men, occurring at noon or sunrise, the Sun is
slightly angular, i.e. is in the 10th or 1st houses, but is slightly cadent for women. If a
solar chart occurs at midnight or sunset for men the Sun is slightly cadent, but for women
is somewhat angular. Specifically in female midnight charts (such as A and I) the Sun is 3
degrees inside the fourth house. It is not known how the law of sex works in the charts of
homosexuals.”
For example, when casting a Jayne Mercury prenatal chart, the luminary/angle
calculation is “noon”, meaning that the Sun is on the Midheaven. Therefore this is a
solar chart, so the time of the chart should be adjusted slightly to cause the Sun to move
into the 10th house for a man, or into the 9th house for a woman. Adjusting the time by
about 2 minutes will effect a change of about half a degree in the Midheaven. This can
be done most easily by viewing the chart and then using Solar Fire’s Rectify button
which allows the chart time and angles to be easily changed.
11.2.2.1.11.3 Interpreting Prenatal Charts

As prenatal charts have only been used by few western astrologers until now, there is a
lack of published material explaining how to use them in a practical way. This situation
may change in the future, but for the time being the reader is referred initially to the
original authors of the techniques used for an explanation of how to interpret and use
them. In particular, refer to E.H.Bailey for directions on how to use Bailey Conception
and Bailey Quickening charts, and to Charles Jayne for directions on how to use the
various Jayne prenatal charts.
The conception and quickening charts of Bailey and Jayne have also received some
coverage in astrological journals and publications, but Malvin Artley, an American
astrologer and esotericist, is currently (early 1995) writing a manuscript which will give a
comprehensive explanation of the meaning and use of conception and quickening charts
in relation to their esoteric associations with the mental and astral/emotional aspects of
man. He has already published an article in the FAA journal (see references) which gives
examples of the ways in which these charts work. It is as a result of his work and
inspiration that these prenatal charts have been included in Solar Fire.
Artley suggests several ways in which the conception, quickening and birth charts can be
interpreted, using the correspondence of conception chart to a mental chart, and of
quickening chart to an astral/emotional chart. He recommends working with the these
© 2014 Esoteric Technologies Pty Ltd

482

Solar Fire 9 User Guide

two charts in addition to the birth chart in order to get a complete picture of an
individual’s physical, emotional and mental make-up.
Firstly one can look at the sign placements of the Suns in each of these three charts, for
example the birth chart may have a Capricorn Sun, the astral chart a Leo Sun, and the
mental chart an Aries Sun. Whilst this person would displays the traditional Capricornian
traits, they are also likely to be somewhat generous and attention-seeking emotionally,
and rather impetuous and quick-thinking mentally.
Further, one can look at each of the three charts to find which one has the most difficult
aspects, and this would indicate the level (physical, emotional or mental) on which that
individual had the most work to do in their lifetime. For example, individuals with
relatively “easy” aspects in their mental chart may have much more stressful aspects in
their emotional chart, indicating that whilst they may be intellectually talented, they
have greater difficulty in coping with emotions.
Artley also suggests a technique of interpretation based on displaying the conception,
quickening and birth charts in a triwheel, with the conception chart innermost and the
birth chart outermost. In this way one can examine the positions of the key planets, such
as the Sun, in each chart in relation to the houses of the conception chart. Using the
correspondence of conception to mental and of quickening to astral, this defines the
flow of energy from the mental, to the astral, to the physical plane. For example if the
mental Sun is in the 6th house, the astral Sun is in the 11th house, and the physical Sun
is in the 3rd house, then that is the major path for descent of psychic energy - from the
6th to the 11th to the 3rd, and thus the major house of outer life expression is the 3rd.
Finally, Artley has investigated methods of determining which of the 7 rays (as defined in
esoteric teachings, such as those of A.A.Bailey) are most strongly represented in each of
the charts, thus arriving at a ray profile for the individual. This may be of particular
interest to esoteric astrologers.
The table below is a summary of keywords that have been used to describe some of the
charts and what they signify, by their authors. These are brief, but never-the-less will
probably give sufficient hints for an experienced astrologer to begin experimenting with
them.
Chart Type
Bailey Birth (C)
Bailey Birth (Q)
Jayne Birth (C)
Bailey Conception
Bailey Quickening
Jayne Vulcan
Jayne Uranus (C)
Jayne Sigma
Jayne Isis
Jayne Mercury
Jayne Neptune (A)
Jayne Rex
Jayne Lion
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Keywords / Meaning
Birth - Physical events, sensation, outer security

(Mental) Thinking, conceiving
(Astral/Emotional) Feeling & emotion
Isolation, will & persistence
(Mental) Thinking, conceiving, individuality
Endings & accomplishments, karma
Inspiration - Fiery feeling of the Heart, yearning, aspiration
(Astral/Emotional) Feeling & emotion, sentimentality
Intuitiveness, elusiveness, nurture
Understanding - Education & civilisation, synthesis and integration

Reference Information

Chart Type

Keywords / Meaning

Jayne Mars
Jayne Morya
Jayne Pluto
Jayne Moon
Jayne Sun
Jayne Chiron
Jayne Venus
Jayne Jupiter

Ego - Instinct & Intuition
Fate - What one has to endure, accept and transmute in life
Ties - What binds one and holds one back
Mother, the body
-
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Note that although no specific meaning was given by Jayne to the Sun, Mercury, Venus,
Jupiter and Chiron epoch charts in the references below, he named his charts to reflect
the energy of the planet that they are named after. Hence one could interpret the Sun
chart as relating to identity and vitality, and the Venus chart as relating to relationships
with women and acquisitions, for example.
11.2.2.1.11.4 References

ARTLEY, MALVIN 1994 Shining an Esoteric Light on Prenatal Charts Federation of
Australian Astrologers Journal Vol 24, No. 2, June 1994
BAILEY E.H. 1916 The Prenatal Epoch Samuel Wieser, NY, USA
GUNZBURG, DARRELYN 1990 Converse Astrology and the Prenatal Epoch Under
Capricorn, Federation of Australian Astrologers Board of Examiners
JAYNE, CHARLES 1975 The Preface to Prenatal Charts Astrological Bureau, Monroe, NY
USA
JAYNE, CHARLES 1985 A Primer of Prenatal and Postnatal Charts Astrological Research
Associates, NY USA
SCHWICKERT, GUSTAV 1954 Rectification of the Birthtime American Federation of
Astrologers, Arizona USA
11.2.2.1.12 Chart Hylegs

Solar Fire calculates chart Hylegs in one of its reports as well as in a page object. The
Hyleg is a planet, or a position in the chart, which is representative of the life and vitality
of the native. Unfortunately there is currently no universal consensus on precisely how
the Hyleg should be determined, even though the general principles are not disputed.
Various astrological authors have written on the matter, and we have attempted to
incorporate our best understanding of some of these by creating a set of algorithms for
their calculation. These are as follows...
Bonatti/Lehman - Based on J. Lee Lehman (et al)’s derivation of Bonatti, as
described in “Medieval Methods of Longevity Measurement: A Pilot Study” The
Astrological Journal Volume 42, No. 1, Jan/Feb 2000, p60.
Omar/Bonatti - Based on Omar's method as described in "Three Books on
Nativities" by Omar of Tiberius, Translated by Robert Hand, Project Hindsight, Latin
Track, Volume XIV. This method was also described by Bonatti as translated in
“Tools & Techniques of the Medieval Astrologers” by Robert Zoller.
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Ptolemy - Based on Ptolemy's method as described in p39-41 "Night & Day Planetary Sect in Astrology" by Robert S. Hand - ARHAT Monograph #1
These methods use data settings stored in two required files – HYLEG.ALM and
HYLEG.ASP. Certain details of these calculations may be altered by the user by editing
HYLEG.ALM in Solar Fire’s main program files folder with the Dignity/Almuten editor, or
by editing HYLEG.ASP in Solar Fire’s aspect set editor.
11.2.2.1.12.1 Bonatti/Lehman

This hyleg calculation uses rulerships and all other options specified in the 1s t definition
in the HYLEG.ALM file - these may be edited by the user, but by default these are as
follows:
Traditional rulerships
Dorothean Triplicities
Egyptian Terms
Signs start at 0 degrees
Default houses
8,5,3 degree house cusp offsets (for angular, succedant, cadent houses)
Different Day/Night Part of Fortune
5 points for rulerships
4 points for exaltations
3 points for (each of the three) triplicity rulers
2 points for term ruler
0 point for face ruler (i.e. face will not be used in this calculation)
No points for any other items
Degree Dignities
Applies to both Diurnal and Nocturnal charts
1. Check if Sun is in 1st, 10th or 11th houses (apply house cusp offsets specified in
HYLEG.ALM). If so, then the Sun is the Hyleg. If not, then go to the next step.
2. Check if Sun is in 7th, 8th or 9th house, and is also in a masculine sign. If so, then
the Sun is the Hyleg. If not, then go to the next step.
3. Check if Moon is in a feminine sign and not in a cadent house. If so, then the Moon
is the Hyleg. If not, then go to the next step.
4. Check if chart is conjunctional (i.e. Moon is waxing). If so, then check if any of the
5 rulers of the Ascendant's position are forming an aspect to the Ascendant. Check
each of the following rulers which have a non-zero score in HYLEG.ALM: Domicile
ruler, Exaltation, Triplicity in Sect, Triplicity out of Sect, Triplicity participating,
Term, Face. If any one or more make an aspect (according to aspects and orbs
specified within HYLEG.ASP), then the Ascendant is the Hyleg. If not, go to next
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step.
5. Check if chart is conjunctional (i.e. Moon is waxing). If so, then check for aspecting
rulers of the Part of Fortune's position as described in step 4. If any make an
aspect, then the Part of Fortune is the Hyleg. If not go to the next step.
6. Check if chart is conjunctional (i.e. Moon is waxing), and find the position of the
Conjunctional Moon (i.e. preceding NEW Moon's position = NM). If so, then check
for aspecting rulers of the NM's position as described in step 4. If any make an
aspect, then the NM's position is the Hyleg. If not go to the next step.
7. Check if chart is preventional (i.e. Moon is waning). If so, then check for aspecting
rulers of the Part of Fortune's position as described in step 4. If any make an
aspect, then the Part of Fortune is the Hyleg. If not go to the next step.
8. Check if chart is preventional (i.e. Moon is waning). If so, then check for aspecting
rulers of the Ascendant's position as described in step 4. If any make an aspect,
then the Ascendant is the Hyleg. If not go to the next step.
9. Check if chart is preventional (i.e. Moon is waning), and find the position of the
Preventional Moon (i.e. preceding Full Moon's position = FM). If so, then check for
aspecting rulers of the FM's position as described in step 4. If any make an aspect,
then the FM's position is the Hyleg. If not go to the next step.
10.If the Hyleg has not been found in any of the previous steps, then the chart is
deemed to have no Hyleg.
11.2.2.1.12.2 Omar/Bonatti

Calculation differences from the Bonatti/Lehman method - the Sun and Moon can be
Hyleg only if they have a ruler (domicile, exaltation, triplicity or term) making an aspect
to them. In the Bonatti/Lehman method (above), they can still be Hyleg even without any
such aspect existing.
This calculation uses rulerships and all other options specified in the 2nd definition in
the HYLEG.ALM file - these may be edited by the user, but by default they are the same
as above.
1. Check if Sun is in 1st, 10th or 11th houses (apply house cusp offsets specified in
HYLEG.ALM). If so, then check if any of the 5 rulers of the Sun's position are
forming an aspect to the Sun. Check each of the following rulers which have a nonzero score in HYLEG.ALM: Domicile ruler, Exaltation, Triplicity in Sect, Triplicity out
of Sect, Triplicity participating, Term, Face. (By default, face is not included
because it has a zero score. The user may include it by assigning face a non-zero
score). If any one or more make an aspect (according to aspects and orbs specified
within HYLEG.ASP), then the Sun is the Hyleg. If not, go to next step.
2. Check if Sun is in 7th, 8th or 9th house, and is also in a masculine sign. If so, then
check for aspecting rulers of the Sun's position as described in step 1. If any make
an aspect, then the Sun is the Hyleg. If not go to the next step.
3. Check if Moon is in a feminine sign and not in a cadent house. If so, then check for
aspecting rulers of the Moon's position as described in step 1. If any make an
aspect, then the Moon is the Hyleg. If not go to the next step.
All remaining steps from 4 to 10 are identical to the previous definition.
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11.2.2.1.12.3 Ptolemy

Note that Ptolemy’s method always results in a Hyleg being found, whereas Omar’s and
Bonatti’s may not.
This calculation uses rulerships and all other options specified in the 3rd and 4th
definitions in the HYLEG.ALM file - these may be edited by the user, but by default they
are the same as follows...
Traditional rulerships
Ptolemy Triplicities
Ptolemy Terms
Signs start at 0 degs
Default houses
5,5,5 degree house cusp offsets (for ang, suc, cad houses)
Different Day/Night Part of Fortune
5 points for rulerships
4 points for exaltations
3 points for (all three) triplicity rulers
2 points for term ruler
1 point for face ruler
No points for any other items
3rd definition
Summation Points: Sun, Ascendant, Pre-natal NM
Minimum Honours: 3
Applies to Diurnal charts
4th definition
Summation Points: Moon, Part of Fortune, Pre-natal FM
Minimum Honours: 3
Applies to Nocturnal charts
"Prorogative" houses are the 1st, 7th, 9th, 10th, 11th
1. If a daytime chart then check if Sun is in a prorogative house (apply house cusp
offsets specified in HYLEG.ALM). If so, then the Sun is the Hyleg. If not then check
if Moon is in a prorogative house. If so, then the Moon is the Hyleg. If the Hyleg
was not found, then go to next the step.
2. If a night-time chart then check if Moon is in a prorogative house. If so, then the
Moon is the Hyleg. If not then check if Sun is in a prorogative house. If so, then the
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Sun is the Hyleg. If the Hyleg was not found, then go to next the step.
3. If a daytime chart then find the almuten according to the 3rd definition, and if a
nighttime chart, then us the 4th definition instead. If this results in a point being
found with a non-zero score, then that is the Hyleg. If the Hyleg was not found,
then go to next the step.
4. If the Moon is waxing, then the Ascendant is the Hyleg. If the Moon is waning, then
the Part of Fortune is the Hyleg.

11.3

Text and Data Supplied with Solar Fire
Solar Fire includes data and interpretations from a variety of sources. This data is
immediately available to the user once Solar Fire is installed.

11.3.1 Chart Data
Solar Fire includes a number of chart databases with a total more than 2000 charts, from
several sources - The Clifford Data Compendium and the Australian Data Collection, and
a collection of other charts from Sy Scholfield.
All of the chart data has been supplied by reputable specialist data collectors, and has
been rated for accuracy using Rodden Rating system.
Rodden Rating
AA - Data from Birth Certificates (BC), hospital or governmental birth records (BR),
notes from Vital Statistics/Registries, family bibles, baby books, family written
records. This is the best evidence of data accuracy available.
A - Data from the person, family member, friend or associate. Also included are
newspaper birth announcements. Times given within a ‘window of time’ of thirty
minutes (e.g. “between 3.30pm and 4.00pm”) are presented here.
B - Data from biographies and autobiographies where no other source is given.
C - Caution, data not validated. No source, vague, rectified/speculative data,
“personal” ambiguous sources, approximate birth times (e.g. “early morning”,
“around lunchtime”).
DD - Dirty Data. Two or more unsubstantiated quotes of time, place or data
(perhaps rectified without designation). Any unverified data that are contradicted by
another source.
11.3.1.1 The Scholfield Collection

This collection consists of about 1200 charts categorized into the following chart files
Corporate.SFcht
Entertainment.SFcht
Infamous.SFcht
Literature.SFcht
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Miscellaneous.SFcht
Politics.SFcht
Royalty.SFcht
Science.SFcht
Sports.SFcht
Visual Arts.SFcht
About the Author
Sy Scholfield (a.k.a. Simon Astley Scholfield) is a British-Australian astro-data collector
based in Brisbane, Queensland. His online collections include "Aussie Stars: Astrological
Profiles of Famous Australians" (www.aussie-stars.com) and "Queer Stars: Astrology
Charts for Gay, Lesbian, Bisexual and Transgender celebrities" (www.astroqueer.com/
charts.html). Selections of Scholfield's data have also been published in Lois Rodden's
Data News and AstroDatabank website & CDs; Frank C. Clifford's book, British
Entertainers: The Astrological Profiles; and Grazia Bordoni's Data Notizie newsletters. For
more information see his official website (www.syscholfield.com).
11.3.1.2 The Clifford Data Compendium

The Clifford Data Compendium presents the birth data of 500 famous individuals in a
number of areas from entertainment to sport, politics to religion. It incorporates some of
the most accurate data of leading figures found in other collections whilst including
many data collected by the author, and some never before published.
The charts are contained in the file clif2000.SFcht.
Each data entry has notes presented in the following format:
Source - Details of where the data originated from (if not from the author’s archives)
and the classification of the data is in brackets (see Data Accuracy below)
Real Name - If available and differing from name given
Profession - The various vocations for which the individual is primarily known
Biography - A short biography, including a few dates for further study
Some entries incorporate birth details of related individuals.
Data Accuracy
It is vital any data collections presented to the astrological community be as accurate
and fully sourced as possible. There may, however, be the occasional update to this
collection, and the author welcomes any corrections or additions.
All data are classified using the simple Rodden Rating system. All data presented in this
collection are of AA, A or B standard. Unverified data have not been included.
Abbreviations found in the Notes section:
FCC - Author Frank C. Clifford
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RR - Rodden Rating - a data classification system (see above)
GBAC - The Gauquelin Book of American Charts
CAH - Contemporary American Horoscopes
Data Bibliography
Most of the data presented have been personally checked by the author himself, and in
most cases the actual Birth Certificate or Birth Record/Note is in hand. Many thanks to
my international colleagues for sharing data and collected BCs and BRs over the last few
years, including Thelma & Tom Wilson, Dana Holliday, Edwin Steinbrecher, David Fisher,
Sally Davis, Francoise Gauquelin, Tashi Grady, Linda Clark, Caroline Gerard, Lois Rodden,
Marion March, and Grazia Bordoni.
The Gauquelin Book of American Charts (ACS, 1982). Accurate BC data by Michel &
Francoise Gauquelin
The House of Commons (1992-7) by Caroline Gerard. Available from: 6 Belford Mews,
Dean Village, Edinburgh EH4 3BT, Scotland (£8).
The Astro-Data series. Five volumes and Data News by Lois Rodden, covering a variety of
data.
Contemporary American Horoscopes. BC data from Janice Mackey and Jessica Saunders,
1990. Available on computer disk from Astrolabe.
A special thank you to Edwin Steinbrecher for providing access to his database and BRs.
The Steinbrecher Data Collection is a comprehensive database of 20,000 timed data (+
6000 noon charts). See the website: www.dome-igm.com/dome/
About the author
Frank C. Clifford is an astrologer, palmist and data collector. His data interests include
running the Data Exchange Network to swap data with international collectors, working
with the Astrological Association’s Data Section, and checking data/biography for many
magazines and books. His non-astrological work includes script-writing, broadcasting
and researching. Frank lives in London and can be contacted via Flare Publications. His
first data book “British Entertainers: The Astrological Profiles” is available from Flare
Publications (SF), P.O. Box 10126, London NW3 7WD, England, UK. UK orders - cheques
or postal orders for £11.50; International orders - an International Money Order for £17.
All prices include p&p. Please do not send cash, unless by guaranteed/registered
delivery.
11.3.1.3 The Australian Data Collection

This is a collection of 375 charts of famous Australians (and immigrants) and Australian
events, all sourced, and some with biographical notes and important dates. This data
was compiled by Australian astrologer Stephanie Johnson, with contributions from other
astrologers around the world.
The charts are contained in the file aus2011.SFcht.
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11.3.2 Chart Art
Solar Fire includes 90 "Chart Art" background graphics that appear as Pages under "Chart
Art" available via the Page Topics Index menu option on the View menu.
The Chart Art background graphics included in Solar Fire were provided by 3 different
Australian artists/designers.
Kay Steventon - Art_Angel.jpg, Art_Angel2.jpg, Art_Angel3.jpg, Art_Planets.jpg,
Art_Sunmoon.jpg
Eila
Laurikainen
Art_Fire_Frame.jpg,
Art_Earth_Frame.jpg,
Art_Earth_Frame_Ltr.jpg, Art_Air_Frame.jpg, Art_Water_Frame.jpg
Celine Lawrence - Art_Air_Dark.jpg, Art_Air_Dark2.jpg, Art_Fire_Dark.jpg,
Art_Fire_Light.jpg, Art_Fire_Red.jpg, Art_Stars_Dark.jpg, Art_Water_Dark.jpg,
Art_Water_Light.jpg, Art_Water_Light2.jpg
These graphics are copyright (2008), and permission is required to use them for any
purpose other than within pages generated by Solar Fire.
See Also:
Using the Page Topic Index
11.3.3 Interpretations Text
The interpretations text in Solar Fire was written by Stephanie Johnson Dip FAA of
Esoteric Technologies Pty Ltd. Text Copyright © 2003 - 2013 Esoteric Technologies Pty
Ltd.
The Sabian Symbols are from four sources: "The Sabian Symbols in Astrology" by Dr.
Marc Edmund Jones © The Marc Edmund Jones Literary Trust. First published in 1993 by
Aurora Press, PO Box 573, Santa Fe, New Mexico 87504, USA.
Another source used for the symbols themselves is Dane Rudhyar.
The interpretations for the symbols in interpretation reports is by Marc Edmund Jones
and by Lynda Hill.
Finally Sabian Symbol interpretation text is also available via "Charubel’s Degrees",
which are taken from the book “The Degrees of the Zodiac Symbolised” which is taken
from the Astrology Classics edition of 2004, Bel Air, MD, USA.
Lynda Hill has also supplied the same contents for the "Sabian Oracle", which is degree
interpretive text but it isn't related to any particular chart when accessed in the "Sabian
Oracle".
The parts of the body for each degree of the zodiac are from "A Handbook of Medical
Astrology"
by Jane Ridder-Patrick ©. Published by Penguin/Arkana 1990 ISBN 0-14-019214-X.
Website: www.janeridderpatrick.com
The interpretations in the file STANDARD.INT relate to natal geocentric charts. It can
also be used fairly effectively with various other types of charts, such as return charts or
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progressed charts, provided that the reader bears in mind the original purpose of the
text, and adapts it to the new context. For example, the interpretation of the Sun in the
5th house in a return chart will only apply for a period of 1 year, whereas the text was
written to refer to enduring traits that would result from this placement in a natal chart.
The interpretations in the file TRANSITS.INT relate to transits to a natal chart.
The interpretations in the file PROGRESS.INT relate to progressions to a natal chart.
The interpretations file SYNASTRY.INT relates to synastry between two natal charts.
The interpretations file CALENDAR.INT relate to transits to a natal chart.
The interpretations file FIRDARIA.INT relates to firdaria planetary periods in relation to a
natal chart.
The interpretations file SABIAN.INT and CHARUBEL.INT relates to the Sabian Symbols in
relation to a natal chart.
The interpretations file ORACLE.INT relates to the Sabian Oracle and not to a natal chart.
Not all possible categories of interpretations are covered in these files given the vast
number of possible combinations that need to be potentially catered for. For example
there is no text relating to aspects between the TransNeptunians and planets.
You are, however, free to add you own text to either of these files, or to create your own
interpretations files from scratch, by using the
Interpretations Compiler supplied with Solar Fire.
Copyright Restrictions
All text included with Solar Fire is copyrighted, but the licensed owner of Solar Fire is
granted permission to use any output printed or exported from Solar Fire for the purpose
of providing astrological charts and reports generated by Solar Fire to friends or clients.
This text must not otherwise be reproduced or copied without the express permission of
the copyright holder. This text may also be edited before distribution, provided that the
copyright of any portions of original text is respected and acknowledged where
appropriate.
If you print reports using text supplied with Solar Fire, then you should ensure that the
copyright notice of Esoteric Technologies appears on the report.
If you have added some of your own text, then you might like to add a copyright notice
that applies to the text you have written yourself, for example
Main Text © 2003 - 2013 Esoteric Technologies Pty Ltd
Portions of Text © 2005 - 2013 Susan Smith
If you are printing reports that use your own text exclusively, then there is no need to
include any copyright notice relating to Esoteric Technologies.
11.3.4 Fixed Stars Data and Text
The fixed star file BRADY.FST contains data and interpretations for 50 fixed stars. This
file was compiled by Bernadette Brady Dip. (FAA) from her work in progress “Fixed Stars
and Stained Glass”. Bernadette has done all her research on fixed stars working with
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parans, so she suggests that the best results can be achieved with this star file by using
the Star Parans report rather than the Star Aspects report in Solar Fire. She recommends
using an orb of 15 to 20 minutes of arc when using the Star Paran report. She has
included coding of + and - signs with some star names to indicate stars which are
especially positive (+++) and those that may prove very difficult (---). Text Copyright ©
1995 Bernadette Brady.
The fixed star file PTOLEMY.FST contains a number of stars that were commonly used in
the era of Ptolemy. This file was also compiled by Bernadette Brady. The keyword text
for each star in this file identifies its nature in terms of planetary symbolism (e.g. Jupiter
for a star which has a Jupiterian nature), and its long text identifies which position in its
zodiacal symbol this star takes. Text Copyright © 1995 Bernadette Brady.
The fixed star file ALLSTARS.FST contains data on about 290 of the most commonly used
stars, but has no interpretations text. It was generated by importing the fixed star file
that is supplied with the NOVA program, and is included by permission of Astrolabe, Inc.
11.3.5 Arabic Parts
There are many Arabic Parts files supplied with Solar Fire. The file called Allparts.arp
contains all the Arabic Parts that were supplied with the NOVA program, and is included
by kind permission of Astrolabe, Inc. The most recent is the file called Moreparts.arp,
which contains 150 Arabic parts.
11.3.6 Asteroids
Solar Fire is supplied with ephemerides for more than 1000 asteroids and minor planets.
The ephemerides cover the period 1500 to 2100. It is possible to obtain additional
asteroid ephemerides from the Astrodienst web site at www.astro.ch/swisseph/.
To be able to use many of these glyphs as User Defined Points or as Extra Ring points
then select the Asteroid file AstGlyphs in the process described in Editing a User
Defined Points File and Editing an Extra Ring Points File. See also other asteroid files.

Asteroid glyphs available
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11.3.7 Dwarf Planets
Dwarf planets are objects in space orbiting the Sun just like the normal planets i.e they
have enough mass that they are subjected to the controlling affect of the Sun's gravity,
but they are too small to have smashed away any other objects in their orbital path.
The dwarf planets are Ceres (often thought of as an asteroid), Pluto (used to be a normal
planet), Haumea, Makemake and Eris.
Ceres, Pluto and Eris are always available as standard displayed points. Haumea and
Makemake are in the asteroid file Newplan.pte and AstGlyphs.pte. See Editing a User
Defined Points File and Editing an Extra Ring Points File for how to utilize these files.
11.3.8 Eclipses
Solar Fire’s eclipse data has been extracted from Fred Espenak’s (NASA/GSFC) web
pages at http://sunearth.gsfc.nasa.gov/eclipse/eclipse.html, which include
comprehensive and accurate astronomical eclipse data covering many millennia.

11.4

Bibliography
Those who are interested in reading further may wish to refer to some of the following
publications. There are, of course, many other high quality astrological publications
available, and this list is simply intended to be a starting point for those wishing to know
more.

11.4.1 General Astrology
Alan Oken's Complete Astrology - Alan Oken - Publ. Bantam Books
Choice Centered Astrology - Gail Fairfield - Publ. Ramp Creek Publishing, Inc.
Synastry - Penny Thornton - Publ. The Aquarian Press
The Astrologer's Companion - John Filbey & Peter Filbey - The Aquarian Press
The Twelve Houses - Howard Sasportas - Publ. The Aquarian Press
11.4.2 Predictive Astrology
Planets in Transit - Robert Hand - Publ. Whitford Press
Solar and Lunar Returns - John Filbey - Publ. Aquarian Press
The Eagle and the Lark - Bernadette Brady - Publ. Samuel Weiser, Inc.
The Progressed Horoscope - Alan Leo - Publ. Destiny Books
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11.4.3 Locational Astrology
Planets in Locality - Steve Cozzi - Publ. Llewellyn
Planets on the Move - Maritha Pottenger and Zipporah Dobyns - Publ. ACS Publications
The Geodetic World Map - I. I. Chris Mcrae - Publ. American federation of Astrologers
Inc.
11.4.4 Medieval & Classical Astrology
Carmen Astrologicum - Dorotheus of Sidon - Translated D. Pingree - Publ. Ascella
Publications
Christian Astrology - William Lilly - Publ. Regulus Publishing Company Ltd
Classical Astrology for Modern Living - Dr J. Lee Lehman - Publ. Whitford Press
Essential Dignities - J. Lee Lehman Ph.D. - Publ. Whitford Press
Night and Day: Planetary Sect in Astrology - Robert S. Hand - Publ. ARHAT and Golden
Hind Press
Tetrabiblos - Ptolemy - Translated F.E.Robbins - Publ. Harvard Uni. Press
Three Books on Nativities – Omar of Tiberius – Translated R.Hand – Publ. Project
Hindsight (Latin Track Volume XIV)
11.4.5 Esoteric Astrology
Esoteric Astrology - Alice A. Bailey - Publ. Lucis Publishing Company
Soul-Centred Astrology - Alan Oken - Publ. Bantam Books
The Best of Charles Jayne - Charles Jayne - Publ. American Federation of Astrologers Inc.
The Labours of Hercules - Alice A. Bailey - Publ. Lucis Publishing Company
The Sabian Oracle: 360 Degrees Of Wisdom - Lynda Hill - Publ. Lynda Hill 2010
The Prenatal Epoch - E.H. Bailey - Publ. Samuel Weiser Inc.
The Sabian Symbols in Astrology - Marc Edmund Jones - Publ. Aurora Press
Transpersonal Astrology - Errol Weiner - Publ. Element, Inc.
11.4.6 Other Specialized Topics
Asteroid Goddesses - Demetra George - Publ. ACS Publications, Inc.
A Handbook of Medical Astrology - Jane Ridder-Patrick - Publ. Penguin/Arkana
Finding Our Way Through the Dark: The Astrology of the Dark Goddess Mysteries Demetra George - Publ. ACS Publications Inc.
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Natural Fertility - Francesca Naish - Publ. Sally Milner Publishing
Planets in Composite - Robert Hand - Publ. Whitford Press
The Black Moon Book - F. Santoni & Demetra George - Publ. Sum Press.
The Combination of Stellar Influences - Reinhold Ebertin - Publ. American Federation of
Astrologers Inc.
The Lunation Cycle - Dane Rudhyar - Publ. Aurora Press
Interpreting the Eclipses – Robert Carl Jansky – Publ. Astro Computing Services
Lunar Shadows, The Lost Key to the Timing of Eclipses - Dietrich Pessin
Delineation With Astrodynes - Ken Stone - Publ. American Federation of Astrologers Inc.
Astrodyne Manual - Elbert Benjamine - Publ. Church of Light
How To Read Cosmodynes - Doris Chase Doane - Publ. American Federation of
Astrologers Inc
Pluto: The Evolutionary Journey of the Soul - Vol 1 & 2 - Jeff Green - Publ. Llewellyn
Publications
11.4.7 Astronomical Calculations and Computing
Astronomical Algorithms - Jean Meeus - Published Willman-Bell, Inc.
Astronomical Formulae for Calculators - Jean Meeus - Published Willman-Bell, Inc.
Mathematical Astronomy Morsels – Jean Meeus – Published Willman-Bell, Inc.
Horoscope Calculation - J.A.Eshelman - Published American Federation of Astrologers,
Inc.
Planetary Programs and Tables from -4000 to +2800 - P.Bretagnon & J-L.Simon Published Willman-Bell, Inc.

11.5

Version Changes
The main new features of Solar Fire 9 are listed below.

11.5.1 Changes from Version 8.x to Version 9
The following is a list of the most significant changes that have been made for version 9
of Solar Fire. Many smaller changes have also been made but these aren't listed.
Primary Directions: This whole area has been revamped, particularly in Dynamic
Reports. There is now the choice of Primary Mundane or Primary Zodiacal directions.
Previously, we computed primary directions according to the semi-arc technique
promoted by Placidus, but you can choose between Placidus’ semi-arc projections and
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Regiomontanus’ preferred projections based on hour circles to determine mundane
position. So now you have a choice of Placidus or Regiomontanus methods for computing
the directions, several new direction rate keys (available in Preferences), and Classical
or Modern definitions of "converse". Additionally the help documentation on Primary
Directions has been expanded to make them more understandable for the general user.
Primary Directions to Radix now compute much faster.
Zodiacal Releasing Tabulation: Zodiacal Releasings show whole periods in a native's
life when certain general astrological influences are increasing in strength. A listing of
these periods is now available as an interactive tabulation, so that any period in the past
or future can be instantly generated and examined.
Graphing Financial Data: Data from financial markets that is in a compatible format in a
file can be imported into Solar Fire, and then graphed on a Graphic Ephemeris alongside
the usual transits, progressions or directions.
Chart Files Merge: Multiple chart files can now be merged together into a single file.
Lunar Gardening Calendar: The Calendar has been revised to include Gardening
recommendations based on the phases and signs of the Moon.
New house systems available: A new house system is available that is a variation of the
"Whole Sign" house system. The Whole Sign (Fortune) house system creates equal
houses of 30 degrees, with the first house starting at 0 degrees of the sign that has the
Part of Fortune in it. Also new is the "South Node on 1st House Cusp" house system.
Toolbar button: There is a new Toolbar toggle button for quickly switching charts
between the Geocentric or Heliocentric coordinate system.
New Wheel Styles: The range of wheel styles supplied with the program is now even
more extensive (Bizod2, Bizod3, Euro5c, Tri4)
New Page Styles: Including a new Sun Signs page to assist in writing sun sign columns,
and eight new pages from Hank Friedman - loads of information available at a glance.
New Chart Files: Including one containing famous race horses and jockeys, and other
files containing over 200 new charts for politics, entertainment, royalty and more,
Aus2014 expanded selection of Australian charts.
New Interpretation files: These are Charubel interpretations (Charubel.int) and Solar
Returns (SolReturn.int)
New Social Media links: These can be found on the Help menu
Appointments Manager: Can now import contacts from a CSV (comma separated
values) file.
User-Defined Points: Progressions and Transits are now calculated for these points.
Eclipses: Search result can be printed or copied, with aspect details included.
Asteroids: 15 new asteroids from the Swiss ephemeris have been added
Glyphs: New glyphs in the font file ET Asteroids1a (ETAst1a.ttf) - for asteroids Salacia
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120347 û, Vulcano 4464 ü, Orcus 90482 ú the Galactic Center þ, and the Super
Galactic Center ý.
Page Designer and Page Browser Improvements: These have been heavily revised to
make it easier to work with the wide range of pages available in Solar Fire. The Page
Browser is now available in the Page Designer as well; graphic backgrounds are visible
in the Page Designer, and in the Page Browser if desired; when the "Temperaments"
object is added to a page the rulership to use for calculating the temperament can now
be specified; plus click-and-drag interactions in the Page Designer more intuitive; as well
as moving pages between categories you can now also copy pages to other categories.
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Frequently Asked Questions
This chapter covers some common questions that users have asked. Where necessary
links are provided to relevant sections of the User Guide.

12.1

Why aren't some of the midpoints showing in the dial?
Check that...
You are using a dial with a modulus that is capable of showing the kinds of
midpoints you want to see
You have the correct orb set for the modulus you are using.
See Using Dials and Pointers.

12.2

How do I use characters like " ä " in a chart name?
You can do this by changing the fonts that Solar Fire uses, see Fonts.

12.3

How do I display all three Liliths in a chart?
The three Liliths are the Black Moon Lilith, the asteroid Lilith and the Dark Moon Lilith.
Black Moon Lilith
See Black Moon Type for information about the Black Moon and its calculation setting.
>> To display the Black Moon in the main ring of any chart wheel
1. Choose the Displayed Points option from the Chart Options menu
This opens the "File Management" dialog box, with the currently selected file
highlighted.
2. If you want to include the Black Moon in a different file than the current one, click
on that file - otherwise go to step 3.
3. Click on the Edit button. This opens the "Select Displayed Points" dialog box.
4. In the Unselected Points list click on the Black Moon.
This transfers it to the "Selected Points" list. (If you want to reverse this... click on
the the Black Moon again to unselect it.)
5. Click on the Save button. This takes you back to the "File Management" dialog box.
6. Click on the Select button.
Asteroid Lilith - asteroid number 1181
To be able to display this in charts and reports it first needs to be included in a Solar Fire
user asteroid file (see Editing an Asteroid File).
However Solar Fire comes supplied with a user asteroid file called "Standard.ast" that
already includes the asteroid Lilith. Therefore, unless you have removed Lilith from it,
there is no need to edit an asteroid file, you simply need to set "Standard.ast" as the
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current asteroid file.
>> To set an asteroid file as the current file
1. Click on the Chart Options menu, then on Files, then on Asteroid Files.
This opens the "File Management" dialog box.
2. Click on the file you want to use for selecting asteroids from. In this situation that
would be Standard.ast.
3. Click on the Select button.
Now that this is done you can include the asteroid Lilith in any user-defined point
and/or extra ring point files (see below for how to do this).
Dark Moon Lilith
This is a possible second satellite of the earth (not confirmed by modern astronomy), as
first postulated by Waltemath, and written about by Delphine Jay and others. You can
include the Dark Moon Lilith in any user-defined point and/or extra ring point files (see
below for how to do this).
Displaying asteroid Lilith and Dark Moon Lilith in charts, pages and reports
Whereas the Black Moon Lilith is one of the generic points in Solar Fire that you can
immediately use, there a couple of further steps needed to use asteroid Lilith and Dark
Moon Lilith.
a) Include each Lilith in a user-defined points or extra ring points file
b) Select the user-defined points or extra ring points file to be "current".

>> To include asteroid Lilith or Dark Moon Lilith in a user-defined points file
If you have previously included the Black Moon Lilith in the current Displayed Points
file (see above), and then include both of these Lilith's in a User-Defined Points file,
then all three Liliths will appear in charts as part of the normal planets (Sun, Moon
etc).
See Editing a User Defined Points File (note the points below first)
a) For asteroid Lilith...
make sure in the Point Type area that you select Asteroid.
make sure the filename under the "Select File" button is "standard". If it isn't
click on the Select File button, select standard.ast then click on the Select
button.
This will display "Lilith 1181" in the "Available Points" list.
b) For Dark Moon Lilith...
make sure in the Point Type area that you select Extra Body.
make sure the filename under the "Select File" button is "extras". If it isn't click
© 2014 Esoteric Technologies Pty Ltd

Frequently Asked Questions

501

on the Select File button, select extras.dat then click on the Select button.
This will display Lilith as "Dark Moon W'mat2" in the "Available Points" list.
>> To include asteroid Lilith or Dark Moon Lilith in an extra ring points file
If you prefer either or both of these Lilith's to be in an extra ring in charts then you
will need to include them in an extra ring points file. Once you have included one or
both of these Liliths in an extra ring points file, you will also need to select wheels
that have an extra ring as part of their design so that these Liliths will be displayed. A
list of these wheels installed by Solar Fire is included in the topic below.
See Editing an Extra Ring Points File (note the points below first)
c) For asteroid Lilith...
make sure in the Point Type area that you select Asteroid.
make sure the filename under the "Select File" button is "standard". If it isn't
click on the Select File button, select "standard.ast" then click on the Select
button. This will display "Lilith 1181" in the "Available Points" list.
d) For Dark Moon Lilith...
make sure in the Point Type area that you select Extra Body.
make sure the filename under the "Select File" button is "extras". If it isn't click
on the Select File button, select "extras.dat" then click on the Select button. This
will display Lilith as "Dark Moon W'mat2" in the "Available Points" list.

12.4

Should I upgrade my Solar Fire?
To help you decide, here are the major changes that have been made in Solar Fire from
version to version. By upgrading to the latest version, Solar Fire 9, you get a complete
new program containing all the additions and improvements that were made in previous
versions. You also get complete revised and expanded Solar Fire and Solar Maps user
guides in PDF form.
You will find your current Solar Fire version number on the title bar at the top of your
Solar Fire main screen. To see what features you are missing, read each of the sections
below down to the heading that contains your version number.

Added in Version 9 (Solar Fire 9, released in Jan-March 2014)
Compatible with Windows 8 and 7, and with 64-bit and 32-bit Vista
Greatly expanded primary directions: Dozens of new possibilities enable you to
explore this time-honored predictive method in depth. Previously, in addition to offering
van Dam primaries, Solar Fire computed primary directions according to the semi-arc
technique promoted by Placidus. Now to determine mundane position you can choose
between Placidus’ semi-arc projections and Regiomontanus’ projections based on hour
circles. You can also choose the classical or modern definition of converse, and rate keys
including Cardan, Placidus, Solar Birthday Longitude and user-defined. It’s all explained
in the new and fuller help pages. Also, primary directions compute faster than before.
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New interactive Zodiacal Releasing table: Now you can broaden your predictive
repertoire with Zodiacal Releasing, a recently discovered Hellenistic Time Lord system
that (much like the existing dasa and firdar tables) assigns each life period (and each of
3 levels of sub-period) to a different sign rulership. Zodiacal releasing can show periods
of heightened activity or importance regarding topics like career, relationships, etc. It
can also show which life periods will be easy or difficult regarding those topics. The new
zodiacal releasing tables can make a valuable supplement to your other predictive
techniques, helping to particularize and qualify life trends and events.
Part of Fortune houses: There’s an added “Whole Signs (Fortune)” house system that
uses equal whole-sign houses with House 1 being the sign that contains the Part of
Fortune. To Traditional astrologers this provided an important supplement to the
information given by houses based on the Ascendant.
Financial data graphing: Downloading stock or futures prices (from free sources like
Finance.Yahoo.com) and overlaying them on SF9’s graphic ephemerides can reveal
striking and useful price-aspect correlations. Using regular CSV-type spreadsheet data,
you can also correlate aspects with any time-series data -- things like sunspot numbers
(from free government sources), the ups and downs of your business income, or even the
fluctuations in your weight.
Chart file merge: The new Chart Merge Utility makes it easier to consolidate the chart
files on your computer. Plus, it it makes it easy to synchronize your chart files with those
on your other devices, such as your laptop or Windows 8 tablet.
Lunar Gardening calendar: Attractive new graphics on the Solar Fire calendar use the
current lunar sign and phase to remind you when and what to plant, as well as when to
fertilize, weed, reap and rest.
Geo/Helio toggle button: Now you can instantly see what the helio chart looks like
without having to re-compute it. Conveniently situated on the Toolbar, you’ll find a new
button for quickly switching a chart from geocentric to heliocentric and back again.
More Solar Maps features: Now you can enhance your astro-mapping with newly
discovered bodies like Eris, Sedna and Selena. For both the radix and relocated charts,
you can see new map lines showing all the locations where the Ascendant and MC
would fall. You can also click to instantly see a relocated chart wheel showing all the
houses. You can create your own custom paran sets, and click to turn individual paran
lines on and off. Plus, there’s better zooming and panning, and you can now save the
map image as a JPG (as well as a BMP or GIF) graphics file.
More interpretations: A new solar return report—plus Charubel’s interpretations for
each zodiacal degree (in addition to the existing interpretations for the Ebertin medical
degrees and the Sabian symbols).
More wheel and page designs: New bi-zodiac, nakshatra, Euro and other wheels, plus
new pages including a 12-wheel design to help you write Sun sign columns.
More dials: Examine hidden planetary relationships in over 180 new uni, bi, tri and quad
dials in both the major and minor harmonics.
More chart data: Over 200 new charts for politics, entertainment, royalty and more.
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Additional Aussie charts, and a new file of 100 horse racing charts including famous
horses, jockeys and trainers. Like the other charts included with Solar Fire, all are
carefully sourced, classified and Rodden-rated.
Better eclipse lists: Now you can view and print detailed eclipse information in one
compact list, sort the list by type, date, degree, duration, Saros number or other factors,
and click on any eclipse to instantly display the eclipse chart.
New social media links: Now you can click on the Help menu to quickly join the Solar
Fire conversations on Facebook and Twitter.
Wider email support: Now you can email charts directly through Gmail, Hotmail, Yahoo
and other services in addition to MAPI services like Outlook.
Page Designer: Improvements include the ability to see the inserted graphics while you
are designing the page. And, to make it easier to locate the page you want, the Page
Topic Index now shows a thumbnail preview of each page design.
More asteroids: Solar Fire 9 includes 15 additional asteroids from the Swiss ephemeris.
More glyphs: New glyphs in the font file ET Asteroid1a (EtAst1a.ttf) include the Galactic
Center, the Super Galactic Center, and the asteroids Salacia 120347, Vulcano 4464 and
Orcus 90482. Also, there’s now a glyph for the Part of Spirit in the font ET Symbol 3
(EtSym3.ttf).
Nodal Axis: Now you can view an aspect line drawn between the North and South Nodes,
clearly showing the nodal axis on the chart.
Improved Appointments Manager: You can now import your contact list from a CSV
(comma separated values) file such as you could create in a spreadsheet.
Atlas: An updated ACS PC Atlas provides recent time zone changes.

Added in Version 8 (Solar Fire Gold v8, released in 2011)
Compatible with Windows 8 and 7, 64-bit Vista, 32-bit Vista and Windows XP
Solar Maps: The full, professional version of Solar Maps has been added to Solar Fire v8.
Now you can add map lines for stars, principal asteroids and Uranian planets, as well as
midpoints and aspects to the angles; get point-and-click interpretations for the map lines
and also print out locational reports, animate the transiting and progressed maps, view
paran lines and lists of the cities that lie along them, plot hurricanes and earthquakes,
and enjoy more customization possibilities.
Teacher/Student Feature: Now you can get your students off to a running start (or help
your friends) by sending them all your preferred Solar Fire settings in one easily-installed
zip file. They can, at any time, switch between your settings and their own.
Astrology Schools: A new “Astrology Schools” item in the Help menu directs a user to a
web page where various categories of astrology schools are listed. If you have a
qualified school, you can have it added to the list.
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User-Defined points: The main wheel of Solar Fire now allows up to 50 User-Defined
points, besides the 50 standard planets/points that the main wheel already displayed.
The 50 User-Defined points on the main wheel can be selected from a list that is similar
to the Extra Ring points (including asteroids, midpoints, fixed stars and more).
More glyphs: New glyphs for 65 asteroids, plus recently discovered bodies like Haumea
and Makemake. You can display these either as User-Defined points in the main wheel
or as Extra Ring points in wheels that have an extra points ring. Also, a new Glyphs tab
in the Preferences enables you to select alternative forms of various glyphs, including a
new glyph for Neptune.
Ashtkoot Compatibility Matching: The Ashtkoot (8-factor) system analyzes a couple’s
Vedic Moon positions to score their overall chances for long-term relationship success.
Fun for dating, and an additional indicator for professional synastry work.
Animated chart: You can now jump directly from the regular chart view to the Animated
chart, and if any of the wheels require a different location and time zone, a new
“Location” button enables you to change them. Now you can also change the time
increment for advancing the chart to Weeks (as well as to the existing Years, Months,
Days, Hours, Minutes and Seconds).
Interpretations: New Vertex interpretations and additional asteroid interpretations
have now been added to the Standard.int file.
New Appointments module: Clients details can now be stored within Solar Fire. Session
appointments can be made for a client with email reminders and receipts for the client
available. Session time for the appointment can be tracked and stored. If a microphone is
part of or plugged into the computer, sessions can also be recorded, stored and played
back.
500 new timed, Rodden-rated (A or B) celebrity charts include today’s newsmakers plus
prominent figures from the past.
New wheels and pages: A bi-wheel that shows the house cusps for both charts; wheels
that show the ruling planets for terms (Egyptian or Ptolemy) and faces; new Vedic single
and bi-wheels with 120-year (and longer) dasa tables; and new “chart art” pages
including old-style drawings for each Sun sign, and illustrated pages for each of the 12
possible house positions of the composite chart Sun.
Arabic Parts: A new set that specifically addresses commodities.
Atlas: Solar Fire v8 now uses only the ACS PC Atlas.

Added in Version 7 (Solar Fire Gold released in 2008, v7.1 and 7.2 released in
2009, v7.3 released in 2010)
Compatible with Windows 8 and 7, 64-bit Vista, 32-bit Vista and Windows XP
Sabian Oracle: Astrologer Lynda Hill has greatly expanded the Sabian Symbols text to
several paragraphs for each degree. She discusses not only the symbolism but also
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shows in detail how the image applies to everyday life. Solar Fire Gold enables you to
consult the Sabian Symbols randomly as an oracle, or have a Symbol interpretation pop
up every day to suggest the day’s important theme.
Sabian Interpretation Report: By selecting the new “Sabian.int” interpretations file for
natal charts, you can also access the expanded Sabian Symbols interpretations as a
printable report that discusses the degree symbolism of every point in the chart.
Temperaments Tabulation: A new Temperaments tabulation and page object scores a
chart according to William Lilly’s rules for finding Hot, Wet, Cold and Dry qualities in a
chart and concluding whether the person is predominantly Choleric, Sanguine,
Melancholic or Phlegmatic. It considers the Ascendant sign and ruler, the Moon’s sign
and phase, and the signs of planets that aspect the Moon.
Astrology Encyclopedia: When you want to learn the meanings of astrological terms
and concepts you can now just look in the Help menu to consult an expanded version of
deVore’s classic astrology encyclopedia.
Chart Art: There are now hundreds of new “Chart Art” pages with attractive graphic
backgrounds. These are ideal for gift-giving or sale -- or just for personal enjoyment.
New Chart Collections: Included are about 1,000 new charts of celebrities and historical
figures, compiled by expert data collectors
14 New Standard Chart Points: various chart angles and zodiac points plus Selena
(White Moon), Sedna and Eris
New Calendar module: to generate customizable daily, weekly or monthly calendar
pages showing your choice of transits and progressions to any natal chart. You can
access newly written interpretations, both as on-screen pop-ups and as printed reports
that you can provide along with the personalized calendars. You can also export the
calendar data directly to MS Outlook and other calendar applications.
New Birthday Reminders: With the little Birthday Reminder window popping up each
day, you’ll never again miss your friend and client birthdays. This can also remind you
when your clients are due their yearly update.
Reports (tables and listings): now include house modality emphasis, and also planetary
stations. Speed to nearest sec arc if rate below 1deg/day.
New Tabulations: A new Tabs section in the Reports selection doubles the range of
supporting information that is instantly available on any chart.
Astrodynes/Cosmodynes: Astrodyne tables are presented in the new Tabs section and
are also available as objects to insert in your page designs.
New Firdaria Interpretations: Also available as tables in the new Tabs section, firdaria,
much like Vedic dasas, divide a life into periods and sub-periods, each of which is ruled
by a different planet or combination of planets. The new firdaria reports by Stephanie
Johnson interpret either a person’s current firdaria periods or the succession of periods
throughout life.
Enhanced Dynamic Reports: All events are now calculated with fullest possible
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accuracy and can be displayed to the nearest second of time. Daylight Saving Time is
now automatically adjusted as required. Events that are within in orb at the start of a
report may now be shown, ensuring that the report will include the long-term transits
that are in effect even though they never become exact during the report period. You can
now right-click on the column headers in the reports to specify which columns of
information you want and what order you want to display them in.
Improved Electional Search: Now shows exact aspect hits, allows searches for events
relating to natal charts, does midpoint searches, allows searches for chart shapes, and
allows bracketing of conditions
Improved Chart Search: Now allows searches for charts with aspects or synastry
placements in relation to any given natal chart. Also allows searches for chart shapes,
and bracketing of conditions
New Wheel Style Preview: Allows user to browse through thumbnail images of the
wheel and dial styles before choosing one
Stationary Points: In both charts and reports stationary points are now marked with an
S. User can define what is considered a station.
Page Print Preview: The View Chart screen now has a button that enables you to
preview exactly what the chart will look like when printed.
File Locations: Solar Fire now uses standard Microsoft folder locations for all its files,
ensuring better compatibility with newer operating systems, and making data backup
easier. Now your chart files and settings are stored in Documents\Solar Fire User Files,
while the Solar Fire program itself is stored in C:\Program Files.
Stellarium: Now, if you have this impressively featured open-source planetarium
program installed, you can directly link to it from within Solar Fire’s View menu. This is in
addition to Solar Fire's own built-in planetarium.
House systems: You can select a different default house system for Vedic charts, and
the Sidereal/Tropical toggle button now also toggles the house systems as well as the
zodiac types.
Retained Charts: You can now add single retained charts instead of having to retain all
charts at once
Page Designer: simpler flexible-list editing, simplified menus and various new object
alignment options
Quinquiwheels: You can now display 5-ringed charts as well as single, bi, tri and quadri
wheels.
Extra Point Wheels: You can now show aspects between extra points
Planetary Status Bar: Pop-up hints have improved format, and nearest lunar phases and
eclipses have been added
Chart View and Report View: A new “Charts...” button enables you to select different
charts to view without going back to the main screen.
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ACS Atlas: You can now add your own places.

Added in Version 6 (Solar Fire Deluxe, released in 2005)
Compatible with Windows 8 and 7, 64-bit Vista, 32-bit Vista, Windows XP and Windows
98se
Chart Search: powerful chart search capability using wide range of astrological criteria
and chart data criteria with Boolean logic, on unlimited number of chart files. Wheel
preview as well as various other sort/copy/export/email/print functions on lists of
matching charts. Savable search criteria.
Electional/Time Search: powerful time search capability using wide range of
astrological criteria and chart data criteria with Boolean logic.
Solar Live: provides access (in your default browser) to the latest news and links posted
online.
New chart file format: comments and life events stored in single chart file.
Life events: ability to store unlimited life events for each natal chart - for use with
subsidiary charts and animation module. Events may be imported from and exported to
chart files.
Chart Open: MRU chart list and search multiple folders. User-definable chart details
columns, sortable by any column. Chartwheel preview window.
Chart Save on exit: new dialog allowing easy save/discard for any unsaved charts to any
file/s.
Restore Charts: from backup location
Import Charts, Files and Settings: from earlier version of Solar Fire or Solar Fire on other
computer
Animation module: can now export calculated charts and jump to Chart View screen at
any time. Can view pop-up interpretations. Can use dial interactively.
Page Objects: now have in-place property editing.
Save to PDF: wheels/pages/graphic ephemeris.
User-defined point order: (e.g. Sun before Moon) in listings and reports
Date/time entry improvements: default month/year, year only entry, a/p time
abbreviations, up/down buttons for d/m/y in chart data entry
Lat/Long entry improvements: decimal entry allowed
Aspect highlighting and filtering: on displayed and animated wheels, grids, aspect lists
and preview charts. Applies line thickness changes to highlight closest orbs. Filtering by
a range of criteria including aspect pattern, by individual chart point, by aspect
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harmonic, and others.
Transparency: selectable for some dialogs (XP/2000 only).
More resizable dialogs: e.g. "View Chart", "Chart Database", "Charts Search Results",
"Chart Tabulations & Reports", all Subsidiary chart dialogs etc
Automated check for updates on web: informs users if patch update is available.
Speaking interpretations: (WinXP or other operating systems with extra download of
speech engine from MS)
Vedic Charts: with optional vedic/tropical warning and new quick toggle between
sidereal/tropical
Age Harmonic Charts: also in dynamic reports and graphic ephemeris
Longitude Equivalent Declination Charts: as new chart types
Subsidiary charts: can now keep dialog open for multiple subsidiary calculations (Apply
button), and dialog stays open if user cancels anywhere in calculation process.
Lunar Phase charts: user can now define how many sequential phases to calculate, and
addition of current/nearest/next New Moon and/or Full Moon chart
Eclipse charts: added under Lunar Phase charts
Direction Arc Multipliers: for Solar, Ascendant and Vertex Directions for static charts or
dynamic reports
Transit charts: as new subsidiary chart type, allowing precessed/converse transit charts
to be calculated
Pages: graphical vertical declination and latitude strip boxes. Nakshatras and Chinese
Lunar mansions page objects, extra column types for these in Flexible point list. Chinese
Lunar Year Info
New ayanamsas: Sri Yukteswar, JN Bhasin, Larry Ely, Takra I, Takra II
Extended aspect pattern analysis: report with extra patterns, pattern preview, chart
search and Electional search by pattern
Dynamic Reports: new automatic report start date selection options, and van Dam
primary directions method. Added Jayne's directions of declination. Added arc multipliers
for directions. Added Void of Course moon events (entering VOC + last aspect and sign
ingress).
Graphic Ephemeris: shows date/angle of cursor crosshairs. Added Jayne's directions of
declination. Ability to jump forward or back in time without exiting.
Selection of displayed transiting points: to optionally avoid showing chart angles and/
or inner planets when viewing transits etc.
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Added in Version 5 (v5.0 released in 2000, v5.1 in 2002)
Compatible with Windows 32-bit (not 64-bit) Vista, Windows XP and Windows 98se
32 Bit: Solar Fire is now a fully compiled 32bit Windows program, running on Windows
32 bit platforms such as Windows 95, 98, NT4 and later releases. It is now able to
access the full power of the 32 bit computer chips (such as Pentium processors), and
take advantage of powerful operating system features, such as long file names.
State of the Art Calculation Accuracy: Planetary calculations now use the Swiss
Ephemeris™, based on JPL (Jet Propulsion Laboratory) data, providing state of the art
accuracy across more than 10,000 years. The full set of Swiss Ephemeris asteroid files
may now also be used with Solar Fire (available for free via web download or at low cost
on CD).
Astro-Locality Mapping: A new mapping module is included to allow planetary, eclipse
path and local space lines to be viewed on a selection of world maps. This module is
compatible with (and may be upgraded to) Solar Maps as a fully comprehensive mapping
package.
Astrologer’s Assistant: a new and very powerful task automation feature which allows
you to record various tasks and then save them for replay at any time. For example, you
could record a task to print a chart, calculate a progressed chart and transits chart for
the current date, display them together in a triwheel and print them, run a dynamic
report with a years transits and progressions and then print that out. This set of tasks
can then be replayed for any other starting chart at the click of a button.
Animated Charts and Pages: any chart or viewable page can now be run as a real-time
astrological clock, or animated backwards or forwards in time using customizable time
steps.
New Chart File Structure: a new chart file storage structure allows users to save almost
all kind of charts generated within Solar Fire, including progressed, directed and
composite charts, for example. Solar Fire is backwards compatible with all earlier version
chart files, and can optionally save to earlier chart file formats if required. Comments
may now also be saved with subsidiary charts, and enhanced chart comment editing
features make it possible to access and edit chart comments whilst casting a chart, as
well as at any stage prior to saving it. Chart files may now be accessed from (or saved
to) any location on your computer or network.
Toolbar Buttons: a fully customizable Toolbar contains graphical buttons for all
frequently used option in Solar Fire, allowing quicker access to commonly used features.
Screen Customization: the user may now easily select background colors and graphics
for the Main Screen and all data viewing screens (such as chart viewing pages), and
save these preferences along with other color selections in named Color Schemes. These
allow different colors to be selected for use with a printer, thus obviating the need to
change color selections when printing.
Synastry Reports: full text for synastry reports has been included as part of the standard
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interpretations text base, and is easily accessible via a new menu item.
Eclipse Data: 5000 years of accurate solar and lunar eclipse data has been included,
plus a module to allow flexible searching based on chart contacts, eclipse types, Saros
numbers etc…
Page topic index: displayed chart pages may now be selected via a customizable topic
index, where pages can be grouped into categories such as Beginner, Classical,
Cosmobiology, Esoteric, Vedic etc. Many new page object have been added such as
square (traditional and vedic) charts, dasas and bhuktis, flexible listings of asteroids,
arabic parts, fixed stars and other bodies, etc…
Email Support: Chart data and graphical data (such as chart page displays) may now be
saved into JPG file format for easy attachment to emails, and (for MAPI compliant email
programs like MS Outlook and Eudora) the email program is automatically launched with
the data file/s already attached or listed in the body of the message.
ASCII Data Export: a powerful and highly flexible method of exporting chart details and
or positions of planets, midpoints, asteroids, stars, Arabic parts etc, which can be read in
by other programs such as spreadsheets or other astrology programs.
Enhanced Dynamic Reports: it is now possible to view dynamic events of one person’s
chart in relation to another person’s radix planets, to merge multiple reports into a single
listing, and to include a greater range of extra dynamic points, such as fixed stars and
asteroids.
Enhanced Graphic Ephemeris: you can now see an ephemeris of declination or latitude,
and also include extra dynamic points such as planetary midpoints.
Enhanced Atlas: greatly expanded with more time zone information, and more forgiving
automatic lookup facilities. Default place may now have an automatic timezone lookup
on startup, thus allowing automatic adjustment for daylight savings periods. Also the
user may select a list of favorite places for quick and easy default location changes.
Enhanced Wheel Designs: Chart wheels may now have multiple house and zodiac rings,
so that both the tropical and sidereal zodiac can be displayed on the same chart, for
example. Different chart rings in a wheel may retain their own house cusps instead of
always anchoring on the inner chart’s house cusps. A ring of user-defined additional
points may also be displayed with a planets ring, including points such as asteroids,
stars, arabic parts etc.
Enhanced Reports: new Planetary Differences report, new Midpoint Weighting Analysis
(MWA) report, Adjusted Calculation Date (ACD), Chart Hylegs, star parans displayed in
local times, etc.

Added in Version 4 (released in 1997)
Compatible with Windows XP and Windows 98se (possible font problems with 32-bit
Vista)
New Chart Types: True Tertiary Progressed, Arc Transform, Relocated, Johndro,
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Geodetic, Progressed Solar Return, Wynn-Key Return, Lunar Phase Return
Page Designer: The user may design page layouts including items such as wheels, grids,
points lists, house cusp lists, dignity tabulations, midpoint trees, modulus sort strips,
balance of element and mode. There are about 50 different types of object which may be
placed onto a page design, moved and re-sized at will. A variety of useful pre-designed
pages are also supplied.
Graphic Ephemeris: A flexible and elegant graphic ephemeris may be viewed and
printed, either with or without radix planetary positions. A novel features is the ability to
display aspect symbols wherever dynamic points cross radix positions.
User Definable Aspects: There are a variety of new aspecting options, including
moieties, unidirectional aspects, and the ability to add any number of user-defined
aspects.
Dial Pointers: Dials now have moveable pointers, showing midpoints and aspects as the
dial is rotated.
Enhanced Rectify Assist: The ascendant may now be adjusted directly, and the user has
a choice of step increments when adjusting times or angles.
Dignity/Almuten Editor: The manner in which essential dignities are calculated may be
specified by the user. Also, it is possible to define complex almuten calculations whose
results are displayed in a tabulation.
Extra House Systems: Several extra house systems have been added, including
Alcabitius.
Interpretations In-place editor: Interpretations may now be edited in-place, without the
need to compile them, which greatly simplifies the editing process.
256, Hi-color and True-color screen support: Colors of signs, planets and aspects may
now be chosen from the full range of possible colors.
Additional Asteroids: 38 additional asteroids are now available in reports and certain
page objects. It is also possible to install further asteroids.
Dynamic report - extra points: Dynamic reports may now include transiting,
progressing or directed midpoints for any combination of chart points. Also, the radix
chart may also include midpoints, fixed stars, Arabic Parts and asteroids.
Dynamic report - primary directions: Dynamic reports may now use a method of
Primary Mundane directions.
Planet Search facility: It is possible to search any chart file for planets in signs, houses,
or in aspect to other planets or positions, and to combine search criteria to perform a
complex search.
Chart Details Comments May Be Printed: It is possible to print summaries of chats or
chart files, including chart details and optionally also any chart comments included with
the charts.
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TimeZone Tables for Solar Fire Place Database: The Solar Fire place database now
allows the use of user editable timezone tables. These tables have been populated for
several countries.

Added in Version 3 (released in 1995)
Compatible with Windows XP and Windows 98se
Context Sensitive Help: Help may be invoked by using the F1 key anywhere in Solar Fire.
New Chart Points: 8 TransNeptunians, TransPluto, Black Moon Lilith (mean)
New Chart Types: Tertiary, Minor and User Rate Progressed; Ascendant Arc and Vertex
Arc and User Arc Directed; Coalescent; Prenatal (18 types, including conception and
quickening); Rising/Setting using either visual or true altitude; Transiting and Progressed
Lunar Phases.
Savable Charts: Return, Ingress, Prenatal and Relationship charts may also now be
saved to a chart file.
Retainable Charts: Any selection of calculated charts may be retained for an indefinite
number of future Solar Fire sessions. Retained charts appear immediately in the list of
"Calculated Charts" when Solar Fire starts up. Any type of chart may be retained,
including composite and progressed charts, for example.
Opening Charts: It is possible to search for a chart through all your chart files at once.
Chart names may be displayed in a variety of orders to help find the charts you want.
Charts may be opened from Nova type chart files transparently.
Chart Comments: Virtually unlimited comments or text may be added to any saved
chart, and this text may be easily browsed or edited whilst opening the chart.
Deleting Charts: Any number of calculated charts may be selected for deletion all at
once.
Rectifying Charts: The date of a chart may now be altered in addition to the time and
the Midheaven. This makes it possible to cross date boundaries when attempting to
rectify charts whose times are close to midnight.
Displayed Points: It is now possible to select a set of displayed points to apply to a
single chart instead of to all charts. This makes it possible, for example, to view only the
outer planets in a transits chart outside all the planets in a natal chart.
DTP: Any chart or grid displayed in Solar Fire may now optionally be copied to the
clipboard or to a file in Windows Metafile format. This allows scalable Desk-TopPublishing quality charts to be viewed and printed in many other programs.
Draconic Zodiac: The Draconic zodiac may be selected for the calculation of any new
chart, in addition to the existing zodiac types. Draconic charts may be mixed with other
types of charts in biwheels and reports, for example.
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Angle Progression Methods: Solar arc in longitude and right ascension; Naibod in
longitude and right ascension, mean quotidian (also known as daily houses). These may
be used both in progressed charts and in dynamic progressions.
Progressions Day Type: May be either Standard or Bija
Lunar Parallax: The moon’s position may optionally be adjusted to take account of the
location on the earth’s surface. This correction may be used in any chart or dynamic
report.
Vulcan Calculation: The position of Vulcan may be calculated using either the orbital
parameters proposed by L.H.Weston, or the theory of D.Baker.
Dials: Any displayed wheel may easily be viewed as a 90 degree dial. The wheel
designer may be used to design dials of any modulus for viewing in Solar Fire.
Wheel Designer: All of the supplied wheel and dial display styles are editable with a
supplied utility program. You can also create your own designs from scratch if you prefer.
Editable features include zodiac glyph style, house cusp style and arrows, color fills,
planet and degree positions, and much more.
New Dynamic Reports Features: Dynamic reports may use any progression or direction
method. From a dynamic report you can: View interpretations of a dynamic event (e.g.
Transiting Uranus Square Natal Sun); Export all the interpretations for the report to a file
for editing or printing in a word-processor; View a list of similar events, including the
number of exact hits before and after the report; View a list of aspects made to the radix
chart by an eclipse or stationary point; View a chart for the time of the dynamic event;
View a graphical Time Map for all the items in the report.
New Reports: Horary: planetary day and hour, almutens of houses, ancient dignities,
point count per planet; Sensitive points - zodiacal positions at which aspects are made to
chart’s planets; Midpoint Modal Sort - zodiacal midpoints sorted by mode; Arabic Parts zodiacal positions and aspects to chart’s planets; Star Aspects - zodiacal positions and
aspects to chart’s planets plus keywords for each star; Star Parans - list of stars in paran
to chart’s planets plus keywords for each star; Planetary Nodes - zodiacal positions of
each planet’s nodes and aspects to chart’s planets
Planetarium: Any chart may be displayed on the celestial sphere with fixed stars in the
background. Special features are: Click on a planet to find the nearest star; Double click
on any star to get full information, including an interpretations (where available); View
the sphere in equatorial, ecliptical or local coordinates, from the side or towards either
pole; Rotate the celestial sphere by clicking on a scroll-bar; Highlight any constellation
by selecting it from a list
Time Map: Any dynamic report may be displayed graphically with bar lines indicating
entering and leaving orbs along a time scale. This is scrollable and printable to allow all
events in the report to be viewed.
Interpretations: Solar Fire is supplied with 2 sets of interpretations - one for natal charts
and one for transits to a natal chart. It is also possible to specify a different default
interpretations file for up to 7 different types of charts or dynamic events, if you create
or acquire other interpretations sets. For example, you can use one set of interpretations
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for a natal chart, and another set for a solar return chart.
Interpretations Compiler: This now keeps track of all the text files related to a set of
interpretations, and allows them to be edited directly from the compiler using Windows
Notepad, Windows Write or any other word-processor of your choice.
Fixed Star Editor: Technical data and interpretations text my be entered for any fixed
stars or other astronomical objects for use in the planetarium and fixed star reports.
Arabic Parts Editor: Any combinations of A+B-C may be entered for use in the Arabic
Parts report.
Ephemeris Generator: It is possible to browse or print an ephemeris for any
combination of planets and asteroids for virtually any time period and using any time
interval.
Utilities Menu Editor: Any program may be added to the Utilities menu so that it may be
called up directly from Solar Fire.

Added in Version 2 (released in 1993, released as Solar Fire Standard in 1995)
Compatible with Windows XP, Windows 98se, Windows 3.1 (and possibly 32-bit Vista)
Windows 3.1: Due to use of Truetype fonts, v2 requires Windows 3.1 - it will no longer
run on Windows 3.0.
Improved Accuracy: Planets are now accurate to within several seconds of arc in most
cases, with the Sun accurate to one second of arc.
Use of Glyphs: Through the use of specially created fonts, all reports may now be
viewed on the screen or printed with either word abbreviations or the graphical glyphs of
signs, planets and aspects, according to your choice.
Status Bars: Status bars have been added to the top and bottom of the main menu
screen. These shows the current date, time, location and a continually updated
Ascendant, Midheaven and planetary positions. Retrograde planets are shown in red.
Additional Menu Help: Whilst the menu is being browsed the bottom status bar gives a
fuller description of whichever menu item is being browsed.
Chart Edit: Any calculated natal chart may now be copied and edited (for example to
alter the house system) by a simple menu selection.
Chart Delete: Any calculated chart may be deleted from the list of "Calculated Charts"
by a simple menu selection.
Coordinate Systems: It is possible to create charts in heliocentric coordinates.
Heliocentric charts may be used alongside geocentric charts in synastry grids and
reports, biwheels, triwheels etc.
Zodiacs: It is possible to select either Tropical or any of 7 different Sidereal zodiacs, plus
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the ability to define your own sidereal ayanamsa.
House Systems: There are two new house systems - Whole Signs and Hindu Bhava.
Precession and Converse Charts: It is now possible to use precession or converse timing
with any progressed or return charts.
Return Charts: Planetary and asteroid return charts have been included.
Improved Place Database: It is now possible to easily edit, copy or delete places on and
between place database files (without having to "mark" records first). It is also possible
to type in a place name (or part of a place name) on any screen requiring a place, and
the details of that place will be retrieved automatically from the current place database
file, if a match is found.
Dual Wheel Display: It is possible to view or print two separate wheels on a single page.
Rectify Assist: It is possible to alter the time, or Midheaven angle of a natal chart via a
simple dialog screen, after which the chart is automatically redrawn.
Faster Chart Display: Due to use of special Truetype fonts, chart displays are faster than
in version 1.2x.
LMT Support: Typing "LMT" in any timezone box will cause the LMT to be calculated
automatically from the longitude.
Chart Compliments: Up to six lines of text may be entered to appear on printed charts
as compliments text (i.e. your name and address).
Pop-Up Menu: Clicking the right hand mouse button in the Chart View screen causes a
pop-up menu with all the display option to appear. It is therefore possible to alter colors,
displayed points, aspects etc, all without leaving the chart viewing screen.
Charts without Aspects: It is possible to select options to prevent aspect lines being
printed in the center of any single wheels, or to prevent aspect symbols being printed in
the center of each aspect line.
Enhanced Copy Ability: It is possible to copy any report (including dynamic reports) to
the clipboard, with an option of either clearing the clipboard first, or simply appending
the report to the current contents of the clipboard. In this manner, almost any number of
reports can be "stacked up" in the clipboard for later pasting into a word processor
document, for example.
3-D Aspects: (Also known as True Body Aspects) It is possible to select an option so that
all reported aspects will be 3-D aspects instead of aspects of longitude and latitude or
declination. (This option does not apply in dynamic reports).
Applying/Separating Aspects: All reports and grids giving aspects have been modified
to show applying/separating. The calculation of these is based on the actual rate of
movement of each point involved in the aspect. A separate orb angle may now be
specified for applying and separating aspects.
Editable Rulerships and Weightings: Modern, Old, Esoteric and Hierarchical rulerships
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are supplied with the program. It is possible to edit and alter these, or to add your own
definitions of rulerships of signs and decanates, exaltations and falls. You may also alter
the weightings applied to planets, asteroids and other chart points for reports containing
assessments of the balance of modes, elements and rays.
Midpoint Reports: Four new reports have been added - 1) Chart point sort (any
modulus), for one or two charts combined; 2) Midpoint listing in planetary order or by
zodiacal position (any modulus), for one chart, or for one chart combined with the
primary positions of a second chart. This may be used to examine transiting positions
relative to the midpoints of a natal chart, for example; 3) Midpoint axes (any modulus or
orb); 4) Midpoint trees (any modulus or orb). Also the existing Aspect Analysis report has
been amended to include a list of aspect patterns found in the chart (Unaspected
planets, stelliums, Grand Crosses, T-Squares, Kites, Grand Trines, Mystic Rectangles,
Yods, Focussed Yods).
Dynamic Reports: It is possible to define a set of "radix points" to be used in any
dynamic reports, instead of the use of the "displayed points". All dynamic options have
been incorporated into a single comprehensive module with the following capabilities:Transits to Radix, Transits to Transits, Transits to Progressions, Transits to Solar Arc
Directed, Progressions to Radix, Progressions to Progressions, Solar Arc to Radix, House
Ingress, Sign Ingress, Parallels of Declination or Latitude, Stationary Points, Solar and
Lunar Eclipses, Entering and Leaving Orb, Precessed, Converse
It is possible to view reports using either graphical glyphs or name abbreviations, both
on the screen and printer. It is also possible to view or print reports using the userdefined colors for each glyph.
On-line Interpretations: A major new feature is the ability to browse through natal chart
interpretations, plus basic definitions of a large variety of items in a charts. By simply
clicking on a particular part of any natal chart which you have displayed in the chart
viewing screen, you can instantly browse through an interpretation. For example, if you
click on a planet, you will see an interpretation of that planet in its house and sign. If you
click on a house cusp, you will see an interpretation what the sign on the cusp of that
house means. If you click on the degree of a planet or house cusp, you will see
information about that degree of the zodiac. If you click on a second planet (within 3
seconds of clicking on a first planet) you will see an interpretation of the aspect between
those two planets. The following types of information are available in relation to a natal
chart: Balance of modes, elements, quadrants, hemispheres, rays, lunar phase, chart
point in house and sign, chart points rulerships and dispositor, list of aspects to a point,
interpretation of an aspect between two chart points.
The following general types of information are available (without referring to a natal
chart): Degrees, decanates, signs, modes, elements, houses, quadrants, hemispheres,
rays, aspects, chart points, houses, signs on cusps, chart points in signs, chart points in
houses, chart point aspecting another chart point.
The information supplied with the program contains interpretations of every planet in
aspect to every other planet with a major aspect (conjunction, opposition, trine, square,
sextile, quincunx), every planet and asteroid in each house and sign, and every sign on
each house cusp, in addition to information relating to individual degrees, signs, houses,
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modes, elements etc.
Although the interpretations module has been designed specifically for use whilst
viewing charts, it is also possible to save all text relating to a chart into a file, which may
subsequently be edited or printed using a word-processing program, for example.
Interpretations Compiler: It is possible to edit/alter the interpretations supplied with
the program, or to add your own entirely new text with the use of the supplied compiler.
This reads through the source text files and compiles them all into a single indexed file
which Solar Fire can then use to access any required paragraph of text almost instantly.
It is possible to include any of a huge variety of information types, as described above.
ACS PC Atlas: It is possible to use the ACS PC Atlas instead of the Solar Fire place
databases, if you have this installed on your computer.

12.5

Search for Declinations
How can I find points in a chart that have the same declination as a particular (main)
point or house cusp? Or points that have the opposite declination to that? And can I
search for points having this in many charts at once or do I have to look in one chart at a
time?
Points having the same declination would be in "parallel" to the declination of that
particular main point, and points having the opposite declination would be in contra
parallel to that particular main body.
When a chart is displayed in the "View" screen we could look for points in parallel or
contra parallel to a specific declination, by clicking on the Reports button, then the
Tabulations tab, then on the Declinations report. In that report we can see the
declination for each chart point, both numerically and graphically, and thus will see
which points are in exact or close to exact parallel or contra parallel to any particular
declination.
However using Solar Fire's "Chart Search" facility we can search for parallel or contra
parallel points in some or all charts in Solar Fire at once, and we can also specify how
much of an orb is permissible in the results.
The following procedure will find all the charts from your selected chart files which have
one or more points with the same amount of declination as your particular main point
(e.g. the declination of the Moon in each chart where that declination is within a certain
range that you specify).
For this example, we will use the Moon in each chart as our particular main point whose
declination we will be searching for amongst the declinations of all the other (specified)
points in our (selected) chart files.
1. From the "Main Screen" click the Chart menu.
2. Click Chart Search, which will bring up the "Chart Search" window.
3. In the "Chart Files To Search" section select all the chart files that have charts in
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them that you want to search.
4. In the bottom right of the window choose an Aspect Set that contains both
Parallels and Conjunctions. Your aspect set must include both Parallels and
Conjunctions in order for this to work properly. The "Standard" aspect set is usually
a good choice.
5. In the "Search Condition Selection" area click on the In Aspect tab.
6. In the Point or Cusp dropdown box select the (particular main) point or house cusp
which has the declination you want to search for in all your charts.
7. For In select "Parallel".
8. For With select a point you want to be included when searching in each selected
chart file to see if that point has a matching declination to that of the point you
selected in (6).
9. Click the Add button. This condition will now appear on the left in the "List of
Search Conditions" area, after the word "FIND".
Repeat steps (8) to (9) for each point you want to be included when searching the
declination of points in your selected chart files. Each time you do this you are adding
another search condition. After the first search condition was added (the first time you
did step 9) it had the word "FIND" at the beginning, and all subsequent conditions will
have the word "AND" at the beginning.
11. For each condition that starts with the word "AND"
(a) click on the condition
(b) click on the And/Or button. This will change the "AND" to "OR".
12. In the "Search Condition Selection" area click on the Coordinates tab.
13. In the Point or Cusp dropdown box select the same point as you did in step (6).
14. In the Coordinate Type dropdown box select "Declination"
15. In the Comparison Type dropdown box select ">=" (greater than or equal to)
16. In the Comparison Value dropdown box enter the minimum orb you will allow in
the results.
17. Click the Add button. This condition will now appear on the left in the "List of
Search Conditions" area, after the word "AND". Leave it this way.
18. In the Comparison Type dropdown box select "<=" (less than or equal to)
19. In the Comparison Value dropdown box enter the maximum orb you will allow in
the results.
20. Click the Add button. This condition will now appear on the left in the "List of
Search Conditions" area, after the word "AND". Leave it this way.
21. Click the Search button. You will get a list of every selected point you set (in steps
8 - 9) in every chart in every selected chart file you selected (in step 3) whose
declination is the same as (within the minimum and maximum orb you set in steps
15 - 20) -parallel to- the declination of the point you set in step 6.
You can also search for contraparallels by repeating all this but selecting
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"ContraParallel" in step 7.
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242
sending an email to a group of clients
248
session receipts
248
viewing all appointments for a client
244
Arabic Mansions
of chart - tabulation
113
Arabic Parts
adding new
439
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dynamic
237
Arabic Parts
editing
415
aspects - page object
342
editing a file
106
editing
439
editing colors
420
files
131
filter for applying/separating
136
in a chart & aspects to
108
filter for harmonic family
136
in extra ring
130
filter for maximum orb
136
page object
336
filter for patterns
136
part of fortune
390
for a specific chart point only
136
selecting
103
for chart - list, sorted list, analysis
108
selecting as extra points for dynamic report
429
highlighting orb tightness
135
sources
492
highlighting partile only
135
using as almuten points
450
how Solar Fire calculates applying/separating
Arc
415
directions types used in Dynamic reports
186
in Dynamic reports
186
user-defined
397
interchart
in
triwheel
281
Arc Transform
lines
133
calculation method
474
mapped aspect names in interpretations file
casting chart
157
237
Ascendent
moieties
417
arc
397
nearest - page object
342
ASCII 287, 288, 365
nearest synastry - page object
342
chart conversion
291
of chart - tabulation
113
editing definitions
367
of moon - page object
342
Ashtkoot Report
121
page objects
342
Aspectarian Grid
486
pattern - search - specifying conditions for
296
Aspected Points
renaming a file
105
aspected point sets used
131
search for in charts
307
changing
131
selecting
103
copying a file
105
selecting for interpretations
237
creating a new set
104
turn on filtering, highlighting
134
deleting a file
105
unidirectional
417
editing a file
106
user-defined tabulation - page object
342
editing a set
414
Asteroids
renaming a file
105
accessing additional files
436
Aspects
accuracy
470
3D (true body)
417
aspects - page object
342
adding user-defined
417
default folder location
436
advanced options
417
displaying in a chart or dynamic report
433
aspect sets used
130
downloading from the internet
436
by sign & orb, by sign only
417
editing, selecting
433
calendar
176
files
131
changing
130
glyphs
492
changing line style, orbs
415
glyphs in Extra Ring Points
432
colors
139
glyphs in User Defined Points
426
copying a file
105
in a chart
108
creating a new set
104
in extra ring
130
deleting a file
105
installing additional - updating lists afterwards
display applying & separating differently
135
438
display aspect lines for conjunctions
135
location
411
displaying glyphs
133
page object
336
displaying lines
133
removing asteroid files from your computer
436
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Index
Asteroids
selecting
103
selecting as extra points for dynamic report
suppliedReport
492
Swiss Ephemeris
436
Astro_Locality Maps
364
Astrodynes
of chart - tabulation
113
page object
336, 340
page objects
341, 342
Astrologer's Assistant
260
editing task list
261
examples
263
running on startup
411
Astrology
learning
26, 493
reference material
493
Astronomical computing
reference material
495
Atlas
adding places
67
connecting to
29
selecting
408
using, radius search, similar names
64
zone changes
64
Australian Data Collection
489
Auto Chart Save
91, 410
Automated
start date of reports
193
Automation
of tasks in Solar Fire
260
AutoRun
411
Ayanamsa
399

-BBacking Up
170, 462
Bailey- E.H.
476
Baker D.
393
Balances
data page objects
351
graphical page objects
352
Bernadette Brady
472
Bhuktis
of chart - tabulation
113
page object
355
Bibliography
493
Birthdays
adding
257
reminders
257

523

viewing
257
Birthtime
429
source rating
61
Bitmap
copy, send, publish graphics as
279
BiWheel
alignment of chart zodiacs
137
houses in both wheels
281
short-cut key
42
viewing or printing
50
Black Moon
390, 470
Blue*Star
287
Bodies calculated from orbital elements
in extra ring
130
Bonatti
hyleg calculation
484, 485
hyleg info source
483
Books
astrology
493
Brady- B.N.
491

-CCalculated Charts
39, 43
view
69
working with
86
Calculations
antiscia and contra-antiscia charts
473
arc transform
474
Bailey prenatal charts
476
black moon lilith
390
combined charts
474
dignities & almutens
448
directed charts
471
Geocentric correction
391
harmonic charts
473
Jaynes prenatal charts
478
locality charts
475
longitude equivalent of declination charts
473
Lunar Parallax correction
391
part of fortune
390
polar regions
394
progressed charts
471
ray weightings
394
return charts
472
setting lunar node type
389
void of course moon
392
vulcan
393
Calendar
accuracy
181
events per day
176

© 2014 Esoteric Technologies Pty Ltd

524

Solar Fire 9 User Guide

Calendar
exporting
179
for financial astrology
269
gardening
176
Gregorian
53
information
175
Julian
53
modern
53
old
53
preferences
176
using
173
Campanus
Houses
400
mundoscope
157
Capricorn
403
Categories
copying or moving pages between
73
CCRS Program
436
Character strings
in chart names & comments
96
Chart
96, 328
adding/editing comments
100
advanced search for charts using a variety of
criteria
96
analysis
108
animating
209
antiscia (solstice), arc transform, Campanus
mundoscope
157
aspect orbs
415
aspected points used
131
aspects used
130
Bailey prenatal
476
balances of elements etc - tabulation
113
base for subsidiary charts
148
bulk entering new
63
calculated
39
calculated - working with
86
calculation & display options
127
calculation methods for progressed charts
471
calculation, operations, storage
43
captions/details/comments on pages
328
casting
coalescent/combined/composite/relationship
161
casting new
52
casting solar return
49
cloning
89
coalescent
474
combined - calculation methods
474
comments
38
comments page object
328
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composite
474
conversion options
410
coordinate System
61
copy to clipboard, send in an email
78
copying a chart file
105
copying charts
99
copying from many files to one file
106
current chart preview
38
daytime/night-time in almuten scoring
452
deleting charts in Calc Charts
39
deleting from chart file
99
description - page object property
357
details - search - specifying conditions for
296
details available on pages
328
directed
471
directed - animating
211
directed, progressed, transiting
149
displaying your contact details
32
eclipse
217
eclipse, lunar phase, lunar phase return
166
editing comments
78
editing details
98
editing details, manually relocating
86
editing points
414
email options
410
emailing
252
entering comments
62
entering subsidiary data
149
exporting data
367
extra points
427
Financial
268
finding character strings in chart names
96
finding character strings in comments
96
finding in chart file
95
harmonic, local horizon
157
here and now
52
hyleg - defined
483
hyleg calculation
484, 485, 486
images
76
importing
34
importing charts & settings from previous versions
32
importing/exporting charts from/to other programs
287
ingress, return, transit
153
Jayne prenatal
478
life events
63
locality, relocation, geodetic, johndro
168
longitude equivalent
157
merging charts from different files
106
midpoint composite
402
moving
100

Index
Chart
96, 328
name
53
natal life events
144
natal, radix
181
new
45, 51
number of life events
38
of a dynamic event
201
opening single/multiple, immediately viewing
97
opening, retrieving from file
92
options - accessing from View Chart window
84
page object property
357
Placidus mundoscope
157
points - modulus sort
108
prenatal
162, 476
prenatal - further reading
483
prenatal - interpreting
481
presetting options
51
printing a chart
122
printing list with summary info
101
quick access to the file it's saved in
38
quickly determining the file it's saved in
38
rectifying
80
relationship
474
removing duplicates
99
renaming a chart file
105
retaining
89
rising or setting
164
saving
91
saving life events
289
search - creating a list of conditions
305
search - selecting files to search in
291
search - specifying conditions for
296
search for components in many charts
291
search for election dates
291
selecting an event type for
60
selecting one or many in Calc Charts
39
selecting one or many in Chart database
97
sending via email
253
sensitive points in a chart
108
shape - search - specifying conditions for
296
shortcut for changing chart event type
98
shortcuts for viewing
75
source of birthtime
62
source rating of birthtime
61
square, traditional objects in Page Designer
332
stepping in time
210
subsidiary
147
swapping positions in multiwheels
78
turn into a graphic file
78
updating details in database
98

525

using life event as subsidiary chart date
148
using search results
308
vedic
87, 169, 355
viewing
70
viewing in multiwheels
70
viewing reports & tabulations
117
while viewing - adjusting angles/date/time
80
zodiac alignment in multiwheels
137
zodiacal analogue
157
Chart Art
281
background colors
139
composite sun pages
283
finding pages
73
sources
490
Chart Data
Australian data collection
489
Clifford Data Compendium
488
exporting
365
Scholfield data collection
487
Chart Database
92
selecting data displayed
93
Chart File
backing up, restoring
170
changing folder
104
converting to Solar Fire - default house system
used
290
creating
104
creating Solar Fire - default coordinates used
290
creating Solar Fire - default zodiac used
290
creating Solar Fire - version format used
289
creating/changing a description of 100
deleting
105
editing
106
finding charts
94
importing/exporting from/to other programs
287
limitations
101
printing list of charts with summary info
101
searching for charts, comments
96
selecting
94, 103
Chart Points
copying a file
105
creating a new set
104
deleting a file
105
editing a file
106
editing a set
414
renaming a file
105
re-ordering
403
selecting
103
Chart Report window
printing
122
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Chart View window
printing
122
Charubel
259
Chinese Mansions
of chart - tabulation
113
Chiron
range of ephemeris
470
Clicking something
definition
36
Clients
adding an appointment
243
adding, viewing and modifying details
241
deleting
243
deleting an appointment
244
emailing
248
emailing appointment reminders
245
saving changes to client details
242
session receipts
248
viewing all appointments
244
Clifford Data Compendium
488
Clock
210
setting
30, 31
using real time astrological clocks
209
Clone
charts
89
Coalescent
casting chart
161
Colors
aspects, background, chart points, points
139
changing color depth
142
copying a file
105
creating a new set
104
deleting a file
105
editing
420
editing a file
106
in dynamic reports
195
printer, screen
139
printing
123
renaming a file
105
scheme, signs
139
screen color depth
142
selecting
103
selecting palette
142
Combined chart
calculation methods
474
casting
161
interpretation category
221
short-cut key
42
Comments
adding to a chart, editing
100
entering for chart
62
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lines
378
searching for in charts
96
Compatability
ashtkoot report
121
Compiler
376
compiling
376
compiling definition file
376
compiling overview
373
creating new interpretations from scratch
372
decompiling
374
definition (input) file layout
378
editing interpretation text
375
error messages
376
execution and output file
376
Compliments
32, 406
Composing
conditions for a search
296
Composite
casting chart
161
progressed chart, automated
263
sun - house
281
Consideration
search - specifying conditions for
296
Contents
how to use the topics in Help
17
Conversing methods
185
Coordinate System
61
planetarium
274
topocentric
391
Coordinates
geocentric, heliocentric
87
search - specifying conditions for
296
Copy
chart or page to clipboard
78
charts
99
charts/images as bitmap, metafile, gif, pdf, jpg
279
dynamic report to clipboard
202
graphic ephemeris as a graphic
208
Time Map to clipboard
202
Copyright
of interpretations text
490
Creating teacher settings
250
Current
chart file
94
file being used
103
setting a file to be "current"
387
Current chart
definition
38
displayed points - changing
128
Current Settings panel

Index
Current Settings panel
changing display
414
Cycle
dark
117

-DDark cycle
tabulation
117
Dasas
of chart - tabulation
113
page object
355
pages
283
single & biwheel
283
Data
357
blocks for page objects
357
entry
35
lines for page objects
357
supplied
487
Date and Place panel
changing display
414
Dates
automating start date of dynamic reports
format
53
Gregorian
53
Julian
53
new style
53
old style
53
old style / new style flags
407
options
407
order of Dynamic report - via print queue
quick-setting feature
205
rectifyng a chart
80
selecting format
31
system
37
Davison Relationship Chart
161
Decanate & face rulers
wheel
281
Declination
517
for financial astrology
269
graph page object
352
of chart - tabulation
113
of transits, progressions
204
Decompiling
interpretation file
374
overview
373
Default
arc for atlas radius search
64
chart event type
60
chart file
94
coordinates used when importing charts

193

186

290

527

date flag style
407
house system
400
house system used when importing charts
290
location for Swiss Ephemeris files
467
place - restoring in chart data entry
56
place - setting
31, 409
superimposition option
137
values for page object properties
285
values in data entry dialogs
35
zodiac
399
zodiac to use for new & existing charts
400
zodiac used when importing charts
290
Definition file
373
changing text in
378
creating a new definition file
375
creating from interpretation file
374
editing
375
layout of file
378
Deleting
calculated charts
88
charts
99
duplicate charts from files
99
DeltaT 470
Description
for a chart file
100
Designing
dials, wheels
313
pages
324
Detriment
421
DeVore
20
Dial
changing
131
editing style
313
modulus & setting orb
83
selecting style
103
selecting style for display
131
style design options
315
using, pointer, rotating pointer, options
81
Dialog boxes
keys
41
Dignity
calc method - degree dignities
448
calc method - sum over points
448
definition files available
447
definition files folder
447
editing a definition
448
file, for page objects
357
in reports and page objects
446
of chart - tabulation
113
opening a definition file
447
page object
346
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Dignity
point modifiers
450
search - specifying conditions for
296
selecting calculation type
448
selecting points for calculations
449
term type for almuten calculations
454
triplicity rulers for almuten calculations
454
Dignity/Almuten
creating
456
deleting
457
page object
346
Dignity/Almuten Editor
daytime/night-time charts
452
editing a definition
448
house cusp offset
455
house system
455
PoF day/night formula
455
point modifiers
450
scoring
452
selecting Arabic Parts file
450
selecting diurnal applicability
453
selecting points for calculations
449
selecting rulership sets to use
453
sign boundaries
455
starting
446
term type
454
triplicity rulers
454
using arabic parts as calculation points
450
Direction of Divisions
primary mundane direction of Asc
116
tabulation of planetary term & ages
113
Directions
173, 205, 209
abbrev/subscripts in time map
202
animating a directed chart
211
animation - setting options
213
calculation method, primary mundane, van Dam
Primaries
471
calendar
176
casting chart
149
for life events
144
in graphic ephemeris
204, 206
in multiwheel - one step construction
211
interpretation input file - editing
380
interpretations require dynamic aspects
239
of term
349
page object- primary
346
primary mundane
186
primary rate key
398
relocating
151
relocation preferences
399
to midpoints, of midpoints
192
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to natal - interpretation category
221
to radix
182
user rate in dynamic reports
189
user-defined
397
viewing a quick snapshot of 152
Directive lines
378
Displayed Points
changing
128
colors
139
copying a file
105
creating a new set
104
deleting a file
105
editing a file
106
editing a set
414
for the current chart
128
for transits - changing
129
in graphic ephemeris
205
renaming a file
105
Displayed Transiting Points
editing a set
414
Dispositor
as an almuten point modifier
450
Distributing settings to students
250
Duplicate
charts - deleting
99
Dwarf Planets
493
Dynamic
converse method options
185
Dynamic points - using
arabic parts, asteroids, extra bodies, house
cusps, stars
429
fixed positions
430
midpoints
428
Dynamic Reports
abbreviations, glyphs, layout, point types
197
accuracy
181
automated start date
193
bold text, colors, glyphs, limitation, sort order,
weightings
195
copying
202
creating quick snapshots in a grid
152
cross chart aspects through time for two charts
186
direction arc
397
editing, choosing columns, resizing
199
print queue (only date order possible)
186
printing
202
progression & direction types, midpoints, orbs
186
saving selections
194
selecting aspects, events, points
186

Index
Dynamic Reports
Time Map
202
viewing
195
viewing chart
201
viewing interpretations

200, 202

-EEclipses
casting charts for
166
data source
493
eclipse points in extra ring
130
for financial astrology
269
in Dynamic reports
186
in extra ring points
430
in user-defined points
425
page object
336
preferences for exact lunar phase/maximum time
412
searching for
217
summary of current
113
types, Saros number
217
Editing
a file
106
chart details
98
definition file
375
quickly changing chart event type
98
updating chart details in database
98
Electional
search
291
setting conditions for search
296
specifying search time range and place
293
using search results
311
Elements
analysis
108
data page object
351
formula determining strength
236
graph page object
352
Email
21
chart data options
410
clients
252
emailing charts
252
graphics
279
including screenshots
22
protocols
252, 405
registration
26
resizing graphics in emails
22
suggestions for improvements
25
support
22
webmail
405
Encyclopedia
20

Entering data
35
Environment variables
SE_EPHE_PATH
467
Ephemeris
accuracy
469
generator
265
graphic
204
viewing, dumping to file
267
Ephemeris Generator
options
266
Eris
403, 493
ESCAPE
quickly exiting some windows/dialogs
42
Esoteric
astrology - reference material
494
rulerships
421
Esoteric Technologies
website
25
Essential Dignity
definition files available
447
definition files folder
447
in reports and page objects
446
opening a definition file
447
page object
346
Euorpean characters
499
Event Type
60
Events
63, 144
Exaltation
421
Exiting
41, 51
Expansion of houses
133
Experimental
470
Export
288
animated charts
215
calendar events to applications
179
chart data - ascii definition
367
chart data - available record fields
368
chart data - overview
365
chart data - record & field limitations
372
chart data - record fields
370
chart data - record format
367
chart files
287
interpretations
231
Extra Bodies
aspects - page object
342
editing the orbital elements
382
files
131
page object
336
selecting as extra points for dynamic report
Extra Points
dynamic - saving selection
430

529

429
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Extra Points
dynamic - types, editing
427
Extra Ring
points - changing
130
points - editing
430
points - in a chart & aspects to
points - selecting
103
setting the current file
432
wheel designs supplied
432

Find
charts in the current file
95
specific charts factors in various chart files
Firdaria
interpretation category
221
108
of chart - tabulation
113
page object
346
Fixed Base Chart
214
Fixed Positions
selecting as extra points for dynamic report
Fixed Star Editor
creating a new file
441
Face ruler
editing star info
443
as an almuten point modifier
450
merging a file
442
opening a file
442
Fall
421
opening editor, editing a file
441
FAQ
499
printing list/info
443
Favorites
saving
a
file
442
creating a customized subset of Help topics
17
sorting the stars
446
File
Fixed Stars
*.def 373
aspects - page object
342
*.int
373
classification of, nomenclature
443
clashing filenames
34
date
of
display
446
copying, renaming
105
description of files
491
creating
104
files
131
deleting
105
importing
442
determining the file a chart was saved to
38
page object
336
importing
34
selecting
103
page object property
357
selecting as extra points for dynamic report
type - currently being used
103
viewing in planetarium
274, 446
types
466
Fixed
stars
and
astronomical
objects
used for arabic parts, asteroids, extra bodies,
stars
131
in extra ring
130
File Manager
101
Fixed zodiacal positions
changing folder
104
in extra ring
130
copying files
105
Folder
creating files
104
changing in file manager
104
deleting files
105
Font Size
editing files
106
page object property
357
renaming files
105
Fonts
selecting files
103
changing size
143
Filename
screen vs printer
143
clash
34
selecting for display
143
Financial Astrology
Force Color
and the graphic ephemeris
271
for page objects
357
Charts
268
Frame Type
Introduction
268
page object property
357
Money
268
Stocks
268
Tools
269
Traders
269
Gardening information
176
Trading
268

-F-

-G-
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291

430

429

Index
Gauq. Sectors
of chart points - tabulation
113
Geocentric Correction
391
Geocentric Latitude Correction
manual set-up
31
Geodetic
casting chart
168
GIF
copy, send, publish graphics as
279
Glyphs
alternative
403
asteroid
492
for aspects
133, 461
for chart points
459
for signs
459
in dynamic reports
195, 197
Graphic Ephemeris
coordinate type
205
copying, printing, viewing
208
directions, lunations, modulus angle
205
display options, displayed points
205
for plotting financial data
271
for plotting user-defined patterns
271
generating
204
importing financial data
205
progressions, transits, relocating
205
quick date setting feature
205
saving selections
205
selecting dynamic type, options, points
205
Graphic File
page object property
357
Graphics
as page objects
352
copying, emailing, publishing
279
Grid
objects in Page Designer
335
settings for half aspect grid
84
using for dynamic snapshots
152
viewing
70
viewing synastry
50
Group Composite
casting chart
161
Guided Tour
45

-HHalf Aspect Grid
grid settings
84
Hank Friedman
495
Hardware
27

531

Harmonic
age & age+1
213
calculation methods
473
casting chart
157
short-cut key for chart
42
Haumea
492, 493
Height, Width
setting for page objects
357
Heliocentric
for financial astrology
269
HELP
17
getting the most from off-line Help
17
showing and hiding tabbed panel
18
Start here
17
Hemispheres
formula determining strength
236
Horary
report - essential dignities tabulations
446
report - house almutens
446
report for chart
108
Horary Considerations
page object
346
Houses
& almutens of chart - tabulation
113
accuracy of angles & cusps
470
aligning charts in biwheel by cusps
137
almuten
446
Asc/MC display
402
breaking down in polar regions
394
cusps - selecting as extra points for dynamic
report
429
cusps as extra transitting or progressing points
427
default system
402
description
400
expansion - switching on or off 133
formula determining strength
236
getting interpretation for
224
house cusp almuten definitions in house.alm
447
house line properties
318
importing charts - default house system used
290
in both wheels in a BiWheel
281
ingresses in Dynamic reports
186
midpoint composite
402
normally used
45
page objects
341
planets in next house in almuten calcs
455
preferences
400
progressions - mean quotidian
396
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Geocentric Latitude Correction
31
Lunar Node Type
31
Lunar Parallax Correction
31
Part of Fortune
31
Primary Direction Rate
31
Progression Day Type
31
User Progression Rate
31
Vulcan Calculation
31
Zodiac
31
Internet
21
updates
24
website
25
Interpretations
advanced tools for the computer literate user
372
author
490
browsing
227
categories
221
compacting a file
240
copyright
restrictions
490
Images
creating
new
file,
editing
file
233
generate/update/remove in View Chart window
current chart mode, general mode, viewing
224
76
dynamic
aspects,
selecting
aspects
237
Import
288
editing a raw source (definition) file
375
chart files
287
exiting
226
chart files with same name as existing files
106
exporting
231
charts and settings option
32
File - selecting
103
difference between Utility menu option & Chart
Interpretation File
373
Conversion utility
287
location
468
from locations
33
mapped aspect names
237
options
34
modes
228
selecting items
34
producing report
232
Improvements
rulerships
230
emailing ideas for
25
sabian
symbols
259
Index
selecting report categories
233
assembling targeted list of relevant Help topics
setting files
224
17
spoken
230
Information
starting the Interpretations Editor
233
finding for Solar Fire
17
text
categories
235
Ingress
types
228
casting chart
153
viewing contents summary
240
in Dynamic reports
186
viewing
dynamic
200
INI file
viewing dynamic report
202
installation
468
viewing
from
Time
Map
202
main
388
viewing full chart & synastry
233
Input file
373
weightings
236
creating from output file
374
window
224
Installation
28
word processor
232, 407
extra tasks for user to do
29
Interpretations Compiler
first run initial set-up
29
compiling
376
Installation (manual set-up)
creating new interpretations from scratch
372
Angle Progressions
31
Houses
proportional - switching on or off 132
search - specifying conditions for
296
selecting a system
61
setting default system for charts
400
setting which chart's used in multiwheel
316
strong/weak balance
228
system derived in harmonic charts
473
system in almuten calculations
455
toggling for a chart
87
Hyleg
484, 485, 486
defined
483
hyleg definitions in hyleg.alm
447
page object
346
Hypothetical
planets
470

-I-
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Index
Interpretations Compiler
decompiling
374
definition (input) file layout
378
editing interpretation text
375
error messages
376
execution and output file
376
opening
373
procedure overview
373
skills required
372
Interpretations Window
display options
231
menu items
221
opening, using
224

-JJaynes
law of sex, prenatal charts & calculations
Jet Propulsion Laboratory
436
Jigsaw
287, 288
John Thomas
259
Johndro
casting chart
168
Johnson- S.M.
490
JPG
copy, send, publish graphics as
279
Justification
of text in page objects
357

-KKeyboard
41
Keys
dialog boxes
41
short-cut
42
Keyword lines
378
Koch Houses
400

-LLAT 58
Latitude
graph page object
352
Latitudes
entering
60
Geocentric correction
391
of transits, progressions
204
Learning astrology
26
Lehman
hyleg calculation
484

478

533

hyleg info source
483
Life Events
63, 144, 289
creating when casting a subsidiary chart
148
editing, importing/exporting
145
using as subsidiary chart date
148
Lilith
470
displaying all three in charts
499
setting black moon apogee
390
Lillly
454
Limitations
exporting data
372
Lines
aspect
133
ListAbbrev
page object property
357
LMT 58
Local horizon
casting chart
157
Locality
Astro_Locality Maps
364
calculation methods
475
casting chart
168
Solar Maps
364
Location
adding new
67
atlas
64
automatic lookup, manual lookup
56
date and place bar
37
entering details, restoring default
56
Locational astrology
reference material
494
Longitudes
entering
60
Lunar
current phases summary
113
Lunar Mansions
page object
346
Lunar Node
87
type - manual set-up
31
type - setting
389
Lunar Parallax Correction
391
manual set-up
31
Lunar Phase
casting chart for, casting return, families of 166
in extra ring points
430
in user-defined points
425
page object
336
prior - in extra ring
130
short-cut key for chart
42
Lunar Phases
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Lunar Phases
for financial astrology
Lunations
in graphic ephemeris
Lynda Hill
259

269
205

-M-

Modalities
analysis
108
Modes
data page object
351
formula determining strength
236
graph page object
352
Modulus
page object property
357
Sort - page object
352
Sort, of chart - tabulation
113
Moieties
417
Money
268
Moon
aspects - page object
342
black moon
470
setting lunar node type
389
toggling node type
87
void of course
186, 392
Mouse
using
36
Moving
charts
100
MultiWheel
superimposition
137
viewing, arranging charts in specific wheels
Munkasey
108
Mutual Reception
page object
346
MWA
108

Macros
260
Mailto
252, 405
Main Screen
36, 37, 38, 39, 40
background
40
changing what is displayed
414
definition
36
Makemake
492, 493
MAPI 21, 252, 405
Maps
astro_locality
364
Margins
125
page object property
357
Max Orb
page object property
357
MC
calculation
394
Medieval & Classical astrology
reference material
494
Memory
running out of 76
Menu
37
Utlities - deleting items
363
Utlities - editing items
363
Utlities - reordering items
364
Naibod
Merge
angle progressions
396
chart files together
106
Nakshatra
Metafile
of chart - tabulation
113
copy, send, publish graphics as
279
wheel
281
Midpoint Weighting Analysis
108
Natal
Midpoints
499
interpretation category
221
composite chart houses
402
Natal Chart
for a chart - listing, axes, trees, modes
108
... see entries for "Chart"
51
in Dynamic reports
186
Natal Chart File
in extra ring
130
copying
105
interpretation category
221
creating
104
options for trees
405
deleting
105
search - specifying conditions for
296
renaming
105
selecting as extra points for dynamic report
428
selecting
103
trees - graph page object
352
Neptune
403
trees of a chart - tabulation
113
Node
Minimize
setting lunar node type
389
a window
76

-N-
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Index
Node
toggling lunar node type
Nodes of planets
in extra ring
130
Nova
287

87

-OOmar
hyleg calculation
485
Operating System
27
Oracle
sabian
259
Orbital Elements
editing the data file
382
Orbs
changing for aspects
415
highlighting tightness
135
planet orb ratios, unidirectional
417
setting different orbs for every planet
417
OS
27
Other bodies
in a chart & aspects to
108
Outlook
exporting daily transits etc to
179
Output file
373

-PPage Designer
astrodynes object, signs object
340
chart object
332
chart captions/comments
328
creating a new page file
325
description of page & object properties
357
designing, editing
324
dignity & ancient objects
346
editing - working with objects
325
editing the page description
362
graphic file
357
grid objects
335
midpoints object
352
objects - almutens, astrodynes, houses
341
objects - aspects, astrodynes
342
opening a page file for editing
325
opening the Designer & a page for editing
324
rays, quadrants, elements, modes objects
351
saving changes
362
selecting page sizes
360
user-defined point/planet lists
336

535

vedic objects
355
Page Objects
modifying properties from View Chart screen
84
Page sizes
in the Page Designer
360
Page Topic Index
arranging in categories
73
Pages
dasas
283
finding newly created
73
finding newly created pages
75
forcing background light/dark backgrounds
139
general captions available
328
margins
125
quickly editing displayed page properties
285
selecting
73, 103
shortcuts for viewing
75
specialized
281
viewing user-defined
72
Parallax
391
Parallels
in Dynamic reports
186
Parans
display format
404
report options
122
Part
of fortune - day/night in almuten calcs
455
of fortune - manual set-up
31
of fortune - selecting formula
390
Partile aspects
highlighting
135
Paths
468
PDF
copy, send, publish graphics as
279
Phase
of chart - tabulation
113
search - specifying conditions for
296
Place
automatic lookup, manual lookup
56
changing on main screen
31
date and place bar
37
entering details, restoring default
56
setting default
31
Place Atlas
29
Places
408
adding new
67
atlas
64
favourite
408
File - selecting
103
recently used
409
setting default
409
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Placidus
Houses
400
mundoscope
157
Planet
Bar
40
Bar - changing display
414
orb ratios
417
search - specifying conditions for
296
Planetarium
274
animating
276
coordinate system
274
printing
276
selecting a star
275
view direction
274
view heading
275
viewing a constellation
275
viewing star information
276
Planetary
36yr cycle - page object
346
day & hour - page object
346
hours - of chart
113
in extra ring
130
nodes
130
nodes - in a chart & aspects to
108
periods - page object
346
Returns - for financial astrology
269
sects - page object
346
tabulation
113
term & ages
113
Planets
...also see entries for "Points"
40
accuracy
469
current positions
40
Hypothetical, Vulcan
470
Jayne's hypothetical
478
relationship with signs
421
returns
153
search for in charts
291
with user-defined orbits
382
Pluto
403
Pointer
dial, dial options
81
Points
colors
139
copying a file
105
creating a new set
104
declination page object
352
deleting a file
105
editing a file
106
editing colors
420
latitude page object
352
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renaming a file
105
selecting
103
show aspects for specific chart point only
136
Solar Fire's default order in lists
403
speeds
470
standard - in extra ring
130
switch current chart display of on or off 128
switch general display of on or off 128
Polar
MC calculation
394
Position
search - specifying conditions for
296
Pottenger- M.
436
Predictive Astrology
reference material
493
Preferences
388
"Now" button precision
404
2 digit year entry
407
angle rounding
406
Asc/MC display
402
auto saving charts
410
black moon lilith
390
calendar
176
calendar date display
407
capricorn glyphs
403
chart angle progression
396
compliments
406
converting chart formats
410
customising toolbar
413
customizing main screen
414
default house system
400, 402
default place
409
default zodiac
399, 400
displayed point order
403
eclipses
412
emailing charts
410
enabling Teachers
250
ephemerides
411
eris glyphs
403
favorite places
408
Geocentric correction
391
importing
32
interpretation reports
407
Lunar Parallax correction
391
midpoint composite houses
402
midpoint tree options
405
neptune glyphs
403
paran display
404
part of fortune
390
pluto glyphs
403
polar region calculations
394

Index
Preferences
388
pre-setting
31
primary directions rate
398
progression day type
396
progs/directions relocation
399
ray weightings
394
recently used places
409
refresh default time zone
409
restoring, saving
388
saving on exit
389
select atlas
408
setting lunar node type
389
sounds
405
startup macro
411
stations
412
Teacher settings
405
uranus glyphs
403
user direction rate
189
user progression rate
397
user-defined direction rate
397
vedic warning
400
view menu display
403
void of course moon
392
vulcan
393
Preferences dialog
389
calculations tab
389
charts tab
410
dates tab
406
glyphs tab
403
houses tab
400
misc tab
404
places tab
408
prog dirns tab
395
zodiac tab
399
Prenatal
calculation methods
476
casting chart
162
description of 476
further reading
483
interpretation category
221
interpreting charts
481
Jayne's law of sex
478
short-cut key for chart
42
Primary Directions
Bob Makransky
182
classic & modern converse
185
converse directions
182
in a dynamic report
182
in Direction of Divisions report
113
in Dynamic reports
186
manual set-up
31

537

Martin Gansten
182
mundane/zodiacal
182
Placidus
182
rate key explained
182
Regiomontanus
182
Rumen Kolev 182
setting rate key
398
used in Direction of Divisions
116
Printing
122
a list of charts
101
altering settings
125
biwheel
50
charts etc in batches
126
dynamic report
202
fixed stars list and info
443
from a View screen
122
in black only, in color, many items at once
123
margins
125
Print Queue
123, 126
Print Queue - Dynamic reports (only date order
possible)
186
synastry grid
50
the planetarium
276
without viewing first
123
Prior lunar phases
in extra ring
130
Profection
animated
213
annual
149
Progressions
173, 205, 209, 281
abbrev/subscripts in time map
202
angles - method of deriving
396
animated charts
211
animation - setting options
213
aspect orbs
415
aspects used in reports
130
calculation method
471
calendar
176
casting chart
149
charts - using natal interpretations for
490
day type
396
day type, manual set-up
31
dynamic report preparation
181
extra points, extra progressing points
427
for life events
144
graphic ephemeris preparation
204
in graphic ephemeris
206
in multiwheel - one step construction
211
interpretation category
221
interpretation input file - editing
380
interpretations file
224
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Progressions
173, 205, 209, 281
interpretations require dynamic aspects
239
lunar phase chart
166
mean
471
mean tertiary progression rate
149
minor progression rate, user-defined rate
149
pre-setting basic options
150
progressed composite chart, automated
263
progressed points - copying a file
105
progressed points - creating a new set
104
progressed points - deleting a file
105
progressed points - editing a file
106
progressed points - renaming a file
105
progressed solar return chart
153
progressing points - editing
414
radix chart aspected points used in reports
131
reference material
493
relocating
151
relocation preferences
399
secondary, tertiary, arc directed
149
short-cut key for chart
42
to midpoints, of midpoints
192
to natal - interpretation category
221
true
471
types in Dynamic reports
186
user-defined rate
397
viewing a quick snapshot of 152
with transits, animated
283
Properties
page & object
357
wheels
315
Proportional Houses
132
Ptolemy
hyleg calculation
486
hyleg info source
483
Publish
graphics
279

-QQuadrants
data page object
351
formula determining strength
236
QuadriWheel
alignment of chart zodiacs
137
Queue
queueing charts etc to be printed
126
Quick
- date setting feature
205
QuickCharts
287
QuinquiWheel
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alignment of chart zodiacs

137

-RRadix
definition
148
extra points
427
File - creating
104
File - deleting
105
File - renaming
105
File - selecting
103
File- copying
105
points - editing a set
414
Rate Key
398
Rays
data page object
351
formula determining strength
236
graph page object
352
weightings
394
Real Time Clock
for financial astrology
269
multiple real time clock windows
210
using
209
Rectify
a chart birth time
78
Redraw
image in View Chart window
78
Reference materials
astronomical calculations & computing
esoteric astrology
494
general astrology
493
locational astrology
494
medieval & classical astrology
494
predictive astrology
493
specialized topics
494
Registration
26
Relationship
ashtkoot report
121
biwheel "synastry"
138
casting various charts for
161
synastry grid
50
synastry report
121
Relocating
combined & composite chart
161
directions, progressions
149, 399
in Dynamic reports
186
in graphic ephemeris
205
lunar phase chart
166
manually change chart location
86
natal chart
168
prenatal chart
162

495

Index
Relocating
returns
153
rise/set chart
164
Reminders
adding
257
birthdays
257
viewing
257
Reports
ashtkoot
121
aspected points used
131
aspects used
130
bold text, colors, glyphs, headers
117
copying, printing
117
date order of dynamic - via print queue
186
description
108
dynamic
181
for single chart
117
generating
108
interpretations
232
modulus angle, orbs
117
parans in star report
122
printing
122
rich text format
407
saving dynamic selections
194
synastry
121
Zodiacal Releasings
117
Requirements
disk space, RAM, system
27
Restore
a window
76
Retaining Charts
clearing
89
Return
accuracy of returns
157
calculation methods
472
casting a chart
153
charts - using natal interpretations
490
demi, quarti etc.
153
interpretation category
221
multiple returns, progressed solar return
153
of asteroids, planets or to user-defined point
153
progressed solar- defined
472
quickly viewing aspects to natal
152
short-cut key for chart
42
Reverse
printing text vertically upwards in page objects
357
Rich Text Format Reports
407
Right-clicking something...
definition
36

539

Rise/Set
casting chart
164
of chart points - tabulation
113
short-cut key for rising/setting chart
42
RTF
407
Rulers
Decanate, Face, Term
281
Rulerships
421
changing
421
hierarchical, esoteric, tabulation of 421
in a chart
108
page object property
357
Rulerships and Weightings Editor
422
used in dignity/almutens
453

-SSabian symbols
in View Chart window
259
interpretation category
221
oracle
259
Saros Number
217
Save chart to file
auto chart save
91
quickly determining the file it's saved to
38
short-cut key
42
Saving Preferences/Settings
389
Scholfield Collection
487
Schools - astrology
26
screen
capturing a screenshot
22
pasting screenshot into an email
22
resizing a screenshot
22
Search
advanced search for chart component(s)
291
creating a list of conditions
305
finding all instances of something in Help
17
for aspects in charts
307
for chart factors
96
for charts, comments
96
for electional dates
291
multiple conditions
306
results
308, 311
setting conditions for
296
specifying electional time range and place
293
Sects
page object
346
Selecting something...
definition
36
Sending Chart Data
253
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Serial number
462
Session
245
appointments for
243
emailing appointment reminders
245
receipts
248
Settings
388
"Now" button precision
404
2 digit year entry
407
access to
387
angle rounding
406
Asc/MC display
402
auto saving charts
410
black moon lilith
390
calendar
176
calendar date display
407
capricorn glyphs
403
capturing teacher settings
250
chart angle progression
396
compliments
406
converting chart formats
410
current file
387
currently in use
38
customising toolbar
413
customizing main screen
414
date, time
37
default house system
400, 402
default place
409
default zodiac
399, 400
displayed point order
403
eclipses
412
editing
389
emailing charts
410
enabling Teachers
250
ephemerides
411
eris glyphs
403
favorite places
408
Geocentric correction
391
importing
32
INI files
468
interpretation reports
407
loading Teacher settings
251
lunar node type
389
Lunar Parallax correction
391
midpoint composite houses
402
midpoint tree options
405
neptune glyphs
403
paran display
404
part of fortune
390
pluto glyphs
403
polar region calculations
394
pre-setting basic progression options
150
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primary directions rate
398
printer
125
progression day type
396
progs/directions relocation
399
ray weightings
394
recently used places
409
refresh default time zone
409
removing Teacher settings
251
restoring, saving
388
saving on exit
389
select atlas
408
sounds
405
startup macro
411
stations
412
Teacher settings
405
types
387
uranus glyphs
403
user progression rate
397
user-defined direction rate
397
vedic warning
400
view menu display
403
void of course moon
392
vulcan
393
Set-up (manual)
Angle Progressions
31
Geocentric Latitude Correction
31
Lunar Node Type
31
Lunar Parallax Correction
31
Part of Fortune
31
Primary Direction Rate
31
Progression Day Type
31
User Progression Rate
31
Vulcan Calculation
31
Zodiac
31
Shortcuts
for viewing charts, user defined pages, wheels
75
how short-cut keys work
37
short-cut keys
42
Signs
459
as text in wheels
321
aspects by signs only
417
aspects to sign boundaries
342
boundaries in almuten calcs
455
boundary - in angle rounding
406
chart alignment
137
colors
139
creating new color file
104
diurnal & nocturnal page object
346
editing colors
420
elements and modalities analysis
108

Index
Signs
459
fill - editing colors
420
filling with color in wheels
319
finding points in
291
formula determining strength
236
getting interpretation for
224
ingress
153, 176
ingress in dynamic report
186
moon sign in calendar
175
of chart - astrodynes
113
of orb - in midpoint trees
405
page objects
340
ray proportions
394
relationship with planets
421
rulership weightings
421
search - specifying conditions for
296
vedic whole sign houses
355
Sky
viewing chart in
274, 276
Snapshot
of dynamic aspects
152
Software
astrological
25
Solar & Lunar Returns
reference material
493
Solar arc
397
Solar Fire
accident recovery / reinstalling
462
backing up charts & user files
462
essential concepts
36
exiting
41, 51
file types, file & folder locations
463
guided tour
45
internet updates, links and information
23
introduction
15
learning how the program works
17
main screen
36
other products
25
prerequisites for using
36
registration
26
starting
35
suggestions/improvements
21
uninstalling
463
updates
21
web support
21
website
25
Solar Live
23, 40
turning display of on or off 414
Solar Maps
28, 364
Solstice (antiscia) chart
157
Sorting

541

in dynamic reports
195
Sound
405
Source Rating
61
Specialized
astrology topics - reference material
494
wheel styles, page layouts
281
Speeds
of points
470
Stars
429
aspects - page object
342
classification of, nomenclature
443
date of display
446
description of files
491
editing star info
443
files
131
importing
442
in a chart - aspects to, parans
108
in extra ring
130
page object
336
printing list/info
443
selecting
103
selecting as extra points for dynamic report
429
viewing in planetarium
274, 446
Starting
Solar Fire
35
Stations
108
in Dynamic reports
186
of chart points - tabulation
113
preferences
412
Stellarium
276
Stocks
268
Students
249
enabling Students
251
Subsidiary
charts
147
charts - selecting a base chart for
148
Suggestions
emailing
25
Superimposition
caption on chart pages displaying option chosen
328
types, options
137
Support
21, 22
Swap
chart positions in View Chart window
78
Swiss Ephemeris
accuracy
469
asteroids
411, 436
location
411, 463, 467
opening swiss ephemeris files folder
437
website
436

© 2014 Esoteric Technologies Pty Ltd

542

Solar Fire 9 User Guide

Symbols
glyphs
459
Synastry
aspected points used in grids & reports
131
aspects used in grids
130
aspects via zodiac alignment in biwheel
137
cross chart aspects through time
186
interpretation category
221
progressed/natal - viewing in a biwheel
138
viewing grid
70
viewing or printing grid
50
Synastry grid
short-cut key
42
Synastry grids
for financial astrology
269
System
468

-TTablets
27
Tabulations
generating
108
of chart - description
113
Teachers
249, 251
capturing teacher settings
250
enabling Teachers
250
Teacher settings
405
zip file
251
Technical
461
support
21, 22
Temperaments
tabulation
113
Term
Tetrabiblos translated by Lilly
454
types defined for almuten calculations
454
Term Directions
page object
346
Term rulers
as an almuten point modifier
450
wheel
281
Text
printing text vertically upwards in page objects
357
Text lines
382
Time
entering, format
55
precision
404
rectifyng a chart
80
selecting format
30
setting clock
30
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system
37
Time Map
181
copying to clipboard
202
dates, hit numbers
202
deleting lines, moving lines
202
viewing interpretations
202
Timezone
LAT, LMT, entering
58
startup
409
Title Line
in page objects
357
Toolbar
37
changing display
414
editing
413
Tools
Financial
269
Topocentric
Moon
391
Trading
268, 269
Transits
173
abbrev/subscripts in time map
202
animated
211
aspect orbs
415
aspects used in reports
130
calendar
176
casting a chart
149
casting a chart - to a specific planet/point
157
definition of a "transits" chart
129
dynamic report
181
extra points, extra transiting points
427
for financial astrology
269
for life events
144
in animated multiwheel - one step construction
209
in graphic ephemeris
204, 205
interpretations require dynamic aspects
239
of midpoints, to midpoints
186
radix chart aspected points used in reports
131
reference material
493
to Directions
182
to natal - interpretation category
221
to natal - interpretation category (calendar)
221
transiting points - copying a file
105
transiting points - creating a new set
104
transiting points - deleting a file
105
transiting points - displayed in a multiwheel
129
transiting points - editing a file
106
transiting points - editing a set
414
transiting points - renaming a file
105
viewing a quick snapshot of 152
with progressions, animated
281

Index
Transneptunians
470
Triplicity
rulers - as an almuten point modifier
450
types defined for almuten calculations
454
TriWheel
alignment of chart zodiacs
137
wth interchart aspects
281

-UUninstalling
Solar Fire
463
Updates
24
Upgrading
501
Uranus
403
Use
Progression Rate
397
User
Direction Rate
397
manual set-up
31
Progression Rate
31
Rate - for directions in dynamic reports
189
User Files
adding external pages
73
almuten/dignity
446
almuten/dignity - user files cf. system default
definition files
447
alternative interpretations location
468
backing up charts & user files
170
compiled interpretations files
376
files and folder locations
463
finding folder containing
170
INI settings stored with
468
interpretation definition files
378
interpretation files location
222
interpretation input files
378
page design file
325, 362
solfire8.ini
388
teachers zip file
251
uninstalling
463
User-Defined
files, pages, points - selecting
103
pages - editing
324
points - editing
425
setting the current file
425
Utilities
362
deleting menu items
363
editing menu items
363
opening swiss ephemeris files folder
437
reordering menu items
364
suggestions
364

543

-Vvan Dam Primaries
animated
213
directions
471
Vedic
casting chart, divisional charts
169
chart page objects
355
dasas/bhuktis of chart - tabulation
113
Nakshatra wheel
281
zodiac warning
400
Vernal Point
81
Version
462, 501
Vertex
arc
397
View Chart window
buttons described
78
changing display/preview options
78
editing page properties on the fly
285
quickly exiting from
78
removing images
76
resizing/moving the window
76
update displayed image with changes
76
using, changing display options
76
View Menu
customizing
403
Viewing
biwheel
50
calculated charts
69
chart reports & tabulations
117
current chart (+grid) instantly
42
snapshot of dynamic aspects
152
Void of Course
definition
392
in Dynamic reports
186
settings
392
Vulcan
calculation
393
calculation (manual set-up)
31

-WWeb support
21
Webmail
405
Weighted Scores
page object property
357
Weightings
422
changing
421
in dynamic reports
195
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Weightings
422
interpretation balances
236
of scores - graphical page objects
352
of scores - page objects using
351
Weston L.H.
393
Wheel Designer
313
adding a chart
323
adding a circle
322
aspect line properties
321
circle properties
317
common properties
316
creating a new wheel or dial
314
cusp annotation properties
318
deleting a chart
323
deleting a circle
323
editing wheel description
324
general properties
316
house line properties
318
house numbering properties
319
opening a wheel or dial for editing
314
planet ring/extra ring properties
321
saving your changes
314
setting all line colors at once
323
zodiac/dial properties
319
Wheels
available on page designs
332
changing
131
decanate, face & term rulers, nakshatra
281
editing style
313
selecting style
103
selecting style for display
131
shortcuts for viewing
75
style design options
315
Whole Sign Houses
400
Width, Height
setting for page objects
357
Windows
8
27
Explorer
466
minimizing/restoring/full screen
76
Print Queue
123
printer driver settings altered
125
version
462
Word processor
default
232
selecting
232, 407
Wynn-Key
defined
472
return
153

© 2014 Esoteric Technologies Pty Ltd

-ZZip file
capturing teacher settings
250
students
251
teachers and students
249
Zodiac
87, 399
manual set-up
31
selecting
61
signs
459
Zodiacal analogue
casting chart
157
Zodiacal Releasings
of chart - tabulation
113
selecting dates of interest
117
viewing report
117

